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1 Get Started using the Developer 
The Developer is a synchronized content platform for creating documentation, training, and 
performance support across the business enterprise. Its use is generally limited to a team of 

content authors. The content is made available to users through a Player or document output. 
 
The Developer allows you to create and publish content easily. Content includes simulations, 
in-application support, and interactive documentation. Users gain a well-rounded knowledge of 
software functionality, complete with an understanding of the concepts, by learning how to 
use a program in both a simulated environment and while working with their own data in a 

live environment. Simulations can be viewed in any one of the following play modes via the 
Player: 

 See It! mode enables a user to learn by watching an animated demonstration of the 
steps for a task being performed in a simulated environment. All of the required 
activities, such as moving the mouse and entering data, are completed automatically. 

  

 Try It! mode enables a user to learn interactively in a simulated environment. The 

user is prompted for mouse clicks and/or keystrokes to complete the task. 
  

 Know It? mode enables a user to test their knowledge of a particular task. Users are 

instructed to complete a particular task without step-by-step instructions. Instead, 
they complete the steps on their own in a simulated environment, and they are scored 
on how accurately they complete them. 
  

 Do It! mode enables a user to learn interactively using a live application. A user is 

presented with a small window on top of the live target application that displays each 
step for a particular task. As the user completes each step, he/she can click a button 
or use a hot-key combination to display the next step in the process. Within the Do It! 
window, a thumbnail graphic of the screen is available with a highlight indicating the 

area where the action should take place. 

  

 Print It! mode enables a user to display linked documentation in the form of a Job Aid 
or System Process Document. 

  

 Test It! mode enables a user to run manual test scripts against a live application. A 
modified version of Do It! mode guides the user through the steps of the test case. 
Users can mark steps as passed or failed, add their own comments, and generate bug 
reports. 

1.1 Review the Developer Interface 
The Developer interface is similar to most Windows applications with a movable menu and tool 

bar, status bar, and a main work area. The main work area can display the Library as well as 
any of the available document editors. If you display the Library, you can see a default set of 
folders and documents. The Library is the central repository of your content that can be 

accessed by one or more authors at the same time. The Library shows all content in the form 
of various folders and documents. Folders are similar to the folders on your computer that 
store files; however, folders in the Developer are used to store content-specific documents. 

Every object in the Developer is called a document and there are specific document types that 
you use to build content.  
 
As you develop content and begin to create and open documents, additional work areas 
appear in new tabs. The document name appears in the tab and cannot be directly edited in 
the tab. If you want to change the name of a tab, you must change the name of the 
document. 

 
Each tab is associated with a specific document editor that is launched when you open a 
document. For example, when you open a module document, a new tab appears, and the 
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Outline Editor is launched in the work area. The name of the document appears in the tab with 

the appropriate document type icon. You can continue to open additional documents, thereby 

opening a new tab for each new work area. You can navigate between each tab by clicking on 
it and close a tab when you are finished with the content that is displayed. 
 
A work area may have multiple panes associated with it. For example, the Library has two 
panes where the left pane displays folders and the right pane displays the documents that are 

stored in the selected folder. The Outline Editor also has two panes where the left pane 
displays the outline of module, section, and topic documents and the right pane can display 
document details or conceptual and introduction content that is linked to each document. 
These different displays of document information are called views. For example, the Details 
View displays columns of document properties such as its Type, Last Modified Date, and so on. 
The Player View simulates the user interface of the Player and displays conceptual and/or 
introduction content that is linked to a specific document in the outline. This linked content 

can be web pages, documents, presentations, and so on. You can easily switch between these 
views using the View toolbar. 
 

The remainder of this section describes how to start the Developer and customize various 
areas of the interface. 
 
Since you can use the Developer in single or multi-user mode, the documentation includes a 

chapter on multi-user functionality as well various multi-user considerations. The following 
convention is used to identify specific multi-user functionality throughout this documentation: 
 

 Multi-user Considerations 

 Information about multi-user aspects of the Developer. 

1.1.1 Start the Developer 

You can start the Developer from the Windows Start menu, or you can create a shortcut on 

your desktop.  

 

Create Profile 

When you start the Developer for the first time in a single user environment, you are asked to 
create a content Profile that determines where the content Library is stored on your local 
computer. See the Add a Content Profile topic in the Create and Manage Profiles chapter of 

this guide for more information. 
 
When you start the Developer for the first time in a multi-user environment, you are asked to 
create a login Profile that controls the connection to a specific content Library on a shared 
server. See the Create and Manage Login Profiles topic in Using the Developer in a Multi-user 
Environment chapter of this guide for more information. 

 
After you create and open a Profile in either a single or multi-user environment, the Start 
Screen appears. 
 

Set Primary Authoring Language  

When you start the Developer for the first time, you are asked to choose a primary authoring 

language that controls the default language for content that you create in the Developer 
(Language property). This setting also controls the language of the default template, and 
several default font settings for text. For example, if you choose Japanese or Chinese, the 
default is automatically set to a font that is capable of rendering these characters onscreen 
and in print. 
 

Launch the Start Screen 

When you launch the Developer, the Start Screen presents you with the following options: 

 Open the Library 
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 Open an existing document 

  

 Create a new module 
  

 Create a new topic 

  

 Import content 

All of these options can also be performed using menu commands. As you become familiar 
with the Developer, you may want to suppress the display of the Start Screen by deselecting 

the Show this screen at startup option. When you launch the Developer without the Start 
Screen, the Library automatically appears. To display the Start Screen at any time, choose the 
Start Screen command from the View menu. 
 
The Start Screen also displays the last six modules that you opened in the Recent Modules 
section. The Library always appears when you close the Start Screen. 
 

 Multi-user Considerations 

 If you installed a multi-user version of the product, the word "Client" appears after the 
Program Group and Program Name. 

1.1.2 Create and Manage Content Profiles 

In a single user installation, a content Profile determines the folder location on your computer 
where the content Library is stored. A default location is provided; however, you can choose 
any folder on your local computer.  

 
You can create multiple content Profiles if you plan to use multiple libraries. You can also edit 
a content Profile and change the folder location and your content moves accordingly. 
 
Important Note: Deleting a content Profile removes all content from your computer. 

1.1.2.1 Add a Content Profile 

You must create a content Profile when you start the Developer for the first time to identify 
the folder location on your computer where your content is stored. The folder location must be 
on your local computer and cannot be on a network drive. You must also have enough disk 
space to accommodate your content. 
  
Note: If you receive a Proxy Authentication dialog box when you log in to the Developer, 

enter your username and password for the proxy server. If you select the Save my password 
option, the username and password information is encrypted and saved to the 
OdDev.exe.config file in the path for the application data, for example c:\Documents and 
Settings\<username>\Local Settings\Application Data\<local cache> (Windows XP) or 
c:\Users\<username>AppData\Local\<local cache> (Windows 7). If your password changes 
for the proxy server, you can open this file in a text editor and delete the tags 
<ProxySettings> and </ProxySettings> and all the text in between. This causes the Proxy 

Authentication dialog box to open the next time you log in so that you can enter your new 
password. 
 

To add a content Profile: 

1. On the Tools menu, choose  Profiles. 
  

2. Click Add to start the Profile Wizard. 
  

3. Click Next to display the Profile Name page. 
  

4. For multi-user installation only, type the location of the Library and click Next. 
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5. Type a unique name for the profile. If you create multiple profiles to access different 

content Libraries, use this name to switch between Libraries. You cannot have multiple 

profiles with the same name. 
  
Also, if you create multiple profiles, you can configure one as the default that is 
automatically used every time you launch the Developer by clicking the Make this my 
default profile option. The name of the active profile appears in the title bar of the 

Developer to identify the Library in which you are working. 
  

6. Click Next to display the Data Storage Location page. You can either accept the 
default data storage location or choose a different folder on your computer. Click 
Browse if you want to change the default folder or click Next to accept the default 
folder. You must choose a folder on your local computer. Network drives are not 
permitted. The folder that you select must also be empty. 

  
7. Click Next to complete the Profile Wizard. 

  

The last page in the Profile Wizard displays a summary of the profile including the 
name and data storage location. 
  

8. Click Finish. 

1.1.2.2 Edit a Content Profile 

You can edit any content Profile that is not in use and change its name or the folder location 
where the Library content is stored. To edit a content Profile that is currently in use, you must 
first exit the Profile. 
 
Note: Changing the location of the Library content does not change the location of other data 
such as preference, profile, view, or log files. 

 

To edit a content Profile: 

1. On the Tools menu, choose  Profiles. 
  

2. Select a profile from the list. 
  

3. Click Edit or Exit Profile if you selected a profile that is in use. 
  

4. Change the folder location or name and click Next. 
  

5. Click Finish. 
  

Your content is moved from the old folder to the new folder that you specified. This 
may take some time depending on the size of your content. 

1.1.2.3 Delete a Content Profile 

Deleting a content Profile permanently removes all content stored in the folder location 
defined in the profile. 
 

To delete a content Profile: 

1. On the Tools menu, choose  Profiles. 

  
2. Select a profile from the list. 

  
3. Click Delete. 

  

You are warned that deleting a profile also permanently deletes all content in the 
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Library (including any documents in the System folder). 
  

4. Confirm the deletion or cancel. 

1.1.2.4 Switch Content Profiles 

If you have multiple content Profiles, you can switch between Libraries without having to close 
the Developer. To do this, you must have a content Profile for each Library. 
 

To switch content Profiles: 

1. On the Tools menu, choose  Profiles. 
  

2. Click a profile for a different Library. 

  
3. Click Open to switch to the Library. 

1.1.3 Configure Toolbars 

The Developer provides the following toolbars: 

 Assessment Editor: Displays icons for linking new or existing questions to an 
assessment. 
   

 Library: Displays icons for creating new documents from the Library. The icons and 

their associated commands are also under New on the File menu. 
   

 Outline Editor: Displays icons for linking new documents, moving, and previewing 

documents in the outline. 
   

 Question Editor: Displays icons for creating and editing questions. 
   

 Standard: Displays icons for common commands that are available across most 

document editors. 
   

 Style Editor - Styles: Displays icons for adding, deleting, and setting default styles 

and adding print and language variations for styles. 
   

 Style Editor - Table and List: Displays controls for selecting individual table 

elements (such as, caption, header row and column, odd/even rows) for formatting 
and the controls for formatting list and bullet levels and adding custom bullet images. 
   

 Style Editor - Text/Paragraph: Displays the icons for formatting text, lines, and 

images. 
   

 Topic Editing: Displays icons for common topic editing commands for context, 
frames, screenshots, and so on. 

   

 Topic Navigation and View: Displays icons for topic frame navigation and bubble 
text display. 
   

 View: Displays icons for changing the screen layout and views. 
   

 Web Page Editor - Appearance: Displays icons for adjusting text display including 

text and page color, lists, spacing, and clearing formats. 
   

 Web Page Editor - Font and Formatting: Displays icons for setting text font and 

format. 
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 Web Page Editor - Insert: Displays icons for inserting content into a web page (for 

example, images, links, or tables). 

   

 Web Page Editor - Package: Displays icons for creating text and input fields on an 

html file in a package. 
   

 Web Page Editor - Tools: Displays icons for finding and replacing text, showing text 
blocks and opening the web page in a browser 

By default, the appropriate toolbar appears based on the document editor that is active. For 

example, when you open a web page the formatting toolbars for the Web Page Editor appears. 
When you close the Web Page Editor, the formatting toolbars are removed from the screen. 
However, you can configure each toolbar to always appear by marking the appropriate option 
on the toolbar menu. 
 

You can restore the toolbar display back to the installation defaults using the Restore Default 
Layout command on the View menu. 
 

 Multi-user Considerations 

 The following toolbar is available only in multi-user installations. 
  
Versioning: Displays icons for document check in and check out. 

To hide/display toolbars: 

1. Start the Developer. 

  
2. On the View menu, point to Toolbars, and then choose the toolbar that you want to 

display. 

To reposition toolbars: 

1. Point to the left corner of a toolbar. 

  
2. Drag the toolbar to any position on the screen. 

Note: You can also reposition the menu bar using these same steps. 
 

Use Menu Commands 

When you are working in the Developer, you may prefer to use menu commands rather than 

toolbar icons. If you want to hide the toolbars to provide more space on the screen, you can 
do so. You can display the toolbars again at any time. On the Toolbars submenu (from View 
menu), a checkmark next to the toolbar name means the toolbar is visible; if there is no 
checkmark, the toolbar is hidden. 
 

Note: You can also drag and drop each toolbar (and menu bar) and reposition it anywhere on 
the screen. Use the Restore Default Layout command on the View menu to restore the default 
toolbar and menu bar positions. 

1.1.4 Split the Work Area 

By default, the work area appears in a single layout; however, you can split the work area 
horizontally or vertically depending on how you prefer to work. Regardless of your choice, the 
entire work area is separated by a split bar that you can use to resize each work area.  
 

Splitting the work area is useful since you can explore different areas of a document in both 
work areas. You can also view different documents and drag/drop or copy/paste reusable 
documents between work areas to help make building content easier.  
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When you open a document in one work area, a tab for the newly opened document 
automatically appears in the second work area. In other words, the same tabs appear in split 

work areas. However, the document displayed within a tab can be different between two work 
areas. For example, you can have the same module document open in two work areas but 

explore different sections of the outline in each. 
 
If you split a work area that has numerous tabs open that cannot be displayed for space 

reasons,  left and  right arrow buttons appear that allow you to scroll to the tabs that do 

not appear. Click  to close a selected tab or right click on the tab and choose Close. 
 
Note: You cannot change the order of the tabs that appear in a window. The order is 

determined by the sequence in which you open documents. 
 

To split the work area: 

1. On the View menu, click  Horizontal Layout to split the work area horizontally or 

click  Vertical Layout to split the work area vertically. 

  
2. Use the mouse to navigate between the different work areas. 

  

3. Click  Single Layout to remove a horizontal or vertical split. 

1.1.5 Configure Toolpanes 

Toolpanes are used to perform many common tasks. You can display and position the 
following toolpanes in the Developer:  

 Broken Links toolpane to display which documents contain broken links. 
   

 Properties toolpane to set and change various document properties. 
   

 Related Documents toolpane to display documents linked to and from a document. 

   

 Derived Documents toolpane to display any documents that were created from the 
parent document. 

   

 Style Inspector toolpane designed to work specifically with the Web Page Editor to 
show which formatting attributes are part of an applied style. 
   

 Context Search toolpane designed to search for documents based on context id. 
   

 Topic Editor toolpanes designed to work specifically with the Topic Editor to create and 

edit bubble text, change action and frame settings, link attachments to concepts, 
create frame links, and add sound, as well as navigate the topic frame structure. 

It is not necessary to close a toolpane to make an action take effect; it can be left open and 
available while you continue to work. 
 

To open a specific toolpane, you select the command or toolbar icon for that task. You can 
open a toolpane from the Library or any document editor. 
 

By default, toolpanes open in a docked, vertical or horizontal toolpane on the right side or 

bottom of the work area depending on the document editor/library that is active. The name of 
the toolpane appears in the toolpane's title bar. You can open a single toolpane or multiple 
toolpanes at the same time and resize and position them. The Developer remembers the 
arrangement and size of your toolpanes. 
 

Note: The toolpane does not split when you enable a split layout. The information in the 
toolpane refers to the selection in the active layout. 
 



Get Started using the Developer 

 

 8 

By default, the appropriate toolpane appears based on the document editor or the Library that 

is active. For example, when you open the library or any document editor other than the Topic 

Editor, no toolpanes appear. However, when you open the Topic Editor, the Frame Properties 
and Frame Comments toolpanes appears on the right side of the screen and the Frame 
Structure and Sound toolpanes appear at the bottom of the screen. When you open another 
document editor, these toolpanes are removed from the screen. However, you can display any 
toolpane in any document editor or the Library by selecting the toolpane on the Toolpane 

menu. If you explicitly choose to display a toolpane in the Library or document editor, it 
appears in any document editor that you open. For example, if you open the Properties 
toolpane in the Library or Outline Editor, it also appears in the Topic Editor (as a tab at the 
bottom of the default Topic Editor toolpanes). 
 
Some toolpanes are designed to function with specific document editors. For example, the 
Frame Properties, Frame Comments, Frame Link and Frame Structure toolpanes are designed 

to function in Topic Editor only. If you decide to display one of these toolpanes in a document 
editor other than the Topic Editor, it does not function and it appears blank or disabled. 
 

You can restore all toolpane displays back to the installation defaults using the Restore Default 
Layout command on the View menu. 
 

To open and close a toolpane: 

1. To open a toolpane, on the View menu, point to Panes, and then choose the toolpane 

that you want to display. 
  

2. To close a toolpane, click  in the top right corner of the toolpane or deselect the 
corresponding menu command or toolbar icon. 

1.1.5.1 Resize a Toolpane 

You can resize docked or floating toolpanes. Docked toolpanes display a thick border, called a 
split bar, between the toolpane and the rest of the work area. Dragging the split bar allows 

you to increase or decrease the size of the toolpane. For floating toolpanes, drag any border or 
corner to resize its length and/or width. 
 

To resize a toolpane: 

1. To resize a docked toolpane, drag the split bar between the toolpane and the work 
area. 

  
2. To resize a floating toolpane, drag a border or corner until the toolpane is the desired 

size. 

1.1.5.2 Move a Toolpane 

You can dock a toolpane vertically or horizontally on the right, left, top or bottom edge of the 
work area or float it anywhere on top of the Developer window. You move a floating or docked 

toolpane by dragging it by its title bar. 

 
When you drag a toolpane, two sets of toolpane icons appear to help you select a position for 
docking the toolpane or positioning multiple toolpanes. One set displays icons around the 
perimeter of the work area and docks the toolpane at the corresponding edge. The other set, 
which initially appears in the center of the work area, helps you layer multiple toolpanes in a 
single stack or position them adjacent to one other. 
 

You dock a toolpane by dragging its title bar to an icon corresponding to the desired docking 
position. If you want to float the toolpane, drop it anywhere on the work area except on a 
toolpane icon. 
 
The function of each toolpane icon is described next: 
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 Docks the toolpane at the top of the work area. For displaying adjacent toolpanes, 
positions the toolpane above the other docked or floating toolpane.  

  

 Docks the toolpane at the bottom of the work area. For displaying adjacent toolpanes, 
positions the toolpane below the other docked or floating toolpane.  
  

 Docks the toolpane on the left side of the work area. For displaying adjacent toolpanes, 

positions the toolpane to the left of the other docked or floating toolpane.  
  

 Docks the toolpane on the right side of the work area. For displaying adjacent toolpanes, 

positions the toolpane to the right of the other docked or floating toolpane.  
  

 Stacks toolpanes on top of one another in layers. Tabs appear at the bottom of the 

toolpane area for displaying a toolpane in the stack.  

  

To move a toolpane:  

1. To dock a toolpane, drag it by its title bar and drop it on an arrow icon corresponding 

to the desired docked position. 
  

Release the mouse button when the shaded image of the toolpane appears in the 
desired position. 
   

2. To float a toolpane, drag it by its title bar and drop it anywhere in the work area, 
except on an arrow icon. 

1.1.5.3 Display Multiple Toolpanes 

When you open multiple toolpanes, you can display them in any of the following positions: 

  
Individual docked or floating toolpanes 
If you dock one toolpane in a vertical dock (left or right side) and another toolpane in a 
horizontal dock (top or bottom), the first toolpane you dock sizes to the full docking space, 
while the other toolpane resizes to fit the remaining docking space. 
  
Stacked in a single docked or floating toolpane with multiple layers 

Stacked toolpanes layer one on top of another, with the most recently opened toolpane on 
top. 
 
The name of each toolpane in the stack appears in a tab at the bottom of the toolpane area. 
Clicking a tab moves that toolpane to the top of the stack so that you can view it. Both 
floating and docked toolpanes support stacking. When you move the stack, all of the toolpanes 

move at the same time. 
 

Adjacent toolpanes sharing the same docked or floating area 
Toolpanes can share the same docked or floating area. You can position toolpanes adjacent 
(side-by-side) to one another in any direction, above, below, left, or right. Adjacent toolpanes 
that share the same docked area (top/bottom for a vertically docked toolpane and left/right 
for a horizontally docked toolpane) display a Maximize icon in the title bar to expand the 

toolpane to the full docking area. 
 

To stack toolpanes: 

1. Drag one toolpane on top of the other until a set of toolpane icons appear on top of 

the dragged toolpane. 
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2. Drop the toolpane on the stack icon  in the center of the toolpane icons. 

  

3. To display a toolpane in the stack, click the tab of the toolpane. 
  

4. To separate stacked toolpanes, drag the tab of the toolpane you want to move to 
another location in the work area. 

To display adjacent toolpanes: 

1. Drag one toolpane on top of the other until a set of toolpane icons appear on top of 

the dragged toolpane. 
  
The icons that appear on top of the dragged toolpane correspond to adjacent positions 
rather than the perimeter of the work area. For example, the Up icon places the 
dragged toolpane above the toolpane under it. 
  

2. Drop the toolpane on the arrow icon corresponding to the desired adjacent position. 
  
Release the mouse button when the shaded image of the toolpane appears in the 
desired position. 

Note: When you position a toolpane above or below a vertically docked toolpane, or to the left 
or right of a horizontally docked toolpane, a  Maximize icon appears on the toolpane's title 
bar. Click  to maximize a toolpane to fit the entire docked area or  to restore it to a 
shared size. 

1.1.5.4 Autohide a Docked Toolpane 

There are two behaviors for a docked toolpane; to always appear on top of the work area, or 

to hide automatically when not in use. This behavior is controlled by the  Pushpin icon, 

which appears in the right corner of the title bar for docked toolpanes. The pushpin points 
down when enabled and points left when disabled. By default, the pushpin is enabled and the 

toolpane always appears on top of the work area, sticking the toolpane to the window. Clicking 
the Pushpin icon unpins the toolpane. Three things happen when you unpin a toolpane; the 

direction of the pushpin changes, a tab for the toolpane appears, and the toolpane disappears 
into the border of the work area as soon as you move the mouse pointer off the toolpane. You 
can autohide multiple docked toolpanes. 
 
To display a toolpane, either point to, or click the tab you want to view, or click the Pushpin 
icon to disable the autohide behavior. For stacked toolpanes, the pushpin controls the pinning 

actions for all toolpanes in the stack and creates a tab for each stacked toolpane. 
 

To autohide a docked toolpane: 

1. On a docked toolpane, click  to unpin the toolpane. 
  

The direction of the pushpin points to the left and a tab appears next to the toolpane 
with the name of the toolpane. 
  
The toolpane hides when you move the mouse pointer from the toolpane. 
  

2. To display the hidden toolpane, point to the toolpane tab. 

  
Clicking the pushpin tab temporarily sticks the toolpane to the window. 
  

3. To disable autohide and display the toolpane always on top, click . 
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1.1.6 Restore Default Toolbars and Toolpanes 

After you configure toolbars and toolpanes in the Developer, you may find that you want to go 

back to the default layout from the original installation. The Restore Default Layout command 
reverts the Developer user interface display back to the original toolbar and toolpane 
configuration that was initially installed. Toolbars and toolpanes for all document editors and 

the library are automatically reverted back to the default layout when you run this command 
from the View menu. 
 

To restore the default layout: 

1. On the View menu, choose Restore Default Layout. 

  
The display and position of toolpanes and toolbars for all document editors and the 
Library is restored to the default layout of your original installation. 

1.2 Understand the Developer Basics 
You use the Developer to create, maintain, and publish your content Library. A typical content 
Library can contain hundreds, if not thousands, of documents. You can organize the Library 
using folders (similar to the way Windows Explorer lets you organize files on your computer). 

The main difference between Windows Explorer and the Library is that documents are stored 
in a relational database and not as individual files on a disk drive. However, this difference is 
largely transparent to you as you develop your content.  
 
To help you visualize your content as you build it, the Developer offers various displays: 

 The Library shows the entire content repository and its organization in folders. Each 

folder displays the documents that it contains or other folders and their corresponding 
documents. This folder structure is completely defined by an author. A System folder 
structure is also created during installation that contains various system-wide 
documents for assessment and question templates, publishing styles, topic text 

templates, roles, and attachment icons. 
  

 Document editors display the content of a single document in an editor. Each 

document editor appears in a new tab as you open or create documents. The 
document editor that appears depends on the type of document that you create or 
open. 

1.2.1 Open and Close the Library 

If you choose to display the Library, it opens in a Library tab in the Developer window. If the 
Library is not open, you can open it from the Start Screen when you start the Developer or 
from the View menu. You can close the Library just as you can close any document editor. If 

you have multiple document editors open at the same time, you may want to close the Library 
to eliminate some of the tab clutter. You can reopen the Library at any time. When you reopen 
the Library, it opens in the last tab position.  
 

Note: You cannot change the order of the tabs that appear in the Developer. The order is 
determined by the sequence in which you open documents in the Library. 
 

To open the Library: 

1. From the Start Screen, click the Library link. 
  

or 
  

From the Developer, select the View menu and choose  Library. 

  
2. If you have multiple tabs open, the Library command activates the Library tab. 
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To close the Library: 

1. Click the Library tab and either click  on the Library tab or choose Close from the 
File menu. 

1.2.2 Use Folders and Documents 

The Library lets you organize and manage your content using folders and documents similar to 
how Windows Explorer lets you manage and organize files on your computer. When the 
Developer is installed and a new content database is created, a System folder is automatically 
created that contains subfolders and various documents that control characteristics of the 
publishing styles, template text, roles, and attachment icons.  
 

As you build new content, you create additional folders in which to store various documents 
such as modules, sections, topics, web pages, packages, roles, glossaries, and so on. The 
folder structure you create is completely up to you; however, it is recommended that you keep 
your folder structure simple to avoid unnecessary navigation or confusion, especially if you are 

working in a multi-user environment. You may want to create a standard folder structure for 
your content before you start creating documents and avoid letting authors build complicated 

folder structures along the way. 
 
A folder can be opened to view its contents, which can be additional folders or documents. 
These objects always appear in the right pane of the Library. You can also open any document 
in a folder, thereby launching the appropriate document editor. Folders and documents in the 
Library can also be moved, copied, and deleted, although the System folder and its documents 
should not be altered. 

  
Note: One exception to altering documents and folders in the system folder is when you are 
creating custom styles. See Create Styles in the Customize Publishing Styles section of the 
Publish Content chapter of this guide for more information.  

1.2.2.1 Understand the System Folder 

The System folder is automatically created when you install the Developer. It contains a series 
of subfolders and documents that store publishing documents, templates, master role 
documents, and attachment icons. The System folder is only visible in the Library and contains 
the following subfolders: 

 Assessment Templates 
  

 Icons 
  

 Publishing 

  

 Question Templates 
  

 Roles 
  

 Style Sheets 

  

 Templates 

Warning! You should not move, delete, or rename the System folder, its subfolders, or any 
documents that are contained within them. Doing so may impair the operation of the software. 
However, you can add and remove documents to the Icons folder without causing problems. 

1.2.3 Understand the Developer Document Types 

When you build content, you create, edit, and link various documents that are stored in the 
Library folders. The Developer provides the various document types that allow you to: 
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 create an outline to facilitate content presentation and navigation 

   

 record application simulations for playback 
   

 construct conceptual and introductory content that link to outlines and recorded 

frames 
   

 develop glossary terms 

   

 define roles for document filtering 
   

 create questions and assessments to evaluate skills, competency, and learning 
   

 apply consistent formatting to web pages 

   

 customize publishing style output 

The following describes each document type: 
  

 Module: A module (purple book) is used to organize a specific unit of learning. It can 

contain other documents such as sections, topics, or even other modules to form a component 
of an outline. 
 

A module can also have conceptual content linked to it that provides a general description of 
the content that is contained within it. 
  

 Section: A section (blue book) is very similar to a module in that it also can contain other 

documents such as sections, topics, or other modules. The main difference between a section 
and module is its visual representation that can help you differentiate between the 
components of your outline and locate areas in the structure faster. 
  

A section can also have conceptual content linked to it that provides a general description of 

the content that is contained within it. 
  
Important Note about Module and Section Documents: A module or section document 
appears as a purple or blue book only when the document has at least one linked child 
document such as a topic or another module or section. However, a module or section 

document with no linked child documents appears as a page icon such as  for module and 

 for section. When you create a new module or section, it automatically appears as a page 

icon until you link at least one additional child document. It then appears with a purple or blue 
book icon.  
 

 Topic: A topic represents a series of recorded steps that complete a task in an application. 

Topics are where you record application-specific transactional content; whereas modules and 
sections provide the structural components of your outline. 
  

 Package: A package is a collection of one or more files that can be imported and attached 

to documents as additional content. For example, a package can be as simple as a document 
that contains an image file or more complex where it contains multiple files that comprise an 
entire web site. 

  

 Web Page: A web page is an HTML page that can contain text, audio, images, and 

hyperlinks to other content. It can be linked to modules and sections or frames and bubble 
text within a topic. 
  

 Question: A question tests student knowledge on a piece of content. There are seven 

types of questions including Fill in, Hot Spot, Matching, Multiple Choice (single answer) 
Multiple Choice (many answers), True/False, and User-Defined. 
  



Get Started using the Developer 

 

 14 

 Assessment: An assessment is collection of questions and topics used to test a student's 

knowledge of larger portions of content. 

  

 Glossary: A glossary is a list of specialized terms unique to your company, or terms that 
require further clarification for your users. 
  

 Role: A role generally represents the actions and activities assigned to or required or 
expected of a person or group. A role is used to filter topics in the Player. 
  

 Template: A template controls the bubble text that is automatically populated when you 
record a topic. 

  

 Publishing Project: A publishing project contains all of the files that are used in a 
publishing style. For example, the Training Guide publishing project has various Microsoft 

Word documents and XML files that control the output format of this style. You can customize 
a delivered style by copying the relevant publishing project document and editing the files to 

define your custom style. 
  

 Style Sheet: A style sheet is a collection of styles that can be used to apply formatting to 

text and objects in web pages. 
 

 Skin: A package, similar to the Player publishing project, that contains all of the 
customized settings and images for publishing a customized Player. You can select a skin 

when publishing a Player or set a default skin. Customizations made in a skin are preserved 
product upgrades. 
  

 IAS Configuration: A document, used to configure content for SmartHelp or help 

integration, which contains options that allow you to associate the configuration with specific 
content, control launch behavior, and set up rules for the context search.  

1.2.4 Work with Document Editors 

When you create or open a document for viewing or editing, it appears in its corresponding 
document editor. For example, when you create or open a module or section, the Outline 
Editor appears in a new tab. If you create or open a web page, the Web Page Editor appears, 

and so on.  
 
The following document editors are available in the Developer: 

 Outline Editor 
  

 Topic Editor 

  

 Web Page Editor 

  

 Package Editor 

  

 Glossary Editor 

  

 Role Editor 

  

 Question Editor 
   

 Assessment Editor 

   

 Style Editor 
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1.2.4.1 Outline Editor 

The Outline Editor displays a hierarchy of documents that is similar in design to a common 

table of contents. This document hierarchy appears in the left pane of the editor and is called 
an outline. The outline can consist of any number of module and/or section documents and 
their related topics and can span as many levels as you want.  
 
The content that you see in this editor is defined by the module or section document that you 
open and is typically not the entire content Library. This allows you to either explore a 
complete outline by opening what is referred to as the "root" document or focus in on a 

specific area of the outline by opening a specific module/section document depending on how 
you have designed your outline. 
 
The Outline Editor lets you create and modify an outline by linking new or existing documents, 
moving or copying existing documents, removing document links, and so on. You can also 
display conceptual and introductory content such as web pages, packages, and URLs or 

document properties such as Last Modified Date, Role, State, and so on. 

1.2.4.2 Topic Editor 

The Topic Editor is used to edit the frame content of a recorded topic. 

1.2.4.3 Web Page Editor 

The Web Page Editor allows you to create HTML pages that include formatted text, graphics, 
and sound, as well as hyperlinks to other documents, images, or web sites. The content you 
create in the editor looks similar to what the user sees after the document is published.  
  
You can use any web page that you create in the Developer and link it to a module, section, or 
topic document as conceptual or introductory material, to an assessment to provide directions 

on how to answer questions, or to any topic frame as supplemental transactional information.  
  
Note: Content created outside of the Developer must be linked as a package. 
 
The Web Page Editor provides a full range of formatting capabilities such as: 

 Text formatting including bold, italics, underline, and font selection 
  

 Paragraph alignment including left, right, centered, and justified 
  

 Tables 

  

 Bulleted and numbered lists 
   

 Graphics support 
  

 Hyperlinks to other documents, web pages, web sites 

  

 Sound recording and editing 

When editing an HTML page stored inside a package, additional capabilities are available, such 
as:   

 Fields 

  

 Buttons and checkboxes 
   

 View the source HTML 

You can use the Outline and Topic Editors to link a web page to documents in the outline or 
individual frames in a topic. 
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1.2.4.4 Package Editor 

The Package Editor lets you import one or more files (such as a web site, image, Microsoft 

Word document, PowerPoint presentation, and so on) into a package in the content Library. 
You can then use any package that you create to attach a file to a module, section, or topic 
document as conceptual or introductory material, or to any topic frame as transactional 
information.  

 
The Package Editor lets you manage a package that you create by: 

 Adding or removing files/folders in a package 
  

 Navigating folders in a package 

  

 Renaming files in a package 

You can use the Outline and Topic Editors to link a file in a package to documents in the 

outline or frames within a topic. 

1.2.4.5 Role Editor 

The Role Editor is where you define a list of roles that can be used to filter topics in the Player. 

1.2.4.6 Glossary Editor 

The Glossary Editor allows you to create a list of terms and links to other documents such as 

web pages that contain their definitions. 

1.2.4.7 Assessment Editor 

The Assessment Editor allows you to design and edit assessments. The toolbar contains icons 
for linking new questions and existing questions, deleting question links and changing question 
order. 

1.2.4.8 Question Editor 

The Question Editor allows you to design questions that test student knowledge. You can 

create six types of standard questions or develop user-defined questions in other software 
applications and link them into the Developer.  
 

Questions can exist as standalone documents in an outline or grouped together in an 
assessment. Questions can also be created in a Library so they can be reused.  

1.2.4.9 Style Editor 

The Style Editor contains the tools to create new styles or edit existing ones in style sheets. 
Styles are instructions for formatting text, paragraphs, lists, tables, and images in web pages. 

The use of styles promotes consistency of appearance and contributes to producing accessible 
content by applying HTML elements that help assistive-technology products interpret content. 

1.2.4.10 Document in Use Message 

As you open and edit documents in the various document editors, you should note the 
following document editing concurrency rules:  

 If a document is open in one document editor, it cannot be modified in any other 
document editor or the Library or deleted. For example, if you have a web page open 
in the Web Page editor, you cannot rename or delete that web page from the Library. 
Or, if you edit a module in one Outline Editor tab but that same module is open in 
another Outline Editor tab, you can edit the module only in the first Outline Editor tab 
in which you initiated editing. A "Document in Use" message is displayed in any such 

document editing concurrency scenario. 
  

 Editors other than the Outline Editor (such as Web Page, Package, and Topic Editors) 
lock the document as soon as it is opened. Once a document is locked it cannot be 

changed until you close the editor. 
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The Outline Editor is different from the rest of editors in that it edits multiple 
module/section documents. Note that, from this perspective, the root outline 

document is co-equal with the other module/section documents in the outline. Since a 
section can be part of multiple outlines, the same section can be present in multiple 

Outline Editors simultaneously. 
  

 The Outline Editor does not lock the module/section documents in the outline when 
they are displayed or expanded. It locks them before it executes the first operation 

that modifies them (add or remove links to it, rename it or do anything that actually 
changes the document). If you create a section in an Outline Editor, the new 
document is created but it is not locked, but as soon as you insert something into the 
new section, it is locked. If you unlink the new section from the module, the document 
still remains locked because you can undo the unlinking and then undo the changes 
you made to the document. 

1.2.5 Link Related Documents 

As you create documents, you can also link them together to form a basic content outline. For 

example, you might start with a module document and link several sections to it. Then, for 
each section, you can link one or more topics that demonstrate how to perform a series of 

specific tasks or transactions in an application. This is just one example of how you could link 
and structure content, but you have the flexibility to design it in many ways to meet your 
needs. For example, you could also start with a section document and link topics or other 
module documents to it. 
 
As you build an outline for your content, you may also want to supplement it with conceptual 
information in the form of web page or package links. For example, any module/section or 

topic can have a link that appears as conceptual or introductory information for the document. 
This link can be a specific page of a web site on the Internet, a custom web page that you 
create within the Developer, a Microsoft PowerPoint presentation, Microsoft Word document, 
Flash movie, and so on. Your users can view this content from the Player once you publish the 
content. These are just two examples of how you can build content by creating and linking 
documents. 

 
At any time you can review the links that a document contains by displaying the Related 
Documents toolpane or by adding the Link count or Links to property columns to the Library. 
 

Related Document Definition by Operation 

As you begin to work with the Developer, notice that there are many document functions that 

consider the inclusion of related documents such as delete and export (as well as check in/out 
and restore in a multi-user environment). Based on the function that you perform, different 
related documents are considered. For example, when you delete a module, you can also 
request to delete its related sections and topics. However, the module is also linked to a 
template and deleting a template does not make sense since a template is usually linked to 
many different documents in the Library. Therefore, when you delete a document and choose 
to include related documents, linked templates are not considered. 

 
When you perform an operation that can impact related documents, you see a prompt asking 

whether you want to include the related documents as well as a View related documents 
hyperlink to display a list of related documents. 
 
Note: Regardless of whether a document is included as a related document, it can always be 

explicitly selected, thus ensuring that it is included in the operation. 

1.2.6 Reuse Documents 

As you begin to build your content Library, you may find a need to reuse documents in 
multiple outlines. Any document that you create can be reused across multiple outlines. 
However, please note that any changes you make to the document are reflected in all 
instances where they appear. For example, if you reuse a section document that has several 
topics across many modules, any changes you make to the section are reflected in each 
module that includes the section. Changes could be as simple as a rename of the section or 
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include additional topic links. If you do not want changes to impact other areas of reuse, then 

you should copy the document and use the various Paste or Paste Special options to create 

additional documents. 

1.2.7 Document Properties 

Documents have specific properties that provide additional information about the document. 
There are two types of properties: calculated properties that are automatically set and 
changed by the Developer and editable document properties that can be manually set and 
changed by an author.  

 
Calculated properties provide useful information about documents. For example, every 
document has a unique ID, document type, creation date, and link statistics showing the 
number of links to and from the document. These properties appear when you are working in 
the Details View from the Library or the Outline Editor. 
 
Documents such as modules, sections, topics, web pages, packages, questions, and 

assessments also have editable properties that impact functional aspects of the document. For 

example, properties for a topic include glossary, language, screen resolution, template, 
application, play modes, Know It? options, documentation fields, and so on. The properties 
you set are saved with the history of the document and travel with it on operations such as 
export and import. These properties appear on the Properties toolpane. 
 

 Multi-user Considerations 

 In a multi-user environment, additional document properties appear that display the 
name of the author who has checked out the document for editing and their computer 
name. 

1.2.8 Undo/Redo Actions 

As you work with documents in the various document editors, you may find it necessary to 

undo or redo the editing actions that you perform. Most document editors provide an Undo 

and Redo command on the Edit menu for just this purpose. For example, in the Outline Editor 
you can undo the linking of any document in the outline, undo the deletion of links, and so on. 
If you are working on a web page, you can undo the addition or editing of text, as well as any 
formatting commands that you perform. You can also redo actions in the same way. There is 
no limit to the number of actions you can undo/redo in most document editors. 
 

Important Note: Undo/Redo is not available from the Library or the Package Editor. Also 
note that you cannot undo glossary term links that are created using the Update Glossary 
Links command. 
  

 Multi-user Considerations 

 If you perform any action that requires a parent document check out such as Link New 
Topic (from the Outline Editor), when you undo this action, the parent document check 

out is not undone. 
  

Any action that involves document versioning/history cannot be undone. These actions 
include check in, check out, delete, restore, and rollback. 

To undo/redo an action: 

1. Perform an action that can be undone. 
  

2. On the Edit menu, choose  Undo or  Redo depending on the action that you 

want to perform. Some editors such as the Outline Editor display the name of the 
action that can be undone; for example, Undo Document Rename. 
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1.3 Set Developer Defaults 
The Developer provides a set of default settings that affect the appearance of the content that 

you create, as well as other settings for content preview, player and recorder behavior, spell 
check, and so on. Before you begin to create content, you should, at a minimum, review the 

settings in the Content Defaults category since these settings impact the appearance of any 
newly created content.  
 
The Options dialog box (from the Tools menu) displays the categories that you can use to 
configure default settings for the Developer, Player, and the content that you create. 
 

When you click on a category, the options appear in the frame on the right. Some categories 
such as Content Defaults have subcategories that list additional options. Click Apply when you 
want to save your settings for a category and then move to another category. 
 

Restore Defaults 

You can reset any option to the original defaults by clicking the Restore Defaults button at the 

bottom of the options frame. This only resets the options for the category you are viewing and 

does not change the settings for any other category. To reset the defaults for another 
category, you must display the options frame for that category and then click the Restore 
Defaults button. 

1.3.1 General Developer Settings 

Use this page to configure the following general Developer default settings:   

 Image Editor: Use this option to specify the program used to edit topic frame 

screenshots. The image editor that you configure here is launched when you use the 
Edit Screenshot command from editable frames in the Topic Editor. You can enter the 

full path of your image editor, or you can use the Browse button to select the 
executable file. 
   

 Package HTML Editor: Use this option to specify the editor used to edit HTML files 

in a package. By default, the Developer's built in HTML editor is used but you can also 
set this option to use your system's default HTML editor or you can set another HTML 

editor of your choice. 
   

 Do Not Ask Again: There are several dialog boxes in the Developer that display a 

Do Not Ask Me Again option that allows you to suppress their display. Use this option 
to reset all dialog boxes that provide this option to the original installation defaults. 
   

 Additional Help Links: Use this option to add additional links on the Help menu. 

For example, you could add a link to an online documentation library. Enter the name 
of the link in the Name field. This is what displays on the Help menu just above the 
About link. Enter the URL of the link in the URL field. Keyboard shortcuts are assigned 
automatically based on availability. 
 

Note: These additional help links are not included as part of the Content Defaults 

upon export but are preserved during upgrades to subsequent service packs and 
releases. 

1.3.2 Library Settings 

Use this page to configure the following default settings for the Library:  

 Automatically save changes every: Allows you to set the time interval that the 
Developer uses to automatically back up open documents. If the Developer 
unexpectedly terminates while you are editing a document, you can recover the last 
backed up copy of the document. See the content later in this topic for details. When 
you restart the Developer, the Recovered Documents dialog box lists any documents 

that have been recovered. You have the option to discard the recovered documents 
(reverting back to the last explicitly saved version) or open all recovered documents in 
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their appropriate editors. When you open a recovered document, the word 

"(Recovered)" is appended to the name of the document in the editor tab as a visual 

indicator that the document is recovered. The "Recovered" indicator is not actually 
part of the document name and is removed when you save or close the document.  
  
Do not use AutoRecover as a substitute for regularly saving your work by clicking 
Save.  

  
Note: The Developer does not autosave package documents. 
  
An action is required to resolve any recovery situation. These situations, actions and 
the resulting behaviors are described below: 
  
Document was previously saved and an autorecover copy exists that the author wants 

to save. 
  
Save: The autorecover copy becomes the current version and the older autosave 

version is discarded. 
  
Document was never saved but the author wants to save the autosave copy. 
  

Save: The author is prompted to provide a document name and save the document. 
The saved document becomes the latest version and the autosave is cleared. If the 
Developer unexpectedly terminates before an autosave was created, the document is 
lost because there is no copy to revert back to. 
  
Author chooses to save an autosave copy by another name. 

  
Save As: A copy of the autosave document is saved as the user supplied name and 
the autosave copy is discarded. Since it is a copy of the original, documents linked to 
the newly saved document (for example, the Section linked to the Topic), must be 
linked again. 
  

Author chooses to discard an autosave document 

  
Close: If the document is closed without being saved, it reverts back to the last 
explicitly saved version and the autosave is cleared. 
  

 Multi-user Considerations  

 
When the author chooses to save an autorecover document, the Developer checks out 
the document if necessary and replaces that version with the autorecover version. The 
author can then check in the new version. 
   

 Scan for Lost Documents: This option scans for problems in the local copy of the 

Library and tries to recover any documents that are not part of the Library. You should 
not have to run this scan unless you are experiencing problems with documents in the 
Library. Contact technical support for more information on recovering lost documents. 

   

  Multi-user Option: MB: This option controls the amount of disk space that is 
allocated to cache library documentation on your computer. 
  

  Multi-user Option: Clear Now: Use this to remove checked in documents from 
your local cache and restore used disk space. This button only removes documents 

that exceed the Available Disk Space setting. 
  

  Multi-user Option: Connection Speed: This option is used to tune the 

software's performance based on the available bandwidth. At the high setting, the 
Developer waits less time before assuming the connection to the server has timed out. 
If you experience the Developer going offline unexpectedly or timing out on server 
operations, consider using the lower setting. 
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1.3.3 Content Defaults 

This category allows you to configure the default properties for newly created documents. 

These properties control how your content appears when published. Content Defaults serve as 
the basis of a common style guide among the authors and can be shared between authors 
using the import and export content default options feature.  

 
Tip: It is recommended that you set the content defaults before you add documents and 
record content. When the content defaults are changed, existing documents are not affected 
and continue to use the defaults that were in effect when those documents were created. 

1.3.3.1 General Defaults 

Use this page to configure content settings. You can override these defaults when you add 
each of the documents or by editing the document properties. 

 Language: This setting controls the language assigned to a document. 
   

 Template: Sets the default template language for module, section, and topic 

documents. 
   

 Screen Resolution: Sets the default screen resolution for module, section, and topic 

documents. Pick from a list of common resolutions or enter a custom resolution 
values. 
   

 Base URL for Previewing Relative Hyperlinks: This setting is used by the 

Developer to find content links using Relative URL's. Set this URL to the deployment 
location's absolute URL. The Developer appends any relative URL's to the base URL to 
find the relative linked content for preview. 
   

 Browse: Use this to browse to the location to set as the base URL. 

1.3.3.2 Topic Defaults 

These options control the default play modes for Player, LMS and Sound when a topic is 
created.  

 Player: All play modes are active when a topic is launched from the Player, 
   

 LMS: See It!, Try It! and Know It? are active for LMS. This determines which modes 

are active when a topic is launched from the Player in an LMS. 
   

 Sound: See It! and Try It! are active for Sound. This determines which modes play 

sound. For example, if See It! mode is turned off, no sound plays in See It! mode.  
   

 Frame Delay: The frame delay controls the amount of time that elapses between the 

appearance of the frame and the start of the action. The delay gives the user time to 
read the text in the bubble before the action starts. You can either select from the 
Frame Delay list or manually enter a delay time. If you choose the 0 or skip option, 

action frames immediately start playback of the action and non-action frames are 
skipped. 
   

The Infinite option means a user must advance the frame manually. The bubble 
displays the text "Press Enter to continue." The user must press ENTER to advance to 
the next step. 
  
If sound is present and Infinite is selected, the user must press Enter to continue. If 
sound is present and any other frame delay is selected, the frame advances 
automatically after the sound playback is complete. 

   

 Required Percentage: Know It? mode is a play mode that enables users to test 
knowledge gained from training. When a topic is played in this mode, the user is 
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expected to complete a task with little or no assistance in a simulated environment. 

Upon completion of the task, the user receives a score. This option is the percentage 

of all the steps within the task the user must answer correctly to pass. You can also 
change this percentage for an individual topic using the Properties toolpane. 
   

 Remediation Options: When users fail to complete a step in Know It? mode, they 

can see up to four levels of remediation. By default, all four remediation options are 
active for any new topic that you create. You can configure the default settings for the 
first three levels, but the fourth level is always required. See Remediation Levels in 
Topic Properties for a definition of each level. These settings do not affect converted 
content. For example, if you make remediation level configuration changes first and 

then convert content, the converted content has all four levels active (default 
settings). 

1.3.3.3 Recorder Content Defaults 

Use this page to configure the following defaults for when content is recorded:  

 Automatically record keyboard shortcuts: While you are recording content, the 
Developer can automatically capture keyboard shortcuts for menu items in standard 
Windows menus. The Developer determines the shortcut using underlined letters in 

the menu name. When you record keyboard shortcuts, it is the same as recording an 
Alternative Action. In the Player, the keyboard shortcut appears as the Alternative 
Action for the current step in Try It! mode. In the Player, users are marked correct if 
they use the keyboard shortcut for a step in Know It? mode. Deselect this option if you 
do not want to capture the shortcuts in recorded content. 
  

 Enable automatic recording: If enabled, the Developer can create "incremental" 

screenshots automatically as you drag the mouse. This process is called automatic 
drag and drop recording. If you do not want the Developer to automatically capture 
the "incremental" screenshots, deselect this option. When automatic drag and drop 
recording is disabled, you need to press PRINTSCREEN (or the designated screen 

capture key) to capture the "incremental" screenshots as you drag. 

  

 Distance between screenshots in pixels: The Distance between screenshots option 
allows you to specify how far the mouse must move before another screenshot is 

captured. 
  

 Action area size in pixels: The Action area size option allows you to control the size 
of the action area for each frame captured during the drag action. The area size is also 

the default size used for an action area that the Recorder recognizes as a Universal 
Object, Workspace, Window, or Active X object. 

1.3.3.4 Bubble Defaults 

This option allows you to configure default settings that control the visual display for bubbles 
that appear in all frames OTHER than the Introduction and End frames. 
 

These defaults are in effect when you create and record new topics; however, you can 
override any of these bubble attributes when you edit a topic in the Topic Editor. 
 

Note: You can control the default settings for the Introduction/End Frame bubbles using the 
Introduction/End Frame option. 
 

Use the following options to configure the visual attributes of the bubbles. The sample bubble 
that appears in the center of the pane reflects the current default settings and automatically 
changes as you edit the settings. 

 Bubble icon: Choose an icon that appears inside of the bubble. 
   

 Pointer position: Choose from the various pointer positions for the bubble. 
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 Font: Choose the font, font style and size for the bubble text. If you are using an 

expanded font, such as Arial or Times New Roman, you can choose from an extended 

list of language characters, including Greek and Russian (Cyrillic), if available in the 
Script field. 
   

 Background color: Choose the bubble background color. See Web Page Defaults for 

more information about selecting colors. 
    

 Use Template Text: The Developer uses template text to automatically generate 
bubble text as you record an application. The template text varies depending on the 

keystroke or mouse action you performed during each step. If you deselect the Use 
template text option, the templates are disabled, and the bubbles are empty after 
recording. 
  

 If you decide to use templates, you can also add your own (custom) text to the 

bubble. By default, this text appears before the text that is populated by the template. 
The Show template text first option allows you to switch the order and have custom 
text appear after template text. 

1.3.3.5 Introduction/End Frame Bubble Defaults 

This option allows you to configure default background color and text font settings that control 
the visual display for the bubble that appears in the Introduction and End frame only. These 

settings also affect the appearance of the Introduction pane in the Developer and the Player.  
 
Tip: If you want to control the background color and text font that appears for content 
displayed in the Concept pane, you should create and link a web page as the concept. In this 
way, you can also create a consistent appearance for content that appears in both panes. 
 
These defaults are in effect when you create and record new topics; however, you can 

override any of these bubble attributes when you edit a topic in the Topic Editor. 
 
Note: You can control the default settings for other bubbles using the Bubble option. 

1.3.3.6 String Input Defaults 

As you record content, one of the action types you record is a string input. This action occurs 

when you are typing text in a document or in a field in a dialog box. When a user plays the 
topic in Try It! mode, the user must enter the specified text to move to the next step.  
 
You can change the look of these string inputs using the Font and Background color options to 
better simulate the application in which you are recording. 

1.3.3.7 Glossary Defaults 

Glossary terms can appear in bubble text, Introduction/End frame bubble text, and web page 
text.  

 Create glossary links for: When a glossary term appears multiple times in one 
location, only the first occurrence is hyperlinked after you perform the Update 

Glossary Links command. You can, however, select the Every Occurrence of the Term 

option to have a glossary term hyperlinked whenever it appears in custom bubble text, 
Introduction/End frames, or web pages, regardless of the number of times the term 
appears. 

1.3.3.8 Web Page Defaults 

You can preset the formatting used in web pages using style sheets or content defaults. 
Content defaults provide a limited set of formatting controls which only affect newly created 
web pages. Style sheets provide additional options to preset the formatting for text, 

paragraph, list, table, heading, and graphic elements in a web page. Style sheets affect all 
web pages to which the style sheet is linked. Regardless of whether web page formatting is 
controlled by content defaults or a style sheet, you can manually format content as you edit a 
web page using the Web Page Editor.  
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 Style Sheet: Use this option to select an existing style sheet as the default style 

sheet for all new documents. This option may be preset for the Standard style sheet, 

but you can select another style sheet as your default. The default location for style 
sheets is the Style Sheets folder in the System folder, but style sheets can be stored 
in any folder. By assigning a default style sheet, new web pages automatically inherit 
the assignment. Content Default settings are ignored for new web pages when you set 

a default style sheet. 
  
The Restore Defaults button is disabled if the Style Sheet is the default Web Page 
option. 
  
Note: The Style Sheet assignment is included when you export content defaults. 
Distributing the exported defaults (.ops file) to all authors ensures that everyone is 

using the same default style sheet. See Export/Import Tools Options Defaults in this 
chapter for more information about sharing default settings. 
   

 Content Defaults: Use this setting to preset basic formatting options for new web 

pages. 

 Font Family: The default font family applied to text in a web page. The Font Family 

can be selected from a list of predefined  font stacks or the system fonts installed on 
the machine. The default setting is Arial. 
   

 Font size: The default font size and unit applied to text in a web page. You can enter 

a numeric value or select a predefined size. The default setting is 10. The default font 
unit is points. 
   

 Text Color: The default color of text in a web page. The default setting is black 

(#FF000000). 
   

 Page Color: The background color for web pages. The default setting is white 

(#FFFFFFFF). 

   

 Select a Color: The same Color dialog box appears for all color settings in the 

Developer; text color, text background color, web page background color, cell 
background and border colors, bubble background color, string input background 

color, and Player and Presentation marquee colors. A No Color option for removing an 
applied color is also available in the Color dialog box for some web page and style 
sheet color options. 
  
You can select a color from either the Basic Colors or the Web Colors palette. Web 
colors have an unambiguous color metric that render similarly for most monitors, and 
are therefore considered safe colors. The Web Colors palette is based on the Microsoft 

Windows default 16-color palette, but safe colors are not limited to these 16 colors. 
   
The More Colors option provides the tools to mix your own custom color or enter the 
RBG (red, blue, green) values for a known color. Mixing a new color is done by using a 

combination of the vertical slider to select a color and the large palette to select a 
variant. As you mix colors, you can preview the results and view the hexadecimal 
value of your custom color. You may want to note the hexadecimal value of a custom 

color if you plan to customize the Player with a matching color. 
   
Custom colors created with the More Colors option appear on the Recent Colors palette 
for easy reuse. This palette only appears after you create the first custom color. When 
the Recent Colors palette is full, older colors drop off as new ones are added. 
   

Note: When you point to a color in the Basic Colors, Web Colors, or Recent Colors 
palette, a tooltip displays the color's hexadecimal value. 



  Get Started using the Developer 

   25 

1.3.3.9 Assessment Defaults 

Use these options to set the defaults to be used for new Assessments.  

 Passing score percentage: Set the minimum percentage of questions a user must 
get correct to demonstrate understanding of the subject matter to pass the 
assessment. 
  

 Question order: If the option is set to As authored, questions are presented in the 

order in which they were created in Developer. If set to Random order, the questions 
are presented in a different order each time the assessment is taken. 
  

 Answer order: If the option is set to As authored, answers are presented in the order 

in which they were created in Developer. If set to Random order, answers to multiple 
choice or matching questions are provided in random order. The answers appear in a 
different order each time the question is presented. For multiple choice (single 
answer) questions that include All of the Above and/or None of the Above, these 
answers remain in their positions at the bottom of the list of choices. 

  

 Remediation: Determines the type of feedback users receive on their responses to 
questions. 
  
The following describes the five types of feedback. Remediation text appears only if it 

was created for the question in Developer. 
  
Always: The feedback window always displays the correct answer and remediation 
text. 
  
Incorrect: If the user's response is incorrect, the feedback window displays the 
correct answer and remediation text. If the user's response is correct, the word 

“Correct” appears in the feedback window. 
  
User Asks: The feedback window displays the word “Correct” or “Incorrect,” along 

with a Show Answer link. When this link is clicked, the correct answer and/or any 
remediation text appears in the feedback window. 
  

Results Only: The feedback window only displays the word “Correct” or “Incorrect.” 
  
None: No feedback provided. 
  

 Show associated content: The Associated Content link displays if this property is 

set, the content is selected on the Associated Content property for the question, and 
the Show Associated Content property is set to Yes on the assessment. Associated 
content can be used to create personalized content (available only in the Professional 
edition). 
  

 Display results summary after completing the assessment: When the Show 

Summary at the End of Assessment option is enabled, users see an Assessment 

Summary page after they have completed an assessment. This page displays the 
assessment results, which include the number of questions in the assessment and of 
those, the number correct, along with the user's score as a percentage. This page also 

displays a breakdown of each major section and the user's score for each. It also 
displays a list of the questions answered correctly and incorrectly. 
  
If the Do Not Show Summary at End of Assessment option is enabled, the Assessment 
Summary page does not appear upon completion of an assessment, nor can a user 
access it later. 
  

When the assessment is used to create personalized content from the Knowledge 
Center, this setting is ignored and the summary is always displayed. The Summary 
option is automatically enabled and cannot be deselected as the Assessment Summary 
page enables a user to configure his/her personalized content. When the personalized 
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content is enabled, checkboxes appear to the left of each section listed, allowing a 
user to choose which sections appear in the personalized content. 

1.3.4 Document Defaults 

You can configure options for each document output that are in effect whenever you preview 

documents from the Developer. These options are also used as the defaults when you publish 
documents for the first time; however, you can also override these options from the Publishing 
Wizard.  
 
From the Outline Editor only, you can publish or preview the following documents for any 
topic: 

 System Process 

  

 Job Aid 
  

 Training Guide 
  

 Instructor Manual 

  

 Test Document 
  

 Test Results 
  

 Test Case (publish only) 

  

 Presentation 

1.3.4.1 Options for Document Outputs 

The following lists show the available Document Output options and the applicable Document 

formats to which they apply. 

 Output format: Published output can be in Microsoft Word, Adobe Acrobat PDF 
format or HTML Web Page. 
  
If you choose Adobe PDF format, the document is published to Word first and then 
converted to PDF. If you choose HTML Web Page format, the document is published to 

Word and then saved as a web page using the Web Page, Filtered option in Word. This 
creates a single HTML file, but all of the graphics are separate, linked files. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results 
   

 Include screenshots: Screenshots are included in a document based on the settings 
for the topic in the Topic Editor. This option allows you to override those settings and 

choose to include one screenshot per topic, one screenshot for each frame, or no 
screenshots. 
  

Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results 
  

 Convert screenshots to 256 colors: Reduces the number of colors used in the 

screenshots, which therefore reduces the size of the published topics and improves the 
playback speed. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Presentation 
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 Paper size: The paper size is set based on the Location setting in the Regional & 

Language options for your operating system locale. You can override this setting by 

choosing a different paper size. If you customize the print template to have a special 
paper size (for example, to print Job Aids on smaller cards), choose the option to use 
the print template setting; otherwise, it gets overridden during publishing. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results 

   

 Text mode: Each document output uses the text from a specific mode. Use this 
option to specify the mode text to use. 
  

Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Test Case, Presentation 
   

 Web page format: Specify the formatting source for published web pages. Select 

Developer Settings to use the styles and direct formatting applied to the Developer 

web pages or Word Template settings to use the formatting specified in the print 
template. 
  
Applicable formats: System Process, Training Guide, Instructor Manual 
   

 Use encoded folder and file names: Publishes the content using the document 

GUID instead of actual module, section, and topic names. Encoding shortens path 
names and prevents the possibility of duplicate file name in the published output. This 
option makes it more difficult to identify the source based on the file name. 
  

Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Test Case, Presentation 
   

 Include alternatives: Alternative Actions and Paths appear in document and 

Presentation outputs. Disable this option to make the output simpler, with only one set 
of steps. 

  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Test Case, Presentation 
   

 Include images from packages: Images appear if they are attached to a frame or 

to the concept pane. 
  
Applicable formats: System Process, Training Guide, Instructor Manual 
   

 Include images in web pages: Images appear if they are attached to a frame or to 
the concept pane. 
  
Applicable formats: System Process, Training Guide, Instructor Manual 

   

 Include relative links: Disable this option to exclude relative links from printed 

output. 
   

Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Presentation 
   

 Include assessments: Disabling this option excludes assessments. 
   

Applicable formats: Training Guide, Instructor Manual 
   

 Include questions: Questions in the content are included in a Training Guide or 
Instructor Manual. In addition, answers are included in the Instructor Manual. 

Disabling this option excludes questions. 
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Applicable formats: Training Guide, Instructor Manual 

   

 Group actions by context ID: Each action appears in a separate row in the Test 
Procedure table. When you select this option, the actions with the same context ID are 
grouped together into one test step. 

   
Applicable formats: Test Case 
   

 Format: Use to select the Test Case output format. Options include Oracle Application 

Testing Suite (default), IBM Rational Quality Manager, HP Quality Center, or Other 
(which contains all available data in the report). Other can be used to get the data into 
a spreadsheet such as Excel. 
   
Applicable formats: Test Case 
   

 Include action areas: In the Player outputs, a marquee - or highlight - appears 

around the action area for each frame. You can choose to include this marquee. You 

can also change the color of the marquee using the icon next to the Color option. This 
setting does not affect the marquee color for the Player outputs. 
   
Applicable formats: Presentation 

1.3.4.2 System Process Document 

This format is useful for creating documents that not only include the procedures and 
conceptual information for system processes, but also contain information relating to intended 
audience, roles and responsibilities, document status, versions, and dates. Each topic is 
published to a separate document which includes a concept page, with information about the 
document and task, and the procedures for completing the task. 

1.3.4.3 Job Aid 

This format results in a quick reference guide, enabling users to view only the procedures for 
completing a task, without conceptual information. Each topic is published in a separate 

document which includes only the procedures for completing the task. 

1.3.4.4 Training Guide 

This format allows instructors to create guides quickly for Instructor-led training. The 
document includes a title page, copyright information, table of contents, conceptual 
information, and procedures for completing all tasks included in the published outline.  
  
Questions and/or assessments in the content are included in the Training Guide when the 

Include Questions and/or Include Assessments options are set. Note that answers to questions 
do not appear in the Training Guide but do appear in the Instructor Manual.  
  
In addition, if the content you publish contains glossary markups, then a glossary is included 
at the end of the document.  
 

Warning! Be aware that when you publish a Training Guide, your entire selection is published 

as one document. If you publish a large amount of content at one time, you may encounter 
memory problems with Microsoft Word. Consider publishing your content in smaller chunks 
and then merge the contents of each Microsoft Word file after publishing from the Developer. 

1.3.4.5 Instructor Manual 

This format allows instructors to publish the Training Guide with instructor notes. There are 
two types of instructor notes; topic notes and frame notes. 
  
Instructor topic notes are inserted in the document per topic, after the Concept, and before 
the Procedure. An Instructor Note heading appears in the output in the same style as 
Procedure text. The instructor notes are formatted like web page attachments (indented 1/2 
inch from the margin in a box with a rule and shading). This is designed to make the notes 

stand out from the other text. The outside margin is adjusted to 2.5 inches. This format allows 
instructors room to write their own notes.  
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Instructor frame notes are inserted per frame and appear as italic text in the Action column in 

the Step/Action table, before the frame text. See Use the Frame Comments Toolpane in the 
Use the Topic Editor chapter for more information about entering frame instructor notes. 
  

Questions and/or assessments as well answers to the questions are included in the Instructor 
Manual when the Include Questions and/or Include Assessments options are set.  
 
Warning! Be aware that when you publish an Instructor Manual, the entire selection is 
published as one document. If you publish an entire outline, the document could be very 
large, and you might experience problems with Microsoft Word. 

1.3.4.6 Test Document 

This format allows you to create documents for testing software applications. Each topic is 
published to a separate document. The document includes the purpose of the test, test 
history, time to test, test setup, test procedure, and an additional validation area. The test 
procedure contains the steps for completing the task. 

1.3.4.7 Test Results 

This format allows you to create Word documents with steps and comments recorded during 
product testing using Record It!. Each topic is published to a separate document. The 
document includes the topic name, the status, the owner, the steps to complete the task, and 
any author notes. 

1.3.4.8 Test Case 

This format allows you to create files that can be imported into testing software applications 
such as Oracle Application Testing Suite (OATS), HP Quality Center, or IBM Rational Quality 
Manager. If you select multiple items in the outline, the published output is combined into a 
single file with each topic separated by a blank row. This file can then be imported into the 

testing software in a single operation. 
 
Only topics with content are included in the output; empty topics do not appear. In addition, 
modules and sections are not included in the output. The output is an Excel Workbook file. Be 

sure to choose the correct version to import into your testing suite application. 
  
Note: To export output from Microsoft Excel into HP Quality Center, you need the HP Quality 

Center Microsoft Add-in installed. See the HP Quality Center documentation for more 
information.  
 
Alternative paths and actions are not included in this format by default, but you can change 
the publishing option to include them. Decision frames are automatically included and cannot 
be suppressed. You can edit the output in Microsoft Excel to remove any unwanted Decision 
frame material. Explanation frames are not included. 

 
If context ID information is available for a frame, it is included at the end of the Action cell. 
The type of information differs or may not appear, depending on the target application of the 
topic. 
 

When you publish the Test Case format, you can choose from four formats: Oracle Application 

Testing Suite, HP Quality Center, IBM Rational Quality Manager, and Other. Each Test Case 
output format has a template that contains the appropriate columns. This template is called 
ColumnSpec.xml, and it can be customized to meet your output needs. The templates are 
stored in the Library under Publishing\Styles. There is a separate .xml file in each language 
folder. See Customize the Test Case Output in the Publish Content chapter for more 
information. 

1.3.4.9 Presentation 

You can configure options for the Presentation output that are in effect whenever you preview 
a Presentation from the Developer. These options are also used as the defaults when you 
publish a Presentation package for the first time; however, you can also override these options 
from the Publishing Wizard. 
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1.3.5 In-Application Support Defaults 

You can enable the use of SmartHelp using these options. 

 SmartHelp enabled: This option is enables the use of SmartHelp. SmartHelp is 
enabled by default so uncheck this option if you do not want to use this feature. 
   

 SmartHelp Installation URL: This option contains the path to the SmartHelp files. If 

a user does not have SmartHelp installed, they are prompted to install the files from 
this location. 

1.3.6 Player Defaults 

You can configure the following Player options that are in effect whenever you preview the 
Player modes from the Developer. This allows you to preview topics directly from the 
Developer in a Player environment that emulates what your users experience when they play 
your content from their Player environment. These options are also used as the defaults when 
you publish a Player package for the first time; however, you can also override these options 

from the Publishing Wizard. 

 Convert screenshots to 256 colors: Reduces the number of colors used in the 
screenshots, which therefore reduces the size of the published topics and improves the 
playback speed. 
  

 Include HTML Web Site: You can choose to include the HTML Web Site format when 

you publish to the Player. The HTML format is contained in a folder called html within 
the PlayerPackage folder. If this folder is present, the HTML Web Site format launches 
if a user has a browser that is not supported by the Player. 
  
If you decide to include the HTML Web Site, you can include or omit the detailed action 
steps. Deselecting the Include Details Actions Steps in HTML Web Site option omits the 

Step # links that launch the graphic and details for each step in the HTML Web Site. 
Note that deselecting this option also omits links to Alternative Actions, Alternative 

Paths, and Decision Frames, as those links appear on the details page. 
  

 Create zip file from published Player package: You can create a zip file of the 

Player package in the published content folder. The zip file is created at the same level 
as the PlayerPackage folder. This option is helpful if you want to import the content 
into an LMS. 
  

 Create Test It! mode Player: This option adds Test It! mode to the Player. Test It! 

mode is used to guide a tester through a test case and record the steps that are used 
to create a Test Document used in bug reporting. When Test It! mode is included, all 
topics are published, no matter what other modes are enabled. 
   

 Include Sound: This option allows you to publish with sound using 96 kbps AAC 

format. By default, sound is not set for publishing. 
   

Note: Sound is published using the .flv: High setting when using the Windows 2008 
SP2 operating system. 

   

 Skin: This option allows you to select a customized Player skin that displays the Player 
customized to your organizations look and feel. 
  

 Format for Print It! mode: If you enable Print It! mode for topics using the Play 
Modes property, you can use this option to determine which document style is 
included when you publish formats that support Print It! mode. Choose "none" if you 
do not want to publish Print It! mode (even when this mode has been enabled for 

topics). By default, Job Aid, System Process and Test Document are the only options 
for Print It! mode. However, the Training Guide and Instructor Guide can appear as 
choices by editing the Style.xml file for the appropriate publishing project document. If 
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you want a publishing style to appear as a choice, modify the PrintItStyle Setting of 
the Style.xml file to have a value of 1. 

   

 Marquee color: Set the color for the action area (or highlight) that appears in See 

It!, Try It! and Do It! modes. 
  

 Play audio: You can set how audio plays on the Player. The All available sound option 

(default) plays any available sound files during playback. The Keyboard and mouse 
clicks option plays only keyboard and mouse clicks sounds during playback in See It! 
mode. These sounds are 96kbps AAC files, delivered in the Audio folder of published 
content, that play automatically when keyboard and mouse clicks occur in See It! 
mode playback. The None option disables sound during playback. The user must have 

Flash 9.0 or greater installed to play sound in the Player. 
 
Note: Sound is published using the .flv: High setting when using the Windows 2008 
SP2 operating system. 
  

 See It! playback size: This option controls the default size of the See It! playback 

window. Select from one of the predefined screen sizes or type in the desired screen 
size. Default screen sizes include 800 x 600, 1024 x 768 (default), 1280 x 800, 1366 x 
768, Half Screen (50% of user's screen resolution), Full Screen (as large as possible). 
  
Note: The default size only applies until the window is resized. Once the window is 

resized, the new sized is used on the next launch of See It! mode. 
  

 Default play mode: This option controls the default mode launched when double 
clicking on a topic in the outline. 

  

 Applicable outline display: This option allows you to select how applicable content 
displays by default when the Player is launched with context sensitivity. If you select 
Applicable Outline, a filtered outline appears along with the Applicable option, to allow 

users to switch between the full outline and the filtered outline. If you select Applicable 
List, a flat list of applicable topics appears along with the Applicable option, to allow 

users to switch between the full list and the filtered list. If you select All, the full 
outline appears along with the Applicable option to allow users to switch between the 
full outline and the filtered outline.   

 

Note: When the Applicable Outline view contains both SmartMatch and ExactMatch 
results, the ranking of the results is lost. SmartMatch ranking only displays with the 
Applicable List view. 
  
It is important to understand the implications if you choose to change this publishing 
option. First, when you use the Outline List view for SmartMatch, there is no relevancy 
to the results. In other words, lower relevant results may appear above higher 

relevant results. Additionally, the load time for the table of contents in the Player may 
be negatively affected in SmartMatch because a higher number of results (maximum 
of 200) may be shown. 
  

 Show introduction text: This option controls whether the Introduction frame 

appears when a topic opens in the Player. Select this option to show the Introduction 
frame as the first frame during playback and deselect it to suppress the frame. 
  

 Enable users to change their Player preferences: If you enable this option, the 

Player includes a Preferences link that enables any user to change the settings. If you 
disable this option, the Preferences link does not appear in the Player. 
  

 Enable skipping in Try It! mode: Select this option to enable the user to advance to 

the next step in Try It! mode by pressing Enter instead of performing the action in the 
bubble. 
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 Enable Direct Do It!: When a user launches Player content in a context-sensitive 

manner from a target or web application and only one topic is returned, the topic is 

automatically launched in Do It! mode when this option is enabled. Note that the topic 
must also be configured for Do It! mode using the Play modes property. You can close 
Direct Do It! and display the full TOC with the View Outline link on the Action menu. 

  

 Key combination for advancing in Do It! mode: Configure a key combination for 
advancing to the next step in Do It! mode. 
  

Note: The Key combination to advance in Do It! mode does not work in Firefox or 
Internet Explorer 11 or later. 

1.3.7 Preview Defaults 

Use this page to configure the default publishing style used for previewing documents from 
within the Developer and options for displaying content in the Concept pane of the Outline 
Editor. 

 Category: This option controls the category of publishing projects that is used when 
you preview any of the output formats. By default, the Developer includes one 
category of publishing project but you can also create your own by copying and 
modifying the delivered publishing projects, or by importing publishing project 

documents from another author. If you do this, you can then use this option to choose 
the category that you want to use when you preview a document. 
  
The list of styles that appear in the Preview toolbar list is determined by the category 
selected here and the language of the content. If there are no styles that can be 
previewed based on the selected language, then the language of the Developer is 

used. If there are no styles that can be previewed based on the language of 
Developer, then the Preview toolbar is disabled. Also note that the Preview list appears 
in the language of the Developer. 
   

 All: This option allows you to control the display of linked content in the Concept pane 

of the Outline Editor Player view as you navigate through documents in the outline. 
You can use this option to prevent the Developer from opening Microsoft Word or 
Adobe Acrobat when viewing content in the Outline Editor. 
   

 Packages: This option allows you to control the display of linked content from 

packages in the Concept pane of the Outline Editor Player view as you navigate 
through documents in the outline. This option is very useful if you have linked 
multimedia-based content that you do not want to launch and play as you navigate 
through an outline. By default, any linked document in the Concept pane displays as 
you click a document in the outline. However, you can turn off the display of linked 

content in packages. If you turn off the display of linked content in packages, a 
message appears in the Concept pane of the Outline Editor telling you how to preview 

the content by clicking  on the Concept pane toolbar. 

   

 Web Pages: This option allows you to control the display of linked content from web 
pages in the Concept pane of the Outline Editor Player view as you navigate through 
documents in the outline. This option is very useful if you have linked multimedia-

based content that you do not want to launch and play as you navigate through an 
outline. By default, any linked document in the Concept pane displays as you click a 
document in the outline. However, you can turn off the display of linked content in 
web pages. If you turn off the display of linked content in web pages, a message 
appears in the Concept pane of the Outline Editor telling you how to preview the 

content by clicking  on the Concept pane toolbar. 

   

 URLs: This option allows you to control the display of linked content from URLs in the 

Concept pane of the Outline Editor Player view as you navigate through documents in 
the outline. This option is very useful if you have linked multimedia-based content that 
you do not want to launch and play as you navigate through an outline. By default, 
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any linked document in the Concept pane displays as you click a document in the 
outline. However, you can turn off the display of linked content from URLs. If you turn 

off the display of linked content from URLs, a message appears in the Concept pane of 

the Outline Editor telling you how to preview the content by clicking  on the 

Concept pane toolbar. 
   

 User-Defined Questions: This option allows you to control the display of linked 

content from User-Defined Questions in the Concept pane of the Outline Editor Player 
view as you navigate through documents in the outline. This option is very useful if 
you have linked multimedia-based content that you do not want to launch and play as 
you navigate through an outline. By default, any linked document in the Concept pane 

displays as you click a document in the outline. However, you can turn off the display 
of linked content in User-defined Questions. If you turn off the display of linked 
content in User-Defined Questions, a message appears in the Concept pane of the 

Outline Editor telling you how to preview the content by clicking  on the Concept 
pane toolbar. 

1.3.8 Recorder Defaults 

Use this page to configure the following Recorder defaults: 

 Manually record screenshots: Recorder behavior that requires a PRINTSCREEN to 
capture a screenshot and another PRINTSCREEN to capture the associated action. 
Instructional text guides the user through the recording process when the Recorder is 
launched in Manual mode. 
  

 Automatically record screenshots: Default Recorder behavior that requires a 
PRINTSCREEN to start the recording process and a PRINTSCREEN to end the recording 
process. All frames and actions (with the exception of point events) that occur 
between the two PRINTSCREENS are recorded. 

  
Tip: Automatic recording should be used when you know the system process you are 

going to record well. Since Automatic recording records every action you perform, it 
also records any actions you perform inadvertently or incorrectly. You then have to 
edit the topic in the Topic Editor to correct any errors. Since Manual recording requires 
you to press PRINTSCREEN after each action you perform, you have the opportunity to 
rehearse the next step without it being recorded. If the action you performed does not 

give the desired result, you can immediately correct it by performing the correct action 
before you press PRINTSCREEN. 
  

 Time in seconds to hide recorder window before screen capture: As you record 

a topic, the appearance of some screens in the target application may change after a 
certain amount of time has elapsed. For example, some menus expand to display 
additional options after the mouse pointer hovers over the menu for a few seconds. To 
capture the correct screenshot, you can set a delay time between hiding the Recorder 
and capturing the screen. 
  

 Screenshot capture key: By default, the Recorder uses the PRINTSCREEN key to 

capture screenshots and actions for a topic. If the PRINTSCREEN key is difficult or 
inconvenient for you to use, you can change the Recorder screenshot key. You can use 
any of the function keys, or a combination of any of the function keys (F1 through 
F12) and the ALT key, CTRL key, and/or SHIFT key. 

  
If you change the Recorder screenshot key, you should select a key or key 
combination that is not used in the target application for another purpose. For 
example, pressing the F1 key in some applications opens a Help window. Therefore, 
for those applications you would not want to use the F1 key to capture the 
screenshots. 

  

 Record sound with topic: By default, the recorder is not set to record sound with a 
topic. Click this option to enable sound recording on the Recorder. The display of the 
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Recorder depends on the state of this option and the Screenshot capture mode 

(Automatic or Manual). See Recorder Logic for more on Screenshot capture mode. 

  

 Sound pause key: By default, the Recorder uses the PAUSE key to pause sound 
recording for a topic. If the PAUSE key is difficult or inconvenient for you to use, you 

can change the Recorder sound pause key. You can use any of the function keys, or a 
combination of any of the function keys (F1 through F12) and the ALT key, CTRL key, 
and/or SHIFT key. 
  
If you change the Sound pause key, you should select a key or key combination that is 
not used in the target application for another purpose. For example, pressing the F1 

key in some applications opens a Help window. Therefore, for those applications you 
would not want to use the F1 key to pause sound recording. 
  

 At the end of recording: Opens the Topic Editor only after you have finished 
recording the entire topic. This option allows you to complete all the steps in the task 

and then go back and confirm the actions and bubble text. 

  

 After each screenshot: Opens the Topic Editor after you record each frame. This 
option allows you to confirm the action and bubble text after every step. 

Note: Recorder options are stored per user. These defaults are used regardless of the Library 
being accessed. 

1.3.9 Spelling Defaults 

Use this page to control the behavior of the Spell Check tool. When you create any document, 
you must choose a default language for use during a spelling check.  
  
Note: These options do not apply to Japanese, Chinese, and Korean content since the 
Developer does not provide spelling dictionaries for these languages. During spell check, the 
Developer ignores any document that has a Japanese, Chinese, or Korean Language property.  

 Ignore words in uppercase: You can choose to have words that appear in all 

uppercase letters be identified as errors or ignored. 
   

 Try to split compound words into two individual words: The Spell Check tool 
identifies compound words as errors. You can choose to have the Developer try to split 

such terms into individual words. 
   

 Custom dictionary: As content authors work with the Spell Check tool, they may 
want to add words to a custom user dictionary. This dictionary allows authors to 

indicate words that should not be identified as misspellings during future spelling 
checks. By default, all content authors working with a shared installation of the 
Developer use the same custom dictionary, Userdic.tlx. Content developers do, 
however, have the option to create their own custom user dictionaries, to add 
dictionaries used by other content authors, or to remove dictionaries. If you want to 

create a new dictionary for use during spelling checks, you can do so. Creating your 

own dictionary allows you to control which words are identified as misspellings during 
your spelling checks without affecting the userdic.tlx list used by all content authors. 
  
Another content author may have already created a dictionary file that you want to 
use to check the spelling of content as well. You can easily add an existing dictionary 
to the list of lexicons used in the Spell Check tool. The existing dictionary file is not 
required to be a .tlx file. 

  
You may decide that you do not want to use a custom dictionary that you have added. 
You can easily remove a lexicon file from the list of dictionaries you use with the Spell 
Check tool. Removing the file does not delete the dictionary file from the location 
where it is stored; it simply removes it from the list of files you can use during a 
spelling check. 
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1.3.10 Export/Import Tools Options Defaults 

After you configure the options in the Content Defaults, Documents, Player, and Preview, you 

can share these preferences with other authors. This is particularly useful in workgroup 
environments where multiple authors are working on the same content that requires 
consistent output regardless of who authored the content. In this scenario, you can create a 

"master" set of Content Default options, export the settings, distribute the options file to the 
other authors, and then have all authors import the master options into their Developer 
installation.  
  

To export content defaults:  

1. Configure the options that you want to export. Only the settings defined for the 

Content Defaults, Documents, Player, and Preview categories are exported. 
   

2. On the Tools menu, point to Export and choose Content Default Options. 
   

3. Browse to where you want to store the exported options file. 

   
4. Type a name for the options file and click Save. 

  
Note: You should distribute the options file (.ops) to the authors that need to import 
the standard settings. 

To import content defaults: 

1. On the Tools menu, point to Import and choose Content Default Options. 

  
2. Browse to where the exported options file is stored. To import content defaults, you 

need to know the location of the exported content defaults file (.ops). 
  

3. Select the file and click Open. 
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2 Use the Developer in a Multi-user Environment 
This chapter describes functionality that is specific to using the Developer in a multi-user 
environment such as:  

 Library Login Profiles 
   

 Online and Offline Operation 

   

 Document Check In and Check Out 

   

 Document Version Control 
   

 Library and Folder Synchronization (Manage Folder Conflicts, Refresh the Library and 

Outline Editor) 
   

 Document Deletion and Recovery 

   

 Workflow Properties 

   

 Sample Custom Views 

The remaining chapters describe functionality that is common to both a single-user and multi-
user environments. However, you also find various multi-user considerations in places where 
common functions vary depending on whether you are using the Developer in a single- vs. 
multi-user installation. 

2.1 Create and Manage Login Profiles 
When you start the Developer for the first time in a multi-user environment, you are asked to 
create a login Profile. A Login Profile identifies the server where the content Library is installed 

as well as your login credentials. If you plan to access multiple content libraries, you need a 
separate login Profile for each.  
 
Note: You can configure the login Profile so that you do not need to enter a user name and 

password each time you log in to a Library. 
 
To create a login Profile, you need the following information: 

 URL of the Library location (for example, http://server/virtual directory) 
  

 Login credentials such as user name and password (Standard authentication only) 

  

 Profile name of your choice 

2.1.1 Add a Login Profile 

The login Profile Wizard walks you through the following steps to create a login Profile.  
 

Step 1: Identify the Library Location 

The first step in creating a login Profile is to identify the server URL where the content Library 
is installed. 
 
The URL must contain the virtual directory that points to web service (asmx files) and web 
configuration files. This allows the Developer to communicate between the local document 
cache and the server-side database. 

 
Note: The Library location is not case-sensitive. 
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When you enter the Library URL, the Developer determines whether the Library is configured 
for Standard or Windows authentication and prompts for the appropriate login credentials. 

 

Step 2: Enter Login Credentials 

Your administrator predefines each author on the server based on whether the server is 
configured for Windows or Standard user authentication. When you create a login Profile that 
connects to the server, you must enter the same login credentials that the administrator 
defined on the server. You receive an error message if your login credentials do not match 
those defined on the server. 

 If the server is configured for Windows authentication, the Use my current Windows 

login account option is automatically selected and your Windows user name and 
password are used. However, you can use a different login account if your 
administrator used different values when adding your account on the server. Please 
note that if you enter a different user name, you must include the domain or machine 
name as the prefix to the user name separated by a backslash (domain name\user 
name). 

  

 If the server is configured for Standard authentication, the Use a different login 
account option is automatically selected and you are prompted to enter the same user 
name and password that the administrator created for you on the server. Your 

administrator should provide you with these credentials before you create a login 
Profile. 

Mark the Save my password as part of this profile option if you do not want the Developer to 
prompt you for your password each time you log in using the profile. 
 

Step 3: Name the Login Profile and Login 

The next step is to name the login Profile. If you create multiple profiles to access different 
content Libraries, you can use this name to switch between the Libraries. Also, if you create 

multiple profiles, you can configure one as the default that is automatically used every time 
you launch the Developer. The name of the active profile appears in the title bar of the 

Developer. 
 

Step 4: Choose a Data Storage Location 

As you use the Developer to create, view, and edit documents that are stored centrally on the 

server, a copy of each document is downloaded and stored locally on your computer. In this 
step, you can either accept the default data storage location or choose a different folder on 
your computer. Click Browse if you want to change the default folder or click Next to accept 
the default folder. The folder that you select must be empty. 
 
Note: You must choose a folder on your local computer. Network drives are not permitted. 
 

Step 5: Complete the Login Profile 

The last step to complete a new profile is to confirm your entries and choose to log in with the 
new Profile or return to the Profile Editor. 
 

To add a login Profile: 

1. On the Tools menu, choose  Profiles. 

  
2. Click Add to start the Profile Wizard. 

  
3. Click Next to display the Library Location page. 

  

4. Type the URL to the server and virtual directory that contains the content Library that 
you want to access using this login Profile (for example, http://server/virtual 
directory). Your administrator provides you with this information. 
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5. Click Next to display the Credentials page. 

  

The Developer automatically detects whether the server was installed using Standard 
or Windows authentication and disables the login credential options that are not valid. 
For example, if Windows authentication was installed, the Use a Different Login 
Account option is disabled. If Standard authentication was installed, you must enter a 
valid user name and password. Your administrator provides you with this information. 

  
6. Enter your login credentials and click Next to display the Profile Name page. 

  
7. Type a name for the login Profile. Consider using the name of the server (Library) to 

identify a profile when you have multiple Profiles that connect to different servers. 
  

8. Click Make this my default profile to configure this profile as the default that is 

used when you launch the Developer, if desired. 
  

9. Click Next to display the Data Storage Location page. Click Browse to change the 

data storage location, if desired. 
  

10. Click Next to complete the Profile Wizard. 
  

The last page in the Profile Wizard displays a summary of the Library location, login 
credentials, profile name choices, and data storage location choices you have made. 
Before you complete the wizard, you can also choose to start the Developer 
automatically and log in using the default profile or return to the Profile Editor and 
continue to add or edit profiles. 
  

11. Choose an option and click Finish. 

2.1.2 Edit a Login Profile 

You can edit any login Profile that is not in use and change the Library URL, profile name, or 
the location of the local cache. If you try to edit a login Profile that is currently in use, you 

must first exit the profile.  
 

To edit a login Profile: 

1. On the Tools menu, choose  Profiles. 
  

2. Select a profile from the list. 
  

3. Click Edit or Exit Profile if you selected a profile that is in use. 
  

4. Make the necessary changes and click Finish. 

2.1.3 Delete a Login Profile 

If you have multiple login Profiles to different Libraries, you can delete any login Profile that is 

no longer needed. You should avoid deleting a login Profile that is currently in use or those 
that you may still want to use to connect to different servers. You should also ensure that you 
do not have documents checked out from a server before you delete a profile that connects to 

that sever. Deleting a login Profile discards any changes that the author made to checked out 
documents. 
 

To delete a login Profile: 

1. On the Tools menu, choose  Profiles. 
  

2. Select a profile from the list. 
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3. Click Delete. 
  

You are warned that any changes to documents that the author has checked out are 
discarded. You may want to log in first and check in all documents before you proceed 
to delete the Login Profile. 

2.1.4 Switch the Library Login 

If you have multiple login Profiles, you can switch between Libraries without having to close 

the Developer. To do this, you must have a login Profile for each Library. You can perform the 

switch from the Profiles dialog box or by clicking  Connection State in the bottom right 
corner of the Developer screen and choosing the Switch Profile command.  
 

To switch profiles from the Profile dialog box: 

1. On the Tools menu, choose  Profiles. 
  

2. Click a profile for a different Library. 
  

3. Click Open to switch to the Library. 

To switch profiles from the Connection State icon: 

1. Click the  Connection State icon in the lower right corner of the Developer screen. 

  
2. Choose Switch Profile from the menu and follow steps 2 and 3 above. 

2.1.5 Change Password 

You can change your current password at any time while you are working online. You are 
prompted for the new password the next time you log in.  
 

Note: If you stored your password in a login Profile, it automatically updates when you 
complete the password change. 
 

To change your password: 

1. Make sure you are working online. 

  
2. On the Tools menu, choose Change Password. 

  

3. Enter your current password. 
  

4. Type a new password. 
  

5. Type the new password again to confirm the change. 

  
6. Click OK. 

2.2 Work Online or Offline 
In a multi-user installation, you can use the Developer in either an online or offline mode. 

When you work online, you are connected to the content server through the network, an 
intranet, or the Internet. In this mode, you can access any document that is checked in to the 
server. When you access any document while online (by opening it in an editor and viewing its 
content), a read-only copy of the document is automatically downloaded to a local cache on 
your computer. If you want to edit a document that is on the server, you must first check out 
the document. When you do this, an editable copy of the document is downloaded to your 
local data storage location. After you make changes to the checked out document, you must 

check the document back in to the server to save the changes to the content server.  
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You can determine the location of the local data storage location when you create a Login 

Profile for the first time. The complete path of the local data storage location is displayed on 
the Summary page of the Login Profile Wizard for reference. 
 

You can set the maximum available disk space for the local data storage location using the 
Library settings in the Developer category in Tools, Options. 
 

Note: As you work with documents, you may see "downloading" messages when documents 
in the Library are downloaded from the server to your local data storage location. 
 

Client - Server Synchronization 

When you are working online, the Developer (client) installation on your local computer 
automatically synchronizes with the content server approximately every minute or so. The 
Library then updates to display all of the changes that have been checked in to the server, 
including new documents and folders, changes to folder and document names or properties, 

deleted documents, and so on. The Outline Editor also displays some of the results of this 
synchronization (for example, changes to document names), except for changes that were 

made to the outline structure (the links between the documents). To display any structural 
changes to the outline from the Outline Editor, you must refresh the display manually using 
the Refresh command on the View menu or by pressing F5. The Library also automatically 
synchronizes when you use commands on the Document menu such as Check In, Check Out, 
Get, Get All, and so on. However, performing a refresh in the Outline Editor is still needed to 

see the any structure changes in the outline you have open. 
 

Work Offline 

You can also work offline when you are not connected to the server. You are working strictly 
with the documents that are stored in your local data storage location. You might choose to 
work offline for the following reasons: 

 There is no connection available to the server (such as on an airplane or at another 

remote location with no connectivity to the content server). 
  

 There is a connection to the content server, but it is slow (such as a dial-up 
connection). 

  

 The server is unavailable for a period of time for technical reasons (such as 
maintenance or a power outage). 

When you work offline, you can edit only the documents that you have previously checked 
out; however, you can view other documents that you have in your local cache that you do 
not have checked out. You can also create new documents but you cannot delete documents 

under version control when you are offline. 
 

Note: If you are working online and your connection with the server stops (for example, the 
server goes offline unexpectedly), the connection state changes to Disconnected. When the 
server is available again, the Developer connects automatically, and the state changes back to 
Online. 
 

If you plan to explicitly work offline, you should always check out documents that you need to 

edit before going offline. You may also want to use the Get command from the Document 
menu to ensure that you have local copies of the most recent documents that you want to 
view in addition to those that you want to edit. If you go offline and do not have copies of 
some documents in your local data storage location, those documents are unavailable to you. 
To remedy this, you need to go back online and "get" the documents that you need. 
 

Note: When you create a login Profile and log in to the Developer for the first time, all 
documents in the System folder are automatically downloaded to your local computer. If 

another author checks in modifications to any of these documents such as a master role list 
document or publishing style, you should periodically go online and download updated 
documents using the Get command. 
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Server Connection States 

There are four connection states in a multi-user environment: Online, Disconnected, Offline, 

and Offline/Login failed. The Connection State icon  in the bottom right corner of the 

Developer screen identifies the state in which you are currently working. 

 Online: You are currently connected to the server. 

  

 Disconnected: You do not have a connection to the server, but would like to. You can 
get in this state if the network connection is dropped. When this happens, the 
Developer regularly tries to reconnect to the server. 
  

 Offline: You explicitly chose to work offline. The Developer does not try to reconnect 
to the server until you explicitly go online. 
  

 Offline/Login failed: The user password is incorrect, or the account does not exist 

on the server. You are notified of the failure to log in, and the Developer remains 
offline. You may also experience this state if the administrator changes your login 
credentials while you are working online. 

2.2.1 Switch Between Online and Offline Operation 

You can manually switch the Developer between online and offline modes, even while you are 
still connected to the server.  
 

To manually switch between online and offline operation: 

1. If you are currently working online and would like to work offline, choose Work 

Offline from the File menu or click the  Connection State icon at the bottom 

right corner of the Developer screen and choose Work Offline. 
  

2. Repeat the procedure to switch from offline to online mode. 

2.2.2 Get Documents for Offline Use 

If you want to work offline, there may be documents that you want to refer to, create links to, 
or simply view but not edit. You do not need to check these documents out from the server, 

since you do not want to change them. In most cases, you may already have local copies of 
the documents that you may need or want if you accessed these documents while working 
online. However, in some cases, you might not have accessed some documents that you may 
want to have in your local data storage location when you go offline. In this case, you use the 
Get command to retrieve read-only copies of these documents before you go offline.  
 
If you are not able to identify the specific documents that you need to work offline, you can 

use the Get All command to download all documents in the Library to ensure that you have 
everything you need. However, this may take some time to download depending on the 
number of documents that need to be downloaded, their sizes, and the connection speed. 
When you use this command, there is no need to select any documents. 

 

To get specific documents for offline use: 

1. Identify the documents that you want to download locally and navigate to them using 

the Library or Outline Editor. 
  

2. Select the document(s) or folder containing the documents that you want to download. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. On the Document menu, choose  Get. 
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You can also right-click on your selection and choose Get. 

  

The Related Documents dialog box appears when you perform an action on any 
document that has links to other documents. You can choose to process only the 
document(s) you selected or to process your selection and all of the related 
documents. 
  

Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. 
  
After you have made your selection, click OK. 
  
You might also receive a message if some documents could not be processed because 
of other constraints. You can click OK to close the message box or click the View 
activity log link to view the results of the action. 

To get all documents for offline use: 

1. On the Document menu, choose Get All. 

2.3 Check In and Check Out Documents 
In a multi-user environment, you use the Developer to connect (online) to a centralized 
content server and share documents using a version control system that allows you to check 
documents in and out. When you check out a document, it is copied to your local computer for 
viewing or editing. The document is also locked on the server to prevent any other author 

from making changes (however, other authors can view it). When you check in a document, it 
is copied from your local computer to the content server and the lock is then removed, making 
it available to other authors.  
 
You can check in an interim version of a document and leave it checked out while you continue 
working by clicking the Keep checked out option on the Check In Comment dialog box during 

check in. The content is checked in and the version number incremented but the document 
remains checked out and unavailable for edit by other users. However, other users can view 
the latest version of the content. 
 
Any document in a Library can be checked in or out depending on its current state. For 
example, a checked out document can only be checked in and vice versa. 
 

New documents are automatically checked out to you. To make this content available to other 
authors, you must check it in. 
 
Note: You must be online to check documents in or out. 
 
You can check in or out one document at a time or multiple documents all at once. Just select 
the documents that you want from either the Library or Outline Editor. Also note that, from 

the Library, you can select folders on which to perform check in/out. In this case, ALL 

documents in the selected folders are processed. If any document in a folder has links to other 
documents in different folders, you have the option to process related documents. 
 
You can also choose to include related documents during check in or out. For example, when 
you check a module in or out, you can choose to include all its related documents such as its 

sections, topics, web pages, packages, and so on. This option is available for any document 
type that can have links to other documents. If you check in/out a Library folder (which checks 
in/out every document in that folder), you can also check in/out related documents that are 
stored in any folder outside of the current folder that you have selected. Templates, glossaries 
and style sheets are not included as related documents when you check in or check out a 
parent document. Use the View related documents link to check the documents included in the 
action. 
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Important Note on Related Documents: The definition of related documents can vary 
based on specific operations that you can perform. For example, documents that are 

considered as related during check in/out operations are different than those considered 
during import/export. See Link Related Documents in the Work with Document Editors chapter 

of the Content Development guide for more information. 
 
To ensure that ALL documents are checked in/out, you should consider checking in/out 
content by a Library folder or use the Document, Check in All command. 
 
Note: You can only check in/out documents from the Library or the Outline Editor. 
 

You can open any document regardless of its check in/out state. However, if you edit a 
document that is not checked out to you and attempt to save it, you are given the option of 
saving the changes (for example, check out the document, if available, and save the changes), 
save the document with a different name, or cancel without saving the changes. 
 
Note: Saving changes to a document that is not checked out to you is not a recommended 

best practice. This functionality is designed to allow you to save changes to a document that 

was un-intentionally edited in Read-Only mode. 

2.3.1 Check In/Out Indicators 

As documents are checked in and out, icons appear to the left of the document name 
indicating the check in/out state as follows:  
  

 indicates that the document is checked out to you. 

 

 indicates that the document is locked and checked out to another author. 

 
No icon indicates that the document is checked in and available to any author. 
 
These icons appear in various places such as the Library and Outline Editor as well as on 

document editor tabs and various views. Also note that additional columns in the Details view 

of the Library and Outline Editor display the check in/out state and version number. The 
Checked Out By column displays the name of the author who is currently using the document. 

2.3.2 Check In a Document 

Checking in a document updates the Library with any changes made to the document or 
documents or, if it is a new document, adds it to the Library. Check in also assigns a version 
number if the document has changed since it was checked out. For documents that you 
edited, the version number is incremented by 1. For new documents, the first version is NEW 

indicating that the doc has not been checked in so a copy does not yet exist on the server.  
 
Note: You cannot check in a document that is open in a document editor. You must close the 
document and then check it in. 
 

Comments 

During check in, you can add comments that are attached to the document and can be 
accessed through the document history and reviewed by other authors. You are always 
prompted for comments during check in. However, if you check in a document with no 
changes, comments are not applied. 
  
If you check out a document but do not make any changes and then check it back in, a new 
version number is also not applied. 

  
If you check in multiple (new or changed) documents at one time. You can specify a different 
comment for each document, or you can click the Apply to all documents option to have the 
same comment applied to all documents in your selection. 
  
Note: Document comments are not exported or included in any published output. 
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Click the Keep checked out option to check in an interim version of a document and leave the 

document checked out so you can continue editing. The version number is incremented by 1. 

Other users can view the updated content but cannot edit the document because it is still 
checked out. 
 

To check in a document: 

1. Make sure you are working online. 

  
2. From the Library or Outline Editor, select one or more documents or folders containing 

the documents that you want to check in. These documents can only be documents 
that were previously checked out to you. You cannot check in a document that was 

checked out by another author. 
  

3. On the Document menu, choose  Check In. 

  
You can also right-click on your selection and choose Check In. 

  
The Related Documents dialog box appears when you perform an action on any 
document that has links to other documents. You can choose to process only the 
document(s) you selected or to process your selection and all of the related 

documents. 
  
Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. After you have made 
your selection, click OK. 
  

4. Type any comments about the document (if applicable) in the Provide check in 

comments field, 
  

5. Click OK. 
 

You might also receive a message if some documents could not be processed because 
of other constraints. You can click OK to close the message box or click the View 
activity log link to view the results of the action. 

Note: You can also use the Check In All command to check in all documents that you 

currently have checked out rather than selecting specific documents. 
 

To check in content changes but leave the document checked out: 

1. Make sure you are working online. 

  
2. From the Library or Outline Editor, select one or more documents or folders containing 

the documents that you want to check in. These documents or folders must be 
checked out to you. 

  

3. On the Document menu, choose  Check In. 

  
You can also right-click on your selection and choose Check In. 
  

The Related Documents dialog box appears when you perform an action on any 
document that has links to other documents. You can choose to process only the 
document(s) you selected or to process your selection and all of the related 
documents. 
  
Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. 

  
After you have made your selection, click OK. 
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You might also receive a message if some documents could not be processed because 

of other constraints. You can click OK to close the message box or click the View 
activity log link to view the results of the action. 

  
4. Type any comments about the document (if applicable) in the Provide check in 

comments field. 
  

5. Click Keep checked out to check in content changes but leave the document checked 
out. 
  

If this option is checked, content changes are checked in and the version number is 
incremented. The document can be viewed but not checked out and edited by other 
users. 
  

6. Click OK. 

2.3.3 Check In All Documents 

Instead of selectively checking in documents, you can also check in all of the documents that 
you have checked out at one time. However, please note that this action may take some time 
depending on the number of checked out documents that you have in the Library. Any 

document that you currently have checked out is checked in to the server when you perform 
this action. 
 

To check in all documents: 

1. Make sure you are working online. 

  

2. On the Document menu, choose  Check in All. 

2.3.4 Check Out a Document 

Checking out a document locks it in the database so that you are the only one who can edit it. 
The document is also downloaded to the local data storage location on your computer. This 

allows you to disconnect from the network and work offline. The documents remain checked 
out and locked until you explicitly check them in to the server.  
 

To check out a document: 

1. Make sure you are working online. 

  
2. From the Library or Outline Editor, select one or more documents or folders containing 

the documents that you want to check out. These documents can only be documents 
that are checked in to the server and not checked out to another author. 
  

3. On the Document menu, choose  Check Out. 

  

You can also right-click the selected document(s) or folder and choose Check Out. 
  
The Related Documents dialog box appears when you perform an action on any 
document that has links to other documents. You can choose to process only the 
document(s) you selected or to process your selection and all of the related 
documents. 
  

Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. 
  
After you have made your selection, click OK. 
  
You might also receive a message if some documents could not be processed because 
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of other constraints. You can click OK to close the message box or click the View 
activity log link to view the results of the action. 

2.3.5 Cancel Check Out 

If you check out a document and make changes but decide that you do not want to commit 

your changes to the server, you can cancel the check out and revert to the server version of 
the document. This action discards any changes you made to the document after it was 
originally checked out.  
 

To cancel a document check out: 

1. Make sure you are working online. 

  
2. From the Library or Outline Editor, select one or more documents or folders containing 

the documents for which you want to cancel a check out. These documents can only 
be documents that are checked out to you. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. On the Document menu, choose  Cancel Check Out. 

  
The Related Documents dialog box appears when you perform an action on any 
document that has links to other documents. You can choose to process only the 
document(s) you selected or to process your selection and all of the related 

documents. 
  
Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. 
  
After you have made your selection, click OK. 

  

You might also receive a message if some documents could not be processed because 
of other constraints. You can click OK to close the message box or click the View 
activity log link to view the results of the action. 
  

4. Click Yes to complete the action or No to abort. 

2.3.6 Open a Checked-in Document 

You can open any document such as a topic, web page, package, glossary, and so on, that is 
checked in to the server without checking it out. When you open a checked in document, a 
(Read-Only) label appears on the tab next to the document name.  
 

If you edit a checked in document, upon exit you are given the option to save the changes, 
save the changes to a new document or discard the changes. If you choose to save the 
changes, the document is checked out and the content is saved. If you choose to save as a 

new document, click Yes when the Save Document message appears. If you choose to discard 
the changes, click No. 
 

Module and section documents that are checked in do not display a Read-Only label when you 
open them in the Outline Editor. You can view these document types but you cannot edit them 
unless you check them out first. For example, to rename a module or section, you must first 
check it out. Also, if you attempt to link a document to a checked in module or section, you 
are always prompted to check out the document before you can continue. 

2.4 Version a Document 
The Developer's version control system automatically keeps track of new documents and 

changes to existing documents as they are checked in and out of the server. A running history 
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of each document is created as changes are checked in. The history of a document is a 
sequential list of the document versions starting with 1, along with their dates, who made the 

changes, and any comments made during check-in to explain the changes in the document. 
This history allows you to view a previous version of the document and/or roll back to a 

previous version. History is only available when you are online.  
 
Note: A new document is automatically assigned a version of NEW until it is checked in for the 
first time. The document is assigned a version of 1 after the first check-in.  

2.4.1 View Document History 

History displays the list of document versions with the most recent version at the top of the 
list. History is not available for new documents that are not under version control. You must 
also work online to review document history.  

 
For each document, the following properties appear: 

 Version (automatically generated during the check in, delete, or restore process). 

    

 Author that changed the document. 

    

 Date when the document version was created. 
    

 Comments that were either user-defined when the document was checked in or 
automatically generated based on actions that were performed on the document. For 
example, system-generated comments of Deleted and Restored appear when those 
actions were performed on a document. 

    

 Owner or author currently responsible for the content of the document. 
     

 State of the document such as draft, in review, or final. 

The Developer creates versions of all document types. From the History dialog box, you can 
open and view any version of a document type, except modules and sections. When you view 
a version of a document, the document opens in the appropriate document editor in read-only 
mode. 
 
You can also roll back to previous versions of a document. 

 
You can resize the History dialog box to display more information such as long comments or 
additional vertical space for historical records. The Developer remembers the History dialog 
box size after you close it. 
 

To view the version history of a document: 

1. Make sure you are working online. 

    

2. From the Library or Outline Editor, select ONE document. If you select multiple 
documents, the History command is unavailable. 

    

3. On the Document menu, choose  History. 
    

4. Review the document history and choose to view or rollback to a previous version, if 
necessary. 

2.4.2 Roll Back a Document 

You can roll back a document to a previous version only if the document is checked in. 
Rollback replaces the current document content with the content of the version you selected 
for rollback. Rollback also creates a new version of a document. For example, if the current 
version of a document is 10 and you roll back to version 6, the Developer creates a new 
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version number of 11 with the content from version 6. This new version of the document 

becomes the current document.  

 
Note: You can roll back a document only if there is more than one version in the history and 
the document is checked into the server. 
 

To roll back to a previous version: 

1. Make sure you are working online. 

  
2. From the Library or Outline Editor, select ONE document that is currently under 

version control and has more than one version. 

  

3. On the Document menu, choose  History. 

  
4. Select a version of the document to roll back to. You might want to view the document 

before you perform a rollback to ensure that it is the version that you want since a 

rollback cannot be undone. You cannot view module and section documents. 
  

5. Click Rollback to create a new version of the document. A comment is automatically 
provided to identify the document version that you rolled back to. 

  
6. Click Close. 

2.5 Refresh the Library and Outline Editor 
When you use the Developer in a multi-user environment and you are working online, the 
Developer (client) installation on your local computer automatically synchronizes with the 
content server every minute. The Library then updates to display all of the changes that have 
been checked in to the server, including new documents (that are checked in) and folders, 
changes to folder and document names or properties, deleted documents, and so on. 
 

The Outline Editor also displays the results of this synchronization, except for changes that 
were made to the outline structure (the links between the documents in the outline). To 
display these structural changes in the Outline Editor, you must refresh the display manually 
using the Refresh command on the View menu or by pressing F5. You can also manually 
refresh the Library using the same command or key. 
 

The Library also automatically synchronizes when you use commands on the Document menu 
that involve the Library, such as Check In, Check Out, Get, and so on. However, you still need 
to perform a refresh in the Outline Editor to see any changes in the content structure. 
 
Note: Performing a manual refresh (F5) from the Library does not immediately refresh new 
(empty) folders that were created by other authors. The client-to-server synchronization 
refreshes the view of folders. However, new folders that contain documents become visible 

after you perform a manual refresh. 
 

To refresh the Library or Outline Editor: 

1. On the View menu, choose  Refresh. 
  

2. You can also press F5. 

2.6 Manage Folder Conflicts 
Regardless of whether an author is working online or offline, folder operations are performed 

locally on the client computer and then synchronized with the server. Synchronizations occur 
in the background if the author is working online or when the author switches from offline 
mode to online.  
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Unlike documents, folders are not checked out, so they are available at all times to all authors. 
Consequently, your local folder structure may differ from the structure on the server due to 

delays in synchronization while you are working online or because you are working offline. For 
instance, while working offline, you create a folder under a parent that another author has 

deleted. The server resolves these conflicts by following prescribed conflict resolution rules. 
The following describes the server side conflicts that can occur for folder operations performed 
on the client side and the rules the server uses to resolve them. 
 

Add Folder 

 

Conflict: Parent folder is renamed or moved. 
Resolution: The new folder is added to renamed/moved folder. 
 
Conflict: Parent folder is deleted (not yet purged). 
Resolution: Undelete parent and add new folder to it. 
  

Conflict: New folder has same name, but different document ID, folder already on server 
under the parent. 

Resolution: The client folder is updated to the same document ID as the folder on the server. 
No new folder is created. 
  
Conflict: Folder on server already exists and was deleted. 
Resolution: Undelete the folder and parent(s) if needed, and update client folder to server 

folder document ID. 
  
Conflict: Parent does not exist; was purged. 
Resolution: Client folder is placed in root directory of Library. 
  
Conflict: No conflicts. 
Resolution: Add folder to server. 

 

Move Folder 

  

Conflict: Old parent folder is renamed or moved. 
Resolution: No problem. Folder moves to new location. 

  
Conflict: New parent folder is renamed or moved. 
Resolution: No problem. Folder moves to new location. 
  
Conflict: New parent is deleted (not yet purged). 
Resolution: Undelete new parent and move folder. 
  

Conflict: Folder already moved on server (parent folder on server already contains folder with 
same document ID). 
Resolution: No action necessary. 
  
Conflict: Another folder with the same name is found in the new parent. 
Resolution: Contents of move folder are moved into server side folder with same name. Purge 

(not mark as deleted) both server and client side old move folder. 

  
Conflict: A deleted folder with the same name is found in new parent. 
Resolution: Undelete the server side folder and parent(s) if needed and move the contents of 
the folder into the server side folder with the same name. Purge both the server and client 
side move folder. 
  

Conflict: New parent does not exist (was purged). 
Resolution: Abort the move. Restore the folder to old location. 
  
Conflict: No conflicts. 
Resolution: Move the folder. 
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Rename Folder 

 

Conflict: Folder name already changed. 
Resolution: Override name with client name. Basically last one to change the name wins. 
  
Conflict: Folder marked as deleted. 

Resolution: Undelete folder, parents if needed and rename it. 
  
Conflict: Parent renamed or folder has moved. 
Resolution: No problem since parent identified by document ID. Renamed folder moves to 
updated parent. 
  
Conflict: Folder does not exist (was purged). 

Resolution: Abort operation. Folder is totally removed when done. 
  
Conflict: No conflicts. 
Resolution: Rename folder. 

 

Delete Folder 

 
Conflict: Folder not empty (contains undeleted documents or folders). 
Resolution: If all of the documents are checked in, delete the contents of the folder and then 
the folder. If server side folder contains checked out documents, folder is not deleted. 
  
Conflict: Parent folder is renamed or moved. 
Resolution: No problem since parent identified by document ID. Delete the folder. 

  
Conflict: Deleted folder was renamed. 
Resolution: No problem finding folder since identified by document ID. Delete the renamed 
folder. 
  
Conflict: Folder already deleted. 

Resolution: Do nothing - work already done. 

  
Conflict: Folder does not exist (was purged). 
Resolution: Do nothing - work already done. 
  
Conflict: No conflicts. 
Resolution: Mark the folder as deleted. 

2.7 Delete and Restore Documents 
You can delete a document only from the Library; however, the implications of deleting a 
document vary depending on a number of factors in a multi-user environment. Some of these 
factors include whether you are working online or offline, whether you are working from the 
Library or a document editor, and whether the document is new or under version control. 
 
This section describes the implications of a deleting a document from the Library in a multi-

user environment. Note that deleting a document from the Outline Editor deletes only the link 
between documents and not the actual document. 

2.7.1 Delete Documents while Online or Offline 

When you are working online, you can delete a document ONLY when it is new and not under 
version control or when it is checked in to the server. You cannot delete a document that is 
under version control but checked out to you. If you try to delete a version-controlled 
document that is checked out to you, you receive the message "Not all of the documents you 

selected were processed". If you click the View activity log link, you also see the comment 
"Document must be checked in to delete".  
 
A document is deemed "under version control" after the first check-in to the server. From that 
point on, the Developer keeps track of changes that are made by various authors and 
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automatically assigns a version number. This is important since a deleted a document that is 
under version control is restorable, unless purged by your administrator. You can also roll back 

to earlier versions of a document that are under version control using the History command on 
the Document menu. It is important to note that new documents not under version control can 

be deleted but CANNOT BE RESTORED. 
 
Note: You cannot delete versioned documents when the Developer is offline. 
 

View Deleted Documents in the Library 

Version-controlled documents that are deleted can be displayed and restored from the Deleted 

documents view in the Library. 
 

View Deleted Documents and the Outline Editor 

When you delete a document from the Library it is immediately removed from the folder in 
which it lives. However, the appearance of a deleted document in the Outline Editor is not as 

immediate. For example, if you delete a version-controlled module, section, or topic from the 
Library, the document name continues to appear in the hierarchy of any outline in which it is 

used, but now appears with an "X" on top of the document icon. 
 
When you select a deleted document from the Outline Editor, you may see a message in either 
the Concept or Introduction pane that a linked document is deleted. For example, this 
message appears if you select a section with a linked web page (as the Concept) that has 

been deleted. To correct this situation, you should restore the deleted document or remove 
the link. 
 

Non version-controlled documents that are deleted from the Library display the  Missing 

Document link in the Outline Editor. Since these documents are not restorable, your only 
option is to remove the document from the outline using the Delete Link command on the Edit 
menu. 

2.7.2 View Deleted Documents 

The Deleted documents view shows documents under version control (checked in or out) that 

were deleted by all authors. Only documents that have not yet been purged by the 
administrator appear in this view.  

 
For each deleted document, you can see the name of the document, the path where the 
document was stored when it was deleted, the deletion date, the name of the author who 
deleted the document, and the document type. 
 
You can sort the documents and rearrange and resize the columns using the same procedures 

that you use to customize the details in the Library. 
 
The only operation you can perform from this view is to restore any of the deleted documents. 
You can also restore deleted documents from the Outline Editor. 
 
Note: You cannot open a deleted document. It must be restored before you can view its 
contents. 

 

To view deleted documents from the Library: 

1. On the View menu, choose Library, if necessary. 

  
2. Click the drop-down list on the View toolbar and choose Deleted Documents. 

2.7.3 Restore a Deleted Document 

You can restore any deleted document under version control to the Library and its linked 
position in the Outline Editor. The Deleted Documents view in the Library displays the 
documents that have been deleted, but not yet purged by the content Administrator. 
Documents that appear in this view are only those that have been deleted after being under 



Use the Developer in a Multi-user Environment 

 

 52 

version control (checked in at least once). New documents that are deleted after they are 

created and never checked in cannot be restored and do not appear in the Deleted Documents 

view. The Deleted Documents view and the Outline Editor let you restore documents to their 
original locations in the Library as well in any outline in which they are used. 
  
If the folder where the deleted document was stored has also been deleted, the deleted folder 
is restored when the document is restored. If the folder has been renamed or moved, the 

document is restored to the renamed/moved folder.  
 
Note: You must be working online to restore a deleted document. 
 
If related documents were also deleted, you have the option to restore only the selected 
document or all related documents. 
 

Restoring a deleted document creates a new version that is viewable in Document History. A 
comment of "Restored" is automatically assigned so you know that the new version was a 
result of performing the Restore command. 

 
Warning! You cannot undo a Restore command. 
 

To restore a deleted document from the Library: 

1. Make sure you are working online. 

  
2. Switch to the Deleted Documents View. 

  
3. Select the documents that you want to restore. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

4. On the Edit menu, choose Restore. 

  
The Related Documents dialog box appears when you perform an action on any 
document that has links to other documents. You can choose to process only the 
document(s) you selected or to process your selection and all of the related 
documents. 
  

Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. 
  
After you have made your selection, click OK. 
  
You might also receive a message if some documents could not be processed because 
of other constraints. You can click OK to close the message box or click the View 

activity log link to view the results of the action. 
  

5. If prompted, choose the option to restore the selected document only or the selected 
document and all related documents and click OK. 

To restore a deleted document from the Outline Editor: 

1. Make sure you are working online. 

  
2. Open the module or section in the Outline Editor that contains deleted documents. 

  
3. Select the deleted documents that you want to restore and perform step 4 above. 
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2.8 Manage Owner and State Workflow 
The Properties toolpane contains properties that allow authors to track document status or 

State. Unlike document properties, the Owner workflow property is maintained on the server. 
To change the Owner, you must be working online and the document must be either checked 

in, checked out to you, or checked out to another author. The Owner is saved in the document 
history when the document is checked in.  
  
To change the State workflow property, you must first check out the document. The State is 
saved in the document history when the document is checked in. 
  

Owner and State workflow properties are saved with the document when the document is 
checked in. In addition, unlike other document properties, a document cannot inherit a 
workflow property from a parent document. 
 
Note: Workflow properties are not included with exported documents. When you import 
content, the Owner and State workflow properties for documents are reset to blank, which is 
the default value. 

2.8.1 Assign Content State 

The State property is an editable property for communicating the status of a document. This is 
particularly helpful when collaborating with other authors in a development team. Authors can 
assign a state to documents from the master list defined by the administrator. The default list 
of States includes (blank), Not Started, Draft, In Review, and Final. Administrators can 
customize the list by adding, deleting or renaming the values.  
 

A State value must be assigned; it cannot be inherited from a parent document. You can 
assign a State to a single document or multiple documents at the same time, but only one 

State can be applied to a document. You can also view the State for a document in the Details 
View in the Library and the Outline Editor, but you cannot assign State values directly from 
this view, unless you display the Properties toolpane. 
 

Note: To assign or change the state of a document, you must be online and you must checked 

out the document. The state is saved with the document when it is checked in and it appears 
on the History dialog box. 
 

The State property is a workflow property. Unlike other document properties, workflow 
properties are external properties that are saved to the server and do not travel with the 
document. State values are not included when you import or export content. The State field is 
set to blank for new documents imported into the Library. Since State values are saved with a 
document on check in, they are part of a document's version and roll back when you roll a 
document back to a previous version. However, When an author restores a deleted document 
to the Library, the value for the state is also restored. 
 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 
 

To assign a State value to a document: 

1. Make sure you are working online. 

    
2. Check out the document. 

    
3. Display the Properties toolpane. 

    
4. Select the document(s) to which you want to assign a state. 

    
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
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5. In the Workflow category, click  in the State cell. 

    
6. Select a value from the list. 

Note: To remove a value, choose the blank value from the list (first value). 

2.8.2 Assign Document Ownership 

In many enterprises, multiple authors often work together developing content in a team 
environment. Team leaders typically handle large projects by assigning specific development 
responsibilities to authors. The Owner property allows team leaders and authors to assign 
documents to themselves and other authors to track who is responsible for a specific 
document.  

 
You view and change document assignments for a document using the Owner property in the 
Properties toolpane. Document assignments also appear in the Owner column in the Details 
View (and other views) in the Library and Outline Editor. You cannot edit the document Owner 

from a view, but you can sort documents by their owner assignment.  
 
Owner values are set by selecting an author from a predefined Owner list which is populated 

based on the names of the authors defined by your administrator. When the administrator 
deletes an author's name from the system, the name is also removed from the list and the 
Owner property for documents assigned to that author is reset to blank. If the administrator 
renames an author that was assigned to a document, updates to the Owner property occur 
when the document is checked into the server. 
 

Note: The Owner list displays the author's name for Standard Authentication and the author 
name and domain name for Windows Authentication. 
 
You can change the Owner to a single document or to multiple documents at the same time. 
Only one Owner can be set for each document. 
 

To change the assignment of a document, you must be online and the document must be 

either checked in, checked out to you, or checked out to another author. When selecting 
multiple documents, the Owner property is not available if any of the documents in the 
selection are checked out to another author. The Owner is saved as part of the document 
history when the document is checked in. 
 
The Owner property is an external workflow property that is saved to the server and does not 
travel with the document. Therefore, Owner values are not included when you export a 

document. 
 
Note: On import, the Owner value for documents is set to blank, which is the default value. 
 
Owner values are part of a document's version and roll back if you roll a document back to a 
previous version. However, if you delete a document with an Owner value and later restore 

the document, the server also restores the last value assigned to the document. 
  

Note: Owner values are preserved by the server. If you delete a document and then later 
restore it, the server also restores the value. 
 

To assign a document owner: 

1. Make sure you are working online. 

     

2. On the View menu, choose  Properties. 

   
You can also right-click any document and choose Properties. 
     

3. Select the document(s) to which you want to assign document responsibility. 
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You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 

     

4. In the Workflow category, click  in the Owner cell. 

     
5. Select a name from the list. 

2.9 Use and Share Custom Views 
Several custom views of the Library are provided for each author in a multi-user installation. 
Each view is designed to show document attributes that are specific to a multi-user 
environment such as checked out documents, documents by State, documents by Owner 
assignment, and so on.  
 

Each custom view can be customized, copied to create a new custom view, or removed. Any 
new custom view that an author creates can also be shared with another author.  

2.9.1 About the Sample Custom Views 

The following sample custom views are available in a client Developer installation (multi-user 
environment). These views appear on the View toolbar list for each author (if they were not 
deleted from your installation). You can use or modify any of these views or create new views 
to display documents based on custom criteria. You can also reset these views back to the 
original settings if changes were made.  

 All by owner: This view lists all documents in the Library sorted by Owner and 
document Name. Documents appear in a flat view (no folder structure) and display 
Owner, State, Checked Out By, Version, and document Type columns. 
   

 All by state: This view lists all documents in the Library sorted by State and 

document Name. Documents appear in a flat view (no folder structure) and display 
State, Owner, Checked Out By, Version, and document Type columns. 

   

 All checked out: This view lists all checked out documents in the Library sorted by 

the author that has documents checked out (Checked Out By) and document Name. 
Documents appear in a flat view (no folder structure) and display Checked Out By, 
State, Last Modified Date, Version, and document Type columns. This view is useful for 
administrators who want to determine if there are any checked out documents in the 
Library before they perform software upgrades or other maintenance activity. 

   

 Checked out to me: This view lists the documents in the Library that are checked out 
to the author that is running this view. The selected documents are sorted by 
document Name. Documents appear in a flat view (no folder structure) and display 
Checked Out By, Last Modified Date, Version, document Type, and Checked Out 

Hostname columns. 
   

 Deleted documents: This view lists only deleted (but restorable) documents in the 

Library sorted by Owner and document Name. Documents appear in a flat view (no 

folder structure) and display columns for Original Location, Deletion Date, Deleted By, 
and document Type. 
   

 Details view: This view lists all documents in the Library sorted by document Name. 

Documents appear in a folder structure and display columns for Checked Out By, 
Permission Type, Last Modified Date, Version, Type, State, and Owner. 
   

 Lost documents: This view lists documents that are considered "lost" due to 

permission changes or a problem in the Library. The status bar of the Developer 
notifies you when lost documents are detected. When you display this view, you can 
either move the documents to a folder in the Library or delete the documents. 
   



Use the Developer in a Multi-user Environment 

 

 56 

 Owned by me: This view lists the documents in the Library that have been assigned 

(Owner property) to the author that is running this view. The selected documents are 

sorted by document Name. Documents appear in a flat view (no folder structure) and 
display Owner, State, Checked Out By, Version, and document Type columns. 

2.9.2 Share a Custom View 

A custom view is specific to the author that created it. For example, if Author_A creates a view 
called CustomView1, Author_B does not have this view in their list. However, an author can 
share any custom view with another author by distributing a copy of a view file from the local 

cache on their computer. Any author who receives a shared custom view needs to copy the 
view file to the local data storage location on their computer. 
 
You can determine the location of the local data storage location when you create a login 
profile for the first time. The complete path of the local data storage location is displayed on 
the Summary page of the Login Profile Wizard for reference. 
 

To share a custom view: 

1. Navigate to the ViewFilters\<language code> folder in your local data storage location. 
  

2. Copy the XML file with the same name as the custom view that you want to share. 
  

3. Distribute this file to another author and have that person copy the XML file to their 
local data storage location in the ViewFilters\<language code> folder on their 
computer. 
  
The author receiving the shared view should close and restart the Developer to refresh 
their list of views. 

2.10 Understand Content Permissions 
By default, all authors have complete access to all Library folders and all actions that you can 
perform to develop, modify, publish, and export content. However, your administrator can also 
restrict your ability to access content in any Library folder and perform actions on that 
content. An administrator can assign the following permissions: 
 
The following permissions can be set for any folder in the Library: 

 List Folder Contents: Authors cannot save to folders with this permission. An author 
can view the names of documents in a Library folder but cannot open a document in 
any editor and perform actions that would change the document content or its location 
in the Library. An author also cannot make a copy of the document in any way. 
  

 Read: An author can open a document in an editor, but cannot perform any actions 

that would change the document content or its location in the Library. An author can 
make a copy (including Save as) of the document and store it in a folder location to 

which they have appropriate permissions. 
  

 Modify: An author has complete access to the folder and its documents and can 
perform any action (create, modify, copy, delete, publish, export, and so on). 

When an author works in a folder with documents that have List or Read permissions, they are 
alerted when they cannot perform an action due to permission restrictions. Each folder and 
document in the Library (or the Details view of the Outline Editor) displays the active 
permission setting in the Permission column which can appear in any view. 
 

If you need access to a document that has permission restrictions, you should contact your 
administrator to determine whether you can obtain the access that you need. 
 

Also note the following about permissions: 
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 The Permission column only appears in the Details view. You can add this column to 

any other custom view. 

  

 If you move a document from one folder to another, the document inherits the 
permissions of the folder to which it is moved. 

  

 When you create a new folder in the Library, it has no permissions of its own, but 
inherits the permissions from the parent folder. 
  

 Permissions are not preserved on exported content. 

  

 Permissions are enforced when you are working online or offline. 

  

 All authors should have at least Read permission to the System folder or any subfolder 
within it. If an author has List Folder Contents permission to the System folders, 

functions such as publishing/preview, role and template assignment, topic editing and 
recording, attachment icon assignment, assigning styles from a style sheet, and so on, 

do not work. 
  

 If you are working offline and your administrator changes your permissions, the 

changes go into effect the next time you are online. Also note that if you create 
documents in a folder to which you no longer have permissions, these documents do 
not appear in the folder when you connect to the server and work online; instead, they 
appear in the Lost documents view. You can switch to the Lost documents view and 
decide whether to delete the document or move it to a folder in which you have the 
appropriate permissions. Also, if you move a document to a folder in which you no 

longer have permissions, the move is ignored when you connect to the server and 
work online. A message appears on the Developer status bar alerting you when there 
are lost documents in the Library. You can double click on the message to 
automatically display the Lost documents view. 
  

 Permissions have no impact on your ability to assign any author as the Owner. 

Therefore, you could assign an author as the Owner of a document in cases where the 
author may not have access to the document. Authors should be careful to only assign 
ownership to documents that are accessible to other authors. 
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3 Manage the Library 
The Library is used to organize the documents that comprise your content for non-
presentation purposes. You use these documents to create an outline in the Outline Editor for 
presentation to your audience in Player or document formats. 
  
The Library displays two panes that are resizable by dragging the vertical bar to the left or 

right to view more of either pane. The Folders pane on the left shows the hierarchy of folders, 
and the Content pane on the right displays additional folders or the documents that are stored 
in a selected folder. The right pane also displays various folder or document properties such as 
icon and name, document type, and so on. 
  

 Multi-user Considerations 

 As documents are checked in and out, icons appear to the left of the document name 
indicating the check in/out state as follows: 

  

 indicates that the document is checked out to you. 

  

 indicates that the document is locked and checked out to another author. 

  
No icon indicates that the document is checked in and available to any author. 
  
These icons appear in various places such as the Library and Outline Editor as well as 

on document editor tabs and various views. Also note that additional columns in the 
Details view of the Library and Outline Editor display the check in/out state and 
version number. The Checked Out By column displays the name of the author who is 
currently using the document. 

3.1 Library Design Considerations 
Although you can organize the Library in many ways to suit your needs, the following are 
some possible ways to design a folder structure in the Library:  
 
Project centric: Create folders for each project. Within each project you can create 

subfolders for each application within that project. You can further organize within each 
application by the various document types (modules, sections, topics, packages, web pages, 
questions and assessments, and so on). 
 
Application centric: A folder is created for each application, with a subfolder for each 
module. Within each folder are the documents that are linked to that module. 
 

Also consider how you intend to version your content. For example, if you are building content 
for an application, you may want to design your Library folder structure around the version of 
the application and duplicate all your content from version to version. 
 

Author or Team: If you normally divide workload by content author or teams of content 
authors, organizing your Library documents by team may be your best approach. This allows 

multiple authors to quickly see who owns a particular set of content and makes it easy to 
locate your documents. To organize by author or team, create a folder for each content author 
or group of authors. Within these folders you can employ one of the other organization 
methods above to further organize your documents. You may even want to organize by 
locations if you have different groups in different locations working on content. 
 
Document Type: If you are doing a lot of content sharing, you may find it beneficial to 

organize the Library by document type. This allows content authors to focus on specific types 
of content. For example, you may want specific authors creating all of your glossary terms or 
creating the packages that are used by other content authors. Organizing by type may make 
more sense as a second layer of organization. 
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Localization: If you are planning to localize your content, you need to make a complete 
duplicate of the source content before it is translated into the target language. To keep all of 

the different languages organized you should create sub-folders within your content folder 
hierarchy for each language. 

 
One guideline is to keep your Library simple. Do not make overly complex folder structures 
and try to keep the Library between a maximum of three to five levels depending on your 
content. 

3.2 Work with Folders 
The Library displays a series of folders that contain various documents. The System folder, 

created by default, contains a series of folders with the system documents that are part of the 
Developer application. System documents include standard icon packages, publishing styles, 
templates, and master role lists for all supported languages.  
 
You should create additional folders in the Library to organize your content development, 
similar to how you use folders on your computer to organize and manage files. However, keep 

in mind that the folders in the Library are not the same as folders on your computer since 

Developer content is stored in a database and not on a file system. The folders in the Library 
are purely for organization purposes.  

3.2.1 Create a New Folder 

You can create as many folders as you need to store and organize your content. Creating a 
logical folder structure makes it easier to locate documents when building an outline. It is best 
to start with a simple organization for your documents. If you later decide to change your 
folder structure, you can move folders and the documents in them to other folders.  
 

When creating a folder, you can insert it at the root of the Library or nest it as a subfolder in 
another folder. In a folder hierarchy, there are parent folders and child folders. The folder 
currently selected in the Folders pane is the parent folder and the default location for new a 
folder. New folders created as subfolders of a parent are called child folders. Therefore, if you 
want to create a folder at the root level, you must select the / at the highest level of the 

Library. 
 

The following restrictions apply when creating folders: 

 A parent folder cannot contain two subfolders with the same name. 
  

 A folder name cannot be blank. 

  

 A folder name cannot contain special reserved characters. 

Long document names are supported for folders, but folder names are limited to 256 
characters. 
  

 Multi-user Considerations 

 You can create, rename, move, copy, or delete a folder when you are working online 
or offline. The Developer follows specified rules to resolve folder conflicts (see Manage 
Folder Conflicts, Refresh the Library or Outline Editor). When working offline, you can 
only delete folders that are empty or contain new documents that have never been 

checked in. 
  
You do not have to check in or check out a folder. As you create new folders, they are 
created automatically on the server during synchronization or when you check in a 
document saved to that folder. In a multi-user environment, the team leader should 
create the folder structure before authors start creating content. 
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To create a new folder in the Library: 

1. From the Library, select the folder in which you want to create a subfolder, or select 

the root node / of the Library to create a new folder under the root node. 
  

2. On the File menu, point to New and choose Folder. 
  
You can also right-click the folder and choose New Folder. 
  

3. Type a name for the folder (up to 256 characters). 
  

4. Click OK. 

3.2.2 Reserved Characters 

The following characters should not be used in folder names. If you use reserved characters in 
document names, the characters appear in the published Player and document output. 

However, when you publish to document formats such as the Job Aid and Training Guide, the 
documents themselves cannot be saved with these characters in the file name, so they are 
converted to underscores.  

 Back slash \ 
   

 Forward slash / 

   

 Question mark ? 

   

 Less than symbol < 
   

 Greater than symbol > 

   

 Colon : 

   

 Asterisk * 
   

 Double quote ” 

   

 Bar | 

3.2.3 Rename a Folder 

You can change the name of a folder if you decide that the name does not fit the contents. 
The name can be any character length up to 256 characters, but blank names, duplicate 

names, and special reserved characters are not allowed.  
 
Note: A parent folder cannot contain two subfolders with the same name. 
  

 Multi-user Considerations 

 Folders can be renamed in the Library regardless of whether you are working online or 
offline. 
  
The following rules apply when you are working offline and then return to online 
status: if the renamed folder or parent folder is marked for deletion, the folder or 

parent is restored; if the parent folder has been renamed/moved, the renamed folder 
moves to the new location; if the renamed folder has been purged, the folder is 
deleted; if another author also renames the folder, the last rename is used. 
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To rename a folder in the Library: 

1. Select the folder you want to rename in the Folders pane or Contents pane. 

  
2. On the Edit menu, choose Rename. 

  
After selecting a folder, you can also click the folder name or press F2 to start edit 
mode. 

  
You can also right-click a folder and choose Rename. 
  

3. Type the new folder name. 
  

4. Press ENTER to save your changes. 
  
You can also click anywhere outside the name to save your changes. 

3.2.4 Move a Folder 

As you build your Library, you may find that you need to move folders to better organize your 

folder structure. The entire contents of the folder, including documents and subfolders, move 
with the folder. If the documents in the moved folder contain links, the links are not broken 
when the documents move. If you move a folder to a destination with a folder of the same 
name, the contents of the moved folder are merged with the contents of the destination folder 
and the moved folder is deleted.  
 
The destination for a moved folder can be another folder or the root level of the Library. 

Folders can be moved in the Library using drag-and-drop or cut and paste. A cut folder does 
not move until it is pasted; if you do not paste the folder, it remains in its original location. 
 
Note: When merging folders, the destination folder can contain documents with the same 
name; because documents have unique IDs, multiple documents with the same name can 
exist in the same folder. 

 

 Multi-user Considerations 

 You can create, rename, move, copy, or delete a folder when you are working online 
or offline. The Developer follows specified rules to resolve folder conflicts (see Manage 

Folder Conflicts, Refresh the Library and Outline Editor). When working offline, you can 
only delete folders that are empty or contain new documents that have never been 
checked in. 
  
When an author moves a folder, the Developer moves all the documents in the folder, 
even if a document is checked out to another author. 

To move a folder using cut and paste: 

1. Select the folder you want to move in the Folders pane or Contents pane. 

  
You can select more than one folder in the Contents pane using the standard Windows 
selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by 
choosing Select All from the Edit menu. 
  

2. On the Edit menu, choose  Cut. 
  

You can also right-click the folder and choose Cut. 
  

3. Select the destination folder. 
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4. On the Edit menu, choose  Paste. 

  
You can also right-click the folder and choose Paste. 

To move a folder using drag-and-drop: 

1. Select the folder you want to move in the Folders pane or Contents pane. 

  
2. Drag the folder and drop it on the destination folder in the Folders pane or Contents 

pane. 
  

As you drag a folder, a yellow arrow also moves, indicating the selected folder in the 
folder hierarchy. Release the mouse button when the arrow points to the destination 
folder. 

3.2.5 Copy a Folder 

When you copy a folder to another folder in the Library, the Developer creates duplicate copies 
of the entire contents of the folder. If the documents in the selected folder are organized in a 
structure of subfolders, the Developer re-creates the subfolder structure in the copy.  
 
Note: When you paste a folder to the same parent folder, the Developer creates a new folder 
named "Copy of <folder name>". 

 
Copy and Paste 
When you copy a folder that contains documents, you can paste it to create new copies of the 
folder and its contents. The new copies are independent documents that you can edit and 
rename without affecting the original documents. Do not use copy/paste if you are trying to 
create a copy of a content outline, even if all of the documents reside in the same folder. 

 
Copy and Paste Special 
If the copied folder contains parent documents related to child documents, such as a section 

linked to a topic or a topic linked to a web page, you can use the options in the Paste Special 
dialog box to select the type of copy you want to create. Each option produces a different 
result. 

 Copy (selection only) - Choose this option to create a copy of the documents in the 

folder that maintain their links to the original child documents. Therefore, if the copied 
folder contains Section A that is linked to Topic 1 and Topic 2, the Copy (selection 
only) option creates a new Section B that still links to Topic 1 and Topic 2. 
  
If the copied folder contains both parent documents and related child documents, the 
Copy (selection only) option creates copies of all of the documents in the folder, BUT 

the new parent documents maintain their links back to the original child documents, 
not to the newly created documents. 
  

 Duplicate (selection and related) - This option creates duplicate copies of the 

parent documents and all related child documents, even if they are not stored in the 

folder. The links between new copies are updated so that new parent documents link 
to new child documents. The Duplicate option breaks all links to the original 
documents and creates an entirely new replica of the original. If the copied folder 
contains Section A that is linked to Topic 1 and Topic 2 (which can reside in any 
folder), the Duplicate (selection and related) option creates new copies of all of the 
documents and related documents and links the new Section B to new Topic 3 and 

new Topic 4. 
  
When duplicating content, you can choose to include or not include duplicate copies of 
the glossaries and style sheets linked to the selected content. If you do not include 
glossaries and style sheets in the duplication, the duplicated content links to the 
glossaries and style sheets linked to the original source content; this allows you to 
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maintain a master glossary and style sheet for all related content. The default setting 
for glossaries is to create a duplicate since you may want to change the definition of 

terms for new versions of your content without affecting previous versions. The default 
setting for style sheets is to not duplicate, with the purpose of linking all content to a 

single style sheet.  
  
Note: The Duplicate (selection and related) option does not create copies of 
templates, master role lists, sound files, and custom icon packages. The new copies 
still point to the original documents for those components. 
  
When duplicating a folder with related documents, the Developer creates a copy of the 

source folder structure for each related document. If the content in the source folder 
links to documents outside of the source folder structure, the duplication process 
creates an Additional Related Documents folder for those document copies. 

 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 

To copy a folder using Copy and Paste: 

1. Select the folder you want to copy in the Folders pane or Contents pane. 

  
You can select more than one folder in the Contents pane using the standard Windows 

selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by 
choosing Select All from the Edit menu. 
  

2. On the Edit menu, choose  Copy. 

  

You can also right-click the folder and choose Copy. 
  

3. Select the destination folder in the Folders pane. 
  

4. On the Edit menu, choose  Paste. 

  
You can also right-click the folder and choose Paste. 

To copy a folder using drag-and-drop: 

1. Select the folder you want to copy in the Folders pane or Contents pane. 

  
2. Hold CTRL and drag the folder to the destination folder. 

  
3. Release the mouse button and then the CTRL key. 

To copy a folder using Copy and Paste Special: 

1. Select the folder you want to copy in the Folders pane or Contents pane. 

  
You can select more than one folder in the Contents pane using the standard Windows 
selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by 

choosing Select All from the Edit menu. 
  

2. On the Edit menu, choose  Copy. 
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You can also right-click the folder and choose Copy. 

  

3. Select the destination folder in the Folders pane. 
  

4. On the Edit menu, choose Paste Special. 
  

5. Choose Copy (selection only) to create a new copy of the selection only and 

maintain links to the original related documents or Duplicate (selection and 
related) to create a new copy of the selection and all related documents and create 
the links among the copies. 
  
For the Duplicate (selection and related) option, choose Duplicate Glossaries and 
Duplicate Style Sheets to link the new copies to duplicate copies of those document 
types. 

   
6. Click OK. 

3.2.6 Delete a Folder 

If you find that you no longer need a folder, you can delete it from the Library. Deleting a 
folder deletes the entire contents of the folder, including all documents and subfolders. A 
Confirm Delete dialog box opens prompting you to confirm your deletion.  
 

If the folder you are deleting contains documents that are linked to other documents stored in 
another folder, you are prompted with the choice of deleting the selection only or the selection 
and all related documents in other folders. Clicking the View related documents link displays a 
list of the related documents. 
 

Selecting Cancel during the deletion process displays a message with a link to view the 
documents that have already been deleted. 
 

Note: If a document in a deleted folder is linked to an outline, the link is broken and a 

 Missing Document link appears in its place in the outline. 
 

Warning! Folder deletions cannot be undone. 
 

 Multi-user Considerations 

 You can delete a folder only when all of the documents in it can also be deleted. 
Documents under version control must be checked in and you must be working online 
to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 
  
Deleted documents under version control that are used in an outline continue to 
appear in the outline as broken links. You can either remove these broken links from 

the outline or restore the deleted documents as long as the administrator has not 
purged them. 
  

If you delete a folder that contains a mixture of checked in and checked out 
documents, the checked in documents are deleted, and the checked out documents 
and the folder remain in the Library. 

  
You can create, rename, move, copy, or delete a folder when you are working online 
or offline. The Developer follows specified rules to resolve folder conflicts (see Manage 
Folder Conflicts, Refresh the Library and Outline Editor). When working offline, you can 
only delete folders that are empty or contain new documents that have never been 
checked in. 
  

Deleted documents that have been checked in to the Library can be restored if they 
have not been purged by your Administrator. New documents that have never been 
checked in cannot be restored. Restoring a document that was part of a deleted folder 
restores the document and the folder. 
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To delete a folder: 

1. Select the folder you want to delete in the Folders pane or Contents pane. 

  
You can select more than one folder in the Contents pane using the standard Windows 
selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by 
choosing Select All from the Edit menu. 
  

2. On the Edit menu, choose  Delete. 
  
You can also press DELETE or right-click the folder and choose Delete. 

  
3. If prompted that one or more documents are not restorable, click Yes to complete the 

action or No to abort. 
  
The Related Documents dialog box appears when you perform an action on any 
document that has links to other documents. You can choose to process only the 

document(s) you selected or to process your selection and all of the related 
documents. 
  
Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. 
  
After you have made your selection, click OK. 

  
You might also receive a message if some documents could not be processed because 
of other constraints. You can click OK to close the message box or click the View 
activity log link to view the results of the action. 

3.2.7 Expand and Collapse Folders 

When the Library opens, only the top level folders appear in the Folders pane. The Folders 

pane, which appears in the left pane in the Library, displays the folder hierarchy in a tree 
view. When you select a folder in the folder tree, its contents appear in the Contents pane to 
the right.  
 

Expand/collapse symbols (+/-) appear next to folders that contain subfolders. A plus (+) 

symbol means that the folder is collapsed and the subfolders are hidden in the folder tree. A 
minus (-) symbol means that the folder is expanded and the subfolders appear in the folder 
tree. 
 

Note: When selecting folders, you can select a single folder in the Folders pane and multiple 
folders in the Contents pane. 
 

To expand and collapse folders: 

1. Click the  (plus symbol) in the folder tree to expand a folder. 

  
You can also double-click a parent folder in the left or right pane to expand it. 
  

2. Click the  (minus symbol) in the folder tree to collapse a folder. 

Note: You can also press ENTER to expand and collapse the selected folder in the Folders 

pane (left pane) or open the selected folder in the Contents pane (right pane). 

3.2.8 Print Library Folder Contents 

You can print a report listing the contents of any folder in the Library. Included in the report is 
a list of folders or documents as well as the columns in the active view. To print the contents 
of a folder you must first select the folder from the Library. You can also customize a view to 
display a flat list of documents in the Library.  
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Note: The report does not honor column sizes that appear in the active view. You can change 

the page orientation or adjust the margins to modify the column sizes, or save the report to 
Microsoft Excel and adjust the columns there. 
 
The report opens in a new window. Use the following toolbar icons to print the report, 
configure printer settings, export the report to file or graphic format, and so on. 
  

 Searches the report for specified text. 

  

 Displays the current printer settings such as the active printer, status, page range, number 

of copies, and so on. 
  

 Prints the report to the active printer. 

  

 Displays the current page setup such as paper size, orientation, and margins that you can 

change. 

  

 Displays scaling options such as scaling by a percentage of normal size and Fit to pages 

options. 
  

 Scrolls the report. 

  

 Zoom Out. You can also enter a Zoom Factor percentage to zoom in or out. 

  

 Zoom In. You can also enter a Zoom Factor percentage to zoom in or out. 

  

 Move to the First Page. 

  

 Move to the Previous Page. 

  

 Move to the Next Page. 
  

 Move to the Last Page. 

  

 Saves the report to PDF, HTML, Excel, or graphic format. Your selection displays additional 

options based on the file type you selected. 
  

 Close Preview. 

  

To print folder contents from the Library: 

1. Open a folder to display its contents in the right pane of the Library. 

  

2. On the File menu, choose Print and use the toolbar icons to print, view, or save the 
report to a file. 

3.3 Work with Documents 
Your content is constructed by creating and linking various documents. The way you add, edit, 

delete, find, and save documents is very similar regardless of the document type.  

3.3.1 Create a New Document 

You can create a new document from the Library. Icons to create each document type are on 
the Library toolbar or under New on the File menu. The new document launches in the 
appropriate document editor in a new tab.  
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Note: You can also create new documents from the Outline Editor using New on the File 
menu. New documents created this way are saved to the Library, not linked to the outline. 

 
Each document type has an icon associated with it that appears next to the document name in 

the Library and Outline Editor. For example, the icon for a module is a purple book and the 
icon for a topic is a piece of paper with a yellow text bubble. 
 
Module and section documents perform the same functions and contain the same document 
properties. Modules and sections do not inherently contain content. They are used to link 
documents together to create the hierarchy for an outline. 
 

There is no difference between a module or section document in an outline. You can create a 
hierarchy using all module documents, all section documents, or a combination of the two. The 
two document types are represented by different icons so that you can easily identify them. 
For instance, to visually differentiate the structure of your content, you can use modules for 
the highest levels in your outline and sections for sublevels. 
  

For more information about creating other new document types from the Library, see Create a 

Glossary in the Define Glossary Terms chapter, Create a New Web Page in the Enhance 
Content with Web Pages chapter, Develop Questions in the Enhance Content with Questions 
and Assessments chapter, Create a New Assessment under Design Assessments in the 
Enhance Content with Questions and Assessments chapter, and Work with Style Sheets in the 
Create Styles to Format Content chapter. 
  

 Multi-user Considerations  

 Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 

3.3.1.1 Create a New Module or Section 

You can create a new module or section document from the Library or any document editor. 

After you create and save the module/section, it opens in the Outline Editor, where you can 
link documents to it and build your outline.  
 
When you create a module/section, the New Module or New Section dialog box opens giving 
you the opportunity to set certain document properties. Most of the default properties that 

appear are inherited from the settings in Tools, Options. Module and section documents 
contain the same properties. You can change the properties when you create the 
module/section or change them later. However, because all new documents that you 
create/link to the new module or section in the Outline Editor inherit its property settings, it is 
a good idea to set the necessary properties when you first create the new module/section. 
  
Tip: If you want all of the documents in a new outline to use the same glossary and style 

sheet, you should assign them to the root document of the outline. 
 
A module/section has the following default properties that you can change: 

 Name: A descriptive name for the document. 
  

 Location: The folder location in the Library where this document is stored. The default 

folder that appears depends on where you are when you create the new document, as 
follows: 
  
If you create a new document from the Library, the default folder is the folder that is 

selected in the Library when you create the new document. 
  
If you link a new document from the Outline Editor, the default location is the same as 
the location of the parent document to which you are linking the new document. 
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 Language: The Language option allows you to choose the default dictionary that is 

used to check the spelling of a document's content. 

  

 Template: The Template option allows you to select another folder of template files. 

The template sets included with the Developer are the Standard and Microsoft 
templates. The Microsoft template conforms to the standards as stated in the Microsoft 
Manual of Style for Technical Publications. In addition to these templates, other 
template sets may be available to you. Alternate template sets are most useful when 
you are creating content for more than one application. Please contact Technical 

Support for more information on this option and its implementation. 
  

 Glossary: The Glossary option allows you to choose the glossary to assign to the 
document. The glossary document is a document that lists the words you have 

assigned as glossary terms. After you have set up the glossary terms and their 
definitions, the Developer can automatically create the links to the terms found in any 
document text. 
  

 Style Sheet: The Style Sheet option allows you to assign a style sheet to the 

document. The style sheet document contains the styles used to control the 
appearance of web page text, paragraphs, lists, tables, and images. 
    

 Screen Resolution: The Screen Resolution option allows you to determine the 

resolution in which the topic content is recorded. If authors attempt to record in a 
resolution other than the one listed in the Screen Resolution list box, a message 
informs them that their resolution does not match the topic setting and indicates in 
what resolution they should record. While content authors are not prevented from 
recording in a different resolution if they choose, this option helps create greater 
consistency in the content. 

  
Please note that the Developer detects the current resolution of your computer and 
automatically sets the screen resolution property to match when you create new 
documents. Once screen resolution for a topic is set and you have saved a recording; 
the screen resolution cannot be changed. 

To create a new module or section document in the Library: 

1. Select the folder where you want to store the document. 

  

2. On the File menu, point to  New and choose  Module or  Section. 
   
or 

 

On the Library toolbar, choose  Module or  Section. 
  

3. Type a name for the new document. 
  

4. To change the folder in which the document is stored, type the folder path in the 
Location field or click Browse, select a different folder, and click OK. 

  
When browsing for a folder, you can use the Make New Folder button to create a new 
subfolder in the currently selected folder. 
  

5. Choose the properties for the new document. 
  

6. Click OK. 
  
The module or section opens in a new tab in the Outline Editor. 
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Important Note about Module and Section Documents: A module or section document 
appears with a purple or blue book only when the document has at least one linked child 

document such as a topic or another module or section. However, a module or section 

document with no linked child documents appears with a page icon such as  for module and 

 for section. New modules or sections appear as page icons until you link at least one 

additional child document, which changes the page icon to a book icon. 

3.3.1.2 Create a New Topic 

Topics are the documents in which you record the steps (and sound, if applicable) of a task or 
transaction in an application. You can create a topic in the Library, or while working on an 
outline in the Outline Editor.  
 
When you create a topic in the Library, the Recorder automatically launches for you to capture 
the topic steps. After finishing the recording, the new topic opens in the Topic Editor. From the 
Topic Editor, you save the topic by naming it and selecting a folder in the Library in which to 

store it. Unlike module and section documents, you do not set properties for a topic when you 
create it. You can however, change the properties for a topic at any time. 

 
The icon for a topic is a piece of paper with a yellow text bubble. To visually differentiate 
between recorded and blank topics, the topic icon for topics with recorded content appears 
with lines on the paper and bubble and for blank topics as a blank paper and bubble. 
  

Note: The Recorder does not launch when you create a new topic in the Outline Editor by 
linking it to an outline. When you name the topic, it is saved automatically to the same folder 
as the parent document. 
 

To create a new topic in the Library: 

1. Select the File menu, point to  New and choose  Topic. 

  
or 

  

On the Library toolbar, choose  Topic. 
  

2. When the Recorder opens, record the steps (and sound, if applicable) of the topic. 
  

3. When you are done recording the steps, click Finish in the Recorder window. 
  

4. To save the topic from the Topic Editor, select the File menu and choose Save. 
  

5. In the Save As dialog box, type a name for the new topic. 
  

6. Navigate to the folder where you want to store the topic. 
  

7. Click Save. 

3.3.2 Save a Document 

As you modify a module or section in the Outline Editor, the Developer automatically saves 
your changes. However, when you open other editors to modify a document such as a topic, 

package, web page, glossary, role, assessment, or question, you need to save the changes. If 
you have not saved your latest changes when you close the document editor, a message 
opens asking if you want to save the document.  
 
The first time you save a document, the Save As dialog box opens allowing you to name the 
document and select a folder for storing the document. The Save As dialog box automatically 
filters the document display for the document type you are saving. However, if you want to 

see the names of all documents stored in a folder, you can use the Type field to view all 
documents. Once a document has been saved, its name appears in the document editor tab. 
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Subsequent saves do not display the Save As dialog box; instead, your changes are saved to 

the existing document. 

 
Note: By default, the Developer automatically creates a temporary backup copy of any open 
document every 10 minutes if a change has occurred. This option can be disabled or the time 
interval between autosaves can be changed in the Autosave section of the Library category on 
the Options dialog box. 

 

Naming Documents 

Each document in the Library is identified with a unique Document ID made up of a long series 
of letters and numbers, such as 3c4c7b1a-a50a-4d54-3719c6b47732. No two documents in 
the Library have the same Document ID. When you save the document, you give it a 
meaningful name, one that identifies its contents or use. There are no restrictions on the 

length of the name or on the characters used. You can use any combination of letters, 
numbers, special characters and spaces to name a document. Since the Developer treats this 
name as a property of the document and does not use this name to identify the document, a 
folder can contain multiple documents with the same name. 

 

Save As 

The Save As command provides the opportunity to create a copy of a document by opening 
the Save As dialog box, where you can give the document a new name and select a folder in 
which to store the document. This creates a new document identical to the original, with all 
links to the original document preserved in the new copy. For example, if a topic is linked to a 
web page, and you save the topic with a new name, the new copy is also linked to the same 
web page. The Save As command is available in any document editor except the Outline 
Editor. You cannot use Save As to create a new copy of an outline or section document. To 

create copies of these documents, you can use copy and paste. 
 
Warning! Using Save As to save a document with the same name and to the same folder 
creates a copy of the original rather than overwriting it. You are prompted that a document 
already exists at the save location and that saving will create a new document. 
 

 Multi-user Considerations 

 When you save a checked out document, it is saved to your data storage location 
regardless of whether you are working online or offline. You must check the document 
in to insure that the server has the most recent copy. A new document is not added to 

the server until you check it in. If a document has never been checked in, your local 
copy is the only copy of that document. 
  
If you click the Keep checked out option on the Check In Comment dialog box during 
check in, the content is checked in and the version number incremented by 1 but the 
document remains checked out and unavailable for editing by other users. 
  

Open documents display check in/out indicators in the document editor tab. While you 
can edit a checked in or locked document, you cannot save your changes to the 
original document. 

  
If you edit a document that you did not check out (in other words, a checked out 
document was opened in Read-Only mode and edited) and you want to save the 
changes, you may still be able to save it. If you have access rights to the document 

and it has not been checked out by someone else, you are given the option to save 
the changes to the original document name. If you choose to save the changes, the 
document is checked out and the changes are saved. If you do not want to save the 
changes to the original document, you can save the document as a different document 
name or you can abandon the changes without saving. 

Note: Saving changes to a document that is not checked out to you is not a recommended 
best practice. This functionality is designed to allow you to save changes to a document that 
was unintentionally edited in Read-Only mode. 
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To save a document: 

1. On the File menu, choose  Save. 
  

2. Type a name for the document. 
  

3. Navigate to the folder where you want to store the new document. 
  
You can use the Save in list and the icons in the dialog box to navigate folder levels. 

Click  to create a new subfolder in the currently selected folder. 

  
4. Click Save. 

Note: You can also open an existing document and use Save As on the File menu to save a 
copy of the document with a new name and/or to another folder. 
 

Note: If you split the layout of the work area, you must first activate the pane containing the 

document before saving it. The tab of the active pane shows the document name in bold text, 
while the text is not bold in the inactive panes. 

3.3.3 Open a Document from the Library 

Opening a document launches the appropriate document editor in a new tab. The document 
editor that launches depends on the type of document that you open. For example, when you 
open a module or section, the Outline Editor launches in a new tab. Opening a package or web 
page launches the Package or Web Page Editor in a new tab. When you open a topic 

containing recorded content, the Topic Editor launches. However, opening a topic that contains 
no recorded content launches the Recorder. Documents that open in tabs appear as the last 
tab on the right in the Developer window. 
 
You can open a document from any view in the Library or Outline Editor, or use the options in 
the Open dialog box, which allow you to navigate and filter Library folders for specific 

document types. You can open multiple documents at the same time from the Library or 

Outline Editor, with each document opening in its own editor. You cannot, however, open two 
unrecorded topics at the same time because the Developer can launch only one instance of the 
Recorder. 
 
Note: You can also open documents from the Start Screen, which appears when you start the 
Developer. 
 

 Multi-user Considerations 

 If you open a document that is not checked out to you, it opens in Read-Only mode. If 
you decide to make any changes to a Read-Only document, upon exit you are given 
the option to save the document (check out and save the changes), save it as a new 
document, or discard the changes. 

To open a document: 

1. To open a single document, double-click the document. 

  
You can also press ENTER to open the selected document. 

  
2. To open multiple documents, select the document(s). 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select 
All from the Edit menu. 
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3. Right-click any document in the selection and choose Open. 

  
You can also press ENTER to open all selected documents. 

To open documents using the Open dialog box: 

1. Select the document(s). 
  

2. On the File menu, choose  Open. 
  

3. In the Open dialog box, navigate the Library to the folder containing the document you 

want to open. 
  
You can use the Look in list or the icons in the dialog box to navigate folder levels. 
  

4. To filter the document display, select the document type from the Type list. 

  

To remove the filter, select All types from the Type list. 
  

5. Select the document to open. 
  

6. Click Open. 

Note: To open a document from the Start Screen, click a link for a recently opened outline or 
click the Document link to open the Open dialog box. 

3.3.4 Close a Document 

Closing a document removes the tab from the work area. When you close a document, you are 
prompted to save if the document has changed. The Outline Editor does not prompt you to 

save your changes when you close since the Outline Editor automatically saves changes.  
 

After you close a document, the next tab to the right of the closed tab becomes the active tab. 
However, if there are no document tabs to the right of the tab you are closing, the tab to the 
left becomes the active tab. 
 

To close a document: 

1. Click the document tab that you want to close. 

  
2. On the File menu, choose Close. 

  

You can also right-click a tab and choose Close, or press CTRL+F4, or click . 

Note: Choosing Close from the File menu in the Library closes the Library. You can reopen the 
Library by choosing Library from the View menu. 

3.3.5 Delete a Document and Related Documents 

You can only delete a document from the Library. Deleting a document from the Outline Editor 

removes the link between documents, but does not delete the document from the Library. You 
cannot restore deleted documents in a single-user installation. The Developer alerts you when 
you delete a document that cannot be restored.  
 
If you attempt to delete a document from the Library that is used by other documents, you 
have the choice to delete the selection only or the selection and all related documents. 
Clicking the View related documents link displays a list of the related documents, their 

locations, and document type. The related documents list includes the direct and indirect links 
for each parent document selected. The direct links are the child documents that are linked to 
the deleted document, and the indirect links are the child documents that are linked to those 
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documents. For example, consider a section that is linked to a topic, whose concept is linked 
to a web page. Deleting this section with related documents not only deletes the topic, but 

also deletes the web page linked to the topic. However, the Developer does not delete a 
document that is also linked to another parent not related to the deletion. 

 
Note: When deleting a parent document with its related documents, the following document 
types are not included as related documents and are not deleted: sound packages, icon 
packages, templates, glossary documents, and style sheets. You can delete sound packages, 
icon packages, templates, glossary documents, and style sheets directly from the Library. 
When you delete a glossary document, the web page and package documents linked to it are 
not deleted unless you choose the delete with related option. Although you can create and 

store additional documents in the System folders, be aware that packages stored in those 
folders are not included as related documents for many actions, including deletion. When 
performing an action with related documents, you can use the View related documents link to 
see which documents are included. 
 
Warning! When you delete a package as a "related document", you delete the entire package 

and all of the files it contains, even if only one file of a multi-file package is linked to the 

document(s) selected for deletion. 
 
When you delete a document in the Library that is directly linked to an outline, the document 

is removed from the outline and a  Missing Document link appears in its place. You can 

delete this link in the outline as well. 
 
Note: You cannot delete a document if it is open in another document editor. For example, 
you cannot delete a section from the Library that is currently open in the Outline Editor. When 
deleting an open document, you are prompted to close the document in the other editor. 

 
In some instances, you may have problems deleting a document if it was previously linked to 
an outline that is currently open in the Outline Editor. If Developer cannot delete the 
document, close the outline and try deleting the document again. 
 

 Multi-user Considerations 

 Documents under version control must be checked in and you must be working online 
to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 
  

Deleted documents under version control that are used in an outline continue to 
appear in the outline as broken links. You can either remove these links from the 
outline or restore the deleted documents as long as the administrator has not purged 
them. 
  
Deleted documents that have been checked in to the Library can be restored if they 
have not been purged by your Administrator. New documents that have never been 
checked in cannot be restored. 

To delete a document: 

  

Note: Before deleting a document, you must close it if it is open in a document editor. 

1. In the Library, select the document that you want to delete. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select 
All from the Edit menu. 
  

2. On the Edit menu, choose  Delete. 

  
You can also press DELETE or right-click the document and choose Delete. 
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The Related Documents dialog box appears when you perform an action on any 

document that has links to other documents. You can choose to process only the 
document(s) you selected or to process your selection and all of the related 
documents. 
  
Click the View related documents link to display a list of the related documents if you 

are not sure whether you want to include related documents. 
  
After you have made your selection, click OK. 
  
You might also receive a message if some documents could not be processed because 
of other constraints. You can click OK to close the message box or click the View 
activity log link to view the results of the action. 

3.3.6 Rename a Document 

You can rename any document from the Library. From the Outline Editor, you can rename a 

module, section, or topic document, or an assessment or question directly linked to the 

outline.  
 
Document names do not have to be unique. Since documents are identified by their ID, two 
documents with the same name can exist in the same Library folder or outline. 
 
Note: You can also rename a document using the Name property in the Properties toolpane 
(General category). However, you cannot rename multiple documents at the same time using 

this toolpane. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 

any changes, you should check in the document to make it available to other authors 

and add the changes to the Developer's version control system. 
  
The Developer preserves the name of versioned documents. When you roll back a 
renamed document to a previous version, the document name rolls back as well. 

To rename a document: 

1. Click the document that you want to rename. 

  
2. On the Edit menu, choose Rename. 

  
After selecting a document, you can also click the document name or press F2 to start 
edit mode. 

  
You can also right-click a document and choose Rename. 

  
3. Type a document name. 

  
4. Press ENTER or click anywhere outside the name to save your changes. 

3.3.7 Move a Document (Library) 

As you work with documents in the Library, you may find that you need to move them to 
another folder due to a change in your folder structure or because the document was saved to 
the wrong folder. When you move a document to another folder, all links to modules, sections, 

assessments and other documents are maintained. Because each document is assigned a 
unique ID, you can move the document into a folder that already contains a document with 
the same name. You can move a single document or multiple documents to another folder 
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using drag-and-drop or cut and paste. A cut document does not move until it is pasted. If you 
do not paste the document, it remains in its original location.  

 
In addition to moving documents within the Library, you can also move documents from the 

Library to an outline, within an outline, and from one outline to another. Dragging a document 
from the Library into an outline links the document to the outline, but does not physically 
move the document from its original folder. Moving documents within an outline or to another 
outline, unlinks the document from its current location in an outline and relinks it to its new 
location in an outline. 
 
Note: A summary message appears if some of the documents you selected could not be 

processed. Clicking the View activity log link in the message displays a list of the results for 
each document. 
 

 Multi-user Considerations 

 You can move a document to another folder regardless of its check in/out state. If you 

move a document while working offline, the move does not appear in the Library until 
you switch to online mode. 
  
You can move a locked document (one checked out to another author) to another 
folder in the Library. Note that documents can be moved at any time, even while the 

document is open in the checked out author's Library. When the author closes the 
moved document, it appears in the new location after a server refresh. 

To move a document in the Library using cut and paste: 

1. Select the document you want to move. 
  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select 

All from the Edit menu. 
  

2. On the Edit menu, choose  Cut. 

  
The icon for the document appears shaded until the document is pasted. 
  
You can also right-click your selection and choose Cut. 
  

3. Select the destination folder in the Folders pane. 
  

4. On the Edit menu, choose  Paste. 

  
You can also right-click the folder where you want to move the document and choose 
Paste. 

To move a document in the Library using drag-and-drop: 

1. Select the document you want to move. 

  
2. Drag the document and drop it on the destination folder. 

  
As you drag a document, a yellow arrow also moves, indicating the selected folder in 
the folder hierarchy. Release the mouse button when the arrow points to the 
destination folder where you want to move the document. 
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3.3.8 Copy Documents in the Library 

You can copy documents from one folder in the Library to another. When you create a copy of 

a document, the Developer creates a new document with a new Document ID. The new copy 
and the original source document are not directly linked, so you can make changes to the copy 
without affecting the source. For example, you may want to copy a topic if two tasks are 
almost identical except for the final frames. You can record the first topic, create a copy of it 
with a new name, and then change the copy by re-recording the final frames.  
 

Paste vs. Paste Special 
There are two paste commands in Developer for copied documents; Paste and Paste Special. If 
the copied document is a parent linked to other related child documents, it is important to 
choose the paste command that gives you the desired results. Examples of a parent document 
include a module or section linked to a topic, web page, package, glossary, assessment or 
question; or a topic linked to a web page, package, or glossary. 

 
Note: Before copying a document, it is a good idea to check the document links in the Related 
Documents toolpane. 

3.3.9 Copy and Paste (Library) 

You can create copies of documents in the Library using copy and paste and drag-and-drop. 
Copying a document creates a unique document, with a new Document ID. After creating the 
copy, you can edit or rename it without affecting the source document.  
 

If the original document links to other documents, the Developer breaks or maintains the links 
in the copy depending on the direction of the link. Pasting a copy maintains the links that go 
down the hierarchy (from parent to child) and breaks the links that go up the hierarchy (from 
child to parent). 
 
Note: Before copying a document, it is a good idea to check the document links in the Related 
Documents toolpane. 

 
The following describes how using Paste to create a copy in the Library affects document links. 

 
Original document links to a parent. 

 The link is broken. The new copy does not link to the source document's parent. 
  

Example: Topic1 links to SectionA 
  
Result: Topic1_copy not linked to SectionA 

Original document links to child documents. 

 The new copy links to the source document's children. 
  
Example 1: Section A links to Topic1 and Topic2 

  
Result 1: SectionA_copy maintains links to Topic1 and Topic2 

  
Example 2: Topic1 links to Web page1 
  
Result 2: Topic1_copy links to Web page1 

Original document is both a child document linked to a parent and a parent 
document linked to child documents. 

 The new copy does not link to the source document's parent, but links to the source 
document's children. 
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Example: SectionA links to parent ModuleA, and in turn, links to child documents 
Topic1 and Topic2 

  
Result: SectionA_copy not linked to ModuleA, but maintains links to Topic1 and Topic2 

Note: See Copy and Paste Special for information about creating a true replica where the 
parent and its children are copied and links are created to the new copies. 

 
Note: Copying a document from the Library and using Paste in the Outline Editor, does not 
create a new document. Paste in the Outline Editor creates a link to the original document. 
You cannot copy a document from the Outline Editor and paste it into the Library. 
 

 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 

To copy a document using Copy and Paste: 

1. In the Library, select the document you want to copy. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select 
All from the Edit menu. 
  

2. On the Edit menu, choose  Copy. 
  
You can also right-click the document and choose Copy. 

  
3. Select the destination folder in the Folders pane. 

  

4. On the Edit menu, choose  Paste. 

  
You can also right-click the folder and choose Paste. 

To copy a document using drag-and-drop: 

1. In the Library, select the document you want to copy. 

  
2. Hold CTRL and drag the document to the destination folder. 

  
3. Release the mouse button and the CTRL key. 

3.3.10 Copy and Paste Special (Library) 

If the document you are copying is a parent to related documents (child documents), you can 
use the options in the Paste Special dialog box to create two different paste scenarios.  
 

Copy (selection only)  

The Copy (selection only) option creates a new copy of all of the selected documents. 
However, the new copies of parent documents link to the original child documents, even when 
the child documents are included in the selection. For example, if you include a parent 
document and its related child documents in the copy selection, the Copy (selection only) 
option creates copies of all of the documents you copied, BUT the new parent documents 
maintain their links back to the original child documents, not to the newly created child 
documents. 
 



Manage the Library 

 

 78 

Note: When copying within the Library, the Copy (selection only) option provides the same 

results as using the Paste command. 

 

Duplicate (selection and related) 

The Duplicate (selection and related) option creates new copies of the entire selection and all 
related documents, even if you did not include the related documents in your copy selection. 

The Developer updates the links so that the new parent documents link to the new child 
documents. 
  
When you create a duplicate copy of a selected document or documents, the Developer 
creates new copies of all the documents and the documents related to the selection, including: 

 Modules 
  

 Sections 
  

 Topics 

  

 Web pages 
  

 Packages 
  

 Assessments 

   

 Questions 

   

 Glossaries (selectable) 
   

 Style sheets (selectable) 

When duplicating content, you can choose to include or not include duplicate copies of the 

glossaries and style sheets linked to the selected content. If you do not include glossaries and 
style sheets in the duplication, the duplicated content links to the glossaries and style sheets 
linked to the original source content; this allows you to maintain a master glossary and style 
sheet for all related content. The default setting for glossaries is to create a duplicate since 
you may want to change the definition of terms for new versions of your content without 
affecting previous versions. The default setting for style sheets is to not duplicate, with the 

purpose of linking all content to a single style sheet. 
  
Note: Packages stored in the System folders installed with the Developer are not included as 
a related document when duplicating content. The Duplicate (selection and related) option 
does not create copies of templates, master role lists, sound files, and custom icon packages 
linked to the copy source. The new copies still point to the original documents for those 
components. 

  
To create a duplicate copy of an outline, you only need to select the highest-level document. 
The Developer automatically compiles a list of all related documents to include in the copy. For 

the highest-level parent document, the Developer creates the folder structure and 
substructure. Related documents that do not exist in the folder structure are copied to a new 
folder named Additional Related Documents.  

  
Note: Duplicating an assessment that contains content linked to questions through the 
assessment's Associated Content property, creates duplicate copies of the assessment and 
question documents, plus all documents directly and indirectly linked to the questions; 
modules, sections, topics, web pages, packages, and so on.  
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 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 

want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 

To copy documents using Copy and Paste Special: 

1. In the Library, select the document you want to copy. 
  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select 
All from the Edit menu. 
  

2. On the Edit menu, choose  Copy. 

  

You can also right-click the document and choose Copy. 
  

3. Select the destination folder in the Folders pane. 

  
4. On the Edit menu, choose Paste Special. 

  
5. Choose Copy (selection only) to create a new copy of the selection only and 

maintain links to the original related documents or Duplicate (selection and 
related) to create a new copy of the selection and all related documents and create 
the links among the copies. If you choose Duplicate, you can click the View related 

documents link to display a list of the related documents if you are not sure whether 
you want to duplicate related documents. 
  
For the Duplicate (selection and related) option, select Duplicate Glossaries and 
Duplicate Style Sheets to create new copies of those document types that link to the 

new copies of the content. Leave the options unchecked if you want the new copies to 

link to the original glossaries and style sheets. 
   

6. Click OK. 

3.4 View Folder Content 
When working in a view in the Library, you can select a folder in the Folders pane on the left 
and the contents of the folder appear in the Contents pane on the right. To open a subfolder of 
a parent, you can either select it from the expanded folder tree or double-click the folder 
name in the Contents pane.  
 

A view displays the properties for the documents in the selected folder in a grid arrangement. 

The grid displays a column heading for each property. The active view appears in the View 
toolbar. You can customize the view by sorting the contents by another property and 
rearranging and resizing the columns. The Name column appears by default as the first 

column on the left in the grid. This column displays the document name and an icon denoting 
the document type. 
 

When working with a large amount of documents and properties, you may want to resize the 
panes by dragging the split bar between the Folders pane and Contents pane. You can also 

explore different parts of the Library by splitting the work area into a horizontal or vertical 
layout. Horizontal and vertical scroll bars appear in the view when the contents exceed the 
dimensions of the pane. 
 

Changes to the active view are preserved, so that the next time you open the Library, you see 
the same view. Using the same procedures, you can customize any view. However, each view 
must be customized separately. You can also customize a view using the Manage Views 

command on the View menu. 
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Document Count 
When working in a view in the Library, a Count in View appears on the status bar. This allows 

an author, at a glance, to see the amount of content in the selected view. The objects that 
appear in the count depend on the selection set. When selecting a folder in the left pane, the 
count displays the number of objects that appear in the right pane. When selecting in the right 
pane, the count displays the number of objects selected. For example, if you selected a folder 

(with three documents under it) and a document, the count would display two objects, one for 
the document and one for the folder. If your display is in a flat view, the count displays the 
number of objects selected. If nothing is selected, count displays the total of all objects in the 
view. 
 

 Multi-user Considerations 

 As documents are checked in and out, icons appear to the left of the document name 
indicating the check in/out state as follows: 
  

 indicates that the document is checked out to you. 

  

 indicates that the document is locked and checked out to another author. 

  
No icon indicates that the document is checked in and available to any author. 
  
These icons appear in various places such as the Library and Outline Editor as well as 
on document editor tabs and various views. Also note that additional columns in the 

Details view of the Library and Outline Editor display the check in/out state and 
version number. The Checked Out By column displays the name of the author who is 
currently using the document. 

3.4.1 Sort Documents 

By default, items in the Contents pane are sorted by the Name column in ascending order. 
Clicking on a column heading sorts the items by that property. Items can be sorted in 

ascending or descending order. When a column heading is clicked, a triangle appears in the 
column label indicating the direction of the sort. A triangle pointing up means that the items 
are sorted in ascending order and a triangle pointing down means that the items are sorted in 

descending order. Each time you click the column heading, you reverse the sort order.  
 
Note: You can also set the sort order by editing the view definition. 
  
If the selected folder also contains subfolders, they appear at the top of the view, in the 
selected sort order. 
 

Your last sort is saved as the default sort for the active view until you change the sort. You 
can also split the work area with a horizontal or vertical layout and apply a different view and 
sort to each work area. For example, you may want to compare documents in the same folder 
or different folders using two different sorts. The sort in a split layout is also preserved and 
the documents appear in that sort the next time a split layout opens. 

 

To sort documents: 

1. Click the column heading for the property on which you want to base the sort. 

  
2. To change the sort order, click the column heading until the triangular indicator points 

up for an ascending sort or down for a descending sort. 

To configure document sort order in a view definition: 

1. On the View menu, choose Manage Views. 
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2. Add a new view or edit an existing view. 
  

3. Click the Sort tab. 
  

4. Click the Sort Items By list and select a document attribute by which to sort 
documents. 
  

5. Choose Ascending or Descending order. 
  

6. Continue to specify secondary sort orders (optional). 
  

7. Click Apply to save your changes. If you are editing the active view, the results of the 
view definition are immediately visible. 
  

8. Move to the next tab or click OK to save the view. 

3.4.2 Rearrange Columns 

You can rearrange the property columns in the Library in an order that suits the way you 
work. For example, you can move frequently-used columns so that they appear in any view 
without scrolling and move the less frequently used columns to the end of the grid.  
 

You can move a column by dragging its column heading to another position in the headings 
row. When you drag a column heading, a transparent image of the column heading moves 
with the mouse pointer. As you drag the transparent image left or right in the headings row, 
vertical white double arrows appear indicating where the column will be placed when you 
release the mouse button. 
 
Note: You can also configure the column arrangement by editing any view definition. Column 

changes made to the active view are automatically saved in the view definition. 
 
The Developer remembers your column order, so that the next time you open the Library or 
Outline Editor, the columns appear in the active view as you last arranged them. 

 
If you split the work area into separate horizontal or vertical layouts, you can create a 
separate column arrangement for each work area. 

 

To rearrange columns: 

1. Drag the heading of the column you want to move and drop it on a heading in the 
headings row, to the left of which you want to insert the moved column. 

To sequence columns in a view definition: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  

3. Click the Column Selection tab. 
  

4. Select one or more columns in the Used in view section and use the up or down 
arrows to change the position. 
  

5. Click Apply to save your changes. If you are editing the active view, the results of the 

view definition are immediately visible. 
  

6. Move to the next tab or click OK to save the view. 
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3.4.3 Add and Remove Columns 

You can remove property columns while working in the Library or Outline Editor. Views in the 

Library and Outline Editor display a different subset of the total list of available property 
columns. If you need more information in a view, you can add one or more columns from the 
list of available properties.  
 
Removing columns simplifies the view and lets you concentrate on the properties you use. If 
you find that you need to see the data in a deleted column, you can add the column back to 

the view. 
 
The Developer preserves your last column display in the active view for the Library and the 
Outline Editor. 
 

To remove a column: 

1. Drag the heading of the column you want to remove down into the view and release 

the mouse button when a large black X appears on top of the column heading. 

To add a column: 

1. Right-click on any column heading and choose Column Chooser. 

  
The Column Chooser window opens displaying the column headings for the hidden 
columns. 
  

2. From the Column Chooser window, drag the column you want to add and drop it in a 
position on the column heading row. 

Note: Dropping a column on top of another column heading adds the dropped column to the 
left of the column heading. To add a column to the end of the column headings, drop it on the 

right border of the last column heading. 
 

To configure columns in a view definition: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  
3. Click the Column Selection tab. 

  
4. To add one or more columns, make your selection in the Available section and click 

the right arrow to move your selection to the Used in view section. To remove one or 
more columns, make your selection and click the left arrow. 
  

5. Click Apply to save your changes. If you are editing the active view, the results of the 

view definition are immediately visible. 
  

6. Move to the next tab or click OK to save the view. 

3.4.4 Size Columns 

You can adjust the width of a property column to view more or less of the data in the column. 
For instance, if you do not need to view the entire Last Modified Date, you can decrease the 

width of that column. If a column is not wide enough to view the entire contents, the view of 
the data is truncated and ends with an ellipsis (...).  
 
Columns can be resized manually by dragging the right column border in the headings row to 
the desired width. You can also autofit a column using Best Fit, which automatically resizes the 
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width of the column to fit its widest text. You can autofit a single column or all columns at the 
same time. 
 

You can split the work area into separate horizontal or vertical layouts and resize the columns 
independently. The column widths in the split layout are preserved during the session. 
 

Note: You can also resize columns in dialog boxes and panes that use a column heading 
layout. 
 

To size columns using drag-and-drop: 

1. In the headings row, point to the right border of the column you want to resize. 

  
The mouse pointer changes to a horizontal two-headed arrow. 
  

2. Drag the column border left to decrease the column size or right to increase the 
column size. 

To size columns using Best Fit: 

1. Right-click the heading for the column you want to size. 

  
2. Choose Best Fit to autofit a single column or Best Fit (all columns) to autofit all 

columns. 
  

You can also double-click the right column border in the headings row to autofit a 
column. 

3.5 Create a Custom View 
You can create an unlimited number of custom views for the Library and control the following 
characteristics of each view:  

 Selection and order of the columns in the view 
   

 Sort order of the documents in the view 

   

 Selection of documents in the view 

Note: Custom views are not Library-specific and are available in any Library. 
 

After you create a custom view, it appears in the list of views on the View toolbar. 
 

Note: You cannot create a custom view for the Outline Editor; however, you can manually 
customize the Outline Details View. 
 

If you modify the configuration settings (column selection/width and sort) of any active view 

outside of the View Editor, your changes are automatically saved in the view definition. For 
example, if you define specific columns to appear in a view, then activate that view in the 
Library and remove columns, those changes appear in the view definition the next time you 

edit it in the View Editor. 
 

Share Custom Views  

Any custom view that an author creates can be shared with other authors by distributing a 
copy of a view file from the ViewFilters\<language code> folder in the local data storage 
location on their computer. You can determine the location of the local data storage location 
when you create a login profile for the first time. The complete path of the local data storage 

location is displayed on the Summary page of the Login Profile Wizard for reference. For more 
information, see Share a Custom View in the Use and Share Custom Views section of the Use 
the Developer in a Multi-user Environment chapter.  
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 Multi-user Considerations 

 A custom view is specific to the author who created it. It does not appear as a choice 
on the View toolbar list of views for all authors. 
  
Also note that the Developer provides sample custom views in the multi-user 
environment for displaying documents by owner, state, check out status, and so on. 

3.5.1 Add a New View 

Before you can add a new view, you should display the Library (View, Library). Although you 

can create a new view from other document editors, you can only apply a custom view to the 
Library.  
 
From the Library, you can manage all existing views that are delivered with the Developer as 
well as create your own. 
 

To add a new view: 

1. On the View menu, choose Manage Views. 

  
2. Click New. 

  
3. Type a unique view name. You cannot have duplicate view names. 

  
You cannot use reserved characters in the view name. 
  

4. Continue to define the column selection, sort, and filter criteria. 
  

5. Click OK to save the view. 

3.5.2 Configure View Columns 

The Column Selection tab controls the data columns that appear in the view as well as their 

sequence from left to right. By default, each new view includes the Name column (to identify 
each document in the view). The Available section lists the columns you can choose to include 
and the Used in view section show the list of selected columns. For each column you include in 
the view, you can determine its position and width (in pixels).  
 

To configure columns in a view definition: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  

3. Click the Column Selection tab. 
  

4. From the Available section, choose one or more columns and click  to move 
your selection to the Used in view section. To remove one or more columns, make 

your selection and click . 
  

5. Click Apply to save your changes. If you are editing the active view, the results of the 
view definition are immediately visible. 

  
6. Move to the next tab or click OK to save the view. 
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To sequence columns in a view definition: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  
3. Click the Column Selection tab. 

  

4. Select one or more columns in the Used in view section and use the  or 

 icons to change the position. 

  
5. Click Apply to save your changes. If you are editing the active view, the results of the 

view definition are immediately visible. 
  

6. Move to the next tab or click OK to save the view. 

To size columns in a view definition: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  
3. Click the Column Selection tab. 

  

4. Select one column in the Used in View section and enter a number (in pixels) in the 
Column Width field (or click the up/down arrows next to the default value). 
  

5. Click Apply to save your changes. If you are editing the active view, the results of the 
view definition are immediately visible. 
  

6. Move to the next tab or click OK to save the view. 

3.5.3 Configure View Sort Order 

The Sort tab controls the order that documents appear in a view. You can enter a primary sort 
order followed by two secondary sort criteria. Choose ascending or descending to determine 

the sort order.  
 
The Organize by folders option controls whether the documents appear in a folder structure 
(default) or as a flat list with no folders. 
 

To configure document sort order in a view definition: 

1. On the View menu, choose Manage Views. 

  

2. Add a new view or edit an existing view. 
  

3. Click the Sort tab. 
  

4. Click the Sort Items By list and select a document attribute by which to sort 
documents. 
  

5. Choose Ascending or Descending order. 
  

6. Continue to specify secondary sort orders (optional). 
  

7. Click Apply to save your changes. If you are editing the active view, the results of the 
view definition are immediately visible. 
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8. Move to the next tab or click OK to save the view. 

3.5.4 Configure View Filter 

The Filter tab lets you control the documents that appear in a view. If you do not define filter 
criteria, all documents in the selected folder, or in the entire Library for a flat view, appear 

when the view is active. If you want to limit the documents that appear, you should define 
filter criteria. For example, you could filter documents by Type and choose to show only 
topics.  
  
You filter documents by creating "selection statements" that include a Column data element 
followed by a Condition and a specific data Value. 

 Column: Select the column that contains the information that you want to filter; such 

as Type, Frame, Path, or Last Modified Date. For a complete list of the columns and 
their attributes, see Select Filter Columns in the Create a Custom View, Configure View 
Filter sections of the Manage the Library chapter.  

  

 Condition: The criteria used to filter the column data. Condition values act as an 

operator such as equals, not equals, is more than, is less than, and so on. The 
available conditions are constrained by the Column data type. For example a numeric 
column includes "equals", a date column includes "on or before", and a text column 
includes "contains". For a complete list of Conditions and their definitions, see Use 
Filter Conditions in the Create a Custom View, Configure View Filter sections of the 

Manage the Library chapter. 
  

 Value: Use this field to add the specific comparison value for the condition. The data 
Value is dependent on the Column data type; the entry may be a date, number, text, 
or a selection from a list, such as a listed role.  

You can add as many "selection statements" as you need for filter criteria. Each statement 

appears in the area below the Match all/any options. These options control how the selection 

statements are applied. For example, use Match all (and) if you only want documents that 
meet all of the selection criteria listed. You can also use Match any (or) if you want documents 
that meet any of the selection criteria listed. 
 
You can modify the parameters of any selection statement after it is added. You can also 
remove one or more statements from the list or clear the entire list.  

  
Examples  
Situation 1: You want to display only topics in a view. To define a filter that displays only 
topics, you would create the following "selection statement": 
  
Column = Type  
Condition = in  

Value = Topic  
  

Situation 2: You want to create a view that displays all of the documents in the HR folder and 
its four subfolders. To define a filter that displays all of the documents in the HR path, you 
would create the following "selection statement":  
  

Column = Path  
Condition = contains  
Value = /HR  
  
Note: In the above example, you would deselect the Organize by folders option on the Sort 
tab to show all documents in the Library that meet the conditions in a single view.  
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To add a selection statement: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  
3. Click the Filter tab. 

  

4. Edit the Column, Condition, or Value fields. 
  

5. Click Add. 
  

6. Click Apply to save your changes. If you are editing the active view, the results of the 
view definition are immediately visible. 

To edit an existing selection statement: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  
3. Click the Filter tab. 

  
4. Choose a selection statement from the list. 

  
5. Edit the Column, Condition, or Value fields. 

  
6. Click Apply to save your changes. If you are editing the active view, the results of the 

view definition are immediately visible. 

To remove a selection statement: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  

3. Click the Filter tab. 
  

4. Choose a selection statement from the list. 
  

5. Click Remove to erase only the selected item. 
  

6. Click Apply to save your changes. If you are editing the active view, the results of the 
view definition are immediately visible. 

To remove all selection statements: 

1. On the View menu, choose Manage Views. 

  
2. Add a new view or edit an existing view. 

  
3. Click the Filter tab. 

  
4. Click Clear to remove all existing selection statements. 

  
5. Click Apply to save your changes. If you are editing the active view, the results of the 

view definition are immediately visible. 
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3.5.4.1 Select Filter Columns 

The following lists the Columns that you can use to construct selection statements for filtering. 

See Use Filter Conditions for more information about each condition.  
  
* Available in multi-user installation only  
  

* Checked Out By: The author that has checked out a document. 
Condition: in, not in, is empty, is not empty 
Value: One or more valid author names  
  
Note: Self can be used to identify the author currently logged into the Developer and running 
the view. For example, use Self to create a view that lists documents that are currently 

checked out to you.  
 
* Checked Out Hostname: The computer name for the author that has a document checked 
out. 
Condition: contains, is, does not contain 

Value: Any text 
 

Creation Date: The date a document was created. 
Condition: on, on or before, on or after 
Value: A valid date or select from the popup calendar 
  
Derived From: The name of the original document from which a document is copied. 
Condition: contains, is, does not contain 
Value: Any text 

  
Derived From Document ID: The Document ID for the original document from which a 
document is copied. 
Condition: contains, is, does not contain 
Value: Any text 
 

Document ID: The unique document identifier. 
Condition: contains, is, does not contain 
Value: Any text 
  
Frames: The number of frames in a topic. 
Condition: equals, not equals, is more than, is less than, is at least, is at most 
Value: Any number from 0 to 1000. 

  
Language: Language code assigned to the document. 
Condition: in, not in 
Value: One or more valid language codes.  
 
* Last Modified By: The author that made the most recent modification to a document. 
Condition: in, not in 

Value: One or more valid author names 
 

Last Date Modified: The most recent date when a document was modified. 
Condition: on, on or before, on or after 
Value: A valid date or select from the popup calendar 
 

Link Count: The total number of document links. 
Condition: equals, not equals, is more than, is less than, is at least, is at most 
Value: Any number from 0 to 1000 
 
Links To: The number of links to a document. 
Condition: equals, not equals, is more than, is less than, is at least, is at most 
Value: Any number from 0 to 1000 
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Name: The name of the document. 
Condition: contains, is, does not contain 

Value: Any text 
 

Original Location: The folder path in the Library where the document resides. 
Condition: contains, is, does not contain 
Value: Folder path in Library. For example, /system/icons/standard. 
 
* Owner: The author currently assigned as the document owner. 
Condition: in, not in, is empty, is not empty 
Value: One or more valid author names 

  
Path: The folder path in the Library where the document resides. 
Condition: contains, is, does not contain 
Value: Folder path in Library. For example, /system/icons/standard  
  
* Permission: The permission assigned to the document (as inherited from the folder 

permission) 

Condition: in, not in 
Value: List, Modify, Read 
 
Questions: Applies to Assessments only. The number of questions in the assessment. 
Condition: equals, not equals, is more than, is less than, is at least, is at most 
Value: Any number from 0 to 1000 

 
Roles: The role(s) assigned to a document. 
Condition:  is empty, is not empty, contains any, contains all, does not contain any, does not 
contain all 
Value: One or more valid roles 
 
* State: The current state value assigned to a document. 

Condition: in, not in, is empty, is not empty 
Value: One or more valid state values 

 
Type: The type of document. 
Condition: in, not in 
Value: One or more valid document types 

 
* Version: The current version of the document. 
Condition: equals, not equals, is more than, is less than, is at least, is at most 
Value: Any number or ‘New’ or ‘new’ documents 
  

 Multi-user Considerations  

 The data values for the Checked Out By column are based on the users defined in the 
system by the Administrator. However, to filter documents that are checked out to 
you, choose the Self option. 

  

You can also use the "is empty" or "is not empty" to filter documents by check out 
status. For example, as an administrator, you may want to create a view that lists all 
documents that are checked out by any author. To do this, you can create a filter that 
selects documents that have the Checked Out By column that is "not empty".  

3.5.4.2 Use Filter Conditions 

Condition values act as operators such as equals, not equals, is more than, is less than, 

contains, does not contain, and so on. Both the Condition and data Value lists are constrained 
by the Column data type. 
 
in 
Select documents that match one or more values specified in the Value field. 
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not in 

Select documents that do not match one or more values specified in the Value field. 

 
is empty 
Select documents with one or more property attributes that are empty. 
 
is not empty 

Select documents with one or more property attributes that are not empty. 
 
on 
Select documents that have a matching date. 
 
on or before 
Select documents that have a date that is on or before the date specified in the Value field. 

 
on or later 
Select documents that have a date that is on or after the date specified in the Value field. 

 
equals 
Select documents that have an exact matching value specified in the Value field. 
 

not equals 
Select documents that do not exactly match a value specified in the Value field. 
 
is more than 
Select documents that have a value greater than the numeric value specified in the Value 
field. 

 
is less than 
Select documents that have a value less than the numeric value specified in the Value field. 
 
is at least 
Select documents that have a value equal to or greater than the numeric value specified in the 

Value field. 

 
is at most 
Select documents that have a value equal to or less than the numeric value specified in the 
Value field. 
 
contains 
Select documents that contain the text specified in the Value field. 

 
is 
Select documents that exactly match the text specified in the Value field. 
 
does not contain 
Select documents that do not contain the text specified in the Value field. 

 

contains any 
Select documents that contain any of the values specified in the Value field. 
 
contains all 
Select documents that contain all of the values specified in the Value field. 
 

does not contain any 
Select documents that do not contain any of the values specified in the Value field. 
 
does not contain all 
Select documents that do not contain all of the values specified in the Value field. 
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 Multi-user Considerations  

 You can also use the "is empty" or "is not empty" to filter documents by check out 
status. For example, as an administrator, you may want to create a view that lists all 
documents that are checked out by any author. To do this, you can create a filter that 
selects documents that have the Checked Out By column that is "not empty". 

3.5.5 Edit an Existing View 

You modify any existing view at any time and make changes.  
 

To edit an existing view: 

1. On the View menu, choose Manage Views. 

  
2. Select a view from the list. 

  

3. Choose Edit. 

  
4. Modify the view configuration settings on the Column Selection, Sort, and Filter tabs. 

  
5. Click OK. 

3.5.6 Copy a View 

You can make a copy of an existing view as a starting place for a new view definition. When 
you copy an existing view, it is automatically created using the same name with " - Copy" 
appended to the end of the view name. You should change the name to make it more 
meaningful and unique; then proceed with your modifications.  
 

To copy an existing view: 

1. On the View menu, choose Manage Views. 
  

2. Select a view from the list. 

  
3. Choose Copy. 

  
4. Change the name of the view. 

  
5. Modify the view configuration settings on the Column Selection, Sort, and Filter tabs. 

  
6. Click OK. 

3.5.7 Delete a View 

You can delete any custom view that you create; however, you cannot delete the Details View. 
 

 Multi-user Considerations 

 You cannot delete the Deleted documents and Lost documents views. 

If you delete the active view, the Details view appears in its place. 
 

To delete an existing view: 

1. On the View menu, choose Manage Views. 

  
2. Select a valid view from the list. 
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3. Choose Delete. 

  
4. Click OK to confirm the deletion. 

3.5.8 Reset Defaults for Views 

The Developer provides one or more sample views depending on your installation type (single 
vs. multi-user). For example, the Library Details View is a sample view delivered with the 
Developer. You can modify a sample view to meet your requirements. You can also discard 
your changes and reset each view back to its original settings. 
 

To reset a sample view: 

1. On the View menu, choose Manage Views. 

  
2. Select a sample view from the list. 

  

Note: You cannot reset the values for a custom view that you add. 
  

3. Choose Reset. 
  

4. Click OK to confirm your choice to reset the view. 

3.6 Understand the System Folder 
The System folder is automatically created when you install the Developer. It contains a series 
of subfolders and documents that store publishing documents, templates, master role 
documents, and attachment icons. The System folder is only visible in the Library and contains 

the following subfolders: 

 Assessment Templates 
  

 Icons 

  

 Publishing 
  

 Question Templates 

  

 Roles 

  

 Style Sheets 
  

 Templates 

Warning! You should not move, delete, or rename the System folder, its subfolders, or any 
documents that are contained within them. Doing so may impair the operation of the software. 

However, you can add and remove documents to the Icons folder without causing problems. 

3.6.1 Attachment Icons 

When you link an attachment to a topic frame, an icon is added as a clickable link that 
navigates to the attached content from the Player. The Developer provides five standard icons 
that you can use, or you can create and use custom icons of your own in addition to the 

standard icons.  
 
The Icons folder contains two subfolders, called Custom and Standard. The Standard folder 
stores the icons that are delivered with the Developer. Each icon is included in a separate 
Package document. If you do not want the standard icons to appear as choices in the Frame 
Link Properties dialog box (Topic Editor), you can delete the package documents from the 
Standard folder. The Custom folder is where you should store any custom icons that you 

decide to create. 
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3.6.2 Publishing Styles 

The Developer provides a variety of deployment and document styles that you can use to 

publish content. In addition, the Developer gives you the ability to launch published content 
from the Help menu of an application.  
 

The Publishing/Styles folder contains the publishing styles. Each publishing style has specific 
formatting attributes that are controlled by Publishing Project documents that are delivered 
with the Developer. Each category or "brand" has its own subfolder. You can customize 
publishing styles to fit your business needs. 
 
The In-Application Support folder contains the files necessary for launching content from the 
Help menu of an application. Within the HINT package, the files necessary for supported target 

applications are in stored in folders, one for each target application. The SmartHelp package 
contains the files necessary to install SmartHelp. See the In-Application Support guide for 
more information about these packages. 

3.6.3 Roles 

The Developer provides a series of empty master role documents for each supported 
language. For example, the Roles.en document is the master role document for roles in the 
English language as determined by the language property of the document. You should not 

create additional role documents for the same language, as the Developer uses only the first 
one created for role assignment. For example, if you make a copy of a role document for 
English and add roles to it, those roles do not appear as assignment choices from any topic 
Properties toolpane. These documents should not be moved to any other folder in the Library.  
 
You should always use these documents to store roles that can be assigned to topics for role-
based filtering in the Player. 

3.6.4 Templates 

The Developer uses templates to generate bubble text automatically for topics as you record 
an application, depending on the keystroke or mouse action performed during each step. 

These templates are stored in the Templates folder. There is a subfolder for each supported 
language, named according to the code for each language. The Developer provides two 
template sets for each language that you can assign to module, section, and topic documents.  

3.6.5 Supported Languages 

In the Library, each supported language has a specific language code. The language code is 
used as the name of the subfolders in the Templates folder:  

  
cs: Czech 
da: Danish 
de: German 
en: English 
es: Spanish 

es-mx: Spanish (Mexico) 
fi: Finnish 

fr: French 
fr-ca: French (Canada) 
hu: Hungarian 
it: Italian 
ja: Japanese 

ko: Korean 
nl: Dutch 
no: Norwegian 
pl: Polish 
pt: Portuguese 
ru: Russian 
sv: Swedish  
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tr: Turkish 

zh-CHS: Chinese (Simplified) 

zh-CHT: Chinese (Traditional)  

3.7 Update the Library (Service Packs) 
When a service pack is installed to a multi-user server installation, Library updates need to be 
run from the Developer as a result. The Developer automatically detects when there are 
Library updates that need to be applied when any user starts the Developer. 

  
The Library Updates dialog box lists the service packs that are installed on the server. You can 
selectively choose the service pack updates that you want to process, although it is highly 
recommended that you update the Library with each service pack listed. However, if you are 
using multiple Libraries, it may make sense for you to selectively choose the service pack 
updates for each Library (depending on the contents of the service pack). This process 
updates various documents in the System folder but does not impact your content.  

  
Service pack document updates are automatically checked in to the Library. Therefore, only 

one user in a multi-user environment would need to run the Library Update process.  
  
As a result of running this Library update process, a System/Service Packs/ folder is created 
that contains an empty package document for each service pack. You should not edit or 
remove these package documents or folders as they are a record of each service pack update 

that was applied to the server. The About the Developer (Help, About) dialog box also lists the 
service packs that have been applied to the server to which you are connected. 
  
Note: Library updates can also be applied manually using the Library Updates command on 
the Tools menu in the Developer. 
  

Custom Document Publishing Style Upgrades  

If updates to the standard document publishing styles are included in a service pack, you can 
have the Developer upgrade your custom document styles with the updates from the standard 
document publishing styles delivered with the service pack. See Upgrade Custom Document 

Publishing Styles in the Manage the Library chapter for more information. 
  

Important Note: A user must have Modify permission on the System folder to perform 
Library updates or Custom Document Publishing Style upgrades. 
  

To update the Library with a service pack: 

1. With a service pack installed on the server, have at least one user start the Developer 

to open the Library that you want to update. The Library Updates dialog box 
automatically appears listing the available service pack updates. 
  

2. Select the service packs that you want to process. 
  

3. Click OK to update the Library. 

3.8 Upgrade Custom Document Publishing Styles 
As you upgrade to new releases and service packs, you can upgrade any custom document 
publishing styles you have created in the Library. This applies to only document outputs, such 
as System Process, Training Guide, Instructor Manual, Test Document, Test Case, Job Aid, and 
Presentation. If publishing styles are not upgraded, they are not available for publishing or 
preview. 
 
During the upgrade process for a custom document publishing style, the following things 

occur: 

 New options in the Publishing Wizard for document styles are added to custom styles. 
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 New bookmarks are added to the print template files. Any legacy bookmarks that may 

have been used in the customization remain, ensuring that the customizations still 

work. 
  

 Word macros, .xslt files, and other publishing files are updated as needed. If custom 

macro modules were created, they are preserved. 
  

 Customizations to the default suffix (style name) and version number that are 
appended to the file name are preserved. 
  

 Customizations to the publishing style name, preview name, and Publishing Wizard 
text are preserved. 

When the upgrade process is run, it looks at all the publishing styles in the Library and 
identifies all the custom document styles, regardless of language or category. 
 
For major new releases, custom document publishing styles are automatically updated during 

the standard Upgrade process (when you upgrade your profile). However, if you import a 
custom document publishing style from a previous version after an upgrade, you are prompted 
to upgrade the custom document style(s) when you start the Publishing Wizard or when you 
preview content (for the category you are publishing). 
 
For service pack releases, the Publishing Wizard checks the styles to determine if there are 
customized document styles (in all languages and the category you are publishing) from a 

previous version. If any are found, you are prompted to upgrade the styles before continuing 
in the Publishing Wizard. Therefore, if an author imports a custom style from a previous 
version, or if an upgrade failed because of lack of permissions or check out status, the style 
can still be upgraded and used to publish. Individual custom document publishing style 
document(s) in need of upgrade do not appear on the Formats list of the Publishing Wizard. 
Also note that a style is checked when you preview content and you are prompted to upgrade 

the style you are trying to preview. 
 

The last page of the Publishing Wizard (Formats column) does not display any publishing style 
that requires an upgrade. To determine if there are styles that need upgrading, just start the 
Publishing Wizard, which notifies you if there are styles that need upgrading. 
 
Note: This process assumes that you have created custom document publishing styles by 

making copies of the standard document publishing styles delivered in the System folder. 
 
If you receive the following error message during the upgrade of a custom document 
publishing style, you must enable access to Visual Basic in Microsoft Word and then retry the 
upgrade. 
 
"Trust access to the VBA project object model is not set in Microsoft Word." 

 
If this message appears in the Activity log, you should do the following in Microsoft Word. 
Then restart the Publishing Wizard, select the custom document publishing style, and confirm 
the upgrade of the custom style. After the upgrade is complete, you can use the custom 

document publishing style to publish content. 

1. On the File menu, click Options. 

  
2. Click the Trust Center tab, and then click Trust Center Settings. 

  

3. Click the Macro Settings tab, click to select the Trust access to the VBA project 
object model option, and then click OK. 
  

4. Click OK. 

Note: It is recommended that you change this Microsoft Word setting back after you complete 
the upgrade of your custom document publishing styles. 
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3.9 Back up Content 
A well-executed backup plan is your only defense against losing all your data in the event of a 
disaster. Your company's system administrator should review any backup and disaster 
recovery plan before it is implemented. 
 
Any backup process should be evaluated against the following criteria: 

 Back up as often as you feel is necessary or your company dictates. 

  

 Back up frequency should be based on the amount of data you are willing to lose if 
disaster strikes. 
  

 Backups should be verified to ensure that the process was successful. 
  

 Backups should be tested periodically to ensure that data can be recovered. 

There are different types of Development environment installations to consider when 

establishing a backup plan. These installation types are not mutually exclusive; a company's 
backup plan should address each type that is in use. 
 

Single User Environment 
The following items must be considered for a single user installation where the Developer and 
the content are installed on a local workstation: 

 Export the outline(s) you are currently developing on a daily basis. 
  

 Export your entire Library on a routine basis to backup all of your content. 
  

 Use backup software to backup your entire file structure on a routine basis. 

Multi-user Environment 
The following items must be considered for a multi-user installation where the Developer is 
installed on client machines and the Library is installed on a server: 

 Ensure that all content authors have checked in all documents. 

  

 Ensure that all content authors have logged out of the Developer. 
  

 Perform a routine backup of the SQL or Oracle database. 

Encourage authors to back up their new and checked out documents by exporting the content. 

3.9.1 Restore a Database 

If a database administrator restores the server database from a backup, the 

UpdateRestoreDateOracle.sql or UpdateRestoreDateMSSql.sql script must be run to update 
specific fields. This is necessary because clients normally synchronize with the server in a way 
that only uploads or downloads the latest changes that occurred after the last synchronization. 
This is a differential or incremental update. This works because the server and the client 

assume that the time can only go in one direction, ahead, but cannot go back. This rule is 
violated when the server database is restored to an earlier point in time. Therefore, a special 
flag must be updated in the database which indicates that an incremental refresh would not 
work, but a full refresh is needed, because the server “went back in time”. The system cannot 
normally handle this situation correctly, unless the script is run.  
 
The scripts are located in the Utils folder in the location where the Developer server is 

installed.  
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4 Build an Outline 
You build an outline by linking documents together in a way that best conveys the information 
that you want to communicate to your audience. Although there are several ways to create 

documents, you must use the Outline Editor to define the outline by linking module/section 
and topic documents to one another. For example, you can create new documents from the 
Library without any links and then use the Outline Editor to design the outline by linking the 
various documents that you have created in the Library. You can also create the outline "on 
the fly" by linking new documents directly from the Outline Editor. 
 

Consider the following before deciding how to build your content: 

 If you create a new document from the Library (File, New), you can predetermine the 
folder in which it is stored; however, you cannot link a document or view its 
relationship to other documents. 
  

 If you link a new section or topic document from the Outline Editor, it is stored in the 

same Library folder as the parent document to which it is linked. When you link a new 
module, you are prompted to define its properties, at which time you can adjust the 
location where it is stored. 

Regardless of how you build content, some combination of module, section, and topic 
documents is used. 

4.1 Navigate the Outline Editor 
The Outline Editor displays the outline on the left and a view of either document details (or 

properties) or linked content on the right. By default, the Outline Editor displays the Player 
view that shows the Concept/Introduction panes depending on the document type you have 
selected. For example, module, section, and topic documents can have Concepts while topics 
can have both a Concept and an Introduction. 

 
Text appears in the Introduction pane after you record topic content and enter text for the 
Introduction frame bubble. Only text that is marked as Visible in See It/Try It modes or Visible 

in Player appears in the Introduction pane. 
 
The Concept pane displays linked content such as a web page, package, or URL. You can 
control the display of linked content using the Preview category in Options (on the Tools 
menu). 
 

Publishing Note: When you publish content to the Player, topic introduction text appears in 
the Player Concept pane if there is no linked content in the Developer Concept pane. 
 
You can navigate the outline and display linked documents by clicking the + icon next to the 
document name. You can also use the left or right arrow keys or the ENTER key to 
expand/collapse a parent document with links. The ENTER key can also be used to open 

recorded topics in the Topic Editor or launch the Recorder for empty topics. Use the up or 

down arrow keys to move the document selection up and down the outline. 
 
To initiate any action on a document such as link a new document, you must select it by 
clicking the document name. When you select a document in the outline, linked 
Concept/Introduction content also appears (if you linked this content to the document). 
 
You can adjust the size of each pane by clicking and dragging the vertical or horizontal split 

bars that separate each pane. The Developer remembers any sizing changes that you make to 
these panes. 
 
Note: You can also use the keyboard to navigate in the Outline Editor. 
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Expand/Collapse Modules or Sections 

You can expand or collapse selected module or section documents to display its related child 

documents. Use the  or  toolbar icons or the Expand and Collapse commands on the View 
menu to expand or collapse selected modules or sections. 
 

 Multi-user Considerations 

 As documents are checked in and out, icons appear to the left of the document name 
indicating the check in/out state as follows: 
  

 indicates that the document is checked out to you. 

  

 indicates that the document is locked and checked out to another author. 

  
No icon indicates that the document is checked in and available to any author. 
  

These icons appear in various places such as the Library and Outline Editor as well as 
on document editor tabs and various views. Also note that additional columns in the 

Details view of the Library and Outline Editor display the check in/out state and 
version number. The Checked Out By column displays the name of the author who is 
currently using the document. 

4.1.1 Open a Document from the Outline Editor 

You can open module, section, topic, question, and assessment documents from the Outline 
Editor. Opening a module or section displays a new Outline Editor tab so you can focus your 
attention on a specific part of the outline. You can open as many modules or sections as you 
want and then copy and paste or drag-and-drop documents between tabs or the Library. 
Opening a topic displays the Topic Editor if the topic has recorded content. Opening an empty 
topic starts the Recorder.  
 

Opening a question or assessment document displays the Question or Assessment Editor. 

Modules and sections open in new Outline Editor tabs. Topics open in new Topic Editor tabs. 
 

Note: You can select and open multiple documents at the same time from the Library or 
Outline Editor. 
 

 Multi-user Considerations 

 If you open a document that is not checked out to you, it opens in Read-Only mode. If 
you decide to make any changes to a Read-Only document, upon exit you are given 
the option to save the document (check out and save the changes), save it as a new 
document, or discard the changes. 

To open a document from the Outline Editor: 

1. Select one or more documents in the outline. 

  
2. Right-click any document in the selection (if you have more than one selected) and 

choose Open. 

4.1.2 Change the Outline Editor View 

The default view in the Outline Editor is called the Player View, which allows you to link 
additional content to a module, section, or topic such as a web page, presentation, image, or 
other document. It has a Concept and Introduction pane. The Concept pane can display 
conceptual or explanatory information about a module or section, or topic that is selected in 

the outline. The Concept and/or Introduction panes are empty until you link content to a 
document.  
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The Introduction Pane typically provides a short statement introducing a topic selected in the 
outline. The Introduction pane does not appear when a module or section is selected in the 

Outline Editor. 
 

Note: Linked documents in the Concept/Introduction display only when you select one 
document in the outline. If multiple documents are selected, the pane is blank and disabled. 
 
In addition to the Player View, there is also a Details View and Assessment Coverage View. 
The Details View shows document properties such as Last Modified Date, Role assignment, and 
so on. Although you can sort the Details View by property column in the Library, you cannot 
sort by property column in the Outline Editor. Also note that you can add or remove columns 

from the Details View. The Assessment Coverage View is used to analyze linked and 
associated assessments to ensure that the assessment questions adequately measure 
competency. 
 

 Multi-user Considerations 

 If you work offline and do not have a local copy of a document that is linked as a 
Concept or Introduction, a message appears in the Player View instructing you to go 
online and perform the Document, Get command to retrieve read-only copies of the 
necessary documents for viewing. You can also check out the necessary documents if 
you want to edit them and they are not in use. 

To change the Outline Editor view: 

1. Launch the Outline Editor by opening a module or section document. 

  
2. On the View toolbar, choose either the Details View, Player View or Assessment 

Coverage View depending on the view that currently appears. 

4.2 Develop an Outline 
You create an outline by linking new or existing documents in a multi-level hierarchy that you 
design using the Outline Editor. You use a combination of modules, sections, or topics to 

design the outline hierarchy using as many levels as you want. Although you typically create 
topic documents to capture transactional recordings of how to perform a task in an 
application, your use of module or section documents is completely your choice as these 
documents are merely containers for other documents. For example, you can choose to design 
an outline using just modules and topics, sections and topics, or a combination of modules, 
sections, and topics. 
  

You can also link questions and/or assessments anywhere in an outline to test a user's 
knowledge of the content that precedes the question/assessment. 
 
After you create an outline, you can refine it by changing document relationships, copying 
documents, deleting incorrect or unnecessary links, and so on. You can also embellish your 
outline with additional attachments in the form of web pages, packages, and URLs. 

 
The Outline Editor also displays broken link documents. 
 
Publishing Note: Empty module and section documents that have concept attachments are 
included in all published outputs. If an empty module/section has no concept attachment, it is 
not included in any published output. Topics with concept/introduction attachments are only 
included in published output if they are recorded and not empty. 

 
Also note that if a topic has no concept link, the topic introduction text appears in the Concept 
pane in the Player. 
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See Also Links 

For any module, section, and topic in an outline, you can create See Also links for related 

content. For example, a section can have See Also links to other module, section, or topic 
documents that a user can navigate to in the Player/HTML Website when a document is 
selected in the outline. A See Also button appears in the Player with a list of related 
documents that the user can navigate to. The list of See Also documents also appear in 

document and presentation output. You can create See Also document links using the See Also 
property on the Properties toolpane. 
 

 Multi-user Considerations 

 When you work in a multi-user environment, you may want to periodically refresh the 
outline to update the content with the latest document information from the server. 

4.2.1 Link a New Module 

Using the Outline Editor, you can link a new module under any existing module or section 

document; however, you cannot link a module under a topic document. Linking a module 
creates a new document that is stored in the Library, as well as a new link between the 
module and its parent document. 
 
A module/section has the following default properties that you can change: 

 Name: A descriptive name for the document. 

  

 Location: The folder location in the Library where this document is stored. The default 
folder that appears depends on where you are when you create the new document, as 
follows: 

  
If you create a new document from the Library, the default folder is the folder that is 
selected in the Library when you create the new document. 
  

If you link a new document from the Outline Editor, the default location is the same as 
the location of the parent document to which you are linking the new document. 
  

 Language: The Language option allows you to choose the default dictionary that is 
used to check the spelling of a document's content. 
  

 Template: The Template option allows you to select another folder of template files. 

The template sets included with the Developer are the Standard and Microsoft 
templates. The Microsoft template conforms to the standards as stated in the Microsoft 
Manual of Style for Technical Publications. In addition to these templates, other 
template sets may be available to you. Alternate template sets are most useful when 

you are creating content for more than one application. Please contact Technical 
Support for more information on this option and its implementation. 
  

 Glossary: The Glossary option allows you to choose the glossary to assign to the 

document. The glossary document is a document that lists the words you have 
assigned as glossary terms. After you have set up the glossary terms and their 
definitions, the Developer can automatically create the links to the terms found in any 
document text. 
    

 Style Sheet: The Style Sheet option allows you to assign a style sheet to the 

document. The style sheet document contains the styles used to control the 
appearance of web page text, paragraphs, lists, tables, and images. 
   

 Screen Resolution: The Screen Resolution option allows you to determine the 

resolution in which the topic content is recorded. If authors attempt to record in a 
resolution other than the one listed in the Screen Resolution list box, a message box 
informs them that their resolution does not match the topic setting and indicates in 
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what resolution they should record. While content authors are not prevented from 
recording in a different resolution if they choose, this option does help to create 

greater consistency in the content. 
  

Please note that the Developer detects the current resolution of your computer and 
automatically sets the screen resolution property to match when you create new 
documents. Once screen resolution for a topic is set and you have saved a recording; 
the screen resolution cannot be changed. 

When you link a new module from the Outline Editor, the default properties from the parent 
document are automatically inherited until you change them.  
  
Tip: If you want all of the documents in a new outline to use the same glossary and style 
sheet, you should assign them to the root document of the outline. Then, all new documents 

that you create/link to the outline from the Outline Editor inherit the glossary and style sheet 
assignments; this includes indirect links such as web pages. 
 

 Multi-user Considerations 

 A Check Out Parent Document message appears when you perform actions that 
impact a parent document that you do not have checked out such as linking a 
document, moving a document, pasting a document, deleting document links, and so 
on. 
  
Any new document that you create or link is automatically checked out to you. If you 

want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To link a new module: 

1. Display the Outline Editor by opening the module or section for which you want to link 

a new module. 
  

2. Select the parent document to which you want link the new module. 
  

3. On the Link menu, choose  New Module. 

  
4. Type a name for the new module. 

  

5. To change the folder in which the module is stored, type the folder path in the 
Location field or click Browse, select a different folder, and click OK. 
  
When browsing for a folder, you can use the Make New Folder button to create a new 

subfolder in the currently selected folder. 
  

6. Choose the properties for the new module. 

  
7. Click OK. 

  
A new module is linked (and automatically saved) beneath the parent document. You 
can also rename the new module after it is linked and saved. 

Important Note about Module and Section Documents: A module or section document 
appears with a purple or blue book only when the document has at least one linked child 
document such as a topic or another module or section. However, a module or section 

document with no linked child documents appears with a page icon such as  for module and 
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 for section. When you create a new module or section, it automatically appears as a page 

icon until you link at least one additional child document. It then appears with a purple or blue 

book icon. 

4.2.2 Link a New Section 

Using the Outline Editor, you can link a new section under any module or section document; 
however, you cannot link a section under a topic. Linking a new section creates a new 
document that is stored in the Library (same folder as the parent document) as well as a new 
link between the section and its parent document.  
 
Note: You can also link an existing section. 
 

When you link a new section from the Outline Editor, the default properties from the parent 
document are automatically inherited until you change them. 
 
Each section that you link is automatically named "New Section" and placed directly beneath 
the parent document that you have selected. If the parent document has existing linked 

documents, the new section appears at the end of the list. For example, if you link a new 
section under a module that has three existing sections, the new section appears after the 

third section. You should rename the new section after it is linked. 
 
Note: You can also link a new section that is automatically linked to a new package using the 
New Section with Package command on the Link menu. This command streamlines the process 
for linking new sections with package attachments for conceptual content. 
 

 Multi-user Considerations 

 A Check Out Parent Document message appears when you perform actions that 
impact a parent document that you do not have checked out such as linking a 
document, moving a document, pasting a document, deleting document links, and so 

on. 

  
Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To link a new section: 

1. Display the Outline Editor by opening the module or section for which you want to link 

a new section. 
  

2. Select the parent document to which you want link the new section. 

  

3. On the Link menu, choose  New Section. 

  
A new section is linked (and automatically saved) beneath the parent document with a 
default name that you should change. 
  
You can also right-click the parent document and choose Link New Section. 

Important Note about Module and Section Documents: A module or section document 
appears with a purple or blue book only when the document has at least one linked child 
document such as a topic or another module or section. However, a module or section 

document with no linked child documents appears with a page icon such as  for module and 

 for section. When you create a new module or section, it automatically appears as a page 



  Build an Outline 

   103 

icon until you link at least one additional child document. It then appears with a purple or blue 
book icon. 

4.2.3 Link a New Topic 

Using the Outline Editor, you can link a new topic under any module or section document. 
Linking a new topic creates a new document that is stored in the Library (in the same folder as 

its parent document) as well as a link between the topic and its parent document.  
 
Note: You can also link an existing topic. 
 
Each topic that you link is automatically placed beneath the parent document that you have 
selected. If the parent document has existing linked documents, the new topic appears at the 
end of the list. For example, if you link a new topic under a section that has three existing 

topics, the new topic appears after the third topic. 
 
When you link a new topic from the Outline Editor, some of the default properties that appear 
are initially inherited from the parent module or section to which the topic is linked and other 

properties are initially set to the values that you have configured in the Options dialog box. 
For example, the general properties (Template, Language, Resolution, and Glossary) are 

inherited from the parent document, whereas topic-specific properties (Play Modes and Know 
It options) are the same as the defaults set in Options dialog box. 
 

Empty vs. Recorded Topic 

A new topic is empty until you open it and start recording. An empty topic  is distinguished 

from a recorded topic  by its icon. When you open an empty topic, the Recorder starts. You 

can continue to record an application or you can click Cancel (automatic recording) or Finish 
(manual recording) to cancel the recording and return to the Outline Editor. Once you start 
recording and press PRINTSCREEN (automatic recording) or click Finish (manual recording), 
the topic opens in the Topic Editor ready for editing. 
 

Publishing Note: Empty topics are not included in any published output. 
 

 Multi-user Considerations 

 A Check Out Parent Document message appears when you perform actions that 

impact a parent document that you do not have checked out such as linking a 
document, moving a document, pasting a document, deleting document links, and so 
on. 
  
Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 

  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To link a new topic: 

1. Display the Outline Editor by opening the outline or section for which you want to link 
a new topic. 

  
2. Select the parent document to which you want link the new topic. 

  

3. On the Link menu, choose  New Topic. 

  
You can also right-click the parent document and choose Link New Topic. 
  
A new topic is linked (and automatically saved) and appears beneath the parent 
document with a default name that you should change. 
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4.2.4 Import a New Topic from Record It! 

Record It! is a standalone application designed to provide anyone with the ability to create 

recorded content that can be imported into the Developer. Record It! allows you to easily 
record the necessary steps to complete any software transaction complete with sound and any 
additional notes or instructions that you want to provide to the author who will receive your 
content.  
  
Note: The Record It! application is automatically installed with a client installation of the 

Developer. 
  
Content authors can make this application available to subject matter experts who can record 
topics that can then be imported into the Developer for refinement and publishing. Topics 
created in Record It! are saved as .topic files to any file system location. The subject matter 
expert can either send the topics to a content author or save them to a location shared with 
the content author.  

  
Content authors can import Record It! .topic files from the Library or the Outline Editor views. 

Record It! files imported from the Library view are stored as topic documents in either the 
current or selected folder in the Library. Record It! files imported from the Outline Editor view 
are automatically linked to the selected parent document (module/section) in the outline and 
saved to the Library at the same time. You can import multiple Record It! files at one time. 
  

Record It! files imported from the Library inherit the current content default properties. Record 
It! files imported from the Outline Editor inherit the content default properties of the parent 
document in the outline to which the topic links.  
  

To import a new Record It! topic in the Library: 

1. Select a folder. 

  

2. Select the Tools menu, point to Import and choose  Topic from Record It! 

  
3. Browse to the location where the Record It! files are stored (.topic). 

  
4. Select one or more files to import and click Open. 

  
5. Click Import. 

To import and link a new Record It! topic in the Outline Editor: 

1. Display the Outline Editor by opening the module or section to which you want to link 

a new Record It! topic. 
  

2. Select the parent document to which you want link the new topic. 
  

3. Select the Tools menu, point to Import and choose  Topic from Record It! 

  
4. Browse to the location where the Record It! files are stored (.topic). 

  
5. Select one or more files to import and click Open. 

  
6. Click Import. 

 
Each imported topic is linked and appears beneath the parent document. 

Note: When importing a Record It! topic from the Library or Outline Editor, you can use the 
Import Content To field to change the Library folder in which the topic is saved. 
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4.2.5 Link an Existing Document 

In addition to linking a new document to the outline, you can also reuse content by linking an 

existing document into the structure. There is no limit to the number of times you can reuse 
an existing document. However, inserting an existing document creates a link to the original 
document and does not create a copy of the existing document. Therefore, if you link multiple 

instances of the same document into your outline and then modify one instance of that 
document, your changes are reflected in all linked instances.  
 
Note: You can also copy an existing document and link it to another document. When you 
copy a document, you have the option to link it as the original or link it as a copy. When it is 
linked as a copy, you can change the content of the copy without changing the content of the 
original document. 

 
In addition to linking new and/or existing documents from the Outline Editor, you can also 
drag-and-drop or copy/paste documents from the Library into the outline. To do this, you 
need to split the view and open the Outline Editor in one pane and the Library in another. 
Then you can select one or more documents in the Library and either copy/paste or drag-and-

drop them into the Outline Editor. 

 
Note: When you link an existing document into the outline, the linked document retains its 
original property settings from when the document was created and does not inherit 
properties from its new parent. 
 

 Multi-user Considerations 

 A Check Out Parent Document message appears when you perform actions that 
impact a parent document that you do not have checked out such as linking a 
document, moving a document, pasting a document, deleting document links, and so 
on. 
  

See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To link an existing document: 

1. From the Outline Editor, select a parent document to which you want to link the 
existing document. 

  
2. On the Link menu, choose Existing Document. 

  
You can also right-click the document and choose Link Existing Document. 
  

3. Browse to a Library folder to locate the document that you want to link. 
  

4. Select a document and click Link. If you selected a module or section as the parent 
document, the document is linked as a child document. If you selected a topic as the 

parent document, the document appears directly beneath the topic at the same level 
(since a topic cannot have child documents). 

4.2.6 Delete a Document Link 

From the Outline Editor, you can delete any link between a document and its parent 
document. For example, you can remove a section (or module) from a module, a topic from a 
section or module, a section from another section, and so on.  
 
Deleting a link does not remove a document from the Library; it only removes the link 

between the selected document and its parent. Deleting a link in the Outline Editor does not 
remove other linked content from the document such as a web page or package attachment. 
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You can use either the Delete Link or Cut command to remove links. The Cut command makes 

the document available for pasting; however, the Delete Link command does not. 

 
Note: You cannot remove the root document in the Outline Editor. 
 

Find Orphan Documents 

When you delete document links from an outline, the result may be orphan documents that 
are no longer needed. You can use the Library to find orphan documents with no relationships 
to other documents. To do this, add the Links To column to the Library and sort the column to 
show documents with zero links first. You should review the list and identify those documents 
that you want to delete. Keep in mind that module and section documents with zero links may 
be used as the root document in one or more outlines. 
 

 Multi-user Considerations 

 A Check Out Parent Document message appears when you perform actions that 
impact a parent document that you do not have checked out such as linking a 

document, moving a document, pasting a document, deleting document links, and so 

on. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To delete a document link: 

1. From the Outline Editor, select the document(s) that you want to unlink. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose  Delete Link. 

  
You can also right-click the document and choose Delete Link. 

To delete a document link using Cut: 

1. From the Outline Editor, select the document(s) that you want to unlink. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose  Cut. 

  
You can also right-click the document and choose Cut. 

4.2.7 Rename a Document 

You can rename any document from the Library. From the Outline Editor, you can only rename 
a module, section, or topic document.  
 

Since documents are identified by their ID, two documents with the same name can exist in 
the same Library folder or outline. 
 
Note: You can also rename a document using the Name property in the Properties toolpane 
(General category). However, you cannot rename multiple documents at the same time using 
this toolpane. 
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 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 

any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. 
  
The Developer preserves the name of versioned documents. When you roll back a 
renamed document to a previous version, the document name rolls back as well. 

To rename a document: 

1. Click the document that you want to rename. 

  
2. On the Edit menu, choose Rename. 

  
After selecting a document, you can also click the document name or press F2 to start 

edit mode. 
  
You can also right-click a document and choose Rename. 
  

3. Type the new document name. 
  

4. Press ENTER or click anywhere outside the name to save your changes. 

4.2.8 Move a Document (Outline Editor) 

You can change the sequence of documents within a parent and/or change the link between 
any documents in the hierarchy by moving documents (with the exception of the root 

document) that are displayed in the Outline Editor. Moving a document in the Outline Editor 
does not change where it is stored in the Library; it only changes its sequence or link to a 
parent document.  
 

To move a document, you can either drag-and-drop it using the mouse, cut and paste the 
document, or use the Move Up/Move Down commands on the Edit menu. Cutting a document 
removes it from the hierarchy until you paste it in another location (although pasting a cut 

document is optional). Cutting is similar to deleting a link in that it removes the relationship 
between a document and its parent. The difference between cutting a document and deleting 
a link is that the Cut command makes the document available for pasting and the Delete Link 
command does not. 
 
When you move or cut an outline or section document that has related child documents, all 
child documents are moved as well. For example, if you move a section that has several 

topics, all topics are moved and linked to the new destination document. 
 
Note: If you move a document between outlines using drag-and-drop, the Paste Special 
dialog box appears so you can choose the action that you want to perform. 
 

Also note that you cannot drag-and-drop documents from the Outline Editor to the Library. 

 
The Move Up/Move Down commands can only be used to move a document within its parent. 
These commands cannot be used to move documents to different parent documents. For 
example, if a section has multiple topics, you can use these commands to change the 
sequence of the topics within that section only. You cannot move a topic from one section to 
another. Use drag/drop or cut/paste to change parent document relationships. 
 

 Multi-user Considerations 

 You can move or cut a document regardless of its check in/out state. However, when 
you move or cut a document you may be prompted to check out the parent document. 
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A Check Out Parent Document message appears when you perform actions that 

impact a parent document that you do not have checked out such as linking a 

document, moving a document, pasting a document, deleting document links, and so 
on. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To move a document in the Outline Editor using drag-and-drop: 

1. Select the document you want to move. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. Drag the document and drop it in the desired destination within the outline. 
  

As you drag a document, a yellow arrow also moves along with a <documents will be 
inserted here> node across the content structure. Release the mouse button when the 
arrow and <documents will be inserted here > node appear at the destination that you 
want in the outline. 

  
If you want to move a document to a different level in the outline you must move the 
mouse to the left. In some cases, you may have to drag the document to the bottom 
of the list beneath its parent to move it to higher level in the outline. For example, if 
you have a section that has several topic child documents and you want to move the 
first topic to be on the same level as the parent section, you must drag the first topic 
to the end of the list first and then drag the document to the left. 

To move a document in the Outline Editor using Cut and Paste: 

1. Select the document(s) that you want to cut. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose  Cut. 
  

You can also right-click your selection and choose Cut. 
  
The document(s) immediately disappears from the outline. You can stop now if you do 
not want to paste the cut documents or continue to establish a new link for the cut 
document. 
  

3. Point to the document where you want to establish a new link. 

  

4. On the Edit menu, choose  Paste. 
  

You can also right-click the document where you want to paste your selection and 
choose Paste. 

To move a document in the Outline Editor using Move Up/Move Down: 

1. Select the document that you want to move. 
  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
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2. On the Edit menu, choose  Move Up or  Move Down depending on the 

direction in which you want to move the document. The first document of the parent 

can only be moved down and the last document of the parent can only be moved up. 
You cannot move a document to a new parent using these commands. 

4.2.9 Copy and Paste a Document (Outline Editor) 

In addition to moving documents in the hierarchy, you can copy and paste documents to 
further refine the outline. When you paste a copied document, you can choose to paste it 
either as a link to the original document or as a copy of the original document.  
 
You can use one of the following two Edit, Paste commands to paste copied documents: 

 Paste - always pastes a new link to the original document(s). If the content of the 
original document changes, the changes are reflected in all linked instances of the 
document. 
  

 Paste Special - presents options to either paste a new instance of the original 

document (Link), paste a copy of the original document as a new document but 
maintain links to the original related document (Copy), or paste a copy of the original 
document and all related documents as new documents (Duplicate). 
  
When you duplicate a document that has child documents, all child documents are 

copied as well. For example, if you duplicate a section that has several topics, all 
topics are copied along with the section. Also, when you duplicate a document that has 
related documents such as web pages, packages, and See Also links to other 
documents, copies of the related documents are made. 
  
You can choose to include or not include duplicate the glossaries and style sheets 
linked to the selected content. If you do not include glossaries and style sheets in the 

duplication, the duplicated content links to the glossaries and style sheets linked to the 
original source content; this allows you to maintain a master glossary and style sheet 

for all related content. The default setting for glossaries is to create a duplicate since 
you may want to change the definition of terms for new versions of your content 
without affecting previous versions. The default setting for style sheets is to not 
duplicate, with the purpose of linking all content to a single style sheet. 
  

Note: The Duplicate (selection and related) option does not create copies of 
templates, master role lists, sound files, and custom icon packages. The new, 
duplicated documents reference the original documents of these types. 

You cannot copy documents from the Outline Editor and paste them into the Library. 
 

 Multi-user Considerations 

 You can copy a document regardless of its check in/out state. However, when you 
paste a copied document you may be prompted to check out the parent document. 

  
A Check Out Parent Document message appears when you perform actions that 
impact a parent document that you do not have checked out such as linking a 
document, moving a document, pasting a document, deleting document links, and so 
on. 

  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 
  
If you copy and paste a document checked out to another author, the Developer uses 
the latest document checked into the server. 

  
If you copy and paste a document while working offline, the Developer copies the 
document in your local cache. 
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If you paste new copies of all documents using the Duplicate option of the Paste 

Special command, all new documents are automatically checked out to you. Document 
history from the original documents is removed and the version number is set to New. 

To copy and paste a new instance of original document: 

1. Select the document(s) that you want to copy. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose  Copy. 

  
You can also right-click your selection and choose Copy. 
  

3. Select the document where you want to paste your selection. 

  

4. On the Edit menu, choose  Paste to paste a new instance of the original document. 
  

You can also right-click the document where you want to paste your selection and 
choose Paste. 

Note: You can also use the Paste Special command (from the Outline Editor) and choose the 
Link option to paste a link to the original document in addition to the options listed next. 
 

To copy and paste new documents without related documents: 

1. Select the document(s) that you want to copy. 

  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose  Copy. 

  
You can also right click your selection and choose Copy. 
  

3. Select the document where you want to paste your selection. 
  

4. On the Edit menu, choose Paste Special and select the Copy (selection only) 
option to create new documents but retain links to the original related documents such 
as web page and package attachments, glossaries, and so on. 

To duplicate documents: 

1. Select the document(s) that you want to copy. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose  Copy. 

  
You can also right click your selection and choose Copy. 
  

3. Select the document where you want to paste your selection. 
  

4. On the Edit menu, choose Paste Special and select the Duplicate (selection and 
related) option to create new copies of both the original selected documents and new 
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copies of all related documents such as web page and package attachments, 
assessments, and so on. Click the View related documents link to display a list of 

the related documents if you are not sure whether you want to duplicate related 
documents. 

  
Select Duplicate Glossaries and Duplicate Style Sheets to create new copies of those 
document types that link to the new copies of the content. Leave the options 
unchecked if you want the new copies to link to the original glossaries and style 
sheets. 

4.2.10 Print an Outline 

The outline or any portion of the outline can be printed to a file or printer. Included in the 
output is the outline structure as well as the layout defined in the Details View of the Outline 
Editor. To print an outline, you must open either a module or section in the Outline Editor. A 
set of default data columns is automatically included in the output; however, you can 

configure which columns you want to appear in the report by switching to the Details View and 
customizing the columns. The Details View does not have to be displayed to print a report; 

however, only the Name column is included in the report when printed from the Player View.  
 
Note: The report does not honor column sizes that appear in the Details View. You can change 
the page orientation or adjust the margins to modify the column sizes, or save the report to 

Microsoft Excel and adjust the columns there. 
 
To print an outline, first expand the documents to show the detail that you want included in 
the report. For example, if you want the report to show child documents for modules/sections, 
make sure you expand these nodes first. Also note that deleted or missing documents are 
included. 
 

The report opens in a new window. Use the following toolbar icons to print the report, 
configure printer settings, export the report to file or graphic format, and so on. 
  

 Searches the report for text. 

 

 Displays the current printer settings such as the active printer, status, page range, number 
of copies, and so on. 

 

 Prints the report to the active printer. 
 

 Displays the current page setup such as paper size, orientation, and margins that you can 
change. 
 

 Displays scaling options such as scaling by a percentage of normal size and fit to pages 
options. 

 

 Scrolls the report. 
 

 Zoom Out. You can also enter a Zoom Factor percentage to zoom in or out. 
 

 Zoom In. 

 

 Move to the First Page. 

 

 Move to the Previous Page. 

 

 Move to the Next Page. 

 

 Move to the Last Page. 
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 Saves the report to PDF, HTML, Excel, or graphic format. Your selection displays additional 

options based on the file type you selected. 

 

 Close Preview. 
 

To print an outline from the Outline Editor: 

1. Open a module or section document in the Outline Editor. 

  
2. Expand the documents to display the details that you want included in the report. 

  
3. On the File menu, choose Print and use the toolbar icons to print, view, or save the 

report to a file. 

4.3 Use Content Tools 
After you build an outline, you can use the following techniques to manage and refine your 
content:  

 Find and replace text in documents 
   

 Find Context 

   

 Replace fonts and styles in document text 

   

 Spell check content 
   

 Find a document in the Library 

4.3.1 Find and Replace Text 

The Find and Replace tool allows you to locate text in your content and replace it with 
alternative text, if desired.  
 
Text in the following areas is included in this operation: 

 Module, section, and topic names 
  

 Text and object names in the Frame Properties toolpane 
  

 Implicit text for string inputs 

  

 Decision frame headings and path names 

  

 Text in Author Notes, Instructor Notes, and Expected Test Results panes in the Topic 
Editor 

  

 Jump-in point text 

  

 Text in web pages 

  

 HTML elements such as text in tables, lists or image alt tags 
  

 Tooltips 
  

 Glossary terms and definitions 

  

 Keywords 
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 Roles 

  

 Document output fields in the Properties toolpane 
  

 Custom properties 

Note: The names of the following document types are not included in this operation: web 
pages, packages, glossaries, role lists, and publishing styles. 
  
Note: The search does not include search JavaScript, cascading style sheets (css) or html 
markup (only content text including Alt tags). 
 
You can start this tool from the Library or the Outline Editor only. From the Library, you must 

have at least one document selected or the tool is disabled. If nothing is selected in the 
Outline Editor, the entire outline is searched; this is equivalent to selecting the root of the 
outline. 
 

In the Find and Replace dialog box, you can type the search and replacement text or select 
from a list of previous entries. The Developer maintains a history of the search and replace 
text entries in both the Find What and Replace With lists. You can search for an entire 

sentence, a specific word, or a portion of a word. If the word or phrase for which you are 
searching has capitalization or formatting, the word or phrase with which it is replaced has the 
same formatting or capitalization. You can also replace text with an empty string (to delete 
the text) or with one or more spaces, except for document names. 
 
By default, the selection and its related documents are searched. Clicking the View Related 

Documents link displays any related documents and their locations. For this process, related 
documents are defined as all searchable documents that are directly or indirectly linked as 
children of the selection. For example, if you select a section that has topics and each of the 
topics has a web page linked as its concept, choosing to search related documents searches 
the section, the topics, and the web pages linked to the topics. Templates and package 
contents are not included in this operation. 

 

If you want to search only the selected item(s), you can deselect the Include Related 
Documents option in the Find and Replace dialog box. You can also select this option after 
starting the search to include related documents for the rest of the selection. 
 
To further define a search, you can choose options that allow you to ignore occurrences of the 
search text that appear as part of another word (Match Whole Word Only) and/or to find text 
that exactly matches the capitalization of the search text (Match Case). Special characters in a 

search string, such as * and ?, are treated as normal text during a search; they do not act as 
wildcards. 
 
Note: The Match Whole Word Only and Match Case options do not apply to Japanese or 
Chinese content. That is, these find options are ignored during searches of documents whose 
Language property is set to Japanese or Chinese. 

 
When the Developer finds the first instance of the text, it indicates the path in the Library to 

the document, plus information about where the word appears, such as a document name or 
web page text. You can choose to replace the text, keep searching the remainder of the 
content, or close the Find and Replace dialog box. 
 
You can precisely control text replacement by confirming each instance, or you can 

automatically replace all occurrences of the search text if you do not want to review each 
replacement. 
 
Warning! Use the Replace and Replace All options with caution. You cannot undo any text 
replaced using this tool. 
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 Multi-user Considerations 

 For changes to be made to a document using this tool, the document must be checked 
out. If you plan to use this tool offline, you should check out all affected documents 
before going offline. 
  

When you execute this process, the Developer searches through all of the documents 
in the selection, regardless of their check in/out state. If a change is necessary and 
the document is not checked out and if you are working online, the Developer 
automatically checks the document out to you and makes the change. If the document 
cannot be checked out, for example, if it is open in another editor or checked out to 
another user or you are working offline, it is skipped. At the end of the process, a 

summary message appears with a link to an activity log. Clicking the View Activity Log 
link in the message displays a list of the documents that were checked out to you 
during the process and those that could not be checked out. After you save any 
changes, you should check in the documents to make them available to other authors 
and add the changes to the Developer's version control system. 

To find text: 

1. From the Library or Outline Editor, select one or more documents or folders containing 

the documents in which you want to find text. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose  Find and Replace. 
  

3. Type the text you want to find in the Find what field. You can also select a previous 

entry from the Find what history list. 
  

4. Select the desired Find Options. 
  

5. Click Find Next. 
  
The first occurrence of the search text is displayed in the Location section, along with 

information describing the location of the text within the document and the location of 
the document within the Library. If the text cannot be found, a message box displays 
informing you that the text was not found in the selected content. Click OK to close 
the message box. 
  

6. Click Find Next as needed to search for additional occurrences of the text. 

  
Each subsequent occurrence of the search text is displayed in the Location section of 
the Find and Replace dialog box. 
  

7. Click OK when notified that the search is completed. 
  

8. When you are done finding text, click Close. 

To find and replace text: 

1. From the Library or Outline Editor, select one or more documents or folders containing 

the documents in which you want to replace text. 
  

2. On the Edit menu, choose  Find and Replace. 
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3. Type the text you want to find in the Find what field. You can also select a previous 
entry from the Find what history list. 

  
4. Type the replacement text in the Replace with field. You can also select a previous 

entry from the Replace with history list. 
  

5. Select the desired Find Options. 
  

6. Click Find Next. 
  
The first occurrence of the search text is displayed in the Location section, along with 

information describing the location of the text within the document and the location of 
the document within the Library. If the text cannot be found, a message box displays 
informing you that the text was not found in the selected content. Click OK to close 
the message box. 
  

7. For each occurrence of the search text, you can do one of the following: 

  

Click Replace to replace the current occurrence with the replacement text and 
advance to the next occurrence. If you are working in the Outline Editor, the first time 
you replace text, a Replace Confirmation message appears indicating that you cannot 
undo changes made during find and replace. Click Yes to replace the text and 
continue the search or No to cancel the find and replace process. 
  

Click Replace All to replace all remaining occurrences with the replacement text. If 
you are working in the Outline Editor, a Replace Confirmation message appears 
indicating that you cannot undo changes made during find and replace. Click Yes to 
replace all occurrences of the text or No to cancel the find and replace process. 
  
Click Find Next to skip the current occurrence without replacing the text and advance 
to the next occurrence. 

  
8. When the find and replace process has completed, click OK to close the confirmation 

message box. 
  
If you made one or more replacements, you can also click the View activity log link to 
see a list of documents in which replacements were made and the number of 

replacements in each document. 
  

9. When you are done replacing text, click Close. 

4.3.2 Find Context 

When there are changes to an application interface or context, a content author may need to 
locate all documents with the changed context so the content can be updated. The Developer 
has a number of tools that allow you to locate documents that are impacted by application 
changes using a context search. Context can be searched from the Outline/Library or the Topic 
Editor. 

  

The Find Context functionality consists of two types of searches:  

 Capture and set Context: Search for context directly from a target application screen 
by recording the screen and searching for documents with the same context. 
   

 Set Context by selected Document: Search for documents that match the context of 
the selected document. 

You can access the Find Context functionality from the Standard toolbar, Edit menu or the 
Context Search pane. 
  



Build an Outline 

 

 116 

The Context pane provides the tools to create a new search, refresh an existing search, view 

the context of a document, select the scope (by folder or individual document) of the search, 

print/save search results, or clear search results. 
  

 Find Context: Use to select the View Context, Capture and set Context or Set Context 

from selected Document tools for initiating a search. 
  
Find in: Use to select the Library or any open tab to set the scope when searching for context 
from the Topic Editor. 
 

 Context: State of the icon when you are on a document that does not use context such as 
a web page. 
  

 Context: State of the icon when you first context has never been captured for a 
document. 

  

 Context: State of the icon after a context search has been performed and the context has 
not been stored. 

  

 View documents and folders included in search: Use to view the documents or folders 
included in a search from the Topic Editor. 

  

 Print: Use to print or save search results. 

  

 Clear search: Use to clear the search results. 
  

 Expand All: Use to expand the search results to display the document details row and 
frame details row for each document in the search results. 
  

 Collapse All: Use to collapse the search results to display only document details row for 
each document in the search results. 

  
Search result limit: Use to set the number of search results to display in the Context pane. 

You can select 50, 100, 200, All or enter the number. 

4.3.2.1 Find Context from Topic Editor 

You can use the context of a particular topic frame to search for other content with the same 
context. This is useful if you know an application screen has changed for this topic and you 
want to find other topics with the same context so they can also be updated. 

  

To find context in an open topic in the Topic Editor: 

1. Display the Context Search toolpane. 

  
2. Navigate to the frame in the topic whose context to use in the search. 

  

3. Select Other or any open tab in the list in the Find in list: to launch the Find Context 
dialog box. 
  

4. Select Folder or Documents and to select the scope of the documents to search and 

click OK. 
  

5. Click OK. 
  

6. Click  Find Context. 

  
The search results display. 
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7. Click View documents and folders included in search to see which documents and 
folders were in the search. 

To find context in the Library from a topic in the Topic Editor: 

1. Display the Context Search toolpane. 

  
2. Navigate to the frame in the topic whose context to use in the search. 

  
3. Select Library in the Find in list: to launch the Find Context dialog box. 

  

4. Select Search my selection or Search my selection and related documents and 
to select the scope of the documents to search. 
  

5. Click OK. 
  
The search results display. 

  

6. Click View documents and folders included in search to see which documents and 
folders were in the search. 

4.3.2.2 Find Context from the Library or Outline 

The Set Context from selected Document option allows you to select a topic or module from 
the Outline or Library whose context is used to search for other documents with matching 
context. Before context is saved, the blue icon shows an empty box above the target 
indicating no contact has been saved. When you select a document from the Outline or Library 

and click Set Context from selected Document, the context is saved and the box disappears 
and a blue icon displays indicating the context is saved.  
 

The Select Context dialog box displays the context name associated with the document in the 
left pane and screenshot of the application from which the context was recorded. There can be 

multiple application screens recorded with the same context for the selected document. You 
can toggle through the screens by selecting the context in the Context Name pane. As you 
click on each context, the application screen it was record on displays in the Screen View 

pane. You can click the Enlarge to full resolution link on the Screen View pane so you can see 
the application screen. This opens the selected application screen in the Screen View dialog 
box. You can use the navigation tools to toggle through the application screens for the 
selected context name. 
 

To find context using a selected topic or module's context from the Outline or Library: 

1. Display the Context Search toolpane. 

  
2. Select the topic or module whose context you want to use to search from the Outline 

or Library. 

  

3. Click  on the Find Context icon and select Set Context from selected 
Document to store the context from the selected document. 
  
If more than one context exists for the selected document, select the context you 
want to use in the search on the Select Context dialog box. 

  
4. In the Library or Outline, select the documents or folders to search for matching 

context. 
   

5. Click  Find Context to open the Find Context dialog box. 
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6. Select Search my selection or Search my selection and related documents to 

select the scope of the documents to search. 

   
7. Click OK. 

4.3.2.3 Find Context from a Target Application 

You can use the context you record from a target application screen to search for documents 
with that screen's context. This is useful if you know an application screen has changed and 
you want to locate any documents that have that context so the screen can be updated.  

  

To search for context from a target application:   

1. Display the Context Search toolpane in the Developer. 

  
2. Select the documents or folder to search from the Outline or Library. 

  

3. Click  on icon and select Capture and set Context to open the Recorder. 
  

4. Click on the application screen whose context you want to use to search for other 

documents with the same context. 
5. Press PRINTSCREEN to record the context. 

   
6. Click the application screen or perform an action in the application to start the search. 

4.3.2.4 Navigate the Search Results 

The bottom of the Context Search pane displays the documents that matched your search 
results. A document details row containing the document name, path, language and document 

type displays for each document. A frame details row containing the context name displays for 
each document.  
  

You can navigate the search results by: 

 clicking on the +/- icons next to the document name to display/hide the context 
name(s) associated with this document. 
   

 double-clicking the document name to open the to document for editing. 
   

 hovering the cursor over the name of the context to view the application screen 
associated with the context. 

4.3.2.5 Print Search Results 

You can print or save your search results using the  Print search results icon on the Context 

Search pane. This opens the Preview dialog box that displays the results as they look in the 
Context Search pane. This dialog box has standard previewing tools such as scaling, zooming 

and printing. You can also save the results as a PDF, HTML, XLS, XLSX or Image file. 

4.3.3 Replace Fonts and Styles 

The Replace Font tool is used to locate text with specific formatting in your content and 
change the formatting, if desired. Replace Font can be used to replace the following 

formatting:  

 Replace direct formatting with other direct formatting (web pages and topics) 
  

 Replace direct formatting with a text style (web pages only) 

  

 Replace one style with another style (web pages only) 
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You can start this tool from the Library or the Outline Editor. From the Library, you must have 
at least one document selected or the tool is disabled. If no documents are selected in the 

Outline Editor, the entire outline is searched; this is equivalent to selecting the root of the 
outline. 

  

Replacement Scope 

By default, Replace Font searches the selection and its related documents. Clicking the View 
Related Documents link displays a list of the related documents and their locations. For this 
process, related documents are all searchable documents that are directly or indirectly linked 
as children of the selection. For example, if you select a section that has topics and each of 

the topics has a web page linked as its concept, choosing to search related documents 
searches the section, the topics, and the web pages linked to the topics. Templates and 
package contents are not included in this operation. If you want to search only the selected 
item(s), you can deselect the Include Related Documents option in the Replace Font dialog 
box. 
  

Replacement Options 

To further define a search, you specify the type(s) of text to include in font replacement. In 
topics, you can apply font replacement to bubble text, Introduction/End frame text, string 
input text, and template text. You can also apply font replacement to web page text. You must 
select at least one type of text to include before you can start the font replacement process. 
  

Note: Style replacement only applies to web pages. The topic text options are only available 
when replacing direct formatting with direct formatting; they are not available when replacing 
with styles. 
 
During font replacement, the Developer searches the specified type(s) of text in the topics and 
web pages in the selection and replaces all occurrences of the search font with the 
replacement font. The font replacement process completes automatically for the entire 

selection without prompts to confirm each replacement. 
 
Warning! Use font replacement with caution. You cannot undo any fonts replaced using this 
tool. 

  

 Multi-user Considerations 

 Fonts can only be replaced in checked-out documents. If you plan to use this tool 
offline, you should check out all affected documents before going offline. 
  

When you execute this process, the Developer searches through all of the documents 
in the selection, regardless of their check in/out state. If a change is necessary for a 
document that is not checked out, and if you are working online, the Developer 
automatically checks the document out to you and makes the change. If the document 
cannot be checked out, for example, if it is open in another editor or checked out to 
another user or you are working offline, it is skipped. At the end of the process, a 
summary message appears with a link to an activity log. Clicking the View Activity Log 

link in the message displays a list of the documents that were checked out to you 

during the process and those that could not be checked out. After you save any 
changes, you should check in the documents to make them available to other authors 
and add the changes to the Developer's version control system. 

4.3.3.1 Replace Direct Formatting 

You can use the Replace Font dialog box to replace direct font formatting with other direct font 
formatting for topics and web pages. For example, the current font is set to a Courier New, 

size 10 font and you want to replace all instances with a Verdana, size 11 font. To replace 
direct formatting, you specify the properties of both the search and replacement fonts. These 
properties include font family (such as Arial or Verdana), font size (such as small or 11), font 
unit (points or pixels), and font style (bold, italic, underline). 
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If you do not specify any of these properties, the search and replace ignores that property. For 

example, if you set the Find What options to Arial, blank, blank, and Bold, respectively, the 

Developer searches the selected content for bold Arial text of all sizes. Similarly, if you set the 
Replace With options to blank, large, blank, and blank, respectively, the Developer changes 
the size of the located text to large, but leaves the font family, unit and style unchanged. 
  
To further define a search, you specify the type(s) of text to include in font replacement. Topic 

text options are only available when replacing direct formatting with direct formatting. In 
topics, you can apply font replacement to bubble text, Introduction/End frame text, string 
input text, and template text. You can also apply font replacement to web page text. You must 
select at least one type of text to include before you can start the font replacement process. 
  
Note: Bubble text in topic frames does not support font families (such as Arial, Helvetica, 
sans-serif) or font units in pixels. If you select a font family or pixel unit to find or replace, all 

of the Apply to options that pertain to topics, such as bubble text and string input options, are 
disabled.  
  

To replace direct formatting with different direct formatting in your content: 

1. From the Library or Outline Editor, select one or more documents or folders containing 

the documents in which you want to replace a font. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose Replace Font. 
  

3. In the Direct formatting row of the Find what section, select the font, font size, 
unit, and font style you want to replace. 
  

4. In the Direct formatting row of the Replace with section, select the font, font size, 
unit, and font style with which you want to replace the search font. 

  
5. Select or deselect Include related documents. 

  
If you include related documents, click View related documents to see the 
documents included in the find and replace. 
  

6. In the Apply to section, select the text to which the font replacement should be 
applied. 
  
You can replace fonts in topic bubble text, Introduction/End frame text, string input 
text, template text, and web page text. 
  
Note: The options that apply to topic bubble text are disabled if the find or replace 

formatting specifies a font family or pixel unit. 
  

7. Click Replace. 
  
If you are working in the Outline Editor, a Replace Confirmation message appears 
indicating that you cannot undo changes made during font replacement. Click Yes to 
continue or No to cancel the font replacement process. 

  
The Developer searches the topics and web pages in the selection and replaces every 
occurrence of the search font with the specified replacement font. 
  

8. Click OK when notified that the font replacement is completed or that the font cannot 
be found in the selected content. 

  
If one or more replacements were made, you can also click the View activity log link 
to see a list of documents in which replacements were made and the number of 
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replacements in each document. 
  

9. When you are done replacing fonts, click Close. 

4.3.3.2 Replace with Styles 

Styles provide much greater flexibility over direct formatting for formatting content. The 
Replace Font dialog box provides the tools to help you move your content from direct 
formatting to styles. Style replacement only affects web pages as styles can only be applied to 
web pages. When you replace with a style, all Apply to options that relate to topic bubble text 
are inactive because the replace process ignores all topic text.  
 

Replace Direct Formatting with a Text Style 

If you have web pages formatted with manually applied formatting, the Replace Font dialog 
box can help you replace that formatting with text styles. 
 

You replace direct formatting with a style by specifying the direct formatting you want to 
replace in the Find What section and the style sheet and style name in the Replace With 

section. A style sheet must link to the content to be available for selection from the Replace 
With section. Several style sheets may appear in the style list if the selected documents and 
related documents link to more than one sheet. 
 

Note that only text styles are relevant for replacing direct formatting; which means that only 
text styles appear in the Style name list. You cannot replace simple direct formatting with a 
paragraph style. A preview of the replacement style appears in the Example box. 
 

Replace a Style with another Style 

You can also use the Replace Font dialog box to replace one style with another style; however, 

both styles must be from the same style sheet and of the same element. After selecting a 
style sheet in the Find What section, you are prevented from selecting a different style sheet 
in the Replace With section. After selecting the style you want to find, the replacement choices 
are limited to styles of the same element. For example, you cannot replace a table with a list 
style. You can preview the replacement style in the Example box. 
 

To replace direct formatting with a style: 

1. From the Library or Outline Editor, select one or more documents or folders containing 

the documents in which you want to replace a font. 
  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose Replace Font. 
  

3. In the Direct formatting row of the Find what section, select the font family, font 
size, unit, and font style you want to replace. 

  
4. In the Style row of the Replace with section, select the select the style sheet and the 

name of the style to replace the direct formatting. 
  
Note: Only the style sheets that are linked to the content appear in the Style sheet 
list. 
  

A preview of the replacement style appears in the Example box. 
  

5. Select or deselect Include related documents. 
  
If you include related documents, click View related documents to see the 
documents included in the search and replace. 
  

6. Enable Web page text in the Apply to field. 
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7. Click Replace. 

  

If you are working in the Outline Editor, a Replace Confirmation message appears 
indicating that you cannot undo changes made during font replacement. Click Yes to 
continue or No to cancel the font replacement process. 
  
The Developer searches the topics and web pages in the selection and replaces every 

occurrence of the search font with the specified replacement font. 
  

8. Click OK when notified that the font replacement is completed or that the font cannot 
be found in the selected content. 
  
If one or more replacements were made, you can also click the View activity log link 
to see a list of documents in which replacements were made and the number of 

replacements in each document. 
  

9. When you are done replacing fonts, click Close.  

To replace a style with another a style: 

1. From the Library or Outline Editor, select one or more documents or folders containing 

the documents in which you want to replace a font. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Edit menu, choose Replace Font. 
  

3. In the Style row of the Find what section, select the select the style sheet and the 
name of the style you want to replace. 
 
Note: Only the style sheets that are linked to the content appear in the Style sheet 

list. 
    

4. In the Style row of the Replace with section, select the name of the replacement 

style. 
  
A preview of the replacement style appears in the Example box. 
  

5. Select or deselect Include related documents. 
  

If you include related documents, click View related documents to see the 
documents included in the search and replace. 
  

6. If necessary, enable Web page text in the Apply to field. 
  

7. Click Replace. 

  

If you are working in the Outline Editor, a Replace Confirmation message appears 
indicating that you cannot undo changes made during font replacement. Click Yes to 
continue or No to cancel the font replacement process. 
  
The Developer searches the topics and web pages in the selection and replaces every 
occurrence of the search font with the specified replacement font. 
  

8. Click OK when notified that the replacement is completed or that the font cannot be 
found in the selected content. 
  
If one or more replacements were made, you can also click the View activity log link to 
see a list of documents in which replacements were made and the number of 
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replacements in each document. 
  

9. When you are done replacing fonts, click Close. 

4.3.4 Spell Check Content 

After recording and editing content, and especially before publishing, you should verify that 
the spelling of text included in the content is correct.  
 

Text in the following areas is included in this operation: 

 Module, section, and topic names 
  

 Text and object names in the Frame Properties toolpane 

  

 Implicit text for string inputs 
  

 Decision frame headings and path names 

  

 Jump-in point text 

  

 Text in Author Notes, Instructor Notes, and Expected Test Results panes in the Topic 
Editor 
  

 Text in web pages 
  

 Tooltips 

  

 Glossary terms and definitions 
  

 Keywords 
  

 Roles 

  

 Document output fields in the Properties toolpane 

  

 Custom properties 

Note: The names of the following document types are not included in this operation: web 
pages, packages, glossaries, role lists, and publishing styles. 
 
You can only start this tool from the Library or the Outline Editor. From the Library, you must 
have at least one document selected or the tool is disabled. If nothing is selected in the 

Outline Editor, the entire outline is searched; this is equivalent to selecting the root of the 
outline. 
 
If the document(s) selected for spell checking are linked to other documents, you are 

prompted with the choice of checking the selection only or the selection and related 
documents. Clicking the View Related Documents link displays a list of the related documents. 

For this process, related documents are defined as all searchable documents that are directly 
or indirectly linked as children of the selection. For example, if you select a section that has 
topics and each of the topics has a web page linked as its concept, choosing to search related 
documents searches the section, the topics, and the web pages linked to the topics. Templates 
and package contents are not included in this operation. 
 
By default, the Spelling tool ignores words that are in all uppercase letters and attempts to 

split compound words into two words. However, you can change these settings on the Spelling 
page in the Tools Options dialog box before you start a spell check, or, if you have already 
started a spell check, you can use the Options button at the bottom of the Check Spelling 
dialog box. 
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When a misspelled word is found, the Developer identifies the Library path of the document in 

which the word appears, as well as the context of the word within the document. You then 

have the option of ignoring that particular instance or all instances of the word, changing the 
word in that particular location or in all locations where it appears, or adding the word to the 
custom dictionary. 
 
Warning! You cannot undo any changes made during a spelling check. 

 
When you add a word to your dictionary during a spelling check, the word is added to the 
custom dictionary specified in the Spelling page in the Options dialog box. While performing a 
spelling check, you can also switch custom dictionaries or create a new one. 
 

Language Property 

During a spelling check, the Developer uses the dictionary that matches the Language 
property of the document it is currently checking. If the content selected for a spelling check 
includes documents with different assigned languages, the spelling checker switches 
dictionaries as needed. If no dictionary of the same language exists, the spelling checker skips 

the document and adds a message to the activity log. 
 

 Multi-user Considerations 

 For changes to be made to a document using this tool, the document must be checked 
out. If you plan to use this tool offline, you should check out all affected documents 
before going offline. 
  

When you execute this process, the Developer searches through all of the documents 
in the selection, regardless of their check in/out state. If a change is necessary and 
the document is not checked out and if you are working online, the Developer 
automatically checks the document out to you and makes the change. If the document 
cannot be checked out, for example, if it is open in another editor or checked out to 
another user or you are working offline, it is skipped. At the end of the process, a 

summary message appears with a link to an activity log. Clicking the View Activity Log 

link in the message displays a list of the documents that were checked out to you 
during the process and those that could not be checked out. After you save any 
changes, you should check in the documents to make them available to other authors 
and add the changes to the Developer's version control system. 

To spell check a document: 

1. From the Library or Outline Editor, select one or more documents or folders containing 

the documents whose content you want to spell check. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

2. On the Tools menu, choose  Spelling. 

  
You can also press the F7 key. 

  
The Spell Check dialog box appears when you perform an action on any document that 
has links to other documents. You can choose to process only the document(s) you 
selected or to process your selection and all of the related documents. 
  
Click the View related documents link to display a list of the related documents if you 
are not sure whether you want to include related documents. 

  
After you have made your selection, click OK. 
  

3. If a misspelling is found, it is displayed in the Location section, along with information 
describing the location of the text within the document and the location of the 
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document within the Library. Click Ignore, Ignore All, Change, Change All, or Add, 
as appropriate. 

  
If you are working in the Outline Editor, the first time you change a word, a Replace 

Confirmation message appears indicating that you cannot undo replacements made 
during a spelling check. Click Yes to continue or No to cancel the spell check. 
  

4. If necessary, click Options to change the spelling options or the custom dictionary. 
  
To change the custom dictionary, select the dictionary from the Custom dictionary list 
in the Options dialog box and click OK. You can also click User Dictionaries in the 

Options dialog box to create a new custom dictionary. After you change the custom 
dictionary, clicking Add in the Check Spelling dialog box adds the word to the newly 
selected dictionary. 
  

5. Click OK when the spelling check is complete. 
  

If you changed one or more misspelled words, you can also click the View activity log 

link to see a list of documents in which changes were made and the number of 
changes in each document. 

4.3.5 Find a Document in the Library 

From the Outline Editor, you can select one document and find its folder location in the 
Library. 
 
In a single layout, the Library tab opens if the Library is not already displayed. If the Library is 
open, it becomes the active tab. 
 

Note: If the Library is using a custom view when finding a document, the view is 
automatically switched to the Details view. 
 
In a split layout (horizontal or vertical), the Library is activated in the layout other than the 

one in which you selected the document from the Outline Editor. For example, if you have a 
horizontal split layout with a document selected in the Outline Editor from the top layout and 
you run this command, the Library is opened in the bottom layout with the folder location and 

document highlighted. 
 

To find a document in the Library: 

1. Open an outline in the Outline Editor. 

  
2. Select one document that you want to locate in the Library. 

  
3. On the View menu, choose Find in Library to display the selected document in the 

Library. 
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5 Record Topic Content 
You can record content using the full Developer or you can use the Record It! wizard. The 
Record It! wizard streamlines the creation of recorded content without a full Developer 
installation. You decide whether to install the full Developer or the Record It! wizard, or both 
at installation time. The Record It! wizard is designed for authors that want to create recorded 
topics quickly and for those that do not need the complete capabilities of the Developer. The 

Record It! wizard can also be used to record testing procedures and produce a printed test 
document. 

5.1 Use the Recorder 
The Recorder appears on top of the application while you are recording the task. When the 
Recorder is active, the Outline Editor closes, allowing the Recorder to take screen captures as 
you perform the steps. Each time you capture an action while recording, the Recorder 
disappears while the screen is captured to prevent the Recorder from appearing in the results.  
 

The Recorder contains brief instructions to help you during the recording process. The Last 
recorded event field tells you the last action you captured. The Next screenshot records field 
indicates the next action that you will capture. 
 

Note: If you are recording in automatic mode, the Recorder disappears after you press 
PRINTSCREEN and records each screen and action until you press PRINTSCREEN again. The 
Recorder contains brief instructions that tell you to press PRINTSCREEN to start recording and 

press PRINTSCREEN again to stop recording. 
 

Note: If you are recording content that will be deployed to end users in the Player format, you 
should record the topics using the same version of the target application that the end users 
will have when playing the content. Otherwise, context sensitivity may not function properly in 
the Player. 

5.1.1 Recorder Logic 

The Recorder functions like a screen capture utility. When you record a topic, you are taking a 
series of pictures of the way the screen looks after each step in a task. Each screen image you 

capture also has an associated action. This action that you perform (mouse click or keyboard 
action) moves you to the next screen. The screenshot and associated action are called a 
frame. The recorder can be set up to function in automatic recording mode (default) or manual 
recording mode. You can change the recording mode in the Recorder category from Tools, 
Options by selecting the desired mode (Manually or Automatically record screenshots).  
 

Automatic vs. Manual Recording 

Use Automatic Recording when you are recording a familiar system process to keep errors to a 
minimum. In this mode, every action after you press PRINTSCREEN is recorded until the next 
PRINTSCREEN. Inadvertent actions are recorded and will have to be edited out in the Topic 
Editor. 
 

Use Manual Recording mode when you are less familiar with the system process you are 

recording. This mode requires you to press PRINTSCREEN after each action you record, giving 

you the opportunity to correct mistakes before the recording is saved with the next 
PRINTSCREEN. 
 

Automatic Recording 

To automatically capture a screen, you press the PRINTSCREEN key on your keyboard. 
Because of the way the Recorder works in automatic recording mode, only two PRINTSCREENS 
are necessary to capture the information for all frames, one to start recording and one to end 

the recording. When you press PRINTSCREEN at the beginning of the topic, the Recorder 
captures each screen and its associated action until you press PRINTSCREEN again. 
 

Before you begin recording, the recorder displays instructions for you to press PRINTSCREEN 
to start recording and press PRINTSCREEN again to stop recording. The recorder is hidden 
after the first PRINTSCREEN so it is not recorded with the application. 
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Note: Point events are not recorded when using the automatic recording mode because there 

is no way to record the action without an event such as a mouse click; for example, when you 
click on a menu then move your cursor to a menu item that opens a submenu. No action 
occurs until you click on the submenu item. Use manual recording mode to record this type of 

situation because you can PRINTSCREEN on the menu item and submenu item to capture 
without a click. 
 
Automatic recording mode is not supported when re-recording a topic. Re-recording a topic is 
always a manual process. 

 

Manual Recording 

To manually capture a screen, you press the PRINTSCREEN key on your keyboard. Because of 
the way the Recorder works in manual mode, two PRINTSCREENS are necessary to capture 
the information for one frame; one for the screenshot and one for the action. When you press 
PRINTSCREEN at the beginning of the topic, the Recorder captures the first screen and creates 

a screenshot file. When you then perform an action and press PRINTSCREEN again, the 
Recorder captures the action you performed and associates it with the first screen to create 

the first frame, and it also captures the screen as it appears as a result of performing the 
recorded action and creates a screenshot file. 
 
As you record frames, two display fields in the Recorder help you keep track of what is being 
recorded. The Next screenshot records field displays the action that you have performed 

that will be captured the next time you press PRINTSCREEN. The Last recorded event field 
tells you the action that was captured the last time you pressed PRINTSCREEN. 
 
Note: You can configure the Recorder to record sound during the screen capture process. The 
Recorder behavior depends on the configuration of several options in the Record category on 
the Options dialog box. See Configure the Recorder for Sound for more information. 

5.1.2 Context Recognition in the Recorder 

Context information can be used in conjunction with in-application support to provide context-

sensitive help. In-application support allows the user to use SmartHelp or the target 
application's Help menu to launch topics that correlate to their current screen rather than the 
entire list of topics. The Developer provides context recognition support differently for target 
applications than it does for non-target applications.  
 
For target applications, the Developer acquires the context information for each screen when 

the content is recorded. This type of recognition is called "ExactMatch" because content is tied 
to a specific screen's context ID ensuring a 100% match. A content developer just records the 

target application screen. The ExactMatch context indicator  appears when the Recorder 

recognizes the context of the object. This indicator means that the context information will be 
captured. When the content is launched in the Player using in-application support, the Player 
searches for "applicable" documents and returns content containing the specific context ID. 
 
Note: Some target applications require additional setup to capture context correctly. Refer to 
the In-Application Support Guide for more information about target applications. 

 

For non-target browser-based applications, the Developer uses a statistical engine to calculate 
an identifier on the application screen based on information it gathers on various parts of the 
screen. This type of recognition is called "SmartMatch". When help is launched through 
SmartHelp, the SmartHelp engine searches for SmartMatch context that will match the current 
context. You can add a SmartHelp toolbar button to the browser which will launch context-
sensitive help content for target and non-target applications. SmartMatch is not as precise as 

ExactMatch but it narrows the content down significantly, giving the user some level of 
context-sensitive help. Additionally, SmartMatch becomes more effective as you record 
content because more data points are accumulated to help determine the correct screen. The 

SmartMatch context indicator  appears when the Recorder is in the SmartMatch recognition 

mode. 
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If the Recorder cannot operate in either ExactMatch or SmartMatch mode, the NoMatch 

 context indicator appears. 

 

Note: If the Recorder does not recognize certain objects within the target application that you 
are recording, you can modify the frame in the Frame Properties toolpane in the Topic Editor. 
 
If the application you are recording is not supported, you can create Context IDs manually in 
the Topic Editor. For more information, see Use Context IDs. If the application you are 
recording is supported, and the correct context information was not recorded, you can also 
recapture the context ID only in the Topic Editor. 

 
Note: Explanation, Decision, and No Context frames are informational and do not have 
Context IDs. However, if matching context occurs on multiple paths of a Decision frame, the 
Decision frame appears. This allows the user to choose the path appropriate to the task they 
are performing. 

5.1.3 Start the Recorder 

When you start the Recorder, the Outline Editor closes and the Recorder opens. The title of 
the topic appears in the Recorder's title bar. Below the title bar, the screen capture 

instructions tell you what key or key combination to use to record an action/screen capture.  
 
The Recorder disappears when you press PRINTSCREEN and records each screen and action 
until you press PRINTSCREEN again. You can configure a Deskband that displays recording 
controls in the Taskbar when recording in automatic record mode. 
  

Note: When recording in manual mode, the Recorder reappears each time you press 
PRINTSCREEN allowing you to set up the next screen before capturing the next action. 
 

To start the Recorder: 

1. From the Outline Editor or the Library, select an empty topic. 

  

2. Click  Record Topic. 

  
You can also double-click the topic or select the topic and press ENTER to start the 
Recorder. 

5.1.4 Record Topic Steps 

As you record a topic, you can edit the steps after each screen capture or at the end of 
recording, depending on the behavior option you chose for the Recorder. You can change this 
option as often as you feel is necessary, depending on the situation. 

5.1.5 Add Notes 

The  Add or edit author notes button in the Recorder is used to add notes about the content 

being recorded. If you preview a topic, the notes added on individual frames appear in the 

Author Notes field in the Topic Editor. These notes can be seen by the content administrator 
when checking the accuracy of your recorded content. When previewing a test document, the 
notes appear in the Test Results report and can be used when submitting bug information. 

  
In Manual recording mode, the Add a Note button (on the Recorder Deskband) pauses sound 
recording while the note is being entered. When the note is saved, the sound recording 
resumes and the Recorder returns to Manual recording mode. Note that in Manual recording 
mode, the action and the screenshot are not recorded until you press PRINTSCREEN. If you 
press the Add a Note button prior to pressing PRINTSCREEN, the note is applied to the 
previous frame. If you press the Add a Note button after PRINTSCREEN, the note is applied to 

the next frame. 
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In Automatic recording mode, the Add a Note button pauses sound and keystroke recording 
while the note is being entered. When the note is saved, sound and keystroke recording 

resumes and the Recorder returns to Automatic recording mode. Note that in Automatic 
recording mode, the action and screenshot are captured as they occur so clicking the note 

button always applies the note to the next frame.  
  

To add a note in the Recorder: 

1. From the Recorder, click  Add or edit author notes. 
   

2. Type the note in the Author Notes dialog box. 

   
3. Click Save. 

5.1.6 Record Different Action Types 

When recording in the Developer, you press PRINTSCREEN after each action. There are three 

categories of actions: Mouse, String Input, and Keyboard.  
 
A Mouse action is any action performed with the mouse, including clicking, dragging, or 
pointing. The frames for each type of mouse action are recorded differently, as described in 
the following list: 

 Click: A click action includes clicking, double-clicking, or triple-clicking the left, 

middle, or right mouse button. This action is the simplest to record. You press the 
PRINTSCREEN key after each click, double-click, or triple-click. 
  

 Drag: A drag action is defined as clicking and holding the left, middle, or right mouse 

button while moving the mouse. This can include dragging to select text or cells or 
dragging an object (such as a graphic) across the screen. This action includes pressing 
the mouse button (left/middle/right button down), moving the mouse, and releasing 
the mouse button (left/middle/right mouse button up). A drag action, then, has 

several parts and involves more than one frame. First, you press and hold the mouse 
button and press the PRINTSCREEN key to record the first frame. By default, the 

Developer creates several "incremental" screenshots as you drag that serve to 
illustrate the area as it is highlighted, or the movement of the object you are dragging. 
Then, you release the mouse button to complete the action and press PRINTSCREEN 
again. If you disable automatic drag and drop recording, you need to press 
PRINTSCREEN as you drag to capture the "incremental" screenshots. When you 
release the mouse button after dragging, you need to press PRINTSCREEN again. 
  

 Point: A point action is defined as using the mouse to point to an object on the 
screen, such as pointing to a menu item to display the submenu. You press the 
PRINTSCREEN key to capture the frame after you point to the submenu. 
  

 Wheel: A wheel action is defined as rolling the center wheel button on the mouse. You 
press the PRINTSCREEN key after each wheel action. 

Note: You can select or deselect the Enable automatic recording option on the Recorder page 
of the Options dialog box to enable or disable automatic drag and drop recording. 
 
A String Input action is defined as entering text into a document or field by typing on the 

keyboard. You press the PRINTSCREEN key after you have typed the text to capture the 
screen with the text. 
  
Note: While recording, you may need to capture a log in process that includes entering a 
password. For security reasons, you do not want to capture and store the actual password that 
you enter. To avoid this, the Recorder recognizes a password field, the entered value is 
replaced by a generic string of dots. In addition, the Set as Password Field option for the 

frame containing the string input is automatically set in the Topic Editor. See String Input 
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Formatting Options in the Edit Action Properties section of the Use the Topic Editor chapter for 

further information. 

 
A Keyboard action is defined as pressing any function key, cursor movement key, or any other 
single key, such as ENTER, TAB, ESC, INSERT, or DELETE. This action type also includes key 
combinations, such as CTRL+A and SHIFT+ENTER. You press the PRINTSCREEN key after 
pressing the key or key combination to record the result. 

5.1.7 Record a Paste Topic 

If the topic you are recording contains Cut or Copy and Paste steps, it is very important that 
you are aware of the following situation. When you press the PRINTSCREEN key to capture a 
screenshot, the screenshot is placed on the Windows Clipboard; therefore, the screenshot 
overwrites the result of the copy or cut operation. 
 
To record the content correctly, you must perform the Cut or Copy step again immediately 
before you record the Paste step. This extra step places the proper information into the live 

application so that the screenshot is correct. If you perform several actions before pressing 

the PRINTSCREEN key to capture the screenshot, the Developer only captures the last action. 
Therefore, you should make sure that the Paste step is the last action you perform before 
pressing the PRINTSCREEN key. 
 
Note: To restore the cut text or object before recording the paste action, you need to undo 
the previous actions until the cut text or object reappears in the application. You can then cut 

it again and record pasting it in a new location. 
 
The following procedure steps you through a basic Cut/Copy and Paste operation using the 
method to open the Topic Editor at the end of recording. 
 

To record a paste topic: 

1. Set up the application in which you want to record in the correct position to begin the 

task. 

  
2. Switch back to the Developer. 

  
3. Select a topic. 

  
4. Start the Recorder. 

  
5. Press PRINTSCREEN to record the Start screen. 

  
6. Select the text or object you want to cut or copy. 

  
7. Press PRINTSCREEN to capture the results of the first step. 

  
8. Cut or copy the selected text or object. 

  

9. Press PRINTSCREEN to capture the results of the step. 
  

10. Select the location where you want to paste the text or object. 
  

11. Press PRINTSCREEN to capture the results of the step. 
  

12. In the live application, cut or copy the selected text or object again. 

  
13. In the live application, return to the location where you want to paste the text or 

object. 
  

14. Paste the selected text or object. 
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15. Press PRINTSCREEN to capture the results of the step. 
  

16. Finish recording the topic as appropriate. 

5.1.8 Undo 

As you record a topic in Manual Recording mode, you may inadvertently press the 

PRINTSCREEN key and capture the wrong action. You can use the  Undo command in the 

Recorder to undo all actions back to the beginning of the topic, including the Start screen. 
Keep in mind that clicking Undo does not undo actions in the application in which you are 
recording. You must do that manually. 
  

Note: Undo is not available in Automatic Recording mode. If you need to perform steps that 
you do not want to capture, you can use the Pause recording button in the Deskband to 
temporarily pause the screen capture process and Recording button to resume. If you do 
capture incorrect steps in your recorded topic, you can delete them later when you edit the 
topic. 

5.2 Use Record It! 
Record It! is a standalone application designed to provide anyone with the ability to create 
recorded content that can be imported into the Developer. Record It! allows you to easily 
record the necessary steps to complete any software transaction complete with sound and any 
additional notes or instructions that you want to provide to the author who will receive your 
content.  
  
You do not need a Developer installation to run this application. Record It! is automatically 

installed and it appears as a shortcut on the Start menu where the Developer is installed. 
As an author you can decide to use the standard Developer topic recorder or the Record It! 
application.  

  
Note: If you are a Developer author and choose to use Record It! instead of the 

Developer topic recorder, you will need to import the Record It! topics into the Developer 
Library to link them to content (see Import a New Topic from Record It! in the Export/Import 
Content chapter of the Content Development guide for more information). 
  

If you are a subject matter expert with no Developer installation, Record It! creates 
standalone files (.topic) that you can distribute to any author with a Developer installation. An 
author can import the recorded .topic files into the Developer for further refinement and 
publishing. 
  
When you launch Record It! for the first time, a home page appears with options to perform 
the following actions: 

 Create a New Topic 
  

 Create a New Topic with Sound 

  

 Open Other... 
  

 Change recording preferences 

Links to the five most recently opened topics also appear in the Open section of the Home 

page. You can use the Other link to open topics saved in a local or network folder. The menu 
and toolbar provide additional alternatives for creating and opening topics. 
  
Note: The Home page also includes a link to the Record It! production documentation.  
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Install Record It! 
In a server installation of the Developer, the Record It! Setup program can be downloaded 

from the Developer server <Library URL>/Public/Recordit; for example, 
https://mycompany:443/ODSContent/Public/RecordIt. You may need to contact a product 
administrator or content authoring team to determine the Library URL. 
  

The installation program is also available in the install media pack and can be distributed to 
subject matter experts. The location in the media pack is: 
Branding/<brand>/Installer/recorditsetup.exe. 
  
To install Record It!, download the Record It! Setup program and then run it. When you run 
the setup program, you are prompted for a program folder and a location where you want the 
application installed on your computer. After installing, launch Record It! using the link that 

appears on your Start menu. 
  
Note: Unless the trusted location policy is turned off, the installation location must be in a 
trusted location such as "C:\Program Files (x86)". The installer checks to see if the trusted 

location policy is in use and warns you, if necessary.  

5.2.1 Create a Record It! Topic 

Before you record content, you should set your Recording Key and Sound Pause key 
preferences (Tools, Preferences) if you do not want to use the defaults. 

  
When you select New Topic or New topic with sound on the Record It! home page, the 
Recorder starts. 
  
Record It! uses automatic recording to record a system process and to keep errors to a 
minimum. In this mode, every action after you press PRINTSCREEN (default recording key) on 

the keyboard is recorded until you press PRINTSCREEN again. Only two PRINTSCREENS are 
necessary to capture the information for all frames, one to start recording and one to end the 
recording. When you press PRINTSCREEN at the beginning of the topic, the Recorder captures 
each screen and its associated action until you press PRINTSCREEN again to complete the 

recording. As you record a topic, you may inadvertently capture the wrong action; these 
recorded frames will have to be edited out in the Topic Editor.  
  

Note: Point events are not recorded when using the automatic recording mode because there 
is no way to record the action without an event such as a mouse click. For example, when you 
click on a menu then move your cursor to a menu item that opens a submenu. No action 
occurs until you click on the submenu item. 
  
Before you begin recording, the Recorder displays instructions for you to press PRINTSCREEN 
to start recording and press PRINTSCREEN again to stop recording. The recorder is hidden 

after the first PRINTSCREEN so it is not recorded with the application. 
  

Deskband Controls 

After pressing PRINTSCREEN to start the recording, a deskband appears in the bottom right 
corner of the Windows taskbar. The deskband contains several controls that allow you to 

perform the additional actions during the recording process. 

  
Note: If Record It! is configured to record sound, the camera sound that occurs when 
recording a frame is disabled so that it is not part of the recording. 
 

 Opens the Notes dialog box for adding comments. You can also add new comments or edit 

existing comments made during the recording after you save your work. The Add a Note 
button pauses sound and the recording of all user actions (mouse events, keystrokes, and so 
on) while the note is being entered. When the note is saved, sound and recording events 
resume and the Recorder returns to automatic recording mode. Note that if you add notes 

while recording, the action and screenshot are captured as they occur so clicking the note 
button always applies the note to the next frame.  
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 The Pause button allows you to temporarily stop the recording and sound to perform steps 

that you do not wish to include in the recording. 

  

 The Record button displays when the recording is paused. Click the Record button to 

resume recording actions and sound. 
 

 This button has no function in Record It!. Record It! uses your system sound settings, 

which should be set before launching Record It!.  
 

 This is a visual scale depicting the recording level. Levels range from no color (no recording 
level), through Green, Dark Green, Yellow and Red (Very High recording level). 

 

 This visual indicator appears when a screenshot is taken. This space on the deskband 
also displays the type of context being recorded.  

  
When you are finished recording, the topic opens in the Record It! Editor where you can save 

your work. When saving, you are prompted for a name and location where you want to save 
the topic. You can then distribute your topic files to any content author that has access to the 
Developer. 
  

To create a topic without sound using Record It!: 

1. Click the New topic link. 

The Recorder opens. 
  

2. Activate the application you wish to record. 
  

3. Press PRINTSCREEN to start the recording and capture the first screen. 
  

4. Perform each action necessary to complete the task you wish to record. 
  

5. When you have finished performing the steps in the topic, press PRINTSCREEN to stop 

the recording. 
The topic opens in the Record It! Editor. 

To create a topic with sound using Record It!: 

  
Note: Record It! uses the system sound settings. These must be set before you launch the 
recording of a topic. 

1. Click the New topic with sound link. 

  
2. Activate the application you wish to record. 

  
3. Press PRINTSCREEN to record sound for the Start Screen. 

  

4. Record the sound for the Start (Introduction) Screen. 
   

5. Press PRINTSCREEN a second time to start the capturing the topic steps. 
  

6. Record the sound for the first step. 
  

7. Perform the action for the first step. 
  

8. Continue recording the sound and performing actions to complete the task you wish to 
record. 
    

9. Press PRINTSCREEN a third time to stop recording. 
The topic opens in the Record It! Editor. 
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To save a new topic: 

1. In the Record It! Editor, on the File menu, choose Save. 

   
2. Type a name for the new topic. 

   
3. Select a folder in which to store the topic. 

   
4. Click Save. 

5.2.2 Edit a Record It! Topic 

You can open existing topics using the Other link in the Open section on the Home page, or by 
clicking the link to any topic file that appears on the Home page. The Record It! Home page 
remembers the five most recent topics that you opened. 
  
Topics open in the Record It! Editor. The Record It! Editor displays screenshot thumbnails (or 

frames) on the left and a full size screenshot on the right. A Notes area appears beneath the 
full size screenshot so you can edit existing note text entered during the recording process or 

add new notes. Frames with note text display an  icon next to the frame thumbnail in the 

left pane. Use the Forward  and Backward  navigation arrows in the toolbar to move 

from frame to frame or click through the frame thumbnails in the left pane. Any changes that 
you make to each frame are automatically applied as you navigate from one frame to another. 

As you edit the topic, you can click  to save your changes.  

  
Note: Use Close from the File menu to close a topic and return to the Record It! Home page. 
Clicking the Close button on the Record It! title bar closes the Record It! application. 
  

While working in the editor, you can  delete any existing frame but you cannot insert a new 

frame. You have to rerecord the topic you if mistakenly delete a frame which is needed, or 
need to insert a new frame. You can, however, insert missing frames using the Topic Editor in 

the Developer. 
  

Note: You cannot undo an action in the Record It! Editor, but you can close a topic without 
saving it, which then reverts to the previously saved version. 
  

Action Areas 

The action area indicates where the action takes place in a frame. In the Record It! editor, it is 

designated by a red rectangle overlaying the frame's screenshot. Most often, the Recorder is 
able to determine the correct menu, menu entry, icon, or other object, and the action area is 
sized and positioned automatically. At times, however, you may need to move or resize the 
action area to select the correct location or to indicate a specific choice in a list.  
  
You can move an action area easily by dragging it. If you need to resize the action area, you 
can drag the black selection handles on the action area or use double-click actions to change 

the size. Double-click the left mouse button where you want to set the upper left corner; and 

then hold the SHIFT key and double-click the left mouse button where you want to set the 
lower right corner. 
  

Action Settings 

The action captured for the current frame appears in editable controls in the Action section of 

the toolbar. There are three basic action types; mouse, keyboard, and string input. A mouse 
action includes clicking, double-clicking, pointing, rolling the wheel, and dragging. A keyboard 
action occurs when you press a key on the keyboard to accomplish a task. A string input 
action occurs when you enter text into a document, field, dialog box, and so on. While Record 
It! automatically determines the action, you can change these captured settings if necessary. 
  
Each action is composed of several action settings that appear in the toolbar. You can change 

an action by selecting another item from a field list or by typing new text into an edit field. 
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Action setting fields include: 

 Action type: The Action type setting represents the mouse, keyboard, or typing 
action performed in the step. You can use the Action type list to select a different 
action. For example, you can change a "Left click" or "Left double-click".  

  

 Keyboard Modifiers: Add Alt, Control, or Shift key to a keyboard action. If a 
keyboard modifier is part of the action, a check appears next to the selected modifier. 
  

 Object type: The Object type setting refers to the type of object on which you 
performed the action. Common object types include Checkbox, Editfield, Combobox, 
Hyperlink, and Menu bar. You can select another object type from the list. 
  

 Object name: The Object name setting refers to the name of the object on which you 
performed the action. This name is entered in the appropriate place in the bubble 
template to tell the user which icon to click. You can change this field, and 
subsequently, what appears in the bubble, by typing other text.  

  

 Key type: If the action is a keyboard action, such as pressing the TAB key, the Key 
type setting appears in the toolbar. The Key type setting specifies what key is pressed. 
You can use the Key type list to select another key. If the keyboard action requires a 

key combination modifier, such as pressing CTRL for a CTRL+B action, the modifier 
key is specified in the Keyboard Modifiers list. 
  

 Input text: An Input text field appears for string input frames. A string input is where 

the user is prompted to type a response. You can change the captured input text by 
typing other text. Note that typing other text does not change what appears in the 
screenshot. 

Changing the action fields affects the text that the user sees in the bubble. The action field 
settings also represent the "correct" action that the user needs to take to satisfy the step in a 
knowledge testing mode. Changing the action settings does not affect the screenshots; they 

remain with the information that you captured. If your screenshots are no longer in sync with 
your action settings, you will need to rerecord the topic. 
  

Note: You can replace screenshots using the Topic Editor in the Developer.   
  

Sound Tools 

You can use the Sound section on the toolbar to  record sound for a frame or  listen to 

already recorded sound. Frames with recorded sound display a  sound icon next to the 
frame in the left pane. If you record sound for a frame that already contains sound, Record 
It! prompts you that you are re-recording sound for that frame. The new recording overwrites 
the original captured sound. 
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6 Use the Topic Editor 
The Topic Editor allows you to edit the frames you have recorded for a topic. You can also edit 
the Concept and Introduction information for the topic. The Topic Editor contains a menu bar, 
toolbars, and the screenshot for the current frame.  
  
The Topic Editor also includes six properties toolpanes that provide additional information 

about each frame: Frame Properties, Frame Structure, Frame Comments, Sound Editor, 
Concept, and Frame Link.  

6.1 Navigate Frames 
Frames in a topic are easily navigated using the navigation icons on the toolbar in the Topic 
Editor. You can move forward or back one frame or jump to the Introduction or End frame of 
the topic. If a topic contains branches with different End frames, a menu with the available 
End frames appears to allow you to choose the End frame you want.  

  
The Frame Structure is a graphical representation of each step in a topic. When displayed, it 
appears in its own pane in the Topic Editor. The Frame Structure pane contains a circle for 
every frame of the topic as follows:  
 

 Introduction Frame 

 

 Frame 

 

 End Frame 

 

 Decision Frame 

 

 Explanation Frame 

 
Move to any frame in the topic by clicking the appropriate circle. You can also navigate using 
the ALT+left arrow and ALT+right arrow keys (following the default path). When you select a 
frame, the frame's circle changes to green and the screenshot for that frame displays in the 

Topic Editor. 
 
Note: When you first open a topic, the Introduction frame displays a green circle only because 
it is the selected frame. 
 
The circles are connected by lines, which indicate the flow of the topic. If an Alternative Path is 
available, it appears below the primary path. In addition, if an Alternative Action or Alternative 

Path is available for a frame, the number of available actions is displayed above the frame's 
circle and to the left. When you move the mouse pointer over the circles, a thumbnail image 

of the frame, and the unique ID of the frame appear, allowing you to identify frames easily. 
 
Note: You can view the total number of frames for each topic from the Library or Outline 
Editor by adding the Frames column to any view. 
  

The Go To menu displays commands for navigating frames. You can also use the Specific 
Frame command to navigate directly to a frame by Frame ID. The Frame ID can also be used 
as reference point for subject matter experts who review content via the Player. You can 
configure published Player output (and preview in the Developer) to display the Frame ID in 
topic playback. See Display Frame ID in Topic Playback in the Customize the Player section of 
the Publish Content chapter. 
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To navigate frames using the navigation icons: 

1. To move to the next frame, click  Next frame. 
  

2. To move to the previous frame, click  Previous frame. 
  

3. To move to the Introduction frame, click  First frame. 

  

4. To move to the End frame, click  Last frame. 

  
Note: Topics with Decision Branch paths contain more than one End frame. If there 
are multiple End frames, a list arrow appears on the Last frame icon allowing you to 

select the End frame for the original path or another path. 
  

5. To move to a specific frame, click  Go to Specific Frame and enter a frame ID. 

To navigate frames using the frame structure: 

1. Display the Frame Structure toolpane, if necessary. 

  
2. Move the mouse pointer over the circles in the Frame Structure toolpane to display a 

preview of the frame in a small window. 

  

3. Click  to display the corresponding frame in the Topic Editor. 

  

4. Click  to display the End frame in the Topic Editor. 

  

5. Click  to display the Introduction frame in the Topic Editor. 

6.2 Save a Topic 
You can save a topic at any time from within the Topic Editor with the Save command. You 
can also use the Save As command to save a copy of a topic with a different name or to a 
different location in the Library.  
 

 Multi-user Considerations 

 When you save a checked out document, it is saved to your data storage location 
regardless of whether you are working online or offline. You must check the document 
in to insure that the server has the most recent copy. A new document is not added to 
the server until you check it in. If a document has never been checked in, your local 

copy is the only copy of that document. 
  

If you click the Keep checked out option on the Check In Comment dialog box during 
check in, the content is checked in and the version number incremented by 1 but the 
document remains checked out and unavailable for editing by other users. 
  
Open documents display check in/out indicators in the document editor tab. While you 

can edit a checked in or locked document, you cannot save your changes to the 
original document. 
  
If you edit a document that you did not check out (in other words, a checked out 
document was opened in Read-Only mode and edited) and you want to save the 
changes, you may still be able to save it. If you have access rights to the document 
and it has not been checked out by someone else, you are given the option to save 

the changes to the original document name. If you choose to save the changes, the 
document is checked out and the changes are saved. If you do not want to save the 
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changes to the original document, you can save the document as a different document 
name or you can abandon the changes without saving. 

Note: Saving changes to a document that is not checked out to you is not a recommended 

best practice. This functionality is designed to allow you to save changes to a document that 
was unintentionally edited in Read-Only mode. 
 

To save a topic in the Topic Editor: 

1. On the File menu, choose  Save. 

Note: You can also open a topic and use Save As on the File menu to save a copy of the 
document with a new name and/or to another folder. 
 

To save a topic with another name or in another location in the Library: 

1. From the File menu, choose Save As. 
  

2. Type a new name for the topic, if desired. 
  

3. Navigate to the desired location to save the topic, if necessary. 
  

4. Click Save. 

6.3 Undo and Redo in the Topic Editor 
You can undo changes that you make in the Topic Editor. If you made changes to frames other 
than the current frame, the Topic Editor navigates to the frame where the change was made. 
For example, if you add custom text to the bubble for three different frames, and then undo all 

three additions, the Topic Editor navigates back to each frame where the bubble text is being 
undone.  

 
If you are using sound in the Topic Editor, Undo undoes frame by frame recordings. The Topic 
Editor updates the frame view, frame structure, and waveform while undoing. 
 
Undo does not affect operations with attachments in the Frame Link Properties window. 

 
You can also redo actions that you have undone. Like Undo, if the action you are redoing 
occurs on another frame, the Topic Editor navigates to that frame. 

6.4 Control Topic Elements 
The Topic Editor provides several tools for controlling which bubble text, frames, screenshots, 
and action areas appear in published content. The following summary includes a brief 

description of each tool and the resulting output.  
  

Note: See the corresponding help topic for each feature in the Topic Editor chapter for more 
complete information.  
 

     Specify the Play Mode for Custom Text 
Use the Visible in <Play Mode> feature to control the play mode in which text appears. Text 
marked for a specific play mode is included when you publish a Player, Presentation or 
document that uses that play mode. Text not marked for the play mode is excluded. This 
feature is commonly used when you want to display different information in different outputs. 
See Specify the Play Mode for Custom Text in the Edit Bubble Properties section of the Use the 
Topic Editor chapter for more information. 
  

This option affects Player, Presentation, and document output.  
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Example: You have two paragraphs in a frame bubble. You want the first paragraph to appear 
in the Player, but do not want it to appear in Do It! playback or the Job Aid. To control the 

output for the paragraphs, you select the first paragraph in the bubble and enable See It/Try 
It! modes and disable Do It! mode. When publishing, make sure that Do It! is selected as the 

Job Aid text mode. 
 

   Control Text for Player and Print Output 

Use the Visible in <Player/Print> feature to prevent custom text from appearing in the output, 
regardless of its play mode. By default, custom text is marked to appear in both Player and 
document outputs, but you can disable an output. Text that is marked to not appear in a 

Player output does not appear in a Presentation output. See Control Text for Player and Print 
Output in the Edit Bubble Properties section of the Use the Topic Editor chapter for more 
information. 
  
This option affects Player, Presentation, and document output.  
  
Example: You have two similar notes in a frame; one is worded for onscreen viewing in the 

Player and the other worded for document output in the Training Guide. Both notes are 
marked for See It/Try It! modes. To control which note paragraph is included in which output, 
you select each note and enable the desired output and deselect the other output. However, 
when publishing documents, make sure that your text mode is set to the same play mode as 
the custom text. 
  

Hide a Frame for a Play Mode  

Use the Show In feature to prevent a frame from appearing in a specified play mode. If you 
hide a frame for See It/Try It! mode, then the frame does not appear in any Player, HTML Web 
Site, or document output published for that play mode. Note that using this option overrules 
other frame and play mode controls during publishing. See Hide a Frame for a Play Mode in 
the Edit Bubble Properties section of the Use the Topic Editor chapter for more information. 

  
This option affects Player, Presentation, and document output.  
 
Example: You have recorded a lengthy task. In Know It? mode, you want to test competency 

for part of the process only, for instance the first 10 frames. To exclude the remaining frames 
from appearing in Know It? mode, you deselect Know It? in the Show In list for each excluded 
frame. 

  

 Hide the Bubble 

This feature applies to See It! and Try It! modes only. When the Display Bubble for this Frame 
icon is disabled, the entire bubble for the frame is hidden. This option is often used when your 

purpose is to give a "slide-like" presentation and you are providing the bubble text narrative, 
or you have added sound for the narrative. In these situations, the bubble text is unnecessary 
and might be distracting. Note that you can also use the Show Bubbles property in the 
Properties toolpane to hide or display all the bubbles for a topic, overriding any individual 
frame settings. See Hide the Bubble in the Edit Bubble Properties section of the Use the Topic 
Editor chapter for more information. 
  

This option affects Player and Presentation output.  

  

 Disable the Action Area    
You can hide the display of an action area (the marquee) on a frame when playing a topic in 

the Player. This feature is often used in conjunction with hiding the bubble for creating and 
running a slide-like presentation. See Disable the Action Area in the Edit Action 
Properties/Create a New Action Area section of the Use the Topic Editor chapter for more 
information. 
  
This option affects Player and Presentation output.  
  

 Display Template Text in Know It? mode 

Template text does not appear for action frames in Know It? mode, except for string inputs 
(action to enter text). Hiding the template text allows you to test for competency. However, 



Use the Topic Editor 

 

 140 

there may be steps in the process for which you do not want to penalize the user for not 

knowing how to perform the step; for instance, if a step is very specific to the example used. 

In this situation, you would want to display the template text. See Display Template Text in 
Know It? mode in the Edit Bubble Properties section of the Use the Topic Editor chapter for 
more information. 
  
This option affects Player output only.  

 

     Use Screenshot Publishing 

By default, all screenshots are set for automatic selection. This means that when you publish a 
document output that includes screenshots, the Developer includes only those screenshots 
that show a change in the context setting for the action. The auto select screenshot publishing 

icon and tooltip change to indicate if the screenshot for the frame is included or is not 
included. However, you can use the other screenshot publishing icons to manually choose 
which screenshots to include or exclude in the published document. See Use Screenshot 
Publishing in the Manipulate Frames section of the Use the Topic Editor chapter for more 
information. 

  

This option affects document output only. 

6.5 Manipulate Frames 
When you record a topic, you record the primary path. After recording, you can manipulate 
this path in several ways. You can insert missing frames and delete unnecessary ones, or you 
can add alternative paths to the topic. If any of the screenshots or actions were not recorded 
correctly, you can recapture them as well. 

6.5.1 Insert a Missing Frame or Frames 

You can insert frames in an existing topic. When you insert a single frame, you are recording a 

single action; therefore you must take two screenshots, so that the Recorder can capture the 
screenshot and the action you perform. When you insert multiple frames, the recording 
process is identical to recording a topic; the Recorder captures the starting screenshot and the 

successive actions and resulting screenshots for new frames.  
 
You insert a new frame after the current frame. You should make sure that you know where in 
the topic you want to place the frame. You should also be sure that the screen in the 

application you are recording is set up to match the correct step in the task where you want to 
insert the frame. 
 

To insert a missing frame or frames after the current frame: 

1. Open or switch to the application in which you want to record the missing step(s), and 

set it up in the correct position to begin the step(s). 
  

2. Switch back to the Developer. 
  

3. On the  Insert menu, choose  Missing Frames. 

  
4. Press PRINTSCREEN to record the screenshot. 

  
5. Perform the action you want to record. 

  
6. Press PRINTSCREEN to capture the results of the step. 

  
Repeat as necessary. 
  

7. Click Finish. 
  

8. Verify and edit the settings and the bubble text as necessary. 
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6.5.2 Re-Record a Topic 

Re-recording a topic allows you to capture screenshots and actions using the original topic as 

a guide. This feature is useful when the topic text has been translated and the frame 
screenshots need to be recaptured in a different language. It can also be used to capture new 
screenshots if the screens have changed or if steps have been added to or removed from 

procedures in the target application.  
 

When you re-record a topic, you can start from any frame you choose. The Recorder opens 
with a Preview of Original window that displays the frame screenshot on the left and the frame 
bubble text on the right. The mouse pointer changes to a magnifying glass, as it moves over 
the Preview the Original window, allowing you to zoom in/zoom out as necessary to set up the 
screenshot. The bubble text used in the preview window is from the active preview mode in 

the Topic Editor. As you press PRINTSCREEN to record these steps, the Recorder advances to 
the next frame automatically. 
 

Note: Two visual cues are displayed when re-recording a Decision frame. First, the Next 
screenshot field shows Decision Frame Screenshot. Secondly, the decision paths of the 

Decision frame display in the bubble area of the re-recorder (however, the links are not 
active). 
 

The re-recording process begins on the currently selected frame, so you can choose the frame 

on which you want to begin by navigating to it in the Topic Editor. Once the Recorder opens in 
Re-recorder mode, the Previous and Next Frame arrows allow you to navigate forward and/or 
backwards within the current path to locate the appropriate frames to be re-recorded. Frames 
can be added within the flow of the re-recording process via the Insert Frame icon. Inserted 
frames can be undone by clicking the Undo icon. As you navigate the frames, only the steps 
where you press PRINTSCREEN are re-recorded. 
 

The re-recording process ends automatically when you reach the end of the topic. You can also 
end the process at any time using the Finish button in the Recorder. This flexibility allows you 
to stop re-recording and restart it again on any frame. 
 

The re-recording process and the Preview of Original window handle the different types of 

frames as follows: 

 Action frame: After the screenshot has been recorded, it advances to the next frame in 
the sequence of the topic. 

  

 Explanation frame: These frames are skipped. The Topic Editor automatically copies 
the screenshot from the following frame and uses it as the background for the 
Explanation frame. 

  

 Alternative Actions/Paths: When a frame has an Alternative action or path, the 
Alternative icon appears in the Preview of Original window between the screenshot and 
the bubble. Clicking this icon scrolls through all of the alternatives. You can choose 

which alternative you want to record. Note that Alternative actions that were 
automatically captured when you recorded the topic are not captured during re-
recording. 

  

 Decision frames: The Preview of Original window displays the Decision frame links, 
and you can choose which path to re-record. 

Note: Automatic recording mode and the Undo button are not supported when re-recording a 
topic. Re-recording a topic is always a manual process. 
 

To re-record the topic starting at the current frame: 

1. On the Edit menu, choose Re-record Topic. 

  
2. Set up the target application at the appropriate screen. 
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3. If necessary, use the Previous Frame or Next Frame arrows to navigate to the frame 

to be re-recorded. 

  
4. Press PRINTSCREEN to capture the screenshot. 

  
5. If necessary, use the Previous Frame or Next Frame arrows to navigate to the next 

frame to be re-recorded. 

  
6. Press PRINTSCREEN to capture the actions and screenshots. 

  
7. Repeat Steps 5 and 6 as necessary. 

  
The Recorder closes automatically when you re-record the last frame in the topic. If 
you want to stop the re-record process before the end of the topic, click Finish in the 
Recorder window. 

To insert a frame during re-recording of a topic: 

1. On the Edit menu, choose Re-record Topic. 

  
2. Set up the target application at the appropriate screen. 

  
3. Press PRINTSCREEN to start the re-record process. 

  
4. If necessary, use the Previous Frame or Next Frame buttons to navigate to the 

frame before where you want to insert a frame. 
  

5. Click the Insert Frame button to start Insert mode. 

  
6. Press PRINTSCREEN to capture the screenshot. The Undo button activates if you want 

to undo the insert. 
  

7. If want to continue re-recording, click the Insert Frame button to exit Insert mode 
and use the Previous Frame or Next Frame buttons to navigate to the next frame 
to be re-recorded. 

  
8. Press PRINTSCREEN to each time you want to re-record any action and screenshot. 

The Recorder closes automatically when you re-record the last frame in the topic. If 
you want to stop the re-record process before the end of the topic, click Finish in the 
Recorder window. 

6.5.3 Insert an Explanation Frame 

You can insert an Explanation frame to provide additional information about a step in the 
topic. No action is associated with this type of frame; it is simply a screenshot image and a 
bubble with text. 
  

Note: Explanation, Decision, and No Context frames are informational and do not have 
Context IDs. 
  
An Explanation frame is always inserted after the current frame. The screenshot used for the 
Explanation frame is the same screenshot used for the frame that follows the Explanation 
frame. In the empty bubble, you can enter text that explains something about the step or call 

the user's attention to something on the screen. Explanation frames appear in See It!, Try It!, 
and Do It! modes; they do not appear in Know It? mode unless the bubble text is marked to 
appear in that mode. 
  
Note: Explanation frame text can be set to appear in Know It? mode by selecting the text in 
the bubble and enabling the Visible in Know It icon in the Frame Properties toolpane. 
  



  Use the Topic Editor 

   143 

By default, the Explanation frame bubble appears in the middle of the screen, but you can 
move it to any location. You can also change the bubble type to one with a pointer and move 

the bubble so that it points to an element on the screen. 
  

When an Explanation frame appears in the Player in Try It! mode, users are prompted to press 
ENTER after viewing the frame to continue playing the topic. In See It! mode, however, the 
user is not prompted to press ENTER to continue. Instead, the topic displays the Explanation 
frame for the delay time specified in the Options dialog box and then continues playing 
automatically. If a default delay of 5.0 seconds is set, the Explanation frame displays for that 
length of time and then proceeds to the next frame. However, if you change the Delay time(s) 
setting in the Frame Properties toolpane to Infinite, users are prompted to press ENTER to 

continue. If you set a delay time value for an Explanation frame with sound, the frame 
advances automatically after the sound plays, overriding the set value. 
  
Note:  Explanation frames appear with no bubbles in See It!/Try It! modes if the frame 
contains no bubble text, or the text is not marked for those play modes. A bubble does appear 
in an Explanation frame if the frame contains text marked for the play mode or the Delay 

time(s) option is set to Infinite. An Infinite frame delay adds the template text "Press Enter to 

continue" to the bubble.  
  

To insert an Explanation frame after the current frame: 

1. Select the frame after which the Explanation frame is to be inserted. 

  

2. On the  Insert menu, choose  Explanation Frame. 

  

The frame is inserted, as indicated by the  in the Frame Structure, and the bubble 

contains the default text “Press Enter to continue.” 
  

3. Enter the desired text and adjust the settings as necessary. 

6.5.4 Insert a Blank Frame 

You can insert a blank frame in a topic. A blank frame is an Explanation frame with a white 
screenshot. Blank frames are used for adding conceptual frames to edit in a Microsoft 
PowerPoint overlay. For example, after exporting the topic to Microsoft PowerPoint, you can 
add an image to the blank frame and annotate it, or add conceptual information by adding a 

Microsoft PowerPoint layout for a bullet list. See Create Screenshot Overlays for more 
information about using blank frames. Blank frames can also be edited in your default image 
editor. 
  
Note: For all frame types, you cannot use an image editor to edit overlay objects that were 
created in Microsoft PowerPoint. 
  

Blank frames automatically appear in See It! and Try It! mode playback unless the Frame 
Delay for the frame is set to Skip. However, if the blank frame contains text marked for See 
It!/Try It! mode, the frame does not appear in See It! mode, but does appear in Try It! mode. 

  
Blank frames appear with no bubbles in See It!/Try It! modes if the frame contains no bubble 
text, or the text is not marked for those play modes. A bubble does appear in a blank frame if 

the frame contains text marked for the play mode or the Delay time is set to Infinite. An 
Infinite frame delay adds the template text "Press Enter to continue" to the bubble.  
  
Blank frames only appear in Do It! mode if the bubble contains text marked for Do It! mode. 
  
If you want the blank frame and its overlay contents to appear in print documents such as a 
Training Guide or System Process, make sure that the blank frame includes bubble text 

marked for the text output used in the publishing style, and the frame is set to include the 
screenshot in print. See Control Topic Elements, Specify the Play Mode for Custom Text, and 
Use Screenshot Publishing in this chapter for more information. 
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To insert a blank frame after the current frame: 

1. Select the frame after which the Blank frame will be inserted. 

  

2. On the Insert menu, choose  Blank Frame. 

  

The frame is inserted, as indicated by the  in the Frame Structure. 

6.5.5 Insert a No-Context Frame 

After you have recorded a topic, including all actions that reference recognized objects, you 
can insert a No-context frame to incorporate actions you were unable to record during the 
initial recording. On a No-context frame, you can specify an action and reposition and resize 
the action area to reference the appropriate object. These frames appear in See It!, Try It!, 

and Do It! modes in the Player.  
 

A No-context frame is always inserted after the current frame. The screenshot used for the 
No-context frame is the same screenshot used for the frame that follows the No-context 
frame. You must also enter any bubble text that should be displayed, as there is no template 
text for No-context frames. No-context frames can be inserted after any action, Introduction, 
Explanation or Decision frame. 
 

Note: Explanation, Decision, and No Context frames are informational and do not have 
Context IDs. 
 

To insert a No-context frame after the current frame: 

1. On the  Insert menu, choose  No-context Frame. 
  

2. Type text and adjust settings as necessary. 

Tip: You can also create a No-context frame during the initial recording by pressing 
PRINTSCREEN a second time to record an additional frame. If no action is associated with a 

frame, the frame is recorded as a No-context frame. If the frame is recorded with an action, 
you can display the frame in the Topic Editor and click the Ignore context icon in the Frame 
Properties toolpane to turn the frame into a No-context frame. 

6.5.6 Copy a Frame or Frames 

You can copy a frame or frames to another location in the same topic or into another topic. 
This feature allows you to easily duplicate sections of a topic that have the same steps, 
without having to record them again. 
 

Any frame can be copied, including the Start frame. The copied frames are not linked to the 

original frames, but any links they contain to other documents such as attachments, icons, 
manual hyperlinks, glossary terms, and sound properties are preserved.  
 

Tip: You can duplicate a frame by copying and pasting it without changing the selected frame 
in the frame structure. 
 

When you copy a frame, the frame's properties are also copied, including the screenshot, all 
actions and alternative actions, jump-in points, bubble text and bubble properties, Context 

IDs, "include this screenshot" settings, frame link settings and tooltips, custom sound, links 
and broken links, action areas, and the "keep with next" setting. The template language and 
the screen resolution are not copied. 
 

To copy a single frame: 

1. Select the frame you want to copy. 
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2. On the Edit menu, choose  Copy Frames. 

  

Or 
  
Right-click the frame selection and choose Copy Frames from the context menu. 
    

3. Select the frame after which you want to paste the copy. 

  
You can open a different topic in the Topic Editor, or switch to a topic already open, if 
desired. 
  

4. On the Edit menu, choose  Paste Frames. 

  
Or 
  
Right-click the frame selection and choose Paste Frames from the context menu. 

6.5.7 Select Multiple Frames 

You can select multiple consecutive frames with SHIFT+click. Selected frames are indicated in 
a dark green color. When multiple frames are selected, the active frame is the last frame you 

selected. Its screenshot and properties appear in the main Topic Editor window, and it is 
highlighted in the frame structure with the same light green selection color used to indicate an 
active single frame.  
 
When you select multiple frames, the topic editor displays the screenshot and properties of the 
last selected frame, because it is the active frame. If you click anywhere in the editor, the 
frame structure shows only the active frame as selected. You cannot edit multiple frames, 

however, you can delete multiple consecutive frames. See Delete Frames for more information 
about deleting multiple frames. 
 
You can deselect multiple frames by clicking any frame without pressing the Shift key or by 
editing the active frame. 

 
When you paste frames, they appear after the selected frame in the frame structure. You 

cannot paste frames in these situations: 

 after an end frame 
  

 into an empty topic 

  

 into topics with different screenshot resolutions 

In a recorded topic, the screenshot for the first recorded action frame is also used for the Start 
frame. Therefore, if you paste a frame immediately after the Start frame, the screenshot for 
the start frame updates to match the new first frame. 
 

To select multiple frames: 

1. Select a frame. 
  

2. Press SHIFT and click another frame to select multiple frames. 
  
The frames you clicked are selected, along with all frames in between them. 

6.5.8 Copy Paths 

You can select and copy an entire path or multiple paths. When you paste a path immediately 
before the end frame of a topic or a branch path, the screenshot for the end frame updates to 
reflect the last frame of the path you pasted. 
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When you copy an end frame into a path that already has an end frame, the end frame you 

are pasting is converted to an Explanation frame. When you copy an action frame with 

alternative paths, the currently chosen path is copied and pasted with the frame. 
 

Select Paths 

You can select multiple paths using CTRL+click. The CTRL+click method selects the path from 

the first frame in the path that you select through the end of the path, either the end frame of 
a branch path or the point where an alternative path rejoins the main path. 
 

To select a path: 

1. Click the first frame in the path that you want to select. 

  
2. Press CTRL and click another frame later in the same path. 

  
The path is selected from the first frame you clicked through the last frame on the 
path. 

   
3. To add another path to the selection, press CTRL and click in the path. 

To copy multiple frames or paths: 

1. Select the frames or paths you want to copy. 

  

2. On the Edit menu, choose  Copy Frames. 

  
3. Select the frame after which you want to paste the copied frames or paths. 

  
You can open a different topic in the Topic Editor, or switch to a topic already open, if 
desired. 
  

4. On the Edit menu, choose  Paste Frames. 

  
5. Click OK to respond to any prompts as necessary. 

6.5.9 Copy Decision Frames and Paths 

Several rules apply when you copy and paste a Decision frame and its paths. 

 Part of the primary path, including a Decision frame; not including a branch or 
alternative path is copied 
  
- The selected frames, including the Decision frame are pasted 

   

 Decision frame and the primary path including the frame where the alternative path 
rejoins, and the alternative path to the selection is copied 

  

- The selected path structure, including the Decision frame, the primary path, and the 
alternative path is pasted 
   

 Decision frame and part of an alternative path or a branch path is copied 

  
- The frames are pasted into an existing path, not as a new alternative or branch path 
   

 Decision frame and entire branch path, including the end frame is copied 

  
- The frames are pasted into an existing path, and the end frame of the path is 
converted to an Explanation frame 
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 Decision frame and multiple branch paths is copied 

  

- The Decision frame and the first selected branch are pasted into the existing path, 
and the structure of the other branch paths is pasted 

6.5.10 Delete Frames 

You can delete a single frame or multiple consecutive frames. When you delete a single frame 
that contains Alternative Actions, you have the option to delete the frame and all of its actions 
or just the current action. 
  

Delete Multiple Frames 

You can select multiple consecutive frames in a path and delete them at the same time. You 
cannot delete a selection of non-consecutive frames, that is, frames that are not in 
consecutive order. When you delete a multiple frame selection that includes a frame with 
Alternative Actions, the frame and all actions on the frame, delete without prompting. If you 
delete a frame that rejoins an Alternative Path, the Alternative Path rejoins at the next 
available frame. 

  

Exceptions 

 Multiple frame selection that includes a Decision frame or a frame that starts an 
Alternative Path prevents multiple frame deletion. However, you can delete 
consecutive frames within a Decision or Alternative Path. 
   

 You cannot delete a Start or End frame in the primary path. If a Start or End frame is 

included in the frame selection, it is not deleted, but the remaining frames are deleted. 
   

 You cannot delete the start frame of an Alternative Path. You can only delete the start 

frame of an Alternative Path by deleting the entire branch path using the Delete Path 
command or by selecting all of the frames in the branch and using the Delete Frames 
command. See Delete a Path for more information about deleting Alternative Paths. 

To delete the current frame: 

1. On the  Delete menu, choose  Frame(s). 
  

If the frame contains Alternative Actions, you can choose to delete the frame and all 
actions or delete the selected action only. 
   

2. Click Yes. 

To delete multiple consecutive frames: 

1. Select the first frame in the group of frames you want to delete. 

  

2. Press SHIFT and click the last frame in the group of frames you want to delete. 
  
Note: Do not select the End frame as your last frame as the Delete menu is not 
available for End frames. 
  
The frames you clicked are selected, along with all frames in between them. 

   

3. On the  Delete menu, choose  Frame(s). 

  
4. Click Yes. 
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6.5.11 Move Frames 

Using cut and paste, you can move one frame or multiple consecutive frames to another 

position in the same topic or to another topic. Cut frames are immediately removed from their 
original position on the frame structure. If you change your mind after cutting a frame 
selection, you can use Undo to restore the cut frames to their original position in the frame 
structure.  
 
Warning! The clipboard only holds one cut/copy selection. So if you cut a frame selection and 

then cut or copy another selection of frames, only the last cut/copied frames are available for 
pasting. 
  

To move one or more frames: 

1. Select the frame you want to move. 

  
To move multiple consecutive frames, select the first frame in the group of frames you 

want to move, press SHIFT, and click the last frame in the group of frames you want 
to move. 
  

The frames you clicked are selected, along with all frames in between them. 
   

2. On the Edit menu, choose Cut Frames. 
  
Or 
  
Right-click the frame selection and choose Cut Frames from the context menu. 

    
3. To paste the cut frames, select the frame after which you want to paste the copy. 

  
You can open a different topic in the Topic Editor, or switch to a topic already open, if 
desired. 
  

4. On the Edit menu, choose  Paste Frames. 

  
Or 

  
Right-click the frame selection and choose Paste Frames from the context menu. 

6.5.12 Recapture a Screenshot 

If the screenshot for a frame is incorrect, you can recapture it without having to re-record the 

entire frame. Make sure that the screen in the target application is set up correctly. When you 
press PRINTSCREEN, the Recorder captures the screen and automatically reopens the Topic 
Editor.  
 

To recapture the screenshot for the current frame: 

1. On the Edit menu, point to Recapture and choose  Screenshot. 

  
2. Activate the target application and navigate to the appropriate screen. 

  
3. Press PRINTSCREEN. 

6.5.13 Recapture an Action 

If the action for a frame is incorrect, you can recapture it without having to re-record the 
entire frame. While you do not necessarily have to be on the same screen in the target 
application as when the screen was first captured, it is recommended. When you press 
PRINTSCREEN, the Recorder captures the action and automatically reopens the Topic Editor.  
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To recapture the action for the current frame: 

1. On the Edit menu, point to Recapture and choose  Action. 
  

2. Activate the target application and perform the action you want to recapture. 
  

3. Press PRINTSCREEN. 

6.5.14 Use Context IDs 

Context IDs are provided by target applications and non-target browser-based applications as 
identifiers for individual screens. They can be used in conjunction with in-application support 
to provide context-sensitive help. In-application support allows the user to use SmartHelp or 
the target application's Help menu to launch topics that correlate to the current screen. The 
Player then launches the topic at the specified screen, rather than at the beginning of the 
topic.  

 

For target applications, the Developer automatically acquires the unique context ID for a 
screen when the content is recorded. This creates an ExactMatch Context ID type. For non-
target browser-based applications, a Context ID can be generated. This generated Context ID 
is called a SmartMatch Context ID type and cannot be edited. When you record an application 
screen, the Context ID type is set in the Type field on the Context ID dialog box. Recording 
non-target applications that are not browser-based, creates blank Context IDs. 

 
Note: You cannot edit Context IDs for the Start/End, Decision, Explanation, and No context 
frames. Context IDs created when recording browser-based applications have a context type 
of SmartMatch that cannot be edited. If the application screen changes, you must recapture 
the context to change the context ID. 
 

The Context ID dialog box has five columns: 
 
Name: A user-friendly name for the value. It can be any text. For unsupported applications, 

the default value for this field is Context ID. For supported applications, the caption for the 
value is captured and placed in this field. 
 
Value: The value of the context ID. 

 
ID: Allows you to indicate a specific part of the Context ID for search purposes. It can be used 
as a grouping mechanism. It is a required field, and it must be unique. 
 
ID as Prefix: When deselected, allows the search engine to ignore the prefix. For 
unsupported applications, this field must be false. 
 

Searchable: Indicates whether the Context ID information for the frame is indexed. If it is 
not indexed, you cannot use it to integrate context-sensitive help. The default is true. 
 
The Context ID dialog box differs for supported target applications vs. non-supported 
applications. Supported target applications have information in all five columns, and may have 

multiple rows for a single frame. Non-supported applications simply display Context ID in the 

Name column. 
 
You can add new rows to the bottom of the grid. This allows you to provide additional context 
values or to fix a corrupt context ID. You can also delete rows as necessary. All editing is done 
inside the grid itself; simply click the cell you want to edit. 
 
Note: You can add the Context IDs field to document outputs by customizing the document 

format publishing projects. See Customize Document Formats for more information on 
customizing document output. 
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To enter or modify a context ID for the current frame: 

1. On the Edit menu, choose  Context ID. 

  
2. Click in the cell you want to edit, and change text as necessary. 

  

3. Click  to add a row at the bottom of the grid. 

  

4. Click  to delete the selected row. 

  
5. Click OK to save your changes or Cancel to exit without saving. 

6.5.15 Re-record Context IDs 

If you previously recorded content and the context ID has changed in the application, you can 
recapture the context ID only instead of re-recording all of the content. There are several 

reasons for recapturing context IDs. 

 When the content was initially authored, the Developer was unable to capture the 

context (either SmartMatch or ExactMatch) for the recorded screens. However, the 
software or application was updated and the recorded screens now have context (or 
altered context values), so you just want to refresh the topics with the context 
information, without losing or overwriting anything else. 
   

 Changes have been made to what was used as context in a particular application and 

previously captured context information is no longer valid. 
   

 The application context is changed by the application development team and recorded 
context is no longer valid for the recorded application.  

Although re-recording the topic or recapturing the frame's action also captures the context ID, 

those methods replace any customizations you have made to the object type, object name, 
action, or action area. Re-recording the context ID captures the values for the screen without 
overwriting your action modifications.  
  
To add or change context recognition for previously recorded content, you must re-record the 
context ID for each screen that has a new context. When re-recording context IDs, you can 

start from any frame you choose. The Recorder opens with a Preview of Original window that 
displays the frame screenshot on the left and the frame bubble text on the right. The mouse 
pointer changes to a magnifying glass, as it moves over the Preview the Original window, 
allowing you to zoom in/zoom out as necessary to set up the screenshot. The bubble text used 
in the preview window is from the active display mode in the Topic Editor. As you perform the 
action and press PRINTSCREEN to record the context ID, the Recorder advances to the next 
frame automatically.  

  
Before starting the re-record process, it is a good idea to choose the frame on which you want 

to begin by navigating to it in the Topic Editor. However, if you are on the wrong frame when 
the Recorder opens in Re-recorder Context mode, the Previous and Next Frame arrows allow 
you to navigate forward and/or backwards within the current path to locate the appropriate 
frames for re-recording the context. As you advance through the topic frames, by either 

performing the steps or manually navigating the frames, only the screen context on the 
current frame is re-recorded when you press PRINTSCREEN. After pressing PRINTSCREEN, the 
Recorder “light” (top-right) flashes to indicate that new context information was captured, 
overwriting the previous value.  
 
The re-recording context process ends automatically when you reach the end of the topic. You 
can also end the process at any time using the Finish button in the Recorder. This flexibility 

allows you to stop re-recording and restart it again on any frame. 
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Note: Automatic recording mode and the Undo button are not supported when re-recording 
context for a topic. Re-recording context is always a manual process. 

  
The re-recording process and the Preview of Original window handle the different types of 

frames as follows: 

 Action frame: After the context ID has been recorded, it advances to the next frame in 
the sequence of the topic. 
  

 Explanation frame: These frames are skipped because these frames are informational 

and do not have context IDs. 
  

 Alternative Actions/Paths: When a frame has an Alternative action or path, the 

Alternative icon appears in the Preview of Original window between the screenshot and 
the bubble. Clicking this icon scrolls through all of the alternatives. You can choose 
which alternative you want to capture. You may need to restart the re-record process 
to capture the context ID for each Alternative action and path. Note that Alternative 

actions that were automatically captured when you recorded the topic are not re-
captured during re-recording. You must manually re-record those Alternative actions 
to capture the context IDs. 

  

 Decision frames: The Preview of Original window displays the Decision frame links, 
and you can choose which path to re-record. However, once the path is re-recorded, 
the Recorder does not return to the Decision frame to access the other paths. To re-

record the context for the additional paths, it is best to end your re-recording and then 
restart the context re-record process from the Decision frame for each path. 
  

 No-context frame: You can capture the context and context ID for this frame by 

recording the action. 
  

 Drag & Drop Sequences: For frames containing drag & drop sequences, only the 
button down part of a context can be recorded. The rest of the drag sequence is 

skipped during re-record, including the button up. 

Note: You can manually change the ExactMatch context IDs in the Context ID dialog box. 

SmartMatch context IDs cannot be edited so you must recapture the Context ID if the 
application screen changes. See Context Recognition in the Recorder in the Record Topic 
Content chapter for more information on the difference between ExactMatch and SmartMatch. 
  

To re-record the context ID starting at the current frame: 

1. On the Edit menu, choose Re-record Context IDs. 

  
2. Set up the target application at the appropriate screen. 

  
3. If necessary, use the Previous Frame or Next Frame arrows in the Recorder to 

navigate to the frame to be re-recorded. 

  
4. Press PRINTSCREEN to start recording. 

  
5. Perform the action as indicated in the Recorder window. 

  
6. Press PRINTSCREEN to capture the context ID for the screen. 

  
7. Repeat Steps 5 and 6 as necessary. 

  
The Recorder closes automatically when you re-record the last frame in the topic. If 
you want to stop the re-record process before the end of the topic, click Finish in the 
Recorder window. 
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6.5.16 Edit a Screenshot 

When you choose to edit a screenshot, the Developer starts the frame image editor you 

specify on the General Developer Settings page of the Options dialog box and opens the 
screenshot in that application. You then edit the screenshot using that application. When you 
save the file and close the application, the Developer updates the screenshot in the Topic 
Editor. 
  
The Developer remains open, but in a suspended state, while you are editing a screenshot. A 

Developer Not Available message appears during the screenshot editing session and closes 
when you exit the image editor and return to the Developer. The Developer is not editable 
while it is in the suspended state. You can click Resume in the message to force the Developer 
to resume at any time during the screenshot editing session, but you receive a warning that 
any changes made to the screenshot during the editing session are lost. 
  
Note: When you edit screenshots in a frame image editor, the Developer temporarily converts 

the screenshots, which are in .png format, into .bmp format. Therefore, the frame image 
editor you use must be able to support .bmp format images. 

 

To edit the screenshot for the current frame: 

1. On the Edit menu, point to Screenshot Editing and choose  Edit Screenshot. 
  

2. Edit the screenshot as necessary. 
  

3. Save the screenshot in the frame image editor application. 
  

4. Close the frame image editor. 

6.5.17 Work with Screenshot Overlays 

The Overlay option in the Topic Editor exports all of the screenshots in a topic to Microsoft 
PowerPoint, creating a slide for each frame. After exporting the topic, you can use the graphic 

and drawing tools in Microsoft PowerPoint and the tools on a custom Overlay Editor tab to 
address a number of content development challenges by making changes to the topic 

screenshots.  

 Enhance a screenshot 
When you record a topic, the Recorder captures the screenshot and action area for the 
frame. To add further value to your topic, you may want to enhance frame 
screenshots with callouts or drawing objects. You can do this by editing single frames 
in a graphics editor or by exporting the entire topic to Microsoft PowerPoint and using 

the drawing tools in that application. 
  

 Application change management 
As applications change, recorded content also needs to be updated. For extensive 

changes, re-recording is the best solution, but not always practical because you may 

not have access to the application, you cannot set up the data as it was originally 
recorded, or the task is too time-consuming. 
  
Where application updates are minor, editing the underlying screenshot is often the 
faster solution. However, editing each individual screenshot in a graphics editor would 
also be time-consuming and difficult to apply the change uniformly to each screenshot. 

  
Using Microsoft PowerPoint, you can insert a graphic image of the updated screen as 
an overlay and apply the overlay to multiple slides. This means that you can add the 
same change to screenshots that appear in multiple or all topic frames. 
  

 Mask information 

Overlays provide a solution for masking sensitive information such as customer, 
personal, or confidential material, and hiding branding points that were captured 
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during the initial recording process. Masking replaces the data that appears on the 
screen so that it is not visible to the user. Another problem often encountered is a 

topic recorded in a test environment with unrealistic data. You may want to replace 
this test data with more realistic examples without re-recording. 

  

 Create prototypes 
You can use overlays to create prototypes showing what the modifications to an 
application would look like. Using Microsoft PowerPoint tools such as the Developer tab 

(or ribbon), you can add design a form by adding controls to represent field labels, 
text boxes, command buttons, check boxes, option buttons, combo boxes, list boxes, 
and so on. 
  

 Add conceptual information frames 

You can add specially designed blank Explanation frames in the Topic Editor for the 
purpose of adding conceptual information to those frames. You can convey this 
information using Microsoft PowerPoint text tools such as bulleted and numbered lists; 
charts to display numerical, process, and hierarchical information; and images such as 
pictures and clip-art. 

6.5.17.1 Create a Screenshot Overlay 

The Overlay feature supports Microsoft PowerPoint 2007, 2010, and 2013. Creating an overlay 
for a topic involves the following steps:  

1. From the Topic Editor, export the topic to Microsoft PowerPoint as an overlay.  

  
2. Use the graphic and text tools in Microsoft PowerPoint to edit or call attention to 

screenshot areas.  
  

3. Insert partial screenshot images or graphics to mask parts of an existing screenshot 
that have changed between versions or that you want to hide. 

    
4. Use the Overlay Editor add-in to copy graphic selections for masking, branding, and 

prototyping across multiple slides. 
   

5. Use Microsoft PowerPoint layouts, design themes, and text tools to add conceptual 
content to blank Explanation frames. See Insert a Blank Frame in this chapter for 
more information about using blank Explanation frames. 

  
6. Add or modify author notes that are exported and imported between the Frame 

Comments toolpane in the Topic Editor and the Notes pane in Microsoft PowerPoint. 
   

7. Save the overlay and close Microsoft PowerPoint. 

The first time you create an overlay, you receive a prompt to install the TopicOverlayEditor 
add-in, which adds a custom Overlay Editor ribbon to Microsoft PowerPoint with specific tools 
for working with overlay objects. If you choose to not register the add-in, the topic opens in 
Microsoft PowerPoint without the Overlay Editor ribbon. Once you register the add-in, the 

message does not appear again. While you can create overlays without registering the Overlay 
Editor ribbon, you do not have access to the features on the ribbon. See Edit the Overlay for 
more information about using the Overlay Editor ribbon. 
 

Note: If you cancel the installation of the overlay, you can install it later by reopening the 
Topic Editor. 
 

When you create or edit an overlay, a Developer Not Available message appears and closes 

when you exit Microsoft PowerPoint and return to the Developer. While you are editing a topic 
in Microsoft PowerPoint, the Developer remains open, but locked in a suspended state. The 
Developer is not editable while it is in this suspended state. You can use the Resume button in 
the message to force the Developer to resume at any time during the overlay editing session, 
but a warning notifies you that any changes made to the overlay during the Microsoft 
PowerPoint editing session are lost.  
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When you add an overlay to a frame, the Developer saves a backup of the original screenshot 

for that frame so that you can restore that screenshot. It also saves the Microsoft PowerPoint 
file (Overlay.pptx) for further editing. The Microsoft PowerPoint file contains the overlays only; 
the underlying screenshots are not included in this file. The Microsoft PowerPoint file is saved 
to the local cache folder for the topic and the original screenshots of frames that contain 
overlays are saved to an Original folder in that topic folder. 
  
Note: The overlay file and the Original folder with the original topic screenshots are included 

in a topic export. 
  
You can choose to delete all overlays from all frames from the Topic Editor and restore the 
original screenshots. This action also deletes the Microsoft PowerPoint overlay file. If you 
mistakenly delete all overlays, you can restore them during the same editing session using 
Undo in the Topic Editor. 
  

Note: To remove individual overlay objects from one or more frames, edit the topic overlay in 
Microsoft PowerPoint. 

  

Recaptured Screenshots 

As you develop a topic, you may need to recapture a screenshot that already contains an 

overlay. When you close the Recorder after recapturing or re-recording a screenshot that 
contained an overlay, you are notified that the new screenshots do not contain the overlays. A 
Missing Overlays dialog box presents two options: 

 View Overlays: Opens the topic in Microsoft PowerPoint and applies the overlays 
from the replaced screenshots to the new screenshots. You can view how the overlays 
affect the newly captured screenshots and make the necessary changes. 
   

 Continue Editing: Returns to the Topic Editor without applying the missing overlay 
objects. 

 Multi-user Considerations 

 You can create or edit an overlay for a checked in topic, but the overlay changes are 
not saved until you save the topic and check it out when prompted. 

To create a new overlay: 

1. On the Edit menu, point to Screenshot Editing and choose  Create Overlay. 

  
If prompted, install the TopicOverlayEditor add-in. 
  
Note: Clicking Resume in the Developer Not Available message resumes the 
availability of the Developer, but any changes made to the overlay in Microsoft 

PowerPoint are lost. 

   
2. Switch to Microsoft PowerPoint to view the exported topic. 

  
Microsoft PowerPoint opens with all topic frames exported as slides. The selected 
frame in the Topic Editor is the active slide when the overlay opens in Microsoft 

PowerPoint. 
   

3. Edit the slide or slides as needed, adding overlay graphic objects and text. 
   

4. Save the presentation and close Microsoft PowerPoint. 
  
The Developer saves the Microsoft PowerPoint overlay, the Developer Not Available 
message closes, and the Developer is active. 
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To edit an existing overlay from the Topic Editor: 

1. On the Edit menu, point to Screenshot Editing and choose  Edit Overlay. 
   

2. Switch to Microsoft PowerPoint to view the exported topic. 
  
Microsoft PowerPoint opens with all topic frames exported as slides. The selected 
frame in the Topic Editor is the active slide when the overlay opens in Microsoft 
PowerPoint. 
     

3. Edit the slide or slides as needed. 

    
4. Save the presentation and close Microsoft PowerPoint. 

To remove overlays from all frames in a topic from the Topic Editor: 

1. On the Delete menu, choose  Delete Overlays. 
   

2. Click Yes to confirm the deletion. 

6.5.17.2 Work with the Overlay Structure 

When you create an overlay from a topic, the topic opens as a presentation in Microsoft 

PowerPoint with the name Overlay.pptx. Although the overlay opens to the slide that 
represents the active frame in the Topic Editor, all frames are converted to slides, except for 
the Start frame, as this is a duplicate of the first frame. Any changes made to the first frame 
also appear in the Start frame. 
  
The first slide in the overlay file is an instructional slide called Guidelines for Overlay Editor. 
This slide includes suggestions of what you should and should not do while working with the 

overlay. 

  
Each slide from a topic frame includes the screenshot and action area, if one is included, the 
bubble showing the bubble text, and a frame ID in a box to the left of the screenshot. The 
frame ID identifies the frame in the Topic Editor and also identifies the name of the graphic file 
containing the frame screenshot. For example, a slide with a frame ID of 6 in Microsoft 
PowerPoint identifies this frame as frame ID 6 in the Frame Structure in the Topic Editor, and 

also indicates the screenshot graphic (which can be found in the local cache for the topic) is 
6.png. 
  
Topics that include other paths, such as Alternative Paths and Decision Frames, are converted 
into a linear sequence of slides in Microsoft PowerPoint. This means that the slides for a 
Decision path may start after the last slide of the primary path. 

  
The overlay process exports author notes from the Author Notes pane in the Frame Comments 
toolpane in a topic to the Notes pane in Microsoft PowerPoint. You can modify the existing 
notes and enter additional notes. An author, subject matter expert, or reviewer can use the 

Notes pane in Microsoft PowerPoint to enter additional information or request changes to be 
made once the topic is imported back to the Topic Editor. Information may include where to 
move the bubble, frames to insert, alternative actions and paths to record, custom text to add 

to frames, and so on. While you can format the text in the slide note, this formatting is not 
supported in the Topic Editor, and is removed when the topic is imported back to the Topic 
Editor. 
  
The overlay slide notes are written directly into the topic. They are not saved with the overlay, 
and therefore, are not cleared or reset when you delete the overlay. 

6.5.17.3 Edit the Overlay 

You edit a topic in Microsoft PowerPoint by advancing through each slide, adding graphics such 
as text boxes, callouts, pictures, and drawing objects to call attention to or cover (mask) 
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specific areas of the screenshot. Microsoft PowerPoint adds these objects as overlays on top of 

the slide. When you import the slides back to the Topic Editor, the overlay objects are merged 

into the screenshot and become part of the screenshot. However, the original recorded 
screenshots are preserved so that you can remove all overlays from a topic. The Microsoft 
PowerPoint overlay file is also preserved for subsequent exports of the topic for future editing. 
  
You can continue to make changes to a topic after creating the initial overlay; this includes 

structural changes such as adding or deleting frames. Deleting a frame from a topic in the 
Topic Editor also deletes the equivalent slide in the overlay file the next time the topic is 
exported to Microsoft PowerPoint. If you add new frames to a topic, you may need to edit the 
topic in Microsoft PowerPoint and copy the overlay objects to the new frames. Structural 
changes made to slides in Microsoft PowerPoint are not preserved. This means that actions 
such as adding, moving, or deleting slides in Microsoft PowerPoint are ignored when the 
overlay is imported back to the topic. 

  
You can insert blank frames in a topic. A blank frame provides an empty screenshot, like a 
canvas, to which you can use Microsoft PowerPoint tools to add bullet lists, graphic objects 

such as flowcharts and organization charts, and slide designs when you export the topic to 
Microsoft PowerPoint. See Insert a Blank Frame in this chapter for information about inserting 
and publishing blank frames. 
  

Note: If you insert a new Explanation or No-context frame before a frame that contains an 
overlay, the screenshot for the inserted frame includes the overlay; however, the screenshot 
is the merged image of the original screenshot and the overlay. Since the overlay is part of 
the screenshot for this frame and was not created with the overlay tools in Microsoft 
PowerPoint, it cannot be selected in Microsoft PowerPoint, and therefore, is not available for 
editing or deleting. 

  
The Microsoft PowerPoint add-in installs the Overlay Editor ribbon, which provides custom 
commands for copying and manipulating overlays. 

  Copy To Previous: Copies the selected overlay object or objects to the 
previous slide in the same position as the selected object. 

   

  Copy To Next: Copies the selected overlay object or objects to the next slide in 
the same position as the selected object. 

  
The Copy to Next command copies the overlay and automatically moves to the next 
slide, with the copied overlay selected. Since the overlay object remains selected, you 
can repeatedly use the Copy to Next command to copy the overlay to a series of 
slides. If you copy an overlay object to a slide that should not include it, use the 
DELETE key to remove the overlay from that slide. 
   

  Copy To All Frames: Copies the selected overlay object or objects to all slides 

in the same position as the selected object. 

  
If most of the slides in a topic need the overlay applied, you can use this command to 
copy the overlay to all slides and then delete the overlay from the slides that should 
not include it. 
   

  Delete From All Frames: Deletes the selected overlay object or objects from 

all slides. 
  
Note: You can also delete all overlays from a topic in the Topic Editor. You cannot 
delete an overlay from a specific frame in the Topic Editor. That delete action can only 

be done by editing the slide in Microsoft PowerPoint. 
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Using Undo in Microsoft PowerPoint after deleting overlays from all frames returns the 

overlay to the original slide only. 
   

  Copy Screenshot: Creates a smaller copy of the screenshot as a shape on the 
slide so that you can use Microsoft PowerPoint tools, such as scaling, cropping, and 
zooming, to emphasize some aspect of the application by enlarging it. The copy sits on 

top of the original screenshot. Although a bubble may appear hidden when you add an 
overlay, the bubble always appears on top of the overlay in the Topic Editor. You can 
refresh the bubble position in Microsoft PowerPoint using the Show/Hide Bubble icon in 
the Overlay Editor ribbon. 
  
As an example, you have a frame where the action takes place in a pop-up window, 

which you would like to enlarge to focus more attention on the action area. To produce 
this effect, you can copy the screenshot, crop the copy to show only the section of the 
pop-up window you want to emphasize, and enlarge the cropped screenshot object. 

   

  Show/Hide Bubble: Hides the bubble and action area on all slides so that you 

can make changes to the screenshot under the bubble and action area. Clicking the 

 icon displays the action areas and bubbles. 

Ways to Mask Data 

A common use for overlays is to mask sensitive data that has been captured during the 
recording process. For example, a topic showing the steps to look up employee information 
captures the lookup string input and the resulting contact information of an actual employee. 
This information appears in several frames. While you can manually change the string input 
text of the lookup, the original data appears on several succeeding frames. 
  

To mask data with an overlay, draw a text box around the field, sizing the text box to fit the 
field. You can then add the appropriate text, making sure that you format the text (font, font 
color, background color, and so on) to look like the original. You can then use the Overlay 
Editor ribbon to copy this mask to multiple frames. Each copy appears in the same position as 
the original overlay. 
  

Another use of masking is to insert a graphic that replaces part of the screen so that you do 
not have to recapture screens for small changes, such as changing a logo or inserting a new 
field. 

6.5.18 Use Screenshot Publishing 

You can change the inclusion of screenshots when a topic is published in one of the document 
formats. Note that screenshots do not appear in the Test Case format. The Auto Select 
Screenshot to Print automatically option includes screenshots based on changes in the context 
settings as determined by the Developer during the publishing process. This is the default 

setting. The Include Screenshot in Print and Do not Include Screenshot in Print options offer 
manual control over which screenshots appear in the printed document.  
 
These options are available on all frames except the Introduction frame, which takes its 
screenshot from the first frame. If you include Decision or End frames, the color graphic, 
rather than the grayscale graphic that appears during topic playback, appears in the 
document. 

 
Note: Changing this option only has an effect if the Include field on the Documents page of 
the Options dialog box is set to Topic Settings and the Include field on the Formats page of the 
Publishing Wizard is also set to Topic Settings. If they are set to any other option, changing 
the screenshot inclusion method at the frame level has no effect. 
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The icons in the toolbar indicate whether the screenshot for the current frame will be included 

when the topic is included in the document format. 

  

 
The screenshot for the current frame is included automatically. 
  

 
The screenshot for the current frame is not included automatically. 
  

 
The screenshot for the current frame has been selected manually to be included, and it would 
also appear automatically. 
  

 
The screenshot for the current frame has been selected manually to be included, and it would 

not appear automatically. 
 

To change the automatic print setting for the current frame: 

1. On the Edit menu, point to Screenshot Publishing and choose  Auto Select 

Screenshot to Print,  Include Screenshot in Print, or  Do Not Include 
Screenshot in Print. 

Note: There are also icons available on the Topic Editing toolbar for these options. 

6.6 Use Alternative Actions and Paths 
Often, the application for which you are recording content has multiple ways to complete a 
task. You can accommodate these ways in your content by using Alternative Actions and 

Paths.  
  
The recording process when inserting Alternate Actions and/or Paths varies based on two 
factors: 

 Sound/No Sound 
   

 Manual or Automatic Recording  

When recording an Alternate Path or Alternate Action with sound in manual mode, the first 
PrintScreen captures the Frame Sound of the new path or action. Subsequent PrintScreen's 
record both the action and the sound. 

  
When recording an Alternate Path with sound in automatic mode, the first PrintScreen records 

the start screen and sound for the new path. Subsequent PrintScreen's continue to record both 
the action and the sound. 
  
When recording an Alternate Action with sound in automatic mode, the first PrintScreen 

records the start screen and sound for the new action. The next PrintScreen ends the action. 

6.6.1 Insert an Alternative Action 

As you are recording a topic, you may have to choose one of several possible actions for 
completing a task. For example, you may need to decide between pressing the Tab key and 
clicking the mouse to move the insertion point to the next available field. If you want to 
document some of these alternative methods for your users, you can insert Alternative Actions 
within the topic. Alternative Actions are single actions that accomplish the same result as the 
primary action.  
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To insert an Alternative Action, you must determine on which frame the Alternative Action 
should appear. When you click the Insert Alternative Action command, the Topic Editor closes 

and the Recorder opens. After performing the action you want to record and pressing 
PRINTSCREEN, the Recorder closes and the Topic Editor reopens with the Alternative Action 

displayed. 
 
Alternative Actions are not available in See It! mode. In the Player, a user can select the Show 
next Alternative action icon to display an action in Try It! and Do It! modes. 
 

To insert an Alternative Action on the current frame: 

1. On the Insert menu, choose  Alternative Action. 

  
2. Set up the application in which you want to record to display the screen on which the 

Alternative Action should be performed. 
  

3. Perform the action you want to insert. 

  
4. Press PRINTSCREEN. 

6.6.2 Insert an Alternative Path 

As you are recording a topic, you may have to choose one of several possible methods for 

completing a task. For example, you may need to decide between using a menu path and 
clicking a toolbar icon. If you want to document some of these alternative methods for your 
users, you can insert Alternative Paths within the topic. While Alternative Actions can display a 
single action only, Alternative Paths may include several steps. These paths may be shorter or 
longer than the primary path, or an equivalent number of steps. Alternative Paths guide the 
user through alternative steps to accomplish the same task as the primary steps.  

 
To insert an Alternative Path, you must determine which frame is the starting point for the 
path. You also need to identify the frame that is the end point, which is where the path rejoins 

the main path of the topic. When you insert an Alternative Path, the current frame becomes 
the starting point for the path and the Frame Structure is automatically displayed if necessary 
to allow you to select the appropriate end frame. When positioned in the Frame Structure, the 
mouse pointer changes into a black arrow attached to a circle with the letter E. You can use 

the arrow to designate the end frame for the path. 
 
You do not need to record a start screen for an Alternative Path. The screenshot for the frame 
already exists; you are simply recording a new action to associate with that screenshot. You 
press PRINTSCREEN after every action completed in the Alternative Path, and you must click 
the Finish button in the Recorder to end recording the Alternative Path when you reach the 
designated end frame. 
 

Alternative Paths are not available in See It! mode. In the Player, a user can select the Show 
next Alternative action icon to follow a path in Try It! mode and Do It! mode. 
 

To insert an Alternative Path beginning on the current frame: 

1. On the Insert menu, choose  Alternative Path. 
  

2. Use the black arrow to click the circle representing the frame you want to use as the 
end frame of the Alternative Path. 
  

3. Set up the application in which you want to record to display the starting screen of the 
first action of the Alternative Path. 
  

4. Perform the first action you want to record. 

  
5. Press PRINTSCREEN to capture the action. 
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6. Perform the next action you want to record. 

  

7. Press PRINTSCREEN to capture the results of the step. 
  
Repeat as necessary to complete the Alternative Path. 
  

8. Click Finish. 

6.6.3 Display Alternative Actions/Paths 

Just as you edit the frames of the primary path, you can edit the Alternative Action frame and 
the frames in an Alternative Path. To edit these frames, you must navigate to them. While you 
do not need to display the Frame Structure to edit Alternative Actions or Alternative Path 

frames, it is helpful to display the Frame Structure to verify that you are working with the 
appropriate frame. 
 

To display an Alternative Action or Path for the current frame: 

1. On the Go to menu, choose  Next Action or  Previous Action. 

6.6.4 Set the Current Action as the Default 

After inserting an Alternative Action or Path, you may decide to use the Alternative Action or 
Path as the primary action or path. This is especially useful as only the primary action or path 
displays in See It! mode. The original primary action becomes an Alternative Action or an 

Alternative Path. 
 

To set the current action as the default action: 

1. Display the Alternative Action or the first frame of the Alternative Path you want to 

use as the default action. 
  

2. On the Edit menu, choose  Set Action as Default. 

6.6.5 Change the End Frame of an Alternative Path 

When you create an Alternative Path, you must specify an end frame for the path. If you 

decide later that the path should reconnect at a different frame, or you chose the incorrect 
end point when you recorded the topic, you can change the end point of an Alternative Path. 
When you change the end point of the path, the other frames in the path are not affected. For 
example, if another frame in that path has a different Alternate Path with a different end 
point, that end point does not change.  
  
Changing the end point only affects the currently selected action. If the end frame in an 

Alternative Path has an Alternative Action, and you change the end point for one action, the 
Alternative Action still connects to the original end point. Two paths appear in the Topic Editor. 
You must select the Alternative Action and change its end point separately. 

  

To change the end frame of an Alternative Path:  

1. Click the final frame in the Alternative Path. 

   
2. On the Edit menu, choose Modify End Point. 

  
You can also click the Modify end point button in the Frame Properties toolpane. 

   
3. Use the black arrow to click the circle representing the frame you want to use as the 

new end frame of the Alternative Path. 
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6.6.6 Delete an Action 

You may want to remove a particular Alternative Action that is incorrect, or one that is no 

longer needed. You cannot delete the only action for a frame. 
  
Note: When you delete a frame that contains Alternative Actions, you have the option to 

delete the frame and all of its actions or just delete the selected alternative action. 
  

To delete an Alternative Action from the current frame: 

1. Display the action you want to delete. 

   

2. On the Delete menu, choose  Action. 

   
3. Click Yes. 

To delete a frame and all Alternative Actions: 

1. Select the frame containing the actions you want to delete. 
   

2. On the Delete menu, choose  Frames. 
   

3. Select Delete frame and all actions to delete the frame and all actions. 

  
Select Delete current alternative action to delete the selected action only. 
   

4. Click OK. 

6.6.7 Delete a Path 

If an Alternative Path is no longer needed, you can remove it. You can delete all frames of an 
Alternative Path along with the first action of the path. You can also delete a portion of the 

path beginning at the currently displayed frame and including all subsequent frames. You 
cannot remove a frame containing Alternative Paths. You must first delete all Alternative Paths 
that use that frame as their starting point before you can delete the frame itself. 

  

To delete an Alternative Path from the current frame: 

1. Display the first action of the path you want to remove. 

   

2. On the Delete menu, choose  Path. 
   

3. Click Yes. 

6.7 Use Decision Frames 
When you are recording topics, you may find that several tasks share common steps. Instead 
of recording separate topics, you can insert a Decision frame to allow your users to choose 
from two or more options. For example, from the Print dialog box in your application, you can 
print all pages in the document, the current page only, or a range of pages. For each task, you 
follow the same steps to open the Print dialog box and start the printing process. You could 
record the steps for printing all pages and then insert a Decision frame to record the other 
print options instead of creating individual Print topics. Decision frames provide a way to 

document multiple tasks rather than different methods of accomplishing the same task. 
  
Note: Explanation, Decision, and No Context frames are informational and do not have 
Context IDs. 
  
The recording process when inserting Decision Paths varies based on two factors: 



Use the Topic Editor 

 

 162 

 Sound/No Sound 
   

 Manual or Automatic Recording 

When recording a Decision Path with sound in manual mode, the first PrintScreen captures the 

start frame of the new Decision Path. Subsequent PrintScreen's record both the action and the 
sound. 
  
When recording a Decision Path with sound in automatic mode, the first PrintScreen records 
the start screen and sound for the new Decision Path. Subsequent PrintScreen's continue to 
record both the action and the sound. 

6.7.1 Insert a Decision Frame 

When you insert a Decision frame, it is placed after the currently selected frame in the Topic 

Editor. The existing path becomes the first path on the Decision frame, so you receive a 
prompt to provide a name for the path. Decision frames are represented in the Frame 

Structure as a dark blue circle with the letter D. A Decision frame utilizes the screenshot from 
the following frame and lists the available paths as hyperlinks. 
 
From a Decision frame, you can create an Alternative Path, which rejoins the existing path, or 
you can create a Branch Path, which has a different ending point. For example, you could 

create Alternative Paths for printing the current page and a range of pages. You could create a 
Branch Path for setting print options, which requires that the Print dialog box be open, but 
does not result in anything being printed. 
 
Note: Explanation, Decision, and No Context frames are informational and do not have 
Context IDs. 
 

To insert a Decision frame after the current frame: 

1. On the Insert menu, choose  Decision Frame. 

  
2. Enter a name for the current path. 

  
3. Click OK. 

6.7.2 Record Paths in a Decision Frame 

After you have inserted a Decision frame, you can record additional paths that your users can 
launch from the Decision frame. These paths allow users to choose from a variety of available 

tasks. When you record a Decision frame path, you must capture both the actions and 
screenshots needed to accomplish the task. However, you do not need to record an 
Introduction frame, as the path launches from the default Decision frame screenshot. 
 
Before you create a new Decision frame path, you must decide whether the new path rejoins 
the primary path. If the new path rejoins the primary path, you create a new Alternative Path. 

If the new path does not rejoin the primary path, you create a new Branch Path. 
 
Decision Alternative Paths can also rejoin the primary path at or before the Decision frame, 
thereby creating a “loop.” If you create a looping Alternative Path, the path is represented by 
a line with an arrow that appears above the primary path in the Frame Structure window. 
 
Note: You can change the end frame of a Decision Alternative Path. See Change the End 

Frame of an Alternative Path for more information. 
 
Decision frames appear in See It!, Try It!, and Do It! modes (and not Know It? mode). When 
you play or preview a topic in See It!, Try It!, or Do It! mode, the available Decision frame 
paths are listed as links in the mode bubble. Clicking a link launches the appropriate Decision 
frame path. 
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To create an Alternative Path for a Decision frame: 

1. In the Decision Properties dialog box, click  New Path. 
  

2. Click Alternative. 
  

3. Enter a name for the new path. 
  

4. Click OK. The mouse pointer turns into an arrow with a circle containing the letter E 
when placed over the Frame Structure. 
  

5. Click the frame where the Decision Alternative Path is going to rejoin the primary 
path. 
  

6. Set up the application in which you want to record to display the starting screen of the 
first action of the path. 
  

7. Perform the first action of the path. 
  

8. Press PRINTSCREEN. 
  

9. Continue to record the actions and screenshots needed to complete the path. 
  

10. Click Finish. 

To create a Branch Path for a Decision frame: 

1. In the Decision Properties dialog box, click  New Path. 

  
2. Click Branch. 

  

3. Enter a name for the new path. 
  

4. Click OK. 

  
5. Set up the application in which you want to record to display the starting screen of the 

first action of the path. 
  

6. Perform the first action of the path. 
  

7. Press PRINTSCREEN. 

  
8. Continue to record the actions and screenshots needed to complete the path. 

  
9. Click Finish. 

6.7.3 Rename Paths in a Decision Frame 

When you insert a Decision frame, the existing path is identified by the text you enter in the 
Create New Decision Path dialog box or Create New Branch dialog box. You can, however, 
change the path name as this text is displayed in the Decision frame. 
 

To rename a path in a Decision frame: 

1. Click the entry in the Path list field in the Decision Properties window. 

  

2. Click  Rename path. 
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3. Enter the text you want to display in the Decision frame. 

  
4. Click OK. 

6.7.4 Edit Header Text 

In addition to the text representing links to various paths, Decision frames display Header text 
that instructs users how to proceed. The Header text appears in the Header field in the 
Decision Properties window. By default, the Header text is "Please select from the following 
choices." You can edit the Header text to provide more descriptive information for your users. 
 

To edit the header text in a Decision frame: 

1. Drag to select the text in the Header field in the Decision Properties window. 

  
2. Type the text you want to display in the Decision frame. 

6.7.5 Reposition Paths 

By default, the first path displayed in a Decision frame is the first path you recorded. If you 
have multiple paths available in a Decision frame, you may want to rearrange the order in 
which they are listed. You can change the position of the paths by using the Move path up and 

Move path down buttons. 
 
Warning! The default path cannot be a loop that rejoins before the Decision frame. 
 

To reposition paths in a Decision frame: 

1. Click the path you want to move in the Path list field in the Decision Properties 

window. 
  

2. Click  Move path up or  Move path down, as appropriate. 

6.7.6 Remove Paths 

After you have created Decision frame paths, you may decide that you want to delete one or 
more of them. When you remove one path, the remaining paths are not affected. 
 

To remove a path from a Decision frame: 

1. Click the path you want to remove in the Path list field in the Decision Properties 

window. 
  

2. Click  Delete path. 

  
3. Click Yes to confirm the deletion. 

6.7.7 Delete a Decision Frame 

You must delete all paths other than the primary path before you can delete the Decision 
frame itself. If you attempt to delete the Decision frame without deleting the attached paths, 
you receive an error message explaining that the frame contains alternatives and cannot be 
deleted. 

 

To delete a Decision frame: 

1. Open the Topic Editor and navigate to a Decision Frame. 
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2. On the Delete menu, choose  Decision Frame. 

  
3. Click Yes. 

6.8 Edit Frame Properties 
The Frame Properties toolpane in the Topic Editor contains settings that allow you to change 
the appearance of the bubble and bubble text, as well as describe the action performed in the 
frame. 
 
The Frame Properties toolpane has two sections, separated by a divider bar. The section above 

the divider bar contains the options for the bubble and bubble text, and the section below the 
divider bar contains the settings for the action. You can drag the divider bar up or down as 
needed, for example, to see more of the bubble text in the upper section. 

6.9 Edit Bubble Properties 
The buttons in the upper section of the Frame Properties toolpane allow you to:  

 change the text that appears in the bubble 

   

 set text formatting (for example, bold, italics, and alignment) 
   

 select the position of the bubble pointer 

   

 change the background color of the bubble 

   

 link an attachment to bubble text 
   

 decide in which play modes and output types the text appears 

Any changes you make apply to the current frame only. 

6.9.1 Add Text to the Introduction and End Frames 

The Introduction frame appears as the first frame before the action frames during playback. 
The Introduction frame text also appears in the Concept pane in the Player for topics with no 
linked concepts. The Introduction frame typically contains a short statement introducing the 
topic; however, you can add any text that you desire. The End frame appears during playback 
in the Player as the last frame of the topic after the action frames. It typically contains a short 

statement about the result of the actions performed in the topic. Like the Introduction frame, 
you can add any text you feel is necessary.  
 
To enter text into the Introduction or End frame, you must display the Frame Properties 
toolpane, and then type the text in the text edit pane. As you type, the text appears in both 
the text edit pane and the bubble in the frame. 
  

Note: You can suppress the Introduction frame from appearing during playback by deselecting 
the Show introduction text option in the Publishing Wizard when you publish a Player. You can 
also set a default for this option in the Player category in the Options dialog box. 
 

To add text to an Introduction or End frame: 

1. Navigate to the Introduction or End frame. 

  
2. Display the Frame Properties toolpane, if necessary. 

  
3. Click in the text edit pane and enter the text. 
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6.9.2 Use Bubble Templates for a Frame 

The Developer generates default text for the bubble for each frame using the action settings to 

determine the correct template text to use.  
 
If the template text is not the text you want for a particular frame, you can choose not to use 
it. If you deactivate the template text, it is cleared from the bubble and you must enter the 
bubble text manually. 
 

Note: This setting can be applied to all frames on the Bubble page of the Content Defaults 
section of the Options dialog box. You can change this setting, but it is not recommended. 
 

To use or disable the bubble templates for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Use templates. 

6.9.3 Change the Template Text Font 

When you record topics, the template text in the bubbles is formatted with the default font set 
on the Bubble page in the Content Defaults section of the Options dialog box. You can change 

this font for the current frame while you are in the Topic Editor. 
 
Note: You cannot change the font color for template text. If you must change the color, you 
can insert the template text as custom text and then format it. Be aware that if you do this, it 
is no longer template text. 
 

To change the font for the template text for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 
  

2. Click  Template fonts and choose the font and attributes. 
  

3. Click OK. 

6.9.4 Add Custom Bubble Text 

You can add your own custom text to the bubble in addition to the template text. You enter 
the text in the text edit pane of the Frame Properties toolpane. By default, the text you enter 

appears before the template text, so that users read it first before performing the action. It is 
good practice to separate custom text from template text with an extra blank line, to make it 
more readable. 
 
You can change this default for all frames on the Bubble page of the Content Defaults section 
of the Options dialog box. For an individual frame, you can deselect the Show custom text first 
option to show the template text first. 

 

To add custom bubble text to the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  
2. Click in the text edit pane. 

  
3. Enter the custom text. 

  

4. Click  Show custom text first, if desired. 
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6.9.5 Insert Template Text as Custom Text 

When you disable template text, the bubble is empty and you must enter custom text. You 

can also convert template text into custom text and then edit it in the text edit pane. When 
you insert template text as user text, the default template text is imported into the text edit 
pane, disabling the template text from displaying in the bubble. 

 

To insert template text as user text on the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Insert template text as user text. 
  

3. Edit the text. 

6.9.6 Edit Custom Bubble Text 

You can edit any custom text you enter in the bubble. In the text edit pane, there are icons 

that enable you to cut, copy, paste, and delete text. You must select text in the text edit pane 
to enable these icons. You cannot use the text editing icons to edit the template text for a 
frame. 
 

 Cut the selected text. 
 

 Copy the selected text. 
 

 Paste the contents of the Clipboard. 
 

 Delete the selected text. 
 

To edit custom bubble text for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  
2. Select the text you want to edit in the text edit pane. 

  
3. Edit the text as desired. 

6.9.7 Format Custom Bubble Text 

You can format any custom text you enter in the bubble. In the text edit pane there are icons 
that enable you to bold, italicize, underline, and change the color of text, as well as change 
the font for the custom text. In addition, you can choose how to align text horizontally within 

the bubble. 
 

 Change the font for the selected text. 
 

 Prevent selected text from wrapping to the next line. (Places a dotted green line under the 
text). 
 

 Align the selected text to the left side of the bubble. 
 

 Center the selected text horizontally. 
 

 Align the selected text to the right side of the bubble. 
 

 Justify the text. 
 

 Bold the selected text. 
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 Italicize the selected text. 

  

 Underline the selected text. 

  

 Change the color of the selected text. See Web Page Defaults under Content Defaults in 

the Set Developer Defaults section of the Get Started Using the Developer chapter for more 
information about selecting and mixing colors. 
  

To format custom bubble text for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  
2. Select the text you want to format in the text edit pane. 

  
3. Apply the formatting as desired. 

6.9.8 Specify the Play Mode for Custom Text 

By default, custom text is set to appear in See It!, Try It!, and Do It! modes. This applies to 
text for the Introduction and End frames as well. You can specify the play modes in which the 
custom text appears. For example, for certain frames, you may find that the custom text is 
inappropriate for all play modes, or you may also want to add custom text to a frame for 
specific use in Know It? mode to provide users with a hint. You can select the text in the text 
edit pane, and then deselect or select the Visible in See It/Try It!, Visible in Do It!, and Visible 
in Know It? icons below the text edit pane to specify the desired mode. 

  

 The text is visible in See It! and Try It! modes only. 
  

 The text is visible in Know It? mode only. 

  

 The text is visible in Do It! mode only. 

  
For certain actions, you may find that the custom text is inappropriate for all play modes and 
can exclude it from a particular mode. If you do not want custom text to appear in See It!, Try 
It!, and/or Do It! modes, you need to select the text in the text edit pane, and then deselect 
the mode icon(s). 
 
Note: Explanation frames provide a method for adding information to a topic. While 

Explanation frames automatically appear during playback in See It!, Try It!, and Do It! modes, 
they do not appear in Know It? mode. If you wish to include Explanation frame text in the 
Know It? playback, you can select the text and enable the Visible in Know It? icon. Be aware 
that deselecting all of the Explanation frame text for Do It! mode causes the playback to skip 
the Explanation frame entirely. 
 

Intro/End Frames in Know It? mode 

When a user plays a topic in Know It? mode, the Introduction bubble appears. This bubble 

typically includes instructions for completing the task, and in many situations it differs from 
the Introduction text for the other modes. By default, Introduction/End frame text does not 
display in Know It? mode. For this reason, you should enter and designate text for the 
Introduction/End frames for Know It? mode only. For example, for a topic in Know It? mode, 

you want the Introduction text to be "Complete the steps for printing a document." or "Print a 
document." In this situation, you can enter the instruction text, select it, and then select the 
Visible in Know It? icon. Next, you would deselect the Visible in See It/Try It! and Visible in Do 
It! icons to exclude the text from displaying in those modes. 
 
When a user completes a task in Know It? mode, the End frame appears. Just as with the 
Introduction text, you may want to enter text that is appropriate for Know It? mode and 

designate it for Know It? mode only. 
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6.9.9 Display Template Text in Know It? mode 

Template text appears in See It!, Try It! and Do It! modes by default for all frames. The 

Visible in See It/Try It! and Visible in Do It! icons below the text edit pane are selected 
automatically. On frames where the user is required to enter text, the Template text visible in 

Know It? mode icon  is also selected, as such actions may require the user to enter specific 

text to perform the step correctly. 
 
Note: When you select an Introduction or End frame; the Template text visible in Know It? 

mode icon is not available because Introduction and End frames contain only custom text. 

6.9.10 Control Text for Player and Print Output 

The play mode for which custom text is marked determines in what playback or print output 
the text appears. By default, custom text that is marked to be visible in See It! and Try It! 
modes appear in the Player for those modes, in the Presentation output, and in the System 
Process Document and Training Guide documentation; text that is marked to appear for 
playback in Do It! mode appears in the Job Aid and Test Document. However, you may want 

custom text to appear during playback, but not appear in your training guide. Conversely, you 
may want text to appear in the printed documentation, but not in the Player. 
 
Using the Visible in Player and Visible in Print icons, you can separately control whether your 
custom text appears for Player and Presentation output only, a Print output only, or for both. 
 
Note: Selecting or deselecting the Visible in Player or Visible in Print icons affects the visibility 

of the selected text in all selected play modes for Player or print output. If custom text is 
marked for both See It/Try It! and Do It! modes, deselecting the Visible in Print icon means 
that the text does not appear in any printed output. 
 

To control the text for the Player and print outputs for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. In the text edit pane, select the text you want to include or remove from a particular 
output. 
  

3. Select or deselect  Visible in Player or  Visible in Print. 

6.9.11 Hide a Frame for a Play Mode 

By default, all action frames appear in the output for all play modes. You can choose to hide a 
frame from appearing in the published output for a specific play mode with the Show In 
option. For example, when testing competency, you may wish to hide a number of frames 
from appearing in Know It? mode because your procedure includes steps that may not be 
important to evaluate. When you hide a frame for a play mode, the frame does not appear 
when the user plays the topic for that mode and the frame step does not appear in print 

documents published with that play mode. That is, deselecting a frame for the Do It! play 
mode means that the frame does not appear in Do It! mode in the Player and the step does 

not appear in a Job Aid, or other documents published using Do It! as the selected text mode. 
With the Show In option, you can assign different frames, or steps, to different outputs. 
  
Note: With ExactMatch context sensitivity, hidden frames are not included in the results of a 

search; instead, the next frame with the same context ID (if it exists), is returned. 
  
When you disable a play mode for a frame that contains custom text marked to appear for 
that play mode, a red diagonal line appears through the Visible in <Play Mode> icon to 
indicate that although the text is enabled for that play mode, the text does not appear 
because the entire frame is hidden. For example, a frame contains custom text for which the 
Visible in See It/Try It! play mode icon is enabled; however, the frame is disabled for See 

It/Try It! mode in the Show In list. To indicate that the custom text does not appear in 
published output, the Visible in See It/Try It! icon displays a red diagonal line. 
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You can use the Display list in the Topic Editor to view your text and frame settings. When you 

preview a hidden frame, a message appears in the bubble indicating that the bubble and 

screenshot does not appear in this play mode. 
  
Note: Although Know It? mode is enabled in the Show In list for Explanation frames, 
Explanation frames do not appear in Know It? mode because, by default, custom text is not 
marked as visible for that play mode. Explanation frames appear in Know It? mode when 

custom text is enabled for that play mode. 
  

To hide the current frame for a play mode:  

1. In the Frame Properties toolpane, click Show in . 

  
A list of play modes appears. 
   

2. Clear an option to hide a frame in a play mode or select an option to include the frame 
in a play mode. 

6.9.11.1 Hidden Frames in Publishing 

The Show In option overrules other frame and play mode controls during publishing. For 
example, if you disable a frame for See It/Try It! mode, then the frame does not appear even 
if the text is marked as visible in See It/Try It! mode.  
  
Note: The HTML Web Site publishing format produces a static version of Try It! mode. 
Therefore, frames that are disabled for See It/Try It! mode do not appear in the published 
HTML output.  

  

Document Output  
When you publish a document based on a play mode, publishing skips those frames which are 
hidden for that play mode, and ignores any other bubble text and screenshot inclusion settings 
for the frame. Conversely, enabling a play mode in the Show In list does not guarantee that 

the frame is included in the published output. If a frame is set to show for a play mode, then 

publishing evaluates if the custom text is marked for both the selected play mode and to 
appear in print, and if the screenshot is marked for inclusion in publishing. See Use Screenshot 
Publishing in the Manipulate Frames section of the Use the Topic Editor chapter for more 
information about screenshot inclusion. 
  
Warning! If a published topic includes an alternative action or path where the primary 

action/path is hidden, the alternative action or path is not included in the published document 
even if the Include alternatives publishing option is enabled. 

6.9.11.2 Rules for Hiding and Skipping Frames 

There are several rules that determine if a frame can be hidden or skipped. 

 All frames hidden: If all of the frames in a topic are hidden for a specified play 

mode, publishing for that play mode reports an error in the activity log. 

   

 Exceptions: Not all frames can be hidden. You cannot hide Introduction or End 
frames. You can hide Explanation, Decision, No Context, and Action frames. 

  
Note: Although you cannot hide Introduction and End frames using the Show In 
option, you can skip them by hiding the bubble. See Skipped Frames below. 
   

 Alternative Actions: In Try It!, Do It!, and Know It? modes, hiding the primary 

action in a frame also hides the alternative action, and conversely, hiding the 
alternative action also hides the primary action. 
  
Note: Alternative Actions are not available in See It! mode. 
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 Alternative Paths: In Try It!, Do It!, and Know It? modes, hiding the frame for any 

alternative path disables the frame for all alternative paths. If the Alternative Path 

frame is hidden for a play mode, the Player skips that frame and continues to use the 
primary path. 
  
Note: Alternative Paths are not available in See It! mode. 
   

 Decision frames: If the Decision frame is hidden for a play mode, the Decision frame 

is skipped and the Player continues to use the default path. 
   

 Jump-in points: Jump-in points that point to a frame that is hidden for a play mode 

do not appear in the Jump-in point list. 
  

 Scoring: In Know It? mode, hidden frames are not part of the calculated score. 

   

 In-application Support (Exact Match only): Hidden frames are not returned in a 
search; instead, the search returns the next frame with the same context ID (if one 

exists) or the topic and section are ignored if the hidden frame is the only one with 
context. 

Skipped Frames  

There are other situations where frames are hidden by being skipped. Hiding the bubble for 
certain frames also skips them. See the Hide the Bubble topic in the Edit Bubble Properties 
section of the Use the Topic Editor chapter for more information about hiding the bubble. 
  
The following frames are skipped when you hide the bubble:  

 Start and End frames in See It! and Try It! modes 

   

 Explanation frames in See It! and Try It! modes 
  

 Action frames with the Delay Time set to Infinite in See It! mode only 

These frames are also skipped in the following situations:  

 Explanation frames with the Delay Time set to "Skip" and no custom bubble text 
marked for See It/Try It! modes: The frame is skipped when played in See It! and Try 
It! modes. 
   

 Explanation frames with the Delay Time set to "Skip" and custom text marked for See 

It/Try It! modes: The frame is skipped in See It! mode, but appears in Try It! mode. 
   

 Explanation frames in Do It! and Know It? modes if the bubble has no text marked for 

display in those play modes: These are skipped even if the frames contain sound. 
   

 Decision frames in Know It? mode are skipped. 

6.9.12 Preview Frame Text for Playback and Print Output 

You can preview how your custom text for a frame appears in the Player and Printed outputs 
in each play mode using the Display list in the Topic Editing toolbar. By default, the bubble 

displays the template and custom text as they appear when you play the topic in See It! and 
Try It! modes. However, you can check how the text appears for each mode in the Player and 
print output. There are six display modes; Player - See It/Try It!, Player - Know It?, Player - 
Do It!, Print - See It/Try It!, Print - Know It? and Print - Do It!. 
 
Note: You can use the Print - See It/Try It! view to see how the text appears in the System 
Process Document, Training Guide, and Instructor Manual. The Print - Do It! views allows you 

to see how the text appears in the Job Aid, Test Document, and Test Case. 
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Tip: You can also access the display modes using the View menu and the Display submenu. A 

checkmark appears next to the selected display mode on the menu. 

6.9.13 Hide the Bubble 

You can prevent the bubble from appearing during playback in See It! and Try It! modes. This 
allows you to create the equivalent of a PowerPoint slide show, and then record sound to 
narrate it if desired. In this case, a bubble on each "slide" would not be appropriate.  
 
This option allows you to hide the bubble on a frame-by-frame basis. You must turn off the 

action areas manually if you do not want them to show. If you turn the action area off, you 
may want to make sure that the Enable skipping in Try It! mode option is selected when you 
publish the content so that the frames can be advanced by pressing Enter in Try It!; if there 
are no action areas, there is no visual cue as what to do to advance the frame, and you may 
have difficulty advancing the frame. 
 
If sound has been recorded for the topic or the frame, all frames displayed during See It! 

mode playback advance automatically when the sound has finished playing. The only 

exception is for frames with sound and the delay set to infinite. In this case, Press Enter to 
continue displays and the frame does not advance until the user presses Enter. In Try It! 
mode, all frames are shown, but the frames must be advanced manually by either performing 
the correct action or pressing Enter. No remediation is shown if you perform the incorrect 
action. 
 

If there is no sound with the topic, turning off the bubble has the following affect on the 
various frame types in See It! and Try It! modes: 

 Introduction/End: See It! and Try It! is skipped 
  

 Explanation: See It! and Try It! is skipped 

  

 Decision: See It! and Try It! is included; user must choose a path 
  

 Action: See It! and Try It! bubble is hidden; action area displayed unless it has been 
turned off 
  

 No-context: See It! and Try It! bubble is hidden; action area displayed unless it has 

been turned off 
  

 Frames with infinite time delay: See It! is skipped and in Try It! bubble is hidden; 
action area displayed unless it has been turned off 

Note: If there are alternative actions on a frame and you hide the bubble, the bubble is 
hidden for all actions. 
 

To hide the bubble for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Display bubble for this frame to toggle the bubble off for the frame. 

6.9.14 Select a Bubble Icon 

Each bubble can contain a default icon before the text. By default, no icon appears. You can 

choose an icon for the current frame by using the Bubble icon in the Frame Properties 
toolpane.  
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To select an icon for the bubble for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Bubble icon and choose a bubble icon. 

6.9.15 Change the Bubble Pointer 

The bubbles appear with a default shape and pointer location. You can choose from nine 

different pointer locations, which effectively relocate the bubble on the screen. You cannot 
relocate a bubble if the bubble does not fit on the screen in the new position. 
 

To change the bubble pointer for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Pointer position and choose a pointer position. 

6.9.16 Change the Bubble Background Color 

The default background color for all bubbles is yellow. You can change this default for the 
current frame. This option is useful for calling attention to certain steps.  

  
See Web Page Defaults under Content Defaults in the Set Developer Defaults section of the 
Get Started Using the Developer chapter for more information about selecting and mixing 
colors. 
 

To change the background color of the bubble for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Background color and choose a background color. 

  
3. Click OK. 

6.10 Edit Action Properties 
The lower section of the Frame Properties toolpane contains settings that describe the action 
performed in the frame. As you record a topic, the Developer automatically enters information 

for these settings, which vary according to the type of action performed. The Developer uses 
these settings to determine the appropriate bubble text based on the template assigned to the 
topic. You can change many of the settings as appropriate for your needs. 

6.10.1 Action Types 

The Action Type setting indicates the type of action taken for the current frame. There are 

three basic action types: keyboard, string input, and mouse. A keyboard action occurs when 
you press a key on the keyboard to accomplish a task. A string input action occurs when you 
enter text into a document, field, dialog box, and so on. A mouse action includes clicking, 

double-clicking, pointing, rolling the wheel, and dragging. While the Developer automatically 
determines the action, you can change this setting if necessary. The following lists the possible 
actions: 
 

Point: Using the mouse to point to an object on the screen. Most often used when displaying 
a submenu. 
 

Drag: Clicking and holding either mouse button while moving the mouse. This action includes 
dragging to select text or cells, or dragging an object (such as a graphic) across the screen. 
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Keyboard: Pressing any function key, cursor movement key, or any other single key, such as 

ENTER, TAB, ESC, INSERT, or DELETE. This action also includes key combinations, such as 

CTRL+A, SHIFT+ENTER, and ALT+TAB. 
 
Left button down 
Left button up: Pressing and holding the primary mouse button (the left mouse button for a 
right-handed user); releasing the mouse button. These actions are used before and after drag 

events to indicate the start and end of the drag. 
 
Left click 
Left double-click 
Left triple-click: Using the primary mouse button. 
 
Left begin drag: Holding the primary mouse button down and moving the mouse. 

 
Right button down 
Right button up: Pressing and holding the secondary mouse button (the right mouse button 

for a right-handed user); releasing the mouse button. 
 
Right click 
Right double-click 

Right triple-click: Using the secondary mouse button. 
 
Right begin drag: Holding the secondary mouse button down and moving the mouse. 
 
Middle button down 
Middle button up: Pressing and holding the middle mouse button; releasing the mouse 

button. 
 
Middle click 
Middle double-click 
Middle triple-click: Using the middle mouse button. 
 

Middle begin drag: Holding the middle mouse button down and moving the mouse. 

 
Wheel: Rolling the middle mouse wheel. 
 
String input: Entering text into a document or a field by typing on the keyboard. 
 
Note: If you record an action that uses a keyboard combination involving the SHIFT, CTRL, or 
ALT keys, the Topic Editor records the action as a keyboard action and automatically selects 

the Alt, Control, or Shift option in the Frame Properties toolpane, as appropriate. 

6.10.2 Object Type 

The Object Type setting refers to the type of object on which you performed the action. The 
Developer determines the object type or class automatically, based on the Template Set 
selected. The Developer then determines which template text to use for the bubble text. Each 

Template Set may contain different text for the same object type. 
 

The Object Type list is divided into an upper and lower section, separated by a horizontal line. 
All object types appear in the lower section. The upper section contains a list of the most 
commonly used object types. As you change object types, the new entries are added to the 
upper section; older entries in the upper list are removed to make room for the new ones. The 
upper section then becomes a personalized list of the objects you frequently use, making 
object type changes faster and easier to manage. 

6.10.3 Object Name 

The Object name setting refers to the name of the object on which you performed the action. 

This name is entered in the appropriate place in the bubble template to tell the user which 
icon to click, which menu item to click, or which option to select. The Developer determines 
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the name of the object from the programming of the application itself. If you want to alter the 
object name, you can use the Object name field in the Frame Properties toolpane to do so. 

 

To edit the object name for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  
2. Click the Object name field. 

  
3. Edit the object name as desired. 

6.10.4 Ignore Context Information 

You can choose to ignore the context information for a particular frame. This action clears all 
the context information settings (SmartMatch or ExactMatch type) except for the action in the 
Action type list. The context information determines the template text in the bubble; when 
context information is removed, the bubble is empty. You must then manually enter the text 

that you want to display in the frame's bubble. 
 
Ignore Context provides the opportunity to document actions and objects that are not 

normally recognized. For example, you can use Ignore Context to document a non-recognized 
scrolling action. You can move and resize the action area to reference the scroll bar and then 
enter text in the Frame Properties toolpane instructing the user to scroll as necessary. 
 

To ignore context information for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Ignore context. 

  
3. Click Yes to confirm the action, if applicable. 

  

4. Move and resize the action area. 
  

5. Click the text edit pane in the Frame Properties toolpane and enter bubble text. 

6.10.5 Create a New Action Area 

The action area indicates where the action takes place in a frame. In the Topic Editor, it is 

designated by a red rectangle overlaying the frame's screenshot.  
 
You may find that you need more than one action area to accommodate an action on a 
particular frame. For example, if you are recording the action of clicking the Home button in a 
browser and two screen elements (toolbar and navigation bar) contain the Home button, you 
could have an action area for each button. 
  

Warning! In document (print) outputs, the action area appears in the Procedure step table for 

frames that contain a single action area only. Frames that contain more than one action area 
display no action areas for that step. 
 

To create a new action area for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Modify action and print areas and choose the Create new action area 

command. 
  

3. Resize and reshape the new action area. 
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6.10.5.1 Delete an Action Area 

After creating new action areas on a frame, you may decide that you do not want to use all 

the action areas. You must have at least one action area on a frame unless the frame is a 
Decision frame or the action for the frame is a keyboard action. 
 

To delete an action area from the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  
2. Click the action area you want to delete. 

  

3. Click  Modify action and print areas and choose the Delete action area 
command. 

6.10.5.2 Copy an Action Area 

If you have edited action areas on a frame and the subsequent frame uses the same action 
areas, you can copy the action area from the previous frame instead of repeating your work. 
All action areas from the previous frame are copied to the current frame, simultaneously 
replacing any existing action areas on the current frame. 
 

To copy action areas from the previous frame to the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Modify action and print areas and choose the Copy action area 
command. 

6.10.5.3 Resize an Action Area 

Most often, the Developer is able to determine the correct menu, menu entry, icon, or other 

object, and the action area is sized and positioned automatically. At times, however, you may 
need to resize the action area to select the correct location or to indicate a specific choice in a 
list. The Developer includes three methods to resize the action area. 

 Selection handles: Drag a selection handle to resize in a specific direction. Drag a 
corner selection handle to resize both horizontally and vertically. 
  

 Redraw mode: Resize using a combination of the left mouse button and the CTRL 
key. Hold CTRL and press the left mouse button to position the upper left corner of the 
action area. Then drag the mouse to redefine the size of the area. The mouse pointer 
changes into a crosshair as you drag. When you release the left mouse button and the 
CTRL key, you position the lower right corner of the action area. Using CTRL in 

conjunction with the right mouse button does not activate redraw mode. 
  

 Double-clicking the mouse: Double-click the left mouse button within the existing 

action area to indicate the upper left corner. Hold the SHIFT key and double-click the 
left mouse button within the existing action to indicate the lower right corner. 

Note: While recording, the action area defaults to the size specified in the Area Size field on 

the Recorder tab in the Options dialog box if the Recorder recognizes the object as a Universal 
Object, Workspace, Window or Active X object. 
 

To resize the action area using the selection handles: 

1. Point to a selection handle on the action area. 

  
2. Drag the selection handle in the desired direction and release the mouse button. 
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To resize the action area using redraw mode: 

1. Hold the CTRL key and click the left mouse button within the existing action area in 

the location where you want the upper left corner of the action area to appear. 
  

2. Drag to extend the action area over the area of the screen you want to reference. 
  

3. Release the mouse button and the CTRL key where you want the lower right corner of 
the action area to appear. 

To resize the action area by double-clicking the mouse: 

1. Double-click the left mouse button within the existing action area in the location where 

you want the upper left corner of the action area to appear. 
  

2. Hold the SHIFT key and double-click the left mouse button within the existing action 

area in the location where you want the lower right corner of the action area to 
appear. 

6.10.5.4 Move an Action Area 

You can move an action area easily by dragging it or by using redraw mode. Be aware that 
double-clicking on the screen resizes the action area. 
 

To move the action area by dragging: 

1. Point to any area within the action area. The mouse pointer changes into a four-

headed arrow. 
  

2. Hold the left mouse button and drag the action area to any location and release the 
mouse button. 

To move an action area using redraw mode: 

1. Hold the CTRL key and click the left mouse button outside of the existing action area 
in the location where you want the upper left corner of the action area to appear. The 

mouse pointer changes into a crosshair and the upper left corner of the action area is 
positioned in the new location. 
  

2. Drag to extend the action area over the area of the screen you want to reference. 
  

3. Release the mouse button and the CTRL key where you want the lower right corner of 
the action area to appear. 

6.10.5.5 Disable the Action Area 

When you play a topic in Try It! mode, a rectangle appears around the area in which you must 
click or type to move to the next frame. You can disable the action area in Try It! mode to 
prevent the rectangle from appearing. The Action area on/off option affects the current frame 
only. 
 

To disable the action area for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Action area on/off. 
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6.10.6 Define a Print Area 

As you record topics, the Recorder captures action areas and print areas (if detected). Action 

areas define the hotspots of the screen for the simulation (See It!, Try It!, Do It!) modes. 
Some action areas (for example, edit fields, radio buttons, and checkboxes) do not include 
important context information, like the field label. In simulation modes, the field labels are not 
important as the user sees the context for the action area as they interact with the screen. 
However, in print, only the action area appears in the step table; the additional context, such 
as the field label or group label, is not included. Print output is more easily understood if the 

step table includes print areas that include field labels along with action areas. 
 

When the Recorder senses a print area from the screen context, it captures the action area 
and a separate print area sized to include the captured label as well as the action area. The 
Recorder captures a print area for most mouse events, even if it does not detect a label. For 
example, you do not see a separate print area for clicking a button, such as the Search or OK 
button, because the print and action areas overlap. If the Recorder does not capture a 
separate print area for a frame, the print output uses the action area; however, you can 

override the action area for print by manually adding a print area to a frame in the Topic 

Editor. 
 

Note: If you recapture an action, the print area is also recaptured if a change in the print area 
is detected. 
 

The print area, similar to the action area, is a semi-transparent rectangle. The area appears as 
a magenta rectangle to differentiate it from the red action area. You can move the print area, 

resize it using the selectors, or delete it. While a frame may contain multiple action areas, it 
can contain only one print area. Changes to the print area can be undone using Undo. 
 

When you view a frame in the Topic Editor, the action area appears on top of the print area, 
covering all or part of the print area. Both the action and print areas are visible for all player 
modes and print outputs on the Display list. You can choose to hide or show the action or print 
areas for ALL frames. Deselecting Show Action Area or Show Print Area hides the 
corresponding area; deselecting both options hides all print and action areas. 
 

Note: The state of the icons affects the display in the Topic Editor only; it does not affect the 
published output. 
 

In published documents, the print area works independently of the action area. If you specify 
a print area for a frame, it is always included in print output. If you do not specify a print area 
for a frame, the print output uses the action area instead. If you create a print area that does 
not include the action area (the print and action areas are separate areas), only the print area 

for that frame is included in the printed output. If the print area completely contains the action 
area, a border appears around the action area within the print area. If you want to remove the 
border in this instance, you can customize the print style for the document output. See 
Remove the Action Area Overlay in the Customize Publishing Styles section of Publish Content.  
 

The placeholder in the print template for the document type determines the maximum width 
and height of the print area. The default setting for the print area uses the full width of the 
Action column in the step-action table. The print area is scaled if it is too large to fit the step-

action table. Conversely, action areas that are too large to fit the step-action table are 
excluded rather than scaled.  
 

To create a new print area for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Modify action and print areas and choose Create Print Area. 

  
or 
  
Right-click the action area and choose Create Print Area. 
  



  Use the Topic Editor 

   179 

3. Resize and reshape the new print area. 

To delete a print area from the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

    

2. Click  Modify action and print areas and choose the Delete Print Area 

command. 
  
or 
 
Right-click the print area and choose Delete Print Area. 
  

3. Click Yes to confirm the deletion. 

To show/hide action or print areas in all frames: 

1. From the View menu, point to Show Area, and click  Action Area to show or hide 

the action areas for all frames. 
  

2. From the View menu, point to Show Area, and click  Print Area to show or hide 

the print area for all frames. 
  

Note: You can use the Show Action Area and Show Print Area icons on the toolbar 
to show and hide the areas and determine the visual state of the areas for the topic. 

6.10.7 Use Keep with Next 

The Keep with Next option displays the steps for the current frame and the following frame 

together during the topic playback in Do It! mode. When the topic is played back, the steps 
are presented together, separated by the word “Next.” For some actions, such as selecting a 

menu and then selecting the menu command, this option is enabled by default. 
 

To display the current frame with the next frame in Do It mode: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  Keep this action with next action in Do It!. 

6.10.8 Set Frame Delay 

The delay refers to the amount of time a frame is visible before the action takes place during 

See It! mode. The default value of 5.0 is five seconds. You can create as much of a delay as 
you feel necessary for the user to understand or read the information on the screen. There is a 
predefined list of delay options from which you can choose, or you can enter the desired delay 
time in the Delay time(s) list. The following bullets describe the predefined options: 

 Skip: The step does not display at all. This option is only available for Introduction, 
End, Decision and Explanation frames. 

   

 0: There is no delay before the animated mouse pointer begins to move for an action 
frame. This option is not available for Introduction, End, Decision and Explanation 
frames. 

   

 5.0: There is a 5-second delay before the animated mouse pointer begins to move for 
an action frame. 
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 10.0: There is a 10-second delay before the animated mouse pointer begins to move 

for an action frame. 

   

 Infinite: The user must press the ENTER key to advance to the next step of the topic. 

When you set the delay to Infinite, the text “Press Enter to continue.” appears 
automatically in the bubble in See It! mode. 

When sound files are available for a frame and sound is activated, if the delay is set to Infinite 
the user must press the ENTER key to advance.  For all other delay values, the frame 
advances automatically after the sound finishes. 
  
This setting can be applied to all frames on the Topic page of the Content Defaults section of 

the Options dialog box. The time set here is the default for all newly recorded and inserted 
frames, with the exception of Decision frames, which automatically default to Infinite. 
Changing the setting here does not change the delay time for existing content. 

6.10.9 Create a Jump-in Point 

Jump-in Points are available to users in the Player. An arrow icon appears on the See It!, Try 
It!, and Do It! buttons in the Player window. Clicking the icon opens a window containing a list 
of Jump-in point links to various frames within a topic. The Beginning of the Topic Jump-in 
point displays by default. These links allows a user viewing content in the Player to start a 

topic at a point other than at the beginning. For example, if you have a topic that covers many 
screens, you can create Jump-in Points to allow users to move directly to the screen with 
which they need help, instead of navigating the entire topic. 
 
The Frame Properties toolpane in the Topic Editor includes a Jump-in point field at the bottom. 
You can enter a descriptive name for a frame in this field to create a Jump-in point. You 
cannot create Jump-in points for Introduction/End frames. 

  
If the play mode for a jump-in frame is unmarked in the Show In list, the jump-in point does 
not appear in the jump-in list for that play mode in the Player. For example, if you add a 
jump-in point for a frame that is deselected for See It!/Try It! mode, the jump-in point does 

not appear in the jump-in lists for the See It! or Try It! play mode buttons in the Player. 
  

Note: The Jump-in point field is at the bottom of the toolpane. You may need to maximize the 
display to see it. 
 

To create a Jump-in point for the current frame:  

1. Display the Frame Properties toolpane, if necessary. 

  
2. Click the Jump-in point field. 

  
3. Type the text you want to appear as the link to the Jump-in point. 

6.10.10 Keyboard Action Options 

If the action is a keyboard action, two extra options appear in the Frame Properties toolpane. 
These options enable you to specify what key was pressed. The Key field contains a list of the 
keys on a keyboard, including: Backspace, Delete, Down, End, Enter, Escape, F1, F2, F3, F4, 

F5, F6, F7, F8, F9, F10, F11, F12, Home, Insert, Left, Page Down, Page Up, PrintScreen, Right, 
Space, Tab, Up, and so on. If any other key is pressed, you need to select the <Character> 
option and then type the specific key in the Char key (character key) field. 
 
You can change these settings if necessary, but it is not recommended. 
 
Note: If the keyboard action involves the ALT, SHIFT, or CTRL key, the appropriate option is 

selected automatically in the Frame Properties toolpane. 
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6.10.11 String Input Formatting Options 

If the action is a string input action, these settings are available. 

 Implicit text: The text in this field appears as selected text before the input text is 
entered in the simulation modes. It is the default text that appears in an edit field, the 
text that is replaced by a string input. 

   

 Input text: The text in this list field appears when the topic is played in See It! mode. 
It is also the text that the user must type when the topic is played in Try It! and Know 
It? modes. Depending upon the options set, this text may also appear to users in Do 

It! mode. 
   

  String input font: Clicking this icon opens the Font dialog box and allows you to 

change the font attributes of the input text. 
   

  String input background color: Clicking this icon opens the Color dialog box and 

allows you to choose the color for the background of the input text. See Web Page 
Defaults in the Set Developer Defaults, Content Defaults sections of the Get Started 
Using the Developer chapter for more information about selecting colors. 
   

  String input case sensitivity: Clicking this icon activates case sensitivity in Try 

It! and Know It? modes. The user must enter text in the proper case to advance to the 
next step automatically. 
   

  Set as password field: Clicking this icon displays string input text as asterisks 
instead of characters as it is typed during playback in See It!, Try It!, and Know It? 
modes. This option is useful for recording password screens. 

  
Note: This option is automatically enabled when the Recorder recognizes that you 
have entered text in a password field. See Record Different Action Types in the Use 
the Recorder section of the Record Topic Content chapter for further information. 

If you want to edit the input text or add other possible entries, you must use the String input 
options icon. See Input Text Options for further information. 
 
Note: By default, string input text is set to appear in Know It? mode as it may be critical for 
users to enter specific text. However, you can turn off the display of this text by de-selecting 

the Template text visible in Know It mode icon in the Frame Properties toolpane. 

6.10.11.1 Input Text Options 

You have several options available to modify input text. You can add additional entries to be 
displayed in Know It? and Do It! modes, replace input text in all three modes, delete entries, 
change the default entry, or clear the string input list. In addition, the available options allow 

you to have multiple “concrete” entries, which are specific text that can be entered, and 
several “meta” entries, which allow for a range of non-specified text in Know It? and Do It! 
modes. You must have at least one concrete entry in the Input text list for every string input 

action. 

6.10.11.2 Replace Input Text 

After recording a string input action in a topic, you may decide that you would prefer other 
text to be displayed in the action. You can change the text that is entered in See It!, Try It!, 
Do It! and Know It? modes. 
 
Warning! If you replace the text for a string input action, be sure to recapture the affected 
screenshots. Otherwise, the bubble text and screenshot do not match for See It! and Try It! 
mode. For example, if you recorded a topic in which "Peter" is entered into a Name field and 

later, you replace "Peter" with "John," the screenshot in the next frame still displays "Peter." 
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To replace input text on the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  String input options and choose  Replace text. 

  
3. Enter the desired text. 

  
4. Click OK. 

6.10.11.3 Delete Input Text 

By default, every string input action has two entries listed in the Input text list; the text you 
entered and < Something >. These entries restrict what users can enter in Try It! mode to 
exactly the text you entered, while still allowing users to enter any text in Know It? and Do It! 
modes. If you want to add additional possible entries for Try It! mode, or use the < Anything 
> or < Blank > entries, you can delete the < Something > entry and then add option(s). You 

can also delete concrete entries or other meta entries if you decide not to use them. 
 
Note: You must have at least one concrete entry in the Input text list. If there is only one 
concrete entry in the list, the Delete entry option is unavailable for that entry. 
 

To delete input text from the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  
2. Click the Input text list. 

  

3. Click the entry you want to delete. 
  

4. Click  String input options and choose  Delete entry. 

6.10.11.4 Add New Text to the Input Text List 

After deleting the default < Something > entry from the Input text list, you can add other 
concrete entries to the list. If you add concrete entries to the list, those entries appear in 
Know It? and Do It! modes and satisfy the string input action; additional concrete entries do 
not affect See It! and Try It! modes. You cannot add text to the Input text list if the list 
includes the < Something > or < Anything > entry. 

 

To add new text to the input text list for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 
  

2. Delete any existing meta entry. 
  

3. Click  String input options and choose  Add new text. 

  
4. Enter text. 

  
5. Click OK. 

  
6. Repeat as necessary. 

6.10.11.5 Add Meta Entries to the Input Text List 

After deleting the default < Something > entry from the Input text list, you can add other 
meta entries to the list. The following bullets list the possible meta entries and their impact:  
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 Anything: When a string input action using the < Anything > entry is played in Know 

It? mode, a user can enter any text or leave the field blank and move to the next step. 

For example, a user may see the following instructions for completing a field: Enter 
information into the Subject field. Enter a valid value (for example, “Meeting on 
Tuesday”) or leave blank. 
   

 Something: When a string input action using the < Something > entry is played in 

Know It? mode, a user must enter some text to satisfy the step. The text entered may 
or may not be the concrete entry created by the content author. For example, a user 
may see the following instructions for completing a field: Enter information into the 
Subject field. Enter a valid value (for example “Meeting on Tuesday”). 
   

 Blank: When a string input action using the < Blank > entry is played in Know It? 
mode, a user must enter the same concrete entry created by the content author or 
leave the field blank and move to the next step. For example, a user may see the 
following instructions for completing a field: Enter information into the Subject field. 

Enter “Meeting on Tuesday” or leave blank. 

   

 No meta entry: If no meta entry is included in the Input text list, a user must enter 
one of the concrete entries to satisfy the string input action in Know It? mode. For 

example, a user may see the following instructions for completing a field: Enter 
information into the Subject field. Enter “Meeting on Tuesday” or “Tuesday's Meeting”. 

Note: You cannot add the < Something > or < Anything > entries if the Input text list 

includes more than one concrete entry. 
 
Note: You can only include one meta entry in the Input text list for a string input action. 
 
In the Player, the string input text appears as described in the preceding bullets. In Do It! and 
Try It!, users can move to the next step using the Next Step button in the Player. 

 

To add meta entries to the input text list for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 
  

2. Delete any existing meta entry or any multiple concrete entries. 
  

3. Click  String input options and choose  Add 'anything',  Add 

'something', or  Add 'blank'. 

6.10.11.6 Set the Default Text Entry 

The default input text entry is used in both See It! mode and Try It! mode, and it is the first 
entry listed in Do It! mode. After recording a string input action in a topic and adding new 
text, you may decide that you prefer to use one of the new concrete entries as the default. 
You cannot use a meta entry as the default entry, however. 
 

Warning! If you set a new default for the string input action, be sure to recapture or edit the 
affected screenshots. Otherwise, the bubble text and screenshot do not match for See It! and 

Try It! mode. For example, if you recorded a topic in which "Peter" is entered into a Name field 
and later, add "John" and set "John" as the default, the screenshot in the next frame still 
displays "Peter." 
 

To set the default input text entry for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  
2. Click the Input text list. 
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3. Click an entry. 

  

4. Click  String input options and choose  Set to default. 

6.10.11.7 Clear the Input Text Entry List 

If you want to remove all of the entries from the Input text list, except for the default entry, 
you can clear the list. You can then add new entries or simply leave the default entry as the 
only entry for the action. 
 

To clear the input text entry list for the current frame: 

1. Display the Frame Properties toolpane, if necessary. 

  

2. Click  String input options and choose  Clear list. 

6.10.11.8 String Input Scoring in Know It? mode 

There are two ways that string inputs are scored in Know It? mode. If the step uses a 
validated string input, the user must enter the string input exactly as indicated by the content 
author in the bubble for the step to be scored as correct. Therefore, if the bubble prompts the 
user to enter “AB31S” into an Account field, the step is counted as incorrect if the user 

mistypes the entry as AB33S. 
 
If you use an unvalidated string input, any entry typed in the field is scored as a correct entry. 
Users are not be penalized for incorrectly typing an entry. 
 
When a user types an entry that matches the text that appears in the bubble, Know It? mode 
scores the step as correct and automatically advances to the next step. This action occurs for 

both validated and unvalidated string inputs. Know It? mode does not automatically advance 
to the next step if the user types an entry that is different from the entry in the bubble. If the 
step does not automatically advance, the user has a choice of either editing the entry to match 

the example, or clicking the Typing Complete button in the Know It? mode bubble to submit 
the current entry. The entry is then scored as correct or incorrect depending on its validation 
status. 

 
Note: For content created with the Japanese or Chinese versions of the Developer, a string 
input step does not automatically advance when the end user types a correct entry. The user 
needs to click the Typing Complete button to submit their entry. 
 
Note: A user can use normal editing functions to correct a string input entry. Mouse actions 
such as dragging and keyboard actions such as the BACKSPACE and DELETE keys are allowed. 

 
The meta entry used for the input step controls whether a string input is a validated or an 
unvalidated one. The possible meta entries and their impact are listed below: 

 Something: Creates an unvalidated string input. When a string input action using the 

< Something > entry is played in Know It? mode, the user must enter some text to be 
scored as correct. The text entered may or may not be the concrete entry created by 

the content author. For example, if a user is prompted to enter “Tuesday”, the step is 
counted as correct if the user enters “Monday” or “123”. However, leaving the field 
blank is scored as a mistake. 
  

 Anything: Creates an unvalidated string input. When a string input action using the < 

Anything > entry is played in Know It? mode, the user can enter any text or leave the 
field blank, to be scored as correct. 
  

 Blank: Creates a validated string input. When a string input action using the < Blank 

> entry is played in Know It? mode, the user must enter the same concrete entry 
created by the content author or leave the field blank, to be scored as correct. Any 
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other entry, including a typing mistake, is scored as incorrect. 
  

 No meta entry: Creates a validated string input. If no meta entry is included in the 

Input text list, the user must enter one of the concrete entries to be scored as correct. 
Any other entry, including a typing mistake, is scored as incorrect. 

6.11 Edit External Content 
In the Topic Editor, you can link attachments to a specific frame. This allows you to include 
explanatory information for a specific step in the topic. 

6.11.1 Link an Attachment as a Concept: Topic Editor 

You can manage the concept of a topic directly from the Topic Editor. This allows greater 
efficiency in editing topics and their concepts and also provides a clearer representation of the 

overall organization of the topic. You can perform the same concept-related tasks from the 
Topic Editor as are available from the Outline Editor. The Concept toolpane also provides a 
preview of the linked concept attachment. 

 

To link an existing package file or web page as a concept from the Topic Editor: 

1. Display the Concept toolpane, if necessary. 

  

2. Click  Create link. 

  

3. In the Link to pane, select  Document in Library. 

  
If desired, you can select Packages or Web pages in the Type field to further filter 
your selection. 
  

4. Navigate the Library to the folder containing the package file or web page to which 

you want to link. 

  
5. Select the desired package file or web page document. 

  
6. Click OK or press ENTER. 

Note: At step 2, you can also click  Create new web page to create a new web page and 

link to it in one step. When you do so, you first specify the name of the web page and the 
Library folder in which it should be saved. The Concept toolpane then closes, and an empty 
web page opens in a new tab. After you complete the web page, you can preview its contents 
in the topic by reactivating the Topic Editor tab. 
 

To link a URL as a concept from the Topic Editor: 

1. Display the Concept toolpane, if necessary. 

  

2. Click  Create link. 

  

3. In the Link to pane, select  URL. 

  
4. In the Address field, type or paste the target URL. 

  
If a Base URL was set, you can enter a relative URL beginning with ../. 

  

5. Click  Go or press ENTER. 

  



Use the Topic Editor 

 

 186 

While selecting a URL, you can also enter a base URL and then follow links in the 

preview displayed in the results pane to reach your desired target. 

  
6. Click OK or press ENTER. 

To create and link a new package as a concept from the Topic Editor: 

1. Display the Concept toolpane, if necessary. 

  

2. Click  to launch the Package Wizard and click Next. 
  

3. Browse to and choose the files/folders that you want to add to the package and click 
Next. 
  

4. Type a name for the new package and browse to a location in the Library where you 
want it saved (if you do not want to save it in the default location). 

  

5. Click Next. 
  

6. Choose a file in the package that is to be launched in the Concept pane. Navigate 
through any folders contained in the new package, if appropriate. 
  

7. Click Next to finish. 

6.11.2 Link to an Attachment from a Topic Frame 

Within a topic, you can link from any frame to one or more attachments. Attachments linked 
at this level provide information to your users as they view a topic. For example, you might 
link from a frame to a spreadsheet listing department codes or other reference information 

that users need at a particular step in a procedure. Like concept and bubble text links, links to 
attachments from topic frames become part of the parent document. If you then move the 
topic or reuse it elsewhere in your content, the linked attachment remains associated with that 

frame of the topic. Conversely, deleting the link to an attachment from a topic frame in one 
location removes the link in all places where the topic is used. 
 

The Frame Link toolpane of the Topic Editor provides the tools for linking to and managing the 
links to attachments from topic frames. When linking to a package file or web page, you can 

filter the display to include packages or web pages only and navigate through the Library 
folders to the specific file you want to link. When linking to a URL, you can type or paste a 
base URL and then follow links in the preview displayed in the results pane of the Insert 
Hyperlink dialog box to reach your desired target. 
 

Note: An absolute URL represents the fixed location of a piece of content without regards to 
its context. A Relative URL is a shortened version of the full URL that only makes sense when 

used in context. The full URL is constructed by taking a Base URL (set in the General Content 
Defaults) and appending the Relative UR set when creating a hyperlink). Here is an analogy to 
help clarify. Let's say you asked me where my brother lives and I said "right next to my 

house". If you didn't know where I lived, this information would not be useful. However, if you 
did know where I lived, then you could find my brother's house by locating my house and then 
find his next door. In this case, my house is an example of the Base URL and "right next to my 
house" is an example of the Relative URL. 
 

Relative URLs are useful when the content developer is not sure of the location where the 
content is to be deployed. They allow the content developer to link to content outside of the 
Library in the Developer. 
 

The Base URL can be set in the Developer and can be changed, if necessary, in the Player 
Package after publication. 
 

Note: If a Base URL is set in the General Content Defaults, you can enter a Relative URL 

(beginning with../) when inserting a hyperlink for a URL on the Insert Hyperlink dialog box. 
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The procedure for linking to an attachment from a topic frame differs slightly from that for 
concepts and bubble text. When you link to an attachment from a topic frame, you can select 

an icon for the link and add a tooltip. The icon appears in the frame bubble when the user 
views the topic in the Player, and the tooltip appears when the user rests the mouse pointer 

over the link icon. The icon and tooltip are stored with the link itself, rather than with the 
attachment. Therefore, when you link to the attachment from another location in your content, 
you can choose to add a different icon and/or tooltip, if desired. 
 
A single frame can link to multiple attachments. You manage all of the attachments linked at 
the frame level from the same dialog box, but you can assign a different icon and/or tooltip to 
each of the links. You can also change the order in which multiple attachments are linked to a 

single topic frame. As you navigate among the frames in a topic with the Frame Link toolpane 
open, the display updates dynamically to show the links for each frame. This provides a simple 
means of managing all frame links in a topic and analyzing the overall topic layout. 
  

To link to an existing package file or web page from a topic frame:  

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a package file or web page. 
   

2. Display the Frame Link toolpane, if necessary. 

   
3. In the empty row in the Frame Link toolpane, click the Name field to activate it. 

   

4. Click  Create link. 

   

5. In the Link to pane, select  Document in Library. 

  
If desired, you can select Packages or Web pages in the Type field to further filter 
your selection. 
   

6. Navigate the Library to the folder containing the package file or web page to which 
you want to link. 

   
7. Select the desired package file or web page document. 

   
8. Click OK or press ENTER. 

   
9. An icon is added to the link by default. If desired, change the link icon. 

   
10. The word "Link" is added as the default tooltip. If desired, change the link tooltip. 

Note: You can repeat steps 3-10 to link to additional package files or web pages from the 

same frame or click  to close the Frame Link Properties toolpane. 

 

Note: At step 4, you can also click  Create new web page to create a new web page and 
link to it in one step. When creating a new web page, you first specify the name of the web 

page and the Library folder in which it should be saved. The Web Page Editor then opens a tab 
where you can create the new web page. After completing the web page, you can return to 
the topic by reactivating the Topic Editor tab. 
 

To link to a URL from a topic frame: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a URL. 
  

2. Display the Frame Link toolpane, if necessary. 
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3. In the empty row in the Frame Link toolpane, click the Name field to activate it. 

  

4. Click  Create link. 

  

5. In the Link to pane, select  URL. 
  

6. In the Address field, type or paste the target URL. 
  
If a Base URL was set, you can enter a relative URL beginning with ../. 
  

7. Click  Go or press ENTER. 

  
While selecting a URL, you can also enter a base URL and then follow links in the 
preview displayed in the results pane to reach your desired target. 
  

8. Click OK or press ENTER. 

  
9. An icon is added to the link by default. If desired, change the link icon. 

  
10. The word "Link" is added as the default tooltip. If desired, change the link tooltip. 

Note: You can repeat steps 3-10 to link to additional URLs from the same frame or click  to 

close the Frame Link Properties toolpane. 
 

To create and link a new package from a topic frame: 

1. Display the Frame Link toolpane, if necessary. 

  
2. In the empty row in the Frame Link toolpane, click the Name field to activate it. 

  

3. Click  to launch the Package Wizard and click Next. 
  

4. Browse to and choose the files/folders that you want to add to the package and click 

Next. 
  

5. Type a name for the new package and browse to a location in the Library where you 
want it saved (if you do not want to save it in the default location). 
  

6. Click Next. 
  

7. Choose a file in the package that is to be launched from the frame. Navigate through 
any folders contained in the new package, if appropriate. 
  

8. Click Next to finish. 

6.11.2.1 Link to an Attachment from Bubble Text 

As you enter custom text in bubbles and Introduction/End frames, you can link to an 
attachment from this text. For example, you could use a web page linked at this level to 

provide a definition of a term. Linked text appears in the frame bubble in color and underlined. 
When a user clicks linked text while viewing a topic in the Player, the attachment is displayed. 
If the attachment is a package file, the file opens in its parent application. If the attachment is 
a web page or URL, it opens in a new, independent browser window.  
 
Note: When a glossary term is used in a manually created bubble text link, no glossary link is 
created during glossary markup. That is, text used in manually created bubble text links is 

excluded from glossary markup. 
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Use the Bubble Text Link Properties dialog box to link to and manage the links to attachments 
from bubble text. When linking to a package file or web page, you can filter the display to 

include packages or web pages only and navigate through the Library folders to the specific 
file you want to link. When linking to a URL, you can type or paste a base URL and then follow 

links in the preview pane to reach your desired target. A preview of the linked attachment 
appears in the Bubble Text Link Properties dialog box. 
 
Note: An absolute URL represents the fixed location of a piece of content without regards to 
its context. A Relative URL is a shortened version of the full URL that only makes sense when 
used in context. The full URL is constructed by taking a Base URL (set in the General Content 
Defaults) and appending the Relative UR set when creating a hyperlink). Here is an analogy to 

help clarify. Let's say you asked me where my brother lives and I said "right next to my 
house". If you didn't know where I lived, this information would not be useful. However, if you 
did know where I lived, then you could find my brother's house by locating my house and then 
find his next door. In this case, my house is an example of the Base URL and "right next to my 
house" is an example of the Relative URL. 
 

Relative URLs are useful when the content developer is not sure of the location where the 

content is to be deployed. They allow the content developer to link to content outside of the 
Library in the Developer. 
 
The Base URL can be set in the Developer and can be changed, if necessary, in the Player 
Package after publication. 
 

Note: If a Base URL is set in the General Content Defaults, you can enter a Relative URL 
(beginning with../) when inserting a hyperlink for a URL on the Insert Hyperlink dialog box. 
 
Like concept and frame links, a link to an attachment from bubble text becomes part of the 
parent document. If you then move or reuse the topic, the linked attachment remains 
associated with that text in the topic. Conversely, deleting the link to an attachment from 
bubble text in one location removes the link in all places where the topic is used. 

 

To link to a package file or web page from bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a package file or web page. 
  

2. Select the bubble text to be linked. 
  

3. In the Frame Properties toolpane, click  Bubble text link. 

  

4. Click  Create link. 

  

5. In the Link to pane, select  Document in Library. 

  
If desired, you can select Packages or Web pages in the Type field to further filter 

your selection. 
  

6. Navigate the Library to the folder containing the package file or web page to which 

you want to link. 
  

7. Select the desired package file or web page document. 
  

8. Click OK or press ENTER. 

Note: you can also click  Create new web page to create a web page and link to it in one 

step. When creating a new web page, you first specify the name of the web page and the 
Library folder in which it should be saved. The Web Page Editor then opens a tab where you 
can create the new web page. After completing the web page, you can preview its contents in 



Use the Topic Editor 

 

 190 

the topic by reactivating the Topic Editor tab, selecting the appropriate bubble text, and again 

displaying the Bubble Text Link Properties dialog box as in step 3 above. 

 

To link to a URL from bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a URL. 
  

2. Select the bubble text to be linked. 
  

3. In the Frame Properties toolpane, click  Bubble text link. 

  

4. Click  Create link. 

  

5. In the Link to pane, select  URL. 

  
6. In the Address field, type or paste the target URL. 

  
If a Base URL was set, you can enter a relative URL beginning with ../. 
  

7. Click  Go or press ENTER. 
  

While selecting a URL, you can also enter a base URL and then follow links in the 
preview displayed in the results pane to reach your desired target. 
  

8. Click OK or press ENTER. 

To create and link a new package from bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a new package file. 
  

2. Select the bubble text to be linked. 
  

3. In the Frame Properties toolpane, click  Bubble text link to display the Bubble 

Link Text Properties dialog box. 
  

4. Click  to launch the Package Wizard and click Next. 

  
5. Browse to and choose the files/folders that you want to add to the package and click 

Next. 
  

6. Type a name for the new package and browse to a location in the Library where you 
want it saved (if you do not want to save it in the default location). 

  
7. Click Next. 

  
8. Choose a file in the package that is to be launched when the bubble text is clicked. 

Navigate through any folders contained in the new package, if appropriate. 
  

9. Click Next to finish. 

6.11.2.2 Change the Tooltip of a Frame Link 

When you link to attachments at the frame level, you can provide tooltips for the links. These 
tooltips appear when a user rests the mouse pointer over the link icon while viewing the topic 
in the Player. By default, the word "Link" is added as the tooltip when the link is created; 
however, you can change the link tooltip at any time. For example, you might want to use a 
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tooltip that identifies the attachment contents, to provide users with information about the 
attachment before they launch it. 

 
If you plan to deploy content to one or more Player outputs, use of tooltips is particularly 

important, especially for links to package files. For example, if a link launches a Flash 
animation that is several megabytes in size, you might use a tooltip such as "Flash animation 
of business process (4.65 MB)" to alert users before they click the link. Without such tooltips, 
users do not have a good indication of the type of content they are launching or its purpose. 
 
Tip: Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most 
useful. 

 

To change the tooltip of a frame link: 

1. Display the Frame Link toolpane, if necessary. 

  
2. Select the row listing the link for which you want to change the tooltip. 

  
3. In the Tooltip field, delete the current text and type the desired tooltip. 

6.11.2.3 Change the Icon of a Frame Link 

When you create a link to an attachment from a topic frame, an icon is added to the link by 
default; however, you can change the link icon at any time. This icon appears in the frame 

bubble when a user views the topic in the Player, indicating that additional information is 
available. Users can then click the icon to launch the linked material. By standardizing your 
use of link icons, you can provide your users with a consistent visual cue as to the type of 
information available through each link. You can also add a tooltip for each link to provide a 
brief text description of the linked attachment. 
 
The Developer comes with a standard set of link icons. You can also create your own custom 

icons, if desired. 
 

To change the icon of a frame link: 

1. Display the Frame Link toolpane, if necessary. 

  
2. Select the row listing the link to which you want to change the icon. 

  
3. In the icon column, click the down arrow to display the list of available icons. 

  
4. Select the desired icon. 

6.12 Use the Frame Comments Toolpane 
The Frame Comments toolpane contains three multi-line text fields for entering comments 

about the frame:  

 Author Notes - Enter comments about the frame in this field. Comments added to a 
frame when recording content also appear in this field. These notes appear in the Test 
Results publishing style. 
   

 Instructor Notes - Enter instructor note; for example, the steps necessary to get the 

expected result or additional information an instructor should provide to students in 
class. When you preview or publish an Instructor Manual, this text appears in italic 
text in the Action column in the Step/Action table, before the frame text. 
   

 Expected Test Results - Enter the expected result of the action of this frame. These 
comments display after the bubble text during Test It! playback and also in the Test 
Results publishing style.  



Use the Topic Editor 

 

 192 

Note: When a topic opens within Record It! mode, the Frame Comments toolpane opens in 

the horizontal view with the Author Notes field expanded and the Expected Test Results and 

Instructor Notes fields collapsed below it. When a topic opens from the Topic Editor, the Frame 
Comments toolpane is displayed vertically on the right side. 
  

To enter Author Notes, Expected Results or Instructor Notes for the current frame: 

1. Display the Frame Comments toolpane, if necessary. 

  
2. Select the field in which you want to enter text. 

  
3. Enter the comment text. 
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7 Use Test It! mode 
Test It! is a special playback mode designed to allow testers to run manual test scripts against 
a live application. A modified version of Do It! mode guides the tester through the steps of the 

test case. Testers can mark steps as passed or failed, add their own comments, and generate 
bug reports. 

7.1 Launch Test It! mode 
Test It! mode for a topic can be launched from a published Player package like other playback 
modes. When you include the Test It! player, a Test It! play mode button appears for all 
topics. 

  
You can also launch Test It! from kp.html. Within the folder where you published the content, 
there is a file called kp.html. When you open this file in your browser, it contains the outline 
structure and provides a list of all the outline items. Next to the topics are links, including one 
for the topic and one for Test It! mode. 

  
Note: Test It! mode playback does not support jump-in points 

 

To launch Test It! from kp.html: 

1. In Windows Explorer, navigate to the location of the published content. 

  
2. Open the folder containing the published content. 

  
3. Open the kp.html file in your browser. 

  
4. Scroll as necessary to locate the desired topic. 

  

5. Click the Topic link next to the topic name to launch the topic in a window, and then 
click Test It!. 

  
or 
  
Click the Test It! link next to the topic name to launch directly into Test It! mode. 

7.2 Play Test It! mode 
In Test It! mode, you are guided through a task while you perform it in the live application. 
This unique mode makes it possible for you to test the steps of an application. In addition, you 

can enter comments, mark steps passed or failed, and create a bug report with the steps to 
recreate the problem.  
  
When a topic is played in Test It! mode, the Test It! window opens on top of the target 
application. A frame appears before the Introduction frame for the topic. This frame contains 
the estimated time for the test and any setup instructions that should be done before starting 

the test. When you advance past this first frame and the Introduction frame of the topic, the 
top section of the window includes the instructions for completing the step. The Expected 
Results section appears below the instructions and displays any text that the test author 
entered about what should happen. 
  
You can mark each step as passed, failed, or skipped. Restarting Test It! mode clears the step 
markings as well as the history of the steps. The following options appear at the bottom of the 

window: 

  Go to previous frame: Returns to the previous frame. If you mark a step passed, 
failed, or skipped, this mark is not reset if you move to the previous step. 
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  Mark this step as passed: Mark the step as passed and moves to the next step. 

  

  This step passed: Indicates that the step passed. 

  

  Mark this step as failed: Mark the step as failed and moves to the next step. 

  

  This step failed: Indicates that the step failed. 

  

  Skip this step: Skips the frame without marking it either pass or fail. If the step 

has already been marked as passed or failed, it does not change the mark. 
  

  This step was skipped: Indicates that the step was skipped. 

  

  Add notes to this step: Opens the Test Step Notes window in which you can enter 

comments about the step. 
  
Note: After you save a note and close the Test Step Note window, if you go back to 
the previous step and reopen the Test Step Note window, the note that you previously 
added appears with the option to edit it. 

  

  Opens steps to recreate web page: Opens the Steps to recreate window in which 
the steps up to and including this step appear. These steps can then easily be copied 

and pasted into a bug report. Only steps marked passed or failed appear in the web 
page. 
  

  Go to Results summary: Skips to the Results summary page without having to 

click through to the end of the Test It! mode. Remaining unrecorded steps are left 
blank in the report and the test case is marked as failed. This option is useful when 
the application you are recording crashes. 

Note: Decision and Explanation frames cannot be marked pass or fail. For frames which have 

alternative actions or paths, only the action that you execute can be marked. You can test 
alternative actions or paths by moving back to the previous step and choosing a different 
path. 
  
The bottom section of the Test It! window displays a graphic that illustrates how the screen 
should appear in the live application for the step. On the graphic, a marquee surrounds the 
area in which you should perform the action in the live application. You can drag the graphic 

to reposition it within the Test It! window, if necessary. You can also drag the lower right 
corner of the Test It! window to resize it and display more of the graphic or you can use the 
Show/Hide Graphic button to toggle the display of the graphic in the Test It! window. You can 

also move the Test It! window to another area of the screen by dragging the title bar to the 
desired location on the screen. 
  
The last frame in the playback is the Result summary page. It displays the total number of 

steps that were passed, failed, and skipped; the total number of steps in the test; and the 
overall test result (passed or failed). It also contains a link to view a full test case report. This 
report is a modified version of the Test Document publishing style. It has a title page with the 
purpose of the test, the test history, the time for the test, and the test setup. The detailed 
part of the report contains columns with the action, the expected results, the test step notes, 
and the results (pass or fail). 

  
Control the topic playback using the following Actions link that appears in the bubble: 
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 Show next alternative action: Display other ways to perform the current step. This 

link appears only when other ways to perform the current step are defined in the 

authoring process. 
   

 Next Step: Advance to the next step. 

   

 Previous Step: Return to the previous step. 
   

 Restart Playback: Return to the first step in the topic and restart the task. 

   

 Display Concept: Display the conceptual information for the task. This link appears 

only if conceptual task information exists. 
   

 Attachments: Display individual links that launch additional information related to the 
current screen. This link appears only if additional information exists for the current 

screen. 
   

 Play: Display links to launch the topic in See It! or Try It! mode or print the topic with 
Print It! mode (if Print It! mode is enabled). After viewing the step in See It! or Try It! 
mode, you can continue in that mode or press ESC to return to Do It! mode. 

   

 Preferences: Display the current preference settings for the Player. If this link does 
not appear, your administrator has preset all of the preferences and has prevented 
them from being changed. 

   

 Help: Display the Player help. 
   

 View Outline: This link only appears if the topic was launched in a context-sensitive 

manner from a target or web-based application. Close the topic and return to the 
outline in the Player. 
   

 Log Out: Log out of the Player. This action appears only if the content you are 

viewing is tracked via the Knowledge Center. 
   

 Close Topic: Close the topic in current play mode and return to the topic launch 
point. 

 To play a topic in Test It! mode:  

1. Start the target application. 
   

2. Launch Test It! mode for the topic you want to test.  
   

3. Click Next Step to start, if necessary. 
   

4. Perform the currently displayed step as indicated. 

   
5. Mark the step pass, fail, or skip. 

   
6. Click Next Step. 

   
7. Repeat to complete all steps for the task. 

   
8. Click the View detailed report link, if desired. 

  
Note: You can print this report to an XPS file. If you do, and some of the icons do not 
appear in the file, open the Page Setup dialog box for printing in your browser and 
select the option to print background colors and images. 
   

9. Click Close to finish. 
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7.3 Test It! mode in Knowledge Center 
You can publish the Player to Knowledge Center with Test It! mode included. When you launch 
the Player through Knowledge Center, you can play Test It! mode. All of the play modes, 
including Test It! are tracked, and the results are included in the Test It! Summary report. 
   
When a Player with Test It! mode is published to or imported into Knowledge Center, [Test] is 
appended to the title. This is to differentiate it from a regular Player for learning purposes. 
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8 Work with Attachments 
In an outline, module and section documents supply the headings for organizing the content, 
and topics supply the recorded steps and sounds (if applicable) for completing each task.  

 
You can supplement your content with additional conceptual and explanatory information by 
linking to attachments from the documents in the outlines. Attachments can include files 
developed in external applications, custom web pages with descriptive text and graphics, and 
Internet and intranet web sites.  
 

Types of Attachments 

There are three types of attachments to which you can link documents in an outline. They 
include: 

 Package files 

  

 Web pages 

  

 URLs 

Packages are containers in your Library that hold one or more files. Any type of file can be 
stored in a package, including word processing documents, graphics, computer animations, 

and so on. You can link from any document in your outlines to any individual file in a package. 
The package file appears in the Concept pane or is launched in its native application when a 
user selects the link in the Player. 
 
Note: The precise appearance and behavior of package files depends on the setup and 
Windows Explorer settings of the computer on which they are viewed. 

 
Web pages are documents that you create in the Developer for displaying additional text and 

graphics in the Player or document output. You can create a simple web page to define a term 
or a more complex one that includes graphics and links to other web pages, package files, 
sound and external URLs. 
 
You can also link from your content to an Internet or intranet web site through its URL 

address. The web site appears in the Concept pane of the Player or is launched in a new 
browser window when a user clicks the link, provided that the user is online and has access to 
the target site. 
 

Link Attachments 

You can link from your content to an attachment at the following three levels: 

 The concept of a module, section, topic, or assessment 
  

 A frame of a topic 

  

 Bubble text in a topic frame, including Introduction and End frames 

An attachment linked as the concept of a module, section, topic, or assessment, appears in 
the Concept pane when the user selects the document to which it is linked from the table of 
contents in the Player. 
 
Note: Some types of package files might launch in their native applications rather than 

appearing in the Concept pane. 
 
When a frame of a topic is linked to an attachment, an icon representing the attachment 
appears in the bubble in Try It! mode or in the window in Do It! mode for that frame. The user 
can point to the icon to read a tooltip describing the attachment and click the icon to open the 
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attachment. Bubble text linked to an attachment appears in the frame as a hyperlink. Users 

can click the hyperlinked text in the Try It! bubble or Do It! window to view the attachment. 

An attachment linked at the frame or bubble text level always opens in a new window. 
 
Note: Attachments linked to frames or bubble text are not available in the See It! or Know It? 
Play modes. 
 

Attachments are automatically included in some document outputs, namely, the System 
Process Document, Instructor Manual, and Training Guide. However, the actual outcome 
depends on the type of attachment and the level at which it is linked. In general, package 
graphics, web pages, and the addresses of URLs linked at the concept and frame levels appear 
in document outputs; all other types of package files and the contents of URL link targets do 
not. See Package Behavior in Publishing, Web Page Behavior in Publishing, and URL Behavior 
in Publishing for more detail. 

 
Note: The Job Aid, Test Results, Test Document, and Test Case document outputs do not 
include attachments. You can include attachments in the Job Aid, Test Document, and Test 

Case by customizing the print template for those document formats. See Customize Document 
Formats in the Publish Content chapter for more information about customizing the print 
template. 
 

You can link to attachments while working in the Outline Editor (concepts only) or Topic Editor. 
 
Once you have created a link from a document to an attachment, the link essentially becomes 
part of the parent document. As a result, you do not need to re-create or repair these links 
every time you move or reuse the parent document in your outlines. Links are also maintained 
if you move or copy the parent document in the Library. 

8.1 Attachment Considerations 
One question you must consider when using attachments is the type of attachment you want 
to use in each case. The three general types of attachments you can use, namely, package 
files, web pages, and URLs, have different characteristics that affect which might be more 

appropriate in a given situation. The following discussion provides a comparison of several 
aspects of the different types of attachments and a summary of their relative capabilities.  
 

Purpose/Complexity 

A primary consideration is the purpose of the attachment and the level of complexity of the 
information it must convey. For example, if an attachment provides the definition of a term, a 
simple, text-only web page is probably the easiest, most straightforward option. Web pages 
are also appropriate for presenting more complex arrangements of text and graphics, as well 
as for providing access to a collection of different resources from a single location through 

hyperlinks. 
 
Packages allow great flexibility, because they can contain essentially any type of file. Thus, 
packages are the preferred option for information that is best presented in its native format, 
such as tabular data contained in an Excel spreadsheet or a multimedia presentation. 
 

Finally, URL links can be used to send users directly to an Internet or intranet site or to 
provide such Internet-based functionality as email contact. 
 

Attachment Location 

Another consideration is the location in which the attachment is saved, specifically, whether it 
is included in the Library or not. Both packages and web pages are saved as Library 

documents, whereas Internet or intranet sites linked as URL attachments are external to the 
Library. This difference can be important when you publish to Player outputs. In particular, 
packages and web pages are incorporated directly in your output during publishing, whereas 
URL attachments are always accessed from their external locations, which might be updated 
or removed over time. As a result, users might find a URL attachment to be missing or 
unavailable if, for example, the Internet address of a URL link target is changed after you 
create the link in your content. 
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Note that, for package and web page attachments, location within the Library is not important. 
That is, you can link from any module, section, or topic document to any package file or web 

page stored anywhere in the Library; the package/web page and the parent document do not 
need to be in the same folder. This provides great flexibility in how you organize your Library, 

while also allowing you to reuse your package files and web pages by linking to each one as 
many times as needed throughout your content. 
 

User System Setup and Connectivity 

When you publish to Player outputs, the setup and connectivity of your users' computer 
systems also impact your choice of attachments, especially for packages and URLs. 
 

For packages, you should avoid any file types that your users are unlikely to be able to view 
directly. For example, if you link to a flowchart saved as a package file in native Microsoft Visio 
format but your users have neither Microsoft Visio nor the Microsoft Visio Viewer installed on 
their computers, they are unable to access the flowchart. A more effective approach to using 
the same flowchart as a package file would be to export it from Microsoft Visio in a more 
common format, such as a standard graphics format, for which your users are more likely to 
have an appropriate application. In addition to the application itself, you should also consider 

the version supported in your users' workplace, to ensure that it is compatible with the version 
in which you create the file(s). 
 

Note: The precise appearance and behavior of package files depends on the user's computer 
operating system, its settings, and the settings for the Web browser on that system. 
 

For URL attachments, the primary considerations involve connectivity, as with any other use of 
Internet or intranet sites. In particular, your users must be online when viewing your content 

to access linked URLs, and their connection speed should be sufficient for the contents of the 
target sites. They should also have any necessary plug-ins installed. Finally, if you plan to link 
to any limited-access or otherwise restricted Internet or intranet sites, you should ensure that 
your users have appropriate permissions or user accounts to access these sites. 
 

In contrast to package files and URLs, web page attachments present minimal system issues. 
Because they are constructed in standard HTML and because they are incorporated in your 

published output, you can consider web pages as a reliable choice for attachments if you are 

uncertain of your users' setups. 
 

File Creation and Maintenance 

You create and maintain web pages entirely within the Developer using the Web Page Editor. 
Whenever you make and save changes to a web page, the changes are immediately reflected 
throughout your content wherever the web page is linked. 
 

You also create and maintain packages in the Developer. Packages provide the advantage of 
allowing you to incorporate a variety of documents, in a variety of formats, into the Library. 
You can copy documents into a package from an external location and then edit them directly 
from the package. 
 

Finally, you create and maintain URLs entirely outside the Library. This allows you to use 
preexisting Internet and intranet content, as well as functionality such as email, but also 
requires that the content be maintained separately. For example, you must ensure that the 

URL address of the link target does not change, in which case the site would no longer be 
accessible from your content. In addition, when a target site is updated, you should ensure 
that it remains relevant as a link from your content. Relative URLs can be used to help 
minimize URL link maintenance. 
 

Player Outputs 

In general, users can access all attachment types in all Player outputs. See User System Setup 

and Connectivity above for certain limitations. 
 

For each frame link, web page hyperlink, or bubble text link, users access the attachment by 
clicking on the link icon or hyperlinked text, respectively; the attachment always launches in a 
new, independent window. For each concept link, the attachment generally appears directly in 
the Concept pane of the Player. 
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You should especially consider the behavior of concept attachments in relation to package 

files, such as external documents and multimedia files, which you might not want to launch 

directly in the Concept pane. For example, you might prefer that a large graphic or detailed 
spreadsheet appear in its own window, rather than in the limited region of the Player's 
Concept pane. Alternatively, your users might prefer that a Flash animation play only when 
they specifically click on a link to activate it, rather than having it launch automatically in the 
Player when they select the document to which it is linked as the concept. In such cases, a 

better alternative is to use a concept link to a web page that, in turn, contains some 
explanatory text and a hyperlink to the desired package file. This approach provides greater 
control over how and when package files used as concepts are displayed. 
 

Document Outputs 

Only three types of document outputs ever include linked attachments: the System Process 

Document, Training Guide, and Instructor Manual. For these three document formats, the 
behavior differs depending on the type of attachment and the level at which it is linked. 

 Web pages that are directly linked at the concept and frame levels are included in 

document outputs. 
  

 Package files that are graphics appear in document outputs, whether they are directly 

linked at the concept and frame levels or inserted in web pages. All other types of 
package files are excluded from document outputs. 
  

 The addresses of URL attachments linked at the concept and frame levels are included 

in document outputs, in the format "Please refer to:" followed by the address. When 
text in a web page or bubble text links to a URL attachment, the address of the link 
target is included in parentheses after the link text. 

Therefore, if you wish to include an attachment in your document outputs, use a web page or 
a package graphic. 
 

Summary 

The following information summarizes various factors that you should consider in determining 
which type of attachment best meets your needs in a particular situation: 

 Package file 
  
Advantages: 

Flexible, allows use of virtually any type of file 
Saved in Library so incorporated directly in published Player outputs 
Graphic files included in document outputs when linked at the concept and frame 
levels or inserted as images in web pages 
  
Disadvantages: 
User setup/access issues for Player outputs, depending on file type 

Excluded from document outputs if anything other than a graphic 
For concept links, consider launching from a hyperlink in a web page, rather than 

linking directly 
  

 Web page 

  
Advantages: 
Saved in Library so incorporated directly in published Player outputs 
Always compatible with users' systems because created in standard HTML 
Can include links to other attachments 
Included in document outputs when linked at the concept and frame levels 

   
Disadvantages: 
No scripting 
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 URL 

  

Advantages: 
Can use existing, independently maintained content 
Can use email, ftp, and other URL-based links 
Address included in document outputs when linked at the concept, frame, and bubble 
text levels 
Can use Relative URLs 

  
Disadvantages: 
Users must be online to access (also consider speed of connection) 
Users must have appropriate permissions for access 
Site (URL address and content) must be maintained separately from Library content 
Decreases the occurrence of broken links because the URL is constructed from an 
established Base URL with the Relative URL added. 

8.2 Link Attachments 
To supplement the basic structure and step-by-step procedures provided by your module, 

section, and topic documents, or provide instructions for taking an assessment, you link from 
these documents to attachments. Attachments can be package files, web pages, or URLs. 
 
You can link from your outlines to an attachment at the following three levels: 

 The concept of a module, section, topic, or assessment 
  

 A frame of a topic 
  

 Bubble text in a topic frame, including Introduction and End frames 

You can link to attachments while working in the Outline Editor (concepts only) or Topic Editor. 

 

Once you have created a link from a document to an attachment, the link essentially becomes 
part of the parent document. As a result, you do not need to re-create or repair these links 
every time you move or reuse the parent document in your outlines. Links are also maintained 
if you move or copy the parent document in the Library. 
 
The procedure for linking to an attachment at a given level is the same, regardless of the type 

of attachment. When you link to an attachment from a topic frame, you also select an icon 
that appears during topic playback in the Player to alert the user to the presence of a link and 
provide access to the linked information. You can also assign a tooltip to the link, for example, 
to provide a brief description of the linked attachment. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the parent document. After 
you save any changes, you should check in the parent document to make it available 

to other authors and add the changes to the Developer's version control system. 
  

You do not need to check out the attachment, only the parent document. In addition, 
you can link to an attachment even if it is checked out to another user. 
  
When you are working offline, you can link to an attachment only if it is available in 
your local cache. Therefore, if you plan to work offline, you should ensure that you 
have a local copy of any attachment to which you want to link. To do this, you can 
either check out or get the attachment(s), depending on whether you plan to edit 

them or to have access to read-only copies. If you go offline and do not have copies of 
some attachments in your local cache, those attachments are unavailable to you as 
you work offline. To remedy this, you need to go back online and get the documents 
that you need. 
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8.2.1 Link an Attachment as a Concept: Outline Editor 

You can use the Player View in the Outline Editor to link a package file, web page, or URL as 

the concept of a module, section, topic, or assessment document. The linked attachment then 
appears in the Concept pane of the Outline Editor, resembling the display in the Player 
window. To assist in the maintenance of concept links in the Developer, the linked attachment 
is also identified at the top of the pane. If the attachment is a package file or web page, the 
file name and location in the Library are shown; if the attachment is a URL, its absolute path is 
shown instead. For module and section documents, the concept expands to fill the entire right 

side of the Developer window, whereas for topic documents, both the concept and the 
introduction frame appear. If the size of the linked attachment is greater than the size of the 
concept pane, scroll bars allow you to view all areas of the concept. 
 
Note: Depending on your computer system setup and browser settings, some types of 
package documents might not appear in the Concept pane. 
 

The Concept pane in the Outline Editor provides the tools for linking to and managing the links 
to concept attachments. When linking to a package file or web page, you can filter the display 

to include packages or web pages only and navigate through the Library folders to the specific 
file you want to link. When linking to a URL, you can type or paste a base URL in the Address 
field and then follow links in the preview displayed in the Insert Hyperlink dialog box to reach 
your desired target. 
  

Note: In the Outline Editor, a drop-down list appears at the top of the Properties toolpane that 
lets you switch between viewing Document and Concept properties. You can use the Concept 
view to assign or change a property of an attachment without opening the attachment in its 
editor. For example, you can use the Concept view to assign a style sheet to the web page 
that is linked as a concept to the selected document in the outline. 
 

The link to the concept of a parent document is saved with the document. Therefore, the 
concept link is maintained when the parent document is copied or moved to another outline. 
Conversely, deleting the link to an attachment from a parent document in one outline removes 
the link in all outlines where the parent document is used. The concept link to an attachment 

is also maintained when you copy or move a parent document in the Library or Outline Editor. 
 
If a linked web page contains sound, controls for sound playback display in the Concept pane. 

 
Note: You can control the display of linked content using the Preview category in Options (on 
the Tools menu). By default, linked content automatically appears in the Concept pane when 
you select a document in the outline. However, you can turn this off for all documents or 
selectively turn off the display by document type. If you turn off the display of linked content, 

you can click  Preview Document for any document in the outline to display the linked 

content. 
 
Note: From the Concept pane in the Outline Editor, you can also create a new web page and 

link to it in one step or create a new package and link a package file in one step. After 
completing the web page or package, you can preview its contents directly in the Concept 
pane of the Outline Editor. 

 

To link a package file or web page as a concept from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 

  
2. Select the document from which you want to create a link. 

  

3. In the Concept pane, click  Create link. 

  

4. In the Link to pane, select  Document in Library. 

  
If desired, you can select Packages or Web pages in the Type field to further filter 
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your selection. 
  

5. Navigate the Library to the folder containing the package file or web page to which 
you want to link. 

  
6. Select the desired package file or web page document. 

  
7. Click OK or press ENTER. 

To link a URL as a concept from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 

  
2. Select the document from which you want to create a link. 

  

3. In the Concept pane, click  Create link. 

  

4. In the Link to pane, select  URL. 

  
5. In the Address field, type or paste the target URL. 

  
If a Base URL was set, you can enter a relative URL beginning with ../. 
  

6. Click  Go or press ENTER. 
  
While selecting a URL, you can also enter a base URL and then follow links in the 

preview displayed in the results pane to reach your desired target. 
  

7. Click OK or press ENTER. 

To create and link a web page as a concept from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 
  

2. Select the document in the outline from which you want to create a link. 
  

3. In the Concept pane, click  Create New Web Page. 

  
4. Type a name for the web page and browse to a location in the Library where you want 

it saved (if you do not want to save the package using the default name and location) 
and click Save. 
   
The web page opens in the Web Page Editor. 

   

5. Edit the web page to include the content that you want. 
  

6. Save and close the web page. 
  
The web page appears in the Concept pane for the document to which it is linked. 

To create and link a new package as a concept from the Outline Editor: 

1. With an outline open in the Outline Editor, display the Player View. 

  
2. Select a document in the outline from which you want to create a link. 
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3. Click  to launch the Package Wizard and click Next. 

  

4. Add items to the package and click Next. 

  
5. Type a name for the new package and browse to a location in the Library where you 

want it saved (if you do not want to save the package using the default name and 
location). 
  

6. Click Next. 
  

7. Choose a file in the package that is to be launched in the Concept pane. Navigate 
through any folders contained in the new package, if appropriate. 
  

8. Click Next to finish. 

8.2.2 Link an Attachment as a Concept: Topic Editor 

You can manage the concept of a topic directly from the Topic Editor. This allows greater 
efficiency in editing topics and their concepts and also provides a clearer representation of the 
overall organization of the topic. You can perform the same concept-related tasks from the 
Topic Editor as are available from the Outline Editor. The Concept toolpane also provides a 
preview of the linked concept attachment. 

 

To link an existing package file or web page as a concept from the Topic Editor: 

1. Display the Concept toolpane, if necessary. 

  

2. Click  Create link. 
  

3. In the Link to pane, select  Document in Library. 

  
If desired, you can select Packages or Web pages in the Type field to further filter 

your selection. 
  

4. Navigate the Library to the folder containing the package file or web page to which 
you want to link. 
  

5. Select the desired package file or web page document. 

  
6. Click OK or press ENTER. 

Note: At step 2, you can also click  Create new web page to create a new web page and 
link to it in one step. When you do so, you first specify the name of the web page and the 
Library folder in which it should be saved. The Concept toolpane then closes, and an empty 

web page opens in a new tab. After you complete the web page, you can preview its contents 

in the topic by reactivating the Topic Editor tab. 
 

To link a URL as a concept from the Topic Editor: 

1. Display the Concept toolpane, if necessary. 

  

2. Click  Create link. 

  

3. In the Link to pane, select  URL. 

  
4. In the Address field, type or paste the target URL. 

  



  Work with Attachments 

   205 

If a Base URL was set, you can enter a relative URL beginning with ../. 
  

5. Click  Go or press ENTER. 

  
While selecting a URL, you can also enter a base URL and then follow links in the 
preview displayed in the results pane to reach your desired target. 
  

6. Click OK or press ENTER. 

To create and link a new package as a concept from the Topic Editor: 

1. Display the Concept toolpane, if necessary. 

  

2. Click  to launch the Package Wizard and click Next. 

  
3. Browse to and choose the files/folders that you want to add to the package and click 

Next. 

  
4. Type a name for the new package and browse to a location in the Library where you 

want it saved (if you do not want to save it in the default location). 
  

5. Click Next. 
  

6. Choose a file in the package that is to be launched in the Concept pane. Navigate 
through any folders contained in the new package, if appropriate. 
  

7. Click Next to finish. 

8.2.3 Link to an Attachment from a Topic Frame 

Within a topic, you can link from any frame to one or more attachments. Attachments linked 
at this level provide information to your users as they view a topic. For example, you might 

link from a frame to a spreadsheet listing department codes or other reference information 
that users need at a particular step in a procedure. Like concept and bubble text links, links to 
attachments from topic frames become part of the parent document. If you then move the 

topic or reuse it elsewhere in your content, the linked attachment remains associated with that 
frame of the topic. Conversely, deleting the link to an attachment from a topic frame in one 
location removes the link in all places where the topic is used. 
 
The Frame Link toolpane of the Topic Editor provides the tools for linking to and managing the 
links to attachments from topic frames. When linking to a package file or web page, you can 
filter the display to include packages or web pages only and navigate through the Library 

folders to the specific file you want to link. When linking to a URL, you can type or paste a 
base URL and then follow links in the preview displayed in the results pane of the Insert 
Hyperlink dialog box to reach your desired target. 
 
Note: An absolute URL represents the fixed location of a piece of content without regards to 

its context. A Relative URL is a shortened version of the full URL that only makes sense when 
used in context. The full URL is constructed by taking a Base URL (set in the General Content 

Defaults) and appending the Relative UR set when creating a hyperlink). Here is an analogy to 
help clarify. Let's say you asked me where my brother lives and I said "right next to my 
house". If you didn't know where I lived, this information would not be useful. However, if you 
did know where I lived, then you could find my brother's house by locating my house and then 
find his next door. In this case, my house is an example of the Base URL and "right next to my 
house" is an example of the Relative URL. 

 
Relative URLs are useful when the content developer is not sure of the location where the 
content is to be deployed. They allow the content developer to link to content outside of the 
Library in the Developer. 
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The Base URL can be set in the Developer and can be changed, if necessary, in the Player 

Package after publication. 

 
Note: If a Base URL is set in the General Content Defaults, you can enter a Relative URL 
(beginning with../) when inserting a hyperlink for a URL on the Insert Hyperlink dialog box. 
 
The procedure for linking to an attachment from a topic frame differs slightly from that for 

concepts and bubble text. When you link to an attachment from a topic frame, you can select 
an icon for the link and add a tooltip. The icon appears in the frame bubble when the user 
views the topic in the Player, and the tooltip appears when the user rests the mouse pointer 
over the link icon. The icon and tooltip are stored with the link itself, rather than with the 
attachment. Therefore, when you link to the attachment from another location in your content, 
you can choose to add a different icon and/or tooltip, if desired. 
 

A single frame can link to multiple attachments. You manage all of the attachments linked at 
the frame level from the same dialog box, but you can assign a different icon and/or tooltip to 
each of the links. You can also change the order in which multiple attachments are linked to a 

single topic frame. As you navigate among the frames in a topic with the Frame Link toolpane 
open, the display updates dynamically to show the links for each frame. This provides a simple 
means of managing all frame links in a topic and analyzing the overall topic layout. 
  

To link to an existing package file or web page from a topic frame:  

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 
link to a package file or web page. 

   
2. Display the Frame Link toolpane, if necessary. 

   
3. In the empty row in the Frame Link toolpane, click the Name field to activate it. 

   

4. Click  Create link. 

   

5. In the Link to pane, select  Document in Library. 

  
If desired, you can select Packages or Web pages in the Type field to further filter 
your selection. 
   

6. Navigate the Library to the folder containing the package file or web page to which 
you want to link. 
   

7. Select the desired package file or web page document. 
   

8. Click OK or press ENTER. 
   

9. An icon is added to the link by default. If desired, change the link icon. 
   

10. The word "Link" is added as the default tooltip. If desired, change the link tooltip. 

Note: You can repeat steps 3-10 to link to additional package files or web pages from the 

same frame or click  to close the Frame Link Properties toolpane. 

 

Note: At step 4, you can also click  Create new web page to create a new web page and 

link to it in one step. When creating a new web page, you first specify the name of the web 
page and the Library folder in which it should be saved. The Web Page Editor then opens a tab 
where you can create the new web page. After completing the web page, you can return to 
the topic by reactivating the Topic Editor tab. 
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To link to a URL from a topic frame: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a URL. 
  

2. Display the Frame Link toolpane, if necessary. 
  

3. In the empty row in the Frame Link toolpane, click the Name field to activate it. 

  

4. Click  Create link. 
  

5. In the Link to pane, select  URL. 
  

6. In the Address field, type or paste the target URL. 
  

If a Base URL was set, you can enter a relative URL beginning with ../. 
  

7. Click  Go or press ENTER. 

  
While selecting a URL, you can also enter a base URL and then follow links in the 
preview displayed in the results pane to reach your desired target. 
  

8. Click OK or press ENTER. 

  
9. An icon is added to the link by default. If desired, change the link icon. 

  
10. The word "Link" is added as the default tooltip. If desired, change the link tooltip. 

Note: You can repeat steps 3-10 to link to additional URLs from the same frame or click  to 

close the Frame Link Properties toolpane. 

 

To create and link a new package from a topic frame: 

1. Display the Frame Link toolpane, if necessary. 

  
2. In the empty row in the Frame Link toolpane, click the Name field to activate it. 

  

3. Click  to launch the Package Wizard and click Next. 

  
4. Browse to and choose the files/folders that you want to add to the package and click 

Next. 

  
5. Type a name for the new package and browse to a location in the Library where you 

want it saved (if you do not want to save it in the default location). 
  

6. Click Next. 
  

7. Choose a file in the package that is to be launched from the frame. Navigate through 
any folders contained in the new package, if appropriate. 
  

8. Click Next to finish. 

8.2.4 Link to an Attachment from Bubble Text 

As you enter custom text in bubbles and Introduction/End frames, you can link to an 
attachment from this text. For example, you could use a web page linked at this level to 
provide a definition of a term. Linked text appears in the frame bubble in color and underlined. 
When a user clicks linked text while viewing a topic in the Player, the attachment is displayed. 
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If the attachment is a package file, the file opens in its parent application. If the attachment is 

a web page or URL, it opens in a new, independent browser window.  

 
Note: When a glossary term is used in a manually created bubble text link, no glossary link is 
created during glossary markup. That is, text used in manually created bubble text links is 
excluded from glossary markup. 
 

Use the Bubble Text Link Properties dialog box to link to and manage the links to attachments 
from bubble text. When linking to a package file or web page, you can filter the display to 
include packages or web pages only and navigate through the Library folders to the specific 
file you want to link. When linking to a URL, you can type or paste a base URL and then follow 
links in the preview pane to reach your desired target. A preview of the linked attachment 
appears in the Bubble Text Link Properties dialog box. 
 

Note: An absolute URL represents the fixed location of a piece of content without regards to 
its context. A Relative URL is a shortened version of the full URL that only makes sense when 
used in context. The full URL is constructed by taking a Base URL (set in the General Content 

Defaults) and appending the Relative UR set when creating a hyperlink). Here is an analogy to 
help clarify. Let's say you asked me where my brother lives and I said "right next to my 
house". If you didn't know where I lived, this information would not be useful. However, if you 
did know where I lived, then you could find my brother's house by locating my house and then 

find his next door. In this case, my house is an example of the Base URL and "right next to my 
house" is an example of the Relative URL. 
 
Relative URLs are useful when the content developer is not sure of the location where the 
content is to be deployed. They allow the content developer to link to content outside of the 
Library in the Developer. 

 
The Base URL can be set in the Developer and can be changed, if necessary, in the Player 
Package after publication. 
 
Note: If a Base URL is set in the General Content Defaults, you can enter a Relative URL 
(beginning with../) when inserting a hyperlink for a URL on the Insert Hyperlink dialog box. 

 

Like concept and frame links, a link to an attachment from bubble text becomes part of the 
parent document. If you then move or reuse the topic, the linked attachment remains 
associated with that text in the topic. Conversely, deleting the link to an attachment from 
bubble text in one location removes the link in all places where the topic is used. 
 

To link to a package file or web page from bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a package file or web page. 
  

2. Select the bubble text to be linked. 

  

3. In the Frame Properties toolpane, click  Bubble text link. 

  

4. Click  Create link. 
  

5. In the Link to pane, select  Document in Library. 
  
If desired, you can select Packages or Web pages in the Type field to further filter 

your selection. 
  

6. Navigate the Library to the folder containing the package file or web page to which 
you want to link. 
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7. Select the desired package file or web page document. 
  

8. Click OK or press ENTER. 

Note: you can also click  Create new web page to create a web page and link to it in one 

step. When creating a new web page, you first specify the name of the web page and the 
Library folder in which it should be saved. The Web Page Editor then opens a tab where you 
can create the new web page. After completing the web page, you can preview its contents in 
the topic by reactivating the Topic Editor tab, selecting the appropriate bubble text, and again 
displaying the Bubble Text Link Properties dialog box as in step 3 above. 

 

To link to a URL from bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

link to a URL. 
  

2. Select the bubble text to be linked. 

  

3. In the Frame Properties toolpane, click  Bubble text link. 

  

4. Click  Create link. 

  

5. In the Link to pane, select  URL. 

  
6. In the Address field, type or paste the target URL. 

  
If a Base URL was set, you can enter a relative URL beginning with ../. 
  

7. Click  Go or press ENTER. 

  

While selecting a URL, you can also enter a base URL and then follow links in the 

preview displayed in the results pane to reach your desired target. 
  

8. Click OK or press ENTER. 

To create and link a new package from bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 
link to a new package file. 

  
2. Select the bubble text to be linked. 

  

3. In the Frame Properties toolpane, click  Bubble text link to display the Bubble 

Link Text Properties dialog box. 

  

4. Click  to launch the Package Wizard and click Next. 

  
5. Browse to and choose the files/folders that you want to add to the package and click 

Next. 
  

6. Type a name for the new package and browse to a location in the Library where you 

want it saved (if you do not want to save it in the default location). 
  

7. Click Next. 
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8. Choose a file in the package that is to be launched when the bubble text is clicked. 

Navigate through any folders contained in the new package, if appropriate. 

  
9. Click Next to finish. 

8.2.5 Change the ToolTip of a Frame Link 

When you link to attachments at the frame level, you can provide tooltips for the links. These 
tooltips appear when a user rests the mouse pointer over the link icon while viewing the topic 
in the Player. By default, the word "Link" is added as the tooltip when the link is created; 
however, you can change the link tooltip at any time. For example, you might want to use a 
tooltip that identifies the attachment contents, to provide users with information about the 
attachment before they launch it. 
 

If you plan to deploy content to one or more Player outputs, use of tooltips is particularly 
important, especially for links to package files. For example, if a link launches a Flash 
animation that is several megabytes in size, you might use a tooltip such as "Flash animation 
of business process (4.65 MB)" to alert users before they click the link. Without such tooltips, 

users do not have a good indication of the type of content they are launching or its purpose. 
 

Tip: Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most 

useful. 
 

To change the tooltip of a frame link: 

1. Display the Frame Link toolpane, if necessary. 

  
2. Select the row listing the link for which you want to change the tooltip. 

  
3. In the Tooltip field, delete the current text and type the desired tooltip. 

8.2.6 Change the Icon of a Frame Link 

When you create a link to an attachment from a topic frame, an icon is added to the link by 
default; however, you can change the link icon at any time. This icon appears in the frame 
bubble when a user views the topic in the Player, indicating that additional information is 
available. Users can then click the icon to launch the linked material. By standardizing your 
use of link icons, you can provide your users with a consistent visual cue as to the type of 

information available through each link. You can also add a tooltip for each link to provide a 
brief text description of the linked attachment. 
 

The Developer comes with a standard set of link icons. You can also create your own custom 
icons, if desired. 
 

To change the icon of a frame link: 

1. Display the Frame Link toolpane, if necessary. 

  

2. Select the row listing the link to which you want to change the icon. 
  

3. In the icon column, click the down arrow to display the list of available icons. 

  
4. Select the desired icon. 

8.2.7 Manage Linked Attachments 

After you create links from your content to attachments, you might need to change the 
properties of one or more of the links. For example, you might choose to link from a particular 
document to a different attachment or to not link from that document to any attachment at 
all. If the link is from a topic frame, you might also choose to change the link icon or tooltip or 
to change the order of multiple attachments linked to the same frame.  
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You can perform any of these actions using the same controls as you used to create the initial 
links. Specifically, the Concept pane in the Outline Editor and the Concept Properties dialog 

box provide the tools for managing the links to concept attachments. The Frame Link 
Properties toolpane in the Topic Editor provides the tools for managing the links to frame 

attachments. Finally, the Bubble Text Link Properties dialog box provides the tools for 
managing the links from bubble text. 

8.2.7.1 Change a Link Target 

Once you have created a link from your content to an attachment, you might need to change 
the target of the link. You do not need to delete the link to the current attachment first; you 

can simply redirect the link to the new target.  
 

To change the attachment linked as a concept from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 

  
2. Select the document for which you want to change the linked concept attachment. 

  

3. In the Concept pane, click  Create link. 

  

4. On the Link to pane, select the type of link target as  Document in Library or 

 URL. 

  
5. Depending on your selection in the preceding step, navigate to the target document or 

file or type or paste the target URL in the Address field. 
  
When selecting a URL, you can also enter a base URL and then follow links in the 
preview displayed in the results pane to reach your desired target. 
  

6. Click OK or press ENTER. 

To change the attachment linked as a concept from the Topic Editor: 

1. Display the Concept toolpane, if necessary. 

  

2. Click  Create link. 

  

3. On the Link to pane, select the type of link target as  Document in Library or 

 URL. 

  
4. Depending on your selection in the preceding step, navigate to the target document or 

file or type or paste the target URL in the Address field. 
  
When selecting a URL, you can also enter a base URL and then follow links in the 

preview displayed in the results pane to reach your desired target. 
  

5. Click OK or press ENTER. 

To change an attachment linked at the frame level: 

1. With the topic open in the Topic Editor, navigate to the frame for which you want to 
change a linked attachment. 
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2. Display the Frame Link toolpane, if necessary. 

  

3. In the list of linked attachments, select the row of the linked attachment to be 
changed. 
  

4. Click  Create link. 

  

5. On the Link to pane, select the type of link target as  Document in Library or 

 URL. 

  
6. Depending on your selection in the preceding step, navigate to the target document or 

file or type or paste the target URL in the Address field. 
  
When selecting a URL, you can also enter a base URL and then follow links in the 

preview displayed in the results pane to reach your desired target. 

  
7. Click OK or press ENTER. 

  

8. Click  to close the Frame Link Properties toolpane. 

To change an attachment linked to bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame containing the bubble 
text for which you want to change the linked attachment. 

  

2. In the Frame Properties toolpane, click  Bubble text link. 

  

3. Click  Create link. 

  

4. On the Link to pane, select the type of link target as  Document in Library or 

 URL. 

  
5. Depending on your selection in the preceding step, navigate to the target document or 

file or type or paste the target URL in the Address field. 
  

When selecting a URL, you can also enter a base URL and then follow links in the 
preview displayed in the results pane to reach your desired target. 
  

6. Click OK or press ENTER. 

8.2.7.2 Edit a Linked Package File 

If you need to edit a package file that is linked to your content, you can access the package 
that contains the file directly from the parent document to which it is linked. This saves you 

the step of having to navigate through the Library to locate the package and open it directly. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 

any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. You need to check out 
only the package, not the parent document to which the package file is linked. 
  
If the package is not checked out, you are prompted to check it out before proceeding. 
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Click Yes to continue and edit the package. Click No to cancel the process and return 
to your starting point; the package does not open in read-only mode. 

To edit a package file linked as a concept from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 

  
2. Select the document for which you want to edit the linked concept package file. 

  

3. In the Concept toolpane, click  Edit package. 

  
The package containing the linked file opens in a new tab for editing. 
  

4. Double-click the file to open it in its native application, and edit the file as necessary. 

  
5. Save the file and close the application. 

  

6. Save and close the package. 
  
In the Outline Editor, the Concept pane refreshes, showing the changes to the concept 
package file. 

To edit a package file linked as a concept from the Topic Editor: 

1. With the topic open in the Topic Editor, on the View menu, point to Panes and choose 

Concept, if necessary. 
  

2. Click  Edit package. 

  
When you do so, the Concept Properties dialog box closes, and the main Developer 
window becomes the active window, displaying the package containing the linked file 

in a new tab for editing. 
  

3. Double-click the file to open it in its native application, and edit the file as necessary. 
  

4. Save the file and close the application. 
  

5. Save and close the package. 
  
You can preview the changes from the topic by reactivating the Topic Editor window 
and again displaying the Concept Properties dialog box as in step 2 above. 

To edit a package file linked at the frame level: 

1. With the topic open in the Topic Editor, navigate to the frame for which you want to 

edit the linked package file. 
  

2. On the View menu, point to Panes and choose  Frame Link, if necessary. 

  
3. In the list of linked attachments, select the row of the package file to be edited. 

  

4. Click  Edit package. 

  
When you do so, the main Developer window becomes the active window, displaying 
the package containing the linked file in a new tab for editing. 
  

5. Double-click the file to open it in its native application, and edit the file as necessary. 
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6. Save the file and close the application. 

  
7. Save and close the package. 

To edit a package file linked to bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame containing the bubble 
text for which you want to edit the linked package file. 

  

2. In the Frame Properties toolpane, click  Bubble text link. 
  

3. Click  Edit package. 
  

When you do so, the Bubble Text Link Properties dialog box closes, and the main 
Developer window becomes the active window, displaying the package containing the 
linked file in a new tab for editing. 

  
4. Double-click the file to open it in its native application, and edit the file as necessary. 

  
5. Save the file and close the application. 

  
6. Save and close the package. 

  
You can preview the changes from the topic by reactivating the Topic Editor window, 
selecting the appropriate bubble text, and again displaying the Bubble Text Link 
Properties dialog box as in step 3 above. 

8.2.7.3 Edit a Linked Web Page 

If you need to edit a web page that is linked to your content, you can access the web page for 
editing directly from the parent document to which it is linked. This saves you the step of 
having to navigate through the Library to locate the web page and open it directly. 

 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. You need to check out 
only the web page, not the parent document to which it is linked. 
  
If the web page is not checked out, you are prompted to check it out before 

proceeding. Click Yes to continue and edit the web page. Click No to cancel the 
process and return to your starting point; the web page does not open in read-only 
mode. 

To edit a web page linked as a concept from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 

  
2. Select the document for which you want to edit the linked concept web page. 

  

3. In the Concept toolpane, click  Edit web page. 

  
The web page opens in a new tab for editing. 
  

4. Edit the web page as necessary. 
  

5. Save and close the web page. 

  



  Work with Attachments 

   215 

In the Outline Editor, the Concept pane refreshes, showing the changes to the concept 
web page. 

To edit a web page linked as a concept from the Topic Editor: 

1. With the topic open in the Topic Editor, display the Concept toolpane, if necessary. 

  

2. Click  Edit web page. 

  
When you do so, the Concept Properties dialog box closes, and the main Developer 
window becomes the active window, displaying the web page in a new tab for editing. 
  

3. Edit the web page as necessary. 
  

4. Save and close the web page. 
  
You can preview the changes from the topic by reactivating the Topic Editor window 
and again displaying the Concept Properties dialog box as in step 2 above. 

To edit a web page linked at the frame level: 

1. With the topic open in the Topic Editor, navigate to the frame for which you want to 

edit the linked web page. 
  

2. Display the Frame Link toolpane, if necessary. 
  

3. In the list of linked attachments, select the row of the web page to be edited. 
  

4. Click  Edit web page. 
  
When you do so, the main Developer window becomes the active window, displaying 

the web page in a new tab for editing. 
  

5. Edit the web page as necessary. 
  

6. Save and close the web page. 

To edit a web page linked to bubble text: 

1. With the topic open in the Topic Editor, navigate to the frame containing the bubble 

text for which you want to edit the linked web page. 
  

2. In the Frame Properties toolpane, click  Bubble text link. 

  

3. Click  Edit web page. 

  
When you do so, the Bubble Text Link Properties dialog box closes, and the main 
Developer window becomes the active window, displaying the web page in a new tab 
for editing. 
  

4. Edit the web page as necessary. 
  

5. Save and close the web page. 
  
You can preview the changes from the topic by reactivating the Topic Editor window, 
selecting the appropriate bubble text, and again displaying the Bubble Text Link 
Properties dialog box as in step 3 above. 
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8.2.7.4 Delete an Attachment Link 

You can delete the link to an attachment from a document, topic frame, or bubble text at any 

time. For example, you might decide that an attachment linked at the fourth frame of a topic 
should be linked at the sixth frame instead. In this case, you cannot just change the link 
target; you need to completely remove the link from the fourth frame. When you delete the 
link to an attachment, you are not deleting it; you are simply removing the link. The 

attachment is still in the Library and available for use. 
 
You can delete links to attachments from the Outline Editor (concepts only) or from the Topic 
Editor (topic concepts and frame and bubble text links). 
 

To delete the link to a concept attachment from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 

  
2. Select the document from which you want to delete the attachment link. 

  

3. In the Concept toolpane, click  Delete link. 

To delete the link to a concept attachment from the Topic Editor: 

1. With the topic open in the Topic Editor, display the Concept toolpane, if necessary. 

  

2. Click  Delete link. 

  
3. Click OK. 

To delete the link to a frame attachment: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

delete the link to an attachment. 
  

2. Display the Frame Link toolpane, if necessary. 
  

3. In the list of attached documents, select the row of the attachment link to be deleted. 
  

4. Click  Delete link. 

  

5. Click  to close the Frame Link toolpane. 

To delete the link to a bubble text attachment: 

1. With the topic open in the Topic Editor, navigate to the frame from which you want to 

delete the link to a bubble text attachment. 
  

2. In the Frame Properties toolpane, select the underlined bubble text with the hyperlink 

that you want to remove and click  Bubble text link. 

  

3. Click  Delete link. 

  
4. Click OK. 

8.2.7.5 Change the Icon of a Frame Link 

When you create a link to an attachment from a topic frame, an icon is added to the link by 
default; however, you can change the link icon at any time. This icon appears in the frame 

bubble when a user views the topic in the Player, indicating that additional information is 
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available. Users can then click the icon to launch the linked material. By standardizing your 
use of link icons, you can provide your users with a consistent visual cue as to the type of 

information available through each link. You can also add a tooltip for each link to provide a 
brief text description of the linked attachment. 

 
The Developer comes with a standard set of link icons. You can also create your own custom 
icons, if desired. 
 

To change the icon of a frame link: 

1. Display the Frame Link toolpane, if necessary. 

  
2. Select the row listing the link to which you want to change the icon. 

  
3. In the icon column, click the down arrow to display the list of available icons. 

  
4. Select the desired icon. 

8.2.7.6 Change the ToolTip of a Frame Link 

When you link to attachments at the frame level, you can provide tooltips for the links. These 
tooltips appear when a user rests the mouse pointer over the link icon while viewing the topic 
in the Player. By default, the word "Link" is added as the tooltip when the link is created; 
however, you can change the link tooltip at any time. For example, you might want to use a 

tooltip that identifies the attachment contents, to provide users with information about the 
attachment before they launch it. 
 
If you plan to deploy content to one or more Player outputs, use of tooltips is particularly 
important, especially for links to package files. For example, if a link launches a Flash 
animation that is several megabytes in size, you might use a tooltip such as "Flash animation 
of business process (4.65 MB)" to alert users before they click the link. Without such tooltips, 

users do not have a good indication of the type of content they are launching or its purpose. 
 

Tip: Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most 
useful. 
 

To change the tooltip of a frame link: 

1. Display the Frame Link toolpane, if necessary. 

  
2. Select the row listing the link for which you want to change the tooltip. 

  
3. In the Tooltip field, delete the current text and type the desired tooltip. 

8.2.7.7 Change the Order of Multiple Frame Links 

More than one web page can be linked to a topic frame. By default, the attachments appear in 
the order in which they were linked. However, you can easily change the order of the linked 

attachments.  
 

To change the order of multiple frame links: 

1. Open the topic in the Topic Editor. 

  
2. Navigate to the frame for which you want to change the link order. 

  
3. Display the Frame Link toolpane, if necessary. 

  
4. In the list of linked attachments, select the row of an attachment whose order you 

want to change. 
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5. Use the  Move Up and  Move Down arrows to move the attachment to the 

desired position in the list. 

  

6. Repeat steps 4 and 5 as needed to obtain the desired order of linked attachments. 
  

7. Click  to close the Frame Link toolpane. 

8.2.8 Create a Custom Icon 

In addition to using the standard icons, you can create your own custom icons. You might 
want to create a custom icon that is consistent with those used in existing documentation, for 
example, or one that is based on your company logo. You can also make a new icon by 
starting with an existing icon, editing it as necessary, and saving it with a new name.  
 
To be used as a custom icon, a graphic file must satisfy the following constraints: 

 It must be 22 pixels x 22 pixels in size 

  

 It must be saved in .png, .jpg, or .gif format 

  

 It must be saved in a package in the Library folder System/Icons/Custom 

An empty Custom folder is present in your Library by default, even if your content does not 
currently include custom icons. 
 
Note: The color depth for icons is unrestricted, although 8- or 16-bit color is typically 
sufficient. 

 
When you change the icon of a frame link, you see a preview of each icon file saved in the 
folders System/Icons/Standard and System/Icons/Custom. You cannot browse to any other 
Library location to select an icon saved elsewhere. Also, if any file saved in a package in either 
of these folders does not satisfy the requirements for use as an icon (22 pixels x 22 pixels; 

.png, .jpg, or .gif format), you are not able to select it as an icon. In this case, you must edit 

the file in the package in order to use it as an icon. 
 
You can simplify icon management by taking the following approach: 

 Save only one icon per package 
  

 Use the same name for the package and the icon file it contains 

  

 Ensure that only valid icon files, contained in packages, are saved in the Library 
folders System/Icons/Standard and System/Icons/Custom 

 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To create a custom icon: 

1. In your image editing software, create a graphic appropriate for use as a link icon. You 

can also make a new icon by starting with an existing icon and editing it as necessary. 
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An icon graphic must be 22 pixels x 22 pixels and must be of .png, .jpg, or .gif format. 
  

2. Create a new package. 
  

3. Add the image file to the package. 
  

4. Save the package in the folder System/Icons/Custom. 

Tip: To simplify icon management, use the same name for the custom icon file and the 
package in which it is saved. 
 
Warning! No size or format validation is performed when you add a custom icon to the 
Library. Therefore, you should verify that the file satisfies the requirements for use as an icon 
before adding it to the Library. 
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9 Enhance Content with Web Pages 
A web page is an HTML page that can contain text, audio, images, and hyperlinks to other 
content. You can enhance your content by creating web pages and linking to them from any 
module, section, or topic document as a concept or from any frame in a topic as explanatory 
information. In a web page, you can create flexible arrangements of text, sound, images, and 
hyperlinks using the Developer's Web Page Editor. Web pages can be displayed online and as 

printable documentation. In addition, the web pages that you create in the Developer are 
saved in the Library, so they are incorporated directly in your published output, thus 
minimizing the possibility of broken links, access problems, or other browser issues.  
 
When you link to a web page as the concept of a module, section, topic, or assessment, users 
can access the web page from the Concept pane in the Player. When you link to a web page 
from a frame in a topic, an icon representing the link appears in the bubble in Try It! mode or 

in the bubble and/or window in Do It! mode. If the web page is linked to the Introduction 
frame of a topic, its icon appears in the Introduction pane of the Player. In each case, a user 

can click the icon to view the contents of the web page. 
 
In addition, you can link to web pages from bubble text in a topic frame or from text or 
graphics in another web page. Users can view the linked web pages by clicking the hyperlinked 

text or graphic appearing when they view the content in the Player. 
 
You can also add sound to a web page and link the web page to a module, section, topic, or 
assessment, and have the sound play back through the Concept pane. See Add Sound on a 
Web Page for details. 
 
Web pages linked at the concept and frame levels are also included in selected document 

outputs, namely, the System Process Document, Training Guide, and Instructor Manual. Web 
pages linked to assessments appear in the Training Guide and Instructor Manual. See Web 
Page Behavior in Publishing for more detail. 
 

To use a web page in the Developer, you must complete two basic steps. First, you create the 
web page, and then you link it to the appropriate module, section, topic, or frame. Once you 
have created a web page in a Library, you can use it multiple times by linking to it from each 

location in your outlines where you want the users to be able to access it. 
 
Note: Web pages linked to frames or bubble text are not available in See It! or Know It? 
modes in the Player. 

9.1 Web Page Editor 
The Web Page Editor allows you to create HTML pages that include formatted text, graphics, 

and sound, as well as hyperlinks to other documents, images, or web sites. The content you 
create in the editor looks similar to what the user sees after the document is published.  
  
You can use any web page that you create in the Developer and link it to a module, section, or 

topic document as conceptual or introductory material, to an assessment to provide directions 
on how to answer questions, or to any topic frame as supplemental transactional information.  
  

Note: Content created outside of the Developer must be linked as a package. 
 
The Web Page Editor provides a full range of formatting capabilities such as: 

 Text formatting including bold, italics, underline, and font selection 
  

 Paragraph alignment including left, right, centered, and justified 

  

 Tables 
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 Bulleted and numbered lists 

   

 Graphics support 
  

 Hyperlinks to other documents, web pages, web sites 

  

 Sound recording and editing 

When editing an HTML page stored inside a package, additional capabilities are available, such 
as:   

 Fields 
  

 Buttons and checkboxes 
   

 View the source HTML 

You can use the Outline and Topic Editors to link a web page to documents in the outline or 
individual frames in a topic. 

9.2 Create a New Web Page 
You can create a web page from the Library toolbar or File menu available in the Library or 
any other document editor. When you create a new web page or open an existing web page, 

the Web Page Editor launches in a new tab and displays an empty web page (or the selected 
web page) where you can add and format text, insert or edit sound, insert images and 
hyperlinks, and so on. You can save the web page to any folder in the Library and then link to 
it from one or more documents anywhere in the Library.  
 
If you save a web page to the wrong folder in the Library, you can always move the document 
to another folder. You can also rename a web page saved in the Library at any time without 

breaking any links from your content to the web page unless the web page is in a package. 

You should not, however, rename a web page saved in a package, for this breaks the link from 
your content to the web page. 
 
Note: The Web Page Editor does not support split views. In a split view, a tab appears for the 
web page in each pane, with the contents of the web page displayed in the active pane and a 
Click here to make this Web Page Editor active link appearing in the other. Clicking the link 

switches the active display of the web page to the other pane. 
 

 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 

want to make a new document available to multiple authors and place the document 
under the Developer's version control system, you must check it in. 
  

See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To create a new web page: 

1. On the File menu, point to  New and choose  Web Page. 

  
or 
  

On the Library toolbar, choose  Web Page.  
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2. Edit the web page to include the content that you want. 

  

You can create new content directly using the Web Page Editor or copy and paste 
material from other sources, such as word processing documents and Internet sites. 
Note that the Web Page Editor may not support all features and formatting copied 
from the source. 
  

3. Save the new web page. 
  
You can also close the tab and click Yes in response to the Save Document message. 
  
When you save a web page for the first time, you are prompted to name it. Enter a 
name for the web page by typing over the default name. Although the web page name 
does not have to be unique, it is recommended that you provide a meaningful name so 
you can easily find the web page later. 

To create and link a web page as a concept from the Outline Editor: 

1. With the outline open in the Outline Editor, display the Player View. 

  
2. Select the document in the outline from which you want to create a link. 

  

3. In the Concept pane, click  Create New Web Page. 
  

4. Type a name for the web page and browse to a location in the Library where you want 
it saved (if you do not want to save the package using the default name and location) 
and click Save. 
  
The web page opens in the Web Page Editor. 
  

5. Edit the web page to include the content that you want. 

  

6. Save and close the web page. 
  
The web page appears in the Concept pane for the document to which it is linked. 

Note: Web pages are not saved automatically, so you should save your work periodically as 
you add content.  

9.3 Rename and Delete a Web Page 
You can delete or rename a web page from the Library, just as you would any other document 
type. 

  
Deleting a web page that is linked to your content creates broken links. Therefore, if you plan 
to delete a web page, you should first remove any links to it from your content. 
 

Tip: You can use the Broken Links tool to identify any broken links in your content that result 
from deleting a web page. 

  
If you rename a web page (that is not in a package) to which you have linked from other 
documents, topic frames, or bubble text, the links remain unaffected. That is, renaming a 
linked web page does not break any links in your content. Renaming a web page in a package 
break links from your content to the web page. 
 
Note: You can delete or rename a web page only from the Library. 
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 Multi-user Considerations 

 Documents under version control must be checked in and you must be working online 

to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 
  
Deleted documents that are used in any outline continue to appear in the outline as 
broken links. You can either remove these links from the outline or restore the deleted 
documents as long as the administrator has not purged them. New documents that 
have never been checked in cannot be restored. 

9.4 Edit a Web Page 
You can open a web page at any time in the Web Page Editor to modify its contents. For each 
web page that you open to edit, an instance of the Web Page Editor opens in a separate tab, 
allowing you to display multiple web pages at one time. 
 

Note: A web page may reference external documents, such as a style sheet document or 
external images from packages located in the Library. If these external documents are 
changed while you are editing the web page, the changes are not reflected on the web page 

until it is saved. You can refresh the web page to show external changes using the F5 key or 
Refresh on the View menu. 
  
Tips: You can undo any changes (saved or unsaved) you make in a web page by selecting 
Undo from the Edit menu while the web page is open. When you save and close the web page, 
you can no longer undo those changes. 

  

 Multi-user Considerations 

 Before you can edit a web page, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. 

To edit a web page: 

1. Open the web page in the Web Page Editor. 

  
You can open a web page for editing from the Library, Outline Editor (Concept pane), 
or Topic Editor (Concept, Frame Link, and Hyperlink Properties toolpanes). 

  
2. Edit text, hyperlinks, sound and/or images as desired. 

  
3. Save and close the web page. 

9.4.1 Paste Content into a Web Page 

You can copy content in a web page and paste it within the web page or to another web page 
using the Developer's copy and paste tools on the Standard toolbar. The Web Page Editor - 
Insert toolbar has two tools for pasting content copied from sources outside of the Developer: 

 Paste as Text - pastes formatted text into a web page as plain text, removing the 
formatting. 

   

 Paste from Word - pastes content copied from Microsoft Word, preserving the 
formatting.    

You can then modify the pasted content using the formatting controls available in the Web 
Page Editor.  
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Tip: Always save your web page after pasting content from other applications and before 

applying Web Page Editor formatting. Because saving a web page removes any unsupported 

formatting, this allows you to see a valid starting point for the pasted content and ensures 
that any subsequent formatting you apply is preserved. 
 

The following are some points to consider when pasting content into your web pages. 
 

Text 

 Fonts that are not supported are converted to the default font style and size. 

Images 

 Images from Internet or intranet sites can be copied using copy and paste or drag-

and-drop. In both cases, you can choose to embed or link the image. If you embed the 
image, the image becomes part of the web page document. The result is exactly the 
same as for an image inserted from your computer. 

  

 In contrast, a linked image is updated whenever the source file changes. However, if 

the source file is moved, deleted, or renamed, the link is broken, and a "file not 

available" indicator  replaces the image on the web page. The linked URL option is 
preferable for images that are maintained on an Internet or intranet site, especially if 
they are updated frequently. You must be sure, however, to use exactly the same file 
name and path within the site structure each time you change the source image for 

the link to be maintained. 
  

 Images from other documents can be copied using copy and paste or CTRL+drag-and-
drop. These images are always embedded; that is, they are treated exactly the same 

as images inserted using the Images on My Computer option. 
  

 Inserted images can be duplicated or moved within a web page using copy/paste or 

cut/paste, respectively. The pasted image retains all of the properties (alternative 
text, size, and border) of the original. 

To paste content copied from Microsoft Word to a web page: 

1. Select the location in the web page to paste the content copied from Microsoft Word. 

   

2. Click  Paste from Word. 

To paste formatted content as plain text to a web page: 

1. Select the location in the web page to paste the formatted content. 

  

2. Click  Paste as Text. 

Note: Since cut, copy and paste functionality access your clipboard, some browsers block 
these functions when accessed from the toolbar or context menu. In these cases, you can use 
the following keyboard shortcuts; Ctrl+X (Cut), Ctrl+C (Copy), Ctrl+V (Paste).  

9.4.2 Find and Replace Text in a Web Page 

The Find and Replace command on the Edit menu searches and replaces text on a Library-
wide basis. The Web Page Editor has two tools, Find in this Web Page and Replace in this Web 
Page that allow you to locate and replace text in the current web page only. 
 

Note: To replace formatting, see Replace Fonts and Styles under Use Content Tools in the 
Build an Outline chapter. 
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Since Find and Replace have similar functions, they are contained on two tabs in the same 
dialog box. They both have these fields: 

 Find what: A text field where you enter the word or phrase that you want to find. 
   

 Match case: Check this option to limit the search operation to words whose case 
matches the spelling (uppercase and lowercase letters) entered in the Find What field. 
This means that the search becomes case-sensitive. For example, when Match case is 
checked and the search term is: "option", you find all instances of "option" with this 

exact spelling but not when the word is spelled "Option" or "OPTION". 
   

 Match whole word: Check this option to find entire words only. For example, when 
Match whole word is selected and the search term is "condition", you find all instances 
of "condition", but not the words "conditional" or "conditions". 

   

 Match cyclic: Check this option to continue the search from the beginning of the 
document after the end of the document is reached. 

The Find tab also contains the following field:   

 Find: Starts the search. 

The Replace tab also contains the following fields: 

 Replace with: A text field where you enter the word or phrase that replaces the 
found text or phrase. 

   

 Replace: Replaces the text in the Find What field with the word or phrase from the 
Replace With field. 
   

 Replace All: Replaces all instances of the text in the Find What field with the word or 
phrase in the Replace With field. 
  

Note: Any text that is replaced can be undone using  Undo on the Standard toolbar. 

To find text: 

1. From the Web Page Editor - Tools toolbar, choose  Find in this Web Page. 
  

2. Type the text you want to find in the Find what field. 

  
3. Select the desired Find Options. 

  
4. Click Find. 

  
The first occurrence of the text is highlighted. If the text cannot be found, a message 
box opens informing you that the text was not found in the selected content. Click OK 

to close the message box. 
  

5. Click Find as needed to search for additional occurrences of the text. 
  

6. When you are done finding text, click Close. 

To find and replace text: 

1. From the Web Page Editor - Tools toolbar, choose  Replace in this Web Page. 
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2. Type the text you want to find in the Find what field. 

  

3. Type the replacement text in the Replace with field. 
  

4. Select the desired Find Options. 
  

5. Click Replace. 

  
The first occurrence of the text is highlighted. If the text cannot be found, a message 
box opens informing you that the text was not found in the selected content. Click OK 
to close the message box. 
  

6. Click Replace to replace the first occurrence with the replacement text. 
  

7. Click Replace as needed to replace the next occurrence of the text. 
  
or 

  
Click Replace All to replace all occurrences with the replacement text. 
  

8. When you are done replacing text, click Close. 

9.4.3 Insert Special Characters 

On occasion, it may be necessary to insert characters into your content that are not on the 
standard keyboard. The Select Special Character dialog box provides a variety of symbols 

including Latin letters, fractions, currency symbols, punctuation, arrows, and mathematical 
operators. 
   

 To insert special characters: 

1. On the Web Page Editor - Insert toolbar, click  Insert Special Character. 

  

2. Click the special character to be inserted. 
  
The character is inserted into the document at the cursor location. 
  
Note: Click Cancel to return to the web page without inserting a character. 

9.5 Format Text 
As you type in the Web Page Editor, the text reflects the default formatting. You can use the 
toolbar icons and controls above the main window to change the formatting for text, lines and 
images. This type of formatting is called direct formatting, to differentiate it from formatting 

that comes from style sheets. See the Use Styles to Format Content chapter for more 
information on style sheets. 
  

You can use either content defaults or style sheets to preset some of the text formatting 
defaults. If you choose to use content defaults, the formatting of web page text results from 
the web page default settings in the Options dialog box, direct formatting that you apply to 

web page elements, and defaults inherited from your browser. If you choose to use style 
sheets, web page formatting is controlled by the default and non-default styles that you 
create, defaults inherited from your browser, and direct formatting that you apply. 
  
Note: You can apply a default style sheet or set content defaults in the Web Page category in 
the Options dialog box. Any changes to content defaults only affect new web pages you create 
after the change. However, you can link a style sheet to existing web pages so updates to the 

style sheet update all documents linked to that style sheet. 
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To format text in a web page: 

1. Position the cursor at the location on the web page where you want to add text. 

   
2. Type the text. 

  
3. Select the text you want to format and use the appropriate toolbar options. 

  

Note: You can also select some formatting attributes before you type the text. Other 
attributes apply to existing text only. 

9.5.1 Set Character Format 

You can apply formatting to individual words or characters using these options: 
 

 Bold: Bolds the selected text. 
 

 Italic: Italicizes the selected text. 
 

 Underline: Underlines the selected text. If the selected text includes multiple words, the 

space between the words is also underlined. 
 

 Strikethrough: Applies strikethrough to the selected text. If the selected text includes 

multiple words, the space between the words is also struck through. 
 

 Subscript: Applies formatting that is smaller and set below the baseline of the 

surrounding text. 
 

 Superscript: Applies formatting that is smaller and set above the baseline of the 
surrounding text. 

9.5.2 Set Text Font 

A font can be applied to any piece of text from a single letter, a word, a sentence, a paragraph 
or an entire web page. You control the fonts with the following options: 

 Font Family: A font family is a set of fonts with similar characteristics, grouped 
together. It may include different font sizes, styles (roman and italic), and weight 
(regular and bold). A browser can only apply fonts that exist on the local system. The 
browser searches the prioritized list of font families looking for the first available 

installed font. 
  
The Font Family list contains predefined font families followed by all system fonts 
installed on the local computer. If you know the font is available on the machines 
where the content is viewed, simply select it from the list; for example, if your 
organization has Arial installed, by default, on all machines. In situations where you 
are not sure what fonts are installed, you can select a font family. This helps ensure 

the content displays in the proper font. 
   

 Font Size: Sets the font size of the selected text. You can enter a numeric value or 
choose from the list of predefined font sizes (7, 8, 9, 10, 11, 12, 14, 16, 18, 20, 24, 

32, 36, 48, 72) or font size keywords; xx-small, x-small, small, medium, large, x-
large, xx-large. The Inherit option allows the font size to be inherited from the style. 
  
Note: The size of keywords is based on font sizes that are scaled to approximately 1.2 
of the medium size as interpreted by the browser. Also note that the keyword sizes for 
fonts in a document (print) output are not identical to the browser sizes. Microsoft 
Word uses a slightly different interpretation when scaling keywords. 

   

 Font Unit: Unit (points or pixels) associated with the value in the Font size field. The 
default unit is points. 
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Note: If you are using a style sheet, you can create separate looks for online and print 

deployments by adding print styles. A print style is a component of a style, but can contain 

different font and formatting settings that are used only when previewing or publishing a 
document output. See Add Print and Language Variations under Create Styles in the Create 
Styles to Format Content chapter for more information about creating print styles. 

9.5.3 Set Text Color 

You can control the color of the text and text background using these options: 

  Text Color: Used to change the color of selected text or any new text. 

  

  Text Background Color: Used to change the background color of the selected 
text or any new text. 

Each tool uses the standard Color dialog box for selecting colors. See Select a Color in the 
Web Page Defaults section of the Get Started using the Developer chapter for more 

information on the Color dialog box. 

9.5.4 Remove Formatting 

Formatting applied to text, such as bold, italic, font size, color, can be stripped out with the 

Clear Formatting tool. All formatting is removed from the selected text and the text is 
displayed in the default font and style. 
  
Note: If you are applying styles to content that uses direct formatting or legacy content 
(content created in an earlier version of the Developer), you may first need to use Clear 
Formatting to remove the formatting for the existing text. 
   

To remove formatting from text: 

1. Select the formatted text. 

  

2. Click  Clear Formatting. 

9.6 Format a Paragraph 
The Web Page Editor supports both paragraph returns (ENTER or CTRL+M) and line breaks 
(SHIFT+ENTER or CTRL+SHIFT+M). These elements are useful in controlling the layout of 
your web pages. For example, you can use a line break in a bulleted paragraph to create the 

following layout. 

 This is a bulleted paragraph. 
  
This is an indented line that is part of the first bulleted paragraph. It was created using 
a line break. 
  

 This is another bulleted paragraph created with a paragraph return. 

You can use non-breaking spaces (CTRL+SHIFT+Space) to keep two or more adjacent words 
in the same line of text. For example, you can use non-breaking spaces between the parts of a 
multiword product name to ensure that the name always appears as a unit and is never 
broken across lines by text wrapping. This provides some control over how your web pages 
are displayed in the user's browser, even if the browser window is resized. 

  
The alignment and indentation options determine the horizontal position of paragraphs in a 
web page. 
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  Align Left: The paragraph is aligned with the left margin and the text is uneven 

on the right side. This is usually the default text alignment setting for the languages 

with left to right direction. 
  

  Align Center: The paragraph is aligned symmetrically along the vertical axis and 

the text is uneven on the both sides. This setting is often used in titles or table cells. 
  

  Align Right: The paragraph is aligned with the right margin and the text is 

uneven on the left side. 
  

  Justify: The paragraph is aligned with both left and right margin; the text is not 

uneven on either side. Flexible spacing between letters and words stretch or contract 
to fill the page. 
  

  Increase Indent: Increases the spacing between a web page element 

(paragraph, list item or image) and the left margin or right margin. 

   

  Decrease Indent: Decreases the spacing between a web page element 
(paragraph, list item or image) and the left margin or the right margin. 

Note: You can also use the Align Left, Align Right, Increase Indent, and Decrease Indent icons 
to horizontally position graphics in a web page. The left and right alignment options create a 
word-wrap effect, with the adjacent text wrapping around the other side of the graphic. 
Deselecting all alignments positions the image at the baseline with no word-wrap. 

9.6.1 Create Block Quotes 

Use block quotes to separate long quotes from the body of the text. Block quotes are indented 

from the left and right side so they stand out. 
  

To insert a block quote: 

1. Select a block of text. 

  

2. On the Web Page Editor - Appearance toolbar, click  Block Quote. 

9.6.2 Use the Format List 

The Format list on the Web Page Editor - Font and Formatting toolbar is used to apply 
predefined paragraph formats to block elements, such as paragraphs and headings. The 
formats apply a combination of attributes designed to give a uniform look to the text in these 
paragraphs. These formats include: 

 Normal: Removes an applied paragraph format and resets the paragraph to the 
default paragraph format. For web pages linked to style sheets, the Normal format 
applies the default Paragraph style or the Document style if no paragraph style is 

marked as default. 
  

 Heading 1 - Heading 6: Creates a hierarchy of heading levels for organizing the 
contents of a document. All levels use the font from the Normal format, but adjust the 

size for each level by using a percentage of the Normal font size. For the sizing 
percentage for each heading level, see Format Heading Styles in the Create Styles to 
Format Content chapter of the Content Development guide. 
  

 Preformatted: Commonly used for including sections of ASCII text. The style applies 

a fixed width font that preserves the spaces and line breaks. The font size is inherited 
from the Normal format or from the document style for web pages that link to a style 
sheet. Preformatted text does not wrap. 
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 Address: Applies italic formatting. Address tags in HTML are commonly used for 
contact information for the author of the document. 

To apply one of the above formats to a paragraph, select the format from the Format list. If 
the web page links to a style sheet that contains a default style for that format, the paragraph 
is formatted for that style; otherwise, the browser default style is applied. 
  
Note: You can apply a paragraph format to new text before you type or apply it to existing 

text by clicking in the paragraph and selecting a format. Since the formats apply to the entire 
paragraph, you do not have to select the text in the paragraph to apply the format. 
  

Styles and the Format List 
You can redefine the formatting for the paragraph formats in the Format list by linking to a 
style sheet and creating or modifying the default styles for each element type, including each 

heading level. Default styles are automatically applied when you add an element from the 
Format list. A style sheet may also contain styles that are not set as default styles. You can 
only apply a non-default style for an element to existing text already tagged for the same 

element. To use a Heading, Preformatted, or Address style that is not a default style, you 
must first add the element to your web page from the Format list. Once you add the element, 
the Styles list displays all default and non-default styles of the same element type. Therefore, 

only Heading 2 styles appear for Heading 2 elements. 
  
Note: The Standard style sheet contains six non-default heading levels that you can apply to 
existing heading elements. 

9.6.3 Add Space Between Paragraphs 

You can add space between paragraphs using the Spacing tool on the Web Page Editor - 
Appearance toolbar. This tool opens the Spacing dialog box where you can enter spacing (in 
points or pixels) before and/or after a paragraph. 

  

You can use the  Show Blocks tool to help you identify and remove blank lines in your web 

page. This tool identifies blocks for paragraphs and other paragraph-based elements such as 

headings by displaying a grid of dotted frames around paragraph block elements. Manually 
inserted blank lines appear as empty grid frames. 
 

To adjust spacing between paragraphs: 

1. Click anywhere within the paragraph. 

  

2. On the Web Page Editor - Appearance toolbar, select  Spacing. 

  
3. Type the amount of space to add before the paragraph in the Before field and select 

the unit (points or pixels) from the list. 
  

4. Type the amount of space to add after the paragraph in the After field and select the 

unit (points or pixels) from the list. 

  
5. Click OK to apply the spacing. 

9.7 Format a Page 
You can format an entire web page including the background color, text color, or even add 
horizontal lines to emphasize the layout of the page. 

9.7.1 Set Page Background Color 

You can control the background color of a web page using the Background Color property. See 
Background Color property in the General Properties section of the View Document Properties 
chapter for more information. 
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9.7.2 Insert a Horizontal Line 

To add visual impact to your web page, you can insert a horizontal line that can span the 

entire width of the page to separate content in the page. 
  
Note: You can use a style sheet to change the settings for the default horizontal line or create 

styles for additional lines with varying appearance. Using the controls in the style sheet, you 
can set the width (length), height (thickness), and color of the line, and the spacing before 
and after the line. See Format Horizontal Line Styles in the Format Styles section of the Create 
Styles to Format Content chapter for more information about creating horizontal line styles. 
  

To insert a horizontal line:   

1. Select the location in the web page to insert the horizontal line. 

  

2. On the Web Page Editor - Insert toolbar, click  Insert Horizontal Line. 

9.8 Format Content with Styles 
Another approach to formatting content is to apply a predefined style rather than applying 
individual formatting attributes. There are several advantages to using styles. First, it gives 
the web page text a uniform look and feel. Second, changes in the style are automatically 
perpetuated through all content with that style. Styles are stored in a style sheet. 

9.8.1 Assign a Style Sheet to a Document 

To use styles in a web page, the style sheet containing those styles must be assigned as a 

property of the web page document. There are several ways to assign (link) a style sheet to a 
web page. 

 Assign a default style sheet: You can assign a default style sheet in the Web Page 
category in the Options dialog box. The initial Style Sheet setting is the Standard style 
sheet found in the Style Sheets folder in the Library, but you can select a style sheet 

from any folder. When you assign a style sheet in the Options dialog box, newly 

created web pages open with the Style Sheet property automatically set to that sheet. 
The default style sheet setting does not affect existing web pages. 
   

 Manually assign a style sheet: For existing documents, use the Style Sheet 

property in the General category of the Properties toolpane to assign or change the 
style sheet from the Library, Outline Editor, or Web Page Editor. To assign a style 
sheet to a web page from the Outline Editor, you must change the Properties toolpane 
view to Concepts. See Use the Properties Toolpane in the View Document Properties 
chapter for more information about setting concept properties. 
   

 Inherit a style sheet: Style sheets are assigned to modules, sections, and topics for 

inheritance purposes only. Web page concepts created in the Outline Editor 
automatically inherit the style sheet property of their parent. Furthermore, when you 
create a new module, you can use the Style Sheet property in the New Module dialog 

box to assign a style sheet to this document. Then, all new documents that you link to 
this module will inherit the style sheet setting.   

Note: You cannot link a style sheet to a file in a package; therefore styles are not available to 

HTML pages created in a package. 
  

 Multi-user Considerations 

 To change general, topic, and document output properties, you must check out the 

document. A message appears at the bottom of the toolpane if any of the documents 
in a selection are read-only. You can change general, topic and document output 
properties while working online or offline. 
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Styles sheets linked to content are excluded when you check in/check out with related 

documents. You must manually check in a style sheet to make it available to other 
authors or check it out to edit it. 
  
See Check In and Check Out Documents in the Use the Developer in a Multi-user 
Environment chapter for more information. 

To assign a style sheet to a document: 

1. From the Library, Outline Editor, or Web Page Editor, display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document to which you want to assign a 

style sheet. 
  

You can select multiple documents from the Library or Outline Editor using the 
standard Windows selection keys (CTRL+click and SHIFT+click). However, only 

modules, sections, topics, and web pages can be included in the selection. 
  
To assign a style sheet to a web page from the Outline Editor, select a document in 
the outline that links to a concept and change the Properties view to Concept. You can 

select multiple documents in the outline using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, only documents linked to web page concepts 
can be included in the selection. 
   

3. In the General category, click the Style Sheet cell then click . 
  

4. In the Select a Style Sheet Document dialog box, navigate to the desired style sheet 
and click Open. 

To remove a style sheet assigned to a document: 

1. From the Library, Outline Editor, or Web Page Editor, display the Properties toolpane. 

   
2. From the Library or Outline Editor, select the document from which you want to 

remove an assigned style sheet. 
  
You can select multiple documents from the Library or Outline Editor using the 
standard Windows selection keys (CTRL+click and SHIFT+click). However, only 
modules, sections, topics, and web pages can be included in the selection. 
  
To remove a style sheet from a web page in the Outline Editor, select a document in 

the outline that links to a concept and change the Properties view to Concept. You can 
select multiple documents in the outline using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, only documents linked to web page concepts 
can be included in the selection. 

   
3. In the General category, click the Style Sheet property name and press DELETE to 

clear the field. 

9.8.2 Apply a Style 

Styles are applied to the text and graphic elements of a web page either by the manual 
application of the style or by inheriting a default style. You can view a style applied to a web 

page element from the Styles box on the Web Page Editor - Font and Formatting toolbar or 
the Style Inspector toolpane. The Styles box is blank if no style is applied to the selection. 
Clicking the Styles list arrow displays a list of styles that you can apply to the selected web 
page element. The styles that appear in the list are filtered to show only the styles that can be 
applied to the currently selected element. For example, when you click in a table, the Styles 
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list displays all table styles in the style sheet. A style name in bold text indicates a default 
style for the element. 

  
Styles are automatically applied to web page elements if those styles are designated as default 

styles in the style sheet. For example, the attached style sheet contains a default Bulleted List 
style named Bullet1. When you create a bulleted list, the Bullet1 style is automatically applied 
and the name appears in the Styles text box when you click in the bulleted list. 
  
Note: You do not have to select text to apply a style that applies to an entire element; you 
can simply click in the element. These styles include paragraph, bulleted and numbered list, 
table, and heading styles. 

  
For more information about creating styles, see the Create Styles to Format Content chapter 
in the Content Development Guide. 
  

Replace Formatting with Styles 

You can use the Replace Font tool to help you replace direct formatting in one or more web 
pages with a text style. In addition, you can also use this tool to replace one style with 

another from the same style sheet. See Replace Fonts and Styles in the Use Content Tools 
section of the Build an Outline chapter for more information. 
  

Clear a Style 

You can use the Clear Style icon to remove a style from an element. Clearing a non-default 
style, automatically applies the default style to the selected element. You cannot clear a 
default style from an element. 
  
Clearing a style does not remove direct formatting; only the Clear Formatting from Text tool 
removes direct formatting from selected text. When clearing a style, you do not have to select 
the entire span of text to which the style is applied. You merely have to click in the text span. 

For example, you have applied a text style to four consecutive words. You can click in any of 
the four words and use Clear Style to remove the style from all four words. 
  

Deleted and Renamed Styles 

If an applied style is deleted or renamed in the style sheet, all instances in web pages using 
the deleted or renamed style are now identified as "Unknown style <style name>". If the 

deleted or renamed style is a default style for an element, the Web Page Editor applies the 
browser defaults for that element. If the deleted or renamed style is not a default style for an 
element, the Web Page Editor applies the default style for that element. 
  

To apply a style to text or graphic in a web page: 

1. Assign a style sheet to the web page. 

  
2. Select the text or object to which you want to apply a style. 

  
3. Click the Styles list and select a style. 

  
Note: Style names in bold indicate a default style for the element. 

 To clear a style from text or graphic element in a web page: 

1. Click in the element containing the style you want to clear. 
  

2. Click  Clear Style to remove the applied style. 

9.8.3 Determine Style Formatting 

The appearance of an element in a web page depends on directly applied styles, styles applied 
through inheritance, and directly applied formatting. 
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When a web page uses styles, many factors may control the formatting for a selected web 

page element (text or graphic). The appearance of an element in a web page depends on 

formatting attributes from a directly applied style, attributes from a style applied through 
inheritance, attributes inherited from the browser, and finally, directly applied formatting. 
When modifying the appearance of web page elements, you may need to determine the 
source of the formatting attributes in order to make your changes.  
  

The toolbars in the Web Page Editor show directly applied formatting. When you select a word 
that you have italicized, the Italic icon in the toolbar is active. To remove the italics from the 
word, you simply click the Italics icon to turn it off. However, formatting attributes that are 
applied through a style or inherited do not appear selected. If the italic attribute is applied 
through a style, the Italic icon does not appear active and you cannot click the icon to remove 
the italics. This behavior also applies to all font controls (font family, size, font color, and so 
on). If the style formats the paragraph text for an Arial 12 point font, those settings do not 

appear in the Font Family and Font Size controls on the toolbar. 
  
Note: The Background color property in the Properties toolpane for the web page shows the 

background color either directly applied to the web page or set through content defaults.  
  
Knowing the source of an element's formatting can help you determine if you want to format 
the element with another style, override a style with direct formatting, or edit the style. The 

element path and the Style Inspector are two Web Page Editor tools designed to help you 
work with styles. The tools can be used in combination to determine the formatting for applied 
and inherited style attributes. 

9.8.4 Work with Element Paths 

The element path at the bottom of a web page shows the hierarchy of HTML elements for the 
currently selected element in the web page. Selected elements may include text, heading, list 
item, table, cell, line, image, and so on. The element path shows the order of elements that 

affect the appearance of the selection. The element path is useful for identifying why your 
style may not be producing the intended results. It is especially helpful for analyzing the 
formatting of complex elements such as tables, where there are multiple elements that can be 

individually formatted, and you are not sure which ones affect the format of a specific table 
element. 
  
To understand the controlling elements for a selection, click anywhere in the formatted text or 

object and view the hierarchy of element identifiers in the element path. Element identifiers 
appear in the path from left to right in the order of inheritance, starting with the Document 
Body style that initially controls the formatting.  
  
Note: Defaults inherited from the browser do not appear in the element path. 
  
Element identifiers also appear for direct formatting applied to a selection. Direct formatting 

may be represented by specific identifiers, such as Bold and Italics, while other direct 
formatting, such as text color, may be represented by the generic "Text" identifier. 
  
Pointing and clicking identifiers in the element path have different functions. When you point 

to an element identifier, a tooltip displays the element name, the HTML element tag (such as 
<body>, <p>, <a>) and a style name if a style is applied to the selection. In addition, the 

tooltip may also display the name of the default style that affects the applied style through 
inheritance. 
  
Clicking an identifier selects the element in the web page and displays the style information for 
that element in the Style Inspector. Use the Style Inspector in conjunction with the element 
path to understand the formatting affecting the elements in your web page. As you select 
elements in the element path, the Style Inspector changes to display the attributes for the 

browser defaults, Document Body style, default style, applied style, and direct formatting 
controlling the appearance of the selection. See Use the Style Inspector in this chapter for 
more information.  
  



  Enhance Content with Web Pages 

   235 

Consider the following example. You have a 4x4 (row/column) table with row and column 
headers. A body cell has a paragraph of text to which you have applied bolding to two 

consecutive words. When you click in one of the bolded words, the element path displays the 
following: 

  
Document Body ---> Table ---> Table Body ---> Row ---> Cell ---> Bold 
  
Clicking each element identifier in the element path selects the following: (Note that only cells 
with content are selected when you click a table element.) 

 Bold: Selects both consecutive bold words in the cell. 

   

 Cell: Selects all of the text in the cell. 
   

 Row: Selects the entire row. 

   

 Table Body: Selects all body cells (excluding header cells). 

   

 Table: Selects the entire table and caption. 
   

 Document Body: Selects the entire web page. 

9.8.5 Use the Style Inspector 

The Style Inspector toolpane opens by default in the Web Page Editor. The purpose of the 
Style Inspector is to help you distinguish formatting from a style (applied or inherited) as 
opposed to direct formatting that is manually applied. 
  
Note: As with other toolpanes, you can close the Style Inspector and open it with the Panes 
submenu. 
  

When you select text or an object in a web page, the toolbars show directly applied formatting 

only. If you applied bold and italics to a word, the Bold and Italic icons appear selected, which 
means that you can remove the formatting by deselecting the icons. However, formatting 
attributes that are inherited from the application of a style or the browser do not appear 
selected in the toolbars. If bold and italics are applied by a text style, you cannot remove the 
formatting by clicking the icons to turn the attributes off. This behavior applies to all 

formatting controls on the toolbar.  
  
Since attributes from a style do not appear in the toolbars, you do not know the source of the 
formatting that is used for the current selection or cursor position, nor how to remove or 
modify those attributes. The Style Inspector shows the attributes by source. Knowing the 
source of the formatting can help you determine if you want to keep the style settings, choose 
another style, clear the style, alter the style in the style sheet, or apply direct formatting to 

override the style. 
  
Note: Colors appear in the Style Inspector with a color preview and their RGB values (black = 
0,0,0 and so on). 

  
The Style Inspector reports on the first character in a text selection. The toolpane is dynamic 
and the reported attributes change as you move the cursor or make another selection. The 

Style Inspector is read only; you cannot make changes to it. 
  
The Style Inspector toolpane is divided into categories and includes links to open the style 
sheet and the controlling styles. Clicking the style sheet link opens the style sheet in the Style 
Editor, with the first style selected. Clicking the style name link in the Style Inspector opens 
the style sheet to the selected style. You can use these links to find styles and make instant 

changes. The Style Inspector categories include: 

 General: Shows the name of the style sheet attached to the web page. 
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 Selected: <element>: This category displays the name and attributes of the style 

applied to the selection. Additional instances of this category may appear if more than 

one style controls the attributes for a selection, such as nesting one style within 
another. As an example, you have applied a text style to words in a paragraph 
formatted with a non-default paragraph style. When you click in the text style, the 

Style Inspector displays the two Selected categories; one for the text style and the 
other for the non-default paragraph style. 
  
Note: New styles initially inherit their attributes from the browser defaults or from a 
controlling parent style. If no changes are made to the style attributes, the Selected 
category does not appear and the attributes for a selection using this style are 

reported under the Inherited from categories; Default Document Body, Default 
<element>, and browser defaults. 
   

 Inherited from Default Document Body: This category displays the Document 
Body style name and the attributes that the selection inherits from this style. Note 

that the Style Inspector does not display Document Body attributes that are 

overridden by another style affecting the selection. For example, you select Heading 1 
text, which uses a style that specifies a larger font size; the font size for the Document 
Body is not reported in the Style Inspector because that attribute is overridden by the 
font size in either the Heading 1 style or the browser defaults. 
   

 Inherited from Default <element> This category appears if a default style is 
applied to a selection, or the selection inherits attributes from a default style, such as 
a default Paragraph or Bulleted List style. 
   

 Inherited from browser defaults: Web page elements inherit the browser defaults 
if the style's attributes do not override the browser settings or if no direct formatting 
was applied to change the initial browser settings. 
   

 Direct Formatting: Directly applied formatting. 

It is important to note that not all styles that control a selection appear in the Style Inspector. 
In the case of multiple layered styles or complex styles with many elements such as tables, 
you may need to use the element path to trace additional style attributes. 
  
Note: The Style Inspector toolpane only functions in the Web Page Editor; it is inactive in the 
HTML package editor. 

9.9 Insert an Image 
You can add images to your web page from files stored in packages in the Library, saved on 
your computer or a local intranet, or available on the Internet. The Web Page Editor supports 
png, jpg/jpeg, and gif image file formats. 
  
When inserting an image, you can choose from three types of sources as follows: 

  Image in Library: Inserts an image saved in a package in the Library.  

  
The image displayed on the web page is linked to the package graphic file. Therefore, 
if you update the package file, the image displayed on the web page is automatically 
updated as well. However, if you move, delete, or rename the package file, you create 

a broken link, and a "file not available" indicator  replaces the image on the web 
page. 
  
Because this option allows for easy image reuse and maintenance, it is preferable for 
images used many times throughout your content. 
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  Image on My Computer: Inserts an image saved on your computer or a 

network. 
   
The image is embedded in the web page; that is, it becomes part of the web page 
document and is not available in the Library as a separate file. 
   
This option is preferable for images used only once or a few times. 

   

  URL: Inserts an image located on an Internet or intranet site. 

   
For images obtained from Internet or intranet sites, you must enter (type or 
copy/paste) the complete URL of the image file itself. The complete URL includes the 
URL of the site on which it is located, plus the path to the image file within the site 
structure. When you insert a URL image in a web page, the image is linked to its 
source and is updated whenever the source file changes. However, if the source file is 

moved, deleted, or renamed, the link is broken, and a "file not available" indicator 

 replaces the image on the web page. Therefore, you must be sure to use exactly 
the same file name and path within the site structure each time you change the source 
image for the link to be maintained. 

Note: See Edit Image Properties in the Enhance Content with Web Pages chapter of the 
Content Development guide for information on setting image properties.  
 

To insert an image: 

1. Position the cursor at the location on the web page where you want to insert the 

image. 
  

2. On the Web Page Editor - Insert toolbar, click  Image.  

   
3. On the Image Info tab of the Image Properties dialog box, click Browse. 

4. Select the type of image source (  Image in Library,  Image on My 

Computer, or  URL), navigate to the desired image, and click OK. 

   
5. Click OK. 

  
Note: If you later decide that the image is not needed on the web page, you can 
delete it by simply selecting it and pressing DELETE. 

9.9.1 Edit Image Properties 

You can set the properties for any image inserted in a web page on the Image Properties 
dialog box. This dialog box has three tabs, Image Info, Link, and Advanced. 

  
The Image Info tab is used to set the URL to the image and configure how the image looks in 
the document. This tab contains the following fields. 

 URL: Sets the location of the image file. You can change the image displayed by 
clicking the Browse button to select a new source file or URL. All other image 
properties except size remain unchanged for the new image. 

  
If the image you intend to use is located on an external server, you must use the full 
absolute path (for example, http://example.com/image1.jpg). If the image is located 
on the same server as your document, you can use a relative URL (for example, 
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/images/image2.jpg). 

  

 Alternative Text: Enter a description of the image that can be read by an assistive 
device such as a screen reader. This provides accessibility for users with disabilities. 
  

Note: When placing an image that is solely decorative, leave the Alternative Text field 
blank. This creates an empty alt-"" tag in the source HTML that is ignored by a screen 
reader. 
   

 Width: Enter the width of a new image and select the associated units (pixels or 

points). Also, used to edit the width of an existing image. 
  

 Height: Enter the height of a new image and select the associated units (pixels or 

points). Also, used to edit the height of an existing image. 
  

 Lock Ratio: Maintains the ratio between the height and width of the image to prevent 
distortion as you resize the image from the Image Properties dialog box. With this 

option is selected, you can type a new value in the Height or Width field, and the value 
of the other dimension is updated automatically when you tab or click off your entry. 
You turn off the Lock Ratio by clicking the icon to show the unlocked state. 
  
Note: This option ONLY applies when you resize an image from the Image Properties 
dialog box; it does not affect changes made by dragging the image anchors directly on 
the web page. 

  

 Reset Size: Use this icon to abandon changes to image properties and reset the 
image back to the original size. 
  

 Border: Sets the width of a border around the image. For images that are not 
hyperlinks, the border is black. If an image with a border functions as a hyperlink, its 
border appears in the default hyperlink color. If an image without a border functions 
as a hyperlink, a 2-pixel colored border is automatically added to indicate the presence 

of the hyperlink, although you can also increase the width of this border, if desired. 
  
Note: After adding a border to an image, you can change the border color using the 
Text Color icon on the Web Page Editor - Appearance toolbar. Furthermore, you can 
use the Text Color icon to change the border color for an applied image style that does 
not specify a border color. 
  

 HSpace: Sets the horizontal spacing (in pixels) between the image border, if present, 
or the image itself and other elements in the document. 
   

 VSpace: Sets the vertical spacing (in pixels) between the image border, if present, or 

the image itself and other elements in the document. 
   

 Alignment: Sets the horizontal alignment (Left or Right) of the image relative to the 

line containing it. Left places the image at the left margin and wraps subsequent text 

along the right side of the image. Similarly, Right places the image at the right margin 
and wraps subsequent text along the left side of the image. If the image is on a line 
by itself (that is, if text wrapping is not important), you can use the paragraph 
alignment controls instead to obtain the same effect. 

  
Note: You cannot directly center an image in a web page, but centering the paragraph 
on which the image is inserted also centers the image. To center an image, insert the 
image on a blank line, click in the empty space just to the right of the image and use 
the Center alignment icon on the toolbar to center the image. You can only center an 
image if the Alignment option in Image Properties is set to <not set>. 
  

 Preview: Displays a view of what the image looks like with the selected properties. 
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The Link tab is used to create a clickable link from an image placed in a document. This link 
can point to many kinds of objects on the internet including a web address, PDF, or video. This 

tab contains the following fields. 

 URL: Use this field to browse to the destination the image links to. 

  
If your image is located on the same server as your link destination, you can use a 
relative URL (for example, /images/image2.jpg). If the image is located on an external 
server to your link destination, you must use the full absolute path (for example, 
http://example.com/image1.jpg). 
   

 Target: Determines how the linked content displays in the window after the image is 
clicked. You can choose between New Window, Topmost Window, Same Window, or 
Parent Window. 

Note: If you want to edit an image that is connected to a link, use the context menu and 
choose the Image Properties option. The Image Properties window lets you modify both the 

image and the link that it is pointing to. If you double click the image instead, you open the 
Link dialog box that allows you to edit the link properties and but not the image itself. 

  
The Advanced tab is used to configure additional image options such as a longer image 
description, or tooltip text. This tab contains the following fields: 

 Long Description URL: Use to point to a URL (longdesc attribute) of a page 
containing a longer description of the image. 
  

 Advisory Title: This is the text of the tooltip (title attribute) that is shown when the 
mouse cursor hovers over the image. This text is not used by screen readers. To 
provide an accessible description, use the Alternative Text field on the Image Info tab.  
  
Note: Items in parenthesis are CSS property names. 

To edit image information properties: 

1. Double-click the image to display the Image Properties dialog box. 

  
You can also right-click the image and select Image Properties from the context 
menu. 

  
2. Change the image properties as needed. 

  
You can see the effects of your changes in the Preview without closing the dialog box 
and then make further changes to the image properties if needed. ` 
  

3. Click OK. 

9.10 Link Text 
You can create links from text in your documents to content outside the Library such as URLs 
to websites, PDF documents or images, to an email address, or to anchor locations 
(bookmarks) set within other documents in the Library. 
  
Note: The appearance of a link is determined by the link formatting for the default browser. 
You can, however, create a link style that overrides this browser default. For example, you can 
format links to use another font or text color. See the Create Styles to Format Content chapter 

for more information about creating styles for web pages. 
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9.10.1 Insert or Delete a Hyperlink to a URL 

The URL Link Type is used to create clickable links to content in the Library or websites outside 

of your content. When you set the Link Type to URL, the Link Info and Target tabs on the Link 
dialog box become active.  
  
The Link Info tab contains the fields necessary to set up the link from the selected text to 
content in the Library or a URL outside of your content. 

 Link Type: This sets the type of link being created. Set this to URL when linking to 

content in the Library or a URL outside of your content. 
   

 URL: This is the location you want to link to. If you want to link to an external server 
address, use the full path such as http://example.com/about.html. If you want to link 

to a document within the Library, you can use a relative path such as 
../about.mission.html. 
   

 Browse: This is used to browse to the URL you want to link to. When you click the 

Browse button you are given the option to browse the Library or the web. 
  

 Document in Library: This option allows you to link to another attachment 

contained in the Library. For example, you could link from a word in a web page to 
another web page containing its definition. This option can be particularly appropriate 
for package files used as concepts. Rather than linking directly to the package file, you 
can link to a web page that, in turn, contains a hyperlink to the package file. This 
approach provides greater control over how and when package files used as concepts 
are displayed. 
   

Package File Parameters/Bookmarks 
The Developer supports URL parameters or bookmarks to files in packages, such as: 
  

test.html?a=1&b=2 
test.html#bookmark 
test.html?a=1&b=2#bookmark 

  
When you insert a link to a file saved in a package, you can use the Name field on the 
Insert Hyperlink Browse dialog box to select a file inside a package and add 
parameters/bookmarks after the selected filename. 
  

 URL: This option allows you to link to an intranet or internet site. To test the 

targets of your hyperlinks from the Web Page Editor, right-click the link and select 
Open Hyperlink. You can also use SHIFT+click to open the targets of your hyperlinks 
from the Web Page Editor. For web pages and package files, this command opens the 
target in a new Developer tab. For URLs, the target opens in a new, independent 

browser window. 

  
When viewing your web page from outside the Web Page Editor (for example, in the 
Concept pane of the Outline Editor), you can test your hyperlinks simply by clicking on 
them. In this case, the target of each hyperlink opens in a new, independent window. 
However, if you need to edit a hyperlink, you must open the web page containing it in 

the Web Page Editor. If you have web content that has not yet been deployed or the 
final deployment server is unknown, you can still create the URL links using relative 
URL addresses. Relative URLs are addresses which are relative to a configurable base 
address. By using URL conventions, you enter a path relative to a base address. If the 
web content is deployed locally or on an accessible server, you can enter a temporary 
base address to preview and check the relative links. See Work with Relative URLs in 
the Enhance Content with URLs chapter for more information. 

   

 Tooltip: Enter text that displays when you mouse over the link. 
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The Target tab allows you to control where the link opens. Target options include: 

 <not set>: Default setting that opens link in the same browser window or tab as the 
document. 
   

 <frame>: Opens the link in a frame you name in the Target Frame Name field. 
   

 <popup window>: Opens the link in a popup window you name in the Popup 

Window Name field in the Popup Window Features section. Additional options are 
available to control the appearance of the popup window. 
   

 New Window: Opens the link in a new window. 

   

 Topmost Window: Opens the link in the window positioned on top. 

   

 Same Window: Opens the link in the same window as the document. 
   

 Parent Window: Opens the link in the window that the document link is nested in. 

To link text to content: 

1. On the Web Page Editor - Insert toolbar, click  Hyperlink. 
   

2. On the Link Info tab, select URL in the Link Type list. 
   

3. Click Browse, then select the type of hyperlink target as  Document in Library 

or  URL. Navigate to the target document and click OK. 

   

4. Type the text to display went the user mouses over the link in the Tooltip field. 
   

5. Click OK. 
  

The presence of the hyperlink is indicated by underlining of the selected text or 
outlining of the selected image. 

To unlink text: 

1. Select the hyperlink to unlink. 
   

2. On the Web Page Editor - Insert toolbar, click  Unlink. 

9.10.2 Link to an Anchor in Text 

An anchor is a placeholder in your content that allows you to link to a specific point in your 
document. Anchors are useful when you have content with a lot of text. Typically, a link takes 
you to the top of the linked page but when the user clicks on the link to an anchor, they are 
taken to the specific point where the anchor is set.   

  
In a web page, you can link to an anchor by anchor name. This is an anchor you create and 
name. This anchor can be placed by selecting the anchor name in the By Anchor Name list on 
the Link Info tab. 
  
Note: Only anchors that have been previously set appear for selection in the Link Info dialog 
box. 
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To create an anchor by name: 

1. Select the location point or text where you want to place the anchor. 

  

2. From the Web Page Editor - Insert toolbar, click  Anchor. 

  
3. Type the name of the anchor in the Anchor Name field. 

  
4. Click OK. 

To link to an anchor in a web page: 

1. Select the anchor. 

  

2. Click  Hyperlink. 

  
3. From the Link Type list, select Link to anchor in the text. 

  

4. Select the name of the anchor from By Anchor Name list. 
  

5. Click OK. 

9.10.3 Insert a Link to an Email 

You can create a link to an e-mail address from within your content. When the user clicks the 
link, the email client opens an email prefilled with the email address and any subject title and 
body message you entered when you created the link. 
  

To create a link to an e-mail address:  

1. Select the text or location in the content you want to link an e-mail address. 

  

2. Click  Hyperlink. 

  
3. From the Link Type list, select E-mail. 

  
4. Type the e-mail address to in the E-Mail Address field. 

  
5. Type the subject of the e-mail in the Message Subject field if you want the subject 

prefilled. 
  

6. Type the body text of the e-mail in the Message Body field if you want the message 
body prefilled. 

  
7. Click OK. 

9.11 Work with Tables 
You can create tables in your web pages to better display data visually. The Table Properties 
dialog box lets you configure the table size, display properties and other settings. 
  
The Table Properties tab allows you to configure the table dimensions and how the table 
appears in the document. It contains these options:   

 Rows: Number of rows in the table. If you are using a header, the header row is 

included as one of the rows entered in this field. 
   

 Columns: Number of columns in the table. 
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 Width: Width of the table cells. By default, this value is expressed in pixels. You can 

also specify a variety of other units. For example, you can enter 1 in for inches. 

Entering the width as a percent value lets you set the proportion of the editing area 
that the table occupies. 
  
By default, the width of a new table is set to 500px, which is the browser default. 
However, if the web page links to a style sheet with a default table style that specifies 
a table width, the Width field appears blank because the width is set through the style. 

You can, however, enter another value to override the style. 
   

 Height: Height of the table cells. By default, this value is expressed in pixels. You can 
also specify a variety of other units. For example, you can enter 1 in for inches. 

Entering the height as a percent value lets you set the proportion of the editing area 
that the table occupies. 
   

 Headers: Defines how a heading cell is formatted. You can apply header formatting to 

First Row, First Column or Both. A None setting uses the same format as normal cells 

for the first row and first column. 
   

 Border size: Thickness of the table border in pixels. 

   

 Alignment: Alignment of the table on the page. The following options are available: 
Left, Center, Right. 
  

 Cell spacing: Space, in pixels, between individual cells or cells and table borders. 

  

 Cell padding: Space, in pixels, between the cell border and its contents. 

   

 Caption: Label that displays on top of the table. 
   

 Summary: Summary of the table contents that is available for assistive devices like 
screen readers. It is a good practice to provide your tables with meaningful summary 

text in order to make content accessible to users with disabilities. See Accessible 
Overview in Appendix D: Accessible Content for more information. 
  

 Table Type: Designates the table as a layout or data table. A data table usually 
contains a heading row with a column of data under each heading. A layout table is 
used by a web designer to control the layout of a web page. 

Table Styles 

If you are not using styles, the initial attributes of a table are based on the browser defaults. 

While you can use direct formatting to change the different table elements each time you 
create a new table, you may want to create one or more table styles that apply specified 
formatting to the individual table elements. If you create a default table style, the attributes of 
that style are automatically applied when you create a new table. You can create several non-
default table styles if you use different styles for different types of tables. For example, you 
may want to create a default table style with a border around the table and no interior cell 

lines, and a non-default table style that applies gray shading for alternating rows. To use a 

non-default table style, you must first create a table in the web page to add the table element. 
Once you add the table element, you can select another table style from the Styles list.  
  
You can save a great deal of time using styles to format tables instead of direct formatting. In 
addition, styles help maintain a consistent look for your tables. See Format Table Styles in the 
Format Styles section of the Create Styles to Format Content chapter for more information 

about creating table styles. 
  
Note: If you are applying a style to an existing table whose width is set in the Table Properties 
dialog box, the table style will not override the width setting as this is considered direct 
formatting. In order to allow the existing table to use the width setting from the style, you 
must delete the width setting for the table in the Table Properties dialog box. Alternatively, 
you can remove all direct formatting from a table by pointing to a table border and clicking the 
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border when the mouse pointer shows a four-headed crossed-arrow. This selects the entire 

table. You can then use the Clear Formatting from Text icon to remove all direct formatting 

from the table. 
  

 To create a Table: 

1. On the Web Page Editor - Insert toolbar, click  Insert New Table. 
  

2. Type the number of Rows and Columns you want in the table. 
  

3. Select a Header option. 
  
Note: If the style sheet contains a default table style that formats row, column, or 
both headers, the formatting does not appear in the table if you do not select a 

corresponding header option. 
   

4. Set other properties to create the desired table format. 

  
5. Click OK. 

Note: To insert a new paragraph above or below a table, move the cursor over the table until 
a red dotted line appears. Click on the red return icon on the right side of the line to add a 
new paragraph. 

9.11.1 Edit a Table 

You can edit table properties in one of two ways:   

 Double-click on the table border to open the Table Properties dialog box. You can edit 
any of the properties except the Rows and Columns. 
  

 Right-click in a table cell to open a context menu. You can edit cells, rows and 

columns, delete the entire table, or open the Table Properties dialog box. You can also 
paste content copied from another cell or from Word into a cell. 

The Cell menu on the context menu contains the following cell related editing functions: 

 Insert Cell Before: insert a new cell before the selected cell. 
   

 Insert Cell After: insert a new cell after the selected cell. 

   

 Delete Cells: delete the selected cell or cells. 
   

 Merge Cells: merges two or more selected cells into one cell. 

   

 Merge Right: merges the selected cell with the cell on its right joining the content of 

both cells. 
   

 Merge Down: merges the selected cell with the cell below it joining the content of 
both cells.  

  

 Split Cell Horizontally: splits the selected cell in two, creating a new cell on its right 
and leaving the content in the original cell on the left. 
   

 Split Cell Vertically: splits the selected cell in two, creating a new cell attached 
below it leaving the content in the original upper cell. 
   

 Cell Properties: opens the Cell Properties dialog box.   
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The Row menu on the context menu contains the following row related editing functions:   

 Insert Row Before: inserts a new row before the one that contains the cursor. 
  

 Insert Row After: inserts a new row after the one that contains the cursor. 

  

 Delete Row: deletes a row that contains the cursor. 

The Column menu on the context menu contains the following column related editing 

functions: 

 Insert Column Before: inserts a new column before the one that contains the 
cursor. 
   

 Insert Column After: inserts a new column after the one that contains the cursor. 

   

 Delete Column: deletes the column that contains the cursor.. 

9.11.2 Delete a Table 

Although you can delete individual table rows or cells using the Row or Column menus on the 
context menu, there may be occasions where you want to remove an entire table. You can 
delete an entire table by right-clicking on the table then click Delete Table on the context 
menu. 

9.11.3 Format Cells 

The Cell Properties dialog box allows you to configure the look of a table cell. It contains these 
options:   

 Width: Set the width of the cell in pixels or a percent value. Using pixels sets the cell 
width to a fixed value. Setting the width as a percent value lets you set the proportion 

of the row that the cell (and the column it is located in) occupies. 
  

 Height: Set the height of the cell in pixels. 
  

 Word Wrap: Set the wrapping of text within the cell. If this is set to Yes, text wraps 

to the next line when a new word is typed that won't fit in the cell. If this is set to No, 
if you enter text that is too big for the cell, the cell expands to accommodate the word. 
  

 Horizontal Alignment: Set the horizontal alignment of the content within the cell. 

Options are: Left, Center, Right, or not set. 
  

 Vertical Alignment: Set the vertical alignment of the content within the cell. Options 

are: Top, Middle, Bottom, Baseline, or not set. 
  

 Cell Type: Set the cell as a data or heading cell. Heading cells typically have 

additional formatting such as centered alignment and bold text. 

  

 Row Span: You can set a cell to span downward over multiple rows. Enter the 
number of rows the cell spans. 
  

 Column Span: You can set a cell to span to the right over multiple columns. Enter the 
number of columns the cell spans. 
  

 Background Color: Set the color of the cell background. You can enter either the 

RGB value (nn,nn,nn) or hexadecimal value (#nnnnnn). You can also click the Choose 
button and select a color from the Color dialog box. 
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 Border Color: Set the color of the cell border. You can enter either the RGB value 

(nn,nn,nn) or hexadecimal value (#nnnnnn). You can also click the Choose button and 
select a color from the Color dialog box. 

To set cell properties: 

1. Right-click in a table cell. 

  
2. On the context menu, point to Cell and select Cell Properties. 

  
3. On the Cell Properties dialog box, make the appropriate cell property changes. 

  
4. Click OK. 

9.12 Work with Lists 
Lists provide a way to structure content visually by grouping related items together. Bulleted 
lists are used for items that are grouped together but with no specific order. Numbered lists 
are used for items that must be grouped in a numerical order. You can create lists using these 
tools on the Web Page Editor - Appearance toolbar. 

  Insert/Remove Numbered List: inserts a numbered list or changes the format 

of selected text to a numbered list. This icon also removes an existing numbered list. 
   

  Insert/Remove Bulleted List: inserts a bulleted list or changes the format of 
selected text to a bulleted list. This icon also removes an existing bulleted list. 

After inserting the first bulleted or numbered list item, pressing the ENTER key creates a new 

item at the same level. Use the Increase Indent and Decrease Indent icons to promote and 
demote list items to create a multilevel list. Different list levels may appear with different 
bullet or number formats depending if the web page links to a style sheet and its styles. The 

list level style is applied when you promote or demote the list item. You can change the bullet 
or number type for the list item using the Properties dialog box for the item. 
  
In new web pages that use content defaults, numbered lists take the font style and size set for 

new web pages or in immediately preceding text if different from the default settings. 
However, you can change the text formatting and apply other bullet or numbering types after 
creating the list. You cannot change the size of the list bullets or insert custom bullets in the 
Web Page Editor. This must be accomplished by using a style in the style sheet.   
  
Note: You can use styles to format bulleted and numbered lists. The Standard style sheet 
includes bulleted styles and numbered styles, but they are not set as default styles, so you 

can only apply them to text already tagged as a bulleted or numbered list. To apply one of 
these list styles in the Web page Editor, you must first create at least one line of the list in 
your web page using the Insert/Remove Numbered List or Insert/Remove Bulleted List icons; 
this identifies the text as a list element. Then you can click in the list and select a list style 

from the Styles list on the Web Page Editor - Font and Formatting toolbar. You can use the list 
styles in the Standard style sheet as formatted, modify them, or copy them and use them as 

the basis for new list styles. 

9.12.1 Change List Types 

The bullet images and numbering types used for list levels are a result of the built-in web page 
formatting or a default style, if the web page is linked to a style sheet. You can use the list 
properties to change the existing bullet image or numbering style for a list level. In a 
multilevel list created by demoting/promoting list levels, changing the bullet or number type 
for one list item, changes the type for all items of the same level nested under the same 
parent. 
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Change Bullet Types 

The Web Page Editor has a number of standard bullets that can be selected using the Bulleted 

List Properties dialog box. Standard bullets include:   

 Circle (○) 

   

 Disc (•) 

   

 Square (■) 

Note: If you do not want to use the standard bullets, you can use a style sheet to create 
styles that apply custom bullets. See Format List Styles in the Create Styles to Format Content 
chapter for more information about using custom bullets. The Standard style sheet includes 

several bullet styles that use custom bullets. 
  

Change Number Types 

You can change the numbering format for items in a numbered list by selecting another 

numbering type from the Numbered List Properties dialog box. Numbering types include: 

 Lower Roman (i, ii, iii, iv...) 

   

 Upper Roman (I, II, III, IV...) 
   

 Lower Alpha (a, b, c, d...) 

   

 Upper Alpha (A, B, C, D...) 

   

 Decimal (1, 2, 3, 4...) 

Note: If you frequently use numbered lists, it is more convenient to use styles for formatting 
the list. You can create a new style or modify the multilevel style in the Standard style sheet 

to format the list for your content. See Format List Styles in the Create Styles to Format 
Content chapter of the Content Development guide for more information about creating 

numbered styles. 
  

To change to a different list type: 

1. Right-click in a list item in a bulleted or numbered list and select  Bulleted List 

Properties or  Numbered List Properties on the context menu. 

  
2. Select a bullet or number type from the Type list and click OK. 

  
Select <not set> to reset the list type to the default setting for the list level. 

  
Note: In a single level list, the change affects all list items. In a multilevel list, the 
change affects only items of the same level nested under the same parent item. 

9.13 Web Page Behavior in Publishing 
The behavior of web pages in publishing depends on the type of published output, the level at 
which the web page is linked, and the content of the web page, as described in this section.  
 

Player Outputs 

Web pages linked at all levels are included in all Player outputs in Try It! and Do It! modes, 
and all hyperlinks within the web pages are active. When linked at the concept level, the web 
page appears directly in the Concept pane when the user selects its parent document. When 
linked at the frame or bubble text level, users access the web page by clicking on the link icon 
or hyperlinked text, respectively. In these cases, the web page opens in a new browser 
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window. Similarly, for hyperlinks within web pages, the link target always opens in a new 

window. 

 
Warning! If the target of a web page hyperlink is a package file or URL, you must ensure that 
your users have the appropriate setup and access to view the target of the link. Otherwise, 
the browser displays an error when the user attempts to access the linked attachment through 
the web page hyperlink. 

  
Note: Web pages linked to frames or bubble text are not available in See It! or Know It? play 
modes in the Player. 
 

Document Outputs 

Only three types of document outputs include linked attachments (by default) such as web 

pages: the System Process Document, Training Guide, and Instructor Manual. For these three 
documents, the outcome depends on the level at which the web page is linked and its 
contents. Specifically, web pages linked at the concept and frame levels are included in 
document outputs. Web pages linked to bubble text are excluded from all document outputs. 

 
Note: You can customize any document output type to include web pages. 
 

When linked at the concept level, the web page appears immediately after the name of the 
parent document to which it is linked. When linked at the topic level, the web page 
immediately follows the screen shot and steps for the frame to which it is linked. It appears in 
a lightly shaded box that is indented slightly to set it off from the surrounding content, with 
the link icon to its left. When the same frame links to multiple web pages or other attachments 
that are included in document outputs, each attachment is displayed as a separate item, in the 

order in which it is linked. 
 
Further details on the appearance of a web page depend on the combination of text, images, 
and/or hyperlinks it contains. 

 Web page background color is not preserved. 

  

 When publishing to a print output, if no spacing before or after the paragraph is set 

then the spacing is automatically set to 0. If spacing was set, either on a paragraph 
basis via the Spacing dialog box or for all paragraphs in the web page by attaching a 
print style, the spacing is preserved. 
  

 When a web page is in a table, the page break is not honored because page breaks in 
tables are not supported in Word. 
  
For default templates, page breaks are not honored inside the attachment or glossary 

table(s). If you want page breaks to be honored, you can customize 
Print.Template.docm so that the Webpagetext or DeveloperWebpageText bookmarks 
are not used in tables. 
  

 If a web page contains formatted text, the bold, italic, underline, text color, and 

numbered and bulleted list formatting is preserved, but the font style and font size are 
not. The default font style and size, as specified in the publishing styles, are used 
instead unless the web page format publishing option is set to Developer settings. 
  

 All images inserted in web pages as embedded images linked package graphics, and 

linked URLs are also included in document outputs if images are included in publishing. 
Although the images appear within the borders of the shaded box, the images 
themselves do not have a shaded background. The maximum image size is 1/2 page; 
graphics larger than this are scaled accordingly and those smaller appear at full size. If 
the image is also hyperlinked, the image is included in the document, but the 

hyperlink is ignored. 
  
If desired, you can use the publishing format options to exclude web page images 
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from all document outputs. 
  

 Web page hyperlinks are included in document outputs only when the target is a URL 

(not another web page or a package file) and the hyperlink is from text, not an image. 
In this case, the hyperlink tooltip appears in place of the linked text, followed by the 
target URL in parentheses. The target URL functions as an active link in the document 
output. 
  

Consider the following example: 
  
A web page linked as a topic concept contains the text "You can find more information 
at the Microsoft web site." with a hyperlink from the words "Microsoft web site" to the 
target URL "www.microsoft.com". Further, the tooltip of the hyperlink is "Microsoft 
Corporation web site". Upon publishing to the System Process Document, for example, 
the result for this URL hyperlink is "You can find more information at the Microsoft 
Corporation web site (www.microsoft.com)." 

Note: The Job Aid, Test, and Test Case document outputs do not include linked attachments 

by default but they can be updated to include web pages. 

9.14 Preview a Web Page 
When creating content, it is often useful to preview how the page looks once it has been 
published. You can preview a web page you are currently editing without going through the 
full publishing process by using one of the following methods:   

 click the Open in Browser icon on the Web Page Editor - Tools toolbar 

   

 toggle between player and print options from the Display list on the Web Page Editor 
toolbar 
   

 select the desired publishing style on the Preview list on the Standard toolbar 

You are prompted to save any unsaved changes to the web page before previewing.   

9.14.1 Open in Browser 

You can see how your web page looks in a browser without leaving the Web Page Editor using 
the Open in Browser icon. The web page opens in a separate browser window. Links in the 
web page to other web pages are active in the browser. 
  
When opening the web page in a browser, you have the option of selecting the browser 

(Internet Explorer, Firefox, Safari, Chrome or your System Default browser) in which the web 
page displays. If you select Do not ask again, the Select Browser dialog box does not appear 
again. 
  
Note: After you click the do not show again box on the Select the Browser to Preview dialog 
box, the dialog box won't display when you click the Open in Browser tool. The preview opens 

in the browser last selected. To display the Select Browser dialog box again, select Reset 
Dialogs on the General Developer Settings page in the Options dialog box. 
  

To open a web page in a browser: 

1. On the Web Page Editor - Tools toolbar, click  Open in Browser. 
  

2. If prompted, click OK to save changes to the web page. 
  

3. Select your browser of choice and click Open. 
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9.14.2 Display in Player or Print View 

While creating or editing a web page, you can toggle between views to preview what your 

content looks like online or in print with the Display list on the Web Editor - Tools toolbar. If 
you have created separate print styles, you can view the web page content directly in the Web 
Page Editor with the print formatting applied. Additionally, you can use Open in Browser to 
check the formatting for each installed browser. See Add Print and Language Variations in the 
Create Styles section of the Create Styles to Format Content chapter for more information 
about creating print styles. 

  
Note: The Display list is not available on the Web Editor - Tools toolbar when editing or 
creating an HTML file in the Package Editor. 
  

To toggle from Player to print style preview: 

1. On the Web Page Editor - Tools toolbar, select Player or Print from the Display list. 

  
The web page displays the content using the selected output styles. 

9.14.3 Preview a Publishing Style 

The Preview list is active when you are in the Web Page Editor, Outline Editor, or Library. 
While all publishing styles appear in the Preview list in Web Page Editor, the Developer does 
not allow you to preview publishing styles that do not fit the situation. For example, you 
cannot preview any Player modes in the Web Page Editor. Only document publishing styles 
that contain web pages are available for preview. These include System Process, Training 

Guide, Instructor Manual, and any custom print styles you have created that include web 
pages; for example you can preview a Job Aid if you add the topic concept bookmarks to that 
template. If you select a publishing style that does not fit the situation, the "Cannot Preview 
Document” message box appears.  
  
Note: See Customize Publishing Styles in the Publish Content chapter for more information 

about creating custom publishing styles and renaming publishing and preview style names. 

  

To preview a web page using the Preview list: 

1. In the Standard toolbar, select a style from the Preview list and click  to preview 
the web page. 
  

2. If prompted, click OK to save changes to the web page. 
  

3. If prompted, select your browser of choice and click Open. 

9.15 Print a Web Page 
You can print the contents of the active web page (or web page within a package) by selecting 
Print on the File menu of the Developer. The content of the web page prints with all of the 

formatting but without the Web Page Editor window and toolbars. 
  

Note: You can control how the page breaks when printing using the  Insert Page Break for 

Printing tool on the Web Page Editor - Insert toolbar. 
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10 Create Styles to Format Content 
If all of the text in a print or online output looked the same, it would be more difficult to read. 
Formatting selections of content not only makes the text easier to read, but also easier to 

comprehend. For example, you may want to show all scripting commands in a font that is 
different from the body text, or you may want to bold and shade the heading row for tables. 
When using formatting, it is important to establish a set of standards so that the formatting is 
applied consistently and communicates the same usage to readers. 
  
When formatting web page content, you should consider using styles rather than applying 

each attribute individually. A style is a container for pre-defined formatting instructions that 
controls the attributes of a specific web page element. Elements are HTML tagged structural 
parts of a web page. They include paragraphs, bulleted and numbered lists, headings, tables, 
spans of formatted text, and so on. 
  
The manual application of each formatting attribute to each element in a web page is called 

direct formatting. There are many advantages to using styles over direct formatting. For 

example, you want to format web page subheadings for a Tahoma, 12 point, blue text color, 
bold font with a 24 point indent. To manually apply those formatting attributes would take at 
least five separate steps. By storing those formatting instructions in a style, all of the 
formatting attributes are applied when you perform the single step of applying that style to 
your subheading text. After creating the style, it is now available for use in other web pages, 
and can be shared with other authors. Styles also make it easy to change formatting because 
you have tagged all the text of the same element type for a particular style. If you decide to 

change the format, you only need to change the attributes of the style to change all instances 
of text tagged with that style. 
  
Styles are applied to text or elements in a web page either by manually applying the style or 
by default. When you create a default style for an element, the style and its formatting are 
automatically applied when you add that element to a web page. For example, if you always 

format tables with a gray background for row and column header cells, you can create a 

default table style with those attributes; this change affects all new tables that you add to a 
web page and all existing tables that use the default table style. You can create multiple styles 
for the same web page element. For instance, you may want to create multiple paragraph 
styles with different font and spacing attributes. 
  
While it takes some initial effort to create your styles, in the long run, styles save you a great 

deal of time. Styles also contribute to the creation of professional looking content by enforcing 
consistency; ensuring that all content has the same look and feel. 
  
Note: You should be judicious in your use of any formatting, as over-formatting loses its 
impact. Plan your formatting strategy by creating standards.  

10.1 Work with Style Sheets 
Styles are stored in style sheets. A style sheet is a collection of styles, images for bullets, and 

other details that define the look of web pages. A single style sheet can contain multiple 

styles, with each style identified by a unique name. You can also create separate style sheets 
for different projects if each project has its own set of visual standards. Whether you choose 
to save all of your styles in a single style sheet or multiple style sheets, it is a good idea to 
decide the formatting for those styles before starting a documentation project. 
  

If you want all of your content to have a consistent look, you should assign a style sheet as 
the default style sheet for new web pages in the Options dialog box and then apply that style 
sheet to existing content. See Web Page Defaults under the Content Defaults section in the 
Set Developer Defaults section of the Get Started Using the Developer chapter for more 
information about setting a default style sheet. 
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Tip: If a team of authors are collaborating on a project, the project administrator should send 

out a content defaults (.ops) file that sets every author's web page default to the same style 

sheet. 
 

The Developer Library installation includes a style sheet named Standard in the System/Style 
Sheets folder. The Standard style sheet, which is initially assigned as the default in the 
Options dialog box, contains a set of pre-defined styles that you can start using immediately 
to format text elements and objects in the Web Page Editor. You can choose to edit the 

included styles or add your own styles to the Standard style sheet. Conversely, you can create 
a new style sheet and assign it as the default. 
 

You create new style sheets just as you create any other document in the Library and save 
them to any folder in the Library. New style sheets open with a single document body style 
named Document. The Document style is set to use the Arial, Helvetica, sans-serif font family 
and a black font color (#000000). The style includes language variations for Chinese 
(Simplified and Traditional), Japanese, and Korean, with the fonts set to best display those 

languages. If you delete all styles from a style sheet, the style sheet displays a hint about 
using and creating styles. The hint then disappears when a style is added to the style sheet.  
 

Styles can be copied from one style sheet to another. For example, you may want to copy one 
or more styles from the Standard style sheet to a new style sheet so that you can use the 
styles as a basis to build new styles. Only full styles can be copied; you cannot copy an 
individual print style or language variation. 
 

Delete a Style Sheet 
If a style sheet you want to delete is stored in /System/Style Sheets folder, you are prompted 
with the standard System file warning that altering the structure of the system folder may 
impair the operation of the software. You can proceed to delete it. 
 

Related Documents 

Style sheets are included as related documents for certain transactions. When duplicating 
content with Paste Special, you have the option to duplicate all style sheets that are linked to 
the content. If the duplicate content links to the original style sheet, changes made to the 

style sheet affect both the original and duplicate content. Conversely, you may want to 
duplicate the style sheet so that you can change the formatting of your duplicate content 
without affecting the original source content. See Copy and Paste Special (Library) in the Work 
with Documents section of the Manage the Library chapter and Copy and Paste a Document 

(Outline Editor) in the Develop and Outline section of the Build an Outline chapter for more 
information about including or excluding style sheets when duplicating content. 
 

Note: If you are using images in a package for custom bulleted lists, it is important to decide 
where the package is stored. Packages stored in the System folders are not duplicated when 
you use Paste Special to duplicate content with style sheets. If the image package is stored in 
a Systems folder, such as the Style Sheets folder, a duplicate action with style sheets makes a 

copy of the linked style sheet, but the bulleted styles that use custom images still link to the 
images in the original package. See Create Custom Bullets in the Format List Styles section in 
this chapter for more information about creating and using custom images for bulleted list 
styles. 
 

Export/Import 
Just like any other document, style sheets can be exported from and imported into the Library 

for backup purposes, or to send to an author using a different Library. Style sheets are 
automatically included when you export content with related documents. On import, you have 
the option to overwrite existing content. If you choose to overwrite existing content on import, 
the style sheet in the Library is overwritten with the version in the import file. 
 

Note: Packages with custom images that link to bulleted styles in a style sheet are also 
included in the export/import process. If you import with the overwrite existing content 

option, the imported package overwrites the current version in the Library.  
 

Tip: It is a good idea to create a backup of your style sheet and any image packages linked to 
the style sheet in case they are accidentally overwritten. 
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 Multi-user Considerations 

 You can save a style sheet to any folder for which you have Modify permission. If this 

style sheet is to be shared by other authors, make sure that you store it in a folder 
that the authors have Modify or Read permission. Authors can link to and publish with 
a style sheet for which they have List permission, but they cannot apply styles from 
that sheet. If you want to lock down the style sheet so that authors can apply styles 
but do not have the ability to modify them, assign the authors Read permission for the 
folder. 

  
Any new document that you create is automatically checked out to you. If you want to 
make a new document available to multiple authors and place the document under the 
Developer's version control system, you must check it in. 
  
Styles sheets linked to content are excluded when you check in/check out or delete 
documents with related documents. You must manually check in a style sheet to make 

it available to other authors or check it out to edit it. See Check In and Check Out 

Documents in the Use the Developer in a Multi-user Environment chapter for more 
information. 
  
Documents under version control must be checked in and you must be working online 
to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 

To create a new style sheet: 

1. On the File menu, point to  New and choose  Style Sheet. 

  
or 

  

On the Library toolbar, choose  Style Sheet. 

  
2. Edit the style sheet to include the styles you want. 

    
3. Save the style sheet. 

  
You can also close the tab and click Yes in response to the Save Document message. 
  
When you save a style sheet for the first time, you are prompted to provide a name 
for it. Enter a name for the style sheet by typing over the default name. Although the 
style sheet name does not have to be unique, it is recommended that you provide a 
meaningful name so you can easily find the style sheet later. 

  
Note: Style sheets are not saved automatically, so you should save your work 
periodically as you add styles to a style sheet. 

10.2 Create Styles 
Style sheets open in the Style Editor. The Style Editor contains the tools to create new styles 
or edit existing ones and the Style Inspector for viewing the source of the formatting for a 
style. See Work with the Style Inspector for more information about using this toolpane. 
  
You add new styles to a style sheet using the Add Style list, which includes all the style 

elements that can be added to the style sheet. The first time you add a style for an element, it 
is created as the default style (except for Text element styles). As you add additional styles of 
the same element, you can select which style is the default. It is important to consider which 
style you assign as the default for an element because the Web Page Editor uses the default 
style when you initially add that element to a web page. 
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The Add Styles list includes the following compound and element styles. Compound styles, 

such as Table and List, cover several elements.   

 List: Format for a bulleted or numbered list. You can create a separate format for 
each list level. 
   

 Table: Format for a table and its elements. 

   

 Text: Character style that applies formatting attributes to a text selection. Character 
formatting includes font, font size and color, bold, italics, underline, and so on. Text 

styles do not include paragraph formatting attributes. 
   

 Address: Italic format commonly used for contact information for the author of the 
document. The style applies to the entire paragraph. 

   

 Block Quote: Left and right indented paragraph format commonly used for quoting 
text from another source. The style apples to the entire paragraph. 

   

 Document Body: Defines the body of the document by controlling its overall 
appearance. 
   

 Heading 1 - Heading 6: Formats for a hierarchy of text headings. Heading styles use 

the Document font, but adjust the size for each level by using a percentage of 
Document font size. 
   

 Horizontal Line: Lines used to divide sections of a document. 

   

 Image: Formatting for images inserted into web pages. 

   

 Link: Formatting for the link text in a document that opens a target destination such 
as another web page or URL. 
   

 Paragraph: Defines the font, alignment, and spacing for paragraphs. 
   

 Preformatted: Commonly used for including sections of ASCII text. The style applies 

a fixed width font that preserves the spaces and line breaks. The font size is inherited 
from the Document font. The style applies to the entire paragraph, however, the 
paragraph text in a Preformatted style does not wrap. 

Note: See Format Styles for more information about creating styles for specific elements. 
  
Styles appear in a style sheet with the following components: 

 Style Headers: Each style displays the style name in a bordered header. When you 

select a style for editing, the header background turns blue. Only one style can be 
selected and edited at a time. The header displays the style name on the left, which is 

editable, and the element name on the right, which is not editable. Bold header text 
indicates a default style. A style can contain multiple language variations and one print 
style for each language. Adding a print style lets you produce a Player and document 
output with different formatting. For example, you may want to use different font sizes 
for online and print presentation. See Add Print and Language Variations for 

information about adding these options to a style. 
   

 Style Name: New styles appear with the <Enter style name here> placeholder text in 
the style header. You edit this text to name the style. If you do not enter another 

name, the Style Editor assigns a name based on the style element with an incremental 
number appended (such as Paragraph 1); however you can change a style name. 
There are no limitations on naming the style, but you should assign a name that is 
descriptive. In addition, style names must be unique. If you enter a duplicate name in 
the same style sheet, you are prompted to enter a unique name. 
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Warning! You should not change the name of a style once the style is assigned to an 

element in a web page. Changing the style name breaks the link to the style, causing 
the Web Page Editor to list the style as "Unknown style" in the Styles list. Breaking the 

link to the style removes the formatting for all web page elements to which the 
renamed style is applied and applies the default style or browser settings instead. If 
you create another style with the same name and style type in the same style sheet, 
web page elements tagged with the former style now use the formatting of the new 
style. 
   

 Default Style Indicator: If you have multiple styles of the same element type, you 

can set one as the default. A default style is indicated by a bold style name and a 

[default ] label and icon in the style header. The default style for an element is 

automatically applied when you add that element type to the Web Page Editor. 
However, after adding the element, you can apply another non-default style of the 
same element type. For example, a style sheet contains three bulleted list styles, with 
one marked as the default. When you create a bulleted list in a web page, the default 

style is automatically applied to the new list. After the bulleted list element is added to 
the web page, you can apply one of the other bulleted styles to the list. 
   
Only one style can be assigned as the default for an element. Assigning another style 
as the default removes the default setting from the original style. When you reassign 
the default style, all web pages using the previous default style for that element now 
use the settings of the new default style. Note that you do not have to set a default 

style for an element type. If there is no default for an element type, the Web Page 
Editor uses the browser formatting defaults for that element. You can then apply a 
non-default style or manually apply direct formatting to change the format of the 
element. 
  
Note: There can be only one document body style in a style sheet, so the default 
option is not available for this style. Furthermore, you cannot set a default for a text 

style. 
   

 Preview Pane: Each style includes a preview pane under the style header that 
displays sample text with the style properties applied. The preview reflects any 

changes made to the style, either manually or by inheritance. The preview itself is not 
directly editable. Lines of silver text appear above and below the preview text to 
indicate spacing and padding around the style content. 
  
Since the document body style controls the appearance and margins for the entire 
document, the preview does not show lines of text above and below the sample text 
for this style. 

Expand and Collapse Styles 

Collapsing and expanding styles hides the preview and any print and language variations, 
reducing the style to display the header only. Hiding style details makes it easier to find and 
work with styles. You can use the icons in the style headers to collapse and expand an 

individual style or use the icons in the toolbar to collapse and expand all styles in the style 
sheet. Collapsing all styles reduces the view to style headers only, hiding the previews and all 
print and language variations. 
  

Note: The Standard style sheet initially opens showing style headers expanded to display the 
preview pane and all print and language variations collapsed. 
  

Style Order 

Styles are grouped by element in the style sheet, and then alphabetically ordered by style 

name within each type. The order of the style elements is fixed by expected usage, with the 
exception of the document body style, which is listed first because of style inheritance. You 
cannot reorder the style elements. The fixed order is: 
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1. Document Body 

2. Paragraph 

3. Text 
4. Table 
5. Bulleted List 
6. Numbered List 
7. Heading 1 to Heading 6 

8. Image 
9. Link 
10. Horizontal Line 
11. Preformatted 
12. Address 
13. Block Quote 

To create a new style: 

1. From the Style Editor - Styles toolbar, click  Add Style and select the style you 

want to create. 
   

2. Type a name for the new style, replacing the <Enter style name here> placeholder 
text. 

To set or remove a style as the default: 

1. Select the style that you want to set or remove as the default style. 

  
2. To set a style as the default for the style type, click the element name on the right 

side of the header. To remove the default setting from the style, click the element 

name or [default ] label on the right side of the header. 

  

or 
  

Select the style and click  Make Default on the Style Editor - Styles toolbar to set 
or remove the default setting for a style. 

To rename a style: 

1. Select the style that you want to rename. 

  
2. In the header, click in the style name, edit the name, and press ENTER. 

To collapse and expand styles: 

1. Click  in the header of a main, print, or language style that you want to collapse. 
  

2. Click  in the header of a main, print, or language style that you want to expand. 

    
3. Click  Collapse All in the toolbar to collapse all styles to style headers. 

   
4. Click  Expand All in the toolbar to expand all styles. 

10.2.1 Style Inheritance 

Styles are applied from the top down where the lowest setting takes precedence over 
everything above it. Initially, the browser defaults control the appearance of the content in a 
web page. These defaults are overwritten by the styles you create, and finally direct web page 

formatting overwrites everything else (as long as the browser understands that markup). 
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Until you make a change, most new styles start by inheriting attributes from the browser 

defaults and the document body style, which is created with every new style sheet. For 
example, you set the document body style to use a Verdana 12 point font and then add a 
bulleted list style; the new style inherits the Verdana 12 point font.  

  
Some styles inherit specific attributes only, such as the font, while the other attributes may be 
determined by another style or the browser defaults. For example, heading styles inherit the 
font from the document body style, but the font size of the style adjusts for the heading level, 
as determined by the browser defaults.   
  

Changing the document body style also changes other styles that are directly dependent upon 
it. If you change an attribute for a style that inherits its setting from the document body style, 
you break the inheritance for that attribute. Therefore, if you set a specific font for a heading 
style, that font is preserved even when you change the document body font. 
  
Default styles for an element also pass their attributes to non-default styles of the same 
element. If your default paragraph style uses 6 points of spacing above and below the 

paragraph, new paragraph styles inherit that setting. 
  
Note: Lists have special inheritance rules for their bullets and numbering styles. See Format 
List Styles for more information about inheritance for List styles. 
  
Style inheritance also affects compound styles where a main element controls the formatting 
for other elements within the style. While bulleted and numbered lists inherit many of their 

settings from the document body style, lower levels inherit their settings from the level 
directly above. So if you change the formatting attributes for Level 1, the remaining levels 
inherit those attributes; however, you can break the inheritance by changing the formatting 
for an individual level.  
  
Attributes that are not inherited from another style are usually inherited from the browser 

defaults. Attribute settings inherited from the browser may be based on a percentage of the 
attribute settings for the document body style rather than absolute values, as is the case with 

heading level styles.  
  
Note that the Style Editor controls (icons and dialog boxes) for the inherited attributes of a 
dependent style do not appear as selected, and may even appear blank. For instance, when 
you select the document body style, you can view the assigned font in the Font Family field. 

However, when you select a paragraph style whose font you have not changed, the Font 
Family field is blank because that attribute is inherited from the document body. If you break 
the inheritance by manually changing an inherited attribute, that attribute setting appears for 
the style. 
  
Tip: Use the Style Inspector to view the attributes directly applied to a style and those 
inherited from other styles and the browser. See Work with the Style Inspector in this chapter 

for more information. 
  

Restore Inheritance   

You can restore inheritance to a style whose attributes you have manually changed. The 
method to remove an attribute to restore inheritance depends on the control that applied the 
attribute. 

 Attributes applied with icons that toggle on and off (Bold, Italic): remove by clicking 
the icon again to disable the attribute. 
   

 Attributes selected from lists (Font Family, Font Size): remove by selecting the blank 

entry at the top of the list. 
   

 Color attributes (Text Color, Background Color): remove by selecting No Color from 
the Color dialog box. 
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 Sizing and spacing attributes (Spacing, Padding, Border, Width and Height): reset by 
deleting the values from the fields. 

Note: Other factors may intercede in this inheritance process. For example, some servers may 
have a front-end application that reads your published HTML and applies its own style sheet 
first. If you also use a Developer style sheet and use direct formatting in your web pages, then 
the order would be: first, your browser has defaults for how to display web page, then 
anything between the browser and the web server may inject contents to override that, then 

the site may do so, then the front-end application, then the Developer style sheet, then the 
local web page markup overrides anything else, and lastly, the user can also set their browser 
to completely ignore all these things and instead use their own styles. 

10.2.2 Add Print and Language Variations 

Print and language style variations can be added to a parent style so that you can assign 
substitute attributes, such as a different font, for publishing a print output or for content 
localized in another language.  

  

Each print and language variation is added with its own header under the parent style. For 
each parent style, you can create one print style and multiple language style variations, and 
one print style for each language variation. Print and language variations are automatically 
given names that cannot be changed. The print style is named "print" and each language 
variation uses the language name from the Add Language list. 
  

Print Styles 

Authors use print styles to create a different look in the printed document output than the 
onscreen output. Most typically, authors select another font and font size for print output and 
remove or change color attributes if they are printing the contents in black and white or 
grayscale. For example, you have a text style that formats white text on a dark blue 
background. For print output, you create a print style that retains the white text color from the 

current style but uses a gray background. 
  
The document body style in the Standard style sheet includes a pre-defined print style that 

uses a different font. Since many other styles in the Standard style sheet inherit the font 
attributes of the document body style, the print output for all other styles (paragraphs, tables, 
lists, and so on) uses the font from the document body print style.  
  

Note: In the Web Page Editor, you can switch between Player and Print views to view the 
style attributes for both deployments. 
  
In addition to adding a print style to a parent style, you can add one print style to each 
language variation for a style. Each print style for a language is added with its own header. 
  

Language Variations 

All new styles are created as language neutral. This means that the same style is used for all 
languages. If you are localizing content for other languages, you may need to use another font 
to display the text correctly in the localized language. You can add one or more languages to 
each style and then apply separate formatting for each language variation. If you change the 

language property for a web page, the corresponding language variation for the style is 

detected and automatically applied. For example, you have a paragraph style that uses the 
Courier New, Courier, monospace font family with a red text color and 12 pixels of above and 
below spacing applied. You create a Japanese variation and apply a font more suited to 
Japanese; however, the language style still inherits the red text color and paragraph spacing 
as you did not change those attributes for the language variation. 
  
The document body and heading styles in the Standard style sheet include pre-defined 

language variations for languages that need specific fonts. Each language variation uses a font 
family to correctly display the text. 
  

Style Inheritance 

When you create a print or language variation for a style, the Style Editor creates a copy of 
the parent style, applying the same attributes specifically set in the parent style and inheriting 
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the same attributes from a default element style, the document body style, and the browser. 
Print and language variations for default element and document body styles pass their 

attributes to the variations in dependent styles. For example, you create print styles for the 
document body style and the default paragraph style. You specify a font for the document 

body print style and change the paragraph spacing for the default paragraph style. You then 
create a print style for a non-default paragraph style that applies italics only. The print style 
includes the directly applied italics, and inherits the font from the document body print style 
and the paragraph spacing from the default paragraph style.  
 

Note: Use the Style Inspector to trace the source of the formatting for a print or language 
variation. 
 

You do not need to specify a print or language style variation for every style. Styles with no 
separate print or language styles can inherit those settings from another style. If there is no 
print or language variation for a style, the browser applies formatting by first searching the 
document body style for a print or corresponding language variation, and then searching for a 
default style of the same element for a print or corresponding language variation, which 
overwrites the document body settings. Finally, attributes not specified in any print and 

language variations are inherited from the parent style itself or from the browser; for 

example, if there are no print styles set, or the print styles do not specify a separate font, the 
browser uses the font from the onscreen style. 
 

If you add print and language variations to styles other than the document body style, an 
order of inheritance is followed.  

 Default styles: Variations for default styles inherit the attributes specified for the print 
and language variations in the document body style. If the attribute is not specified in 

the document body style, it is then inherited from the parent style. All other non-
specified attributes, such as paragraph spacing or bullet image, are inherited from the 
parent style. However, you may want to create a print variation for the default 
paragraph style that sets specific paragraph spacing for print output. 
   

 Non-default styles: When you add print and language styles to a non-default style, the 

styles first inherit the settings specified for the print and language styles in the default 
style for that element. If the default style does not set specific attributes, then the 
non-default style uses the settings from the print and language styles in the document 
body style.  

If you only want to specify a different font for print and language variations, then you only 
need to create those variations for the document body style. Consider the following example: 
a style sheet contains a document body style with a Verdana 11 point font and a print style set 

to a Courier 12 point font. The style sheet also contains a non-default paragraph style 
formatted to use a 10 point font with one inch left and right indents. In the print output, text 
using the non-default paragraph style appears in the Courier font specified in the document 
body print style, but with the 10 point font size and one inch indents directly specified in the 
style. 
 

To add a print style: 

1. Select the style or language variation of a style to which you want to add a print style. 

  

2. From the Style Editor - Styles toolbar, click  Add Print Style. 

To add a language variation: 

1. Select the style to which you want to add one or more languages. 

  

2. From the Style Editor - Styles toolbar, click  Add Language. 
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3. Select the language(s) you want to add. 

  
4. Click OK. 

To format a print style or language variation: 

1. Select the print style or language variation that you want to format. 
  

2. Use the Style Editor toolbars to apply the desired formatting. 

10.3 Use Style Editor Tools 
The Style Editor provides several toolbars of icons and controls for creating and editing styles. 
In most cases, you need to use more than one toolbar to achieve the formatting you desire. A 
style can be edited only when it is selected, and you can select only a single style at a time. 

 Style Editor - Styles: Options for adding and deleting styles, assigning a style as a 
default, and adding print and language variations to styles. 
  

 Style Editor - Table and List: Options for selecting table elements to format and list 

options for applying bullet images and number formats for selected list levels. 
   

 Style Editor - Text/Paragraph: Options for formatting the font, text and 

background color, horizontal alignment, spacing, border, width and height, and 
padding elements of the selected style. 

If you apply a format that produces undesirable results, you can undo changes that you made 
in the Style Editor. 
  
Note: New styles automatically inherit formatting attributes from the document body style, 
other default styles, or from the browser defaults. Manually applying another format for an 

inherited attribute breaks the inheritance. You can restore the inheritance by removing the 
applied attribute. See Style Inheritance for more information about restoring inherited 
attributes. 
  

To format a style: 

1. Select the style you want to format. 

  
2. Use the Style Editor toolbars to apply the desired formatting for the style, and each 

print and language variation. 

10.3.1 Styles - Format Text 

You can apply text formatting to all styles that contain text using the tools on the Style Editor-
Text/Paragraph toolbar. 

  

Depending on the type of style you are formatting, text settings may affect the entire web 
page, an entire paragraph, or a text selection. In addition, you can use text settings to control 
the text for elements within a style, such as table headers, cells, and captions, and the text for 
the individual levels in a bulleted or numbered list. 
  
When creating a style for text, you should think about the scope of the text that is affected by 
the style. For example, you want to create a style that italicizes text. You would create a 

Paragraph style if you wanted to italicize all of the text in the entire paragraph, or you would 
create a Text style if you wanted to italicize selected characters or words only. You would 
probably not want to apply italics to the document body style as that would affect all of the 
text in the entire web page. 
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Set Text Fonts 

The following options control the fonts for a style or style element: 

 Font Family: The Font Family list includes a group of predefined font families followed 

by all system fonts installed on the local computer. 
  
A font family is a set of multiple fonts with similar characteristics, grouped together. 
For instance, Arial and Helvetica are grouped in the same font family because they are 
both sans serif fonts. Times New Roman and Times are grouped because they are serif 
fonts, and Courier New and Courier are grouped because they are monospace fonts. 

Font families may also be prioritized. Prioritized fonts are known as font stacks. A web 
browser can only apply fonts that exist on the local system. If the first font in a font 
family is not available, the browser goes through the fonts in the family until it finds 
one that is installed. 
  
If you know a font is available on the machines where the content is viewed, simply 
select it from the list; for example, if your organization has Arial installed, by default, 

on all machines. However, where you are not sure what fonts are installed, it is 
preferable to select a font family. This helps ensure the content displays properly. 
  

 Font Size: Sets the font size for the style text. You can enter a numeric value or 

choose from the list of predefined font sizes (7, 8, 9, 10, 11, 12, 14, 16, 18, 20, 24, 
32, 36, 48, 72) or font size keywords; xx-small, x-small, small, medium, large, x-
large, xx-large, and Inherit. The Inherit option results in a font size inherited from the 
document body style. 
  
Note: The size of the keywords are based on font sizes that are scaled to 
approximately 1.2 of the medium size as interpreted by the browser. Also note that 

the keyword sizes for fonts in a document (print) output are not identical to the 
browser sizes. Microsoft Word uses a slightly different interpretation when scaling 
keywords. 
   

 Font Unit: Unit associated with the value in the Font Size field. You can choose points 
(the default) or pixels. 

Set Character Format 
The character format icons are typically used in text styles for applying a format to a selection 
only, such as characters and words in paragraphs, headings, table cells, and bulleted and 
numbered lists. 

  Bold: Bolds the selected text. 

   

  Italic: Italicizes the selected text. 

   

  Underline: Underlines the selected text. If the selected text includes multiple 
words, the space between the words is also underlined. 

   

  Strikethrough: Applies strikethrough to the selected text. If the selected text 
includes multiple words, the space between the words is also struck through. 

10.3.2 Styles - Use Colors 

The color icons are used to control the color of the text, text background for paragraphs and 
table cells, and the background color of the entire web page. The color icons open the 
standard Color dialog box for selecting colors. The No Color option removes the applied color 

and resets the color to the default. See Select a Color in the Web Page Defaults section of the 
Get Started using the Developer chapter for more information on the Color dialog box. 
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  Text Color: Changes the color of the text in the style. 
  

  Background Color: Changes the background color of text. The scope of the 

affected background depends on the type of style or style component to which the tool 
is applied. This tool changes the background color for the following: the entire page for 
the document body style, an entire paragraph for paragraph, list, heading, address, 
block quote, and preformatted styles, selected text for text and link styles, all or 
specific table cells and rows in a table style, and the line color in a horizontal line style. 

To set the page background color: 

1. Select the document body style. 

  

2. On the Style Editor - Text/Paragraph toolbar, click  Background Color. 

  
3. Select the desired color. 

  
4. Click OK. 

To set the text color or text background color: 

1. Select the style to which you want to add color. 

  
For table and list styles, also select the element you want to format from the Apply to 
or List level lists on the Style Editor - Tables and Lists toolbar. 

  

2. On the Style Editor - Text/Paragraph toolbar, click  Text Color or  Background 
Color. 

  
3. Select the desired color. 

  
4. Click OK. 

To remove an applied color: 

1. Select the style from which you want to remove color. 

   
2. For tables and lists, select the element whose color you want to remove. 

   

3. On the Style Editor - Text/Paragraph toolbar, click  Text Color or  Background 

Color. 
   

4. Select No Color. 
   

5. Click OK. 

10.3.3 Styles - Alignment, Spacing, and Sizing 

You can use the tools on the Style Editor - Text/Paragraph toolbar to define attributes such as 
alignment, spacing, padding, and line and border settings for paragraphs, lists, tables, images, 

and lines. 
  
The alignment options determine the horizontal position of text and images. Clicking an icon 
for an alignment applied to a style removes the formatting and returns the alignment to the 
default setting. Alignment options are available for Address, Block Quote, Bulleted/Numbered 
List, Document Body, Headings, Image (left and right only), Preformatted, and Table (all 
elements) styles. 
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  Align Left: Aligns a paragraph or image with the left margin. When a paragraph is 

left aligned, the text is uneven on the right side. This is usually the default text 

alignment setting for the languages with left to right direction. When an image is left 
aligned, the text wraps around the right side of the image. 
   

  Align Center: Symmetrically aligns a paragraph along the vertical axis and the 

text is uneven on the both sides. This setting is often used in titles or table cells. 
   

  Align Right: Aligns a paragraph or image with the right margin. When a 

paragraph is right aligned, the text is uneven on the left side. When an image is right 
aligned, the text wraps around the left side of the image. 
   

  Align Justify: Aligns a paragraph with both left and right margin; the text is not 

uneven on either side. Flexible spacing between letters and words stretch or contract 
to fill each line.   

The following tools may be available for different style types to apply attributes for 
paragraphs, lines, images, table elements, and so on. 

  Spacing: Opens the Spacing dialog box to set the spacing around paragraphs, list 

items, headings, images, and table elements. You can set values in points (default 
unit) or pixels for the Before, After, Indentation Left, and Indentation Right fields. To 
apply the same value to all sides, select the Use Same for All option and enter a 
spacing value and unit.   
  

Available for Address, Block Quote, Bulleted/Numbered List, Document Body, Heading, 
Horizontal Line, Image, Paragraph, Preformatted, and Table (table position and 
caption) styles. 
   

  Border: Opens the Border dialog box with options to set the border width in pixels 

(default unit) or points and select a border color. A border color preview displays the 

selected color. You can use the Border tool to change the line attributes for tables and 
horizontal lines or create a border around paragraphs and images. 
  
Note: If you create a border around a paragraph or image, you may want to use 

padding to create additional spacing between the text and the border lines. 
  
Available for Address, Block Quote, Heading, Image, Link, Paragraph, Preformatted, 
Table (whole table, headers, rows, and cell elements), and Text styles. 
    

  Width and Height: Opens the Width and Height dialog box with options to set the 

width and height and select a unit of measurement for each value. You must enter 
whole numbers for the width and height settings. The unit settings for width and 
height include points, pixels (default unit), and percentage. The percentage unit 

automatically resizes the width of the element to fit a percentage of the screen. A 
percentage of 100 uses the entire horizontal space. 

   
Available for Horizontal Line and Table (position element) styles. 
   

  Padding: Opens the Padding dialog box with options for setting the Top, Bottom, 

Left, and Right padding values in points (default unit) or pixels for each side. To apply 
the same value to all sides, select the Use Same for All option and enter a padding 
value and unit. When used in a style that includes borders, padding applies to the 

spacing between the text and the border lines. 
   
Available for Address, Block Quote, Bulleted/Numbered List, Document Body, Heading, 
Image, Paragraph, Preformatted, and Table (caption, headers, rows, cell elements) 
styles. 
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10.3.4 Work with the Style Inspector 

The Style Inspector toolpane opens by default in the Style Editor. The purpose of the Style 

Inspector in the Style Editor is to show all of the attributes controlling a selected style and 
identify the source or origin of those attributes; including those directly applied to the style, 
those inherited from a parent style, and those inherited from the browser. 
  
When you create a new style, or select an existing one, the controls (toolbars and dialog 
boxes) in the Style Editor only show formatting attributes that are directly applied to the style. 

Formatting attributes inherited from the document body style, a default style or style element, 
or from the browser do not appear in the Style Editor controls, which makes it difficult to 
identify the attributes that control a style and change them. Therefore, if a non-default 
paragraph style inherits 6 points of spacing before and after the paragraph from the default 
paragraph style, those values do not appear in the Spacing dialog box for the non-default 
style. 
  

Note: Colors appear in the Style Inspector with a color preview and their RGB values (black = 
0, 0, 0 and so on). 

  
Since attributes from a default style or the browser do not appear in the toolbar controls, you 
may not know the source of the attributes affecting a style, nor how to remove or modify 
them. The Style Inspector shows the attributes by source so that you can make appropriate 
changes.  

  
Note: Some attributes may appear in the Style Inspector that are not directly changeable. 
These are attributes that are built into the style sheet itself. For example, the default browser 
border style for a table is a double line style, but the style sheet attributes are set to create 
table styles with a single solid line style. 
  

The Style Inspector toolpane is divided into the following categories: 

 Selected: <element>: This category displays the style element name (for example 
Paragraph, Text, Table) and the attributes directly applied to the style. 

   

 Inherited from Default Document Body: This category displays the document body 

style name and the attributes inherited from this style. Note that the Style Inspector 
does not display document body attributes that are overwritten by another style. 
   

 Inherited from Default <element>: This category appears if the selected style 

inherits attributes from a default style, such as a default paragraph or bulleted list 
style. 
   

 Inherited from browser defaults: New styles inherit many of their attributes from 

the browser defaults until you break that inheritance by directly changing an attribute 
in the style or its parent. This category displays the browser attributes that are still 
affecting the style. 

The toolpane is dynamic and the reported attributes change as you select other styles or in 

the case of complex styles such as tables, other elements of the style. The Style Inspector is 
read only; you cannot make changes to it.  
  
Note: The Style Inspector also appears in the Web Page Editor to help you distinguish 

between formatting that results from a style as opposed to directly applied formatting. See 
Use the Style Inspector in the Format Content with Styles section of the Enhance Content with 
Web Pages chapter for more information about using the Style Inspector in a web page. 

10.4 Format Styles 
After adding a style to the style sheet, you use the tools in the Style Editor to format the 
attributes for the style. The attributes that are available for change depend on the style type. 
Font attributes are available for styles that affect text, but are not available for graphics, such 

as image and horizontal line styles. Styles initially inherit their attributes from the browser, 
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the document body style, and a default style of the same element. You can assign your own 
values for inherited and browser-dependent attributes; however, be aware that modifying 

these settings either breaks the inheritance or replaces the default settings for the browser. 
See Style Inheritance for more information about inheriting element attributes. 

  
When you create a new style for elements, such as paragraphs, headings, tables, lists, 
images, and so on, most of the initial formatting attributes in the toolbars appear blank or not 
selected; this is because these attributes are either inherited from another style or are 
browser-dependent settings. Browser-dependent settings have no specific values assigned as 
they vary between browsers. For example, the following occurs when you add a new heading 
1 style:  

 The Font Family list box in the toolbar is blank because that attribute is inherited from 
the document body style (or from the browser's body element if no document body 
style is defined). 
   

 The Font Size list box in the toolbar is blank because each browser interprets the font 

size for heading 1 text as a certain percentage of the document body style; for 
example, many browsers use a 200% font size for text tagged as a heading 1 
element. 
   

 The Before and After fields in the Spacing dialog box are blank because those values 

vary depending on the browser. 
   

 The Bold attribute in the toolbar is the only attribute that is selected. 

Note: You can use the Style Inspector toolpane to view the source of the formatting for a 

selected style. 

10.4.1 Format the Document Body Style 

The document body style affects the entire web page document by controlling much of its 

overall appearance. Most other styles inherit the font attributes from the document body style, 
unless you customize those styles. Setting the font family and font size for the document body 
style means that all new and existing web pages linked to this style sheet use the specified 
font. Other document body attributes include setting the background color for the entire web 
page. Furthermore, the options in the Spacing dialog box control the page margins. The 

Before and After fields control the top and bottom margins of the page, while the Indentation 
Left and Indentation Right fields apply indents that affect the paragraph style and all other 
paragraph-based styles such as headings, bullet lists, numbered lists, and so on. 
  
The default alignment for the document body style is left aligned, but you can select another 
alignment such as Align Justify. Note that the selected alignment applies to all web pages 

linked to the style sheet. Formatting that centers or right aligns text is probably better suited 
to paragraph styles. 
  
Note: Since there can be only one document body style in a style sheet, the Make Default 
option is not available for this style. 

10.4.2 Format Paragraph Styles 

When you apply a paragraph style, it affects all of the text in the paragraph. You do not have 
to select the text in the paragraph to apply a paragraph style; you only need to place your 

cursor in the paragraph and apply the style. The style applies all paragraph and character 
attributes to the entire paragraph. 
  
New paragraph styles initially inherit the attributes of the browser and the document body 
style. The first paragraph style added to a new style sheet is marked as the default for the 
type. Paragraph settings include font, alignment, spacing, padding, and border attributes. See 
Use Style Editor Tools for more information about formatting a paragraph style. 
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Tip: If you are applying a style sheet to a web page that was created using content defaults, 

you may encounter unwanted spaces between paragraphs because the web page contains 

manually entered hard returns to separate the paragraphs and the default paragraph style 
includes spacing above and below paragraphs to create the separation. You can either remove 
the extra hard returns in the web page or remove the spacing in the paragraph style by 
setting a 0 value for spacing above and below the paragraph. 
  

Authors often create several paragraph styles in their style sheets, one default paragraph style 
for the main body of their documents and several other styles with different formatting. For 
example, a paragraph style font inherits an Arial font from the document body style, but you 
want to create another style that uses a Courier New font in a blue font color to visually 
differentiate the content when viewed in the Player. 
  
There are other styles that also affect the text in an entire paragraph. They include the 

heading level styles Heading 1 to Heading 6, Address, Preformatted, and Block Quote. These 
paragraph-based styles also inherit some formatting attributes from the document body style 
and browser defined defaults. For example, heading styles inherit the document font from the 

document body style, but with an adjusted font size inherited from the browser defaults, while 
preformatted styles inherit the document font size, but not the font. 
  
Note: In the Web Page Editor, you create heading levels, preformatted, and address 

paragraphs using the Format list and the Block Quote icon to create block quote paragraphs. 
These controls insert the paragraphs using the default style if one is set in the style sheet or 
the default formatting for the browser. After creating the paragraph in the web page, you can 
use the Styles list to change to another style if others exist for that paragraph type. 

10.4.3 Format Text Styles 

Text styles, also known as character styles, apply attributes to selected text. Text style 
attributes include font, font size and units, text color, background color, bold, italics, 

underline, strikethrough, and border (width and color). For each text style, you can add a print 
style and multiple language variations.  
  

Text styles apply additional formatting within elements, such as paragraphs, headings, tables, 
or lists. Since those elements have their own formatting, the text styles only change the 
specified attributes for the selected text. Therefore, if you apply a text style with a red text 
color attribute to selected text using a paragraph style formatted for an Arial 16 point, bold 

font, only the text color changes for the selected text. The paragraph has its own style that 
controls the entire element, and the text style formats only the specified attributes for the 
selected text. For this reason, you cannot set a default text style. 

10.4.4 Format Heading Styles 

You can use a hierarchy of heading levels to organize the contents of a document. There are 
six levels of headings that you can add to the style sheet. Heading 1, using the largest font, is 
the most important and Heading 6, using the smallest font, is the least important. Each level 
in the hierarchy can be assigned different formatting by modifying the font, font size, 

character styles, and spacing of the heading style.  
  

Heading styles are based on font sizes relative to the document body style font size. The 
relative sizes are: 

 Heading 1: 200% 

 Heading 2: 150% 

 Heading 3: 117% 

 Heading 4: 100% 

 Heading 5: 83% 

 Heading 6: 75% 

Relative font percentages are not uniform across browsers, and therefore, may be rendered 
differently. To overcome this problem, you can set a specific font size for headings, but they 
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do not adjust in size if you change the document body font size. Note that if relative font 
sizing produces an unreadable size font for heading levels 5 and 6, you may want to specify a 

larger size for those levels or have the levels inherit their size from level 4. 
  

The Web Page Editor automatically applies the attributes of the default heading style when a 
heading element of the same level is added to the web page. To apply a non-default heading 
style, you must add the heading element to the web page and then apply the style from the 
Styles list. See Use Styles in a Web Page in this chapter and Use the Format List in the Format 
a Paragraph section of the Enhance Content with Web Pages chapter for more information 
about using heading styles in a web page. 

10.4.5 Format Table Styles 

A table style is a compound style made up a many elements. You can apply a single format for 

the entire table or format certain elements for a different appearance.  
  
After creating a table style, you can select and format each table element by first selecting the 
element name from the Apply To list in the Style Editor - Table and List toolbar and then 

applying the desired formatting attributes from the other toolbars. The sample in the table 
style preview displays your formatting choices. To use the same attributes for all table 

elements, format the Whole Table and Table Position elements only, as the other elements 
inherit those settings. Note that setting an attribute for some table elements overwrites the 
same attribute setting in another element. 
  
Table Position: Select this element to set the horizontal position on the web page, the 
spacing around the table and the minimum size of the table. 

 Horizontal Alignment: Select a left (default), center, or right horizontal placement of 

the table on the web page. Setting a Left or Right alignment for a table allows you to 
wrap adjacent text around a table. 
   

 Spacing: Set the spacing above and below the table. You can also set a left and right 

indent from the page margins for tables that are left and right aligned. To use the 

same setting for all sides, select the Use Same for All option and enter a value and 
unit for the first side. 
   

 Width and Height: Sets the minimum size (width and height) for the table. 

Whole Table: This element affects all of the text in all cells in the table and the table caption. 

 Vertical Alignment: Select a vertical alignment for cell text from the Style Editor - 
Table and List toolbar. Align Middle is the default setting. 
  

Align Top: Aligns the text in the selected table element with the top of the cell. 

  

Align Middle: Aligns the text in the selected table element with the middle of the 

cell. 

  

Align Bottom: Aligns the text in the selected table element with the bottom of the 

cell. 
  

 Align Baseline: Aligns the text in the selected table element with the baseline of 

the cell. This is the default vertical alignment setting for tables. 
  

 Font Attributes: These attributes affect the text in all cells, including the caption, 
unless overwritten by other table elements. Attributes include font family, size and 

unit, and character formats (such as bold, italics, and text color). 
   

 Background Color: Sets the text background color for all table cells. 
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 Horizontal Alignment: Sets the horizontal alignment of text in the cells in the body of 

the table. This setting does not affect header cells. 

   

 Border: Formats the border around the table; border width (line thickness), unit, and 

color. Select the Apply to All Table Elements option to apply the border setting to all 
exterior and interior border lines. 
  
The display of table and cell borders is controlled by several elements. The Whole 
Table element controls the border lines around the table; the Header element controls 

the cell borders for the top Header Column row and the left Header Row column; and 
the Cell element controls the interior border lines for all table cells except headers. 
Where there are overlapping lines of the same width, the Cell element overrides the 
adjoining Whole Table outside border and the Header element overrides the adjoining 
Cell and Whole Table border. If you set separate line colors of the same width for Cell, 
Header, and Whole Table, the Whole Table setting is overwritten by the other 
elements. However, a larger width setting changes the priority of border settings; in 

other words, the thicker line wins. In the example where all borders are set for 

different colors at the same line width, you can force the appearance of the border 
around the table in its designated color by increasing the line width for the Whole 
Table element. 
  
A border width of 0 removes the border for the element. 

  
Tip: To create a table style with no exterior or interior borders, change the border 
width for the Whole Table element to 0 and select the Apply to All Table Elements 
option. If necessary, delete the border width values and select No Color as the border 
color for the other elements. 
  
Note: Table borders may look different in print output. Microsoft Word may not 

interpret the border settings of the style as they appear in the web page. You can 
check table appearance in print by previewing the web page in a document style that 
includes web pages, such as a System Process or Training Guide. 

Table Caption: Use this element to format the text and horizontal alignment for the caption.   

 Caption position: Sets the caption position to appear above or below the table using 

 Caption Bottom or  Caption Top on the Style Editor - Table and List toolbar. 

   

 Font Attributes: Attributes include font family, size and unit, and character formats 
(such as bold, italics, and text color). 

   

 Background Color: Creates a background color behind the caption that extends the 
width of the table. 
   

 Horizontal Alignment: Sets the horizontal alignment of caption text. Align Center is the 
default setting. 
   

 Spacing: Sets the spacing around the caption. Depending on the caption position, use 

the Before or After settings to create more spacing between the caption and the table. 
The Left and Right Indentation settings are mainly used to indent left or right aligned 
captions. 

Header: Use this element to apply the same format to text and borders for both the Header 
Row and Header Column elements at the same time. This setting affects the cells in the 
heading rows and columns only. 

  
Note: Header formatting is not applied to a table if the Header option for the table in the web 
page is set to None in Table Properties. 
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 Vertical alignment: Select a vertical alignment for the text. Align Middle is the default 

setting. 

   

 Font Attributes: Attributes include font family, size and unit, and character formats 
(such as bold, italics, and text color). 

   

 Background Color: Creates a background color for the header cells. 
   

 Horizontal Alignment: Sets the horizontal alignment of text in the header cells. Align 

Center is the default setting. 
   

 Border: Sets the border width and color for header cells. 

   

 Padding: Sets the spacing between the text and the cell borders in header cells. 

Header Row: Use this element to apply a format to the cells in the first column of the table 
only.   
 

Header Row formatting is only applied to a table if either the First Column or Both option for 

Headers is selected for the table in Table Properties in the web page. 
 

Header Column: Use this element to apply a format to the cells in the first row of the table 
only. Formatting includes the font and font size, text color and text (cell) background color, 
character formats, and horizontal text alignment. 
 

Header Column formatting is only applied to a table if either the First Row or Both option for 
Headers is selected for the table in Table Properties in the web page. 
 

Table Rows: Use this element to apply formatting that affects all table rows except for the 

Header Column row.   
 

Note: The Header, Header Row, and Header Column element settings overwrite the Table 
Row, Even Rows, and Odd Rows settings for row and column heading cells. The Cell element 

settings overwrite all Table Row, Even Rows, and Odd Rows settings for non-heading cells. 

 Vertical alignment: Select a vertical alignment for the text. Align Middle is the default 
setting. 

  

 Font Attributes: Attributes include font family, size and unit, and character formats 
(such as bold, italics, and text color). 
  

 Background Color: Creates a background color for the table rows, excluding the 
Header Row. 
  

 Horizontal Alignment: Sets the horizontal alignment of text in the table rows, 

excluding Header cells. A left alignment is the default setting. 
  

 Border: Sets the border width and color. 

  

 Padding: Sets the spacing between the text and the cell borders. 

Even Rows; Odd Rows: Use these elements to apply formatting that affects even or odd 
rows only. For example, you may want to assign separate background colors for odd and even 
rows so that the table data is easier to read. The Border setting is not available for even and 

odd row elements. Even and odd rows inherit the single border setting from the Table Rows 
element. 
 

Note: When you select the Even Row or Odd Row element, a message informs you that 
alternating formats for rows in tables are not supported in Internet Explorer 8 or earlier. If 
your organization uses these browsers, authors and end users do not see the formatting, but 
they do see the table and its data. 
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Cell: This element applies formatting to all cells in the table, excluding the Header Row, 

Header Column, and Table Caption. 

 Vertical alignment: Select a vertical alignment for the text. Align Middle is the default 
setting. 
  

 Font Attributes: Attributes include font family, size and unit, and character formats 

(such as bold, italics, and text color). These settings override Table Row settings. 
  

 Background Color: Creates a background color for cells. This setting overrides Table 

Row settings. 
  

 Horizontal Alignment: Sets the horizontal alignment of text in the table rows. A left 
alignment is the default setting. This setting overrides Table Row settings. 

  

 Border: Sets the border width and color for non-header cells. 

  

 Padding: Sets the spacing between the text and the cell borders in table rows. 

To create a table style: 

1. From the Style Editor - Styles toolbar, click  Add Style and select Table. 
   

2. Type a name for the style, replacing the <Enter style name here> placeholder text. 
   

3. On the Style Editor - Table and List toolbar, select Apply to and choose the table 

element you want to format. 
   

4. For each element, select the formatting attributes you want to apply. 
  

Format the Whole Table element first to apply the same font formatting and cell 
background color to the entire table. To apply the same border style to all elements, 
select the Apply to All Table Elements option in the Border dialog box. 

10.4.6 Format List Styles 

List styles are used to format single level or multilevel bulleted and numbered lists. You can 
create a list style that applies the same format to all list levels or a separate format for each 

level. Multilevel lists often use different formatting to differentiate the list levels, such as font, 
bullet image, number type, and left indent.  
  
Note: In the Web Page Editor, you create multilevel lists using the Increase Indent icon to 
demote a list item and the Decrease Indent icon to promote a list item. The designated list 
level style is applied when you promote or demote the list item. 
  

List items in a style inherit attributes, such as font, font color, and spacing, from the 

document body style and inherit all other settings from the browser defaults. If you change a 
font or spacing attribute for Level 1, the other levels automatically inherit the change, but you 
can apply separate attributes to each level. For example, if you apply a yellow background 
color to Level 2, all subordinate levels inherit the yellow background until you directly format 
the background for those levels as well. 
  

If you set a default list style, new non-default list styles inherit the font, spacing, and padding 
attributes set in the default style. Bullet images and number list types for each level are not 
inherited from a default list style; those are inherited from the browser. You can change these 
attributes in the non-default styles to create different types of lists. See Spacing and Padding 
in List Styles in this page for more information about using these attributes in list styles. 
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Bulleted List Styles 

A bulleted list is an unordered list of summary or important points. Each bulleted item begins 

with a graphic symbol such as a circle, square, or image to call attention to the item. Bulleted 

lists range from single level lists where all items are on the same level to multilevel lists that 
organize subpoints under major points. 
  
The Style Editor supports creating bulleted lists for five levels. After adding the bulleted list 
style to the style sheet, you use the List Level list on the Style Editor - Table and List toolbar 
to select the level you want to format and the List Type list to select a bullet image. You can 
select one of the standard bullet symbols or add a custom image from a package or from your 

computer. List Type options include: 

 Circle (○) 

 Disc (•) 

 Square (■) 

 Inherit 

 None 

 Custom bullets, if added 

If you want to use the same standard or custom bullet image for all levels, select the image 
for Level 1 and choose the "Inherit" List Type option for each additional level. The Inherit 
setting uses the image from the previous level. Then, if you decide to change the bullet, you 
only have to change the image for the first level, and the other levels inherit the change. A 
None setting creates an indented list item with no bullet image. 
  
Standard bullet images automatically adjust in size when you change the font for the bullet 

level, but custom images do not. Therefore, if your style uses a custom bullet image and 
decreasing font sizes for each bullet level, you may want to create the custom image in 
several descending sizes, one for each level. 
  
In addition to the standard bullets, the Standard style sheet includes three custom bullet 
images (star, checkmark, and dash) in three sizes. These custom images are used by the pre-

defined bulleted list styles included in the Standard style sheet. These list styles create three 
levels of bullets, with each level using a custom image in a smaller size and smaller font. 
  
Note: To use the custom bullet images that are embedded in the Standard style sheet in 
another style sheet, copy the style and paste it into the other style sheet. The copied images 
are then embedded in the style sheet and appear when you select the List Type option. See 
Copy Styles for more information about copying styles within a style sheet or to other style 

sheets. 
  

Numbered List Styles 

A numbered list is an ordered list for items that require a numerical order or rank. A 
numbering system is used to start each item in the list. After adding the numbered list style to 
the style sheet, you use the List Level list on the Style Editor - Table and List toolbar to select 

the level you want to format and the List Type list to select a number format for the level. 
Number formats include: 

 Decimal (1, 2, 3, 4...) 

 Lower Roman (i, ii, iii, iv...) 

 Upper Roman (I, II, III, IV...) 

 Lower Alpha (a, b, c, d...) 

 Upper Alpha (A, B, C, D...) 

 Inherit 

 None 

After assigning a number format to Level 1, assign "Inherit" for the other levels if you want to 
continue with the same number format. If you are creating a single level list, you can omit 
assigning a number format to other levels. To create an outline style for a multilevel list, 
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select a different number format for each level. The Standard style sheet includes a multilevel 

numbered list style that you can use, modify, or copy to use as a basis for your own list 

design. 
 

Spacing and Padding in List Styles 

Spacing and padding attributes work differently for default and non-default styles. In a non-
default list style, where no default list style exists, the spacing and padding settings for Level 

1 affect the vertical and horizontal positioning of the entire list in relation to the surrounding 
text or page. The other levels in the list do not inherit the Level 1 spacing and padding 
settings, but use the browser defaults instead. For non-default styles, you must format each 
list level separately if you do not want the browser default settings. 
 

In default list styles, list levels inherit the spacing and padding attributes of the level above 
(parent level). You can set the spacing and padding attributes for Level 1 and all other levels 
inherit these settings. If you have a default list style, the non-default list styles that you create 

inherit these settings. When you remove the default setting from a default list style, the 
dependent non-default list styles no longer use the inherited settings and use the browser 
settings instead. 
 

Consider the following examples and their results: 

 You set a Before spacing attribute of 20 points to Level 1. 
Default list style: Creates 20 points of spacing above every list level. Tip: If you want 

to 20 points of spacing above Level 1 only, but 6 points of spacing between the list 
levels, apply 6 points of Before spacing to Level 2; the other levels inherit the setting 
of the previous level. 
  
Non-default style: Creates 20 points of spacing above Level 1 only. The other list 
levels use the default browser settings. You must set each level separately. 
   

 You set an Indentation Left spacing attribute of 50 points to Level 1. 
Default list style: Add an extra 50 points of spacing to the left of every list level. Tip: If 
you want to 20 points of spacing above Level 1 only, but 6 points of spacing between 

the list levels, apply 6 points of Before spacing to Level 2; the other levels inherit the 

setting of the previous level. 
  
Non-default style: Creates 20 points of spacing above Level 1 only. The other list 
levels use the default browser settings. You must set each level separately. 

Note: Padding is not supported between list levels in Microsoft Word. Use the Spacing 
attribute to include extra space between list levels for published documents or create separate 
print styles for list styles. 
 

To create a bulleted or numbered list style: 

1. From the Style Editor - Styles toolbar, click  Add Style, point to List, and select 

Bulleted List or Numbered List. 

    
2. Type a name for the style, replacing the <Enter style name here> placeholder text. 

    
3. From the Style Editor - Table and List toolbar, click the List level list and select Level 

1. 

    
4. Click the List type list and select a standard or custom bullet image for a bulleted list 

or a number format for a numbered list. 
  
Select None for no bullet image or number format. Select Inherit for Level 1 to 
inherit the browser default bullet or number style. 

    
5. Apply the desired text formatting. 
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6. For each additional level, click the List level list and select a Level #. 
    

7. Click the List type list and select a standard or custom bullet image for a bulleted list 
or a number format for a numbered list, or select Inherit to use the same bullet 

image or number format as the previous level. 
  
Select None for no bullet image or number format. 

10.4.6.1 Create Custom Bullets 

You can add custom bullets to a bulleted list style from a package or from a file on your 
computer. You cannot link or embed a bullet from a URL. 
  

Custom bullet images from packages are linked, which means that you can easily update the 
images in the style sheet by updating the package files. Custom bullet images from your 
computer are embedded, so if there are changes to the image, it must be embedded again. 
  
Note: If you add custom bullet images from a package file, you need to consider where to 

store that package. Packages stored in the System folder are not included as a related 
document for duplication. This means that if you duplicate an outline and include the style 

sheet in the duplication, the package with the linked bullet images is not duplicated and the 
duplicated style sheet links back to the original package. For this reason, you may not want to 
store packages linked to a style sheet in the Style Sheet folder, or in any of the System 
folders. 
  
Style sheets support the following graphic file formats for custom bullets: 

 png 

 jpg 

 gif 

Custom bullet images are added to the bottom section of the List Type list, and remain on the 

list until you delete them. For accessibility purposes, custom bullet images, either linked from 
a package or embedded, should be decorative only since you cannot apply alternative text to 
the image in the style sheet or when it is used in a bulleted style in a web page. 
  
Tip: If you use icons in your documents for notes, tips, and warnings, you can create a 
bulleted style for each icon. For each style, create a single level bulleted list style, add the icon 
as the bullet image, and format the text as desired. You can also add a text background color 

and left indent to the style for additional level formatting. 
  

 Multi-user Considerations 

 Any new document that you create is automatically checked out to you. If you want to 

make a new document available to multiple authors and place the document under the 
Developer's version control system, you must check it in. 
  

You can save a custom bullet package to any folder for which you have Modify 
permission. If this package is to be shared by other authors creating styles or applying 
list styles with custom bullets from a package, make sure that you store the package 

in a folder that the authors have Modify or Read permission. Authors cannot link to a 
package for which they have List permission. 

Delete Custom Bullets 

Embedded bullets remain embedded in the style sheet until they are deleted, even if they are 
no longer referenced in any style. On the other hand, custom bullets linked from packages are 
automatically removed from the List Type when they are no longer referenced in the style 
sheet. 
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You can choose to delete one or more embedded or package bullet images with the Delete 

Image option on the List Type list. When you delete an embedded or package bullet image, 

the image no longer appears in the List Type list. The image is removed from all bulleted list 
styles in the style sheet and replaced with the default image for that list level. Deleting a 
package file bullet from a style sheet does not delete the image file from the package. 
  
Note: Embedded images are immediately removed from the list when you choose to delete 

them. Package images remain on the list while the style sheet is open; however, they are 
removed when you reopen the style sheet.  
  

To add a custom bullet image: 

1. Select the bulleted list style to which you want to add a custom bullet image. 

  
2. From the Style Editor - Table and List toolbar, click the List type list and select Add 

image. 
   

3. To add an image from a package in the Library, select Document in Library, 

navigate to the package and open it. Select the bullet image and click Open. 
  
or 
  
To add an image from your computer, select File on My Computer, navigate to the 
file and click Open. 

To delete custom bullet images: 

1. Select a bulleted list style. 

  
2. From the Style Editor - Table and List toolbar, click the List type list and select 

Delete image. 

   

3. Select the images you want to delete. 
   

4. Click OK and confirm the deletion if prompted. 

10.4.7 Format Image Styles 

Image styles are used to control the alignment, spacing, border width and color, and padding 
of images in documents.  
  

 Align Left and  Align Right 

Alignment options horizontally position the image in relation to the page margins. Using the 
Align icons, you can choose a  left or  right alignment, or you can deselect all alignment icons 
to choose no alignment. A left or right alignment creates a word wrap effect by floating the 
graphic on one side of the page and the adjacent text on the other side of the image, with the 
excess text flowing under the image. The default alignment for images is no selected 

alignment. When no alignment icons are selected, there is no text wrapping, and the image 
appears where it is inserted, anchored to the baseline of the paragraph or cell. 
  

 Border 

The default border width for images is set to 0, which is no border. You can add a border to 
the image by entering a width value in a point or pixel (default) unit. The default color for an 
image border is black, but you can select another color. 
  
Both the Spacing and Padding attributes create open space around an image. 
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 Spacing 

Spacing options create space around the sides of an image, adding space between the image 

and the web page margins and surrounding text. You can enter separate values for each side 
or use the same value for all sides. 
  

 Padding 

If you have applied a border to an image, padding options affect the spacing between the 
border line and the image. If the image does not have a border around it, the padding options 
also affect the spacing between the image and the surrounding text. If the image has no 

border, the padding values are added to any specified spacing values to add additional spacing 
around the image. 
  
Depending on your use of images, you may want to create several image styles for your 
content. For example, you can create one style for icons with no alignment. This style allows 
you to place the icon in any position within a paragraph or table. For larger screen captures, 
you may want another style that aligns the graphic to one edge of the web page and wraps 

the text on the other side of the graphic. 

  
Note: You cannot directly center an image in a web page. To center an image, insert the 
image on a blank line and center the paragraph where it is inserted.  

10.4.8 Format Horizontal Line Styles 

You can insert horizontal lines (also known as "rules") into a web page to separate sections of 
the page. The default browser settings for a horizontal line is a centered, black, 1 pixel in 
height (thickness) line that extends across the entire web page, with 6 points of spacing above 

and below the line.  
  
You can use the following tools in the Style Editor to create a default line style that overwrites 
the browser defaults, or create several non-default line styles for different uses. If you set a 
default horizontal line style, new non-default line styles inherit the attributes of the default 
style. For example, if the default line style creates a green line that is 4 pixels wide, all non-

default line styles inherit these settings. To override the inheritance for a non-default style, 

enter other values for the inherited attributes. 
  

 Background Color 

Select a color for the line, or choose No color to remove the applied color and reset the line 
color to the default.   
  

 Spacing 

Spacing options create space above and below a line. 
  

 Width and Height 

Use the Width value to specify the length of the line and set the units to pixels (default), 
points, or a percentage. Setting a width in pixels or points sets a fixed width line, which can 
cause a problem if it is much larger than the user's screen resolution. The browser inserts 
horizontal scroll bars if you specify a width that is larger than the screen display. Specifying 

the width as a percentage avoids this problem. A percentage setting is a relative width that 
automatically resizes the line to fit the percentage of the screen. A percentage of 100 uses the 
entire horizontal space.  
  
Use the Height value to specify a thickness for the line in pixels (default) or points. 

10.5 Copy Styles 
Styles can be copied within the same style sheet or from one style sheet to another. This is 

helpful if you want to use a style as a basis for another style. When copying a style, all print 
and language variations of the style are also copied and pasted. 
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After copying a style, you can change the copied style as needed. If you copy a style into a 

style sheet that contains a duplicate style name, an incremental number is appended to the 

name of the copied style to prevent naming conflicts. 
  
Styles copied from one style sheet to another may not appear with the same attributes as the 
original style if the style inherits attributes from another style. Because of inheritance, the 
appearance of the copied style is affected by the styles in the style sheet where the copy is 

pasted. For example, if you copy a paragraph style that inherits its Arial font style from the 
document body style or from a default paragraph style and paste it into a style sheet that 
defines a Courier font for the document body style, the pasted style now inherits the Courier 
font from the document body style.  
  
Note: You can use Undo to undo the pasted copy. 
  

When copying styles to another style sheet, only directly applied attributes are copied and 
guaranteed to remain unchanged. You can use the Style Inspector to see which attributes are 
directly applied or inherited, and the styles providing those attributes for the copied style.  

  
Warning! When copying bulleted list styles, note that a style sheet cannot contain two 
embedded bullet images with the same file name. If you copy a bulleted list style with an 
embedded image into another style sheet that uses an embedded image with the same file 

name, the pasted style uses the image in the current style sheet. 
  

Default Styles 

There are several rules that govern copying a style that is marked as a default style for an 
element. 

 Copying and pasting a default style into the same style sheet, pastes the style as a 
non-default style. 
   

 Copying and pasting a default style into another style sheet that already contains a 

default style for that element, pastes the style as a non-default style. 

   

 Copying and pasting a default style into another style sheet that does not contain a 
default style for that element, pastes the style as a default style. 

To copy a style: 

1. Select the style that you want to copy. 

  

2. On the Edit menu, choose  Copy. 

  
3. To create a copy the style in the same style sheet, select the Edit menu and choose 

 Paste. 

  
To copy the style to another style sheet, open the style sheet and then paste the style. 

  
4. Rename the copied style if needed. 

10.6 Delete Styles 
You can delete a style that you no longer need from a style sheet. When you delete a style, all 

instances in web pages using the deleted style are now identified as "Unknown style <style 
name>". If the deleted style is a default style for an element, the Web Page Editor applies the 
browser defaults for that element. If the deleted style is not a default style for an element, the 
Web Page Editor applies the default style for that element if one exists, and the browser 
defaults for that element if no default style exists. 
  
If you delete a default style, the attributes of the non-default styles that are inherited from the 

default style are reset to the browser settings.  
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When deleting a style, all print and language variations of the style are also deleted. 

  
Note: You can use Undo to restore a deleted style if the style sheet is still open in the Style 
Editor. 

  

To delete a style from a style sheet: 

1. Select the style that you want to delete. 

   

2. From the Style Editor - Styles toolbar, click  Delete Style. 

10.7 Use Styles in a Web Page 
To use styles to format a web page, a style sheet must be linked to the web page. A style 
sheet is linked to a web page either by having the Options dialog box automatically assign the 

default style sheet to new pages or by manually assigning a style sheet to a web page.  

  
You can manually assign a style sheet to a web page from the Library, Web Page Editor, or 
Outline Editor. From the Outline Editor, you assign a style sheet to a web page by displaying 
the Concept properties in the Properties toolpane. See Style Sheet Property in the General 
Properties section of the View Document Properties chapter for information on assigning style 

sheets to web pages. See Assign a Style Sheet to a Document in the Create Styles to Format 
Content chapter for more information about assigning and removing style sheet assignments.  
  
Note: You cannot use styles for HTML pages created in packages. 
  
Styles are applied to web page elements either by default or by manual application. Default 
styles are automatically applied when you add the corresponding elements to the web page. 

You can manually apply a style to text or an element by selecting it from the Styles list. The 
styles that appear in the list are filtered to show only the styles that can be applied to the 
selection. 

  
If you have created separate print styles, you can check the formatting for those styles by 
switching the Display list between Player and Print displays. In addition, you can check the 
formatting for language variations by changing the Language property of the web page. 

  
The Web Page Editor contains two tools, the element path and the Style Inspector toolpane, to 
help you understand how styles are affecting the elements in a web page. The element path at 
the bottom of the web page shows the order of styles and style elements that produce the 
formatting for a selection. The element path is especially useful for compound elements such 
as tables, where there are multiple elements that can be individually formatted, and you are 

not sure which ones affect the format of a specific table element.  
  
The Style Editor toolpane in the Web Page Editor helps you distinguish formatting from a style 
(applied or inherited) as opposed to direct formatting that is manually applied. While working 
in a web page, you can use the Style Inspector toolpane to open the assigned style sheet and 

select the style that is applied to the current web page element. 
  

See Format Content with Styles in the Enhance Content with Web Pages chapter for more 
information about using styles in web pages. 
  

 Multi-user Considerations 

 Before you can link a style sheet to a document, you must check out the document. If 

you are assigning a style sheet to multiple documents at the same time, all selected 
documents must be checked out. 
  
Styles sheets linked to content are excluded from the check in/check out process. You 
must manually check in or check out a style sheet to edit it. 
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10.8 Publish with Styles 
If a web page links to style sheet, that style sheet is always used to format published output 
for the Player, HTML Web Site, and PowerPoint deployments. For document outputs that 
include web pages (System Process, Training Guide, and Instructor Manual), you can use the 
Web Page Format option to choose between using the Developer settings or Word Template 
settings. Web pages published with the Developer settings use the styles in the assigned style 
sheets or direct formatting if no style sheet is assigned. You can set the Web Page Format 

option for a document type in the Options dialog box or while publishing in the Publishing 
Wizard.  
  
If a style sheet includes print styles, those styles are applied when you publish documents 
using the Developer settings. Before publishing, you can use the Print option on the Display 
list in the Web Page Editor to view your content with the print styles applied, or you can use 
the Preview list to preview the document in Microsoft Word or as an HTML web page 

(depending on the selected Output Format for the document type in the Options dialog box). 
  
Note: If a style sheet is deleted, a warning message appears during publishing, but the 

content still publishes. 
  

 Multi-user Considerations 

 Authors can link to and publish with a style sheet for which they have List permission, 
but they cannot apply styles from that sheet. If you want to lock down the style sheet 
so that authors can apply styles but do not have the ability to modify them, assign the 
authors Read permission for the folder. 
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11 Enhance Content with Packages 
You can enhance your content by linking it to images, web sites, multimedia presentations, 
Microsoft Word documents, PowerPoint presentations, and so on. To use such resources in the 

Developer, you create package documents, which are essentially containers that allow you to 
add externally created material to the Library. For example, you can create a package that 
contains either a collection of related folders and files in the case of a web site or multimedia 
presentation or a single file such as a Word document. You can then link to a single file in the 
package as the concept of a module, section, or topic document or as explanatory information 
for a specific frame or bubble text in a frame of a topic. 

 
When you publish your content to a Player output, your users can view the linked package 
material in Try It! and Do It! modes. In general, package files linked at the concept level 
appear in the Concept pane of the Player window or launch in their native application when a 
user selects the document to which they are linked. The specific behavior depends on the type 
of package file and the user's system setup. When linked at the frame or bubble text level or 
when linked in a web page, the package file launches in its native application when a user 

clicks on the link icon or hyperlinked text or graphic. Package files are ignored in searches 
performed in the Player. 
 
Note: Package files that are linked to frames or bubble text are not available in See It! or 
Know It? play modes in the Player. 
 
With one exception, linked package files do not appear in document outputs; the exception is 

graphic files. Graphics linked at the concept and frame levels are included when you publish 
document types that include attachments, namely, the System Process Document, Training 
Guide, and Instructor Manual. In addition, package graphic files inserted as images in web 
pages also appear in these document outputs. See Package Behavior in Publishing for more 
detail. 
 

To use a package in the Developer, you must complete two basic steps. First, you create and 
add files to the package, and then you link to a file in the package from the appropriate 

module, section, topic, or frame. Once you have created a package in a Library, you can use it 
multiple times by linking to its files from various locations throughout your content. 
 

User System Setup 

It is important that you understand your users' system setup before you link to package files 
from your content. When you link to a file that was developed in an external application, such 
as a Microsoft Excel workbook, a Microsoft Project file, or a Flash video, you need to consider 
whether your users have the appropriate applications and plug-ins to launch this content from 
their desktops. If a user's browser or system is not configured so that it can open a particular 
type of package file, the Player displays an error. Therefore, you should plan carefully to 
anticipate and avoid such situations. 

 
Note: The precise appearance and behavior of package files depends on the setup and 
browser settings of the computer on which they are viewed. 
 

Package Graphic Files 

Package graphic files display at their actual size in the Player. When published to document 

outputs, directly linked package graphics appear at actual size or are resized in Microsoft Word 
to be ½ pages, whichever is smaller. When inserted in a web page, the package image is sized 
appropriately according to web page behavior in document outputs. 
 
Note that the formats for package graphics that are supported by the Developer are those that 
are supported natively by Microsoft Word 2007, 2010, and 2013. These include: 

 Graphics Interchange Format (GIF) 
  

 Joint Photographic Experts Group (JPEG/JPG) 
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 Macintosh (PICT) 

  

 Portable Network Graphics (PNG) 

  

 Windows bitmap (BMP) 
  

 Run-length encoded (RLE) 
  

 Device-independent bitmap (DIB) 

  

 Windows Enhanced Metafile (EMF) 
  

 Windows Metafile (WMF) 

All non-native graphics formats are not exported to Word. 
 
In using package graphic files, however, you must also consider whether you intend to publish 

to Player outputs in addition to document outputs, as not all of the formats supported by 
Microsoft Word work well in online, browser-based formats. 

11.1 Package Considerations 
Although packages can contain multiple files of different types and even an internal folder 
structure, the Developer regards each package as a single document. The file(s) and/or 
folder(s) within a package are components of the package, rather than Developer documents 
as such. These facts have implications for how packages function in the Developer and how 
best to use them. The main considerations for packages are how many items a package 
should contain, what the items in the package should be named, and whether the package 

should have an internal folder structure.  
 

Number of Package Items 

When creating packages, you need to decide whether each package document should hold a 

single file or multiple files. Although there is no limit to the number of files and folders you can 
add to a package, it is generally a good idea to create packages with a single file or a few 

related files rather than to add all of your external files to one package. 
 
Because the Developer regards each package as a single document, tasks such as publishing 
and exporting affect an entire package, even if only part of it is needed. For example, when 
you publish a document that is linked to a file in a package, all of the files in the package are 
included in the published output, even those files that are not linked to the document being 
published. This is undesirable, as publishing unused files takes longer and increases the size of 

the published output. 
 
Nevertheless, there are situations in which you must keep multiple files in a single package. 
For example, suppose that you want to use a package to link to a custom web site that 
consists of several linked pages containing graphics (rather than making the site available on 
a server and linking to it as a URL attachment). To do so, you must copy the entire file and 

folder structure of the web site into one package for the hyperlinks in the web site to work and 
the graphics to appear properly. 
 

Naming of Package Items 

Each package is a Developer document and, as such, is identified by its Document ID, rather 
than its name. In contrast, package items are not Developer documents and do not have 

Document IDs. Rather, each package item is identified by the Document ID of the package in 
which it is stored and its name, as well as its relative path within the folder structure of the 
package, if relevant (see below). This difference has a number of consequences: 
 
First, if a package contains multiple files and/or folders, the name of each item at a given level 
of the package must be unique. This is identical to the requirement for folder names (but not 
document names) in the Library. 
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Second, when you link to a package attachment, you actually link to a single file within the 
package, not the overall package document. To uniquely identify the target of such a link, the 

link path must include the name of the package file, as well as its relative path within the 
folder structure of the package, if relevant (see below). As a result, if you change either the 

name or the relative path of the package file, you break the link to it. Therefore, it is 
recommended that you establish final names for all package items before linking to them. 
 
Warning! The Broken Links tool does not penetrate packages and cannot detect when links to 
package files are broken. 
 
In contrast, because Developer documents are uniquely identified solely on the basis of 

Document IDs, a package can be renamed and/or moved within the folder structure of the 
Library without breaking any links to the files it contains. This is identical to the behavior of all 
other Developer documents, such as modules, topics, glossaries, and so on. 
  
Warning! It is best to avoid using ampersands "&" or percent signs "%" in a package file 
name. Document attachment names with those characters may not open depending on the 

protocol for your security layer for deployed content. Document attachment names with 

ampersands or percent signs do not open if you are using the Knowledge Center to deploy 
your content.  
 

Internal Structure of a Package 

If you do choose to store multiple files in a single package, you might want to organize them 

using a folder structure within the package. For example, in the case of a custom web site 
such as that mentioned in Number of Package Items, the package must have an internal folder 
structure identical to that of the source. 
 
As stated above, when you link to a package file, the link path includes the relative path of the 
file within the package. It is therefore recommended that you keep the internal package folder 
structure relatively simple so as to avoid creating excessively long link paths (>255 

characters). In addition, if you change the relative path of a package file after linking to it, you 
break the link. Therefore, it is recommended that you establish the final internal structure of a 
package before linking to any items it contains. 

 
Warning! The Broken Links tool does not penetrate packages and cannot detect when links to 
package files are broken. 

 
In summary, when using packages, you should consider the following recommendations: 

 Store one or a few related files in each package. 
  

 Use unique package file and folder names. 

  

 Use relatively simple internal folder structures, if possible. 
  

 Establish the file names and internal folder structure, if any, before linking to any 
items in a package. 

11.2 Create a New Package 
Before you create a package, you need to identify the folders/files on your local computer or 
network server that are to be included in the package. Package content is always created from 
material outside the Library. Once you identify the material to include in a package, you use 
the Package Editor to create a new package and add the file(s) and/or folder(s) that get 

included in the new package. Then, you can save the package with a name of your choice, 
store it anywhere in the Library, and link to the file(s) in the package from your content. 
 
You can create a package from the main File menu available in the Library or any other 
document editor. When you create a new package, the Package Editor launches in a new tab 
and displays an empty package where you can add files and folders. After creating a new 
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package, you can name it and save it to any folder in the Library. The name of the package 

appears in the Package Editor tab. 

 
You can also create a new package from the Concept pane in the Outline Editor using the 

 Create New Package icon. Or, you can create and link a new package to new section using 

the New Section with Package command on the Link menu. 
 
If you save a package to the wrong folder in the Library, you always have the option to move 
the package document to another folder. You can also rename a package just as you would 
any other document. If you rename a package containing items to which you have linked from 

other documents, topic frames, or bubble text, the links remain unaffected. That is, renaming 
a package does not break any links to the items it contains; however, renaming a package 
item does break the links to that item. 
 
Warning! Although the Undo/Redo commands are available in the Package Editor for most 
actions, you cannot undo the actions of adding, deleting, renaming, moving, or copying 
package items/folders. 

 

 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 

under the Developer's version control system, you must check it in. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To create a new package from the File menu: 

1. On the File menu, point to  New and choose  Package. 

  

or 
  

On the Library toolbar, choose  Package. 
  

2. Add items to the package. 
  

3. Save the new package document. 
  
You can also close the tab and click Yes in response to the Save Document message. 
  

When you save a package for the first time, you are prompted to provide a name for 
it. Enter a name for the package by typing over the default name. Although the 
package name does not have to be unique, it is recommended that you provide a 
meaningful name so you can easily find the package later. 

To create and link a new package as a concept from the Outline Editor: 

1. With an outline open in the Outline Editor, display the Player View. 

  
2. Select a document in the outline from which you want to create a link. 

  

3. From the Concept pane, click  to launch the Package Wizard and click Next. 

  
4. Add items to the package and click Next. 

  
5. Type a name for the new package and browse a location in the Library where you 

want it saved (if you do not want to save the package using the default name and 
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location). 
  

6. Click Next. 
  

7. Choose a file in the package that launches in the Concept pane. Navigate through any 
folders contained in the new package, if appropriate. 
  

8. Click Finish. 

To link a new section and package to an outline: 

1. With an outline open in the Outline Editor, display the Player View. 

  
2. Select a document in the outline from which you want to link a new section with an 

associated package document. 
  

3. On the Link menu or Outline Editor Toolbar, choose  New Section with Package 

to launch the Package Wizard and click Next. 
  

4. Type a name for the new section. 
  

5. Click Next and Add items to the package. 
  

6. Click Next and type a name for the new package. You can also browse to specify a 
location in the Library where you want to save the new package (if you do not want to 
save the package using the default name and location). 
  

7. Choose a file in the package that launches in the Concept pane. Navigate through any 
folders contained in the new package, if appropriate. 
  

8. Click Finish. 

11.3 Edit a Package 
You can open a package at any time in the Package Editor to modify its contents. For each 
package that you open to edit, an independent instance of the Package Editor opens in a 
separate tab, allowing you to edit multiple packages at one time. When you edit a package, 
you can add, move/copy, rename, delete, and/or edit the files and folders in the package. As 

you make such changes, the name of each item at a given level of the package must remain 
unique. 
 
Warning! Moving, renaming, or deleting a package item that is linked to a document creates 
broken links in your content. Because the Broken Links tool does not penetrate packages, it 
cannot detect when links to items within packages are broken. Therefore, if you plan to 
perform any of these actions on a package item, you should first remove any links to it from 

your content. 
 

Folders 

You can store package items at the root of a package, or you can create a folder structure in 
the package to organize the items. Folders in a package behave similarly to folders in the 
Library; they can be named, renamed, deleted, moved, and copied. When naming folders in a 

package, duplicate names and blank names, as well as certain reserved characters, are not 
permitted. Once you have created folders, you can move or copy items into the folders in the 
current package using cut/copy and paste or drag-and-drop. 
 
Warning! Adding folders to a package increases the Library path to the files in those folders. 
If you choose to create folders in your packages, it is best to keep the folder names short and 

to create only a simple folder hierarchy. Long folder names and/or a complex folder structure 
with multiple levels can create problems if the paths to the package files exceed the maximum 
Windows file system length. 
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The Package Editor does not save empty folders. If you save a package that contains a folder 

with no content, the folder is not be there the next time you open the package. 

 
Folders can also be added to a package from a file system. When you copy an existing folder 
from a local or network drive, the folder and its entire contents are copied to the package. 
 
You can navigate the folders in a package by double-clicking the folder icon to drill down 

through the folder structure. The Location field at the top of the Package Editor tab displays 

the folder path. To move back through the folders, use the  Up One Level icon to the right 
of the Location field until you reach the root of the package. 

 
Changes to a package are not automatically saved. You can save a package as you are 
working with it or save it as prompted when you close the package. A progress bar displays to 
give you an estimate on how long the package takes to save. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. Note that you check 
out and in the overall package document; you cannot check out/in individual package 
items. 

  
A new version of a package document is created upon check in whenever you add, 
delete, rename, or edit an item in the package. Only the overall package is versioned; 
the items themselves are not versioned. Therefore, if you decide to undo changes to a 
package by rolling back to an earlier version, you return ALL items in the package to 
that version. 

To edit a package: 

1. Open the package in the Package Editor. 

  
2. Edit the package as necessary. 

  
You can add, move/copy, rename, delete, and/or edit the files and folders contained in 

the package. 
  

3. Save and close the package. 

Tip: To create a new folder in the Package Editor, on the File menu, point to New and select 
Folder. You can also right-click in a blank area in the Package Editor and choose New Folder 
from the context menu. A new folder icon appears in the Package Editor window with the 
folder name in edit mode. Type a name for the folder and press ENTER. 
 

You can also click  on the Package Editor toolbar to add a folder and all of its contents from 

your computer or network drive. 

11.4 Add Items to a Package 
You can add one or more files and/or folders to a package document from any drive on your 
computer or local network. The files/folders that you add to packages are not removed from 
your local computer/server unless you specifically choose to remove them, rather than 
copying them.  
 

The  Add Files icon allows you to browse your computer or network to select files to add to 

the package. The  Add folder icon allows you to browse your computer or network and 

select folders (and all its content) to include in a package. 
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You can also add both files and folders to a package by copying or moving them from their 
location on your computer or network to an open package using one of the following 

procedures: 

 Drag-and-drop from a window on your computer to an open package to create new 

copies of the files/folders 
  

 Copy from a window on your computer and paste in an open package to create new 
copies of the files/folders 

  

 Hold SHIFT and drag-and-drop from a window on your computer to an open package 
to move the files/folders from your computer to the package 
  

 Cut from a window on your computer and paste in an open package to move the 
files/folders from your computer to the package 

Warning! When copying files and folders with very long, complicated names from your 

computer to a package, the Package Editor might truncate some file and folder names to an 
8.3 (MS-DOS compatible) file format. After copying such files and folders, check the copies in 
the package. 

 
When adding items to a package, file and folder names at the same level within a package 
must be unique. Therefore, if you attempt to add a file with a duplicate name to the same 
folder in a package, you are prompted to replace the original with the new file. If two distinct 
package files must keep the same name, you can either create a new package for the 
additional file or create a separate folder for it in the same package. 
 

Tip: If you plan to localize your content, you should consider a language-neutral naming 
convention for package items. This helps avoid having to re-create links to package files in the 
translated content. 
 

To add files only to a package: 

1. On the Edit menu, select  Add Files. 

  
2. In the Open dialog box, browse your computer or network to select the file(s) you 

want to add to the package. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). In this case, the files must be located in the same 

source directory to be added to the package at the same time. 
  

3. Save the package. 

To add files and folders to a package: 

1. Organize your desktop so that you can simultaneously view both the package open in 
the Developer window and a Windows Explorer window. 

  
2. In Windows Explorer, navigate to a source directory on your computer or server and 

select the files/folders that you want to include in the package. 
  

3. Copy and paste or drag-and-drop the selected files/folders into the Package Editor tab. 
  
-or- 

  

On the Edit menu, select  Add folder and browse to a folder that you want to 

include in the package. Click OK to include the folder and all of its contents (including 
subfolders and their files). You can also make a new folder on your computer and 
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include it in the package. 

  
4. Save the package. 

11.5 Move/Copy Items in a Package 
After creating packages and adding items to them, you might find that you want to move 
items from one package to another. For example, you might want to keep all of the files used 
in one section in a single package rather than creating a separate package for each file. 
 
Items in a package can be moved or copied to another package using cut/copy and paste. You 

can also drag-and-drop items between packages by splitting the work area and viewing 
different packages in the two panes of the layout. When you drag-and-drop an item between 
packages, a new copy of the item is created in the destination package. To move an item 
between packages using drag-and-drop, hold the SHIFT key while dragging. 
 
Note: If the source and destination are different folders within the same package tab, drag-

and-drop moves the item rather than copying it. 

 
When moving and/or copying items in a package, file and folder names at the same level 
within a package must be unique. Therefore, if you attempt to copy or move a file with a 
duplicate name to the same folder in a package, you are prompted to replace the original with 
the new file. If two distinct package files must keep the same name, you can either create a 
new package for the additional file or create a separate folder for it in the same package. 
 

Warning! Moving a package item that is linked to a document creates broken links in your 
content. Because the Broken Links tool does not penetrate packages, it cannot detect when 
links to items within packages are broken. Therefore, if you plan to move a package item, you 
should first remove any links to it from your content. 
 

 Multi-user Considerations 

 Note that if you want to move items between two packages, you must check out both 
packages. If you want to copy items between two packages, you need to check out 
only the destination package. 

To move or copy items in a package: 

1. Open the source package containing the items you want to move or copy. 

  
2. Open the destination package into which you want to move or copy the package items. 

  
3. Split the layout of the work area. 

  

4. Display the source package in one layout pane and the destination package in the 
other layout pane. 
  

5. Use drag-and-drop or cut/copy and paste to move or copy the items between the 
packages. 
  
To move items, hold the SHIFT key and drag the items from the source package to the 

destination package. You can also use the  Cut and  Paste commands to move 
items between packages. 

  
To copy items, drag the items (or hold the CTRL key and drag the items) from the 

source package to the destination package. You can also use the  Copy and 

 Paste commands to copy items between packages. 
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The Cut, Copy, and Paste commands are also available on the Edit menu. 
  

6. Save the packages. 

11.6 Rename an Item in a Package 
You can rename any file or folder that is contained in a package. Long document names are 
supported for package items, but special reserved characters are not allowed. 

  
Warning! It is best to avoid using ampersands "&" or percent signs "%" in a package file 
name. Document attachment names with those characters may not open depending on the 
protocol for your security layer for deployed content. Document attachment names with 
ampersands or percent signs do not open if you are using the Knowledge Center to deploy 
your content. 
  

When renaming items in a package, file and folder names at the same level within a package 
must be unique. Therefore, if you attempt to assign a duplicate name to a package item, you 
receive an error. If two distinct package files must keep the same name, you can either create 

a new package for the additional file or create a separate folder for it in the same package. 
 
Warning! Renaming a package item that is linked to a document creates broken links in your 

content. Because the Broken Links tool does not penetrate packages, it cannot detect when 
links to package files are broken. If you need to rename a package item, you should do so 
before linking to it from your content. 
 
Tip: If you plan to localize your content, you should consider a language-neutral naming 
convention for package items. This helps avoid having to re-create links to package files in the 
translated content. 

 

To rename an item in a package: 

1. Open the package in the Package Editor. 

  
2. Select the package item. 

  
3. Click the document name or press the F2 key to start edit mode. 

  
You can also right-click a document and choose Rename. 
  

4. Type the document name. 
  

5. Press ENTER to save your changes. 
  
You can also click anywhere outside the document name to save your changes. 

11.7 Delete Items in a Package 
You can delete any folder or file in a package. Deleted package items are sent from the 

package in the Developer to the Windows Recycle Bin. 
 

Warning! Deleting a package item that is linked to a document creates broken links in your 
content. Because the Broken Links tool does not analyze packages, it cannot detect when links 
to items within packages are broken. Therefore, if you plan to delete a package item, you 
should first remove any links to it from your content. 
 
If you later discover that you improperly deleted a package item, you can restore the deleted 

item from the Windows Recycle Bin to its original package, as long as you have not emptied 
the Recycle Bin. To do so, you must first open the package in the Package Editor. 
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 Multi-user Considerations 

 You must check out the package both to delete items from the package and to restore 
deleted package items from the Windows Recycle Bin. 

To delete items in a package: 

1. Open a package and select the folder(s) and/or file(s) that you want to delete. 

  

2. On the Edit menu, choose  Delete. 

  
You can also press DELETE or right-click the folder or file and choose Delete from the 
context menu. 
  

3. Click Yes to confirm the deletion and move the items to the Windows Recycle Bin. 
  

You can restore a deleted item from the Windows Recycle Bin to its original package, 
as long as the Recycle Bin has not been emptied. However, before you restore the 
item, you must first open the package in the Package Editor. 
  

4. Save the package. 

11.8 Edit Files in a Package 
You can edit the content of any file in a package by opening it directly from the Package 
Editor.  
 

The file opens in its native application so you can make your changes. 
  
Note: HTML files automatically open the Developer HTML Editor (by default) regardless of the 
application that was used to originally create the file.  You can change the default HTML Editor 

with the Package HTML Editor option. 
 

You can use any one of the following methods to open a file from the Package Editor: 

 Double-click the file name. 
  

 Right-click the file name and choose Open. 

  

 Right-click the file name and choose Open with. 
  

 Drag the file into an open instance of the native application. 

Before you save or close the package, be sure to save and close any open documents. 
Depending on the native application you are using to edit the file, different messages appear if 

you try to close the Package Editor while the file is still open. For example, with applications 
such as Microsoft Word or Excel, you cannot save or close the package until the files you are 
editing are closed. If you are using other applications such as Notepad, messages appear 
warning that the file may be open and need to be closed, but you can force the Package Editor 
to save or close anyway. 

 
The messages could also vary depending on the method you used to open the file from the 
Package Editor. If you used either of the first two, the scenarios as described in the previous 
paragraph apply. If you used either of the last two methods, the Package Editor cannot 
determine reliably if the file is open, so you receive a warning that the files may be open. 
 

If the file you want to edit is also being maintained outside the Library, you can move or copy 
it from the Package Editor to your computer or a local server. 
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You can move or copy an item from a package to your desktop using standard Windows 
controls as follows: 

 To move an item, drag the item (or hold the SHIFT key and drag the item) from the 
package to your desktop. You can also use the Cut and Paste commands. 

  

 To copy an item, hold the CTRL key and drag the item from the package to your 
desktop. You can also use the Copy and Paste commands. 

Warning! Dragging a package item from the Package Editor to your desktop or a local 
network removes the file from the package. Press CTRL while dragging to copy the file and 
leave the original in place in the package. 

11.9 Create and Edit HTML Files in a Package 
Use the Web Page Editor to edit any existing HTML documents contained within a package in 
the Library. 

  
You can also create new HTML documents which can be saved and copied into the package 
you are editing. These HTML files can take input and communicate this information to a 
server. You can create form elements that contain a variety of input elements such as: 

 Buttons 
   

 Checkboxes 

   

 Text Fields 
   

 Selection Fields 

   

 Hidden Fields 

   

 Text Direction Fields 

Publishing Note: HTML files stored in packages are not published in document outputs. See 
Package Behavior in Publishing in the Enhance Content with Packages chapter. 
  

To edit HTML files in a package:  

1. Open a package in the Package editor. 

  
2. Double-click HTML file that you want to edit and it opens in the Web Page HTML editor. 

You can also right-click the file and choose Open to edit the file in the Web Page HTML 

editor or Open with... to open it in another program. 
  

3. Edit and save the file using the Web Page Editor toolbar functions. 

  
4. Save the package. 

 To create a new HTML file in a package: 

1. Open a package in the Package editor. 

  

2. Select  New HTML File to open an empty document in the HTML editor. 

  
3. Edit and save the document using the Web Editor toolbar functions. 

  
4. Save the package. 
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11.9.1 Create Div Containers 

Sometimes you may want to apply formatting to a larger piece of text than a block element. 

For example, you want to apply the same style to two paragraphs and a list. You can always 
select the text and apply the style, but if you want to apply a different style in the future, you 
would have to select the text again and apply the new style. 
  
You can accomplish the same results in more efficient way by placing the text in a div 
container. A div container serves as a placeholder for all styling. It also allows you to control 

the formatting by adding a class from a style sheet to the div container. 
  
The Create Div Container dialog box contains two tabs for configuring the style sheet that you 
apply to the text in the Div Container. 
  
The General tab is used to manually add a style class to apply to the text in a Div Container 
and contains these fields: 

 Style: If the system administrator defined some additional styles in the default.js file, 

you can choose these styles from the list. 
  

 StyleSheet Classes: This field is automatically populated once you select a style. 

The Advanced tab is used to configure additional options such as assign it an ID, a language 
code, a text direction, a tooltip, or CSS style properties. It contains these fields:  

 Id: Unique identifier (id attribute) for a div element in the document. 
   

 Language Code: Standardized language code (lang attribute) of the div element. 
   

 Style: CSS style definitions (style attribute). Note that each value must end with a 
semi-colon and individual properties should be separated with spaces. 
  

 Advisory Title: Tooltip text that displays when you mouse over a Div Container.  

   

 Language Direction: Direction of the text LTR (Left to Right) or RTL (Right to Left). 

To create a Div Container: 

1. Open an HTML file in a package. 

  
2. Select the text to be included in the div container. 

  

3. On the Web Page Editor - Package toolbar, click  Create Div Container. 
  

4. Type the appropriate style information on the General and Advanced tabs. 

  

5. Click OK. 
  
The text in the Div Container receives the style properties of the style sheet class. Any 
time that style sheet changes, the text in the Div Container is automatically updated. 

11.9.2 Create a Form 

A Form element is a container for elements such as buttons, options, or text fields. Use the 
Form Properties dialog box to name and configure the basic settings that let the form 
communicate with the server. 
  

The Form Properties dialog box contains these fields: 
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 Name: Name of the form. 

   

 Action: Location of the application that produces the form data. 
   

 Id: Unique identifier for a form element in a document. 

   

 Endcoding: Parameter that specifies how the form data should be encoded before it is 

sent to the server. 
   

 Target: Window where the results display after the data is sent to the server. Options 
are New Window, Topmost Window, Same Window, or Parent Window. 

   

 Method: Method data is sent to the server. Choices are GET or POST. 

To create a Form:   

1. On the Web Page Editor - Package toolbar, click  Form. 

  
2. Enter the appropriate information in the fields on the Form Properties dialog box. 

  
3. Click OK. 

  
The form displays in the HTML file as a frame with a red dotted board. 

11.9.3 Create Buttons and Checkboxes 

You can add Buttons, Radio Buttons, Image Buttons and/or Checkboxes to a Form. These 

controls allow a user to click on a selection that they want submitted to the server. 
 
Radio buttons allow you to select an item from a group of items. Only one radio button can be 
selected per group. 
  

The Radio Button Properties dialog box contains these fields: 
  

Name: Name of the Radio Button 
 
Value: Value of the Radio Button 
 
Selected: Default status of the Radio Button (selected or not selected) 
  

To create a Radio Button: 

1. On the Web Page Editor - Package toolbar, click  Radio Button. 

  
2. Type the name of the Radio Button. 

  

3. Type the value to be sent to the server when the Radio Button is selected. 
  

4. Click the Selected option if you want the default state of the button to be selected. 
  

5. Click OK. 

Checkboxes allow you to select items from a group. Each item is independent so you can 
select multiple options from a group.   
  
The Checkbox Properties dialog box contains these fields: 
  
Name: Name of the Checkbox 
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Value: Value of the Checkbox 

 

Selected: Default status of the Checkbox (selected or not selected) 
  

To create a Checkbox: 

1. On the Web Page Editor - Package toolbar, click  Checkbox. 
  

2. Type the name of the Checkbox. 
  

3. Type the value to be sent to the server when the Checkbox is selected. 
  

4. Click the Selected option if you want the default state of the checkbox to be selected. 
  

5. Click OK. 

Buttons provide a visual cue to the user to complete an action. Buttons come in three types: 

 Standard button with arbitrary text 
  

 Submit button that submits the form data to the server 
  

 Reset button resets the form 

The Buttons Properties dialog box contains these fields: 
  
Name: Name of the button 
  
Text (Value): Text that displays on the button 
  

Type: The type of button. Values are Button, Submit, or Reset 

  

To create a Button: 

1. On the Web Page Editor - Package toolbar, click  Button. 
  

2. Type the name of the button. 
  

3. Type the text to appear on the button. 
  

4. Select the type of button. 
  

5. Click OK. 

Image Buttons are clickable images that provide a visual cue to the user to complete an 

action. 
  
The Image Buttons Properties dialog box contains two tabs: 

 Image Info 
  

 Advanced 

To create an Image Button: 

1. On the Web Page Editor - Package toolbar, click  Image Button. 
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2. Fill in the appropriate information on each tab and click OK. 

11.9.4 Create Text Elements 

You can create several types of fields elements where you can enter text. A Text Field element 
allows you to enter short pieces of text in a single line. A Text Area field is a scrollable area 
that allows you to enter multiple lines of text. 
  
The Text Field Properties dialog box contains these fields: 

 Name: Name of the Text Field. 
   

 Value: Value of the Text Field that displays when the form is loaded in the browser. 
   

 Character Width: Width of the Text Field expressed in the number of characters that 
can be entered. If left blank, the default size is determined by the browser. 
   

 Maximum Character: Highest number of characters that can be entered in the Text 

Field. If left blank, an unlimited number of characters can be entered. The text scrolls 
to the right after you enter more characters then the size of the field box. 
   

 Type: Parameter that determines is the Text Field is plain text, email address, 

telephone number, URL, search, or protected password field. Password fields display 
as an asterisk (*), a bullet (•), or another symbol used by the browser. 

 To create a Text Field: 

1. On the Web Page Editor - Package toolbar, click  Text Field. 
  

2. Type the name of the Text Field. 

  

3. Type the value of the Text Field to be sent to the server. 
  

4. Type the number of characters of the Text Field box. 
  

5. Type the maximum number of characters that can be entered in the Text Field or 
leave blank for unlimited size. 

  
6. Click OK. 

 The Text Area Field Properties dialog box contains these fields: 

 Name: Name of the Text Area field. 
   

 Column: Width of the Text Area field expressed in the number of characters that can 

be entered in a line. If left blank, the default size is determined by the browser. 

   

 Row: Number of lines of text that displays. If left blank, the default number of rows is 
determined by the browser. 

 To create a Text Area field: 

1. On the Web Page Editor - Package toolbar, click  Text Area. 

  
2. Type the name of the Text Area field. 

  
3. Type the number of characters of the Text Area column box. 
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4. Type the number of rows of the Text Area or leave blank to let the browser default the 

number of rows. 

  
5. Click OK. 

11.9.5 Create a Selection Field 

A Selection Field allows you to select items from a scrollable list. You can set selection for a 
single item or multiple items. Multiple items can be selected by holding down the CTRL Key 
while selecting. 
 

The Selection Field Properties dialog box contains these fields: 

 Name: Name of the Selection field. 

   

 Value: Value of the Selection field. This item is filled when you set of the items in the 
Set as selected value field. 

   

 Size: The number of rows of the Selection field that are visible. If the number of 
selection values is greater than the size, a scrollbar appears. 
   

 Text: Label of a selection field option. 

   

 Value: Value associated with the Text field. 

   

 Add: Adds the Text and Value fields as a selection option. 
   

 Modify: Allows you to modify the Text or Value of a selection option. 

   

 Up: Moves a selection option up one row in the selection option list. 

   

 Down: Moves a selection option down one row in the selection option list. 

   

 Set as selected value: Sets a value as preselected by default. 

   

 Delete: Deletes a selected option from the selection option list. 

   

 Allow multiple selections: Allows the user to select multiple options from the 
selection list. 

To create a Selection Field: 

1. On the Web Page Editor - Package toolbar, click  Selection Field. 

  
2. Type the name of the Selection Field. 

  

3. Type the number of rows of the Select Field. 
  

4. Enter the text and value of a selection option. 
  

5. Click Add to put the selection option in the list. 
  
Note: Repeat Steps 4 and 5 for each selection option. 
  

6. Select a selection option from the list and click Set as selected value if you want to 
have a selection option selected by default. 
  

7. Toggle on the Allow multiple selections option if you want to allow multiple 
selections. 
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8. Click OK. 

11.9.6 Change Text Direction 

You can set the direction that the text your HTML file is read using two text direction fields on 
the Web Page Editor - Package toolbar: 

  Text Direction from Left to Right: Sets text direction as from left to right. This 

is the direction of most Western languages. 
  

  Text Direction from Right to Left: Sets text direction as from right to left. This 
is the direction of languages such as Arabic, Persian, Hebrew). 

 To change the text direction: 

1. Select the text. 

  

2. On the Web Page Editor - Package toolbar, click  Text Direction from Left to 

Right or  Text Direction from Right to Left to change the direction the text is 
read. 

11.9.7 Create Hidden Fields 

A Hidden field is hidden from view and does not allow for interaction but whose value is sent 
the server when the form is submitted. 
  
The Hidden Field Properties dialog box contains these fields: 

 Name: Name of the Hidden field 
   

 Value: Value of the Hidden field 

 To create a Hidden Field: 

1. On the Web Page Editor - Package toolbar, click  Hidden Field. 
  

2. Type the name of the Hidden Field. 
  

3. Type the value of the field to be sent to the server. 
  

4. Click OK. 

11.9.8 Create an Anchor in an HTML file 

An anchor is a placeholder in your content that allows you to link to a specific point in your 

document. Anchors are useful when you have content with a lot of text. Typically, a link takes 
you to the top of the linked page but when the user clicks on the link to an anchor, they are 
taken to the specific point where the anchor is set. 
  

You can link to an anchor by Anchor name in a web page or in the HTML file in a package. See 
Create an Anchor in the xxxxxx of the xxxxxx for information on creating an anchor or linking 
to an anchor by Anchor Name. 
   
In an HTML file, you can also link to an anchor By Element Id. T his is an anchor you create by 
editing the element id (for example, ElementById("myHeader")) attribute in the documents 
source HTML. These anchors can be placed by selecting the Element Id in the By Element Id 

list on the Link Info tab. 
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To create an anchor by element Id: 

1. Open an HTML file in a package where you want to place the anchor. 

  

2. From the Web Page Editor - Package toolbar, click  Show Source. 

  
3. Type the Element Id where you want to place the anchor in the document HTML. 

  

4. Click  Save. 

11.9.9 View the HTML Source 

The Web Page Editor allows you to create and format browser ready content in a package 
without knowing HTML code. However, there may be occasions where a content author with 
HTML coding experience wants to work directly with the HTML code. The Show Source tool 

allows the author to view or edit the underlying HTML of the web page. 
  

Note: The Show Source icon is only active on the Web Page Editor - Package toolbar when 
editing an HTML file in a package. 
  

To view the HTML source:   

1. Open an HTML file in a package. 

   

2. On the Web Page Editor - Package toolbar, click  Show Source. 

 
The HTML code displays in the editor. 
  

3. Click  Show Source again to return the HTML file. 

 To edit the HTML source:   

1. Open an HTML file in a package. 

   

2. On the Web Page Editor - Package toolbar, click  Show Source. 

 
The HTML code displays in the editor. 
  

3. Edit the HTML and click  Save. 

  

4. Click  Show Source again to return the HTML file. 

11.10 Delete a Package 
Deleting a package deletes the package document from the Library, along with all of the items 

it contains. You can delete a package only from the Library, just as you would delete a 
document of any other type.  
 
Deleting a package that contains items linked to your content creates broken links. Therefore, 
if you plan to delete a package, you should first remove any links from your content to the 
files it contains. 
 

Tip: You can use the Broken Links tool to identify any broken links in your content that result 
from deleting a package. However, you cannot use this tool to identify broken links resulting 
from deleting, moving, or renaming items within packages. 
 
The situation might also arise in which you attempt to delete a package as a related 
document. For example, if a package file is the concept of a module and you delete the 



  Enhance Content with Packages 

   297 

module with related documents, the package is deleted as a related document. Note that the 
entire package is deleted, not just the file linked as the concept of the module. However, you 

cannot delete a package as a related document if any file it contains is linked to any other 
document that is not selected for deletion. 

 
Consider the following two examples involving a package named Package AB that contains the 
files File A and File B: 

 First, suppose that File A is linked as the concept of Module A but File B is not linked to 
any other document. If you delete Module A with related documents, Package AB, 
including both File A and File B, is deleted. The entire package is deleted, even though 

only one of the files it contained was linked to the document being deleted. 
  

 Now suppose that File A is linked as the concept of Module A and File B is linked as the 
concept of Module B. If you now attempt to delete Module A with related documents, 

Package AB is not deleted, because of the link between File B and Module B. Further, 
File A is also not deleted, even though it was directly linked to the document being 

deleted and is not linked to any other document. In this case, the selected document 
is successfully deleted, but the related package document is left intact. 

Therefore, you cannot create any broken links in your content by deleting a package as a 
related document. 
 

 Multi-user Considerations 

 Documents under version control must be checked in and you must be working online 
to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 
  
Deleted documents that have been checked in to the Library can be restored if they 

have not been purged by your Administrator. New documents that have never been 
checked in cannot be restored. 

11.11 Change the Package View 
Just as you can change how you view files and folders in Windows Explorer, you can change 
the view for items in a package. The four views for packages are Large Icons, Small Icons, 
List, and Details. The Large Icons view is the default. The Large Icons, Small Icons, and List 
views display only the names of the package items. To see additional properties for each item 
in the package, such as file size, file type, and date modified, use the Details View.  
 

If you split the work area using the horizontal or vertical layout, you can choose a separate 
view for the package in each pane of the layout. 
 
By default, the package items in a view are arranged alphabetically by the Name property. If 
you view the package items in the Details View, which displays the properties for each item, 
you can use the column headings to rearrange the items by sorting the view on the different 

properties. The other views, which do not contain column headings, can be arranged by the 

Name, Type, and Date Modified properties. 
 
Note: The icon representing each file in the package views is the standard Windows icon for 
the associated file type. 
 

To change the package view: 

1. Open a package. 

  
2. Right-click in a blank area in the Package Editor window. 

  
3. Point to View and choose a view. 
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To arrange the icons in the package view: 

1. Open a package. 

  
2. Right-click in a blank area in the Package Editor window. 

  
3. Point to Arrange Icons and choose a property. 

11.12 Package Behavior in Publishing 
The behavior of package files in publishing depends on the type of published output, the type 
of package file, and the level at which the package file is linked, as described below.  
 

Player Outputs 

Package files linked at all levels are included in all Player outputs in Try It! and Do It! modes. 
When linked at the concept level, most package files appear directly in the Concept pane when 

the user selects the parent document. Depending on the type of file, some concept package 

files open in a new window instead. When linked at the frame or bubble text level or when 
linked from a web page, users access the package file by clicking on the link icon or 
hyperlinked text/image. In these cases, all package files open in a new window, although the 
precise appearance and behavior of package files depends on the setup and browser settings 
of the computer on which they are viewed (see Package Considerations). 
 

Warning! If a user's browser/system does not support a specific type of package file, the 
browser displays an error when the user attempts to access the linked package file, whether in 
the Concept pane or through a link. Therefore, you should consider your users' system setup 
when determining which types of package files to use. 
 

Note: Package files linked to frames or bubble text are not available in See It! or Know It? 
play modes in the Player. 
 

Document Outputs 

With one exception, package files do not appear in document outputs. The exception is graphic 
files, which can be included when you publish a System Process Document, Training Guide, or 
Instructor Manual. Specifically, package graphic files linked directly at the concept and frame 
levels are included in these document outputs. Package graphic files linked to bubble text are 
excluded from all document outputs. 
 

When linked at the concept level, the package graphic appears immediately after the name of 
the parent document to which it is linked. When linked at the topic frame level, the package 
graphic immediately follows the screen shot and steps for the frame to which it is linked. It 
appears in a lightly shaded box that is indented slightly to set it off from the surrounding 
content, with the link icon to its left. Although the graphic appears within the borders of the 
shaded box, it does not have a shaded background. When the same frame links to multiple 
package graphics or other attachments that are included in document outputs, each 

attachment is displayed as a separate item, in the order in which it is linked. If desired, you 
can use publishing format options to exclude directly linked package graphic files from all 
document outputs. 
 

In addition, package graphics inserted as images in web pages can also be included in the 
above document outputs. In this case, the images appear as part of the web page, for web 
pages linked at the concept and frame levels. If desired, however, you can use publishing 

format options to exclude web page images, including those linked through packages, from all 
document outputs. 
 

Finally, if a glossary term links to a graphic in a package as its definition link, the graphic 
appears in the Glossary section of a published Training Guide or Instructor Manual. 
 

The maximum size for package graphics in document outputs is ½ page, so graphics that are 
larger than this are scaled accordingly and those that are smaller appear at full size. 
 

Note: The Job Aid, Test, and Test Case document outputs do not include linked package files. 
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12 Enhance Content with URLs 
In addition to package files and web pages, you can also enhance your content by linking it to 
URLs. This allows you to link to information that is created and maintained outside the Library 

and is accessed directly on the Internet or a local intranet. You can use this option for any 
valid URL, including mailto and ftp links. For example, you can use a URL attachment to link 
from the Introduction frame of a topic to your corporate web site. Alternatively, you can use a 
mailto URL link to your help desk to allow users to easily submit questions or comments while 
they are viewing your content in the Player.  
 

Note: Clicking a mailto link in the Developer or Player launches the default e-mail program 
specified on the user's computer and opens a new mail message with the mailto address 
included in the To field. You can also include a default subject and/or message text by using 
the "subject" and/or "body" attributes of the mailto tag. 
 
When you use links to URL attachments, you must take three issues into consideration: 

 First, your users must be online when viewing content in the Player to access URL 

links. In addition, you should take into account the speed of their Internet connection, 
especially if the target sites contain many graphics and/or multimedia components. 
  

 Second, you must ensure that the path to the target of the link always remains valid; 

that is, you must not move the target of the link from its current location on the 
Internet or intranet. If the path to the target does change, you must update the link in 
the Developer and republish your content. Otherwise, your users encounter a "page 
not available" browser error when they try to access the URL by clicking the link. 
  

 Third, you must ensure that your users have appropriate access and an appropriate 

setup to view the target of the link. For example, if the target of the link is located on 
a secure server, your users must be authorized to access the server. Likewise, if the 
target of the link employs plug-ins, you should ensure that your users have the 
appropriate plug-ins installed before they attempt to view the linked content. 

When you link to a URL as the concept of a module, section, or topic, users can access the 
target Internet or intranet site from the Concept pane in the Player window. When you link to 
a URL from a frame in a topic, an icon representing the link appears in the bubble in Try It! 

mode or in the bubble or window in Do It! mode for that frame. If the URL is linked to the 
Introduction frame of a topic, its icon appears in the Introduction pane of the Player window. 
In each case, a user can click the icon to view the contents of the target Internet or intranet 
site. 
 
In addition, you can link to URLs from bubble text in a topic frame or from text or an image in 
a web page. Users can view the target Internet or intranet site by clicking the hyperlinked text 

or graphic appearing when they view your content in the Player window. 
 
URLs linked at the concept and frame levels and in web pages are also included in selected 

document outputs, namely, the System Process Document, Training Guide, and Instructor 
Manual. See URL Behavior in Publishing for more detail. 
 

Note: URL attachments that are linked to frames or bubble text are not available in See It! or 
Know It? play modes in the Player. 

12.1 URL Behavior in Publishing 
The behavior of URLs in publishing depends on the type of output and the level at which the 
URL is linked.  
 

Player Outputs 

Like links to package files and web pages, links to URLs are included in all Player outputs in 
Try It! and Do It! modes. For URLs linked at the concept level, the target of the link appears in 
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the Concept pane. For example, if your corporate web site is the concept of a module, the 

Concept pane displays the home page of the web site when the user selects the module 

document. The display is fully functional, so that users can explore the site using its 
navigation buttons and links. For URLs linked at the frame or bubble text level, users access 
the link target by clicking on the link icon or hyperlinked text, respectively; in both cases, the 
link target opens in a new browser window. The same is true for hyperlinks to URLs within web 
pages. 

 
Users must be online when viewing your content to access linked URLs. They should also have 
a sufficient connection speed, any necessary plug-ins, and all appropriate permissions or user 
accounts to access the target sites. 
  
Note: URL attachments linked to frames or bubble text are not available in See It! or Know It? 
play modes in the Player. 

  
Note: Some Internet web pages (such as http://www.google.com and 
http://www.yahoo.com) cannot be launched in a frame due to web server security settings. 

These Internet web pages do appear in the Concept pane in the Outline Editor, but do not 
open in the Concept pane in the published Player. Internet Explorer displays a friendly error 
message instead of these pages and allows the user to open the original web page in a new 
browser window. Other browsers, such as Chrome and Firefox display an empty page. Before 

deploying a Player, you should check the links in the Published content. If the Internet page 
does not display in the Concept pane in the Player, you can link a Developer web page as a 
concept and then link text or an object in that web page to the URL of the Internet web page. 
These links will then open in a separate browser window from the Player, thus preventing the 
above issue that would occur when the page is embedded into a frame. 
 

Document Outputs 

Only three types of document outputs ever include linked attachments such as URLs: the 
System Process Document, Training Guide, and Instructor Manual. For these three documents, 
the outcome depends on the level at which the URL is linked. 
 
Direct links to URLs at the concept and frame levels appear in the same format: the text 

"Please refer to:" is followed by the address of the target. For example, a concept link to the 
Microsoft web site appears as "Please refer to: www.microsoft.com". The URL address 
functions as an active text hyperlink in the document output that your users can use to 
directly access the target of the link. 
 
When linked at the concept level, this text appears immediately after the name of the parent 
document to which it is linked. When linked at the topic level, this text immediately follows the 

screen shot and steps for the frame to which the URL attachment is linked. It appears in a 
lightly shaded box that is indented slightly to set it off from the surrounding content, with the 
link icon to its left. When the same frame links to multiple URLs or other attachments that are 
included in document outputs, each attachment is displayed as a separate item, in the order in 
which it is linked. 
 

Unlike package and web page attachments, URLs linked to custom bubble text in action 
frames are also included in document outputs. In this case, the address of the target appears 

in parentheses immediately after the linked text and again functions as an active text 
hyperlink. For example, the bubble text "You can find more information at the Microsoft web 
site." with a link from the text "Microsoft web site" would appear as "You can find more 
information at the Microsoft web site (www.microsoft.com)." 
 

Web pages can also contain hyperlinks to URLs. Such hyperlinks are included in document 
outputs as part of the web pages to which they belong under the following conditions: 

 The web page is linked at the concept or frame level. 
  

 The hyperlink is from text in the web page, not an image. 



  Enhance Content with URLs 

   301 

In this case, the hyperlink tooltip (if defined) appears in place of the link text, followed by the 
address of the target URL in parentheses. The URL address functions as an active text 

hyperlink in the document output. Consider the following example: 
 

A web page linked as a topic concept contains the text "You can find more information at the 
Microsoft web site." with a hyperlink from the words "Microsoft web site" to the same target as 
above (www.microsoft.com). Further, the tooltip of the hyperlink is "Microsoft Corporation web 
site". Upon publication to the above document outputs, the result for this URL hyperlink is 
"You can find more information at the Microsoft Corporation web site (www.microsoft.com)." 
with an active link from the text "www.microsoft.com" to the web site. 
 

Note: The Job Aid, Test, and Test Case document outputs do not include linked URL 
attachments. 
  
An absolute URL represents the fixed location of a piece of content without regards to its 
context. A Relative URL is a shortened version of the full URL that only makes sense when 
used in context. The full URL is constructed by taking a Base URL (set in the General Content 

Defaults) and appending the Relative URL set when creating a hyperlink). Here is an analogy 

to help clarify. Let's say you asked me where my brother lives and I said "right next to my 
house". If you didn't know where I lived, this information would not be useful. However, if you 
did know where I lived, then you could find my brother's house by locating my house and then 
find his next door. In this case, my house is an example of the Base URL and "right next to my 
house" is an example of the Relative URL. 
 

Relative URLs are useful when the content developer is not sure of the location of the 
deployed content. They allow the content developer to link to content outside of the Library in 
the Developer. 
 
The Base URL can be set in the Developer and can be changed, if necessary, in the Player 
Package after publication. 
 

Note: If a Base URL is set in the General Content Defaults, you can enter a Relative URL 
(beginning with ../) when inserting a hyperlink for a URL on the Insert Hyperlink dialog box. 

 

To insert a Relative URL: 

1. Display the Insert Hyperlink dialog box. 

  

This dialog box opens by clicking  Create link from a number of locations including 

the Concept, Frame properties, and Frame Links panes. 
  

2. On the Link to pane, select  URL. 

  
3. Enter the Relative URL beginning with ../ in the Address field. 

  
When typing the Relative URL, the full URL displays in the Full URL field. 

  

4. Click  Go to preview the link to the URL. 
  

5. Click OK. 

12.2 Work with Relative URLs 
You can link Developer content to Internet or intranet web pages or other content files such as 

documents and spreadsheets on a web server by linking to the document's URL address. 
Linking to a URL allows you to access content that is maintained outside of the Library.  
  
When linking to a URL, you can type the entire absolute address of the linked content and 
preview it to confirm the correct address. However, you may want to link to content that has 
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not yet been deployed, and you are unsure of the final web server for deployment. For 

example, you create supplemental content that is used by several customers who deploy it on 

different servers. In this case, you cannot enter the absolute address of the URL.  
  
If the location of linked content is in a common base path, you can use relative URLs instead 
of absolute. Relative URLs are addresses which are relative to a configurable base address. 
The base address can be set in the Developer for previewing and in the Player package after 

publishing. With relative URLs, you can temporarily load the web content locally, or on a 
server you can access, and then create and verify the links in your content. After deploying 
the linked content on the permanent web server, you can edit one file in the published Player 
content with the location. Using relative URLs also makes it easier to update the content if the 
web server is moved to another location.  
  
When using relative URLs, you do not enter the base address; instead you enter the rest of 

the URL path using standard URL conventions (see Add a Relative URL in the Work with 
Relative URLs section of the Enhance Content with URLs chapter for more information about 
standard URL conventions).  

  
Example: You want to create links to the following URLs on a web server: 
  
http://abc-srv/us/support/index.html 

http://abc-srv/us/downloads/index.html 
http://abc-srv/us/products/middleware/default.html 
http://abc-srv/us/products/database/list.docx 
  
With "http://abc-srv/us" as the base URL address, you can use the following relative 
addresses to create the links: 

  
./support/index.html 
./downloads/index.html 
./products/middleware/default.html 
./products/database/list.docx 

12.2.1 URL Links in Content 

Links to a URL can appear in several locations in the content. Listed below are the locations 
where you can create these links and the methods for linking them.  

 Concept for modules, sections and topics 
  

In the Outline Editor, select  Create link in the Concept pane, and select URL in 

the Link to pane. See Link an Attachment as a Concept: Outline Editor in the Link 
Attachments section of the Work with Attachments chapter. 
  

In the Topic Editor, display the Concept pane, select  Create link, and select URL 

in the Link to pane. See Link an Attachment as a Concept: Topic Editor in the Link 
Attachments section of the Work with Attachments chapter. 
   

 Link in a web page (embeds the URL link in the web page) 

   
In the Web Page Editor, select the text or an image, on the Insert menu, choose 
Hyperlink, and select URL in the Link to pane. See Insert or Delete a Hyperlink to a 
URL in the Link Text section of the Enhance Content with Web Pages chapter. 
   

 Link in a topic frame 
  

In the Topic Editor, display the Frame Link pane, select  Create link, and select 

URL in the Link to pane. See Link to an Attachment from a Topic Frame in the Link 
Attachments section of the Work with Attachments chapter. 
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 Link frame text 

  

In the Topic Editor, select the bubble text, select  Bubble text link in the Frame 
Properties pane, and select URL in the Link to pane. See Link to an Attachment from 

Bubble Text in the Link Attachments section of the Work with Attachments chapter. 
   

 Glossary definition 
  

In the Glossary Editor, add a new term, select the Definition Link cell and the 

Browse button, select  Create link, and select URL in the Link to pane. See Select 
a Definition Link Attachment in the Define Glossary Terms chapter. 

Note: Although you can link images from a URL, relative URLs do not apply to images. 

12.2.2 Specify a Base URL 

When using relative URLs, you can specify a base URL path. This base URL is not used in 

publishing, but allows you to preview your relative links to verify that the address is valid.  
  
You specify a base URL path using the Browse button for the Base URL for Previewing Relative 
Hyperlinks setting on the General page in the Content Defaults category in the Options dialog 
box. A base URL path must begin with "http://" or "https://". You can type the address or 
copy and paste it from another location, such as your browser. If the content is deployed on a 
locally shared web folder or on an accessible server, you can use the Go button to preview and 

verify the location. The base path should point to a target directory, but can also point to a 
filename.   
  
When you preview a relative link in the content, the Developer combines the base URL (in the 
Options dialog box) with the Relative URL (as specified in the link) to create the path that the 
system uses to find the target URL. If you change the base URL path, preview automatically 

uses the new setting for newly created AND existing relative URL links. If you enter a relative 
URL with no base URL specified, you are notified that a base address for the relative URL is not 

set.  
  
The base URL path applies to the entire Library and is included in the exported content 
defaults, so it can be shared with other authors. If different authors use different base URLs, 
all the relative links may not work. However, if you are using multiple Libraries, each Library 

can have its own base path. 
  
In published content, the system resolves relative links by combining the relative paths with 
the current location of the Player's index.html file, which it considers the base URL path. 
However, the resolved links are tagged as relative links and can be updated in post-publishing. 
Once the target URL content is deployed on its final server, you can modify the baseUrl 
variable in the config.js file in the published Player content and enter this address. 

12.2.3 Add a Relative URL 

All absolute and relative hyperlinks to a URL are added using the Address field in the Insert 

Hyperlink dialog box. The Insert Hyperlink dialog box also contains a Full URL field, which 
shows the base path if one is set in the Options dialog box, plus the appended relative URL. 
The Full URL field is a calculated field; meaning that it is not editable. When you first open the 
Insert Hyperlink dialog box, the base URL path does not appear; however, as you enter a 
relative URL, the Full URL field updates to show the entire URL link as it is being typed. 
Depending on the relative URL convention you use, the Full URL inserts all or part of the base 

path and appends the relative address.  
 
Note: If you enter a relative URL in the Address field , the same relative URL appears in the 
URL field on the Link Info tab of the Link dialog box. 
  
Note: If the linked content is not accessible or available for you to install locally, you can still 

create the links with relative URLs without setting a base URL; however, the linked content 
cannot be previewed. After the linked content is deployed, you can set the base URL path in 
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post-publishing to resolve the links. See Publish Relative URL Links in the Work with Relative 

URLs section of the Enhance Content with URLs chapter for more information.  

  

URL Conventions  

When entering a relative URL, the Developer follows standard URL conventions of dots and 
slashes as defined by webreference.com. The following list describes the standard 

conventions. The examples below each convention show the relative address typed into the 
Address field and the resulting Full URL when the base URL path is set to "http://wsgsrv/hr-
content/en/us."  
  
. (one period)  

 This notation refers to the current directory. During publishing, the base path is 
defined as "./" (period slash); therefore, you should use the notation "./" to start a 

relative URL that you want appended to the full base URL. 
  
Relative address = ./support/supportoffices.docx  
Full URL = http://wsgsrv/hr-content/en/us/support/supportoffices.docx 

.. (two periods)  

 This notation indicates the parent directory. Using this in a relative URL removes 
everything up to the previous slash in the base URL. 
  

Relative address = ../au/contacts.html 
Full URL = http://wsgsrv/hr-content/en/au/contacts.html 

/ (one slash)  

 A relative URL that begins with / (a slash) always replaces the entire path name of the 
base URL.  

  
Relative address = /training/schedule.xlsx  
Full URL = http://wsgsrv/training/schedule.xlsx 

// (two slashes)     

 A relative URL that begins with // (2 slashes) always replaces everything from the 
hostname onward. 

    
Relative address = //sales-content/contracts.html 
Full URL = http://sales-content/contracts.html 

<targetfilename> (no notation)  

 An Address field that contains a target file with no relative URL notation characters 
points to the base URL. Therefore, if the target file is located in the base URL folder, 
you can enter the file name without a relative URL notation. 
  

Relative address = default.html 
Full URL = http://wsgsrv/hr-content/en/us/default.html 

Note: You cannot use URL conventions to navigate to an address higher than the root of the 

base URL path.  
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Enter an Absolute URL  

You can link to another URL outside of the base URL path if you enter an absolute URL in the 

Address field. Typing http:// or https:// in the Address field indicates that you are not entering 

a relative URL, and therefore, not using the base URL path.  
  
Relative address = http://xyzserver/salescontent/home.html  
Full URL = http://xyzserver/salescontent/home.html  

12.2.4 Preview Relative URL Links 

If you have set a base URL in the Options dialog box that is accessible, you can preview your 
relative URL links to ensure their accuracy. If you set an incorrect path to the hyperlinked 
content or one that is not accessible at this time, the system cannot preview the outline 

content. However, the link may still be valid once the content is fully deployed. 
  
There are three places to preview a relative link; in the Insert Hyperlink dialog box, in the 
Concept pane in the Outline Editor, and in a topic preview. 
  

Insert Hyperlink Preview  

You can preview a link after typing it in the Insert Hyperlink dialog box by clicking the Go 
button in the dialog box. If the Full URL is accessible and is correct, the target web page 
appears in the dialog box. 
  

Concept Pane Preview  

You can preview a relative link used as the concept of a module, section, or topic from the 
Concept pane in the Outline Editor. If you link a relative URL without setting a base URL, a 
message notifies you that the base address is not set. 
  
A concept may link to a relative URL in several ways:  

 The concept is the URL link 
  

You can test this link by selecting the document in the outline and viewing the results 

in the Concept pane. 
   

 A web page linked to the concept contains a hyperlink to a relative URL that you 

manually inserted 
  
You can test this link by clicking the link in the Concept pane to see if the correct 
target opens. 
   

 A web page linked to the concept contains a glossary term that links to a relative URL 

  
You can test this link by clicking the link in the Concept pane to see if the correct 
target opens. 

Note: You are not able to preview relative URLs in the Concept pane if you suppressed the 

preview of URLs and/or web pages on the Preview page in the Options dialog box. 
  

Topic Preview  

You can use Preview in the Outline Editor to preview single topics in Try It! mode and check 
the relative URLs in frame links, manual bubble text links, and glossary links. 
  
Tip: After the web content is deployed, you can change the base URL in the Options dialog 
box to the final location. 
  

Document Preview  

Only relative URLs appear in previewed or published documents. Depending if the document 
type you are previewing includes attachments, you can view the relative links in topic 
concepts and frame links. Although the links appear clickable in the previewed document, they 
do not resolve with the base URL as they do in the Player. During document preview, the 
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Developer defines the base path (./) as a location in your local Preview folder, which means 

that the links do not point to the full URL. 

  
Note: The relative links in published documents only point to the correct target if the 
documents are placed in the base URL folder of the hyperlinked content on the deployment 
server. See Publish Relative URL Links in the Work with Relative URLs section of the Enhance 
Content with URLs chapter for more information. 

12.2.5 Publish Relative URL Links 

Relative URLs are used because there are situations where the exact deployment location is 
not known at the time of content authoring. You know the document structure of the 
Internet/intranet site to which you are linking, but not the server location. By using a relative 
URL, you can create the hyperlinks and set the base URL path after publishing. 
  

Player Outputs: Updating the Root Location  

The Publishing Wizard uses the location of the Player's index.html file as the base URL path to 
resolve the relative links; however another base URL path can be specified after publishing. 

  
For the Player/LMS and HTML outputs, you can set the base URL path by editing the 'baseUrl" 
variable located in the config.js JavaScript file in the root of the published PlayerPackage 
folder (same level as play.exe). After adding the base URL to the JavaScript file, the relative 
links update during runtime. Updating the base URL in post-processing ONLY applies to 

relative URLs; there is no impact on absolute URLs. 
  

To edit the base URL path, open the config.js file in Notepad and navigate to the "baseUrl" 

variable. To add the correct base URL, enter the path between single quotes, as shown in the 
example below. 

  
baseUrl='http://wsgserver/en/us'; 

  
Post-processing the base URL by editing the JavaScript file only applies to Player/LMS and 
HTML outputs. In LMS deployments, the relative URL must be updated prior to importing the 

content into an LMS to ensure that the proper path is resolved. 
  
Note: You should check the content links after deploying the Player content and linked 
content on the web server(s). 
  
Warning! If JavaScript is turned off, the post-processing does not run and the paths to the 

relative links cannot be updated. 
  

Document Outputs  

Unlike Player outputs, the relative links in published documents are not updatable post-
publishing. When you open a published document, only the relative links appear, but the links 
are active, and can be clicked. The Developer defines the base path (./) for documents as the 

location where the document is stored and uses that path to resolve the relative URL. 
Therefore, if you want to be able to use relative links to open a target URL while viewing a 
document online, the document must be stored in the base URL location of the deployed web 

content; then the relative links resolve to the correct full URL. 
  
If storing the linked content and the documents in the same location on the web server is not 
possible, another option is to omit the relative links from published documents. All document 

output styles (System Process, Job Aid, Test Doc, Training Guide, Instructor Manual, 
Presentation), except the Test Case, have an Include Relative Links publishing option. This 
option allows you to control whether the links appear in the output. 
  
Note: If you want to include links in your documents and you cannot resolve the relative links, 
you may have to manually edit the links in each document post-publishing with absolute URLs 

so that they work properly for each document. Another option is to wait until the web content 
is deployed, and then replace all of the relative URLs in the Developer content with absolute 
URLs and republish as necessary. 
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13 Enhance Content with Sound 
The Developer provides the tools that you need to create and edit sound to deploy in your 
content without any specialized audio applications. You can add sound during topic recording 

using the Recorder (with sound enabled) or to an existing topic using the Topic Sound 
Recorder.  
 
Once recorded, you can use the Sound Editor to make adjustments to recordings.  
 
Sound can be created on a frame by frame basis but when you edit a frame, the sound file for 

the previous and next frames (if they exist) are combined with the current sound file. This 
allows for a seamless adjustment of sound with the neighboring frames. Once saved, the files 
are split back out to the associated frames but are stored together with the sounds that make 
up the topic.  

13.1 Sound Recording Best Practices 
Audio recording is a noise-sensitive process that requires a quiet space, free from typical 
ambient office sounds such as voices, phones, air-conditioning, street noise, and so on. 

Choose an office space to record in that has minimal evident street noises. Listen for air-
conditioning hum, voices, and other obvious noise in the space. If there are blinds in the 
windows, lower them to further reduce outside noise. If you are recording in more than one 
session, be sure to record in the same space each time. This reduces obvious changes in 
sound quality. 
 

Selecting a Microphone 

There are many microphones available to use with your computer. DO NOT use the internal 
microphone on your computer; it is not appropriate to record narration, as it picks up hard-
drive and cooling-fan noise. USB microphones are primarily made for low budget applications 
and are not recommended for professional recording. These microphones tend to add 
background noise and have limited dynamic range. 

 

Noise cancellation or rejection microphones are recommended. These microphones only pick 
up the sound from directly in front of the microphone. A windscreen helps cut the sound of the 
speakers breathing. Some microphones listen for sound from all directions and are not 
recommended because they pick up extraneous sounds during recording. 
 
Microphones designed for the telephone are not a good choice because they usually use only 

mid range frequencies to reduce bandwidth requirements. Choose a microphone with a wide 
frequency range (100Hz to 15kHz). Analog microphones are preferable because they plug 
directly into the audio card microphone input and can take advantage of the computer's pre-
amp instead of the lesser quality pre-amp typically found in a USB cable. 
 
When using an external microphone, always turn off the Line In and Internal Mic controls to 
prevent interference in the recording quality. Close any extraneous applications on your 

computer, particularly those with alerts and sounds, such as email that has a new mail 
notification. These sounds record with the audio if not turned off. 

 
For additional microphone information, go to http://www.microphones.com. 
 

Position Microphone 

Choose a microphone with a headset mount or a stand. If you are using a free-standing 
microphone, always place the microphone in the same location to help ensure recording levels 
are the same for each recording session. With free standing microphones, you often have to 
turn up the gain to increase the signal enough to get a good recording. Turning up the gain 
also turns up the background noise. Moving closer to the microphone can eliminate the need 
to turn up the gain but often creates an uncomfortable position and is not ideal for long 

recording sessions. If you are using a headset, position the microphone several inches away 
and below your mouth so that when you speak, you are speaking over the microphone. This 
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reduces the risk of distorting the signal into the computer. A headset with a flexible boom 

microphone that moves with the speaker is ideal for long recording sessions. 

 

Create a script for your narration 

Scripts are helpful when you record audio. They ensure that the final presentation flows 
coherently and incorporates the appropriate level of detail, ensuring that the audio portion 

delivers easily and the message is clear and succinct. 
 
Create a test recording to determine the proper levels 
Record the narration for the first page of your presentation using the Sound Recorder's VU 
meter to monitor and review the audio for quality. 
 

Record in one session 

It is very clear when a narrator has recorded audio at different times and on different 
equipment. This can distract learners. If possible, plan enough time to record your 
presentation, play it back, and edit the audio in a single session. 
 

Set Sound Playback and Record Options 

Do not mute the speaker on your computer while you are recording because sounds are used 
to indicate Record and Pause states. 
 
To prevent feedback, set your Windows audio to mute the Playback microphone. 

13.2 Record Sound 
You can record sound at:  

 Content creation: When the content is created via the Recorder (for example, when 

recording a topic) or via the Sound Editor toolpane (for example, when recording 
sound on a new web page). 
   

 Post content creation: Using the Sound Editor toolpane (for example, replacing the 

sound on an existing web page). 

13.2.1 Enable Sound 

You enable sound in the Developer by selecting a few settings on the Options dialog box 

accessed from the Tools menu.  
 
Sound settings are located in the Recorder category: 
 

Recorder category 

 Sound Recording: Use these options to control how sound is recorded with a topic. 

  
Record Sound with Topic: By default, the recorder is not set to record sound with a 
topic. Click this option to enable sound recording on the Recorder. The display of the 

Recorder depends on the state of this option and the Screenshot capture mode 
(Automatic or Manual). See Recorder Logic in the Record Topic Content lesson for 
more on Screenshot capture mode. 

  
Note: This setting can be overridden on the Recorder at the beginning of the 
recording session. 
  

 Pause Sound Recording key: By default, the Recorder uses the PAUSE key to pause 

sound recording for a topic. If the PAUSE key is difficult or inconvenient for you to use, 
you can change the Recorder Sound Pause key. You can use any of the function keys, 
or a combination of any of the function keys (F1 through F12) and the ALT key, CTRL 
key, and/or SHIFT key. 
  
If you change the Sound Pause key, you should select a key or key combination that is 
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not used in the target application for another purpose. For example, pressing the F1 
key in some applications opens a Help window. Therefore, for those applications you 
would not want to use the F1 key to pause sound recording. 

13.2.2 Configure the Recorder for Sound 

The Recorder behavior varies based on how the Screenshot capture mode (Manual or 
Automatic) and Sound Recording (Record sound with topic) are set.  
 

The Recorder behavior is summarized below. 

 Record Sound with Topic is On 
  
Screenshot capture is Manual: Sound icons are active. "Press PrintScreen to begin 
Recording" message displays. The Recorder records Start Screen sound. A screenshot 
(with associated sound) is recorded with each additional PrintScreen. 

  

Screenshot capture is Automatic: Sound icon is On. "Press PrintScreen to record 
Start Screen Sound" message displays. The Deskband activates and Start Screen 
sound is recorded. A second PrintScreen begins recording a screenshot for each 
keystroke (and sound if any) until the next PrintScreen. The camera icon flashes to 
indicate when a screenshot is taken. 
   

 Record Sound with Topic is Off 
  
Screenshot capture is Manual: Sound icon is muted, volume and VU meter 
disabled. "Press PrintScreen to begin recording" message displays. The Start Screen is 

recorded. A screenshot is recorded with each PrintScreen. A camera clicking sound 
indicates when the screenshot is taken. 
  
Screenshot capture is Automatic: Sound icon is muted. The Deskband activates 
and keystrokes are recorded until the next PrintScreen. No sound is recorded. The 
camera icon flashes and the camera clicking sound indicates when a screenshot is 
taken. 

13.2.3 Record Sound When Recording a Topic 

If sound is enabled in Tools, Options, the icons for recording sound appear at the bottom of 
the Recorder. 

  

 Opens the Author Notes dialog box for adding comments or testing notes. 
  

 Starts recording sound on the current screen. This icon is only active until the first 
screenshot of the session is taken. 
 

 Opens the Sound Tuning Wizard for adjusting sound playback and recording volume. This 
icon is only active in Pause mode. 

 

 Visual indicator of the amplitude of the speaker's voice. 
 
How these icons function depends on the Screenshot capture mode (Manual or Automatic). 

13.2.4 Use the Recorder Deskband in Automatic Record Mode 

A deskband is a dockable window on your desktop that is designed to minimize programs you 
want to keep running but only use on occasion. These programs do not take up space on the 

Taskbar and only display when necessary. 
 
If the Recorder is configured to record sound and set to record screenshots automatically, the 
camera sound that occurs when recording a frame is disabled so it is not part of the recording. 
When you press PRINTSCREEN during the recording process, the Recorder deskband appears 
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in the taskbar providing a visual camera cue that a screenshot is being taken. The Recorder 

deskband also contains other icons to make adjustments to sound recordings. 

 

 Opens the Author Notes dialog box for adding comments or testing notes. 

  

 When sound is being recorded, the Pause button displays. 

  

 When sound recording is paused, the Record button displays. 
 

 Opens the Sound Tuning Wizard for adjusting sound playback and recording volume. This 
icon is only active in Pause mode. 

 

 This is a visual scale depicting the recording level. Levels range from no color (no recording 
level), through Green, Dark Green, Yellow and Red (Very High recording level). 
 

 This visual indicator appears when a screenshot is taken if the Recorder is configured to 

automatically record screenshots. This space on the deskband also displays the type of context 
being recorded. See Context Recognition in the Recorder in the Record Topic Content section 
of the Content Development Guide for more information. 

13.2.5 Record Sound in a Topic using the Sound Editor 

Record Sound  on the Sound Editor toolpane of the Topic Editor lets you record sound on a 

frame or series of frames of an existing topic. 
 
The mode of the Sound Recorder depends on the selection when the Record Sound button is 

pressed. If a sound segment is selected, the Sound Recorder opens in Record Selection mode 
and the new sound replaces the selected segment. If nothing is selected, the Sound Recorder 
opens in Record Frame mode and the new sound replaces the sound on the frame. 
  
You can select and tune a recording device in the Sound Tuning Wizard. The Sound Recorder 

displays the name of the selected device. If the selected device is not connected, a message is 

displayed. You can either reconnect the device or run the Sound Tuning Wizard and select 
another device. 
 
Note: Record Sound is inactive on selections that cross frames.  
 

To record sound on an existing topic or web page: 

1. Click the location in the waveform where you want to record sound. 

  

2. Click  Record Sound. 

  
The Sound Recorder opens in Record Sound mode and recording begins. 
  

3. Record the desired sound using the  or  to navigate the frame structure if 

recording over multiple frames. 
  

4. Click OK when you are finished recording. 

13.2.6 Record Sound in a Web Page using the Sound Editor 

Record Sound  on the Sound Editor toolpane of the Web Page Editor lets you record sound 

on a web page. 
 
The mode of the Sound Recorder depends on the selection set when the Record Sound button 
is pressed. If a sound segment is selected in the waveform, the Sound Recorder opens in 

Record Selection mode and the new sound replaces the selected segment. If no selection set is 
made in the waveform, the Sound Recorder opens in Record Sound mode and the new sound 
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displays in the waveform if no sound has previously been recorded or replaces any sound 
previously recorded in the waveform on the web page. 

  
You can select and tune a recording device in the Sound Tuning Wizard. The Sound Recorder 

displays the name of the selected device. If the selected device is not connected, a message is 
displayed. You can either reconnect the device or run the Sound Tuning Wizard and select 
another device. 
 

To record sound on a web page: 

1. Display the Sound Editor toolpane in the Web Page Editor. 

  

2. Click  Record Sound. 

  
3. Record the desired sound. 

  
4. Click OK. 

  
The newly recorded sound covers the entire waveform and replaces any exiting sound 
on the web page. 

To record over a selected sound segment on a web page: 

1. Display the Sound Editor toolpane in the Web Page Editor. 
  

2. Left click and drag in the waveform to select the sound segment to be recorded over. 
  

3. Click  Record Sound. 

  
The Sound Recorder opens in Record Sound mode and recording begins. 
  

4. Record the desired sound. 
  

5. Click OK. 

  
The newly recorded sound replaces the selected sound. 

13.2.7 Insert Sound 

Insert Sound allows you to insert a new segment of sound into the waveform. For example, if 

you need to insert a new sentence or paragraph into your recording, you can insert the sound 
instead of rerecording the entire sound file. Clicking Insert Sound opens the Sound Recorder in 
Insert Sound mode. The toolbar is identical to Sound Recorder in Record Frame mode but the 
new sound is inserted at the selection point without overwriting the existing sound in the 
waveform. 
 

Note: Insert Sound is inactive if a segment is selected in the waveform. Sound can only be 
inserted at a marker in a waveform. 
 

To insert sound: 

1. Click the location in the waveform to insert a new recording. 

  

2. Click  Insert Sound. 

  
The Sound Recorder opens in Insert Sound mode and begins recording. 
  

3. Record the desired audio. 
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4. Click OK. 

  
The new sound is added to the waveform without overwriting the existing sound. 

13.3 Import a Sound File 
If you have access to a prerecorded sound file that you want to use in your content, you can 
import the sound file. Supported file formats include .aiff, .aif, .au, .mp3, .snd, .wav or .wma. 
The imported sound file is embedded into the topic. 
 

Note: You cannot import an .mp3 file into a web page. 
 

Importing .mp3 files into topics 

You can import an .mp3 file into a topic but you cannot edit it in the Sound Editor. To edit an 
.mp3 file, export it, edit it using a valid MP3 editor and import the file back into the Sound 
Editor. 
 

Note: You can import sound files in bulk to a Library. This allows you to use a central folder 

for your sound files. See Import Sound Files in Bulk in Export/Import Content for more 
information. 
 

To import a sound file: 

1. From the Sound Editor toolpane select the frame or web page where you want to 
import a sound file. 

  

2. Click  Import Sound. 
  

3. In the Import Sound dialog box, click the Look in list and choose the drive where the 
file is located. 
  

4. Open the folder where the file is located and choose the desired sound file. 

  
5. Click Open. 

  
The sound file is imported into the selected frame or web page. 

13.4 Export a Sound File 
After you have recorded sound for your content, you can edit it or use it in another application 
by exporting the sound file. 
 

Note: You can export sound files in bulk from your outline. This allows you to use a central 
folder for your sound files. See Export Sound Files in Bulk  in Export/Import Content for more 
information. 
 

To export a sound file: 

1. From the Sound Editor toolpane select the frame or web page with the sound to export 

and click  Export Sound. 

  
2. Navigate to the destination export location and select (or enter) a file name. 

  
3. Click Save. 

13.5 Edit Sound 
The Developer has a fully functional Sound Editor built in to the Topic Editor. You can edit 

sound frame by frame or across frames on a topic or edit the sound on a web page using the 
Sound Editor toolpane.  
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Note: Each time sound playback or recording is started, the Sound Editor checks to see if the 
playback and recording device last used are still available. If the device is no longer 

connected, a warning message displays. You can reconnect the device and click OK or click 
Cancel to launch the Sound Tuning Wizard. See Adjust Sound Controls in the Enhance Content 

with Sound chapter of the Content Development guide for more information on the Sound 
Tuning Wizard. 

13.5.1 Sound Editor Toolpane 

The Sound Editor toolpane is used to manipulate the sounds associated with each frame of a 
topic or a web page. The Sound Editor toolpane is made up of a waveform and a toolbar. 
 
The waveform is a visual representation of the shape and form of the sound signal. You can 
use the Sound Editor controls to locate, select and edit, all or parts of the sound in the 

waveform. 
 
Note: When you edit sound for a topic, the Sound Editor toolpane displays a temporary sound 
file made up of the current frame and the sound from the previous and next frames (if they 

exist). When the file is saved, the sound file is stored as three separate sound files. 
  

 Opens the Import Sound dialog box for importing sound into the current frame or web 
page. 
  

 Opens the Export Sound dialog box for exporting sound from the current frame or web 
page. 
  

 Launches the Sound Recorder - Record Sound dialog box to record sound on a frame or 
frames or on a web page. 

  

 Opens the Sound Recorder - Insert Sound dialog box in insert mode so a new piece of 
sound can be added at the insertion point without overwriting any existing sound. 

  

 Plays the sound from the beginning of the waveform or from a selection point if one is 
selected. 

  

 Pauses the playback of a sound file. Once the Play or Play frame buttons are pressed, they 

are replaced by the Pause button. 
  

 Plays the sound from the beginning to the end of the current frame. This icon does not 

display when editing sound on a web page. 
  

 Stops the playback of the sound file. 

  

 Cuts the selection to the clipboard and removes it from the waveform. 

  

 Copies the selection to the clipboard and retains it in the waveform. 

  

 Inserts the copied or cut selection. The selection is inserted at the cursor or replaces the 
selection. 
  

 Deletes the selection in the waveform. Deleting the selection reduces the timeline of the 
waveform. This is grayed out if nothing is selected. 

  

 Selects the current frame in the waveform when editing sound on a topic or selects the 
entire waveform when editing sound on a web page. 

  

 Deselects any selection set. 
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 Allows you to adjust the start of frame sound. When the icon is clicked, the cursor location 

becomes the new beginning of the frame. Any sound to the left of the cursor becomes part of 

the previous frame. You can also adjust the frame sound start position by dragging the frame 

start marker. If no previous frame exists, this button is grayed out. This icon does not display 
when editing sound on a web page. 
  

 Allows you to adjust the end of frame sound. When the icon is clicked, the cursor location 

becomes the new end of the frame. Any sound to the right of the cursor becomes part of the 
next frame. You can also adjust the frame sound end position by dragging the frame end 
marker. If no next frame exists, this button is grayed out. This icon does not display when 
editing sound on a web page. 
  

 Removes all sound that is not selected and replaces it with the selection. Frame markers 

are preserved when cropping sound in a topic. This button is grayed out if nothing is selected. 
  

 When editing sound in topic, this menu contains three preset zoom levels (Zoom to 

Current Frame, Zoom to Previous and Next Frame, Zoom to Selection) for zooming in the 
waveform. When editing sound in a web page, this icon zooms to the selection set in the 

waveform. The icon is grayed out when nothing is selected. 
  

 This menu contains options to extend the timeline, add silence in the waveform, and 

adjust the amplification of the sound level. 
  

 Opens the Sound Tuning Wizard for adjusting the playback and recording volume. 

13.5.2 Cut, Copy and Paste Sound 

The Topic Sound Editor contains tools for copying, cutting and pasting pieces of sound in the 
waveform. 
  

 Cuts the selected portion of the waveform to the clipboard. The waveform updates and 

removes the cut selection. Cut is disabled until a selection is made in the waveform. 
  

 Copies the selected portion of the waveform to the clipboard. The waveform is left 

unchanged. Copy is disabled until a selection is made in the waveform. 
  

 Inserts sound from the clipboard into the waveform. The pasted sound is added to the 

waveform at the insertion point. Paste is disabled unless something has been copied or cut to 
the clipboard. 
  

To copy and paste a piece of sound: 

1. Click and drag in the waveform to select the piece of the sound you want to copy. 

  

2. Choose  Copy. 

  
You can also right-click your selection and choose Copy. 
  

3. Select the desired location to paste your selection. 
  
The destination location can be within the current waveform or a waveform in another 
topic. 
  

4. Choose  Paste to paste a new instance of the copied sound. 

  
You can also right-click the waveform where you want to paste your selection and 
choose Paste. 
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To cut a piece of sound: 

1. Left click and drag in the waveform to select the piece of the sound you want to cut. 

  

2. Choose  Cut. 

  
You can also right-click your selection and choose Cut. 

To cut and paste a piece of sound: 

1. Left click and drag in the waveform to select the piece of the sound you want to cut. 
  

2. Choose  Cut. 
  

You can also right-click your selection and choose Cut. 
  

3. Select the desired location to paste your selection. 
  
The destination location can be within the current waveform or a waveform in another 
topic. 
  

4. Choose  Paste to paste a new instance of the copied sound. 
  
You can also right-click the waveform where you want to paste your selection and 
choose Paste. 

13.5.3 Delete a Sound 

If you do not want a segment of existing sound, you can delete it and compress the waveform 

by the size of the deletion. Delete is only active if a piece of sound is selected in the 
waveform.  

 

To delete a piece of sound: 

1. Left click and drag in the waveform to select the piece of the sound you want to 

delete. 
  

2. Click  Delete selection. 

13.5.4 Select a Frame 

When working with sound across frames, the sound displaying in the Sound Editor is often 
over more than just the current frame. If you want to work with only the sound on a frame, 
you can use Select Frame to highlight the piece of sound associated with the current frame. 
 

To select the current frame in the waveform: 

1. Choose  Select frame. 

  
The sound associated with the current frame is highlighted in the waveform. 

13.5.5 Deselect a Sound 

Many Sound Editor functions are applied against a selection that you make in the waveform. 
When a piece of sound is selected, either by Select Frame or by clicking and dragging in the 
waveform, the Deselect All icon becomes active. Use Deselect to cancel the selection displayed 
in the waveform. 
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To deselect a sound in the waveform: 

1. Choose  Deselect all. 

  
Any selected piece of sound in the waveform is deselected. 

13.5.6 Adjust the Start and Stop Point of Sound in a Frame 

When working with sound recorded over a series of frames, you may need to adjust where the 
sound begins and/or ends on a specific frame. You can make these adjustments with Set Start 

of Frame Sound  and Set End of Frame Sound  or by dragging the frame start and end 

markers. Any pieces of sound excluded from the frame by the adjustment become part of the 
sound for the previous or next frame. For example, if the start marker is moved 3 seconds to 
the right, those three second that were part of the current frame become part of the previous 
frame. If no previous or next frame is available, the icons are disabled.  

 

To set the start of frame sound: 

1. Click the location in the waveform of a frame where you want the current frame sound 
to start. 

  

2. Click  Set start of frame sound. 

  
The solid yellow vertical line marks where the frame sound starts. Any sound to the 
left of this marker that was previously in the frame becomes part of the previous 
frame sound. Any sound to the right of this marker that was previously in the frame 
become part of the sound for the next frame. 

To set the end of frame sound: 

1. Click the location in the waveform of a frame where you want to sound to end. 

  

2. Click  Set end of frame sound. 

  
The solid yellow vertical line marks where the frame sound ends. Any sound to the 
right of this marker that was previously in the frame becomes part of the next frame 
sound. Any sound to the left of this marker that was previously in the frame become 
part of the sound for the previous frame. 

13.5.7 Crop Sound to Selection 

When editing sound, you may need to remove the sound before and after the sound. For 
example, you made final edits and you want to discard some extraneous sound before and 
after your edited sound. You can make these adjustments by cropping sound with Crop to 

Selection  by selecting the sound you want to keep. All sound in the waveform not selected 

is replaced with the selection. Your selection set can be across frames which allows the frame 
markers to be preserved. 

 
If no sound is selected, the icon is disabled. 
 

To crop the sound in a frame: 

1. Click and drag in the waveform to select the piece of the sound you want to crop to. 

  

2. Click  Crop to selection. 

  
All frame sound in the waveform that is outside the selection set is replaced with the 
selection. 
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13.5.8 Zooming to a Sound 

When working with sound in the Sound Editor, the waveform often displays sound across more 

than one frame. The ability to zoom makes it easier to keep track of the frame sound on which 
you are working. 
 

The Sound Editor provides the following zoom modes: 

 Zoom to Current Frame: Centers the current frame in the waveform with portions of 
the previous and next frames on either side. The gray slider bar shows the duration of 
the current frame with respect to the entire sound file. 
  

 Zoom to Previous and Next Frame: Displays the entire waveform (previous, 

current and next frames). The gray slider bar spans the entire waveform. 
  

 Zoom to Selection: Displays the selected piece of sound in the waveform. The gray 

slider bar shows the duration of the selected sound with respect to the entire sound 
file. 

Once a zoom mode is selected, it remains the mode until a different mode is selected. The 
active mode is indicated with a checkmark in the Zoom menu. Dragging the gray slider 
changes the zoom and removes the checkmark next to the selected predefined zoom mode. 
 
Note: The Sound Editor toolpane in the Web Page Editor only contains the Zoom to Selection 
mode. 

 

To zoom to the current frame: 

1. From the Zoom menu, click Zoom to Current Frame. 

  
The current frame displays in the middle of the waveform with portions of the previous 
and next frame on either side. 

To zoom to the previous and next frames: 

1. From the Zoom menu, click Zoom to Previous and Next Frame. 
  
The entire previous, current, and next frames display in the waveform. 

To zoom to a selected piece of sound: 

1. Left click and drag in the waveform to select the piece of the sound you want zoom. 

  
2. From the Zoom menu, click Zoom to Selection. 

  
The selected sound only displays in the waveform. 

13.5.9 Adjust Sound Controls 

You can adjust the sound quality using the Sound Tuning Wizard. 
 

Step 1: Adjust the Playback Volume 

The first page of the wizard steps you through the selection of a sound playback device and 
adjustments to the playback volume. When the wizard is launched for the first time (after 
installation or upgrade), the playback device defaults to the sound playback default device set 

in the Control Panel. You can override this default on the wizard by selecting a different device 
from the Playback device list box. 
 
Note: Master volume and/or Wave volume controls differ by operating system. See your 
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operating system documentation if these adjustment sliders do not appear in the Sound 

Tuning Wizard on your operating system. 

  
Use the Play button to play a standard sound so you can adjust the volume settings. 
  
Note: If you press the Cancel button, volume changes are not saved. 
 

Step 2: Adjust the Recording Volume 

The second page of the wizard steps you through the recording device selection and the 
recording volume settings. When the wizard is launched for the first time (after installation or 
upgrade), the recording device defaults to the recording default device set in the Control 
Panel. You can override this default by selecting a different device from the Recording device 
list box. 

 
You have the option to manually or automatically set the recording level. If you choose to 
manually set the recording level, you can adjust the recording volume by moving the slider. 
The recording level meter is a color coded scale ranging from Too low to Too high with an 

Optimal recording level in between. Use the Record button to record sample audio and the 
Play button to play the sample to see the recording level. If you choose to automatically set 
recording levels, the volume defaults to 75%. When you record a sample, the level is adjusted 

to the 75% range. 
 
Note: If you are automatically setting the recording level, the Recording volume slider is 
disabled but moves to the appropriate level during recording. 
 

Step 3: Completing the Sound Tuning Wizard 

The final page of the wizard confirms completion of the Sound Tuning Wizard. It reminds you 
that the wizard appears again if the device settings are changed outside of the wizard or that 
you can launch the wizard directly from the Sound Editor. 
 
Note: Each time the playback or recording starts, the Sound Editor checks to see if the 
playback and recording device last used are still available. If the device is no longer 

connected, a warning message displays. You can reconnect the device and click OK or cancel 

to launch the Sound Turning Wizard. 
 

To adjust sound volume: 

1. Click  Sound Tuning Wizard on the Sound Editor toolbar. 
  

2. Choose a playback device in the Playback device list box, if necessary. 
  
Adjust the Volume slider and click Play to test the sample audio. 
  

3. Click Next to display the Adjust the Recording Volume page. 
  
Choose a recording device in the Recording device list box, if necessary. 

  

Choose Manual recording level setting or Automatic recording level setting 
option. If you selected the Manual recording level setting, adjust the Recording 
volume slider to the desired level. Try to keep the recording level as close to Optimal 
as possible. 
  

4. Click Record to record test audio. 

  
5. Click Stop to stop recording. 

  
6. Click Play to listen to the playback. 

  
Check the Recording level to see if the recording is at the desired level. 
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7. If you are manually recording level settings, adjust the Recording volume slider and 
repeat the test recording, if necessary. 

  
8. Click Next to complete the wizard. 

  
9. Click Finish. 

Note: If the sound settings have changed, the next time you play the sound a dialog box 
appears giving you the option to restore the previous setting, open the Sound Tuning Wizard 
to tune your settings or skip tuning and continue with the current settings. 

13.5.10 Extend Timeline 

You can add silence to the end of the waveform to extend the timeline. The time added is 
always at the end of the waveform regardless of what is selected. The silence added is 
designated in minutes and seconds. 
 

To add silence to the end of a frame: 

1. On the Options drop-down list, choose Extend Timeline. 
  

2. Select the amount of silence to be added using the spinbox control. 
  

3. Click OK. 

13.5.11 Add Silence 

Add silence allows you to add a user specified amount of silence at the point selected in the 
waveform. If a selection point is made in the waveform, the Add Silence dialog box opens 
allowing you to specify the amount of time (in minutes and seconds) of silence to be added at 
that point. If a piece of sound is selected in the waveform, silence replaces that piece of 
sound. If no selection point is made, silence is added at the beginning of the waveform. 
 

To add silence at a selected point: 

1. Select an insertion point in the waveform. 
  

2. On the Options drop-down list, choose Add Silence. 
  

3. Select the amount of silence to be added using the spinbox control. 
  

4. Click OK. 

To add silence over a selected piece of sound: 

1. Left click and drag to select a piece of sound in the waveform. 

  
2. On the Options drop-down list, choose Add Silence. 

  
The selected sound is replaced with silence. 

13.5.12 Amplify Sound 

Amplify allows you to increase or decrease the audio signal of the selected sound resulting in a 
louder or softer sound. 
 
Amplify is disabled if no sound is selected in the waveform. Once a selection is made in the 

waveform, the Amplify menu item is enabled. Use the slider control or spinbox to increase 
amplification by up to 400% or decrease amplification to as low as 1%. 
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To amplify a sound: 

1. Left click and drag in the waveform to select the sound to amplify. 

  
2. On the Options drop-down list, choose Amplify. 

  
3. Increase or decrease the amplification using the slider or spinbox control. 

  
4. Click OK. 

13.6 Play Sound 
After you have recorded or imported sound, you can play it to verify the audio. You can play 
sound for a single frame, a series of 3 consecutive frames, or a selection in the waveform. 
  
Since sound can be recorded over a series of frames, the sound playback may cover more 

than one frame. The sound that displays in the waveform is one temporary sound file that 

maybe made up of the previous, current, and subsequent frames. This sound file is one file in 
the Sound Editor, but it is stored as three separate files. 
  
Note: You need Flash 9.0 or later to play content with sound through the Player or when 
previewing topics from the Outline Editor. Flash is not necessary to play sound that is 

embedded as a concept from the Outline Editor. 
 

To play the entire sound file on a web page: 

1. Click  Play without making a selection in the waveform. 

To play the entire sound file on a topic: 

1. Place the cursor at the beginning of the previous frame or do not make a selection in 

the waveform, then click  Play. 

To play the sound file from a selection point to the end of the file: 

1. Click a selection point in the waveform. 

  

2. Click  Play. 

To play a selection of a sound file: 

1. Select a beginning point and drag to select the end point in the waveform. 

  

2. Click  Play. 

To play the sound associated with a frame: 

1. Click  Play Frame. 

To pause the sound file: 

1. Click  Play or  Play Frame. 
  



  Enhance Content with Sound 

   321 

The playback begins and the button changes to the Pause button. 
  

2. Click  Pause. 

  
The playback pauses. 
  

3. Click  Pause again to resume playback. 

13.6.1 Stop Sound File Playback 

You can stop a sound file at any point during the playback. Stopping the playback sets the 
sound file back to the starting point; it does not pause the sound file at the point at which you 
stopped playback. 
 

Note: The starting point of playback can be the beginning of the sound file, the selection point 
in the wave file or the beginning of a selected section of the waveform. 
 

To stop the playback of the sound file: 

1. Click  Play or  Play Frame. 
  

2. Click  Stop. 
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14 Enhance Content with Questions and 
Assessments 
Questions test a user’s skills, competency, and learning in the subject matter. Questions can 
appear directly in the table of contents in the outline for a Player or document output, or they 

can be included in assessments. An assessment is a collection of questions and topics used to 
test a user's knowledge of larger portions of content. 
  
Questions and assessments can be published to the Training Guide and Instructor Manual print 
styles. This can be set using the Include Assessments and Include Question options on the 
Training Guide or Instructor Manual Document outputs. Questions and assessments that are in 
an outline are published to print outputs. Related assessments are grouped together in the 

output under the title Associated Assessments. 
  
Note: You can add questions and assessments to publish to other print styles besides the 
Training and Instructor Manual styles. Questions and assessments are not part of In-

application support launches. See Insert Bookmarks for Questions and Assessments and 
Bookmark Reference under the Customize Document Formats section in the Publish Content 

chapter of this guide for more information. 
  
Questions and assessments have properties that are global defaults but can be changed for 
individual questions or assessments. The properties set for the assessment override individual 
properties set on each question to ensure consistent presentation of the questions in the 
assessment. See Question Properties and Assessment Properties in the View Document 
Properties chapter of this guide for more information on these properties. 

14.1 Questions and Assessments in Player Content 
How a user interacts with questions and assessments in the content depends on the 
deployment method and the settings you choose. For example, there are specific pre-
assessment and post-assessment options that you can set in the Professional edition of the 

Knowledge Center. It is important to know your deployment method, understand what user 
options are available for questions and assessments in that deployment, know if usage 
tracking is available in your deployment, and have a general understanding of how you want 

to utilize questions and assessments in your content before you start creating them. 

14.1.1 Questions in Player Content 

Questions that appear in the table of contents (linked directly to the outline) are also called 
inline questions. Inline questions often follow a topic and may test comprehension of the 
concepts linked to the topic or evaluate proficiency with specific procedures.  
 
Depending on the question type, users may be required to select one or more answers, type 

the answer text, click an area of a graphic, or select matching items. Users can select the Do 
Not Know option if they do not wish to guess. If questions are being tracked, selecting Do Not 
Know counts as an incorrect response. 
  

When creating questions, you should use the question's Associated Content property to link it 
to the module, section, or topic on which the question is based. Setting the Associated Content 
property provides the following advantages:  

 Question remediation: A Show Associated Content link appears after the user 
answers a question. Clicking the link allows the user to open the document linked to 
the question. However, you can disable the Show Associated Content link for questions 
in assessments. 
   

 Assessment analysis: Associating content with assessment questions allows you to 

use the Assessment Coverage View to analyze if you are providing a balanced 
assessment that adequately covers the content. 
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 Personalized content: For content deployed in a Knowledge Path (available in the 

Professional edition only), users can view a filtered version of the full content based on 
assessment results. 

Question Remediation 
Remediation provides feedback after the user answers a question. In the Developer, authors 
can set the type of question feedback for each question. Feedback can simply indicate if the 
answer was correct or incorrect, show the correct answer if the user answers incorrectly, 
display remediation text fully explaining the correct answer, or provide a link to view the 
remediation. See Remediation Property in the Question Properties section of the View 

Document Properties chapter for more information about remediation. 
  
Your decision to include remediation for questions may depend on your deployment method. It 
is a good idea to provide complete remediation as a learning tool. Users who answer a 
question incorrectly are highly motivated at that time to know why their answer is wrong and 
understand the correct response. The correct answer, along with remediation text with a 
reason why the answer is correct, and a link to the content on which the question is based, 

provides an opportunity for a memorable learning event and reinforcement. However, if you 
are tracking user responses in the Knowledge Center or an LMS, you may want to refrain from 
providing remediation for pre-assessment or inline questions until the user takes a post-
assessment so that you can compare scores and gauge the effectiveness of your content. 
  
When content is deployed through a Knowledge Path in the Knowledge Center (available in 

Professional edition only), a pass  or fail  indicator appears next to the question in the 

table of contents after answering a question. 
 

Note: In the Professional edition of the Knowledge Center, you can choose to honor the 
question remediation settings from the Developer or override these settings with another 
remediation option. You can also override assessment remediation settings. 

14.1.2 Assessments in Deployed Content 

Assessments are containers that can hold one or more questions. In addition to questions, 

assessments can also include topics. Topics are added to an assessment as Know It? 
questions; meaning that only the Know It? play mode is included. Know It? questions evaluate 
skills; they test if a user can independently perform the topic procedures with minimal 

prompting. After the user takes an assessment, an Assessment Summary page appears 
showing the assessment results. 
  
Assessments that are directly linked to modules and sections in the outline appear in the 
outline's table of contents and are known as inline assessments. Assessments may also be 
associated with module and section documents in the outline. These associated assessments 
do not appear in the table of contents, but can be designated as pre-assessments and/or post-

assessments for content deployed in the Professional edition of the Knowledge Center or LMS. 
Associated assessments do not appear in a Player output.  
  
Assessments have their own remediation property in the Developer that overrides the 
remediation settings for each individual question in the assessment. A uniform assessment 

remediation provides a consistent look and feel for the assessment.  

  
Note: In the Professional edition of the Knowledge Center, you can choose to honor the 
assessment remediation settings from the Developer or override these settings with another 
remediation option.  
  
Although assessments are often presented along with the published content, assessments can 
also be deployed as individual activities. If you are employing user tracking, you can use an 

assessment to perform a needs analysis before you begin development. The results of the 
assessment can help you determine a baseline of what your audience knows, and therefore a 
starting point for developing your content. This saves the time, money, and the effort of 
developing needless content. Conversely, presenting an assessment a few days or weeks after 
a user completes the content shows the effect of training retention.  
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Note: If you are deploying content in the Professional edition of the Knowledge Center, 

assessments can be used to determine personalized content. Personalized content is a filtered 

version of the full content based on the assessment results. See Understand Personalized 
Content in this chapter.  

14.1.2.1 Inline Assessments 

Assessments can be directly linked to a module or section in the outline and appear in the 

table of contents. Assessments that appear in the outline are also known as inline 
assessments. Assessments can be placed anywhere in the table of contents as a child 
document of the module or section to which it is linked. For example, an assessment in the 
outline at the end of a module or section can function as a review of the material in that 
module or section.  
  

Inline assessments can function as pre-assessments and post-assessments by where they are 
placed in the outline. In a Player output, an assessment that precedes a section of content lets 
the user know what content areas they need to learn and what they can skip. An assessment 
that follows a section of content lets the user know what content they need to re-review to 
gain competency in the subject matter.  

  
In the Knowledge Center (Professional edition only), inline assessments can be used to create 

personalized content.  

14.1.2.2 Pre- and Post-Assessments (available in Professional edition only) 

After bringing published content into the Professional edition of the Knowledge Center, you can 
set up knowledge paths and activities, and specify pre- and post-assessments and choose the 
settings for each.  

  
In the Knowledge Center, only assessments associated with the parent document added as an 
activity to a Knowledge Path can be designated as pre- and/or post-assessments. Inline 
assessments directly linked to the outline cannot be selected when setting up the pre- and 
post-assessment for an activity. Assessments associated with sub-level headings (not linked 
as an activity) are ignored. Assessments are associated with a parent document through the 
Assessments property in the Properties toolpane in the Developer.  

 
A pre-assessment appears before the user starts an activity and records baseline knowledge 
prior to viewing the content. A pre-assessment can be set as a required activity, which means 
that the user must take the pre-assessment before starting the content. Pre-assessments can 
only be taken once. When setting up a pre-assessment in a Knowledge Path, an author can 
designate a place-out score. When a user’s assessment score meets or exceeds the place out 

score, the content associated with the assessment is marked as completed and the user can 
bypass the subject matter and proceed to the next activity. 
  
A post-assessment appears after the subject matter and can also be set as a required activity 
with a required passing score, which specifies the score that users must achieve before 
advancing to the next activity. Post-assessment scores can be compared with pre-assessment 
scores to determine the level of knowledge gained from completing the subject matter. Pre- 

and post-assessments also help define personalized content. 
  

An Assessment Summary page appears after the user takes a pre- or post-assessment. The 
Assessment Summary page in the Professional edition of the Knowledge Center provides 
options for taking personalized content and selecting the content to be included. You can, 
however, use the Manager in the Knowledge Center to disable the appearance of the summary 
page for a pre-and/or post-assessment if personalized content is not enabled. 

  
Note: When publishing content to be used in a knowledge path, you can publish the entire 
outline and add the individual sections of the outline as activities to the knowledge path. It is 
not necessary to publish each activity separately.  
  
See Activity Properties in the Create a Knowledge Path section in the Manage Knowledge Paths 

chapter of the User and Content Management guide for more information on Assessment and 
Summary Page options in the Knowledge Center.  
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14.1.2.3 Assessment Summary Page 

After taking an assessment in the Player, Knowledge Center, or LMS, an Assessment Summary 

page may appear if it is enabled. This page displays the assessment results, which include the 
number of questions in the assessment and the number questions answered correctly, along 
with the user's score as a percentage.  
  
The Assessment Summary page also includes a Section Summary and Response Summary. 
The Section Summary displays a breakdown of each document (module, section, or topic) 
directly linked to the same parent as the assessment and the user's score as a percentage for 

each. A correctly answered question is scored as 100% and a failed question as 0%. 
Therefore, if a user correctly answers 3 out of 4 questions linked to a section, the pass 
percentage for that section would be 75%. The Response Summary displays a list of the 
questions indicating if they were answered correctly or incorrectly. After viewing the results, 
users can print this page. 
  

In deployment methods that include content tracking, users can return to the Assessment 
Summary page at any time in post-assessments and inline assessments by selecting the 

assessment in the outline and clicking the Show Summary link in the Concept pane. If content 
is deployed without tracking, the summary page results are not available once the user selects 
another outline item.  
  
Note: The section breakdown and score is based on linking the outline documents to the 

Associated Content property for questions. If assessment questions are not linked to the 
content, the Assessment Summary page does not include a Section Summary. 
  
You can choose to show or hide the Assessment Summary page in the Player using the 
Summary property on the Properties toolpane for the assessment. If the Summary is hidden, 
the Assessment Summary page does not appear upon completion of an assessment, nor can a 
user access it later. 

  

Assessment Summary Page in the Professional Edition    
The Assessment Summary page appears after the user takes a pre- or post-assessment. You 

can, however, use the Manager in the Knowledge Center to disable the appearance of the 
summary page for a pre-and/or post-assessment.   
  

In addition to providing assessment results, the Assessment Summary page in the 
Professional edition of the Knowledge Center provides options for taking personalized content 
and selecting the content to be included. If the section score falls below the passing score set 
for the assessment, the section content is required for the personalized content and cannot be 
excluded. Conversely, if the section score meets or exceeds the passing score, the user can 
optionally add the section that they passed for additional learning reinforcement.  

  
Since content is tracked in the Professional edition, users can return to a completed 
Assessment Summary page to view or print the results.  
  
See Activity Properties in the Create a Knowledge Path section in the Manage Knowledge Paths 
chapter of the User and Content Management guide for more information on Summary Page 
options in the Knowledge Center.  

14.1.3 Track Questions and Assessments 

Depending on your installation, responses to inline questions and assessments and pre- and 
post-assessments are tracked. Inline questions and inline assessments are tracked when 
deployed through the Player in the standard installation of the Knowledge Center or through a 
Knowledge Path in the Professional installation of the Knowledge Center. Tracking reports are 
available in the Reports section in the Knowledge Center for users with the appropriate 
permissions. You can run one of the sample custom reports, customize an existing report, or 
create a new one.  

  
In the Professional installation, additional reports are available for tracking pre- and post-
assessments, or you can create new reports using external tools, such as Microsoft Excel, to 
query the tracking database.  
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14.1.4 Understand Personalized Content (available in Professional edition 
only) 

Personalized content can be taken after a user takes a pre-assessment, post-assessment, or 

an assessment in the outline (inline assessment). Personalized content is a customized version 
of the full content based on a user's assessment results. Content that the user has mastered 
with a passing score in the assessment is not included in the personalized content.  
  
The purpose of the personalized content is to allow a user to complete an objective 
assessment of his/her skills in the subject matter and then take a subject, or retake a subject, 

that contains only the content upon which the user needs to focus. Personalized content does 
not create a new subject outline, but rather filters the full content to show only the content 
that is necessary for the user to learn.  
  
When you create an assessment, you should include questions based on, and associated with, 
the subject content. It is particularly important that these questions provide a representative 
sampling of the subject material if an organization uses the personalized content feature. For 

content to appear in personalized content, you must associate the questions in the assessment 

with the content (module, section, or topic) by setting the Associated Content property for 
each question.  
  
When a user completes an assessment, the Assessment Summary page displays a list of 
sections upon which assessment questions were based and the user's score on the questions 
for each section. A user can also choose to add content that has been successfully passed to 

the personalized content for additional reinforcement. Personalized content can be started 
from the Assessment Summary page. Users can switch between personalized content and full 
content at any time. Personalized content is only available if the Knowledge Center 
administrator has enabled the Personalized Content option for the content. 

14.1.4.1 Design the Assessment 

Personalized content can be enabled for inline assessments or pre- and post-assessments. You 
may choose to include a pre- and post-assessment associated with the major headings in your 
outline, but also include several smaller inline assessments to test retention just after 

learning. 
  
Note: To designate an assessment as a pre-assessment and/or post-assessment in the 

Professional edition of the Knowledge Center, you must associate the assessment to the 
parent level document using the Assessments property for the parent document. See 
Assessments for Personalized Content in this chapter for more information.  
  
When designing assessments for personalized content, you should start by identifying the 
sections (parent documents) of your content for which you want to test competency. Consider 
the amount of content coverage for each assessment (the level in the outline you want to 

associate with one or more assessments). You can create several smaller assessments linked 
to each subheading in your content or fewer, larger assessments linked to the major headings. 
  
Questions in the assessment can cover the concepts that appear in the Concept pane for 
modules, sections, and topics. They can also include important information found in action 

frames and Explanation frames. You can add topics (Know It? questions) to the assessment to 
test competency with a process. In Know It? mode, it is important that you include additional 

text in frames that need further explanation and remove frames from Know It? mode that 
contain actions you do not want to test.  
  
Use the Assessment Coverage View to make sure that your questions are associated with the 
content in your outline and the dispersal of your questions adequately covers the content. 
Personalized content is based on setting the Associated Content property for questions, so this 

is a mandatory step if you want to incorporate the Personalized Content feature. 
  
A common scenario for using personalized content is to include a pre-assessment and post-
assessment. After users take the pre-assessment, they can switch to personalized content 
based on the assessment results. The personal content includes only the content that was 
failed. After completing the personal content, users can take the post-assessment to see if 
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they have successfully mastered the content material and processes. Based on the post-
assessment, the user can continue reviewing the personalized content until it is fully 

mastered.  
  

Place-Out Scores  
Pre-assessments allow place-out scores. Place-out scores allow the user to skip content based 
on the results. Skipped content includes all the sub-level content associated with the 
assessment's parent. If you permit an assessment to place the user out of the content, make 
sure that your assessments are not placed at too high a level, in other words, covering too 
many processes or too much information causing a user to place out of too large a section of 
content. Place-out scores may result in users placing out of content they failed. For example, if 

you permit a place-out score of 80% for an assessment with five questions, the user can fail a 
question, score 80%, and never be required to learn the content associated with the failed 
question. If you are using place-out scores, it is a good idea to provide several questions for 
important concepts to thoroughly test competency and avoid placing out of content based on a 
single question. 

14.1.4.2 Configure Personalized Content 

The Assessment Summary page displays sections for the questions included in the 
assessment, each with a checkbox to its left. A user can select the sections he/she wants to 
include in the personalized content based on the individual scores. For example, a user would 
probably include a section for which he/she scored a 50% and exclude a section for which the 
score was 100%.  

 
Depending on the options set in Knowledge Center's Manager, some sections are selected by 
default on the Assessment Summary page. A training manager can set scores to exclude or 
include sections in the personalized content automatically. A training manager can also set an 
exclusion percentage which represents an acceptable score on a section. When a user meets 
or exceeds the exclusion percentage, he/she has demonstrated competency in the subject 
matter and does not need to include the section in the subject. The checkboxes to the left of 

sections meeting the exclusion percentage are unmarked by default. If desired, a user can still 
include these sections in the personalized content by selecting them. A training manager can 
also set a required percentage which represents an unacceptable score on a section. When a 

user falls below the required percentage, he/she has not demonstrated competency in the 
subject matter and needs to include the section in the subject. The checkboxes to the left of 
sections falling below the required percentage are marked by default and cannot be 

deselected. Sections with scores falling in between the exclusion percentage and required 
percentage are selected by default; however, a user can deselect these sections as desired. 
 
Each time a user takes an assessment, the personalized content results are updated to reflect 
the user's most recent score. A user can reconfigure the personalized content each time 
he/she accesses the personalized content results. 
 

When a user completes an assessment in the user interface, the Assessment Summary page 
displays a list of sections upon which assessment questions were based and the user's score 
on the questions for each section. 
 
Warning! Questions tied to the top level of the outline are not used in configuring the 

personalized content as you cannot exclude (or test out of) the entire course. 
  

See Activity Properties in the Create a Knowledge Path section in the Manage Knowledge Paths 
chapter of the User and Content Management guide for more information about setting up 
personalized content.  

14.2 Develop Questions 
There are six standard question types that provide a wide variety of ways to test a user's 
understanding of the content. Additionally, questions can be created in other applications such 

as Flash and brought into the Developer as User-Defined questions. 
 
Questions are created or edited using the Question Editor. You can create the following 
question types: 
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 Fill in: A question is presented and the user fills in an answer. 
   

 Hot Spot: An image is presented with hotspots (areas of the image) that the user 

chooses to identify the correct answer to the question. 
   

 Matching: A question is presented where the user must match the choices in the right 

column with the choices in the left column. 
   

 Multiple Choice (Single Answer): A question is presented where the user must 
select one correct answer from a list of possible answers. 
   

 Multiple Choice (Many Answers): A question is presented where the user must 
select more than one correct answer from a list of possible answers. 
   

 True/False: A question is presented where the user indicates whether a statement is 

true or false. 
   

 User-Defined: A question of any type created in another application and imported 
into the Developer. 

Questions can exist as standalone documents in an outline or grouped together in an 
assessment. Questions are stored in the Library so they can be reused. 
 
Note: You can modify the Question Template in the Library to customize the appearance of 
questions in the Developer and published output. See Customize Question Elements in the 
Customize the Player section of the Publish Content chapter of this guide for more information. 

 
There are four basic components in most question types (with the exception of the User-
Defined question): 

 Question text 

  

 Response text with correct answer 

  

 Remediation text that provides supporting feedback about the correct answer 

(optional) 
  

 Background image (optional except for hotspot questions) 

Each question type (except User-Defined) contains placeholders for adding the question text, 
responses and remediation. 
  
As you create a question, you can preview it at any time to review how it functions and 

appears to users. You can return to the question and continue editing as needed. In addition, 
you can change questions types at any time for a new or existing question using the Question 
type list in the Question Editor. Changing the question type applies the template for the 

selected type. Depending on the question type, some or all of your existing response text may 
not appear after you change question types. You can, however, return to the original question 
type to restore the text. 

 
The following icons appear on the Question Editor toolbar and vary depending on the question 
type: 
  

 Add Option: Adds a new choice to the question. If a response is selected, the new 

response is added after the selected one. If no response is selected, a new response is added 
to the end of the responses but before any static responses such as None of the Above or All 
of the Above. For Hotspot questions, this adds a new hotspot that is labeled with a number 
one more than the previous hotspot. 
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Applicable question types: Multiple Choice (Single Answer), Multiple Choice (Many Answers), 
Matching, Hotspot 
 

 Delete Option: Delete a selected choice to the question. For Hotspot questions, this 

deletes the selected numbered hotspot. 
Applicable question types: Multiple Choice (Single Answer), Multiple Choice (Many Answers), 
Matching, Hotspot 
 

 Update Link: Defines the location of the package containing the user-defined question 
code. 
 

Applicable question types: User-Defined 
 

 Update Image: Applies a background image to a question. This icon opens the 
Background Images Properties dialog box where you can select an image and assign 

alternative text that appears when you mouse over the image. After inserting the image, you 
can rearrange the image and question box by dragging them to other positions. To move a 

question box, drag it by the blue Question header at the top.  
 

You should size an image before inserting it in the question, since it cannot be resized in the 
Question Editor. You can, however, resize the width of the question box by horizontally 
dragging any of the square edit handles that appear after you click the box. You cannot make 
the question box smaller than its default minimum size. 
 

Only one image can be inserted into a question. Inserting a second image automatically 
replaces the first image. 
 

Applicable question types: True/False, Fill in, Multiple Choice (Single Answer), Multiple Choice 
(Many Answers), Matching, Hotspot 
 

 Delete Image: Deletes the background image for a question.  
 

Applicable question types: True/False, Fill in, Multiple Choice (Single Answer), Multiple Choice 

(Many Answers), Matching, Hotspot 
 

 Move Up: Moves a selected response choice up one row in the response choice list.  
 

Applicable question types: Multiple Choice (Single Answer), Multiple Choice (Many Answers), 
Matching 
 

 Move Down: Moves a selected response choice down one row in the response choice list.  
 

Applicable question types: Multiple Choice (Single Answer), Multiple Choice (Many Answers), 
Matching 
 

 Reset Layout: Resets the question to the default layout with the image positioned at the 
top left corner and the question/response box beneath it. This icon is only active when there is 
a background image. 
 

Applicable question types: True/False, Fill in, Multiple Choice (Single Answer), Multiple Choice 
(Many Answers), Matching, Hotspot 
 

 Edit: Indicates the Question Editor is in Edit mode so you can modify the question content. 

When you launch the Question Editor, it is in Edit mode by default. 
 

Applicable question types: True/False, Fill in, Multiple Choice (Single Answer), Multiple Choice 
(Many Answers), Matching, Hotspot 
  

 Preview: Displays the question as it would appear in published output such as the Player 

or LMS so you can interact with the question as a user.  
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Applicable question types: True/False, Fill in, Multiple Choice (Single Answer), Multiple Choice 

(Many Answers), Matching, Hotspot 

  
Note: A broken link can cause a question to be excluded from publishing. See Broken Links in 
Questions and Assessments in the Manage Document Relationships chapter of this guide for 
more information on possible reasons for broken links. 

14.2.1 Add Questions to Content 

There are several ways to create and add questions to content in the Developer.  

 Create a question in the Library: Questions created in the Library can be linked to 
one or more content outlines or added to assessments. 
   

 Add questions to an outline in the Outline Editor: Link new and existing 

questions to appear in the outline's table of contents. See Link a Question to an 
Outline in the Develop Questions section of the Enhance Content with Questions and 

Assessment chapter. 
   

 Add questions to an assessment using the Assessment Editor: Add new or 

existing questions to an assessment. See Add Questions to an Assessment in the 
Develop Assessments section of the Enhance Content with Questions and Assessment 
chapter. 
   

 Add questions to an assessment using the Assessment Coverage View: 

Analyze and balance assessments by adding new and existing questions to 
assessments using the Assessment Coverage View. See Work with the Assessment 
Coverage View in the Enhance Content with Questions and Assessment chapter for 
more information about using this view. 

Note: See the help for each question type in the Develop Questions section of the Enhance 
Content with Questions and Assessment chapter for more information about creating each 

question type. 

  

Assign Roles to Questions 

If you are using roles to filter your content for different audiences, you can create questions 
that are role-specific and assign the applicable role or roles to each question. When you 
publish by roles, only the questions assigned to that role are included in the published output. 
  

Note: If the questions are linked to an assessment, you must also assign the question roles to 
the assessment. For example, if different questions in the assessment are assigned to the 
Sales, Clerk, and Administrator roles, all of those roles must be assigned to the assessment if 
you want the assessment to appear in the role-specific published output. 

14.2.2 Create a Fill In Question 

Fill In questions require a user to read a question and type an answer.  Fill-in questions test a 
user’s recall rather than just recognition as in a multiple choice question. However, because 

fill-in questions require an exact text match, you should reserve this question type for specific 

response text. Fill-in questions may penalize a user for providing an acceptable alternative 
response or a spelling error. Be sure to phrase the question so that there is only one clear 
answer. In addition, it is best to restrict this question type to a single word, unless the phrase 
has no ambiguity.  
  
To create the answer for a Fill In question, it is necessary to enter the word or phrase in the 
Response area that constitutes a correct response. Fill In answers are not case-sensitive; 

however, a user must match the text in the Response field exactly. For example, if a user 
enters Window and the correct answer is window, the answer is correct. However, if a user 
answers Windows, the answer is incorrect. 
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To create a Fill In question: 

1. On the File menu, choose  New, point to  Question, and choose Fill In. 

 
or 
  

On the Library toolbar, point to  Question, and choose Fill In.  

   
2. Click Click to add question text and type the question text. 

  
3. Click the Response field and type the correct answer. 

  
4. Click Click to add remediation text and add remediation text, if desired. 

  
5. Save the question. 

14.2.3 Create a Hotspot Question 

A hotspot question includes a graphic with multiple highlighted areas or "hotspots" that 

prompts the user to identify the area of the graphic that constitutes the correct answer. 
 
To create a hotspot question, you should first include a background image. Background 
images can be stored on your computer or saved in package documents and stored in the 
Library. You should size the background image before inserting it into the question since you 
cannot resize it in the Question Editor. 

 
Once the background image appears in the hotspot question, you identify the hotspot areas by 

adding options. Each time you click  Add Option, a red box (with the number incremented 

by one) appears on the top left corner of the background image. If you add multiple hotspots, 
they appear one on top of the other. You can drag and drop the red box to reposition the 
hotspot. You can also drag any of the edit handles to resize a hotspot. 

  

Note: To delete a hotspot area, click the hotspot area to display the edit handles and click . 

 
When you view the question in Preview or in the Player, the question box may cover some of 
the background image and hotspots. You can reposition the question box by dragging it by its 
blue Question header to a new location. 

 

To create a Hotspot question: 

1. On the File menu, choose  New point to  Question, and choose Hotspot. 

  
or 
  

On the Library toolbar, point to  Question, and choose Hotspot. 

  

2. Click  Update Image to add a background image. 

  
3. Click Click to add question text and enter the question text. 

  

4. Click  Add Option and drag the red box labeled 1 so that it identifies the first 
hotspot area on the background image. 

  
5. Click the hotspot and drag the sizing handles to resize the hotspot accordingly. 

  
6. Repeat steps 4 and 5 for each hotspot that you want to add to the background image. 
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7. Select the hotspot number that represents the correct answer in the Response list. 

  

The number displays as the correct answer in the Correct field. 
  

8. Click Click to add remediation text and add remediation text, if desired. 
  

9. Save the question. 

14.2.4 Create a Matching Question 

Matching questions can be used to put a list of steps in the correct order or match the 
responses in one column to the questions in another column. 
 

Matching questions show a column of choices on the left and a column of responses on the 
right. The responses in the right column are numbered sequentially. Each choice in the left 
column has an answer box next to it where the user enters the corresponding choice number 
from the right column. The user can also drag the answer text from the right column over the 
corresponding answer box in the left column. The number automatically fills in the box. 

 

When creating the question text that appears above the match columns, you should explain 
how to answer the matching question. For example, “Match the terms and definitions by 
typing the number corresponding to the definition in the answer box next to the correct term. 
You can also drag the definition to the answer box.” 
 
There are three steps to complete for creating the matching question items: 

 Enter a series of choices in one of the columns. 

  

 In the remaining column, create any number of choices that match up with the choices 
in the other column, but in random order. A common use for a matching question is to 
match terms and definitions. You can place the terms and definitions items in either 

column. Generally it is recommended to place the shorter items in the response 
column on the right, since the user has to read through every choice in the response 

column to make each match. 
  
If the purpose of the matching question is to put steps in the appropriate order, you 
can type “Step 1, Step 2” and so on in the one column and type the list of steps in 

varied order in the other column. 
  
To make the matching question more challenging and reduce guessing, you can 
include more choices in one of the columns. 
  
You can also use a response multiple times; that is, a choice in one column can match 
more than one choice in the other column. For example, you may have categories in 

the right column that match several choices in the left column. For matching food 
groups, "fruit" would be the correct response for both "apple" and "orange". If 
responses are used more than once, it is a good idea to mention this in the question 
text; for example, "You can use the answers in the right column once, more than 

once, or not at all." 
  

 In the answer box for each choice in the left column, enter the number from the right 

column that creates the match. This establishes the correct answer order the user 
must enter to answer the question correctly. 

Note: If you choose to randomize answers in an assessment, the answers in the right column 
appear in a different sequence than the original creation order. 
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To create a matching question: 

1. On the File menu, choose  New, point to  Question, and choose Matching. 

  
or 
  

On the Library menu, point to  Question, and choose Matching 

  
2. Click Click to add question text and enter the question text. 

  
3. Click Click to add choice text and enter the first choice text in the left column. 

  
4. Press ENTER to create each subsequent choice and repeat step 3 for each choice. 

  
5. In the right column, click Click to add choice text and enter the first choice text. 

  

6. Press ENTER to create each subsequent and repeat step 5 for each choice. 
  

7. In the answer box next to each choice in the left column, enter the number of the 
matching response choice from the right column. 

  
The order displays in the Correct area. 
  

8. Click Click to add remediation text and add remediation text, if desired. 
  

9. Add a background image, if desired, and position the question on or around the image. 
  

10. Save the question. 

14.2.5 Create a Multiple Choice (Single Answer) Question 

Multiple Choice (Single Answer) questions require users to read a question and select one 

answer from a list of possible answers. To create the answer for a Multiple Choice (Single 
Answer) question, it is necessary to create a list of choices and then select the one option that 
constitutes a correct response. In the Response area, you create the choices to be displayed 
to users, and then mark the correct answer. To create challenging multiple choice questions, it 
is important that the incorrect choices be plausible. 
 

Two standard answers are also available for Multiple Choice (Single Answer) questions; All of 
the Above and None of the Above. You can choose the Include All of the Above or Include 

None of the Above option when all answers listed are correct or incorrect. You can also include 
both options to make the question more challenging for the user. These answer options always 
appear at the bottom of the list of answers. 
 

To create a Multiple Choice (Single Answer) question: 

1. On the File menu, choose  New, point to  Question, and choose Multiple 

Choice (Single Answer). 
 
or 
  

On the Library toolbar, point to  Question, and choose Multiple Choice (Single 
Answer). 
  

2. Click Click to add question text and enter the question text. 
  

3. Click Click to add choice text and enter the first choice text. 

  
4. Press ENTER and create each subsequent choice. 
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5. Click the Include All of the above and/or the Include None of the above options, 

if desired. 

  
6. Click the appropriate choice to indicate the correct answer. 

  
7. Click Click to add remediation text and add remediation text, if desired. 

  

8. Add a background image, if desired, and position the question on or around the image. 
  

9. Save the question. 

14.2.6 Create a Multiple Choice (Many Answers) Question 

Multiple Choice (Many Answers) questions require users to read a question and select more 
than one answer from a list of possible answers. The author can choose to tell the user how 
many answers to select by setting the Show the Number of Correct Answers option. The exact 
number of correct items appears in parentheses after the question. If the Show the Number of 
Correct Answers option is not set, the user must determine how many of the answers are 

correct. 
 

To create the answer for a Multiple Choice (Many Answers) question, create the list of choices 
and then mark which of those choices are correct. 
 

To create a Multiple Choice (Many Answers) question: 

1. On the File menu, choose  New, point to  Question, and choose Multiple 

Choice (Many Answers). 
  
or 
  

On the Library toolbar, point to  Question, and choose Multiple Choice (Many 

Answers). 

  
2. Click Click to add question text and enter the question text. 

  
3. Click Click to add choice text and enter the first choice text. 

  

4. Press ENTER and create each subsequent choice. 
  

5. Click the Show the number of correct answers option, if desired. 
  

6. Click the box to the left of the appropriate choices to indicate the correct answers. 
  

7. Click Click to add remediation text and add remediation text, if desired. 

  
8. Save the question. 

14.2.7 Create a True/False Question 

True/False questions require the user to read a statement and indicate whether it is true or 
false. To create the answer for a True/False question, it is necessary to select either the True 
or False option provided in the Response area. 
 

To create a True/False question: 

1. On the File menu, choose  New, point to  Question, and choose True/False. 

  
or 
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On the Library toolbar, point to  Question, and choose True/False. 
  

2. Click Click to add question text and enter the question text. 

  
3. Click the option to the left of the appropriate choice to indicate the correct answer. 

  
4. Click Click to add remediation text and add remediation text, if desired. 

  
5. Save the question. 

14.2.8 Create a User-Defined Question 

User-Defined questions are created outside of the Developer, using HTML, DHTML, 
Macromedia Flash, or another application. These questions may be of a type not available in 
the Developer, such as drag-and-drop, or you may have similar questions already created. For 

a new or existing user-defined question to be included, it must contain the necessary 
JavaScript code to communicate with the Developer for scoring and tracking purposes.  

 
Note: User-Defined questions do not appear in published documents such as the Training 
Guide or Instructor Manual. 
 
Once you have created a valid file, you add it to a package so it can be linked to a User-

Defined question object in the Developer. 
 

To add a User-Defined question, you click  Update Link and navigate to the appropriate 

package. After selecting the question file, enter a correct score percentage (0-100%) in the 
Correct Score field that is used to compare to what is deemed a passing score in the user-
defined question. This information is passed back to the Professional edition. 
 
You can preview the question after it is saved but you cannot edit the question in the 
Developer. You can suppress the preview of User-Defined questions in the Outline Editor using 

the Preview page in the Options dialog box. 

 
Warning! Deleting a package that contains the code for a user-defined question creates 
broken links in your content. Therefore, if you plan to remove the package, you should first 
remove any links to that User-Defined question. Moving, renaming, or deleting a package item 
that is linked to a document creates broken links in your content. Because the Broken Links 
tool does not penetrate packages, it cannot detect when links to items within packages are 

broken. Therefore, if you plan to perform any of these actions on a package item, you should 
first remove any links to it from your content. 
 
See Broken Links in Questions and Assessments in the Manage Document Relationships 
chapter of this guide for more information. 

14.2.9 User-Defined Question Example 

Use this very simple question example to create a User-Defined question to observe its 
behavior in the Developer. The code can be modified to meet your question needs.  

 
This sample code includes diagnostic feedback that appears at the top of the question. There 
are 4 parameters (kpnextpage, kpmode, kpfeedbk, kprnda) that are populated from the 
Knowledge Center and one parameter (kpremed) populated from the Developer. 
 
kpnextpage: This parameter is the full URL to the portal page where tracking data is sent. 

  
kpmode: This parameter indicates if a question is being played within a course, pre-
assessment, or post-assessment. 
  
kpfeedbk: This parameter indicates if feedback is enabled within the assessment. The 
parameter is on, by default, for courses. 
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kprnda: This parameter indicates if answers are randomized in order. This parameter is off, 

by default, for courses. 

  
kpremed: This parameter indicates the remediation mode currently set within the course or 
assessment. 
  
Note: To remove these parameters from your question, delete the bolded code from the 

example code. 
 

Sample User-Defined Question Code 

  
<html> 

<head> 

<meta content="en-us"> 

<meta content="text/html; charset=windows-1252"> 

<title>Custom Question Page</title> 

<script>  

 
var isIE = (navigator.appName.indexOf("Microsoft") != -1) ? true : 

false;  
 
function GetQueryStringValue(param) {  

 
var strQueryString; 

  

if (self.location.search.length>1) { 

  // this was a get request where the results are in location.search (URL?...) 

  strQueryString = self.location.search.substr(1); 

} 

else if (self.location.hash.length>1) { 

  // this used the hash method (URL#...) 

  strQueryString = self.location.hash; 

}  

 
var QueryItems = strQueryString.split("&"); 

for (var i=0; i < QueryItems.length; i++){ 

  var QueryItem = QueryItems[i]; 

  var intEqPos = QueryItem.indexOf("=") 

  var strName = QueryItem.substr(0, intEqPos) 

  if (strName == param) { 

   return QueryItem.substr(intEqPos+1) 

  } 

} 

  

// no querystring item found 

return ""; 

}  

 
var kpmode = GetQueryStringValue("kpmode"); 

var kpremed = GetQueryStringValue("kpremed"); 

var kpfeedbk = GetQueryStringValue("kpfeedbk"); 

var kprnda = GetQueryStringValue("kprnda"); 

var kpResultURL = GetQueryStringValue("kpnextpage");  

  
 
function SendResult(score, answer){  

 
// code to send score and answer back to Knowledge Pathways 

  

// get the nextpage and target from querystring  
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if (kpResultURL == "") { 

  // we must have an URL 

  alert("no result URL supplied."); 

  return false; 

} 

   

 
if (isNaN(score)) { 

  // the score must be numeric 

  alert("the score must be a numeric value.") 

  return false; 

}  

  
 
  

// send get request back to the target frame 

if ((kpResultURL.indexOf("?") >= 0) ||  (kpResultURL.indexOf("#") >= 0)){ 

  // the url already contains a ? or #, append to current querystring 

  window.location.href = kpResultURL + "&score=" + score + "&answer=" + 

escape(answer); 

} 

else { 

  window.location.href = kpResultURL + "?score=" + score + "&answer=" + 

escape(answer); 

    }  

  
 
return true; 

}  

 
function ProcessResult() {  

 
// determine if the answer is correct, if correct score = 1 

// else the score is 0 

  

var objForm = window.document.QuestionForm; 

var score; 

var message; 

  

var answer = "";  

 
for (var i=0; i<objForm.elements.length;i++) { 

  if (objForm.elements[i].name == "answer") { 

   if (objForm.elements[i].checked) { 

    if (i == 0) { 

     // correct answer setting score to 1 

     score = 1; 

     if (kpfeedbk == "1") { 

      if (kpremed == "0") { 

       // remediation not enabled 

       message = "Correct!"; 

      } 

      else { 

       message = "Correct! 1+1 does equal 2."; 

      } 

      alert(message); 

     } 

    } 

    else { 

     // incorrect answer setting score to 0 

     score = 0; 

     if (kpfeedbk == "1") { 

      if (kpremed == "0") { 

       message = "Incorrect."; 
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      } 

      else { 

       message = "Incorrect. 1+1 equals 2."; 

      } 

      alert(message); 

     } 

    } 

    // pull the answer from the radio options value 

    answer = objForm.elements[i].value; 

   } 

  } 

} 

  

SendResult(score, answer) 

}  

 
</script> 

</head>  

 
<body> 

<h3>User-Defined Question Example</h3> 

<p>Available parameters:</p> 

<Script> 

document.write("kpmode indicates if the question is being played within a 

course, pre-assessment or post-assessment.</b>"); 

if (kpmode != "") { 

  switch(kpmode){ 

   case "0": 

    document.write("Question was launched from a <b>Course</b>"); 

    break; 

   case "2": 

    document.write("Question was launched from an <b>Assessment</b>"); 

    break; 

  } 

  document.write("<br><br>"); 

}  

 
document.write("kpremed indicates the remediation mode currently set within the 

course or assessment.</b>"); 

if (kpremed != "") { 

  switch(kpremed){ 

   case "0": 

    document.write("Remediation mode(kpremed) is <b>(0) Off</b>"); 

    break; 

   case "1": 

    document.write("Remediation mode(kpremed) is <b>(1) User Asks</b>"); 

    break; 

   case "2": 

    document.write("Remediation mode(kpremed) is <b>(2) Incorrect</b>"); 

    break; 

   case "3": 

    document.write("Remediation mode(kpremed) is <b>(3) All</b>"); 

    break; 

  } 

  document.write("<br><br>"); 

}  

 
document.write("kpfeedbk indicates if feedback is enabled within the 

assessment. Always enabled in courses.</b>"); 

if (kpfeedbk != "") {  

 
  switch(kpfeedbk){ 

   case "0": 

    document.write("Feedback(kpfeedbk) is <b>NOT enabled</b>"); 

    break; 
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   case "1": 

    document.write("Feedback(kpfeedbk) is <b>enabled</b>"); 

    break; 

  } 

  document.write("<br><br>"); 

}  

 
document.write("kprnda indicates if answers should be randomized in order. 

Always disabled in courses.</b>"); 

if (kprnda != "") { 

  switch(kprnda){ 

   case "0": 

    document.write("Random Answer(kprnda) is <b>NOT enabled</b>"); 

    break; 

   case "1": 

    document.write("Random Answer(kprnda) is <b>enabled</b>"); 

    break; 

  } 

  document.write("<br><br>"); 

}  

 
document.write("kpnextpage indicates the full URL to the Portal page to which 

tracking data must be sent.</b>"); 

if (kpResultURL != "") { 

  document.write("Tracking data URL: <b>" + kpResultURL + "</b>"); 

  document.write("<br><br>"); 

} 

  

</script>  

 
<form method="GET" action=""  name="QuestionForm" target=""> 

  <p>Example question:</p> 

  <p>1+1=</p> 

  <p><input type="radio" value="2" checked name="answer">2</p> 

  <p><input type="radio" name="answer" value="42">42</p> 

  <p><input type="button" value="Submit" name="Submit" 

onClick="ProcessResult(); return false"> 

  <input type="reset" value="Reset" name="B2"></p>  

 
</form> 

</body> 

</html>  
 

To create a User-Defined question using the example HTML: 

1. Copy the User-Defined example HTML from the Developer help system and paste into 

Notepad or other program and save with an .htm extension. 
  
Warning! Do not copy the example HTML from the .pdf document. When the 
document is published to .pdf format, it inserts line breaks and other information that 

causes errors. 

  

2. On the File menu, point to  New, and choose  Package. 
  

3. Add the .htm file to the package. 
  

4. Save the new package. 
  

5. On the File menu, point to  New, point to  Question, and choose User-

Defined. 
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6. Click  Update Link and navigate to the package containing the user-defined 

question. 

  

7. Select the .htm file. 
  

8. Click OK. 
  

9. Select the percentage of correct answers (0-100%) needed to pass the question in the 
Correct Score field. 
  

10. Save the question. 

To create a User-Defined question: 

1. On the File menu, point to  New, point to  Question, and choose User-

Defined. 

  

2. Click  Update Link and navigate to the package containing the User-Defined 

question. 
  

3. Select the file containing the code. 
  

4. Click OK. 

  
5. Select the default value in the Correct Score field. 

  
6. Save the question. 

14.2.10 Link Questions to an Outline 

Questions can be directly linked to an outline so that they appear in the outline’s table of 

contents. Questions that appear in the table of contents are known as inline questions. Inline 
questions are often used for reinforcement and are usually placed immediately after the 
concept or topic they are testing.  
 

In the Outline Editor, you add questions to the outline by linking them to any module or 
section document. If you want to add a question after a topic, you can select the topic and add 
a question; however, the question links to the selected topic’s parent. After adding a question 
to the outline, you can move it to another position. Moving the question to another parent, 
deletes the link to the original parent and reestablishes it to the new parent. Moving a 
question in the outline does not change its location in the Library, but you can move the 

question to another folder in the Library without breaking the link to the parent. 
 
New questions are added to the outline with the name "New Question" and are stored in the 
same folder as the parent. After adding the new question, you can give it a more meaningful 
name in the outline. 
 

Linking a new question in the Outline Editor does not open the Question Editor. You must open 

or edit the question to create the question text and responses. 
 
You can preview and test a question from the Outline Editor by selecting the question in the 
outline and answering it in the Question Preview pane that appears to the right of the 
question. Use the Take Question Again button to clear your answer and test a different 
response. 
 

Questions can be linked to multiple locations within the outline or to other outlines. Deleting a 
link to a question removes it from the outline but the question remains in the Library and 
other linked locations. Deleting the question in the Library removes the question from the 
Library and breaks links to that question in all outlines. 
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Note: During playback, users can select questions in the outline. If content is tracked, inline 
questions are tracked in reports as pass/fail, but are not used to determine personalized 

content (available in the Professional edition only). 
 

To link a new question to an outline: 

1. Display the Outline Editor by opening the outline to which you want to link a new 
question. 

  
2. Select the module or section document to which you want to link the new question. 

  
Note: You can also select a topic or another question to insert a new question under 
it, but the question links to the selected document's parent. 
  

3. On the Link menu, point to  New Question and choose the type of question to 

create. 
  

You can also right-click the parent document in the outline, point to Link New Question 
and choose the question type. 
  
A new question is linked (and automatically saved) and appears in the outline beneath 
the parent document with the default name, that you should change. 
  

4. To open the question in the Question Editor, click  Edit question in the Question 
Preview pane or double-click the question in the outline. 

Note: You can link existing questions to an outline using the Link menu and Existing 
Document command. You can select multiple questions using the standard Windows selection 
keys (CTRL+click and SHIFT+click). You can also link questions to an outline by copying them 
from the Library and pasting them to the parent document in the Outline Editor or by splitting 

the work area and dragging questions from the Library in one work area to the open outline in 
the other work area. 

14.2.11 Delete a Question 

You can permanently delete a question you no longer need from the Library. 
 
If the question is part of an assessment, it is deleted from the assessment as well. However, if 
you delete a question from an outline or an assessment, you are only removing the link and 
the question remains in the Library where it was created. 

 
Warning! Deleting a question from the Library may create broken links in your content. 
Deleting a package item that contains the code for a User-Defined question or the package 
itself creates broken links in your content. Therefore, if you plan to perform any of these 
actions you should first remove any links to that question. 
  

 Multi-user Considerations 

 Documents under version control must be checked in and you must be working online 
to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 

To delete a question from the Library: 

1. Navigate to the location in the Library where the question you want to delete is stored. 

  
2. Select the desired question to be deleted. 
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3. On the Edit menu, choose  Delete. 

  

4. Click Yes to delete the selected question. 

  
The question is permanently deleted from the Library and from any assessments in 
which it was included. 

14.2.12 Preview a Question 

You can preview a question at any time by clicking  Preview on the Question Editor toolbar. 
This allows you to interact with the question just as the user would in the Player or in an LMS. 

 

To preview a question: 

1. Open the question that you want to preview in the Question Editor. 

  

2. Click  Preview on the Question Editor toolbar. 
  

3. Answer the question and review any remediation feedback, if available. 
  

4. Click Take question again to preview the question again. 

14.3 Develop Assessments 
An assessment is a collection of questions or questions and topics that help determine a user's 
level of understanding of the content. You create and edit assessments in the Developer using 
the Assessment Editor by linking existing questions or by creating new questions. Assessments 
can be added anywhere in the Library or outline; however, only assessments linked to or set 
as associated assessments to an outline are available for publishing. 

  
Note: You can modify the Assessment Template in the Library to customize the appearance of 
the Assessment Summary page in the Developer and published output. See Customize 

Assessment Elements in the Customize the Player section of the Publish Content chapter for 
more information. 
 
The Assessment Editor is used to design and manage assessments. The Assessment Editor 

toolbar contains icons for linking new and existing questions, deleting links to questions and 
changing question order. 
 

 Link New Question: Links a new question (of any type) to the assessment. 

 

 Link Existing Question: Browses the Library to link existing questions or topics to the 

assessment. 
  

 Delete Link: Removes the link for the selected document (question or topic) to the 

assessment. The document remains in the Library but is no longer linked to the assessment. 

  

 Move Up: Moves the selected document(s) up one row. 

  

 Move Down: Moves the selected documents(s) down one row. 

 
You can add a concept to an assessment to provide additional instructions for the assessment 
or explain how it is used. You add a concept to an assessment in the Outline Editor by 
selecting the assessment in the outline and using the Concept pane to create or link a web 
page, package item, or URL. The concept appears in the Concept pane on the assessment's 
Start page in the Player and is included in the Training Guide and Instructor Manual document 

formats if you choose to publish with assessments. 
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Note: Assessments are also important for Personalized Content if you are using the 
Professional edition of the Knowledge Center. Personalized Content uses assessment results to 

allow a user to modify the full subject by excluding sections for which he/she has 
demonstrated competency. This feature allows users to concentrate on the sections in which 

they had the most difficulty. If you are using assessments as a way for a user to narrow down 
content to focus on, you should design assessments that cover a representative sample of the 
subject material. See Work with the Assessment Coverage View in the Enhance Content with 
Questions and Assessments chapter. 
 

Assign Roles to Assessments 

If you are using roles to filter your content for different audiences, you can create an 

assessment that contains a pool of all questions for all roles. When you publish by roles, only 
the questions assigned to the specified role, or roles, are included in the published 
assessment. 
 

To use an assessment as a question pool, you assign one or more roles to each assessment 
question and then assign those same roles to the assessment. Each role that you assign to a 
question in the assessment must also be assigned to the assessment document itself. For 

example, if different questions in the assessment are assigned to the Sales, Clerk, and 
Administrator roles, all of those roles must be assigned to the assessment if you want the 
assessment to appear in the role-specific published output. If you assign the Marketing role to 
assessment questions, but fail to assign that role to the assessment, the assessment will not 
be included when you publish content filtered for the Marketing role. 

14.3.1 Create a New Assessment 

When you create an assessment, it opens in a new tab in the Developer. You can link to 
existing questions or topics from the Library using the Link menu or create and link new 

questions from the Assessment Editor to populate the assessment. Once a question is linked, 
it displays in the assessment. 
 

When you close the assessment you can save it to the desired location in the Library. 
 

To create a new assessment in the Library: 

1. On the File menu, point to  New and choose  Assessment. 

  
or 
  

On the Library toolbar, choose  Assessment. 

  
2. Save the assessment. 

To create and link a new assessment in an outline: 

1. Display the Outline Editor by opening the outline to which you want to link a new 
assessment. 

  
2. Select the module or section document to which you want to link the new assessment. 

  

3. On the Link menu, choose  New Assessment. 

  
You can also right-click the parent document in the outline and choose Link New 
Assessment. 
  
A new assessment is linked (and automatically saved) and appears in the outline 

beneath the parent document with the default name, that you should change. 
  

4. To open the assessment in the Assessment Editor, click  Edit assessment in the 
Assessment Preview pane or double-click the assessment in the outline. 
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Note: You can link existing assessments to an outline using the Link menu and Existing 

Document command. You can select multiple assessments using the standard Windows 

selection keys (CTRL+click and SHIFT+click). You can also link assessments to an outline by 
copying them from the Library and pasting them to the parent document in the Outline Editor 
or by splitting the work area and dragging an assessment from the Library in one work area to 
the open outline in the other work area. 

14.3.2 Add Questions to an Assessment 

When you link an existing question in the Library, the question is added to the assessment but 

also remains in the Library for use in other assessments or outlines. 
 
If you create a question from the File menu, it is saved in the Library but not linked to any 
assessment. 
 

You can link a new or existing question to an assessment from the  Link New Question or 

 Link Existing Question options on the Assessment Editor toolbar. You can also use the Link 

menu or context menu to link new or existing questions. 
 

To link a new question to an assessment: 

1. Create or open an assessment in the Assessment Editor. 

  

2. On the Link menu, point to  New Question and choose the type of question to 

create. 
  

3. Type a name for the new question and save the question to the desired Library 
location. 
  

4. Double-click the new question in the assessment to edit it in the Question Editor. 
  

5. Save the changes to the question. 

  
6. Close the question. 

  
7. Save the assessment. 

To link an existing question to an assessment: 

1. Create or open an assessment in the Assessment Editor. 

  
2. On the Link menu, choose Existing Question. 

  

3. Navigate in the Library to find the question or questions you want to add to the 
assessment. 
  

4. Select a question and click Open. 
  
You can select multiple questions using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 

  
You can also link existing questions to an outline by copying them from the Library 
and pasting them to the parent document in the Outline Editor or by splitting the work 
area and dragging questions from the Library in one work area to the open outline in 
the other work area. 
  

5. Save the assessment. 
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14.3.3 Reorder Questions in an Assessment 

After you include questions in an assessment, you can reorder them. During playback, 

assessment questions can appear in the same order they appear in the Assessment Editor if 
the Question Order property (of the assessment) is set to As Authored (default). However, you 
can have questions appear in random playback order by changing this property to Random 

Order. See Assessment Properties in the View Document Properties chapter of the Content 
Development guide for more information on random question order. 
  
Note: You can override the Question Order property for associated assessments (linked using 
the Assessments property) when setting up pre- and post-assessments in the Professional 
edition of the Knowledge Center. 
 

To reorder questions in an assessment: 

1. Open an assessment. 
  

2. Select one or more questions that you want to reposition. 

  

3. Click  or  on the Assessment Editor toolbar as necessary until the questions are 

in the desired location. 
  
You can also use drag-and-drop to move questions to another location. 
  

4. Save the assessment. 

14.3.4 Delete Questions from an Assessment 

You can delete questions from an assessment at any time. This deletes the link to the question 
in the assessment but the question remains in the Library.  
 

To delete a question from an assessment: 

1. Open the assessment. 
  

2. Select one or more questions that you want to delete. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. From the Edit menu, choose  Delete Link to remove the linked question from the 

assessment. 
  

4. Save the assessment. 

14.3.5 Assessments for Personalized Content (available in Professional 
edition only) 

Assessments can be used to create Personalized Content when deployed in the Professional 
edition of the Knowledge Center. 
  

To enable Personalized Content, an assessment must be designated as a pre-assessment or 
post-assessment associated with a parent document in the outline, or linked directly to an 
outline as an inline assessment. Personalized Content is based on associating the questions in 
an assessment with a document in the outline using the question's Associated Content 
property. 
  
When deploying content in a Knowledge Path, you can specify which assessment to use as a 

pre-assessment and post-assessment. Pre-assessments and post-assessments have their own 
features and options that you can set in the Knowledge Center Manager. 
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In order to designate a pre-assessment and/or post-assessment, the assessments must be 

associated to the parent level document in the outline using the Assessments property for the 

parent. After the parent document is added as an activity in a Knowledge Path, you choose 
which of the associated assessments are to be used as a pre-assessment and a post-
assessment. 
  
While inline assessments appear in the table of contents for the deployed outline, pre-

assessments and post-assessments do not. Instead, they appear as nodes (headings) before 
the Subject Activity (for pre-assessments) and after the Subject Activity (for post-
assessments) in the Knowledge Path. 
  
Note: You can add a concept to an assessment to provide additional instructions for the 
assessment or explain how it is used. You add a concept to an assessment in the Outline 
Editor by selecting the assessment in the outline and using the Concept pane to create or link 

a web page, package item, or URL. The concept appears in the Concept pane on the 
assessment's Start page in a Knowledge Path or in the Player, and is included in the Training 
Guide and Instructor Manual document formats if you choose to publish with assessments. To 

add a concept to an associated assessment, you can temporarily link the assessment to a 
module or section so that it appears as an inline assessment in the Outline Editor, add the 
concept, and then unlink the assessment. 
  

See Design the Assessment in the Understand Personalized Content section in the Questions 
and Assessments in Player Content section in this chapter. 
 

To associate an assessment: 

1. Create an assessment in the Library. 

  
The assessment opens in the Assessment Editor. 
   

2. In the Assessments category of the Properties toolpane, set the desired properties 
for the assessment. 

  
Note: The Developer settings for Answer order, Passing score %, Question order, 
Remediation, Show Associated Content, and Summary properties can be overridden 
when setting up the pre-assessment and post-assessment in the Professional edition 
of the Knowledge Center. 
  

3. Add questions to the assessment. 
  

4. Open each question from the assessment or select the question in the Library. In the 
Question category of the Properties toolpane, set the Associated Content property 
to a document in the outline linked directly or indirectly to the assessment's parent. 
  
Note: You can also use the Assessment Coverage View to add questions to an 

assessment and set the Associated Content property. 
  

5. Save the assessment. 
  

6. In the Outline Editor or Library, select the parent module or section. 
  

7. Display the Properties toolpane. 

  

8. In the General category, click in the Assessments cell and click . 
  

9. From the Associated Assessments for Knowledge Center dialog box, click  Add 

associated assessment, navigate to the folder, select one or more assessments to 
be associated, and click Open. 
  

10. Click OK to close the Associated Assessments for Knowledge Center dialog box. 
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14.3.6 Preview an Assessment 

You can preview an assessment prior to publishing the content from the Outline Editor. To 

preview an assessment, it must be included in an outline. The first question displays in the 
Assessment Preview pane when you select the assessment from an outline. You can move 
through the questions in the order that they were defined in the Assessment Editor using the 

arrow keys. 
  
To preview and test an associated assessment, you can temporarily link it to a module or 
section. 
 

To preview an assessment: 

1. Open any outline containing an assessment. 

  
2. Click the assessment you want to preview. 

  

3. Answer the questions and review feedback using  or  or move the slider to 
advance through the questions. 

14.3.7 Delete an Assessment 

You can delete an assessment from any outline as needed. When you delete an assessment 
from an outline, only the link to the outline is deleted; the assessment and the questions it 
contains are unaffected and remain in the Library. 

 
If you delete an assessment from the Library, the assessment is removed from the Library and 

from any linked outline. The Missing Document icon  displays in all locations where the 

assessment was linked to an outline. Deleting the selected document only, deletes the 
assessment without deleting the questions in the assessment. 
  
Warning! Deleting an assessment with related documents, also deletes the questions that 

only link to that assessment. Questions that link to other assessments or outlines are not 
deleted since they are used by other documents. To see where a question is used, select the 

question and open the Related Documents toolpane. The bottom pane lists the other 
assessments that link to the question or a parent module or section if the question is used as 
an inline question in an outline. 
 
Note: Deleting an assessment can cause broken links in your content. See Broken Links in 
Questions and Assessments in the Manage Document Relationships chapter of the Content 
Development guide for more information. 

  

 Multi-user Considerations 

 Documents under version control must be checked in and you must be working online 
to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 

To delete an assessment: 

1. In the Library, select the assessment you want to delete. 

  

2. On the Edit menu, choose  Delete. 

  
3. Click Delete my selection to delete the assessment only or Delete my selection 

and related documents to delete the assessment and any questions linked to it. 

Note: You can see which documents are related to the selected assessment by clicking the 
View Related Documents link. 
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14.4 Work with the Assessment Coverage View 
The Assessment Coverage view is an Outline Editor view for analyzing assessments to ensure 
that the assessment questions adequately measure competency as related to the content 
linked to the assessment. The analysis in the Assessment Coverage view is based on 
associating a question with a module, section, or topic using the Associated Content property 
for the question. See Associated Content Property under Question Properties in the View 
Document Properties chapter for information about setting the Associated Content property for 

a question. 
  
Note: You can include questions in your content by linking them directly to a module or 
section in the outline structure (inline questions), or by including them in a linked or 
associated assessment, or both. You can include assessments in your content by linking them 
directly to the outline structure (inline assessment), or by associating them with a parent 
document such as a module or section using the Assessments property. 

  
The Assessment Coverage view serves several functions. 

 It shows the question coverage in an assessment by the parent document in the 
outline to which the assessment is associated or linked. 
  

 It shows the question coverage for all documents (modules, sections, topics) in the 

outline, allowing you to see the areas of the outline that have no associated questions 
in the assessment. 
  

 It shows questions in an assessment that have no associations with documents in the 

outline. 
  

 It helps authors find additional questions that can be added to improve coverage. 

The Assessment Coverage view includes three components:  

 Assessment section: Used to select the assessment you want to analyze or improve. 
   

 Questions Associated section: Used to view which questions in the current 
assessment are associated with the currently selected item in the outline. You can also 

use the tools in this section to add or delete questions. 
   

 Questions column: This column is added to the Outline pane when you display the 
Assessment Coverage view. The numeric value in the Questions column shows the 

number of questions in the selected assessment that are associated with each 
document in the outline and its children, if the document is a parent. 

Associating content with a question determines if the content document appears in 
Personalized Content (available only in the Professional edition). See Understand Personalized 
Content in the Enhance Content with Questions and Assessments chapter for more 
information. 

  

To open the Assessment Coverage View:  

1. From the Outline Editor, click  on the View toolbar and choose Assessment 
coverage view. 

14.4.1 Select an Assessment 

The first step in using the Assessment Coverage view is to select the assessment you want to 
build or whose coverage you want to examine from the Select an Assessment list. All 
assessments directly linked as an inline assessment to a parent document (module or section) 
in the open outline, or associated with a module or section in the outline (through the 
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Assessments property), appear in the Select an Assessment list; however, you can also work 
with assessments not linked or associated with the outline. 

  
Note: While an assessment is selected in the Assessment Coverage view, it is considered open 

and cannot be renamed from the Library. 
 
After selecting an assessment, the view shows the Library location of the assessment and a 
question count, which is the total number of questions and topics (Know It? questions) in the 
selected assessment. The Open Assessment button opens the selected assessment in the 
Assessment Editor, where you can see the full assessment and the question order. 
  

Note: You can undo your actions in the Assessment Coverage view until you select a different 
assessment from the Select an Assessment list. Although it is possible to make content 
changes to the outline in the Assessment Coverage view, such as linking new sections and 
topics, it is a good idea to reserve those changes for the Player view because the Player view 
and Assessment Coverage view maintain separate undo lists. If you make outline changes 
while in the Assessment Coverage view and then change assessments, you lose the ability to 

undo your content changes. 

  

 Multi-user Considerations   

 The assessment selected in the Assessment Coverage view is considered open and 
cannot be checked in from the Library. However, if the assessment is linked directly to 
the outline structure, you can select it from the Outline pane while working in the 
Assessment Coverage view and check it in. 

To select an assessment: 

1. Click the Select an assessment . 
   

2. Select an assessment from the list or click Other and browse the Library to select 
another assessment. 

14.4.2 Use the Questions Column 

The Assessment Coverage view includes a Questions column in the Outline pane. The value in 
this column indicates the number of questions in the selected assessment that are associated 
with each document in the outline (through the question's Associated Content property). For 

example, if a topic is associated with two questions in the assessment, a "2" appears in the 
Questions column for the topic. Parent documents (modules and sections) show the number of 
questions that are associated directly with the module and section, plus the number of 
questions associated with the child documents belonging to the module or section.  
  
Assessments may also include topics. Adding a topic to an assessment adds a Know It? 

question to the assessment for testing competency in completing the task. When you add a 
topic (Know It? question) to an assessment, it is automatically associated with the topic itself, 
and therefore, included in the Question column count for the topic. For example, if a topic is 

associated with one question and also added as a Know It? question in the assessment, a "2" 
appears in the Question column for the topic.  
  
The Questions column shows the dispersal of questions in the outline so that you can create 

an assessment with balanced coverage. For example, a "0" in the column for a topic indicates 
that the selected assessment contains no questions associated with that topic. Selecting the 
assessment's parent document (the document to which it is linked) shows all of the questions 
and topics (Know It? questions) associated with the parent and child documents. Questions 
that are included in the selected assessment and are also directly linked to the outline 
structure (inline questions) are only counted once in the Questions column. 
  

Note: You can compare the Question count in the Assessment section to the value in the 
Questions column for the assessment's parent document. If the values do not agree, the 
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assessment includes questions whose Associated Content field is not set, or set to documents 

not linked to the assessment's parent.  

14.4.3 Use the Questions Associated Table 

The information in the Questions Associated table varies with the selected assessment and the 
document selected in the Outline pane. The table is filtered to show only those questions and 
topics (Know It? questions) in the assessment associated with the selected document. In other 
words, how many questions have you assigned to test competency for this specific document. 
For example, if you select a topic for which you have created and associated two questions, 

those two questions appear in the table. If you also add the topic itself as a Know It? question 
to the assessment, the filtered list shows three items, the two questions and the topic. 
Selecting a parent document, such as a module or section, displays a table of all the questions 
and topics associated with the parent document plus all child documents. 
  
The filtered table includes the following columns: 

 Name: Name of the question. 

  

 Type: Indicates if the assessment item is a Question or Topic (Know It? question). 
  

 Associated Content: Lists the name of the document associated with the question as 

set in the Associated Content property. In the case of a Know It? question, the topic 
itself is listed, as the Know It? question tests the topic and is associated with itself. 
  

 Path: Library path to the assessment item. 

Questions in the assessment that do not have their Associated Content property set (not 
linked to any content), are not included in the filtered table. The questions in the table do not 
appear in the same order as in the assessment. To compare the full assessment and see the 
order in which the questions appear, you can open the selected assessment using the Open 
Assessment button in the view.  

  

Note: A question can have only one document associated with it (for example, only one 
document can be set as the Associated Content property). However, a single document 
(module, section, or topic) can be associated with multiple questions. To quickly associate a 
document with several questions, select the questions in the Library and use the Properties 
toolpane to assign the same document as the Associated Content property for all of the 
selected questions. See Associated Content Property under Question Properties in the View 
Document Properties chapter for information about setting the Associated Content property for 

a question.  

14.4.3.1 Improve Question Coverage 

After viewing the dispersal of questions in the outline, you can use the tools in the view to 
strengthen the assessment by providing better question coverage. For example, if you see 
that one topic has no associated questions and another has five, you may want to balance the 

coverage in the assessment by adding one or two questions to one topic and removing 
questions from the other. 

  
While you may use the Assessment Coverage view to analyze an assessment after you create 
it, it is also a good place to begin building an assessment. Using the view to link a new or 
existing question with a document in the outline, adds the question to the selected 
assessment and automatically sets the Associated Content property for the question to the 

document selected in the outline; in effect, mapping the question to your content. You can 
also clear the Associated Content property for a question, which removes the association, but 
does not remove the question from the assessment. 
  
Note: The Publishing Wizard includes a warning in the activity log if a published assessment 
contains questions that do not have the Associated Content property set. You can open the 

activity log from the final Publishing Wizard screen and view which assessments were affected. 
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14.4.3.2 Add Questions to the Assessment 

If you determine that a selected assessment does not provide adequate coverage for the 

content, you can use the tools in the view to strengthen the assessment. The tools let you link 
new or existing questions to the assessment and find additional questions related to the 
content that could be added to improve coverage. 
  

 Link New Question  

Use the Link New Question list arrow to add new Fill in, Hotspot, Matching, Multiple Choice 
(Single Answer), Multiple Choice (Many Answers), True/False, and User-Defined questions. 
When adding the question, you are prompted to name it and select a folder for saving the 
question (defaults to the same folder where the document is saved). The new blank question 

is added to the selected assessment and automatically associated with the document selected 
in the outline, so it also appears in the Questions Associated table. You can double-click the 
question in the Questions Associated table to open it in the Question Editor and add the 
content for the question. 
  

 Link Existing Question  

Use this option to browse the Library and add an existing question or topic (Know It? 
question) to the selected assessment. When you link an existing question associated with 
another document, you automatically break the original association and set the Associated 
Content property of the question to the currently selected document. 

  
When you add a topic (Know It? question) that is outside of the assessment's coverage (either 
not linked to the outline or not linked to the assessment's parent), the Know It? question is 
added to the assessment, but no association is made with the selected document. Instead, the 
Know It? question is associated with the topic itself, and therefore does not appear in the 
Questions Associated table for the selected document. 
  

When you add an existing question (question or Know It! topic) that is already part of the 
assessment, a Duplicate Questions or Topics message opens telling you that the question item 
is already part of the assessment and is not added. Duplicate question items are not added 
since a question or topic can occur only once in an assessment. 

  

 Delete Link  

Use this option to remove the question from the assessment. Deleting the question link does 
not delete the question from the Library or delete the association between the question and 
the document. 

  

 Clear Associated Content  
Use this option to clear the Associated Content property for the selected question. The 

question remains in the assessment, but since it is no longer associated with a document, it is 
removed from the Questions Associated table. Clearing the association between a question 
and a document reduces the associated question count by one. You cannot clear the 
association for a Know It? question, but you can remove the question from the assessment. 
  
Note: You can undo your actions in the Assessment Coverage view until you select a different 

assessment from the Select an assessment list.  

  

 Multi-user Considerations   

 The Associated Content property is an attribute of the question, therefore the question 

must be checked out to you to associate it with a document. However, the content 
that is being associated does not have to be checked out. 
  
The Assessment document must be checked out to add a new question. The system 
automatically checks out the assessment and question when you associate a question 
with a document. 
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14.4.3.3 Suggest Questions 

The Suggest Questions dialog box shows questions that are associated with the selected 

document, or linked in the outline to the selected parent document (module or section) as a 
child document, but are not included in the selected assessment. For example, if you open 
Suggest Questions for a topic in the outline, the questions listed all have their Associated 
Content property set for the topic but are not included in the selected assessment. The 

suggested questions may be part of another assessment, such as a pre-assessment, or just 
independent questions in the Library. If the selected outline item is a parent document, the list 
includes any questions directly associated with the parent or with a child document, and 
questions linked in the outline (as inline questions) to the parent or any of its children. 
  
In addition to listing the questions and topics associated with a document, the Suggest 

Questions list provides additional columns of information including the reason for suggesting a 
question or topic; 

 Add: This column shows an empty checkbox next to each question or topic in the list. 
Select a checkbox to add the question or topic to the selected assessment. 

   

 Name: This column displays the name of the suggested question or topic. 

   

 Type: This column indicates if the suggested question is a question or topic. 

   

 Associated Content: This column indicates the document that is associated with the 
question through the Associated Content property. See Associated Content Property 
under Question Properties in the View Document Properties chapter for information 

about setting the Associated Content property for a question. 
   

 In Outline: A checkmark in this column indicates that the reason for suggesting the 
question or topic for a selected document is that the question or topic is a child 
document linked to the outline, but not included in the assessment. 

   

 Associated with Selection: A checkmark in this column indicates that the question 

is associated with the selected document or one of its child documents, but is not 
included in the assessment. 

  
Tip: The questions that appear in Suggest Questions may be associated with the 
outline document but linked to another assessment. For example, you may want to 
include separate questions in your pre- and post-assessments, so several questions 
may be associated with the same document. If you add a question to one assessment 
that is already linked to another assessment, the question appears in both 

assessments. If you wish to use unique questions in each assessment, you can 
indicate which questions belong to which assessments by appending the assessment 
name to the question name. You can also create separate folders for each assessment 
and its questions. Then the Path column for each question tells you the assessment for 
which the question is designed. 
   

 Path: This column displays the location in the Library of the suggested question or 

topic. 

Note: You can undo your actions in the Assessment Coverage view until you select a different 
assessment from the Select an assessment list. 
  

 Multi-user Considerations   

 The Associated Content property is an attribute of the question, therefore the question 
must be checked out to you to associate it with a document. However, the content 
that is being associated does not have to be checked out. 
  

The Assessment document must be checked out to add a new question. The system 
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automatically checks out the assessment and question when you associate a question 
with a document. 

14.4.3.4 Set Associated Content 

The Set Associated Content list shows questions in the selected assessment that are not 

associated with the selected document or its children. When you select a question from the 
list, you set the association of the question to the document selected in the outline. If the 
question is already associated with another document, selecting the question changes the 
question's Associated Content property. However, when you close the Set Associated Content 
list, you receive notification that the Associated Content property was updated. You can use 
the View activity log link to see which question was affected. 

 Add: This column shows an empty checkbox next to each question or topic in the list. 

Select a checkbox to add the question or topic to the selected assessment and set the 
Associated Content property. 
   

 Name: This column displays the name of the suggested question or topic. 

  

 Path: This column displays the location in the Library of the suggested question or 
topic. 

Note: You can undo your actions in the Assessment Coverage view until you select a different 
assessment from the Select an Assessment list. 
  

 Multi-user Considerations   

 The Associated Content property is an attribute of the question, therefore the question 
must be checked out to you to associate it with a document. However, the content 
that is being associated does not have to be checked out. 

  
The Assessment document must be checked out to add a new question. The system 

automatically checks out the assessment and question when you associate a question 
with a document. 
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15 Manage Document Relationships 
As you build your content and link various documents, you may need to review the 
relationships between documents and repair broken links that resulted from deleted or 
unavailable documents. 
 
The Developer provides toolpanes that allow you to: 

 View Related Documents 
  

 View Derived Documents 
  

 View Broken Links 

You can display these toolpanes from the Library or any document editor. You must select one 
document to view its related documents, derived documents or broken links when you use 

these toolpanes from the Library or Outline Editor. When you display these toolpanes and 
open a document in a document editor, these panes automatically display the results for the 
open document. 

 
Note: The Related Documents, Derived Documents, and Broken Links toolpanes are empty if 
you select multiple documents from either the Library or Outline Editor. Select only ONE 
document to display the appropriate results. 
 
You can open any document listed in any of these toolpanes by double-clicking the document 

name or by selecting the document and clicking  Open in Editor. You can find the location 

of the document by selecting it and clicking  Find in Library. Open in Editor and Find in 

Library are also available via the right-click context menu. 
 
Publishing Note: Broken links are automatically removed from any published output. This 
generates errors during the publishing process which get listed in the activity log, and may be 

viewed at the end of publishing. 
 

 Multi-user Considerations 

 If you open a document that is not checked out to you, it opens in Read-Only mode. If 

you decide to make any changes to a Read-Only document, upon exit you are given 
the option to save the document (check out and save the changes), save it as a new 
document, or discard the changes. 

15.1 View Related Documents 
You can view documents that link to the current file and documents that the current file links 
to using the Related Documents toolpane. For example, a section can have one or more 
modules that link to it as well as links to topics, web pages, or package documents.  

  
Note: The Related Documents, Derived Documents, and Broken Links toolpanes are empty if 

you select multiple documents from either the Library or Outline Editor. Select only ONE 
document to display the appropriate results. 
 
The top section of the toolpane displays the name of the selected document and a list of 
documents that it links to. The bottom section of the toolpane displays the documents that link 
to the selected document. In the Library Details View, you can add the Link Count and Links 
To columns. These columns calculate the total number of document links from the top and 

bottom sections of the Related Documents toolpane, respectively. For more information about 
adding columns to the view, see the View Folder Content section in the Manage the Library 
chapter. 
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Note: You can resize either section of the toolpane by dragging the horizontal split bar up or 
down. 
 

Broken links are also displayed in the Related Documents toolpane; however, you can display 
the Broken Links toolpane to show only broken links and not related documents. 
 

 Multi-user Considerations 

 If you perform this operation while you are working offline, only the documents in your 
local cache are considered. 

To view related documents: 

1. On the View menu, point to Panes, and then choose Related Documents. 

  
2. Select ONE document from the Library or Outline Editor that you want to see its links. 

  
3. Review the document links. 

  
4. Double-click the name of any document in either section of the toolpane to open a 

related document. 
  
or 
  

Select the name of any document in either section of the toolpane and click  Open 

in Editor to open a related document. 
  

5. Continue selecting other documents to review their related links. 

To locate related documents in the Library: 

1. Display the Related Documents toolpane. 

  
2. Select ONE document from the Library or Outline Editor that you want to see its links 

  

3. Review the document links. 
  

4. Select the name of any document in either section of the toolpane and click  Find 

in Library to find the location of the document in the Library. 
  

5. Continue selecting other documents to review their related links. 

15.2 View Derived Documents 
There are times during the life of a document when it is necessary to make duplicate copies of 

the document. For example, copies are often made during the translation process. If 
something changes in the original document, it is useful to know which documents were 
copied from the original incase those documents need to be updated with the changes. 
 

Note: The Related Documents, Derived Documents, and Broken Links toolpanes are empty if 
you select multiple documents from either the Library or Outline Editor. Select only ONE 
document to display the appropriate results. 
 

The top section of the toolpane displays the name of the selected document and a list of 
documents that were copied from it. The bottom section of the toolpane displays the 
document from which the selected document was copied. 
 

Note: You can resize either section of the toolpane by dragging the horizontal split bar up or 

down. 
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You can view derived document information for all documents in a folder by adding the 

derived property columns to the Library view. The Derived From column lists the name of the 

original document from which a document is copied and the Derived From Document ID 
column lists the original document's ID. You can create a custom view to display this 
information for the entire Library or multiple specified folders. See Create a Custom View in 
the Manage the Library chapter for more information about custom views. Derived columns 
can also be added to the Details View in the Player, but this view does not include concepts 

linked to the outline. 
  

 Multi-user Considerations 

 If you perform this operation while you are working offline, only the documents in your 
local cache are considered. 

To view derived documents: 

1. Display the Derived Documents toolpane. 

  
2. Select ONE document from the Library or Outline Editor that you want to see its 

derived documents. 

  
3. Review the derived documents, if any exist. 

  
4. Double-click the name of any document in either section of the toolpane to open the 

document. 
  

or 
  

Select the name of any document in either section of the toolpane and click  Open 

in Editor to open a related document. 
  

5. Continue selecting other documents to review. 

To locate derived documents in the Library: 

1. Display the Derived Documents toolpane. 
  

2. Select ONE document from the Library or Outline Editor that you want to see its 
derived documents. 
  

3. Review the list of derived documents, if any exist. 
  

4. Select the name of any document in either section of the toolpane and click  Find 

in Library to find the location of the document in the Library. 
  

5. Continue selecting other documents to locate in the Library. 

15.3 View and Repair Broken Links 
As you develop content, you want to ensure that there are no broken links between 

documents. In most cases, broken links result when linked documents are deleted and not 
available. 
  
Note: The Related Documents, Derived Documents, and Broken Links toolpanes are empty if 
you select multiple documents from either the Library or Outline Editor. Select only ONE 
document to display the appropriate results. 
 

To help you track the state of links between documents, you can display the Broken Links 
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toolpane from the Library or any document editor and repair broken links for selected 
documents. For example: 

 If you are working in the Library, select one document to view its broken links. 
  

 If you open a document in an editor (other than the Outline Editor) such as a web 
page or glossary, broken links are displayed for the open document. 
  

 If you are working in the Outline Editor, the results are based on the selected 

document. For example, if you select the root document in the Outline Editor, broken 
links are displayed for all documents that appear in the outline as well as any related 
documents. As you select other documents in the outline, broken links are displayed 
for the selected document and child documents as well as their related documents. 

The Broken Links toolpane displays the document you have selected or opened in an editor. If 
there are broken links for the selected document they automatically appear in the toolpane 

once a document is selected or opened. The Name column shows the related documents that 

have broken links and the Broken Link column identifies the document to which the link is 
broken. 
 

If the broken link is the result of a deleted document, you see the  Missing Document in the 

Broken Link column. You can repair a broken link by removing the link to the missing 
document. For example, if a section has a broken link because a linked topic was deleted, you 
can open the section in the Outline Editor and remove the missing topic from the section. If a 
broken link results because a glossary document was deleted, you can open the Properties 

toolpane for the document and either remove the linked glossary or assign a different 
glossary. 
 
Note: Broken link documents also appear in left pane of the Outline Editor so you see where 
they are in the context of the outline. 
 

Link to Package File 

A broken link cannot be detected when you have a document that links to a file in a Package 
and the file is then deleted from the Package. 
 

 Multi-user Considerations 

 Broken links can happen for several reasons, and, in most cases, can result from 
working offline. For this reason, it is recommended that if you do work offline and 
establish links between documents, you should periodically go back online and check 
in your work. 
  
A broken link can be created the following ways: 

  
- You create a link to a document that was deleted by another author. 
  

- You create a link to a new document that exists in your local cache but has not been 
checked in to the server. This appears as a broken link to other authors who view the 
source document until you check in the new document. 
  

- You create a link to an external document on your computer that is not visible to the 
other users. 
  
- A link target URL existed at the time the link was created but it was deleted or 
renamed. 
  

- A link can be broken because you are offline and you do not have a document in 
your local cache that a document is linked to. You should go online and get the 
appropriate documents that you need. 
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Broken links are represented in two ways. The  Missing Document label appears for 

a broken link document that was new (not under version control) and deleted. A 

document that is under version control and deleted is identified by its name and a red 

X on top of the standard document icon. To repair this type of broken link you can 
either restore the deleted document or remove the link to the document. 

To view broken links: 

1. Display the Broken Links toolpane. 

  
2. Select ONE document that you want to review from the Library or Outline Editor. 

  
If the Broken Links toolpane remains empty when you select a document, there are no 
broken links. If broken links exist for the selected document, each document with a 
broken link appears. You should take the appropriate steps to fix any broken links that 
are reported. 

15.4 Broken Links in Published Content 
Most broken links (links to a document in the Library such as module and section documents, 
topics, questions, assessments, package files, or web pages) are automatically detected and 
removed during publishing from any Player or document format. However, links to external 

content such as URL links or graphic links to external files cannot be verified at time of 
publishing. If these links are broken, they may appear in published content. 
 
In online formats such as the Player, the browser handles a missing URL or graphic file with a 
standard "content not found" message. In document formats, the Developer includes the bad 
URL in the document and let Microsoft Word display the standard "content not found" message 

when the author launches the link. 
 
If attachment icon links are broken (but the attachment itself exists), the Developer inserts a 
stock graphic icon so the online users have something to click, rather than displaying a broken 

image link. 
 
Note: Although broken links are removed in publishing, the source content is unaffected and 

still has broken links that should be fixed. 

15.4.1 Broken Links in Questions and Assessments 

Questions and Assessments, like other document types, can contain broken links for a variety 
of reasons.  
 
If the link to a question is broken, the question is excluded from the published output. This 
occurs if the question is deleted from the Library. If the question is renamed or moved to 
another location in the Library, the link remains intact. 

 
The following scenarios describe how broken links in questions and assessments affect 

publishing: 
 

Background graphic is missing from package 

If the background graphic used in a question was removed from the package where it resided, 
a broken graphic image displays in the Preview pane but the question does not display in the 
Broken Links pane. A Broken Link message is created in the Activity Log but the question 
publishes without a graphic. 
 

Package with background graphic missing 

If the package with the background graphic used in a question was removed, a broken graphic 
image displays in the Preview pane and the question displays in the Broken Links pane. A 
Broken Link message is created in the Activity Log but the question publishes without a 
graphic. 
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Package with content used in a question is missing 

If the package with content used in a question was removed, a message indicating the 

package may have been deleted displays in the Preview pane and the question displays in the 

Broken Links pane. A Broken Link message is created in the Activity Log. The question does 
not publish but the other content publishes. 
 

File linked to content in a package is missing 

If the file linked to content in a package was removed, a message indicating the file cannot be 
found displays in the Preview pane but the question does not display in the Broken Links pane. 

A Broken Link message is created in the Activity Log and the question does not publish. 
 

Broken link to question template 

If a link to the question template is broken, the question does not appear in the Preview Pane 
but does appear in the Broken Links pane. A Broken Link message is created in the Activity 
Log and the question does not publish. 

 

Broken link to associated content 
If a link to associated content is broken, the question displays in the Broken Links pane. An 
error message is created in the Activity Log and the question publishes without the associated 
content. 

 

Assessments links to a deleted question 

If an Assessment links to a question that was deleted, a message indicating the question does 
not exist displays in the Preview Pane and the assessment appears in the Broken Link pane. A 
Broken Link message is created in the Activity Log and the Assessment publishes without the 
question. 

 
Note: See View and Repair Broken Links in the Manage Document Relationships chapter for 
information on resolving broken links. 
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16 Define Glossary Terms 
As you create content, you might use specialized terms unique to your company or terms that 
require further clarification for your users. You can use glossaries to provide definitions for 
these terms.  
 
Use of glossaries involves three steps: 

 
First, you create a glossary document using the Glossary Editor. Each glossary document 
contains a list of terms and definitions, where the definitions are attachments to which the 
terms link. You can also specify a tooltip for each definition link, along with conditions 
describing markup of each term (match whole word and match case). Using the Glossary 
Editor, you can add, edit, and delete terms. You can also create multiple glossary documents 
and use them for different parts of your content. 

 
You next assign one or more glossaries to your content using the Properties toolpane. You can 

assign glossaries in this way from the Library, Outline Editor, and Web Page Editor. In 
addition, in the Outline Editor and Topic Editor, you can use property inheritance to ensure 
that the appropriate glossary is automatically assigned to children created under a parent 
document to which a glossary has been assigned. Glossaries can be assigned only to modules, 

sections, topics, and web pages. 
  
Note: The glossary must be attached to the parent document prior creating the child 
document for the child to inherit the glossary. If child documents already exist when the 
glossary is attached to the parent, you must manually attach the glossary to each child 
document. 
 

The final step in using glossaries is glossary markup, or updating glossary links, which can be 
done from the Glossary Editor, Library, and Outline Editor. When you update glossary links, 
the Developer searches the text in your content for occurrences of glossary terms. When it 
finds a term that matches the selected markup conditions (match whole word and match 

case), it creates a link to the attachment specified as the definition link. By default, when a 
glossary term appears multiple times in one location, only the first instance of the term is 
marked as a glossary link. You can also change the glossary default settings to have all 

occurrences of all terms marked as glossary links. 
 
If you later make any changes to a glossary, to glossary assignments, or to text containing 
glossary terms, you must update the links again. 
 
Glossary markup affects text in frame bubbles in topics, including Introduction and End 

frames, and text in web pages. However, if a glossary term is included in the text of a 
manually created bubble text link or web page hyperlink, no additional glossary link is created 
during glossary markup. That is, text used in manually created links is skipped during glossary 
markup. For example, suppose that a frame bubble in a topic contains the text "Save this file 
to your local disk." and you create a link from the phrase "local disk" to a web page 
attachment. Further suppose that the glossary assigned to this topic contains the term "disk" 

with a different attachment as its definition link. If you then update the glossary links for the 

topic, the original link to the web page is left intact, and no glossary link is created from the 
word "disk" to the definition link attachment. 
 
Note that document names, package files, and templates are all excluded from glossary 
markup. 
 
When you publish your content to Player outputs, glossary terms appearing in bubble text in 

topic frames or web page text are linked to their definitions as in the Developer. Users can 
click glossary links to display the attachments containing the definitions of the glossary terms. 
When you publish content that contains glossary markup to a Training Guide and Instructor 
Manual, a glossary is included as a list of terms and definitions at the end of the document. If 
you publish content containing more than one glossary to one of these document outputs, the 
glossaries are merged and presented as one alphabetical list. If a term appears in more than 
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one of the merged glossaries, it is listed multiple times, once for each glossary in which it 
appears. However, only those terms with definition link attachments that typically appear in 

document outputs are included in the glossary. Specifically, the types of definition links 
included in the glossary sections of document outputs are package files (graphics only), web 

pages, and URLs (addresses only). Therefore, if a definition link is a non-graphic package file, 
such as an Excel spreadsheet, the corresponding term is not included in the document 
glossary. 

16.1 Create a Glossary 
You create and manage glossaries using the Glossary Editor. You can create a glossary from 
the Library toolbar or File menu available in the Library or any other document editor. When 

you create a new glossary or open an existing glossary, the Glossary Editor launches in a new 
tab and displays an empty glossary (or the selected glossary) where you can add, edit, and 
delete terms and change their properties (such as tooltip). You can save the glossary to any 
folder in the Library and then assign it to one or more documents anywhere in the Library. 
 
If you save a glossary to the wrong folder in the Library, you always have the option to move 

the glossary document to another folder. You can also rename a glossary at any time without 

breaking any links from your content to the glossary. 
 
Note: You can open multiple glossaries at the same time. Each glossary appears in its own 
tab. 
 
In addition to its name, each glossary document has a language assigned to it. The default 
language of a new glossary document is the language of the Developer. However, you can 

change the language of the glossary in the Properties toolpane. 
 

 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 

want to make a new document available to multiple authors and place the document 

under the Developer's version control system, you must check it in. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To create a new glossary: 

1. On the File menu, point to  New and choose  Glossary. 

  
or 
  

On the Library toolbar, choose  Glossary. 

  
2. Add terms to the glossary. 

  
3. Save the new glossary. 

  
You can also close the tab and click Yes in response to the Save Document message. 

  
When you save a glossary for the first time, you are prompted to provide a name for 
it. Enter a name for the glossary by typing over the default name. Although the 
glossary name does not have to be unique, it is recommended that you provide a 
meaningful name so you can easily manage multiple glossaries. 
  
Long document names are supported. 
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16.2 Edit a Glossary 
You can open a glossary at any time in the Glossary Editor to modify its contents. For each 
glossary that you open to edit, an independent instance of the Glossary Editor opens in a 
separate tab, allowing you to edit multiple glossaries at one time. When you edit a glossary, 
you can add, edit, or delete glossary terms, where each glossary entry consists of a term (the 
text to be matched for markup), a link to an attachment that provides its definition, a tooltip 
(optional), and markup conditions (Match Whole Word and/or Match Case). 

 
After making any changes to a glossary, you should update glossary links to apply your 
changes. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. 

  
When you add, edit, or delete glossary terms, you are editing the glossary document, 
so you must check the glossary out. When you assign a glossary to a document or 

update glossary links, you are not editing the glossary document itself, so you do not 
need to check the glossary out. In these cases, you are editing the parent documents 
to which the glossary is assigned, so you must instead check out the parent 
documents. 

To edit a glossary: 

1. From the Library, open the glossary document that you want to edit. 

  
2. Add, edit, and/or delete glossary terms as needed. 

  

3. Save and close the glossary document. 
  
When you close a glossary document to which you have made and saved changes, you 

are prompted to update glossary links. Click Yes to update links for all documents to 
which the glossary is assigned, or click No to close the glossary without updating links. 
  
If you have not saved the changes before closing the glossary, you are prompted to 
save the glossary and update links, to save the glossary without updating links, or not 
to save the glossary. Select the appropriate option and click OK, or click Cancel to 
keep the glossary open without saving changes. 

16.3 Add a Glossary Term 
Each glossary entry consists of a term (the text to be matched for markup), a link to an 

attachment that provides its definition, a tooltip (optional), and markup conditions (Match 
Whole Word and/or Match Case). Glossary terms can include both spaces and special 

characters, and there is no limit to the length of a term. However, each term must include at 
least one non-space character and cannot begin or end with one or more spaces. In addition, 
glossary terms must be unique, on a case-insensitive basis, within a glossary document. 
Therefore, for example, one glossary cannot include both the terms "document" and 
"Document". You must enter a valid term before you can set any of the properties of the 

glossary entry (Definition Link, Tooltip, markup conditions). 
 
You can use any type of attachment (package file, web page, or URL) as a definition link. In 
the Developer and in published Player outputs, glossary terms appearing in bubble text in 
topic frames or web page text are linked to their definition attachments. Users can click 
glossary links to display the attachments containing the definitions of the glossary terms. 

Glossaries are also included in the Training Guide and Instructor Manual as a list of terms and 
definitions at the end of the document. If you publish content containing more than one 
glossary to one of these document outputs, the glossaries are merged and presented as one 
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alphabetical list. If a term appears in more than one of the merged glossaries, it is listed 
multiple times, once for each glossary in which it appears. However, only those terms with 

definition link attachments that typically appear in document outputs are included in the 
glossary. Specifically, the types of definition links included in the glossary sections of 

document outputs are package files (graphics only), web pages, and URLs (addresses only). 
Therefore, if a definition link is a non-graphic package file, such as an Excel spreadsheet, the 
corresponding term is not included in the document glossary. 
 
You also have the option to enter text for a tooltip that identifies the link contents. These 
tooltips appear in the Player when a user rests the mouse pointer over the link text. For 
example, because these links apply to glossary terms, you might use the tooltip "definition". 

However, the length of the tooltip is not limited, and you can use a different tooltip for each 
term, if desired. 
 
Tip: Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most 
useful. 
 

In addition, you can specify that the glossary term must match the whole word only, 

preventing words containing the glossary term from being marked as glossary links. For 
example, if the Match Whole Word option is selected for the glossary term “test”, the word 
“testing” is not marked as a glossary link. You also have the option to require glossary terms 
to match the specified case, so that words that are not typed in uppercase and lowercase 
letters exactly as the term in the glossary document are not marked as glossary links. 
 

After adding glossary terms, you should update glossary links to apply your changes. 
 

To add a glossary term to a glossary document: 

1. In the empty Glossary Term cell in the bottom row of the table, type the term. 

  
2. In the Definition Link cell in the same row, select an attachment for the definition 

link. 

  
3. In the Tooltip cell in the same row, type a tooltip, if desired. 

  

4. Set the markup conditions. 
  
By default, Match Whole Word is selected, and Match Case is not selected. Change 
a setting by checking or clearing the appropriate option. 
  

5. Continue adding terms or save and close the glossary document. 

  
When you close a glossary that is assigned to one or more documents after making 
changes to it, you are prompted to update the glossary links. Select Save the glossary 
and update the links and click OK to close the glossary and update links. Otherwise, 
you can select Save the glossary and click OK to close the glossary without updating 
links. Click Cancel to close the glossary document without saving changes. 

Tip: To navigate in the glossary, you can click in the desired cell or press TAB to move one cell 
to the right or SHIFT+TAB to move one cell to the left. 

16.4 Select a Definition Link Attachment 
When you create a new glossary term, you must also select a corresponding definition link, 
which is an attachment containing the definition for the term. If you do not select a definition 
link attachment for a term, no glossary links are created in your content for that term. A 
definition link can be any type of attachment: package item, web page, or URL. When you 
publish your content to Player outputs, glossary terms appearing in bubble text in topic frames 
or web page text are linked to their definitions as in the Developer. Users can click glossary 
links to display the attachments containing the definitions of the glossary terms. Glossaries 

are also included in the Training Guide and Instructor Manual as a list of terms and definitions 
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at the end of the document. If you publish content containing more than one glossary to one 

of these document outputs, the glossaries are merged and presented as one alphabetical list. 

If a term appears in more than one of the merged glossaries, it is listed multiple times, once 
for each glossary in which it appears. However, only those terms with definition link 
attachments that typically appear in document outputs are included in the glossary. 
Specifically, the types of definition links included in the glossary sections of document outputs 
are package files (graphics only), web pages, and URLs (addresses only). Therefore, if a 

definition link is a non-graphic package file, such as an Excel spreadsheet, the corresponding 
term is not included in the document glossary. 
 

To select a package file or web page as a definition link for a glossary term: 

1. In the Definition Link cell for the term, click . 

  

2. In the Edit Definition Link dialog box, click  Create link. 

  

3. In the Link to pane, select  Document in Library. 

  
If desired, you can select Packages or Web pages in the Type field to further filter your 
selection. 
  

4. Navigate the Library to the folder containing the package file or web page to which 
you want to link. 

  
5. Select the desired package file or web page document. 

  
6. Click OK or press ENTER. 

  
7. Click OK to close the Edit Definition Link dialog box. 

Note: At step 3, you can also click  Create new web page to create a new web page and 

link to it in one step. When you do so, you first specify the name of the web page and the 
Library folder in which it should be saved. The Web Page Editor then launches in a new tab, 
displaying an empty web page. 
 

To select a URL as a definition link for a glossary term: 

1. In the Definition Link cell for the term, click . 

  

2. In the Edit Definition Link dialog box, click  Create link. 
  

3. In the Link to pane, select  URL. 

  

4. In the Address field, type or paste the target URL. 

  
If a Base URL was set, you can enter a relative URL beginning with ../. 
  

5. Click  Go or press ENTER. 

  
While selecting a URL, you can also enter a base URL and then follow links in the 
preview displayed in the results pane to reach your desired target. 
  

6. Click OK or press ENTER. 
  

7. Click OK to close the Edit Definition Link dialog box. 
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16.5 Edit a Glossary Term 
You can edit a glossary term, if necessary, from the Glossary Editor. In addition to changing 

the text of the term itself, you can change the Tooltip, select a different attachment for the 
Definition Link, or change the markup conditions (Match Whole Word, Match Case). You make 

these changes in the same way as when you add a new glossary term.  
 
Note: Glossary terms can include both spaces and special characters, and there is no limit to 
the length of a term. However, each term must include at least one non-space character and 
cannot begin or end with one or more spaces. In addition, glossary terms must be unique, on 
a case-insensitive basis, within a glossary document. Therefore, for example, one glossary 

cannot include both the terms "document" and "Document". You must enter a valid term 
before you can set any of the properties of the glossary entry (definition link, tooltip, markup 
conditions). 
 
After editing one or more glossary terms, you should update glossary links to apply your 
changes. 

16.6 Delete a Glossary Term 
If a glossary term is no longer needed or appropriate, you can delete it by deleting the entire 
entry from the glossary document. Deleting the glossary term and updating links for the 
glossary from which it was deleted removes the glossary links from affected text; however, 
the link text itself is not deleted. The attachment (web page or package) used as the definition 
link is also not deleted. (URL attachments used as definition links are obviously not affected, 
as they are external to the Developer.)  

16.7 Assign a Glossary to a Document 
Once you create a glossary, you can assign it to one or more documents in the Library. A 
glossary can be assigned to a document in two ways: through manual assignment and through 
inheritance from the document's parent. 
 
You can manually assign a glossary while working in the Library, Outline Editor, or Web Page 

Editor, using the Properties toolpane. A glossary can be assigned only to modules, sections, 

topics, and web pages. Although no module or section text is marked up when glossary links 
are updated, assigning glossaries to modules and sections is useful for inheritance purposes of 
children documents. 
 
Tip: You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, you must select only document types that support 
glossaries. If a multi-document selection in the Library includes a document type that does not 

support glossaries, such as a package, the Glossary property does not appear in the Properties 
toolpane. 
 
Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 
 

Glossaries can be assigned through property inheritance only in the Outline and Topic Editors. 
If you assign a glossary to a module or section, all new module, section, and topic documents 
that you link as children of this document while working in the Outline Editor inherit the 
parent's glossary setting. Similarly, any new web page that you create from the Concept pane 
of the Outline Editor inherits the glossary of its parent. Likewise, if you assign a glossary to a 
topic, any new web pages that you create while working in the Topic Editor, for example, as 

new frame attachments, inherit the topic's glossary setting. However, new documents that are 
not linked (documents that are created using the File, New command) and existing documents 
that are linked as children of the document do not inherit any property settings. 
  
Note: A glossary must be attached to the parent document prior creating the child document 
for the child to inherit the glossary. If child documents already exist when the glossary is 
attached to the parent, you must manually attach the glossary to each child document. 
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Once you have assigned a glossary to a document, you still must update glossary links to 

create glossary links in that document. 

 
If a glossary is no longer appropriate for a document, you can change or remove the assigned 
glossary using the Properties toolpane. Changing or removing the glossary assigned to a 
parent does not automatically change the glossary for any child documents, even those that 
inherited their glossary from the parent. You must change the glossary for each child 

document manually. 
 
In addition, changing or removing the glossary assigned to a document does not automatically 
update glossary links. Therefore, after making any changes in glossary assignments, you must 
update glossary links to apply the new glossary to the affected documents. 
 
Note: You can view the glossaries assigned to selected documents in the Related Documents 

toolpane. However, you cannot use the Related Documents toolpane to change glossary 
assignments. 
  

When duplicating content, you can use the Duplicate Glossaries option to choose if you want 
to duplicate the glossary or glossaries linked to the selected content. If you do not include 
glossaries in the duplication, the duplicated content links to the original glossaries linked to 
the source content; this allows you to maintain a master glossary for all related content. The 

default setting for this option is to create a duplicate since you may want to change the 
definition of terms for new content without affecting previous content. Deselecting the option 
maintains the links to the original glossaries. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. If you are changing 
the glossaries of multiple documents at the same time, all selected documents must 
be checked out. 

  
Glossaries linked to content are excluded from the check in/check out process. You 
must manually check in a glossary to make it available to other authors or check it out 
to edit it. 
  
You can link to a glossary even if it is checked out to another user. 
  

When you are working offline, you can link to a glossary only if it is available in your 
local cache. Therefore, if you plan to work offline, you should ensure that you have a 
local copy of any glossary to which you want to link. To do this, you can either check 
out or get the glossary, depending on whether you plan to edit it or to have access to 
a read-only copy. If you go offline and do not have a copy of a glossary in your local 
cache, that glossary is unavailable to you as you work offline. To remedy this, you 
need to go back online and get the documents that you need. 

To assign a glossary to a document: 

1. Display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document(s) to which you want to assign 

a glossary. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, glossaries can be assigned only to modules, 
sections, topics, and web pages. 
  

3. In the General category, click the Glossary cell and then click . 

  



  Define Glossary Terms 

   367 

4. Navigate the Library to the folder containing the desired glossary. 
  

5. Click Open or press ENTER. 
  
After assigning a glossary to a document, be sure to update glossary links. 

To remove a glossary assigned to a document: 

1. Display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document(s) from which you want to 

remove an assigned glossary. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, you must select only module, section, topic, 
and/or web page documents to which the same glossary has been assigned. 
  

3. In the General category, click the Glossary property name and press DELETE to clear 

the glossary field. 
  
Note: Click the Glossary field label in the left column, not the assigned glossary in the 
right column. 
  
After removing an assigned glossary from a document, be sure to update glossary 
links. 

16.8 Update Glossary Links 
The final step in using glossaries is glossary markup, or updating glossary links. You can 

update glossary links from the Glossary Editor, the Library, or the Outline Editor. 
 
When you update glossary links from the Glossary Editor, all documents to which the open 

glossary is assigned are updated. 
 
When you update glossary links from the Library or Outline Editor, the selection and its related 
documents are included by default. Clicking the View Related Documents link displays a list of 

the related documents. For this process, related documents are defined as all searchable 
documents that are directly or indirectly linked as children of the selection. For example, if you 
select a section that has topics and each of the topics has a web page linked as its concept, 
choosing to search related documents searches the section, the topics, and the web pages 
linked to the topics. Templates and package contents are not included in this operation. 
 

From the Library, you must have at least one document selected or the tool is disabled. If 
nothing is selected in the Outline Editor, the entire outline is searched; this is equivalent to 
selecting the root of the outline. 
 
The documents that are included in glossary markup from the Library and Outline Editor do 

not all have to have the same assigned glossary, but each one must have an assigned 
glossary to be updated. The appropriate glossary is applied to each document, regardless of 

the glossary used to update any document to which it is related. 
 
During glossary markup, the Developer searches the text in your content for occurrences of 
glossary terms. When it finds a term that matches the selected markup conditions (Match 
Whole Word and Match Case), it creates a link to the attachment specified as the definition 
link. By default, when a glossary term appears multiple times in one location, only the first 
instance of the term is marked as a glossary link. You can also change the glossary default 

settings to have all occurrences of all terms marked as glossary links. 
 
If you later make any changes to a glossary, to glossary assignments, or to text containing 
glossary terms, you must update the links again. 
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Glossary markup affects text in frame bubbles in topics, including Introduction and End 

frames, and text in web pages. However, if a glossary term is included in the text of a 

manually created bubble text link or web page hyperlink, no additional glossary link is created 
during glossary markup. That is, text used in manually created links is skipped during glossary 
markup. For example, suppose that a frame bubble in a topic contains the text "Save this file 
to your local disk." and you create a link from the phrase "local disk" to a web page 
attachment. Further suppose that the glossary assigned to this topic contains the term "disk" 

with a different attachment as its definition link. If you then update the glossary links for the 
topic, the original link to the web page is left intact, and no glossary link is created from the 
word "disk" to the definition link attachment. 
 
Note that document names, package files, and templates are all excluded from glossary 
markup. 
 

Note also that glossary markup does not create recursive links. Therefore, if a web page that 
is used as the definition link for a term includes text containing the same term, no glossary 
link is created, so that the web page is not linked to itself by glossary markup. 

 
Once created, a glossary link functions just like any other link to an attachment, such as a 
hyperlink inserted in a web page. Therefore, you can edit or remove the link, if desired. 
However, any changes that you make to a glossary link apply only to that link and do not 

affect the entry for the glossary term in the glossary document. In addition, if you later update 
glossary links again, the text used in a manually edited glossary link is excluded from glossary 
markup and is not overwritten with a new glossary link. 
 

 Multi-user Considerations 

 For changes to be made to a document using this tool, the document must be checked 
out. If you plan to use this tool offline, you should check out all affected documents 
before going offline. 
  
When you execute this process, the Developer searches through all of the documents 

in the selection, regardless of their check in/out state. If a change is necessary and 
the document is not checked out and if you are working online, the Developer 
automatically checks the document out to you and makes the change. If the document 
cannot be checked out, for example, if it is open in another editor or checked out to 
another user or you are working offline, it is skipped. At the end of the process, a 
summary message appears with a link to an activity log. Clicking the View Activity Log 
link in the message displays a list of the documents that were checked out to you 

during the process and those that could not be checked out. After you save any 
changes, you should check in the documents to make them available to other authors 
and add the changes to the Developer's version control system. 
  
To update glossary links, you do not need to check out the glossary, only the parent 
document(s). In addition, you can update links with a glossary even if it is checked out 
to another user. However, the glossary markup in this case does not reflect any 

changes made to the glossary after it was checked out. 

  
When you are working offline, you can update glossary links only if the glossary is 
available in your local cache. Therefore, if you plan to work offline, you should ensure 
that you have an up-to-date local copy of any glossary you plan to use. To do this, you 
can either check out or get the glossary, depending on whether you plan to edit it or 

to have access to a read-only copy. If you go offline and do not have a copy of a 
glossary in your local cache, you are unable to update glossary links for any 
documents to which it is assigned as you work offline. To remedy this, you need to go 
back online and get the documents that you need. 
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To update glossary links from the Glossary Editor: 

1. Open the glossary document, if necessary. 

  
2. On the Edit menu, choose Update Glossary Links. 

  
If you have unsaved changes in the glossary, you can also choose Save and Update 
from the File menu to save your changes and update glossary links in one step. 

  
The Developer searches all documents to which the glossary is assigned and updates 
links for glossary terms found in those documents. 

To update glossary links from the Library or Outline Editor: 

1. Select the document(s) for which you want to update glossary links. 
  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). If you do not select a document in the Outline Editor, 
the entire outline is updated. 
  

2. On the Edit menu, choose Update Glossary Links. 
  

The Developer searches all selected documents and their directly related children and 
updates links for glossary terms found in those documents to which a glossary is 
assigned. 

16.9 Delete a Glossary 
If a glossary is no longer needed or appropriate, you can delete it just as you would delete a 
document of any other type. You can delete a glossary only from the Library. 
 

Deleting a glossary removes the glossary document from the Library, but does not delete the 
package files and web pages used as definition links unless you explicitly choose to delete 

related documents as well. The links created using the glossary are also not removed when 
the glossary is deleted. Therefore, if you delete the glossary with related documents, you 
break these links. Moreover, deleting a glossary does not remove the glossary from the 
documents to which it was assigned. Therefore, if you delete a glossary that is assigned to one 
or more documents, you break the glossary assignment links. You can use the Broken Links 
tool to identify any broken links in your content that result from deleting a glossary. 
 

To avoid breaking links when you delete a glossary document, you should first ensure that it is 
not assigned to any documents. To do this, you can use the Related Documents tool to find all 
of the documents to which the glossary is assigned (parent documents). Then, select the 
parent documents in the Library or Outline Editor and use the Properties toolpane to remove 
the glossary from these documents or to assign a different glossary. If you plan to delete the 
glossary's related documents as well (child documents used as definition links), you should 

also update glossary links for the parent documents, to remove any links created using the 

glossary to be deleted. After completing these steps, you can select the glossary document 
from the Library and delete it without creating any broken links. 
 

 Multi-user Considerations 

 Documents under version control must be checked in and you must be working online 
to delete a document from the Library. You can delete new documents that have never 
been checked in (are not under version control) while working online or offline. 
  
Deleted documents that have been checked in to the Library can be restored if they 
have not been purged by your Administrator. New documents that have never been 
checked in cannot be restored. 
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17 Create Roles for Content Filtering 
Role-based filtering allows users to quickly locate modules, sections, topics, questions or 
assessments based on their job function or department. While developing content, you can 
create a list of roles corresponding to your intended users and assign the roles to the 
appropriate documents. During publishing, you can tailor your output by publishing selectively 
to one, several, or all roles. In the Player, users can then choose from a list of available roles 

to display only the content that is relevant to their job function; they can also toggle to display 
the entire outline if necessary. 
  
Note: Roles are not available when content is played through a Learning Management 
System. The user never sees the Player interface, as the LMS creates its own outline for the 
content. You can still use roles to filter the content that gets published, however. 
  

You can also create document outputs, such as Training Guides, that contain information 
relevant to only specific roles. In addition, the assigned roles populate the Roles/Responsibility 
field when you publish a System Process Document. 

 
Note: See Also links can also be filtered by Role. If a linked document has a role assigned to it 
that matches a role set on the parent document, the See Also link appears in the Player 

output. If no matching role exists, the See Also link is excluded from the Player output. 
 
Working with roles in the Developer requires two basic steps: First, you create the roles, and 
then you assign these roles to the appropriate documents. You use the Role Editor to create 
and manage roles in master role list documents. You assign roles and view role assignments 
at the document level through the Properties toolpane in the Library or Outline Editor. Once 
you assign one or more roles to a document, the role assignment is saved as a property of the 

document and travels with it on operations such as export and import. 
 
By default, the Developer comes with one empty master role list for each language installed. 
These role lists are stored in the System/Roles folder and are named according to language. 
The default name of a role list document is Roles, followed by the two-letter abbreviation of 

the language of the document. For example, the Roles.en document is the master role list for 
the English language. Additional roles that are not included in any role list can also exist in 

your content. For example, while new roles assigned to imported content are automatically 
added to the master role list, newly imported roles may not be added if the master role list is 
open in the Role Editor and unavailable for updating. To simplify role assignment, however, it 
is recommended that you always update the master role list to include these additional roles 
whenever they exist. 
  

 Multi-user Considerations 

 If the master role list is checked out by another author, the new roles assigned to 
documents in a new import are not added to the role list as the document is locked for 
editing. Roles that have not been saved in the master role list appear as additional 
roles in the Assign Roles dialog box for those documents to which the roles have been 

assigned. After a locked role list is checked in, you are prompted if you want to add 
these roles the next time you open the role list. 

When you assign roles to modules, sections, topics, questions or assessments, the Developer 
determines the language of the selected document(s) and displays a list of all roles in the 
master role list for that language, as well as any additional roles that are in use in the selected 
documents. You can assign roles to all selected documents at the same time; however, the 
selection can include modules, sections, topic questions, or assessments only, and all of the 
documents selected for role assignment must be of the same language. 

 
Warning! Do not delete the role list for any language. Doing so disables role assignments for 
that language. 
 
Once you assign one or more roles to a document, the role assignment is saved as a property 
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of the document. If you later make changes to these roles in a master role list, the document 
assignment is not updated. Therefore, it is recommended that you define and finalize your role 

lists before assigning roles to documents. Otherwise, you must manually update each 
document to which obsolete roles are assigned to reflect the changes in the master role list. 

17.1 Edit a Master Role List 
By default, the Developer comes with one empty master role list for each language installed. If 
needed, you can create role lists for additional languages. You use the Role Editor to add, 
rename, and/or delete roles in these master role lists. 
 
In addition, content that you import might be assigned to roles that are not included in the 

master role list for the appropriate language. From the Role Editor, you can easily update the 
master role list to include such additional roles whenever they exist. 
 
Tip: It is recommended that you define and finalize your role lists before assigning roles to 
documents. If you later rename or delete a role that has been assigned to one or more topics, 
you should update the role assignments automatically when you save the changes to the role 

list. 

 
You can access the Role Editor from the Library or Outline using the Manage Roles item on the 
Edit Menu. The Role Editor can also be opened using the Manage button on the Assign Roles 
dialog box. Using these methods, the Developer determines the appropriate language master 
role list to open based on the following: 

 No document selected: Master role list opens in the default language specified on 
the General Tab of the Content Defaults category on the Options dialog box. 

  

 Document selected: Master role list opens in the language associated to the 
document. 
  

 Document selected in a language where no Master Role List exists: New 
master role list is created and opens in that language. 

  

 Multiple documents of different languages are selected: The master role list for 
each selected language opens in a separate tab. 

You can open the master role list in a specific language by opening the associated Role file 
from the System/Roles folder in the Library. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. 

If you rename or delete a role assigned to one or more documents, a prompt appears to 

update the role assignments automatically when you save your changes to the master role 
list. If you choose to do this, the Developer searches through all of the documents with the 
same language as the master role list, regardless of their check in/out state. If a change is 

necessary and the document is not checked out and if you are working online, the Developer 
automatically checks the document out to you and makes the change. If the document cannot 
be checked out, for example, if it is open in another editor or checked out to another user or if 
you are working offline, it is skipped. At the end of the process, a summary message appears 
with a link to an activity log. Clicking the View Activity Log link in the message displays a list 
of the documents that were checked out to you during the process and those that could not be 
checked out. After you save any changes, you should check in the documents to make them 

available to other authors and add the changes to the Developer's version control system. 
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If a document cannot be checked out to update a renamed or deleted role, you need to update 

the role assignment for that document manually. 

 
Automatic updating of assignments for a role that is renamed or deleted is available only at 
the time the change is made. If you choose not to update role assignments automatically at 
that time, you need to update them manually for all documents to which the renamed or 
deleted role was assigned. 

 

To edit a master role list: 

1. Navigate in the Library to the System/Roles folder. 
  

2. Open the role list to which you want to add the role. 
  
If the Add Roles in Use message box appears, click Yes to add these roles to the role 
list or No to proceed without adding the roles. See Update a Master Role List for 
further detail. 

  

3. Add, rename, and/or delete roles as necessary. 
  

4. Save and close the master role list. 
  
If you renamed or deleted any roles that are assigned to one or more documents, you 
are prompted to update these role assignments when saving your changes. Click Yes 
to save the master role list and update role assignments or No to save the master role 

list without updating role assignments. 
  
If you have not saved the changes before closing the master role list, you are 
prompted to save the master role list and update role assignments, to save the master 
role list without updating role assignments, or not to save the master role list. Select 
the appropriate option and click OK, or click Cancel to keep the master role list open 
without saving changes. 

  
If you choose not to update role assignments automatically when saving your 
changes, you need to update them manually for all documents to which the renamed 
or deleted role was assigned. 

17.2 Add a Role 
You can add one or more roles to a role list using the Role Editor. 
 
Each role consists of a text description of a group of users, such as a department name or job 

function. Roles can include both spaces and special characters, and there is no limit to the 
length of a role name. Each role must include at least one non-space character and cannot 
begin or end with one or more spaces. In addition, roles are not case sensitive and must be 
unique within a role list document. Therefore, for example, one role list cannot include both 
the roles "author" and "Author". 

 

To add a role to a role list: 

1. In the role list to which you want to add a role, click the empty Role cell in the bottom 

row of the table. 
  

2. Type the name of the role. 
  

3. Continue adding roles or save and close the role list document. 

Tip: To navigate in the role editor, you can click in the desired cell or press TAB to move one 
row down the list or SHIFT+TAB to move one row up the list. 
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17.3 Rename a Role 
After you have created roles, you might need to rename them. For example, you might have 

inadvertently misspelled a role and need to correct it. Roles can include both spaces and 
special characters, and there is no limit to the length of a role name. Each role must include at 

least one non-space character and cannot begin or end with one or more spaces. In addition, 
roles are not case sensitive and must be unique within a role list document. Therefore, for 
example, one role list cannot include both the roles "author" and "Author". 
 
If you rename a role that is assigned to one or more documents, you must also update the 
role assignments of the document(s). It is recommended that you update role assignments 

automatically when prompted to do so after saving changes to the master role list. If the role 
assignment for a document cannot be updated automatically at that time, for example, if the 
topic is open in the Topic Editor, or if you choose not to update role assignments 
automatically, you must manually update each topic to which obsolete roles are assigned to 
reflect the changes in the master role list. 
 
Tip: You can use find and replace to update role assignments. 

 
Warning! Renaming a role in the master role list without updating role assignments to 
remove the original role from all documents, causes the original role to remain in the Library 
as an additional role in use and is added back to the role list if you automatically update the 
role list before it is removed from all document(s). To completely rename a role, you must 
both rename it in the role list and update all documents to which the original role was 
assigned. 

 

To rename a role: 

1. In the role list, select the role you want to rename. 

  
2. Type the changes. 

  
Note that this renames the role in the role list only and does not update any 

documents that might have been assigned to this role. 
  

3. Save and close the role list document. 

  
It is recommended that you update role assignments automatically when prompted to 
do so after saving changes to the master role list. If you choose not to update role 
assignments automatically at this time, you need to update them manually for all 
topics to which the renamed role was assigned. 

17.4 Delete a Role 
In addition to removing roles from documents, you can delete them from a role list. 
 
If you delete a role that is assigned to one or more documents, you must also update the role 

assignments of the document(s). It is recommended that you update role assignments 

automatically when prompted to do so after saving changes to the master role list. If the role 
assignment for a document cannot be updated automatically at that time, for example, if a 
topic is open in the Topic Editor, or if you choose not to update role assignments 
automatically, you must manually update each document to which obsolete roles are assigned 
to reflect the changes in the master role list. 

 
Tip: You can use Find and Replace to update role assignments. 
 
Warning! Deleting a role in the master role list without updating role assignments to remove 
the original role from all documents, causes the original role to remain in the Library as an 
additional role in use and is added back to the role list if you automatically update the role list 
before it is removed from all document(s). To completely delete a role from the Library, you 

must both delete it from the role list and remove it from all documents to which it is assigned. 
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To delete a role from a role list: 

1. In the role list, select the row of the role you want to delete. 

  
Note that you must select the entire row; you cannot simply delete the text name of 

the role. 
  

2. Click  Delete or press DELETE. 

  
3. Save and close the role list document. 

  
It is recommended that you update role assignments automatically when prompted to 
do so after saving changes to the master role list. If you choose not to update role 
assignments automatically at this time, you need to update them manually for all 
documents to which the deleted role was assigned. 

17.5 Update a Master Role List 
Although you create and manage roles using role lists, additional roles can exist in your 
Library that are assigned to one or more documents but are not included in any role list. Such 
roles can arise as a result of conversion or import, as described later in this section. 
 
During import, the Developer identifies all roles used in the imported content. It then 
compares these roles to the master role list of the same language. If any of these roles is not 
included in the appropriate master role list, the Developer attempts to add the role to the role 

list. If the role cannot be added to the list, for example, if the master role list is open in an 
editor, the role is still kept in the content but is not included in any role list. 
 
When you open a role list for which such roles exist, you are prompted to add these roles to 
the role list. Clicking Yes adds these roles to the role list; clicking No opens the role list 
without adding the roles. In the latter case, you can still update the master role list to include 
such roles from within the Role Editor. 

 
Although you can allow roles to continue to exist in your Library as additional roles in use that 
are not included in any role list, this is not recommended, as such roles are available for role 
assignment only in certain cases. See Assign Roles to Modules, Sections, or Topics for further 
detail. Rather, it is recommended that you include all roles in use in your content in the 
appropriate master role list, thus making them available for assignment to all documents of 

the same language. 
 

To update a master role list from the Role Editor: 

1. On the Edit menu, choose Update Master Role List. 

  
The Developer searches documents of the same language as the role list and adds any 
roles that are not currently in the document. 
  

2. Save and close the role list document. 

17.6 Create a New Role List 
By default, the Developer comes with one empty master role list for each language installed. 
Each master role list can be used to assign roles to all documents of the same language. 

Therefore, you need to create a new role list only if your content includes a language for which 
no role list currently exists. 
 
Note: Only one role list can be used to assign roles to documents of a given language. If 
multiple role lists exist for the same language, only the oldest (the first one created) is used to 
populate the role assignment selection list. For example, if you make a copy of the Roles.en 
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document and add roles to it, those new roles do not appear as assignment choices for any 
English documents. Therefore, you should not create more than one role list for any language. 
 

Warning! Do not delete the role list for any language. Doing so disables role assignments for 
that language. 
 

To create a new role list, you must start with an existing role list. For example, you can set up 
all necessary roles in an existing role list and then create new role lists for other languages 
using this initial list as a model. 
 

Tip: You can change the language of a role list from the Properties toolpane. 
 

You can create a new role list from the Library or the Role Editor. From the Library, you make 
a copy of the roles document. From the Role Editor, you save the original role list as a new 

document. 
 

The original master role lists in the Library are named according to language. For example, the 
Roles.en document is the master role list for the English language. Although you do not have 

to follow this convention in naming new role lists, it is recommended that you provide a 
meaningful name so you can easily find the new role list later. 
 

All role list documents must be saved in the System/Roles folder to be used for role 

assignment. 
 

 Multi-user Considerations 

 Any new document that you create or link is automatically checked out to you. If you 
want to make a new document available to multiple authors and place the document 

under the Developer's version control system, you must check it in. 
  
See Check In and Check Out Documents in Use the Developer in a Multi-user 
Environment for more information. 

To create a new role list from the Role Editor: 

1. Open the master role list you want use as the basis for the new role list. 

  
2. On the File menu, choose Save As. 

  
3. In the Save As dialog box, type a name for the new role list. 

  
Although there are no restrictions on the name of a role list, it is recommended that 

you provide a meaningful name so you can easily find the new role list later. 
  
Both the Type field and the Save in field should read "Roles". 
  

4. Click Save or press ENTER. 
  

5. Use the Properties toolpane to set the language of the new role list. 

To create a new role list from the Library: 

1. Navigate to the System/Roles folder. 

  
2. Select the master role list you want use as the basis for the new role list. 

  

3. On the Edit menu, choose  Copy. 
  
You can also right-click your selection and choose Copy. 
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4. On the Edit menu, choose  Paste to paste a new copy of the original role list. 

  

You can also right-click in a blank area in the Contents pane or right-click a folder in 

the Folders pane and choose Paste from the context menu. You can paste the new role 
list document in any Library folder, but it cannot be used for role assignment unless it 
is saved in the System/Roles folder. 
  

5. If desired, rename the new role list document. 
  
Although this step is optional, it is highly recommended. There are no restrictions on 

the name of a role list, but it is recommended that you provide a meaningful name so 
you can easily find the new role list later. 
  

6. Use the Properties toolpane to set the language of the new role list. 

17.7 Assign Roles to Modules, Sections, Topics, Questions, or 
Assessments 
Once you have created roles using role lists, you can assign the roles to one or more modules, 
sections, or topics. This step is necessary to allow both role-selective publishing in the 
Developer and role-based filtering in the Player. 

 
You can assign roles while working in the Library or Outline Editor, using the Properties 
toolpane. Roles can be assigned to module, section, topic, question or assessment documents, 
and all of the documents selected for role assignment at one time must be of the same 
language. 
 

Tip: You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). If a multi-document selection in the Library includes a 
document type that does not support roles, such as a package, the Role property does not 
appear in the Properties toolpane. 
 

When you select documents for role assignment, the Developer determines the language of 
the selected document(s) and displays a list of all roles in the master role list for that 

language. If any additional roles are in use in the selected documents but are not on the role 
list, they are also shown. Note that inclusion of these additional roles depends on the specific 
document(s) selected for role assignment, rather than just language. Consequently, such roles 
are available for role assignment only if the document(s) to which they are assigned are 
included in the selection. It is therefore recommended that you always update the master role 
list to include these additional roles whenever they exist. 
 

If no role list exists for the language of the selected document(s), role assignment is not 
enabled. 
 
Warning! Do not delete the role list for any language. Doing so disables role assignments for 
that language. 
 

To assign a role to a document, you simply select the checkbox next to the desired role in the 
Assign Roles dialog box. To remove the role from the document, clear the checkbox. Note, 
however, that, if you remove a document from all roles, the document appears in the Player 
only if role-selective filtering is turned off. 
 
If you select multiple documents for property assignment, the checkboxes for the property 
values can have any of three initial states: 

 Unselected (clear): The value is not assigned to any of the selected documents. 
  

 Selected (checked): The value is assigned to all of the selected documents. 
  

 Partially selected (gray with gray checkmark): The value is assigned to some, but not 
all, of the selected documents. 
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You can check or clear any checkbox, regardless of its initial state, to assign the value to or 
remove it from ALL of the selected documents. If you do not change the state of a partially 

selected checkbox, the assignment of the corresponding value remains unchanged (assigned 
to some, but not all, of the selected documents). However, once you click a partially selected 

checkbox, you cannot restore it to its initial state. Therefore, when assigning property values 
to documents, you should select only those documents to/from which you want to add/remove 
the same value(s). 
 
Once you assign one or more roles to a topic, the role assignment is saved as a property of 
the topic document. If you later make changes to these roles in a master role list, the topic 
assignment must also be updated. It is recommended that you update role assignments 

automatically when prompted to do so after saving changes to the master role list. If the role 
assignment for a topic cannot be updated automatically at that time, for example, if the topic 
is open in the Topic Editor, or if you choose not to update role assignments automatically, you 
must manually update each topic to which obsolete roles are assigned to reflect the changes in 
the master role list. Therefore, it is recommended that you define and finalize your role lists 
before assigning roles to topics. 

 

Tip: You can use Find and Replace to update role assignments. 
  

 Multi-user Considerations  

 Before you can perform this action, you must check out the document. After you save 

any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. If you are assigning 
roles to multiple documents at the same time, all selected documents must be 
checked out. The Roles property is not available for editing if one or more documents 
in a multi-document selection are not checked out. 
  

You do not need to check out the role document, only the document(s) to which roles 
are being assigned. In addition, you can assign roles even if the appropriate master 
role list is checked out to another user, although only the roles in the latest checked in 

version of the role list are available for assignment. 
  
To assign roles while working offline, you should ensure that you have the latest 
version of the appropriate master role list(s) available in your local cache. To do this, 

you can either check out or get the role list, depending on whether you plan to edit it 
or to have access to a read-only copy. If you go offline and do not have a current copy 
of a role list in your local cache, some of the roles on the role list might be unavailable 
to you as you work offline. To remedy this, you need to go back online and get the 
documents that you need. 

To assign roles to one or more documents: 

1. Display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document(s) to which you want to assign 

roles. 
  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). However, all documents included in your selection must 
have the same language. 
  

3. In the General category, click in the Roles cell then click . 
  

4. In the Assign Roles dialog box, select the role(s) to which you want to assign the 

selected document(s). 
  
To include a role, click the checkbox next to its name. To remove a role, clear the 
checkbox next to its name. 
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You can also use the Select All button to include all roles or the Clear All button to 

remove all roles from the selection. These buttons apply to all roles listed in the Assign 
Roles dialog box, whether they are included in the master role list or are available as 
additional roles for the selected documents. 
  

5. Click OK or press ENTER. 
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18 View Document Properties 
Documents contain two types of properties; those that are calculated and those that you can 
manually edit. Examples of calculated properties are the columns that display on the Details 

view such as Document ID, Checked Out By, Version, and Frames. Modules, sections, topics, 
web pages, and packages have editable properties that you can set and change at any time. 
These properties display in the Properties toolpane. The properties you set are saved with the 
document and travel with it on operations such as export and import. 
  

Initial Values  

Some editable document properties start with an initial value. The initial value assigned 
depends on how the document was created. New documents that are created by linking them 
to an outline inherit the same value as the parent. New documents created in the Library as 
stand-alone documents not linked to a parent, adopt the system setting in the Options dialog 
box as the initial value. As with any editable property, you can change document's initial value 
at any time. 

  

Note: There are several exceptions to the rules. The Resolution property is set prior to 
recording and cannot be edited on the Properties toolpane after recording. Additionally, 
Workflow properties do not travel with the document on import or export. 

18.1 Use the Properties Toolpane 
Editable document properties are viewed and modified in the Properties toolpane, which can 
be opened from the Library and all document editors. By default, the Properties toolpane 

opens docked on the right side of the Developer window. However, you can undock, move, 
and resize the Properties toolpane as needed.  
 
Properties are grouped under categories in the Properties toolpane. Depending on the selected 
document type, different categories and properties appear. When you select a document, 
categories such as General, Topic, and System Process Document may appear. You can 
expand and collapse categories to show or hide the related properties. The expand/collapse 

state of any category is saved as you navigate to other documents. 
 
When you select a property, its description appears at the bottom of the toolpane. The bottom 
of the toolpane also displays warning messages when you cannot change the properties for a 
document. 
 

The Properties toolpane is divided into two columns, with the name of the property in the left 
column and the value assigned to the property in the right column. You can resize the columns 
by dragging the vertical border between them. In addition, you can resize the height of the 
description pane at the bottom of the toolpane to view more or less of the text. When the 
descriptive pane or a property column is not large enough to display the full contents, pointing 
to the truncated text displays the full text in a tooltip. 
  

Note: The Properties toolpane does not split when you enable a split layout. The properties in 
the toolpane refer to the document selected in the active layout. 
 

Toolpane Views 

The Categorized and Alphabetical buttons that appear at the top of the Properties toolpane 
control how you view the properties. The Categorized view, which is the default, displays the 

properties organized by category names. The Alphabetical view removes the category names 
and sorts all properties in alphabetical order. 
  

Set Concept Properties 

In the Outline Editor, you can use the Properties toolpane to set the properties of a concept 

linked to the document in the outline. For example, you can assign a style sheet to the 
concept of the topic that you have selected in the outline. When working in the Outline Editor, 
the top of the Properties toolpane contains a drop-down list that you can use to switch 
between viewing Document and Concept properties. The Document option, which is the 
default, shows the properties for the selected document in the outline. The Concept option 
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displays the properties for the web page or package linked to the selected document as a 

concept. 

  
Note: The Properties drop-down list also displays the document type for the selected 
document and linked concept. Document types under the Document option include 
module/section, topic, question, or assessment; and the document types under the Concept 
option include web page or package. 

 

 Multi-user Considerations 

 To change general, topic, and document output properties, you must check out the 
document. A message appears at the bottom of the toolpane if any of the documents 

in a selection are read-only. You can change general, topic and document output 
properties while working online or offline. 
  
To change workflow properties, you must be working online and the document can be 
either checked in or checked out to you. Properties in this category include Owner and 
State. 

18.2 Change Document Properties 
You can leave the Properties toolpane open as you modify properties. The contents of the 
toolpane change as you move from document to document. If you select multiple documents 

and change a property, the change is applied to all selected documents. When the selection 
includes multiple documents of mixed document types, the only properties that are available 
for editing are the properties that the document types have in common. Only editable 
properties appear in the Properties toolpane. 
 
You can open the Properties toolpane from the Library or any document editor. Property 
changes made from the Library or Outline Editor are automatically saved to the document. 

Changing a property from another editor, such as the Web Page editor, initiates a prompt to 
save your changes when you close the editor. You cannot change properties for a document 

open in another editor. For example, if you open a web page or topic, you cannot change 
properties for the open documents from the Library. A warning message appears at the 
bottom of the Properties toolpane indicating that the document is open and that you must 
close it to modify the document properties. 
 

Undo Document Properties 

Most document editors (for example, Outline, Glossary, and Role editors) have an Undo 
command that allow you to undo a property change. You cannot undo property changes from 
the Web Page or Package editors or from the Library. There is no limit to number of actions 
you can undo/redo in the Outline Editor. 

 
If you are changing properties from an editor that does not allow undo, and you are still in the 
property cell, you can press CTRL+Z or right-click in the cell and choose Undo from the 
context menu to undo a property change. Once you click outside a cell, you cannot undo your 
changes. 

 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. When you select a 
checked in document, a Read-Only message appears at the top of the Properties 

toolpane. If you are changing the properties of multiple documents at the same time, 
all selected documents must be checked out. Properties are not available for editing if 
one or more documents in a multiple document selection are not checked out. 
  
You can change workflow properties for documents that are checked in or checked out 
to you. 



  View Document Properties 

   381 

To change properties for a document: 

1. Display the Properties toolpane. 

  
You can also right-click any document and choose Properties or press F4. 
  

2. Select the document(s) whose properties you want to change. 
  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  
You can also edit the properties for a web page or package open in a document editor. 
  

3. Click the property cell in the Properties toolpane and make the necessary changes. 

Note: The Developer automatically saves property changes made while you are working in the 
Library or Outline Editor. For properties that you type directly in a cell, you can press ENTER 

or click outside of the property cell to finalize your entry. 

18.2.1 Ways to Assign Properties 

How you enter or change the value for a property depends on the type of property. The 
methods for assigning property values include:  

 Text entry: For properties such as keywords and document output fields, you type a 
value for the property directly into the corresponding cell in the Properties toolpane. 
For properties that may contain a large amount of text, such as an instructor note or a 

table, a browse button ( ) appears in the cell. Clicking the Browse button opens a 

window where you can enter text or create the table. 
   

 Selection of a single value from a list: A drop-down arrow appears in the property cell 
for properties where you select a single value from a preset list of values. These 

properties include language and screen resolution. 
   

 Selection of multiple values from a list: A drop-down arrow or browse button appears 
in the property cell for properties where you can select multiple values from a preset 
list of values and options. You can select or clear one or more options. 

18.2.2 Assign a Property to Multiple Documents 

You can select multiple documents and change one or more properties at the same time. If 

the selected documents have different values for the same property, the property value 
appears blank in the property cell or dialog box. Entering new text or selecting a new value 
applies the property value to all the selected documents. 
 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 

existing values for all selected documents. 
 

Assign Checkbox Properties 

Properties such as roles, play modes, and remediation levels allow you to assign multiple 
values. The available values for these properties appear in an option list. You assign property 
value(s) by selecting one or more options. 
 

If you select multiple documents for property assignment, the checkboxes for the property 
values can have any of three initial states: 

 Unselected (clear): The value is not assigned to any of the selected documents. 
  

 Selected (checked): The value is assigned to all of the selected documents. 
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 Partially selected (gray with gray checkmark): The value is assigned to some, but not 
all, of the selected documents. 

You can check or clear any checkbox, regardless of its initial state, to assign the value to or 
remove it from ALL of the selected documents. If you do not change the state of a partially 
selected checkbox, the assignment of the corresponding value remains unchanged (assigned 
to some, but not all, of the selected documents). However, once you click a partially selected 
checkbox, you cannot restore it to its initial state. Therefore, when assigning property values 

to documents, you should select only those documents to/from which you want to add/remove 
the same value(s). 

18.3 General Properties 
The General Properties category appears for all document types. Depending on how a 
document was created, the initial property values for a document either default to the settings 
in Tools, Options or are inherited from the parent document. 
 

When you create a new module or section document from the Library, you have the 
opportunity to change the default settings for the Language, Template, and Screen Resolution 
properties. These defaults are then passed to any new module, section or topic documents 
that are linked to the parent in the Outline Editor. For example, if you create a new Purchasing 
module with a screen resolution of 800 x 600, and then link a new Purchase Orders section 
and new Reviewing a Purchase Order topic, the new documents inherit the same screen 
resolution as the parent module. 
 

Existing documents inserted into an outline retain their original properties, even if they do not 
match the property settings of the parent. For example, if you link the Working with Vendors 
section with a screen resolution of 1024 x 768 to the Accounts Payable module, the linked 
section retains its original screen resolution settings. However, if you now create/link new 
documents to the Working with Vendors section, the new documents inherit the new screen 
resolution. 
 

You can change the properties in the General category for a single document or several 

documents at the same time. 
 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 
 

The General Properties category includes the following properties: 

 Assessments 

  

 Background color 
  

 Context 

  

 Custom properties 

  

 Description 
   

 Glossary 
  

 Group for LMS 

  

 Keywords 
  

 Language 
  

 Name 
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 Resolution 

  

 Roles 
  

 See Also 

  

 Style Sheet 

  

 Template 

 Multi-user Considerations 

 To change properties, you must check out the document. 

18.3.1 Assessments Property 

The Assessments property allows you create an association between a module or section and a 
course, even if it is not included in the course. By setting an assessment as a property of the 

module or section, the assessment can then be selected as a pre-assessment or post-
assessment in the Professional edition. 
  
Note: The Assessments property only applies to content deployed in a Knowledge Path in the 
Professional edition of the Knowledge Center. 
 

To associate an assessment to a module or section: 

1. Display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document(s) to which you want to 

associate an assessment. 
  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. In the General category, click the Assessments cell then click . 

  

4. In the Associated Assessments for Knowledge Center dialog box, click  Add 
associated assessment. 

  
5. In the Add Assessments dialog box, navigate to the desired assessment and click 

Open. 
  

6. Click OK. 

Note: To remove the association between an assessment and a module or section, open the 
Associated Assessments for Knowledge Center dialog box, select the assessment you want to 

remove, and click the  Remove associated assessment from this list or press DELETE. 

18.3.2 Background Color Property 

The Background color property allows you to control the background color of your web page. 
This property uses the standard Color dialog box for selecting colors. See Select a Color in the 
Web Page Defaults section of the Get Started using the Developer chapter for more 

information on the Color dialog box. 
  
Note: When you create a web page, the No Color option on the Color dialog box is checked by 
default since the page has either no color or a color assigned from a style. You can set the 
background color or override a style color on a web page, by unchecking the No Color option 
and selecting a color. 
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To set the web page background color: 

1. Display the Properties toolpane. 

   
2. From the Library or Outline Editor, select the web page to set the background. 

 
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, all documents included in your selection must 
have the same language. 
   

3. In the General category, click  in the Background color cell. 

   
4. Select the desired color. 

  
5. Click OK. 

18.3.3 Context Property 

The Context property allows you to define a relationship between a topic(s) and a non-topic 
document such as sections and modules. This relationship allows for better search results 
because searching and finding the non-topic document also finds the related topics.  
 
The Context button opens the Context dialog box which is used to add relationships from 

existing topics to non-topic documents and/or create Context IDs for new topics that are 
related to non-topic documents. 

18.3.3.1 Context for Topic verses Non-Topic Documents 

Context, which allows for better search results, can be applied to individual frames that make 
up a topic or associated, in a broader sense, to non-topic documents that can be related to 

one or more topics. 
 

Topic documents 

Context is added to a topic (on a frame by frame basis) during the recording process. You can 
view the Context ID for any frame in the Context ID dialog box. 
 

Context can also be manually added to a topic, on a frame by frame basis, if the match type is 
ExactMatch or NoMatch. You cannot add context to frames with a context type of SmartMatch 
because they are fuzzy matches, not specific Context IDs. 
 

The Context ID dialog box opens from within a topic by clicking  on the toolbar or by 

choosing Context ID from the Edit menu. 
 

Non-topic documents 

Context can be assigned to a non-topic document such as a section or module. This allows you 
to define relationships between topics and non-topic documents ensuring that related 
documents appear in a topic. For example, each time a user works through the process of 
filling out a purchase order form (for example, a series of topics), a link to the actual purchase 

order form (for example, a non-topic document) can be provided. In the Developer, the author 
can associate each frame of the process with the non-topic document. They can also associate 
the entire topic with a section or module. 

 
Note: Frames added to a process after the context association was made to a non-topic 
document are not automatically associated to the non-topic document. The author must 
manually make the association to the new frames. However, if a topic is associated directly 
with a topic or section, any new frames added to the topic automatically inherit the association 
to the topic or section. 

 
Context relationships for non-topic documents are set up from the Context field in the General 
category of the Properties toolpane. The Context field displays the name of each topic 
associated with the non-topic document. The Context button opens the Context dialog box 
which is used to add relationships from existing topics to non-topic documents and/or create 
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Context IDs for new topics that are related to non-topic documents. The Context dialog box 
contains two tabs: Topic Contexts and Context Names. 

 
The Topic Contexts tab is where you create Context IDs for non-topic documents by selecting 

existing topics with context. This relationship insures that when you look at the section, the 
associated topics also appear. The Add Topic Contexts button opens the Add Existing Topic 
Contents dialog box where you can select existing topics with context to relate to the non-
topic document. 
 
Note: Context can also be added to non-topic documents by copying context from an existing 
topic and pasting it to a non-topic document or by capturing the context by recording 

screen(s) of the relevant application. 
 
The Context Names tab is where you create additional Context IDs or edit the existing Context 
IDs of supported application screens associated with a non-topic document. The Create New 
Context button opens the Recorder in order to record an application screen. Once recorded, 
the Context Name field is filled with a context name and the Screen View show a snapshot of 

the captured screen. The Edit Context button opens the Context ID dialog box. You can add 

additional context names or edit the captured Context ID context name. This allows you to 
find specific context via a user-friendly name without having to understand all of the parts that 
make up the context ID. 
 

To add context to a section/module: 

1. Select a section or module document in the outline. 

  

2. Click in the Context field in the Properties toolpane then click  to open the Context 

dialog box. 
  

3. With the Topic Contexts tab active, click  Add topic contexts to open the Add 

Existing Topic Contexts dialog box. 
  

4. Select the existing topic(s) to be associated with the document and click OK. 
  
The selected topics display on the Topic Contexts tab. 
  

5. Click OK. 

18.3.3.2 Copy Context 

Context can be copied from a frame within a topic and pasted to a non-topic asset such as a 
section or module. This copies all rows of the Context ID into the section or module. Context 
IDs cannot be pasted from one frame into other frames. 
 
Context can also be copied from a section or module to another section or module. Since 
multiple contexts can be associated to a section/module, you can copy single Context IDs or 

all Context IDs associated with a section to another section. 
 

To copy context from a topic frame to a section/module: 

1. Open a topic in the Topic Editor. 

  
2. Select a frame with context that you want to copy. 

  

3. On the Edit menu, choose  Copy Frames. 

  
4. In the outline, select the section or module to which you want to paste the context. 

  
5. If necessary, open the Properties toolpane of the section or module. 
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6. Click  in the Context field to open the Context dialog box. 

  

7. From the Context Names tab, click the  Paste Context button. 

  
8. Click OK to save the context. 

To copy context between sections/modules: 

1. If necessary, open the Properties toolpane of the section or module. 
  

2. Click  in the Context field to open the Context dialog box. 
  

3. From the Topic Contexts tab, select the topic(s) within the section to be copied and 

click the  Copy Context button. 

  
4. Click OK. 

  
5. Navigate to the Context dialog box of the destination section. 

  

6. From the Topic Contexts tab, click  Paste Context. 
  

7. Click OK. 

18.3.4 Custom Properties 

You can add custom properties to any document type that appears in the outline: modules, 
sections, topics, questions, and assessments. Custom properties are metadata, which can be 

used to add searchable information to the item, such as author, author email, date, and so on. 
This information is included when you use the Find and Replace command in the Developer, so 
you can locate specific content more easily. In addition, you can include this table in document 
outputs. See the Customize Document Formats section of the Publish Content chapter in this 

guide for more information. 
 

The property table is blank by default and does not contain prepopulated field names. There 
are three columns in the table. The Field column is for the name of the field, while the Value 
column is the content of the field. The Bookmark Name field is generated automatically from 
the text in the Field column. The bookmark name must be unique, as the bookmark can be 
used to add the custom property field to the document output on its own (not as part of the 
table), as duplicate bookmarks are not allowed. Using the bookmarks separately can be useful 
to place an author's name on the cover of a guide, for example. See the Use Bookmarks 

section in the Customize Document Formats section of the Publish Content chapter in this 
guide for more information. 
 
You can add more rows to the Custom Properties table, delete rows, and move rows up and 
down to rearrange the order. The text in the first cell of the table appears in the Properties 
toolpane when you select a document that contains this custom property. 

 

If a multiple document selection contains existing table text, the table dialog box displays the 
common table rows that appear in ALL of the selected documents. The common table row can 
appear in different row positions in the selected documents as long as the text in the row is 
identical. If the selected documents contain no common table rows, the table appears blank. 
  
Warning! The changes made to a table for a multiple document selection affect all of the 

selected documents, and overwrite any existing values. Therefore, the table rows that do not 
appear in a multiple selection because they are not common to the entire selection are 
deleted. 
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To add custom properties: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select the document to which you want to add custom 

property values. 
  

3. In the General category, click  in the Custom properties cell. 

  
4. The Custom Properties dialog box opens with a blank row ready for text entry. 

  
5. Type the text in the appropriate cell. Press TAB to move from one cell to the next. A 

new row is automatically added. 
  

6. Click OK to save the changes. 
  
You can also click Cancel if you do not want to save your changes. 

Tip: All cells allow multi-line entries. You can create multiple lines in a cell by letting the text 
word-wrap or by pressing Shift+ENTER to insert new lines. Scroll arrows appear in multi-line 
cells for navigating through the text. 
 

To insert a new row: 

1. Select a row and click  to add a new row before the selected row. 

  
2. Type the text in the appropriate cell. 

  
3. Click OK to save the changes. 

  
You can also click Cancel if you do not want to save your changes. 

To delete a row: 

1. Select the row you want to delete and click . 

  
2. Click OK to confirm the deletion. 

  
You can also click Cancel if you do not want to save your changes. 

To sequence a row: 

1. Select a row and click  or  to move the row to a new position in this list. 
  

2. Click OK to save the changes. 

  
You can also click Cancel if you do not want to save your changes. 

18.3.5 Glossary Property 

Once you create a glossary, you can assign it to one or more documents in the Library. A 
glossary can be assigned to a document in two ways: through manual assignment and through 
inheritance from the document's parent.  
 
You can manually assign a glossary while working in the Library, Outline Editor, or Web Page 
Editor, using the Properties toolpane. A glossary can be assigned only to modules, sections, 
topics, and web pages. Although no module or section text is marked up when glossary links 
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are updated, assigning glossaries to modules and sections is useful for inheritance purposes, 

as described below. 

 
Tip: You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, you must select only document types that support 
glossaries. If a multi-document selection in the Library includes a document type that does not 
support glossaries, such as a package, the Glossary property does not appear in the Properties 

toolpane. 
 
Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 
 
Glossaries can be assigned through property inheritance only in the Outline and Topic Editors. 

If you assign a glossary to a module or section, all new module, section, and topic documents 
that you link as children of this document while working in the Outline Editor inherit the 
parent's glossary setting. Similarly, any new web page that you create from the Concept pane 

of the Outline Editor inherits the glossary of its parent. Likewise, if you assign a glossary to a 
topic, any new web pages that you create while working in the Topic Editor, for example, as 
new frame attachments, inherit the topic's glossary setting. However, new documents that are 
not linked (documents that are created using the File, New command) and existing documents 

that are linked as children of the document do not inherit any property settings. 
 
Once you have assigned a glossary to a document, you still must update glossary links to 
create glossary links in that document. 
 
If a glossary is no longer appropriate for a document, you can change or remove the assigned 

glossary using the Properties toolpane. Changing or removing the glossary assigned to a 
parent does not automatically change the glossary for any child documents, even those that 
inherited their glossary from the parent. You must change the glossary for each child 
document manually. 
 
In addition, changing or removing the glossary assigned to a document does not automatically 

update glossary links. Therefore, after making any changes in glossary assignments, you must 

update glossary links to apply the new glossary to the affected documents. 
 
Note: You can view the glossaries assigned to selected documents in the Related Links 
toolpane. However, you cannot use the Related Links toolpane to change glossary 
assignments. 

18.3.6 Group for LMS Property 

You use the Group for LMS property to indicate to a Learning Management System that a 
module or section should be considered as one unit in the outline. These units can be launched 

and tracked individually when a user accesses the content. 
  
A group cannot contain another group. If you designate a high-level outline item to be 
grouped for an LMS, any groups at a lower level within its structure are ignored. For example, 

if there is a module which contains 3 sections, and you designate the module and all 3 
sections to be grouped for an LMS, only the module is considered a group. 

  
The Group for LMS property is set to No by default. If you do not change it for any item in the 
outline, then the LMS generates the full outline. If you change the Group for LMS property to 
Yes for the top-level item (module or section) in the outline, the LMS displays an outline with 
only that item in it, and a user must launch that item to see the content. If you change this 
property to Yes for items which are at lower levels in the outline, the LMS generates an outline 
showing only those items, and they are each individually launchable. 

  
Although scored items within the LMS group (assessments, inline questions, and topics with 
Know It? mode available) display a pass or fail indicator in the outline when completed, the 
LMS group as a whole is an unscored item and its completion status is either "completed" or 
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"incomplete". See LMS Groups in the Deploy the Player through an LMS section in the Deploy 
the Player chapter of the Content Deployment guide. 

  
Note: This property is not needed for topics, as they are considered individual units by 

default. 
 

To change the Group for LMS property: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select a module or section. 

  
3. In the General category, click the Group for LMS cell. 

  
4. Click the arrow to the right of the cell and select the desired option. 

18.3.7 Keywords Property 

When a user performs a search in the Player, the Player performs a full text search of the text 
in the content you have created. You may, however, want to link text not used in the content 

to specific documents. The Keyword property allows you to attach words or text that relate 
specifically to your organization that might not occur in the content. 
 
Note: Keywords can be assigned to module, section, or topic documents. 
 
Keywords act like an index for locating documents and allow users to quickly find relevant 
content. For example, if members of your organization are required to use special formatting 

features to create end of month reports, you might want to attach the name of the monthly 
report as a keyword to all documents that could assist users with format features needed for 
report creation. It is very important for content authors to develop good keywords that enable 
users to quickly find the information they need. 
 
Note: Document text is not indexed for Far Eastern languages. The only way for Search to 

work in the Player for such languages is for authors to attach keywords. 
 
Keywords travel with the document, so that each time you reuse or export/import the 
document, the keywords are also reused or exported/imported. 

18.3.7.1 Assign Keywords 

Keywords are assigned to module, section, or topic documents from the Library or Outline 
Editor. You can select a single or multiple documents and assign one or more keywords to the 
selection. 
 
There is no limit on the number of characters in a keyword, nor is there a limit to the number 
of keywords a document may contain. However, the Keywords field is limited to a total of 
1024 characters. Multiple keywords in the same document are separated by a comma (,), for 

example, "order, payment, vendor". Spaces added before or after a keyword are ignored. 
 

Note: You can copy a comma delimited list of words from Microsoft Word or Notepad and 
paste it into the Keywords field. The copied text cannot include paragraph marks. 
 
Keywords are not case sensitive, you can type them in upper or lower case. If the keyword for 
topic A is "print" and the keyword for topic B is "Print", both topics A and B are indexed under 

the same keyword "print". The Developer automatically reorders the keywords for a document 
in alphabetical order and removes any duplicate keyword entries. 
 
Note: Although you can enter a phrase (multiple words separated by spaces) for a single 
keyword entry, the Developer treats each word in the phrase as a single keyword. The 
Developer does not remove a duplicate word if it is part of a phrase. 

 
Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
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existing values for all selected documents. To assign additional keywords to multiple 

documents, see Rules for Assigning and Deleting Keywords in the Keywords Property section 

of the General Properties section of the View Document Properties chapter of this guide. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. 
  
In a multiple selection, you cannot add, edit or delete keywords unless all documents 
are checked out. 

To assign a keyword: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select the document(s) to which you want to assign a 

keyword. 
  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. In the General category, click the Keywords cell. 
  

4. Type the first keyword. 

  
5. To assign additional keywords, type a comma (,) and then type the next keyword. 

Note: To append a keyword to existing keywords, click at the end of the keywords, type a 

comma and the new keyword. 

 
Note: You can move or copy keywords from one topic to another. You can right-click in the 
Keywords cell and use the commands on the context menu to cut, copy, and paste selected 
keywords. You can also use the Select All command to select all the keywords in the cell. 

18.3.7.2 Delete Keywords 

You can remove a keyword from a document by deleting the keyword in the Keywords field. 
You can also edit an assigned keyword to correct it. 
 
Note: To delete or edit keywords for multiple documents, see Rules for Assigning and Deleting 
Keywords in the Keywords Property section of the General Properties section of the View 

Document Properties chapter of this guide. 
  

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 

any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. 
  
In a multiple selection, you cannot add, edit or delete keywords unless all documents 
are checked out. 

To delete a keyword: 

1. Display the Properties toolpane. 
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2. In the Library or Outline Editor, select the document(s) for which you want to delete a 
keyword. 

  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). 
  

3. For a single document or multiple documents with identical keywords, select the text 
in the Keywords cell and press DELETE. 
  

4. To delete all keywords for multiple documents with different keywords assigned, type 
any text in the blank Keywords cell, then select the text and press DELETE. 

18.3.7.3 Rules for Assigning and Deleting Keywords 

The results of assigning keywords depend on whether you are assigning keywords to one 
document or multiple documents and if those documents already contain existing keywords. 
The following list describes the rules for assigning keywords: 

 Selection: One document with no keyword assigned 
Display in Toolpane: Keywords cell appears blank 

Actions Available: You can add a new keyword. 
   

 Selection: One document with an existing keyword 
Display in Toolpane: Keyword appears in Keywords cell 
Actions Available: You can edit, delete, or append to existing keyword. 

   

 Selection: Two or more documents that contain no existing keywords 
Display in Toolpane: Keywords cell appears blank 
Actions Available: You can add a new keyword. The keyword is assigned to all selected 

documents. 
   

 Selection: Two or more documents that contain identical existing keywords 
Display in Toolpane: Keywords appear in Keywords cell 

Actions Available: You can edit, delete, or append to existing keywords. 
   

 Selection: Two or more documents that contain different existing keywords 
Display in Toolpane: Keywords are not displayed. The Keywords cell appears blank 

Actions Available: You can enter a new keyword. The new keyword overwrites any 
existing keywords in the selected documents. You cannot append keywords if different 
keywords are assigned. 

18.3.8 Language Property 

The Language property indicates the default language of the content and determines the 
language dictionary that is used to check the spelling of the document. If you assign a 
language to a document for which no Developer dictionary exists, the spelling checker skips 
checking the document.  
 

New documents created from the Library inherit the default language setting. New module, 
section, and topic documents created in the Outline Editor automatically inherit the language 

of their parent. 
 

You can also view the Language property for documents in the Details View in the Library or 
Outline Editor. 
 

Note: The Language property for a topic also determines the template text and publishing 
styles that are available for preview and the master role list that is used for assigning roles. 

18.3.9 Name Property 

The Name property is the name the author gave to the document when it was created/saved. 

You can use this property to rename a document.  
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Note: The document must be checked out to change the name. The Name property is not 

available for a multiple document selection. 

18.3.10 Resolution Property 

The Resolution property determines the screen resolution in which the content is recorded. 
The resolution is determined by the dimensions in the Width and Height properties.  
 
To set the resolution, you can select one from the list of common screen resolutions or enter a 
custom screen resolution in the Resolution field. 

 
If authors attempt to record in a screen resolution other than the assigned resolution, a 
message box informs them that their resolution does not match the setting for the topic and 
indicates in what resolution they should record. While authors are not prevented from 
recording in a different resolution if they choose, this property does help to create greater 
consistency in the content. 
 

The Resolution property for recorded topics is read-only; you cannot change the resolution for 

a topic that has already been recorded. 

18.3.11 Roles Property 

Role-based filtering allows users to quickly locate documents based on their job function or 
department. 
 
For each language, there is a separate master role document to which you can add the roles 
that correspond to your company roles. You can then use this master role list to assign roles 

to modules, sections, or topics. 
 
Roles are assigned to one or more document from either the Library or the Outline Editor 
using the Roles property. The Roles property opens the Assign Roles dialog box, from which 
you can select a single role or multiple roles to assign to the selected document(s). 
 

Note: If roles assigned to a document appear truncated in the toolpane, you can point to the 

Roles property to display a tooltip showing the assigned roles. 
 
Roles travel with the document so that each time you reuse or export/import the document, 
the roles are also reused or exported/imported. 
 
You can view the roles assigned to documents in the Properties toolpane or in the Roles 

column that appears in the Details View in the Library or Outline Editor. 
 

Removing Roles from Documents 

You can choose to remove one or more roles from one or more documents by clearing the 
appropriate checkbox in the Assign Roles dialog box. 
 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. If some of the documents in a multiple document 

selection already contain roles, adding or removing roles overrides the original role 
assignments for all selected documents. See Assign Roles to Modules, Sections, or Topics in 
the Create Roles for Content Filtering in this guide for more information about changing roles 
for multiple topics. 

 

To assign roles to one or more documents: 

1. Display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document(s) to which you want to assign 

roles. 
  
You can select multiple documents using the standard Windows selection keys 
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(CTRL+click and SHIFT+click). However, all documents included in your selection must 
have the same language. 

  

3. In the General category, click  in the Roles cell. 

  
4. In the Assign Roles dialog box, select the role(s) to which you want to assign the 

selected document(s). 
  
To include a role, click the checkbox next to its name. To remove a role, clear the 
checkbox next to its name. 

  
You can also use the Select All button to include all roles or the Clear All button to 
remove all roles from the selection. These buttons apply to all roles listed in the Assign 
Roles dialog box, whether they are included in the master role list or are available as 
additional roles for the selected documents. 
  
You can also use the Manage button to open the Roles property (in the language you 

are using) in the System folder to edit or add roles. 

  
5. Click OK or press ENTER. 

18.3.12 See Also Property 

The See Also property allows an author to create a relationship between a document and other 
related content. Use this property to link modules, sections, or topics from an outline or library 
to other modules, sections or topics in the Outline Editor or Library for publishing to the 
Player. When the content is viewed in the Player, the See Also links display. The user can click 
on these links to see the content the author has connected to the content being viewed. 

 
You create a See Also link on a module, section or topic by setting the See Also property in the 
General section of the Properties toolpane. 
 

 Multi-user Considerations 

 Before you can perform this action, you must check out the document. After you save 
any changes, you should check in the document to make it available to other authors 
and add the changes to the Developer's version control system. 

See Also links can be published to the Player. Content selected with See Also links not selected 
during publishing causes the target of the link to be included in the publishing output. This 
creates a self-contained package so no content is lost. 
  
Note: See Also links can be published to any element (module/section/topic) below the 

selected root element. The root element is not published, so there is nothing to link a See Also 
link. 
 

See Also in the Player output 
When content is published to the Player, a See Also list for a selected document displays in the 
top right corner of the Player if there is linked content. The order of the See Also links on the 

Player list is determined by the order the related documents on the See Also property dialog 
box. When the user clicks on a See Also document in the Player, the related content opens in 
a separate window. The left pane contains a See Also table of contents that contains all See 
Also documents for the selected document (module, section or topic). 
 
Note: The See Also table of contents or any documents launched from the See Also table of 
contents do not contain additional See Also links. See Also links are only available from the 

original parent document. 
 

Filter See Also links by role 

See Also links can be filtered by role. When you publish to the Player, if you filter by role the 
linked documents must have the same role property set for the See Also link to appear on the 
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list. Like any other role-based filtering, this can be useful to provide related content to the 

user based on roles. For example, you may have different roles set up for new employees then 

you do for existing employees. The new employee role might include how to fill out a timecard 
while the existing employee would have no need for this content. By filtering by these roles, 
the same content can be used but customized to the needs of each experience level. See the 
Create Roles for Content Filtering topic of the Manage Document Relationships section in the 
Content Development guide for more information on role-based filtering. 

 

See Also links to missing documents 

See Also links that refer to missing or deleted documents creates a warning message in the 
activity log. The missing document also displays in the Broken Links pane. If all of the See 
Also links related to a document are broken, the See Also list does not display in the Player. 
 

Customizing See Also links 

The appearance of the See Also link list and button text in the Player can be customized in the 
skin.css file by editing the following elements. The See Also text font, font size, color and 
background color is controlled by the .tocFrameText element. The background color, size and 

border of the See Also button are controlled by the .tsep element. The arrow button can be 
changed by replacing the seealsoarrow graphic in the img folder of the Player style. See the 

Customize the Player topic of the Publish Content section of the Content Developer guide for 
more information on customizing the player interface. 
 
Note: When Knowledge Center content is converted for use in the Developer, using 
Convert>Knowledge Center from the Tools menu, existing Related Sections are converted to 
See Also links. 
 

To link a See Also document: 

1. Display the Properties toolpane. 
  

2. From the Outline Editor or Library, select a document(s) to which you want to link an 
existing document(s). 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. In the General category, click  in the See Also cell. 
  

4. In the See Also dialog box, click  and navigate to the document(s) you want to link 

to the selected document(s) and click Open. 
  
You can use the Type field to filter by topic, section or module, if necessary. 
  

5. Click OK. 
  
The newly linked document(s) display in the See Also field on the Properties toolpane. 

To change the order of related documents: 

1. Display the Properties toolpane. 

  
2. Select a document with See Also links you want to reorder. 

  

3. In the General category, click  in the See Also cell. 
  

4. In the See Also dialog box, select the document(s) and click  or  to change the 

order of how the related documents appear in the output. 
  

5. Click OK. 
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To delete See Also links: 

1. Display the Properties toolpane. 

  
2. From the Outline Editor or Library, select the document(s) from which you want to 

delete a See Also link(s). 
  

3. In the General category, click  in the See Also cell. 

  

4. In the See Also dialog box, select a document(s) to remove and click . 

  
The See Also link to the document is deleted but the document still exists in the 
Library. 
  

5. Click OK. 

18.3.13 Style Sheet Property 

Style sheets are documents that contain one or more styles that are used to format text and 
other elements in web pages. In order to use a style, the style sheet containing that style 
must be assigned to the document. A style sheet can be assigned to a document in two ways: 
through manual assignment or through inheritance from the document's parent. 

  
A style sheet can be assigned only to modules, sections, topics, and web pages. You can 
manually assign a style sheet while working in the Library, Outline Editor, Web Page Editor, or 
Topic Editor using the Style Sheet property on the Properties toolpane. A style sheet can be 
assigned to multiple documents from the Library or Outline Editor. Style sheets only affect 
web pages, but assigning a style sheet to a module, section or topic is useful for inheritance 
purposes, as described below. 

 
Tip: You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, you must select only document types that support 

style sheets. If a multi-document selection in the Library includes a document type that does 
not support style sheets, such as a package, the Style Sheet property does not appear in the 
Properties toolpane. 

 
Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 
 
Style sheets can be assigned through property inheritance. If you assign a style sheet to a 
parent document, all new module, section, and topic documents that you link as children of 

this document while working in the Outline Editor, and more importantly, all new web pages 
linked as concepts inherit the parent's style sheet setting. 
 

Any new web page that you create from the Concept pane of the Outline Editor inherits the 
style sheet of its parent. Likewise, if you assign a style sheet to a topic, any new web pages 
that you create while working in the Topic Editor, for example, as new frame attachments, 

inherit the topic's style sheet setting. However, new documents that are not linked 
(documents that are created using the File, New command), and existing documents that you 

link, do not inherit any property settings. 
 

If a style sheet is no longer appropriate for a document, you can change or remove the 
assigned style sheet using the Properties toolpane. Changing or removing the style sheet 
assigned to a parent does not automatically change the style sheet for any child documents, 
even those that inherited their style sheet from the parent. You must change the style sheet 
for each child document manually. 
 

Note: You can view the style sheets assigned to selected documents in the Related Links 
toolpane. However, you cannot use the Related Links toolpane to change style sheet 
assignments. 
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 Multi-user Considerations 

 Before you can perform this action, you must check out the document. If you are 
assigning a style sheet to multiple documents at the same time, all selected 
documents must be checked out. 

To assign a style sheet to a document: 

1. Display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document(s) to which you want to assign 

a style sheet. 
  

You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). However, only modules, sections, topics, and web 
pages can be included in the selection. 

  
Note: You cannot change the style sheet property for a web page from the Outline 
Editor. You can change the property from the Library or Web Page Editor. 
  

3. In the General category, click the Style Sheet cell then click . 
  

4. In the Select a Style Sheet Document dialog box, navigate to the desired style sheet 
and click Open. 

To remove a style sheet assignment from a document: 

1. Display the Properties toolpane. 

  
2. From the Library or Outline Editor, select the document(s) for which you want to 

remove a style sheet. 
  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). However, only modules, sections, topics, and web 
pages can be included in the selection. 
  
Note: You cannot change the style sheet property for a web page from the Outline 
Editor. You can change the property from the Library or Web Page Editor. 
   

3. In the General category, click the Style Sheet property name and press DELETE to 
clear the style sheet name from the field. 

18.3.14 Template Property 

The document template determines the text used for bubble text and action properties. The 

Template property allows you to browse the Library and select another template set. The 

template sets included with the program are the Standard and Microsoft templates. The 
Microsoft template conforms to the standards as stated in the Microsoft Manual of Style for 
Technical Publications. In addition to these templates, other template sets may be available to 
you. 
 
You can use the template to modify the text used in bubbles for action and object types. For 

example, you can change the template text for a Left click action to display the bubble text 
"Click on" instead of "Click the". Templates are read-only, but you can create a copy of the 
template with a new name, edit the text in the new template and use the Template property 
to assign the new template to your content. 
 
If you are creating content for a language other than the default Developer language, you can 
select the template for that language. However, you can set only one language per document. 
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If you need to produce the same content in multiple languages, you can follow the localization 
process to create a copy of your outline based on another language template. 

 
Note: Templates are stored in the Library by language in the System/Templates folder. 

18.4 Question Properties 
The Question Properties category applies to all types of questions. Some of the initial property 
values are pre-filled but you can override the values by changing the properties for an 
individual question or multiple selected questions. 
 
The Question Properties category includes the following properties: 

 Associated Content 
  

 Remediation 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 

18.4.1 Associated Content Property 

This property allows you to link remedial content, within the Developer, to a question to help 

reinforce the answer. Clicking the property opens the Select Associated Content dialog box for 
linking a module, section or topic to the question. This property can also be updated from the 
Set Associated Content button on the Assessment coverage view for questions in an 
assessment that do not have associated content. 
  
This property works in conjunction with the Show Associated Content option set on the 

assessment. The Show Associated Content property on the assessment makes all questions in 
the assessment available for linking remedial content. The Show Associated Content option 
selected in the Assessment category on the Options dialog box must also be checked to allow 

for remedial content on questions within an assessment. All three must be set for associated 
content to display. 
 
When a question is viewed in the Question Preview in the Developer or published to the 

Player, a Show Associated Content link displays in the Remediation area after the question is 
answered.  
  
Note: Content selected as associated content is also used to create personalized content in 
the Professional edition. 

18.4.2 Remediation Property 

This property determines the type of feedback a user receives after answering a question.  
 

The following describes the four types of feedback. Remediation text appears only if it was 

created for the question in Developer.  

 Always: The feedback always displays the correct answer and remediation text 
explaining why the answer is correct. 
   

 Incorrect: If the user's response is incorrect, the feedback displays the correct 

answer and remediation text that explains why the correct answer is correct. If the 
user's response is correct, the word “Correct” appears in the feedback. 
   

 User Asks: The feedback displays the word “Correct” or “Incorrect,” along with a 

Show Answer link. When this link is clicked, the correct answer and/or any 
remediation text appears in the feedback. 
   

 Results Only: The feedback only displays the word “Correct” or “Incorrect.” 
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Note: When questions are part of an assessment, the assessment's remediation property 

overrides the remediation property set for an individual question. If you import the 

assessment into the Knowledge Center (available in the Professional edition only), the 
remediation defaults from the Developer. These settings can be overridden for pre/post 
assessments in the Knowledge Center (available in the Professional edition only). 

18.5 Assessment Properties 
The properties in the Assessments category apply specifically to assessments. New 

assessments inherit certain defaults from the Assessment category on the Options dialog box; 
such as Passing score percentage and Question order. After an assessment is created, you can 
change the properties of a single assessment or several assessments at the same time. 
Assessment properties only appear in the Properties toolpane for a multiple selection if all 
selected documents are assessments.  
 
The Assessment properties category includes the following properties: 

 Answer Order 
  

 Passing Score % 
  

 Question Order 
  

 Remediation 

  

 Show Associated Content 
  

 Summary 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 

18.5.1 Answer Order Property 

Use the Answer Order Property to change the order of the answers on multiple choice 
questions in an assessment.  

 
If the Answer Order Property is set to As Authored, answers are presented in the order in 
which they were created in Developer. 
 
If the Answer Order Property is set to Random Order, answers to multiple choice questions are 
provided in random order. The answers appear in a different order each time the question is 
presented. For Multiple Choice (single answer) questions that include All of the Above and/or 

None of the Above, these answers remain in their positions at the bottom of the list of choices. 
 
Note: The default answer order is set on the Answer Order option in the Assessment category 
on the Options dialog box. 

18.5.2 Question Order Property 

Use the Question Order Property to change the question order for an assessment.  
 

If the Question Order Property is set to As Authored, questions are presented in the order in 
which they were established in the assessment. 
 
If the Question Order Property is set to Random Order, questions are presented in a different 
order each time the assessment is taken. 
 
Note: The default question order is set on the Question Order option in the Assessment 

category on the Options dialog box. 
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18.5.3 Question Limit Property 

This property determines the number of questions in the assessment which are displayed to 

the user when taking the assessment. Questions are selected randomly each time a user takes 
the assessment. If the property is empty or the value is higher than the number of questions, 
all the questions in the assessment are displayed. If an invalid value is entered, such as 0, the 

property reverts to the previous value. 

18.5.4 Passing Score Percent 

This property is the percentage of correct answers needed to pass an assessment. The range 
is from 0 to 100 (default). This value is used to track scoring in the Professional edition or an 
LMS. This information appears on the Summary Page in the Player when the student is done 
taking an assessment. 

18.5.5 Remediation Property 

This property determines the type of feedback a user receives on the response to a question.  
 

The following describes the five types of feedback. Remediation text appears only if it was 
created for the question in Developer.  

 Always: The feedback always displays the correct answer and remediation text 
explaining why the answer is correct. 
   

 Incorrect: If the user's response is incorrect, the feedback displays the correct 

answer and remediation text that explains why the correct answer is correct. If the 
user's response is correct, the word “Correct” appears in the feedback. 
   

 User Asks: The feedback displays the word “Correct” or “Incorrect,” along with a 

Show Answer link. When this link is clicked, the correct answer and/or any 
remediation text appear in the feedback. 
   

 Results Only: The feedback only displays the word “Correct” or “Incorrect.”  

   

 None: No feedback is provided for a question. 

Note: When questions are part of an assessment, the assessment's remediation property 
overrides the remediation property set for an individual question. If you import the 
assessment into the Knowledge Center (available in the Professional edition only), the 
remediation defaults from the Developer. These settings can be overridden for pre/post 

assessments in the Knowledge Center (available in the Professional edition only). 

18.5.6 Show Associated Content Property 

This property, when set to Yes, allows remedial content associated with questions to display 
when taking an assessment. This property works in conjunction with the Associated Content 
property set on each question and the Show Associated Content option selected in the 
Assessment category on the Options dialog box. You receive warning messages when 

publishing if some of the questions are missing the Associated Content property. 
 

When content is viewed in the Question Preview in the Developer or published to the Player, a 
Show Associated Content link displays in the Remediation area when a question is answered.  
  
Note: Content selected as associated content is also used to create a personal course in the 
Professional edition.  

18.5.7 Summary Property 

This property determines if a Summary page displays upon completion of an assessment, 
viewing the assessment in the Question Preview in the Developer or when published to the 

Player. If this property is set to Show Summary (default), a summary displays comparing the 
actual score to the passing score and a breakdown of correct and incorrect answers.  
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18.6 Topic Properties 
The properties in the Topic category apply specifically to topic documents. New topics inherit 
certain topic defaults from the Options dialog box, such as the default play modes and Know 
It? options. After you create topics, you can change the properties for a single topic or several 
topics at the same time. Topic properties only appear in the Properties toolpane for a multiple 
selection if all the selected documents are topics. 
  

The Topic Properties category includes the following properties: 

 Know It Remediation 
  

 Know It Required % 

  

 LMS Play Modes 
  

 Play Modes 

  

 Play Sound 

  

 Show Bubbles 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 
  

 Multi-user Considerations 

 To change properties, you must check out the document. 

18.6.1 Know It? Options 

The Know It? options are available if Know It? play mode is selected for a topic. Know It? 
options for new topics are set in the Options dialog box, but you can change them on a per 
topic basis. Know It? options include the Know It Required % and Know It Remediation 
properties. 
 

Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 

18.6.1.1 Know It Remediation Levels 

When you create a new topic, it inherits the remediation levels for Know It? mode from the 

defaults set in the Options dialog box. Remediation provides feedback for users when they 
perform an incorrect action in Know It? mode. 
 
When a user fails to complete a step in Know It? mode, they can see up to four levels of 

remediation. Of the four levels, you can configure whether any combination of the first three 
listed in the following content are active for a topic. The fourth level is always active. When 

users fail to complete a step on the first attempt, they are marked incorrect for that particular 
step. The following lists the four levels of remediation available, although you can only 
configure the first three for a specific topic or set global defaults for all new topics. 

 Level 1: User told to try again, the bubble informs you that your action was incorrect 
and to try again. 
  

 Level 2: User provided with instructions, the bubble informs you that the action was 

incorrect and provides instructions for completing the step. 
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 Level 3: User provided with instructions plus action area, the bubble informs you that 

the action was incorrect and provides instructions for completing the step and a 

highlighted area indicating where the action should take place. 
  

 Level 4: The Step is Completed for You, the bubble informs you that the action was 
incorrect and states that the action is now being completed for you. 

You can view and change the remediation levels assigned to a topic in the Know It 
Remediation property cell in the Properties toolpane. When activated, the Know It Remediation 

property cell displays a drop-down list from which you can select and deselect remediation 
levels. A short description of each level appears at the bottom of the list. You can change 
remediation levels for one or more topics. 
 
Note: If all of the topics in a multiple selection are assigned the same remediation levels, the 
levels appear in the Know It Remediation property cell. If the selected topics have different 

remediation levels assigned, the Know It Remediation property cell appears blank. Levels 
common to all selected topics appear active in the Remediation drop-down list, and the levels 

that differ appear grayed out. You can make changes to active or grayed out levels. See 
Assign a Property to Multiple Documents for more information about changing remediation 
levels for multiple topics. 
 
Warning! Be careful when changing a property for multiple documents that already contain 

values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 
 
Note: Changing default Know It? options in the Options dialog box affects new topics only. 
 

To change the Know It Remediation levels for a topic: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select the topic(s) whose remediation level you want 

to change. 

  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. In the Topic category, click  in the Know It Remediation cell. 
  

A list of remediation levels appears. 
  

4. Select a checkbox to include a remediation level or clear a checkbox to remove a 
remediation level. 
  

5. Press ENTER or click outside of the cell. 

18.6.1.2 Know It Required Percent 

When you create a new topic, it inherits the required percentage for Know It? mode from the 
defaults set in the Options dialog box. This percentage is the score a user needs to achieve in 
order to pass the assessment for the current topic. You can enter any value between 0 and 
100. 
 

There may be some specific topics for which you want to change the passing percentage. You 
may want to lower it for certain difficult tasks or raise it for common tasks. You can change 
the required percentage for Know It? mode for one or more topics using the Know It Required 

% property in the Properties toolpane. You can type any value between 0 and 100 and it is not 
necessary to type the % sign. 
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Note: If all of the topics in a multiple selection are assigned the same required percentage, 

the value appears in the Know It Required % property cell. If the topics have different 

percentages assigned, the Know It Required % property cell appears blank. 
 
Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 

 
Note: Changing default Know It? options in the Options dialog box affects new topics only. 
 

To change the Know It Required % for a topic: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select the topic(s) whose required percentage you 

want to change. 
  

You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). 
  

3. In the Topic category, click the Know It Required % cell. 
  

4. Type a value between 0 and 100 and press ENTER or click outside the cell. 

18.6.2 LMS Play Modes Property 

The play modes assigned to a topic with the LMS Play Modes property determine which play 
modes are available when the topic is launched from the Player in the Knowledge Center with 
the Professional edition or from another LMS. This gives you the flexibility to set different play 
modes in the LMS then other deployments. For example, you may want Try It!, Do It! and 

Print It! modes available for a targeted-application deployment but Try It! and Know It? mode 
for an LMS deployment.  

  
Note: Content played through the Player Table of Contents in Usage Tracking mode with the 
Standard edition honors the Play Modes property.  
  
These play modes can be set separately from the Player play modes. New topics automatically 

have See It!, Try It! and Know It? modes enabled for LMS playback, but you can change the 
play mode for a topic after it is created.  
 
You can view the LMS play modes assigned to a topic in the LMS Play Mode property cell in the 
Properties toolpane. You change the play modes for one or more topics by selecting or 
deselecting play modes from the LMS Play Mode drop-down list. A short description of each 

play mode appears at the bottom of the list. You can also set the default LMS play modes for 
new topics in the Topic page in the Options dialog box. 
  
Note: When publishing a topic with no play modes set (in the Player or LMS styles), the topic 
appears in the outline and the concept (if applicable) displays with no play modes.  

  
If you select multiple topics, the play mode settings you select apply to the entire selection, 

and overwrite any previous settings for that property. See Assign a Property to Multiple 
Documents for more information about changing play modes for multiple topics. 
 
Note: If all of the topics in a multiple selection are assigned the same play modes, the modes 
appear in the LMS Play Mode property cell. If the topics have different play modes assigned, 
the LMS Play Mode property cell appears blank. 
  

To change the LMS Play Mode property for a topic: 

1. Display the Properties toolpane. 
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2. In the Library or Outline Editor, select the topic(s) for which you want to change play 
modes. 

  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). 
  

3. In the Topic category, click  in the LMS Play Modes cell. 
  
A list of play modes appears. 
  

4. Select a checkbox to include a play mode or clear a checkbox to disable a play mode. 
  

5. Press ENTER or click outside the cell. 

18.6.3 Play Modes Property 

The play modes assigned to a topic determines which play modes are available when a user 

plays the topic in the Player. New topics automatically have all play modes enabled, but you 
can change the play mode for a topic after it is created. 
 
You can view the play modes assigned to a topic in the Play Mode property cell in the 
Properties toolpane. You change the play modes for one or more topics by selecting or 

deselecting play modes from the Play Mode drop-down list. A short description of each play 
mode appears at the bottom of the list. You can also set the default play modes for new topics 
in the Topic page in the Options dialog box. 
 
Warning! If you select multiple topics, the play mode settings you select apply to the entire 
selection, and overwrite any previous settings for that property. See Assign a Property to 

Multiple Documents for more information about changing play modes for multiple topics. 
 
Note: If all of the topics in a multiple selection are assigned the same play modes, the modes 
appear in the Play Mode property cell. If the topics have different play modes assigned, the 
Play Mode property cell appears blank. 

 

To change the play mode for a topic: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select the topic(s) for which you want to change play 

modes. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
  

3. In the Topic category, click  in the Play Modes cell. 

  
A list of play modes appears. 

  
4. Select a checkbox to include a play mode or clear a checkbox to disable a play mode. 

  
5. Press ENTER or click outside of the cell. 

18.6.4 Play Sound Property 

The sound play modes assigned to a topic determines which play modes with sound enabled 
are available when a user plays the topic in the Player. New topics automatically have sound in 
See It! and Try It! modes enabled, but you can change the play sound mode for a topic after it 

is created.  
 
You can view the sound play modes assigned to a topic in the Play Sound property cell in the 
Properties toolpane. You change the play modes for one or more topics by selecting or 
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deselecting play modes from the Play Sound drop-down list. A short description of each play 

mode appears at the bottom of the list. You can also set the default play modes for new topics 

in the Topic page in the Options dialog box. 
 

Warning! If you select multiple topics, the play mode settings you select apply to the entire 
selection, and overwrite any previous settings for that property. See Assign a Property to 
Multiple Documents for more information about changing play modes for multiple topics. 
 

Note: If all of the topics in a multiple selection are assigned the same play modes, the modes 

appear in the Play Sound property cell. If the topics have different play modes assigned, the 
Play Sound property cell appears blank. 
 

To change the play sound mode for a topic: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select the topic(s) where you want to change the 

sound play mode. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 

  

3. In the Topic category, click  in the Play Sound cell. 
  
A list of play modes appears. 
  

4. Select a checkbox to include a play mode or clear a checkbox to disable a play mode. 

  
5. Press ENTER or click outside of the cell. 

18.6.5 Show Bubbles Property 

The Show Bubbles property allows you to turn all bubbles on or off in a topic. You can prevent 
the bubble from appearing during playback in See It! and Try It! modes. This allows you to 
create the equivalent of a PowerPoint slide show, and then record sound to narrate it if 
desired. In this case, a bubble on each "slide" would not be appropriate. 
 

There are three options in the Show Bubbles property:  

 Always: All bubbles show for the topic. 

   

 Never: No bubbles show for the topic. 
   

 Use frame settings: Uses the settings on each frame to determine if the bubble 
appears. This is the default value. 

Using the Always and Never options do not update the settings on the individual frames; 

instead they override and ignore the frame settings. The Never option suppresses all frame 
bubbles and also suppresses all of the action areas for the topic during playback. Since the 
action areas are not present, you may want to make sure that the Enable Skipping in Try It! 
Mode option is selected when you publish the content so that the frames can be advanced by 
pressing ENTER in Try It! mode; if there are no action areas, there is no visual cue as what to 

do to advance the frame, and you may have difficulty advancing the frame.  
 

If sound has been recorded for the topic or the frame, all frames displayed during See It! 
mode playback advance automatically when the sound has finished playing. The only 
exception is if the Delay has been set to Infinite on the frame. In this case, the user is 
prompted to Press ENTER to Continue to the next frame. In Try It! mode, all frames are 
shown, but the frames must be advanced manually by either performing the correct action or 

pressing ENTER. No remediation is shown if you perform the incorrect action.  
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If there is no sound associated with the topic, turning off the bubble has the following affect 
on the various frame types in See It! and Try It! modes:  

 Introduction/End Frames 
See It! and Try It!: Skipped 

   

 Explanation frames 
See It! and Try It!: Skipped 
   

 Decision frames 
See It! and Try It!: Included; user must choose a path 
   

 Action frames 

See It! and Try It!: Bubble hidden; action area displayed unless it has been turned off 
   

 No-context frames 

See It! and Try It!: Bubble hidden; action area displayed unless it has been turned off 

   

 Frames with Infinite time delay 

See It!: Skipped 
Try It!: Bubble hidden; action area displayed unless it has been turned off 

Note: If there are alternative actions on a frame and you hide the bubble, the bubble is 
hidden for all actions. 
 

To show or hide bubbles for a topic: 

1. Display the Properties toolpane. 

   
2. In the Library or Outline Editor, select the topic(s) for which you want to change 

bubble settings. 

  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). 
   

3. In the Topic category, click  in the Show Bubbles cell. 
   

4. Select Always, Never, or Use frame settings. 

18.7 Document Output Properties 
The document output for a published System Process Document, Test Document, and 
Instructor Manual can contain fields that display information about a topic. The fields included 

in each output vary by document type. 
 
Some of the document field values in the published output are generated by the Developer 

from information taken from the topic. Developer-generated field data includes the name of 
the document, the roles assigned to the topic, and the date the document was generated. 
Fields that are not generated by the Developer are left blank for you to enter the appropriate 
topic information. 

 
For a System Process Document, user-defined fields may include the department, revision 
number, the name of the person who last changed the document, and the status of the 
document. For a Test Document, these fields include the purpose of the test being performed 
(note that the text in this field also appears in the Test Case format), the estimated time, and 
the required test setup. For an Instructor Manual, you can add instructor notes that relate to a 

topic. 
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You enter document output text directly in the Properties toolpane or in a text entry dialog box 

for those properties that appear in tables or allow multi-line entries, such as Instructor Notes. 

You can enter and edit document field values for a single topic or multiple topics. 
 
Warning! Be careful when changing a property for multiple documents that already contain 
values for the same property. The new values you enter for the property overwrite any 
existing values for all selected documents. 

 

 Multi-user Considerations 

 To change properties, you must check out the document. 

To add text to document output fields: 

1. Display the Properties toolpane. 

  

2. In the Library or Outline Editor, select the topics(s) to which you want to add 
document output text. 
  
You can select multiple documents using the standard Windows selection keys 

(CTRL+click and SHIFT+click). 
  
If you try to edit the properties for a topic open in the Topic Editor, a message appears 
prompting you to close the topic. 
  

3. In the Properties toolpane, expand the heading for the document output category (for 

example, System Process Document, Test Document, and so on). 
  

4. Type the text directly in the property cell or click  and enter the text in the text 
entry dialog box. 

18.7.1 Required Fields and Output Results for the System Process 
Document 

The System Process Document includes property tables for Required fields and Output results. 
These property tables are blank and do not contain prepopulated field names. They can be 
used to enter custom field names and comments. 
 
When creating entries for either the Required Fields or Output property, you can add more 

rows to the table, delete rows, and move rows up and down to rearrange the order. The text 
in the first cell of the table appears in the Properties toolpane when you select a document 
that contains text for either property. 
 
If a multiple topic selection contains existing table text, the table dialog box displays the 
common table rows that appear in ALL of the selected topics. The common table row can 
appear in different row positions in the selected topics as long as the text in the row is 

identical. If the selected topics contain no common table rows, the table appears blank. The 
changes made to a table for a multiple topic selection affect all of the selected topics, and 
overwrite any existing values. Therefore, the table rows that do not appear in a multiple 
selection because they are not common to the entire selection are deleted. 
 

To add a Required field or Output result: 

1. Display the Properties toolpane. 

  
2. In the Library or Outline Editor, select the topic to which you want to add property 

values. 
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3. In the System Process Document category, click  in the Required fields or 
Output cell. 

  

4. The Required Fields or Output dialog box opens with a blank row ready for text entry. 
  

5. Type the text in the appropriate cell. Press Tab to move from one cell to the next. A 
new row is automatically added. 
  

6. Click OK to save the changes. 
  
You can also click Cancel if you do not want to save your changes. 

Tip: All cells allow multi-line entries. You can create multiple lines in a cell by letting the text 

word-wrap or by pressing Shift+ENTER to insert new lines. Scroll arrows appear in multi-line 
cells for navigating through the text. 
 

To insert a new row: 

1. Select a row and click  to add a new row before the selected row. 
  

2. Type the text in the appropriate cell. 
  

3. Click OK to save the changes. 
  
You can also click Cancel if you do not want to save your changes. 

To delete a row: 

1. Select the row you want to delete and click . 
  

2. Click OK to save the changes. 

  
You can also click Cancel if you do not want to save your changes. 

To sequence a row: 

1. Select a row and click  or  to move the row to a new position in this list. 
  

2. Click OK to save the changes. 
  
You can also click Cancel if you do not want to save your changes. 

18.7.2 Add Document Revision Text 

The System Process Document, Test Document, and Job Aid publishing formats allow you to 

assign revision text that is appended to the topic filename (after the Document Type) when 

you publish these formats.  
 
Revision text is appended to the topic file name as follows: 
 

Syntax: Topic Name_Document Type_Revision.file extension  
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19 Preview Content 
You can preview a selected non-empty topic, web page, or outline using the Preview list on the 
Standard toolbar. The Preview list is only active when a single document is selected in the 
Outline Editor, Web Page Editor, or Library. 
 
When you preview a document in any format, the Developer uses the settings configured in 

the Documents and Player options (Tools menu). The Developer also uses the Category setting 
in the Preview option to determine which category of publishing styles should be used for 
previewing content. You should review these settings in Tools, Options before you preview a 
topic. 
  

Set the Default Preview 

You can choose any of the available publishing styles as the default preview using the Preview 

list. The Preview list box indicates the current preview default. Click  to preview the 

selected content using the current default or click the down arrow in the Preview list and select 

a different format. Your selection becomes the new default. 
  

Preview and Languages 

If you preview localized content in a Player format, the interface elements are in the default 
Developer language. For example, if you preview French content from an English Developer, 

the Actions menu and its options appear in English. If you preview localized content in a 
Document or Presentation output, the static text appears in the default Developer language. 
For example, if you preview French content from an English Developer in the Training Guide 
style, the Table of Contents text is still in English. 
 

 Multi-user Considerations 

 You can preview content while working online and offline; however, you should note 
that only the local content is used in the preview. For example, you cannot choose to 

preview server vs. local content; however, you do have this option when publishing 
content. While working offline, a message appears when you try to preview content 
that you do not have in your local cache. If this happens, you should go online to 

preview the document or use the Get command to download the topic and return to 
working offline. 
  
Also note that you cannot preview deleted, but restorable documents. You must first 
restore the document to preview it. 

Preview from the Library  

The preview behavior varies based on the type of content selected in the Library.   

 Topic: If a topic is selected with a Player style, the topic launches in the selected play 

mode. If a topic is selected with a print style, the topic launches in the software 

associated with that style. For example, Presentation style opens in Microsoft 
PowerPoint while the Training Guide style opens in Microsoft Word. 
  

 Web Page: You can preview web pages only in print styles with web page definitions. 

When you select a style, the Preview Topic document in the Styles folder is used to 
publish a preview of the current web page in the appropriate print output format. 
  

 Module or Section: If a module or section is selected, only the concept (if one exists) 
is published for preview and any children are omitted. 

Preview from the Outline Editor 
When you select a module or section for preview from the Outline Editor, the preview 
publishes the selection item only. In addition, any item that is in the direct path from the root 
item to the selected item is published. For example, your outline is called Main outline and has 
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a section called First Child section. Under First Child section are two subsections called First 
Grandchild section and Second Grandchild section. If you select the Second Grandchild 

section, the published output for preview would contain the Main outline, the First Child 
section and the Second Grandchild section but the First Grandchild section would be omitted 

because it is not in the direct path. 
  
No items at levels below the selected item are published. 
  
Preview from the Web Page Editor 
When you preview a web page from the Library or Outline Editor, the preview behavior is as 
described above. Additionally, you can preview a web page you are editing from within the 

Web Page Editor using either the Preview in Word or Preview in Browser icons on the Web 
Page Editor - Tools toolbar. 
  

To preview content: 

1. From the Library or Outline, select the recorded topic or web page that you want to 

preview. 
  

2. On the File menu, point to Preview and choose one of the formats listed. The Player 
modes are listed first followed by the document formats. 

  
You can also click the down arrow to the right of the Preview list on the Standard 

toolbar and choose one of the formats listed. Then click  to preview the topic. 

  
3. Review the topic and close it when you are finished. 

19.1 Preview Player Modes 
While the player mode previews gives you a good idea of how the topic appears in the Player, 
some differences do exist. For example, when you preview in Player mode you do not see the 
entire Player interface such as the outline and other controls for searching, filtering by role, 

and so on. However, this option allows you to test a recorded topic to verify that all the frames 
and bubble text are correct.  
 

Preview in See It! and Try It! modes use simulated environments, while Do It! mode uses a 
live environment where you interact with the live application. In See It! mode, you watch 
while the simulation progresses. In Try It! mode, you click in the location indicated or type the 
specified text to advance to the next frame. In Know It? mode, you are required to complete a 
particular task and are scored on how well you complete the task. 
 
Note: The appropriate Play Modes property must be set on the topic to preview it in a 

particular mode. 

19.1.1 Play See It! mode 

See It! mode enables you to learn by watching an animated demonstration of tasks being 
performed in a simulated environment. As tasks are performed, information is provided 

explaining the steps being performed. 
  
The topic begins playing automatically when you launch it, except on the iPad, which has a 

launch button. You can control the playback with the following buttons on the control bar: 
  

 Moves to the previous step. 
  

 Plays the simulation. Available while the playback is paused. 
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 Pauses the simulation. Available while the playback is running. 

  

 Moves to the next step. 

  

 Restarts playback from the beginning. 
  

 Allows you to move quickly forward or backward. 

  

 Controls the volume. Hovering the mouse pointer over this icon displays a volume 

control. Clicking it mutes the sound. 

  

 Indicates that the volume is muted. Clicking it unmutes the sound. 
  

 Shows current time in the playback and the total duration. 
  

 Opens the More menu that contains the Print It!, Preferences and Help 

options. A Share option also appears for a Player launched from a web server. 
  

You can press ENTER to advance to the next step manually, if desired. You can close the 
window at any time to exit the topic. 

  
Note: The volume controls do not appear on an iPad. 

19.1.2 Play Try It! mode 

Try It! mode enables you to learn a task by practicing in a simulated environment with step-
by-step instructions and guidance throughout the task. If you make a mistake, you are 
prompted to try again. Whenever text input is required, the text must be entered EXACTLY as 

suggested to advance to the next step. If the step does not automatically advance after you 
enter the requested input, you may need to modify your entry. If you feel that your entry is 
also an acceptable one, you can click the Typing Complete button to submit it. If your entry is 
also considered a correct response, the step advances. Otherwise, you are prompted to enter 
the requested text. Because you are using a simulated environment, your actions have no 
impact on actual system data or settings. 

 
Control the topic playback using the Actions link that appears in the bubble. The following are 

the possible Action links depending on administrator settings and if the play mode is started or 
paused. 

 Next Step: Advance to the next step. 
  

 Previous Step: Return to the previous step. 

  

 Restart Playback: Return to the first step in the topic and restart the task. 

  

 Show next Alternative action: Display other ways to perform the current step. This 
link only appears when other ways to perform the current step are defined in the 

authoring process. 
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 Display Concept: Display the conceptual information for the task. This link only 

appears if conceptual task information exists. 

  

 Print It!: Display the document provided for the topic by your content provider. This 
link only appears if a document was provided for Print It! mode. 

  

 Attachments: Display individual links that launch additional information related to the 
current screen. This link only appears if additional information exists for the current 
screen. 
  

 Preferences: Display the current preference settings for the Player. If this link does 
not appear, your administrator has preset all of the preferences and has prevented 
them from being changed. 
  

 Help: Display the Player help system. 
  

 Close Topic: Close the topic in current play mode and return to the topic launch 

point. 

19.1.3 Play Know It? mode 

Know It? mode enables you to test your knowledge of a task in a simulated environment. 
When you click the Know It? icon, you are presented with the score needed to pass, and you 
may also receive instructions for completing the Know It? or other pertinent information. You 
can then start to perform the required steps for completing the current task. Once you start 
the task, you may not see any further instructions for completing it, depending on how the 
task was structured by the content author. Since Know It? mode is a simulated evaluation, 

you must perform the steps of the topic exactly as they were recorded during content 
creation. If Try It! mode includes alternative methods of performing a step, either method is 
scored properly in Know It? mode. 
 
If you are unable to complete a step, you can click the Show Step link in the Know It? bubble. 
When you click this link, a window opens, informing you that you are graded as incorrect if the 

Player completes the step for you. You can then confirm the action by clicking Yes or cancel 

the action by clicking No. If you cancel the action, you can attempt to complete the step. If 
you confirm the action, the step is completed for you and you are marked incorrect for that 
particular step. Once the step is complete, you can then complete the remaining steps in the 
task. 
 
If you fail to complete a step, up to four levels of remediation display. Following are the four 
levels of remediation: 

 
Level 1: User told to try again 
The bubble informs you that your action was incorrect and to try again. 
 
Level 2: User provided with instructions 
The bubble informs you that the action was incorrect and provides instructions for completing 

the step. 

 
Level 3: User provided with instructions plus action area 
The bubble informs you that the action was incorrect and provides instructions for completing 
the step and a highlighted area indicating where the action should take place. 
 
Level 4: The Step is Completed for You 

The bubble informs you that the action was incorrect and states that the action is now being 
completed for you. 
 
Although you cannot control the playback in Know It? mode, you can use the Actions link that 
appears in the bubble to access the following links: 
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 Preferences: Display the current preference settings for the Player. If this link does 
not appear, your administrator has preset all of the preferences and has prevented 

them from being changed. 
  

 Help: Display the Player help system. 

  

 Close Topic: Close the topic in current play mode and return to the topic launch 
point. 

You can exit Know It? mode at any time by clicking the Close button in the Know It? bubble or 

by pressing ESC. When you attempt to exit Know It? mode, you are presented with two 
options that enable you to: 1) exit the Know It? without being scored; or 2) return to the 
Know It? and complete the task. 
 
When you complete the Know It? steps, you are presented with your score as a percentage of 
steps completed properly without assistance. Therefore, you are scored correct only when you 

complete a step right the first time. The passing score and a Result field also appear. The 

Result field displays “Pass” or “Fail” to indicate if you passed or failed the assessment. 

19.1.4 Play Do It! mode 

With Do It! mode, you are guided through a task while you perform it in the live application. 
This unique mode makes it possible for you to accomplish real work while you learn.  
 
When a topic is played in Do It! mode, the Do It! window opens on top of the target 
application. The top section of the window includes step-by-step instructions for completing 

the task. When you complete a step, you click the Next Step button to display instructions for 
the next step or to skip a step. The Previous Step icon appears after you perform the first step 
in the topic, allowing you to move back to a previous step. If a key combination was set in the 
Preferences window, you can use that combination to advance to the next step in Do It! mode. 
A key combination is not available to navigate back to the previous step, however. 
  
Note: Do It! mode does not stay on top in Internet Explorer 11 or later versions. The key 

combination to advance in Do It! mode does not work in Firefox or Internet 11 or later.  
 
The bottom section of the Do It! window displays a graphic that illustrates how the screen 
should appear in the live application for the step. On the graphic, a marquee surrounds the 
area in which you should perform the action in the live application. You can drag the graphic 
to reposition it within the Do It! window, if necessary. You can also drag the lower right corner 

of the Do It! window to resize it and display more of the graphic or you can use the Show/Hide 
Graphic icon to toggle the display of the graphic in the Do It! window. You can also move the 
Do It! window to another area of the screen by dragging the title bar to the desired location on 
the screen. 
  
Note: When using the Firefox browser, you can install the Firefox plug-in that always keeps 
the browser on top to keep the Do It! window on top of the application window.  

 
Control the topic playback using the Actions link that appears in the Do It! window. The 

following are the possible Action links depending on administrator settings and if the play 
mode is started or paused. 

 Show next Alternative action: Display other ways to perform the current step. This 
link only appears when other ways to perform the current step are defined in the 

authoring process. 
  

 Next Step: Advance to the next step. 
  

 Previous Step: Return to the previous step. 

  

 Restart Playback: Return to the first step in the topic and restart the task. 
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 Display Concept: Display the conceptual information for the task. This link only 

appears if conceptual task information exists. 

  

 Attachments: Display individual links that launch additional information related to the 
current screen. This link only appears if additional information exists for the current 

screen. 
  

 Play: Display links to launch the topic in See It!, Try It!, or Print It! mode (if Print It! 
mode is enabled). After viewing the step in See It! or Try It! mode, you can continue 
in that mode or press ESC to return to Do It! mode. 

  

 Preferences: Display the current preference settings for the Player. If this link does 
not appear, your administrator has preset all of the preferences and has prevented 
them from being changed. 

  

 Help: Display the Player help system. 
  

 Close Topic: Close the topic in current play mode and return to the topic launch 
point. 

19.2 Preview Documents 
You can preview topics with content, web pages, or Outline/Sections in any of the following 
document formats:  

 System Process 
     

 Job Aid 
   

 Training Guide 

   

 Instructor Manual 

   

 Test Document 
   

 Test Results 

   

 Presentation 

Each of these preview options appears below the Player modes on the Preview list. When you 
choose one of these options, the document appears in Microsoft Word, Adobe Acrobat, or an 
HTML Web Page, depending on the options you selected for the format you are previewing. If 

you choose Presentation format, the document appears in Microsoft PowerPoint. If more than 
one output format is chosen, the last item in the list (HTML Web Page) is used. 
  
Note: Not all of these publishing styles are available in the Web Page Editor, Outline Editor, or 
Library. An error is generated when a publishing style is selected from an editor or view that is 

not compatible.  

19.2.1 System Process Document 

This format is useful for creating documents that not only include the procedures and 
conceptual information for system processes, but also contain information relating to intended 
audience, roles and responsibilities, document status, versions, and dates. Each topic is 
published to a separate document which includes a concept page, with information about the 
document and task, and the procedures for completing the task. 
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19.2.2 Job Aid 

This format results in a quick reference guide, enabling users to view only the procedures for 

completing a task, without conceptual information. Each topic is published in a separate 
document which includes only the procedures for completing the task. 

19.2.3 Training Guide 

This format allows instructors to create guides quickly for Instructor-led training. The 
document includes a title page, copyright information, table of contents, conceptual 
information, and procedures for completing all tasks included in the published outline.  
 

Questions and/or assessments in the content are included in the Training Guide when the 

Include Questions and/or Include Assessments options are set. Note that answers to questions 
do not appear in the Training Guide but do appear in the Instructor Manual.  
 

In addition, if the content you publish contains glossary markups, then a glossary is included 
at the end of the document.  
 

Warning! Be aware that when you publish a Training Guide, your entire selection is published 
as one document. If you publish a large amount of content at one time, you may encounter 
memory problems with Microsoft Word. Consider publishing your content in smaller chunks 

and then merge the contents of each Microsoft Word file after publishing from the Developer. 

19.2.4 Instructor Manual 

This format allows instructors to publish the Training Guide with instructor notes. There are 
two types of instructor notes; topic notes and frame notes. 
 

Instructor topic notes are inserted in the document per topic, after the Concept, and before 
the Procedure. An Instructor Note heading appears in the output in the same style as 
Procedure text. The instructor notes are formatted like web page attachments (indented 1/2 

inch from the margin in a box with a rule and shading). This is designed to make the notes 
stand out from the other text. The outside margin is adjusted to 2.5 inches. This format allows 

instructors room to write their own notes.  
 

Instructor frame notes are inserted per frame and appear as italic text in the Action column in 
the Step/Action table, before the frame text. See Use the Frame Comments Toolpane in the 
Use the Topic Editor chapter for more information about entering frame instructor notes. 
 

Questions and/or assessments as well answers to the questions are included in the Instructor 

Manual when the Include Questions and/or Include Assessments options are set.  
 

Warning! Be aware that when you publish an Instructor Manual, the entire selection is 
published as one document. If you publish an entire outline, the document could be very 
large, and you might experience problems with Microsoft Word. 

19.2.5 Test Document 

This format allows you to create documents for testing software applications. Each topic is 

published to a separate document. The document includes the purpose of the test, test 

history, time to test, test setup, test procedure, and an additional validation area. The test 
procedure contains the steps for completing the task. 

19.2.6 Test Results 

This format allows you to create Word documents with steps and comments recorded during 
product testing using Record It!. Each topic is published to a separate document. The 
document includes the topic name, the status, the owner, the steps to complete the task, and 
any author notes. 

19.2.7 Presentation 

This format allows you to preview a topic in the Presentation format. The document appears in 

Microsoft PowerPoint format. 
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20 Publish Content 
The publishing process copies content out of the development environment, restructures it, 
and creates one of two types of outputs: content that you can deploy to end users through a 

Player or a series of document files. You can customize both the Player and the documents, as 
well as create your own custom publishing styles.  

20.1 Deployment Formats 
When you publish to any one of the Deployment formats, the Developer creates a package 
which can then be placed on a web server for users to view the content and play the topics. 
The package can also be distributed to end users to play offline on their local computers.  

20.1.1 Player and LMS 

This publishing format creates a package for the Player and an LMS. The Player interface 

includes a customizable header (showing a default image or custom image/html page), 
Outline/Search pane, and a content pane. Users can play topics in See It!, Try It!, Do It!, and 
Know It? modes. They can also select Print It! mode to view and print a document of the 
process covered in the topic. 
  
Note: The Player content can be viewed on an iPad. For more information, see the Content 

Deployment guide. 
 
You can launch the Player when the publishing process is complete. If you publish just the 
Player format, the option to launch the content automatically is selected and you can launch it 
directly from the Publishing Wizard. If you want to launch it later, navigate to the location 
where you published and open the Publishing content folder. Within that folder, open the 
PlayerPackage folder and double-click the Play.exe file to launch the Player. 

 
For complete information on using the Player, see the Content Player guide or online help. 
 

The Player and LMS options page on the Publishing Wizard contains 6 subcategories (In-
Application Support Configuration, Content, Player Preferences, Print It!, LMS Options, 
Knowledge Center Publishing). Subcategories are collapsible/expandable so you can view only 

the options of interest. The following publishing options are available for the Player: 

 Select your In-Application Support Configuration: This option allows you to 
select an In-Application Support Configuration that has been predefined by your 
administrator. 
   

 Skin: This option allows you to select a skin to be used to publish the Player. 

   

 Include Sound: This option allows you to publish with sound using 96 kbps AAC 

format. By default, sound is not set for publishing. 
  

Note: Sound is published using the .flv: High setting when using the Windows 2008 
SP2 operating system. 
   

 Convert screenshots to 256 colors: Reduces the number of colors used in the 

screenshots, which therefore reduces the size of the published topics and improves the 
playback speed. 
   

 Include HTML Web Site: You can choose to include the HTML Web Site format when 

you publish to the Player. The HTML format is contained in a folder called html within 
the PlayerPackage folder. If this folder is present, the HTML Web Site format launches 
if a user has a browser that is not supported by the Player. 
   

 Include detailed action steps in HTML Web Site: If you decide to include the 

HTML Web Site, you can include or omit the detailed action steps. Deselecting this 
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option omits the Step # links that launch the graphic and details for each step in the 

HTML Web Site. Note that deselecting this option also omits links to Alternative 

Actions, Alternative Paths, and Decision Frames, as those links appear on the details 
page. 
   

 Create zip file from published Player package: You can create a zip file of the 

Player package in the published content folder. The zip file is created at the same level 
as the PlayerPackage folder. This option is helpful if you want to import the content 
into an LMS. 
   

 Create Test It! mode Player: This option adds Test It! mode to the Player. Test It! 

mode is used to guide a tester through a test case and record the steps that are used 
to create a Test Document used in bug reporting. When Test It! mode is included, all 
topics are published, no matter what other modes are enabled . 
   

 Marquee color: Set the color for the action area (or highlight) that appears in See 

It!, Try It! and Do It! modes. 

   

 Play audio: You can set how audio plays on the Player. The All available sound option 

(default) plays any available sound files during playback. The Keyboard and mouse 
clicks options play only keyboard and mouse clicks sounds during playback in See It! 
mode. These sounds are 96kbps AAC files, delivered in the Audio folder of published 
content, that play automatically when keyboard and mouse clicks occur in See It! 
mode playback. The None option disables sound during playback. The user must have 

Flash 9.0 or greater installed to play sound in the Player. 
  
Note: Sound is published using the .flv: High setting when using the Windows 2008 
SP2 operating system. 
   

 See It! playback size: This option controls the default size of the See It! playback 

window. The initial screen size is set in the Player category on the Options dialog box. 
Select from one of the predefined screen sizes or type in the desired screen size. 

Default screen sizes include 800 x 600, 1024 x 768 (default), 1280 x 800, 1366 x 768, 
Half Screen (50% of user's screen resolution), Full Screen (as large as possible). 
   

 Default playback mode: This option controls the default mode launched when 
double clicking on a topic in the outline. 
   

 Applicable outline display: This option allows you to select how applicable content 

displays by default when the Player is launched with context sensitivity. If you select 
Applicable Outline, a filtered outline appears along with the Applicable option, to allow 
users to switch between the full outline and the filtered outline. If you select Applicable 
List, a flat list of applicable topics appears along with the Applicable option, to allow 

users to switch between the full list and the filtered list. If you select All, the full 
outline appears along with the Applicable option to allow users to switch between the 
full outline and the filtered outline. 
  

Note: When the Applicable Outline view contains both SmartMatch and ExactMatch 
results, the ranking of the results is lost. SmartMatch ranking only displays with the 
Applicable List view. 

  
It is important to understand the implications if you choose to change this publishing 
option. First, when you use the Outline List view for SmartMatch, there is no relevancy 
to the results. In other words, lower relevant results may appear above higher 
relevant results. Additionally, the load time for the table of contents in the Player may 
be negatively affected in SmartMatch because a higher number of results (maximum 

of 200) may be shown. 
   

 Show introduction text: This option controls whether the Introduction frame 
appears when a topic is played in the Player. Select this option to show the 

Introduction frame as the first frame during playback and deselect it to suppress the 
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frame. 
   

 Enable users to change their Player preferences: If you enable this option, the 

Player includes a Preferences link that enables any user to change the settings. If you 
disable this option, the Preferences link does not appear in the Player. 
   

 Enable skipping in Try It! mode: Select this option to enable the user to advance to 

the next step in Try It! mode by pressing Enter instead of performing the action in the 
bubble. 
   

 Enable Direct Do It!: When a user launches Player content in a context-sensitive 

manner from a target or web application and only one topic is returned, the topic is 
automatically launched in Do It! mode when this option is on. This option is off by 
default. Note that the topic must also be configured for Do It mode using the Play 
modes property. You can close Direct Do It and display the full TOC with the View 
Outline link on the Action menu. 

   

 Key combination for advancing in Do It! mode: Configure a key combination for 
advancing to the next step in Do It! mode. 
   

Note: The Key combination to advance in Do It! mode does not work in Firefox or 
Internet Explorer 11 or later. 
   

 Format for Print It! mode: If you enable Print It! mode for topics using the Play 
Modes property, you can use this option to determine which document style is 

included when you publish formats that support Print It! mode. Choose "none" if you 
do not to want publish Print It! mode (even when this mode has been enabled for 
topics). By default, Job Aid, System Process, and Test Document are the only options 
for Print It! mode. However, the Training Guide and Instructor Guide can appear as 
choices by editing the Style.xml file for the appropriate publishing project document. If 
you want a publishing style to appear as a choice, modify the PrintItStyle Setting of 

the Style.xml file to have a value of 1. 
  

If the Print It! document type includes web pages, such as the System Process 
Document, you may want to change the source of the web page formatting; that is, 
use Developer settings such as styles and inline settings or use Word template 
settings. The web page formatting default is set in the Options dialog box for the 
document type. 

   

 Text mode: Each document output uses the text from a specific mode. Use this 
option to specify the mode text. 
   

 Include screenshots: Screenshots are included in a document based on the settings 
for the topic in the Topic Editor. This option allows you to override those settings and 
choose to include one screenshot per topic, one screenshot for each frame, or no 
screenshots. 

   

 Web page format: Specify the formatting source for published web pages. Select 

Developer Settings to use the styles and direct formatting applied to the Developer 
web pages or Word Template settings to use the formatting specified in the print 

template. 
    

 Convert screenshots to 256 colors: Reduces the number of colors used in the 
screenshots, which therefore reduces the size of the published topics and improves the 
playback speed. 

   

 Include alternatives: Alternative Actions and Paths appear in document and 
Presentation outputs. Use this option to make the output simpler, with only one set of 
steps. 
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 Include images from packages: Images appear if they are attached to a frame or 

to the concept pane. 

   

 Include images in web pages: Images appear if they are attached to a frame or to 

the concept pane. 
   

 Include relative links: Relative links are included in all printed output with the 

exception of Test Case. Turn this option off to exclude relative links from printed 
output. 
   

 Output format: Published output is in HTML Web Page. 

  
If you choose Adobe PDF format, the document is published to Word first and then 
converted to PDF. If you choose HTML Web Page format, the document is published to 
Word and then saved as a web page using the Web Page, Filtered option in Word. This 
creates a single HTML file, but all of the graphics are separate, linked files. 
   

 Paper size: The paper size is set based on the Location setting in the Regional & 
Language options for your operating system locale. You can override this setting by 
choosing a different paper size. If you customize the print template to have a special 
paper size (for example, to print Job Aids on smaller cards), choose the option to use 

the print template setting; otherwise, it is overridden during publishing. 
   

 SCORM version: The content is compliant with the specifications for SCORM 1.2 and 
1.3 (SCORM 2004). This allows you to select the SCORM version for publication. 

Regardless of the SCORM version you publish, the published content includes the files 
necessary for the other version. You do not have to republish to use the content for 
the other version. 
   

 Prefix URL: Allows you to enter the URL prefix that points to the location where the 

package is placed on the LMS server. Each URL in the appropriate AICC and SCORM 
file is prefixed with this text. The path should include http://, followed by the name of 

the server and the folder name. 
   

 Publish content to Knowledge Center: Select this option to publish new content to 

or update existing content directly to the Knowledge Center server. When this option 
is selected, the current Knowledge Center server settings appear. If you are using this 
option for the first time, the settings are empty. Use the Server Settings button to 
specify the login credentials. 
   

 Server Settings: This button opens a login screen. You click Add to specify the URL 
for the Knowledge Center server, and then either enter a valid username and 
password, or use your Windows login account. You may also need to select a 
workgroup. The Knowledge Center server administrator should supply you with the 
server URL and the login information that you need. The settings are saved with the 

publishing settings for the publishing destination. 
  

Note: If the server settings are incorrect or missing and the publishing process is 
unable to connect with to the Knowledge Center server, the content is still published to 
a Player package and the error is logged in the Activity log. You can upload a title 
manually to the Knowledge Center server, if necessary. See the Manage Titles section 

in the User and Content Management Manual for more information. 
  
Note: If you receive a Proxy Authentication dialog box when you log in, enter your 
username and password for the proxy server. If you select the Save my password 
option, the username and password information is encrypted and saved to the 
kcLogin.xml file in the path for the application data, for example c:\Documents and 
Settings\<username>\Application Data\User Productivity Kit (Windows XP) or 

c:\Users\<username>\AppData\User Productivity Kit (Windows 7). If your password 
changes for the proxy server, you can open this file in a text editor and delete the tags 
<ProxyAuthentication> and </ProxyAuthentication> and all the text in between. This 
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causes the Proxy Authentication dialog box to open the next time you log in so that 
you can enter your new password. 

   

 Current Server Settings: The Authentication, Connection and Workgroup 

information currently being used to connect to the Knowledge Center server displays 
below the Server Settings button. 

20.1.2 HTML Web Site 

If you publish content for an HTML Web Site, the result is a tree of hyperlinked HTML files. 
Users can view the content via a browser. Exported content appears in a static version of Try 
It! mode suitable for posting to an Intranet or Internet site. With this method, users can view 
content without downloading a Web plug-in or installing content. 

 
Note: The HTML Web Site is designed to meet accessibility requirements. The site meets the 
following requirements: it can be read by a screen reader such as JAWS; it is not color 
dependent; the font size can be changed by the user; it is fully functional without using a 
mouse; and it does not depend on an audio track for functionality. 

 
Users access the content by launching the index.html page in the HTMLPages folder in the 

Publishing Content folder in the location where you published. This page displays a table of 
contents page showing the outline. Each topic has a link. If there is an attachment, a Concept 
link appears next to the topic name. 
 
After users click a topic link in the table of contents page, the topic overview page opens with 
a Steps list that displays the text for each frame in the primary path. If you published the 
outline with the detailed action steps included, a Step # link appears under each step. The 

Step # link launches an HTML page for the frame (the detailed action page) that allows users 
to navigate a static version of Try It! mode. The detailed action page for each frame contains a 
graphic showing the recorded target application screen with the action listed below the image. 
One action appears in each page, and a red border indicates the action area for the frame. To 
navigate through the topic, users can either click in the action area or click the navigation 
hyperlinks that appear below the graphic. Hyperlinked text appears below the frame to view 

any attachments as appropriate. The text used for the links is the tooltip as defined by the 
content author. Alternative Actions, Alternative Paths, and Decision frames are included in the 
detailed action pages as well. In addition, a Keyword Index link appears on the Table of 
Contents page. After clicking this link, users see each keyword followed by a list of the topics 
in which it appears. The topic names on this page are hyperlinked to the appropriate topic. 
When publishing an HTML Web Site, you can choose to omit the detailed step content, which 
excludes the Step # link from Steps list. 

  
Note: Alternative Actions, Alternative Paths, and Decision frames do not appear in the topic 
overview page; they only appear when a user navigates the detailed action steps.  
  
The graphics are in .png format and are linked to each HTML document as appropriate. 
  
The following areas do not appear in the HTML Web Site output: 

 Jump-in points 
  

 Roles 

  

 Questions 
  

 Assessments 

   

 Unrecorded topics 

The following publishing options are available for the HTML Web Site: 
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 Convert screenshots to 256 colors: Reduces the number of colors used in the 
screenshots, which therefore reduces the size of the published topics and improves the 

playback speed. 
  

 Include detailed action steps: Deselect this option to omit the Step # links that 

launch the graphic and details for each frame. Note that deselecting this option 
excludes the details page, which provides the links to Alternative Actions, Alternative 
Paths, and Decision frames. 

20.2 Document Formats 
Document formats allow you to publish content in various predefined documents that can 
appear in Microsoft Word (.docx), HTML, and Adobe Acrobat (.pdf) format. To publish 

document formats, Word 2007 or 2010 is required.    
 
Note: All document formats are designed to conform to the following Section 508c 
requirements for accessibility: the document can be read by a screen reader such as JAWS, 

except for headers, footers, and image alternative text; and the text background shading is 
formatted to meet legibility standards for the visually impaired. 
 

Document Type and Version 

When you publish any of the Document formats except Presentation, the document type is 
appended to the filename of each document published. The following lists the document types. 

 System Process: SPD 
  

 Job Aid: JOBAID 
  

 Training Guide: TRAIN 

  

 Instructor Manual: INSTMAN 
  

 Test Results: TESTRESULTS 
  

 Test Document: TEST 

  

 Test Case: TC 

If a revision number has been assigned to a topic, the revision number is also appended. This 
allows you to maintain multiple versions of different published output. 
 

The document name is separated from the document type and revision number by an 
underscore. For example, a topic file name for a System Process is TopicA, the resulting 
published document is TopicA_SPD.docx. If the assigned revision value is 2, the published 
document name is TopicA_SPD_2.docx. 
 
You can remove this document type extension if desired. See Remove the Document Type 

from the File Name in the Customize Publishing Styles section. 

20.2.1 Attachments in Document Formats 

Sections which have no topics but do have a concept attachment are included in the Training 
Guide and Instructor Manual styles. Attachments are also included in the document formats as 
follows:  

 Instructor Manual, Training Guide, System Process: web pages, graphics in 
packages, URLs as static text plus hyperlink, link icons 
  

 Test Case, Job Aid, Test Document: no attachments included 



  Publish Content 

   421 

Web pages and graphics in packages linked to frames and concepts appear as inline graphics 
in the document formats. All graphics retain any property settings made in the Web Page 

editor. Links to files other than graphics in packages are excluded. A link to an external file is 
shown as a hyperlink, with the static text "Please refer to:" before it. 

 
Note: Supported graphic types are .gif, .jpg, .pict, .png, .bmp, .rle, .dib, .emf, and .wmf. 
 
There are several special considerations for links in web pages. If a web page contains a link 
to an external file or URL, the tooltip text for the link appears in the document, with the 
address in parentheses ( ) after it. A link to an internal file or web page in the Library is not 
included. 

20.2.2 Options for Document Outputs 

The following lists show the available Document Output options and the applicable Document 
formats to which they apply. 

 Output format: Published output can be in Microsoft Word, Adobe Acrobat PDF 

format or HTML Web Page. 
  
If you choose Adobe PDF format, the document is published to Word first and then 

converted to PDF. If you choose HTML Web Page format, the document is published to 
Word and then saved as a web page using the Web Page, Filtered option in Word. This 
creates a single HTML file, but all of the graphics are separate, linked files. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results 
   

 Include screenshots: Screenshots are included in a document based on the settings 
for the topic in the Topic Editor. This option allows you to override those settings and 
choose to include one screenshot per topic, one screenshot for each frame, or no 
screenshots. 

  

Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results 
  

 Convert screenshots to 256 colors: Reduces the number of colors used in the 

screenshots, which therefore reduces the size of the published topics and improves the 
playback speed. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Presentation 
   

 Paper size: The paper size is set based on the Location setting in the Regional & 
Language options for your operating system locale. You can override this setting by 
choosing a different paper size. If you customize the print template to have a special 
paper size (for example, to print Job Aids on smaller cards), choose the option to use 

the print template setting; otherwise, it gets overridden during publishing. 

  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results 
   

 Text mode: Each document output uses the text from a specific mode. Use this 

option to specify the mode text to use. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Test Case, Presentation 
   

 Web page format: Specify the formatting source for published web pages. Select 
Developer Settings to use the styles and direct formatting applied to the Developer 
web pages or Word Template settings to use the formatting specified in the print 
template. 
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Applicable formats: System Process, Training Guide, Instructor Manual 

   

 Use encoded folder and file names: Publishes the content using the document 
GUID instead of actual module, section, and topic names. Encoding shortens path 

names and prevents the possibility of duplicate file name in the published output. This 
option makes it more difficult to identify the source based on the file name. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 
Document, Test Results, Test Case, Presentation 
   

 Include alternatives: Alternative Actions and Paths appear in document and 
Presentation outputs. Disable this option to make the output simpler, with only one set 
of steps. 
  
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 

Document, Test Results, Test Case, Presentation 

   

 Include images from packages: Images appear if they are attached to a frame or 
to the concept pane. 

  
Applicable formats: System Process, Training Guide, Instructor Manual 
   

 Include images in web pages: Images appear if they are attached to a frame or to 

the concept pane. 
  
Applicable formats: System Process, Training Guide, Instructor Manual 
   

 Include relative links: Disable this option to exclude relative links from printed 

output. 
   
Applicable formats: System Process, Job Aid, Training Guide, Instructor Manual, Test 

Document, Test Results, Presentation 
   

 Include assessments: Disabling this option excludes assessments. 

   
Applicable formats: Training Guide, Instructor Manual 
   

 Include questions: Questions in the content are included in a Training Guide or 

Instructor Manual. In addition, answers are included in the Instructor Manual. 
Disabling this option excludes questions. 
   
Applicable formats: Training Guide, Instructor Manual 

   

 Group actions by context ID: Each action appears in a separate row in the Test 
Procedure table. When you select this option, the actions with the same context ID are 
grouped together into one test step. 

   
Applicable formats: Test Case 
   

 Format: Use to select the Test Case output format. Options include Oracle Application 

Testing Suite (default), IBM Rational Quality Manager, HP Quality Center, or Other 
(which contains all available data in the report). Other can be used to get the data into 
a spreadsheet such as Excel. 
   
Applicable formats: Test Case 
   

 Include action areas: In the Player outputs, a marquee - or highlight - appears 

around the action area for each frame. You can choose to include this marquee. You 
can also change the color of the marquee using the icon next to the Color option. This 
setting does not affect the marquee color for the Player outputs. 
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Applicable formats: Presentation 

20.2.3 System Process Document 

This format is useful for creating documents that not only include the procedures and 
conceptual information for system processes, but also contain information relating to intended 
audience, roles and responsibilities, document status, versions, and dates. Each topic is 
published to a separate document which includes a concept page, with information about the 

document and task, and the procedures for completing the task. 

20.2.4 Job Aid 

This format results in a quick reference guide, enabling users to view only the procedures for 
completing a task, without conceptual information. Each topic is published in a separate 
document which includes only the procedures for completing the task. 

20.2.5 Training Guide 

This format allows instructors to create guides quickly for Instructor-led training. The 
document includes a title page, copyright information, table of contents, conceptual 
information, and procedures for completing all tasks included in the published outline.  

  
Questions and/or assessments in the content are included in the Training Guide when the 
Include Questions and/or Include Assessments options are set. Note that answers to questions 
do not appear in the Training Guide but do appear in the Instructor Manual.  
  
In addition, if the content you publish contains glossary markups, then a glossary is included 
at the end of the document.  

 
Warning! Be aware that when you publish a Training Guide, your entire selection is published 
as one document. If you publish a large amount of content at one time, you may encounter 
memory problems with Microsoft Word. Consider publishing your content in smaller chunks 
and then merge the contents of each Microsoft Word file after publishing from the Developer. 

20.2.6 Instructor Manual 

This format allows instructors to publish the Training Guide with instructor notes. There are 

two types of instructor notes; topic notes and frame notes. 
  
Instructor topic notes are inserted in the document per topic, after the Concept, and before 
the Procedure. An Instructor Note heading appears in the output in the same style as 
Procedure text. The instructor notes are formatted like web page attachments (indented 1/2 
inch from the margin in a box with a rule and shading). This is designed to make the notes 
stand out from the other text. The outside margin is adjusted to 2.5 inches. This format allows 

instructors room to write their own notes.  
  
Instructor frame notes are inserted per frame and appear as italic text in the Action column in 
the Step/Action table, before the frame text. See Use the Frame Comments Toolpane in the 
Use the Topic Editor chapter for more information about entering frame instructor notes. 

  
Questions and/or assessments as well answers to the questions are included in the Instructor 

Manual when the Include Questions and/or Include Assessments options are set.  
 
Warning! Be aware that when you publish an Instructor Manual, the entire selection is 
published as one document. If you publish an entire outline, the document could be very 
large, and you might experience problems with Microsoft Word. 

20.2.7 Test Document 

This format allows you to create documents for testing software applications. Each topic is 

published to a separate document. The document includes the purpose of the test, test 
history, time to test, test setup, test procedure, and an additional validation area. The test 
procedure contains the steps for completing the task. 



Publish Content 

 

 424 

20.2.8 Test Results 

This format allows you to create Word documents with steps and comments recorded during 

product testing using Record It!. Each topic is published to a separate document. The 
document includes the topic name, the status, the owner, the steps to complete the task, and 
any author notes. 

20.2.9 Test Case 

This format allows you to create files that can be imported into testing software applications 
such as Oracle Application Testing Suite (OATS), HP Quality Center, or IBM Rational Quality 
Manager. If you select multiple items in the outline, the published output is combined into a 

single file with each topic separated by a blank row. This file can then be imported into the 
testing software in a single operation. 
 
Only topics with content are included in the output; empty topics do not appear. In addition, 
modules and sections are not included in the output. The output is an Excel Workbook file. Be 
sure to choose the correct version to import into your testing suite application. 

  

Note: To export output from Microsoft Excel into HP Quality Center, you need the HP Quality 
Center Microsoft Add-in installed. See the HP Quality Center documentation for more 
information.  
 
Alternative paths and actions are not included in this format by default, but you can change 
the publishing option to include them. Decision frames are automatically included and cannot 
be suppressed. You can edit the output in Microsoft Excel to remove any unwanted Decision 

frame material. Explanation frames are not included. 
 
If context ID information is available for a frame, it is included at the end of the Action cell. 
The type of information differs or may not appear, depending on the target application of the 
topic. 
 

When you publish the Test Case format, you can choose from four formats: Oracle Application 
Testing Suite, HP Quality Center, IBM Rational Quality Manager, and Other. Each Test Case 

output format has a template that contains the appropriate columns. This template is called 
ColumnSpec.xml, and it can be customized to meet your output needs. The templates are 
stored in the Library under Publishing\Styles. There is a separate .xml file in each language 
folder. See Customize the Test Case Output in the Publish Content chapter for more 
information. 

20.2.10 Presentation 

If you publish content for a Presentation, a separate PowerPoint file is created for each topic, 
each of which can be launched from a main page. This page displays a table of contents page 
showing the outline. If a concept exists for a module, section, or topic, a Concept link appears 
next to the name. The names of the modules and sections are not links; however each topic 
has a link.  
 
When you click a topic link, a PowerPoint presentation launches. You can then view the 

PowerPoint slideshow to navigate the topic in a static version of Try It! mode. Each frame is a 
separate slide in the presentation. The slide contains a graphic showing the screenshot, with 
the bubble text next to it. A box on the screenshot indicates the action area or areas for the 
frame. To navigate through the topic, use standard PowerPoint methods. If a frame has 
attachments, the attachment icons appear above the bubble text. You can click the icons to 
access the attachments, if the presentation is being viewed online. If the presentation is 

printed, hyperlinked content is not included. Alternative Actions, Alternative Paths, and 
Decision frames are included as well, and links are provided to choose paths. 
 
The following areas do not appear in the Presentation output: 

 Jump-in points 
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 Roles 

  

 Keywords 
  

 Unrecorded topics 

You can launch the Presentation when the publishing process is complete. If you publish just 
the Presentation format, the option to launch the content automatically is selected and you 
can launch it directly from the Publishing Wizard. If you want to launch it later, navigate to the 
location where you published and open the Publishing content folder. Within that folder, open 
the Presentation folder. You can then choose to launch the index.html file or play.exe to 
display the table of contents, or open any of the PowerPoint files for a specific topic. 

20.3 Use the Publishing Wizard 
The Publishing Wizard steps you through the publishing process. There are several screens of 
options, each of which is described in more detail in the following sections.  

 
When the publishing process is finished, you have a number of options on the final screen: 

 Your content was published to the following location: This link opens a Windows 
Explorer browser window displaying the contents of the folder where the content was 

published.  
  

 Your local player can be viewed using: For Player packages, this link launches the 
Player window and displays the content. If you publish to document formats only, this 

option does not display. In addition, if an error occurs during publishing, this option 
becomes View activity log. The log helps you to determine what caused the publishing 
error. 
   

 Your player can be accessed in Knowledge Center at: For a Player published to 

the Knowledge Center, this link launches the Player in the default browser. 

    

 You can manage the Knowledge Center deployment using Manager: For a 
Player published to the Knowledge Center, this link launches the Knowledge Center 

Manager in your default browser. 
   

 This player can be used for In-Application Support if your application is 
configured to use the player: For Player packages, this link opens the IAS 

Information window with instructions for configuring applications to use this player for 
In-Application Support. 
  

 Finish: This button closes the Publishing Wizard without opening any windows or 
displaying content. 

20.3.1 Publishing Destination 

The first time you publish, the default destination location is set to the My Documents folder 

on your local computer. You can change this either by browsing to a new location or typing a 
path. If you change the location, it becomes the new default location for the next time you 
publish.  
 
It is essential to understand the importance of the destination location when you publish 
content.  
 

Publishing settings 

The first time you publish to a specific destination location, the Developer saves the publishing 
settings you used to that location. These settings include the output formats that were 
published and the options for each individual format. Each time you publish to that same 
location, the settings in the Publishing Wizard reflect the ones specified for that location. You 
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can change the options as necessary each time you publish to that location, and the changes 

are saved for the next time you publish. 

 

Incremental publishing 

Incremental publishing allows you to update published content quickly. When you publish 
content to a destination location, the Developer records the publishing data. When you publish 

the same content to the same location, the Developer accesses the publishing data and only 
the changes are published, including new content, changes to the existing content, and 
deletions. Because only the changes are published, the publishing process is much faster. 
Therefore, if you want to publish the changes to an outline, you publish the entire outline 
without having to select individual items in the outline structure. 
 

Replace Published Content 
If you choose to publish a different content selection to a destination in which you have 
already published, the Developer warns you and asks you whether you want to replace the old 
content. If you continue, the result depends on the type of format to which you are publishing: 

 Player formats: Old content is deleted for the same format. If you select fewer 
formats to publish, the published content for other formats is kept. 
  

 Document formats: Old content is kept. 

20.3.2 General Publishing Options 

There are options for selective publishing, publishing by role, and skipping advanced options. 
 

Selective Publishing 

You can choose to publish the entire outline or just the items you selected in the outline. If 

you are publishing to a format which has a table of contents, such as a Player package, a 
training guide, or an instructor manual, your results may differ depending on what you have 
selected and what you have open in the Outline Editor. Note the following: 

 The entire hierarchy of sections and modules above the selection is included, in a 
direct line up to the highest level of the outline. 
  

 The name of the highest level in the hierarchy, that is, the name that appears on the 

tab of the document window you are publishing from, appears in the title bar of the 
Player, and on the title page for the Training and Instructor Manuals. 

For example, you have Topic 1 and Topic 2, both of which are contained in Section A. Section 
A is in turn contained in Module 1. You open the Module 1 document in the Outline Editor, 
select Topic 1, and choose to publish only that topic to a Player package. After publishing, in 
the Player window, Module A appears in the title bar of the window, Section A appears as the 

highest level in the outline pane on the left, and Topic 1 appears below Section A. If, however, 
you open the Section A document in the Outline Editor and publish only Topic 1 to a Player 
Package, Section A appears in the title bar of the resulting Player Package and the outline 
pane contains only Topic 1. 

 

Publish by Role 

You can choose to publish by roles to filter content. If you have roles assigned to the content 
you are publishing, the Publish by roles option is available. When you select it, the Select 
Roles button becomes available, which opens the Select Roles dialog box. The list of roles 
includes only the roles available for the content you are publishing. You can select as many 
roles as desired. Only the items in the selected content that are associated with the specified 
roles are included in the published output. See Add Questions to Content and Develop 

Assessments in the Enhance Content with Questions and Assessments chapter for more 
information about filtering question and assessments by role. 
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Note: Roles are not available when content is played through a Learning Management 
System. The user never sees the Player interface, as the LMS creates its own outline for the 

content. You can still use roles to filter the content that gets published, however. 
 

 Multi-user Considerations 

 Publish by States 
In a multi-user environment, you also have the option to publish by states. This allows 
you to filter the content to publish only those items that are indicated as ready. When 

you select the Publish by states option, the Select States button becomes available. In 
the Select States dialog box, you can select the states to publish as desired. Only the 
items in the selected content that are associated with the specified states are 
published. If you specify roles as well as states, only items that meet all of the 
specified criteria are published. Items with no state assigned are always excluded. If 
you select the Publish by state option and then do not choose any states, you are 
notified that you have made an invalid selection. 

Skip Advanced Options 

There is an option to skip the Advanced Options page. When it is disabled, the Advanced 
Options page appears next in the Publishing Wizard. In addition, your choice for this setting 
becomes the default until you change it again. 

20.3.3 Advanced Options 

On the Advanced Publishing Options page, you can choose the category and language in which 
you want the published output to appear. The category defines which logos and formatting is 
used for player and print outputs. The language changes the language of the Player and help 
files as well as the default headings in the print outputs. It does not affect the bubble text or 

the template text. 
 
You can use the publishing settings from another location. This allows you to easily reuse 
settings from other published content to help ensure consistency. The settings are stored in 

the Publishing.Project.xml file, located at the root of the publishing destination folder. When 
you want to import settings, you do not need to select the .xml file; you only need to navigate 

to the publishing destination folder where it is located. 
 

 Multi-user Considerations 

 In a multi-user environment, when you are online, you also have the option to choose 

local or server content. Local content includes the locally edited copies of all selected 
documents that you have checked out and the server versions of those not checked 
out to you. Use this option for documents in progress for review. Server content 
includes only the checked in versions of the selected documents. Any local changes to 
checked out documents are ignored. Use this option for final versions of documents. 

20.3.4 Publishing Formats 

Deployment formats allow you to publish content for users to play topics in the various play 
modes. 
 
Document formats allow you to publish content in various predefined documents that can 

appear in a Microsoft Word (.docx) document, an Adobe Acrobat (.pdf) format, a Microsoft 
PowerPoint presentation, or a Microsoft Excel spreadsheet. 
 
The first time you publish, the options for the format or formats you choose to publish default 
to the ones that are set in the Options dialog box. You can change the options each time you 
publish, if desired. You can also reset them back to the settings on the Options page. 
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To publish content: 

1. On the File menu, choose  Publish. 

  
2. Enter the location to which you want to publish, or click Browse to navigate to the 

location or create a new folder. 
  

3. Click Next to display the Select Publishing Options page of the Publishing Wizard. 

  
4. Choose to publish the entire outline or the selected documents only. 

  
5. If desired, specify to publish by roles, and select the roles from the list. 

  
6. If desired, specify to publish by states, and select the states from the list. 

  
7. Click Next to display the Formats and Options page of the Publishing Wizard, or 

deselect Skip Advanced Options Page and click Next to display the Advanced 

Publishing Options page of the Publishing Wizard. 
  

8. Select the format(s) to which you want to publish. 
  

9. For each format that you choose to publish, select the desired options. 
  

10. Click Publish. When the publishing process finishes, the Publishing Complete page of 
the Publishing Wizard appears. 
  

11. Click the desired link or click Finish to close the Publishing Wizard. 

20.4 Customize Publishing Styles 
Publishing styles are Publishing Project documents that are stored in the 
System/Publishing/Styles folder in the Library. Within the Styles folder, each category has a 

folder. Each output format has its own Project document, such as Job Aid and Player. 
 
You can use categories to create customized styles to change the branding, that is, the logo, 
or format the appearance of the published output. You can also create categories with only 
certain published outputs, such as Job Aid and Training Guide, to limit the publishing outputs 
available to the content authors. 

 
Note: If you create custom publishing styles, you should document your customizations so 
you can easily re-apply them, if necessary, after a software upgrade. 

20.4.1 Create Publishing Styles 

You can create custom styles as needed for any publishing format. To customize the 
appearance of any style, you should first make a copy of the publishing project document that 
you want to modify. It is not recommended that you customize the standard styles that ship 
with the Developer.  

 
When you copy a publishing style in the Library, you can place the copy within the same folder 
in the Library, or you can create a new folder and subfolder structure to contain the 
customized styles. If you place the copy in the same folder, the style name is listed twice on 
the Formats and Options screen of the Publishing Wizard. See Rename a Publishing Style for 
information on how to change the name. If you create a new folder structure, the name of the 
folder appears as a category on the Advanced Publishing Options page of the Publishing 

Wizard. 
 
Follow these basic steps to create a custom style or styles: 

 Copy the style or styles that you want to customize. 
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 Customize the style documents as desired. The style documents are packages, and 
you can edit the files as you would files in any other package. 

20.4.2 Rename a Publishing Style 

If you make a copy of a publishing style in the same subfolder as the original, the style name 
is listed twice on the Formats and Options page in the Publishing Wizard and in the Preview 

list. In order to rename the publishing style, you must modify lines in the style.resources.xml 
file for the appropriate language in the Lang folder for the publishing style. 
 
In the package, open the lang folder and then the folder for the appropriate language. Open 
the style.resources.xml in any text editor, such as Notepad. Near the top of the file there 
should be a StyleName line that has the name of the style in between <Resource ID> and 

</Resource> codes. The StyleName controls the style name for the Publishing Wizard. For 
example, for the System Process style, the line looks like this: 
 

<Resource Id="StyleName">System Process</Resource>  

  

A separate PreviewTitle line controls the name of the style in the Preview list. This line appears 
a few lines below the StyleName and looks like this: 
  
<Resource Id="PreviewTitle">System Process</Resource> 

  

To change the name of the style that appears in the Publishing Wizard and the Preview list, 
edit the text between the codes for both lines. Save and close the file and save the style 
package. 

20.4.3 Remove the Document Type from the File Name 

Several of the document formats append the document type to the file name. For example, 
the System Process document appends _SPD, the Job Aid appends _JOBAID and so on. You 
can remove these document types from the file name in the publishing style, so that you do 
not have to remove it manually after publishing. There are two things to remember; first, 

changing the publishing style affects every document published using the style, and second, to 
change it in more than one style, you need to edit the publishing style separately for each 
document type. 
 
In order to remove the document type, you must modify a line in the styleconfig.xml file for 
the publishing style. 

 
Open the publishing style, and then open the styleconfig.xml in any text editor, such as 
Notepad. This file should have the document type extension in between 
<DocumentNamePrefix> and </DocumentNamePrefix> codes. For example, for the System 
Process style, the line looks like this: 
 

<DocumentNamePrefix>SPD</DocumentNamePrefix>  

 
Delete the text between the codes; in the example above, delete SPD. Save and close the file 
and save the style package. 

20.4.4 Remove the Action Area Overlay 

In the document formats, if the print area completely contains the action area, a border 
appears around the action area within the print area. You can remove this border by 

customizing the style for the document type. There are two things to remember; first, 
changing the publishing style affects every document published using the style, and second, to 
change it in more than one style, you need to edit the publishing style separately for each 
document type. 
 

To remove the border, you must modify a line in the styleconfig.xml file for the publishing 
style. Open the publishing style, and then open the styleconfig.xml in any text editor, such as 
Notepad. This file has <HotspotOverlay> and </HotspotOverlay> codes with the word true 

between them. Change the word to false. Save and close the file and save the style package. 
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20.5 Customize the Player 
There are numerous ways you can customize the Player interface and the topic playback, 
including changing the appearance of the play modes, changing the logo, changing the search, 
preferences and help icons, changing the "For Example" text in string inputs, and suppressing 
the scores in Know It? mode. Additionally, you can change style sheet elements such as 
dividers, background colors or text colors. 
  

You can customize the look of the Player interface by creating a customization package (also 
known as a skin) that contains all of your customized settings and images. During publishing, 
the elements (settings and images) in a skin override the corresponding elements in the 
Player publishing style. 
 
A typical skin contains four types of components:    

 A custom.css file with settings for changing various visual elements of the Player. 

   

 A config.xml file with settings for changing the functional behavior and appearance of 
Player elements. 
   

 A language specific resource.xml files with the names of user interface elements that 
you can customize in the \lang\<language> folder. 
   

 Images (logos, buttons) you have customized for your Player output. 

You should only customize these files in a skin. These customizations are preserved when you 
upgrade your software. Customizations made in the Player publishing style are overwritten 
during upgrade and are not supported. 
  
It is important to note that if you need to edit an .xml file, the file must be saved with UTF-8 
encoding. A common editor to use is Notepad, but any editor that can save files with UTF-8 

encoding is acceptable. 

  
Warning! If you have customizations created in Player styles prior to the implementation of 
skins, you must recreate them in a skin. Old customizations are overwritten during upgrade. 
Going forward, the new customizations made to a skin are preserved. 
  
Customization Overview 

There are 5 basic steps for customizing the Player. 

1. Create a skin or use the Player Customization package in the Library. 

  
2. Open the installed Player publishing style. Copy the syntax and settings for the 

elements you want to customize from the custom.css, config.xml, and resource.xml 
documents and place them in the corresponding documents in the skin. 
  

3. Copy the images you want to customize from the Customizable image folder in Player 

package to the root of the skin. 

  
4. Make the changes to the attributes and images in the skin. 

  
5. Optionally, select a skin in the Player category in the Options dialog box to use as a 

default for previewing and publishing content. See Player Defaults in the Set 
Developer Defaults section of the Get Started Using the Developer chapter for more 
information. 

Note: You can export a skin to transfer it to another Library. 
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Create a skin 
The Developer installs with an empty skin called Player Customization located in the 

System/Publishing/Styles folder. To create a customized Player, you can copy elements and 
graphics from the Player style into this skin or create a new skin. 
 

Note: You can rename the Player Customization file. 
 

The Player Customization package and all new skins contain a folder structure similar to the 
Player style with the following empty configuration files for creating your customizations:   

 an empty custom.css file 
  

 an empty config.xml file 

  

 a lang folder with separate subfolders, for each language, that each contain an empty 
resource.xml file 

You can create a single skin or multiple skins, with each one producing a different visual 

appearance. For example, if you need to create content for different organizations that have 
their own color schemes, preferred images, and logos, you can create multiple “skins” and 
choose the desired skin at publishing time. 
 

In addition to an empty Player Customization package, the Styles folder also contains a skin 
named Gray, which is a predefined skin that contains the same folder structure plus some 
customizations. You can publish using the Gray skin as installed or modify it by adding 

additional customized elements.   
 

You can save a skin to any folder. Skins saved to the Styles folder automatically appear in the 
Skin list in the Publishing Wizard when you publish a Player, but you can browse to other 
locations when publishing. Once you select a skin from another folder for previewing or 
publishing, it remains on the Skin list, regardless of its folder location. 
 

To create a skin: 

1. On the File menu, point to  New and choose  Skin. 

  

2. On the File menu, choose  Save. 

  
3. Type a name for the document. 

  
4. Click Save. 

Copy Elements to the skin 

When you copy customizable elements from the Player style, make sure you copy the entire 
piece of element code. In this example, you must copy the element name (.header) and 
everything between the { and } brackets. Additionally, you can copy the comments between 

/* and */. This comment helps you identify the element in the code. 
 

/* TOC header */ 
.header 
{ 

background-color: #FFFFFF; 
height: 60px; 
position: relative; 
} 
 

When copying a configsection from the config.xml into the config.xml of the skin, make sure 
you copy the <configsectionname="section_name">, the </configsection> and everything in 

between the two tags. Anything copied must be pasted within the <config> and </config> 
tags in the config.xml of the skin. 
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<config> 

<!--<configsection name="section_name"> 

  <item name="setting_name">setting_value</item> 
</configsection>--> 
</config> 
   
Note: Question and Assessment customizations are not supported in a skin. These 

customizations are made in the question and assessment templates and are overwritten on 
upgrade. You should document these customizations so you can easily re-apply them after 
software upgrade. 
  
Note: You can customize the size of frame link attachments by editing these elements in the 
config.xml file; InfoWidth: 400, InfoHeight: 300, InfoWidth2: 640, InfoHeight2: 480. 

20.5.1 Customize the Player Graphics 

You can customize many of the graphics in the Player interface to fit your corporate look. For 

example, if you want to change the background color of the header, find the 

.headerTransparent element and change the color value.  
  

 
  

Gateway page 

  

 
 
The logo can be customized in two locations in the Player. The first location is on the Gateway 
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page when you start up the Player. This graphic is called large_logo.gif. The second location is 
in the top left corner of the Player interface. This graphic is called small_logo.gif. 

 
Note: You can also use the Customize Logo tool in the Developer to replace the logo. If you 

use this tool, the logo should be no larger than 230x44 pixels. 
 
Other Player graphics, such as the banner, search, preferences, help, and log out icons can 
also be customized. 
 
The following images can be copied from the Customizable images folder in the Player style. 
The elements can be copied from the custom.css in the Player style unless otherwise noted.  

 1 Logo (small_logo.gif): This image controls the logo in the top left corner of the 
Player. 
  

 2 Gradient (banner_image.png): This image controls the color gradient that fills the 

area containing the small_logo. The image is 425 x 1 pixels. 

  
Note: The default banner_image.png automatically resizes to the height of the logo 
(small_logo.gif). If banner_image.png is changed to a fixed size, (recommended size 
is: 425 x 54 pixels), and you change the height of the logo, you must resize the 
banner image 10 pixels higher than the new height of the logo. 

  
.header: Use to specify the color of the gradient fill. This changes the color of the right 
column of the color table that controls the gradient color. The left column of the table 
is #FFFFFF (white) and cannot be edited. Changing the color only applies if the 
banner_image.png is 1 pixel in height. 
  
.headerTransparent: This controls the background color of the header. 

   

 3 Divider lines (.background): Use .background to change the border and background 
color of the vertical divider bar between the Outline and Concept panes and the 

horizontal border around the Player toolbar. 

   

 4 Blue Shading (.headerDivbar): Use this to change the height and/or color the blue 
shading in the Player toolbar. 
   

 5 Color of outline background (.thover): Use this to customize the background color of 
the Outline pane. 
   

 6 Color of selected outline item (.tselected): Use this to customize the background 

color of selected items in the Outline pane. 
   

 7 Preferences Icon (prefs_button.gif): Use this to customize the Preferences icon 

(default is 16x16 pixels). 
   

 8 Help Icon (help_button.gif): Use this to customize the Help icon (default is 16x16 

pixels). 
   

 9 Share Icon (share_link.gif): Use this to customize the Link icon (default is 16x16 
pixels). 

   

 10 Share link font & color (.share_link:link): Use this to customize the font and color 
of the Share link on the Player toolbar. 
   

 11 Open Module/Section (module_o.gif): Use this to customize the Open 
Module/Section icon (default is 16x16 pixels). If an icon that is not 16 x16 pixels, the 
top left 16x16 pixels are used. 
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 12 Closed Module/Section (module_c.gif): Use this to customize the Closed 

Module/Section icon (default is 16x16 pixels). 

   

 13 Topic Icon (topic.gif): Use this to customize the Topic icon (default is 16x16 

pixels). 
   

 G large_logo.gif: Use this to customize the logo on the Gateway page. 

  

 logout_button.gif: 16x16 pixels (not shown). This icon appears only when the content 
being viewed is tracked via the Knowledge Center. 

20.5.2 Customize the Player Search Pane 

You can customize the look of the Player search pane. For example, if you want to change the 
background color of the search area, find the .tocSearchColor element and change the color 
value. 

  

 
  
The following images can be copied from the Customizable images folder in the Player style. 
The elements can be copied from the custom.css in the Player style unless otherwise noted. 

 1 Search icon (searchbtn.gif): Use this to customize the Search icon (default is 23x21 
pixels). 
  

 2 Clear/Show Outline icon (clear.gif): Use this to customize the Clear/Show Outline 

icon (default is 23x21 pixels). 
  

 3 View outline (.treeControlNode): Use this to customize the font and color of the View 

filtered outline link in the Outline pane. 
  

 4 Search results background (.TocFrameText): Use this to change the background 

color of the search results area of the Outline pane. 
   

 5 Search background (.TocSearchColor): Use this to change the background color of 
the search field on the Outline pane. 

20.5.3 Customize Player Mode Buttons 

You can customize the play mode buttons to fit your corporate look. For example, if you want 
to change the color of the mode buttons upon mouse over, find the .button:hover element and 

change the color value. 
 

The R_mode_* elements are located in the resource.xml file in the \lang folder for each 
language. Copy the elements you want to customize from the resource.xml in the Player style 
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into the corresponding resource.xml in the skin. The images can be copied from the 
Customizable images folder in the Player style. 

  

 

 1 Mode button color (.button, .lastbutton, .button:hover): Use .button and .last button 
to customize the color of the buttons when the mouse is not hovering over the button. 
Use .button:hover to customize the color of the buttons when the mouse is hovering 
over the button. 

  

 2 Mode button background (tdbackground.png): Use this to change the background 
color of the mode buttons. 
  

 3 Mode button divider line (.dividerColor): Use this to customize the color of the 
divider lines between the buttons. Default value is background color #3E5782. 
  

 4 See It! mode button (seeit.png): Use this to customize the See It! mode button. 

   

 5 See It! mode text (R_mode_seeit): Use this to customize the text on the See It! 

mode button. 
   

 6 Try It! mode button (tryit.png): Use this to customize the Try It! mode button. 
   

 7 Try It! mode text (R_mode_tryit): Use this to customize the text on the Try It! mode 
button. 
   

 8 Know It? mode button (knowit.png): Use this to customize the Know It! mode 

button. 
   

 9 Know It? mode text (R_mode_knowit): Use this to customize the text on the Know 

It? mode button. 

   

 10 Do It! mode button (doit.png): Use this to customize the Do It! mode button. 

   

 11 Do It! mode text (R_mode_doit): Use this to customize the text on the Do It! mode 
button. 
   

 12 Test It! mode button (testit.png): Use this to customize the Test It! mode button. 
   

 13 Test It! mode text (R_mode_testit): Use this to customize the text on the Try It! 

mode button. 
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 14 Print It! mode button (printitdoc.png, printithtml.png, printitpdf.png): Use this to 

customize the Print It! mode button. 

   

 15 Print It! mode text (R_mode_printit): Use this to customize the text on the Try It! 

mode button. 
   

 16 Jump-in point arrow (jumpinarrow.png: Use this to customize the jump-in arrow 
icon on each of the modes. 

20.5.4 Customize See It! mode 

You can customize the See It! mode to fit your corporate look.  For example, if you want to 

change the click graphic, find the bullseye.png and replace it with your graphic of the same 
name. 
 
Note: Changes to options 2 and 3 also affects Try It! and Know It? modes. 

   

 
  
The following images can be copied from the Customizable images folder in the Player style. 
The elements can be copied from the custom.css in the Player style unless otherwise noted. 

 1 Click graphic (bullseye.png): Use this to customize the graphic that displays when 
See It! mode clicks an action area. 
   

 2 Bubble border: Use these to customize the blue border around the bubble. The areas 
are top left curve ( b_01.png), top ( b_02.png), top right curve of bubble with x close 
button (b_03.png, b_03disab.png, b_03over.png), left side (b_04.pnb, right side 
(b_06.png, bottom left curve (b_07.png), bottom (b_08.png) and bottom right curve 

(b_09.pgn). Customizing these graphics affects the bubble for See It!, Try It! and 
Know It? modes. 
   

 3 Name of the play mode in the bubble header (.CurvedBoxText): Use this to 

customize the See It!, Try It! and Know It? header text and font. 
   

 4  Previous icon (previousstep.png): Use this to customize the Previous button. 
   

 5 Play/Pause icon (play.png/pause.png): Use this to customize the Pause button. 
   

 6 Next icon (nextstep.png): Use this to customize the Next button. 
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 7 Restart icon (restartplayback.png): Use this to customize the Restart button. 

   

 8 Navigation bar color (.PlayerCombination): Use this to customize the color of the 
navigation bar. 
   

 9 Navigation border color (.PlayerCombination): Use this to customize the border color 
around the navigation bar. 
   

 10 Volume (volume_butt.png/volumemuted_butt.png): Use this to customize the 

Volume/Mute icon. 
   

 11 Show Help (more_butt.png): Use this to customize the Show Help icon. Show Help 

menu has the Preferences (prefs_button2.gif), Share and Help (help_button2.gif) 
icons. 
   

 12 Dimensions of SeeIt! window (.windowedsize): Use this to customize the size of 
the SeeIt! window. 

Note: You can also copy css elements from other css files in the Player, paste them into the 

custom.css file in the skin and customize them. For example, you can customize the Actions 
link text (.CurvedBoxNav) and Actions menu (.AMenu) in the bubble header for Try It! and 
Know It? modes. 

20.5.4.1 Hide the Click Graphic in See It! mode 

In See It! mode, when the animation plays for an action step, there is a graphic that looks like 

an "impact" symbol which appears when the mouse simulates the clicking action. You can 
prevent the user from seeing this graphic by editing the config.xml file in the root of the 
published Player package. You can also configure this setting in the Player Publishing style 
using the config.xml file. This can be useful if you are creating the equivalent of a PowerPoint 
slide show and have hidden the bubbles for the topic. (See Show Bubbles Property for more 
information.) In this case, it would be desirable for the click graphic to be hidden.  

 

To suppress this graphic, edit the HideClickMark variable and change the value to true. 

20.5.5 Customize Do It! mode 

You can customize DoIt! mode to fit your corporate look. For example, if you want to change 
the color of the Do It! menu, find the DoItActionsColor element and change the color value. 
  

Note: These elements are located in the config.xml file at the root of the Player style. Copy 
the elements you want to customize from config.xml of the Player style into the config.xml in 
the skin. 
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 1 Do It! font and color (DoItFont): Use this to customize the font and color of the Do 
It! text font and color. 

  
<item name="DoItFont" comment="Do it font and color">{'font-size': '10pt', 'color': 
'white', 'font-weight': 'bold', 'font-family': 'Arial, Helvetica, sans-serif'}</item> 
   

 2 Do It! header color (DoItHeaderColor): Use this to customize the color of the Do It! 

header. 
  
<item name="DoItHeaderColor" comment="Do it header color">{ 'background-color': 
'#003366' }</item> 
   

 3 Action dialog background color (DoItActionsColor): Use this to customize the 

background color of the action menu. 
  
<item name="DoItActionsColor" comment="Actions dialog background color">{ 
'background-color': '#f7f7e7' }</item> 

  

 4 Action dialog border color (DoItActionsBorderColor): Use this to customize the color 
around the border of the Action menu. 
  

<item name="DoItActionsBorderColor" comment="Actions dialog border color">{ 
'border-color': 'gray' }</item> 

20.5.6 Customize Know It? mode 

You can customize KnowIt? mode to fit your corporate look. For example, if you want to 
change the color of the text in the Know It? certificate heading, .KnowItPOMain element and 
change the color value. 
  
Note: Customizations to the KnowIt? certificate are made in the certificate.css located at the 
root of the Player style. Graphics are located in the Customizable images folder. Changes to 
certificate.css are not supported in a skin and are overwritten during upgrade. 
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 1 Know It Certificate heading text, font & color (.KnowItPOMain): Use this to 
customize the font size, font family and color of the Know It? header. 
   

 2 Logo (small_logo.gif): Use this to customize the logo. 

   

 3 Results table text (R_certificate_*): Use these to change the standard text that 
displays in the table. This is located in the resource.xml file, in the lang folder for each 

language, of the Player style. 
   

 4 Results table border color (003366lin.gif & giftrk1.gif): Use this to customize the 
horizontal and vertical lines of the table. 

   

 5 Color of scores and date. (.KnowItPORes): Use this to customize the scores and 
dates that display on the table. You can customize the font-weight, font size, color and 
font family. 

20.5.6.1 Suppress Scores in Know It? mode 

When a user plays a topic in Know It? mode, the Introduction frame displays the score that is 
needed to pass the topic. At the end of a Know It? topic, a frame appears displaying the user's 
final score and if the user passed the topic assessment. 
 
You can prevent the user from seeing either the score needed at the beginning of the topic or 
the final score frame at the end of the topic by editing the config.xml file at the root of the 

skin. To suppress the score needed information at the beginning of the topic and the final 

score frame at the end of the topic, edit the value of the ShowScoreNeeded variable to 

“false”. 

 
Another option is to display the score needed at the beginning of the topic, but suppress the 

scoring screen that appears at the end of the topic. To use this option, leave the 

ShowScoreNeeded variable as “true” and change the value of the trackFeedBack 

variable to “false”. 

20.5.7 Customize the Preferences Dialog Box 

You can customize the Preferences dialog box to fit your corporate look. For example, if you 
want to change the color of the outer border around the dialog box, find the #dig2 element 
and change the border color value. The elements are located in the custom.css file. 
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 1 Preferences dialog box outer border (#dig2): Use this to customize the color of the 
outer border around the Preferences dialog box. 
  

 2 Preferences dialog box inner border (#dlg2): Use this to customize the color of the 

inner border around the Preferences dialog box. 
   

 3 Close Preference dialog box icon (close_qualifier.png): Use this to customize the 
icon used to close the Preferences dialog box. 

20.5.8 Customize the Share Link Dialog Box 

You can customize the Share Link dialog box to fit your corporate look. For example, if you 
want to change the color of the outer border around the dialog box, find the .PlayerBorder 
element and change the border color value.  
  

 

 1 Share Link dialog box outer border (.PlayerBorder): Use this to customize the color 
of the thinner outer border around the Share Link dialog box. 
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 2 Share Link dialog box inner border (.PlayerShading): Use this to customize the 

background color the thicker inner border around the Share Link dialog box. 

   

 3 Close Share Link dialog box icon (close_qualifier.png): Use this to customize the 
icon used to close the Share dialog box. 

20.5.8.1 Disable Share link 

The Share link allows users to share the location of a topic or other asset in the outline with 

other users. The user can click the  Share link in the Player interface and copy and paste 
the URL into an e-mail or other messaging software to send to others. By checking View 

Outline, you can share the specific content (not just the location in the outline) with other 
users. 
  
The EnableShare parameter in the PlayerConfig section in the config.xml is set to True by 
default.  
  

<configsection name="PlayerConfig"> 

<item name="EnableShare">true</item> 
</configsection>--> 
  
To prevent the Share link from appearing, copy the EnableShare parameter from config.xml in 
the Player style and paste it to the PlayerConfig section in the config.xml in the skin. In the 
skin, you can then change the EnableShare parameter value from True to False. You should 

not customize config.xml in the Player style.  
  
Note: If the config.xml file in the skin does not contain begin and end tags for the 
PlayerConfig section, you must also include those tags. 
  
Note: You can disable the Share link in published output by changing the EnableShare 
parameter in the config.js file to False. Config.js is created from config.xml during the 

publishing process. 

20.5.9 Customize the My Roles Dialog Box 

You can customize the Roles dialog box to fit your corporate look. For example, if you want to 
change the color of the outer border around the dialog box, find the #dig2 element and 
change the border color value.  

  

 

 1 Roles dialog box outer border (#dig2): Use this to customize the color of the thinner 

outer border around the Roles dialog box. 
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 2 Roles dialog box inner border (#dig2): Use this to customize the background color 

the thicker inner border around the Roles dialog box. 

   

 3 Close Roles dialog box icon ( close_qualifier.png): Use this to customize the icon 

used to close the Roles dialog box. 

20.5.10 Customize Jump-in Points 

You can customize the text attributes and background colors of the Jump in dialog box to fit 

your corporate look. For example, if you want to change the color of the hyperlink, find the 
.textWindows element change the color value. 

 

 1 Dialog background (.textWindows): Use the background color to change the 

background color of the dialog box. 
  

 2 Jump in border color (div#content0): Use the border value to customize the color of 

the border around dialog box. 
  

 3 Color of hyperlinks (.textWindows): Use the color to change the color of the link. 

20.5.11 Customized See Also Links 

You can customize the attributes and background colors of the See Also links list to fit your 

corporate look.  For example, if you want to change the See Also border color, find the #dig2 
element and change the border color value. 
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 1 See Also arrow (.seealsoarrow.png): Use this to customize the arrow graphic on the 
See Also list. 
  

 2 See Also border color (#dig2): Use this to customize the border color around the 

See Also list. 
  

 3 See Also background color (#content0): Use this to customize the background color 

of the See Also list. 
  

 4 See Also link color (TocFrameTextLink:link): Use this to customize the color of the 
See Also link. 

20.5.12 Customize the Navigation Buttons 

You can customize the text attributes and background colors of the navigation controls to fit 
your corporate look. For example, if you want to change the graphic of the Previous arrow, 

find previoustraversalarrow.png and change it. 
  

 

 1 Previous (previoustraversalarrow.pgn): Use this to customize the graphic (default is 
16 x 16 pixels) for navigating to the previous document in the outline. There are 4 
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graphics showing the disabled, enabled, hover and selected states. 

  

 2 Next (nexttraversalarrow.png): Use this to customize the graphic (default is 16 x 16 
pixels) for navigating the next document in the outline. There are 4 graphics showing 
the disabled, enabled, hover and selected states. 

20.5.13 Disable Player Navigation Bookmarks and Preference Settings 

By default, published Player content saves outline bookmarks and preference settings in 
cookies that are saved on a user's computer. With outline bookmarks, a user can exit and 

restart the Player, and it automatically displays the last document the user was viewing. 
Settings changes on the Preferences dialog box are also saved by default. 
  
You can disable this functionality in the config.js file in the published Player package by editing 
the config.js file in the root of the published Player package. You can also configure this 

setting in the Player Publishing style using the config.xml file. Edit the EnableCookies 

variable and change the value to false. 

20.5.14 Customize Expanded Table of Contents 

When a Player package content is started in the Player for the first time, the Table of Contents 
is collapsed so only the first level of documents (those directly linked to the root document) 
appear. You can configure the Player to open with the Table of Contents expanded and control 
the number of documents that automatically display. 
  

The DefaultExpandLevel element controls the number of levels that appear when the Player 

opens. The standard value is 1, but you may specify any number of levels; however, 
increasing the number of levels may impact performance exponentially. If you have a large 
outline, you can use the AutoExpandLimit element to set how many documents should 

automatically appear and the SearchResultLimit element to set the number of documents 

returned in a search.  
  
To set these elements, copy the TreeConfig section from the config.xml file and make the 

modifications in a skin. You can also modify a published Player by changing the settings for 
the same elements in the config.js file in the root of the Player Package. 
  
var TreeConfig = { 

AutoExpandLimit: 100, 

SearchResultLimit: 200, 

DefaultExpandLevel: 1  

}; 

  
Warning! Setting this configuration for large outlines could affect performance of the Player. 

20.5.15 Display Frame ID in Topic Playback 

A unique frame ID for a topic appears on the Topic Editor toolbar as you navigate to each 
frame. This ID can be used as a reference point as you develop content and distribute it to 

subject matter experts for review. The expert can reference the frame ID in the Player so you 
can quickly find the corresponding frame in the Topic Editor using the Go To command on the 

Edit menu. You can enable the display of the frame ID for playback by configuring the 

ShowFrameID variable, found in the PlayerConfig section, to one of the following: 

  
On - The frame ID is always visible. 
 

Off - The frame ID is not visible. This is the default setting. 
 
<Key> - The frame ID is enabled by a key combination. Authored keys always take 
precedence over the frame ID key. Possible key combinations are limited to Shift + function 
keys, Shift+F1 through Shift+F12. Notation in the file should be "ShiftF1", "ShiftF2", and so 
on. 
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As with all publishing elements and variables, changes to the ShowFrameID variable should be 
make in a skin. It may be useful to create a skin designed to publish content for review. To 

enable the frame ID for all packages you publish with this skin, copy the  ShowFrameID 

variable (and the beginning and ending PlayerConfig section tags) from the config.xml file in 
the Player publishing style to the config.xml file in the skin and change the variable setting. 
  
Note: While you can directly edit the variable in the Player publishing style, the setting is not 
preserved during application upgrades. Changes made directly to the Player publishing style 
are not supported. 

  
You can also enable the frame ID display in a published Player package by editing the same 
variable in the config.js file at the root of the package. 

20.5.16 Customize Question Elements 

You can customize the way questions look in the Player and the Developer by editing the 
resources.xml and question.css files in the question template. This enables you to customize 
the question default text to match a localized Player or Developer interface. These files are in 

the Standard template in the Question Templates folder under the System folder. 
 
The resources.xml file is the language resource file that contains question template specific 
language elements such as button text, and Question and Response heading text. The 
question.css file is the style sheet that controls icons and header elements such as background 
color. 
  

Warning! All customizations to questions must be done in the Standard template in the 
Question Template folder. These customizations are overwritten when you upgrade your 
software. It is recommended that you create a copy of the Standard template in the Question 
Templates folder. This provides a backup so you can restore the original if necessary. When 
you are done customizing the Standard template, copy and rename the copy. The Standard 
template is overwritten when you upgrade your software but the copy is preserved so you can 
reapply your customizations. 

  

.  
 

Customize the resources.xml file 

You can customize the text for any of the HTML_strings in the resources.xml file. These 

changes can appear in both the Developer and the published output depending on the string 
you modify and the format you publish. 
 
You can customize the standard question text, such as the OK button or the Question heading 
text, if your company uses different terminology in questions. Open the resources.xml file in 
any text editor and edit the appropriate lines. For example, if you want to change the OK 
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button text to YES, find the Html_Response element and change the text from OK to YES as in 

the following example. 

 
<Html_OK xml:id="Html_Response">OK</Html_OK> 
<Html_OK xml:id="Html_Response">YES</Html_OK> 
 
The Standard template is located in the System/Question Templates folder in the Library. The 

resources.xml file is located inside the lang/<language code> folder. The resources.xml file is 
also located in lang folder for each language in the published output. 
 

Customize the question.css file 

You can customize the look of the Question header, Response header and Assessment bar of 
questions in the Player and Developer. You can replace the Question and Response icons, 

change border and background colors of the headers and the font of the header text by editing 
the appropriate lines in the question.css file. For example, if you want to increase the font size 
of the text in the Assessment Bar, find the .AssessmentBar element in the question.css file 
and change the font from 10px to the desired font. 

 
The Standard template is located in the System/Question Templates folder in the Library. The 
question.css file is located at the root of the template package. 

 
The following elements are fully customizable. Additional elements in the question.css file can 
be customized for appearance (for example, font) but not for positioning. Only properties that 
already exist for the element can be customized. No new additional properties can be added. 

 1 Question icon (question_icon.gif): Use this to customize the question icon in the 
Question header. This graphic is located in the Standard template under the Question 

Templates folder. You can change the graphic by editing .NewQuestionHeaderIcon in 
the question.css file. 
   

 2 Response icon (response_icon.gif): Use this to customize the response icon in the 

Response header. This graphic is located in the Standard template under the Question 

Templates folder. You can change the graphic by editing the graphic name in the 
.NewQuestionHeaderIcon element in the question.css file. 
   

 3 Question Text (#questionlabel): Use this to customize the question text in the 

Question header. This element is located in question.css. 
   

 4 Response Text (#responselabel): Use this to customize the response text in the 
Response header. This element is located in question.css. 

   

 5 Question & Response Header background color (.PlayerShading): Use this to 
customize the background color of the Question and Response headers. This element 
is located in question.css. 

   

 6 Question Count background color (.AssessmentBar): Use this to customize the 
background color and border of the Question Count header. This element is located in 

question.css. 

  

 7 OK button text (html_OK): Use this to customize the text on the OK button. This 
element is located in resources.xml. 
  

 8 Do Not Know button text (html_DoNotKnow): Use this to customize the text on the 
Do Not Know button. This element is located in resources.xml. 
  

 9 Continue button (html_Continue): Use this to customize the text on the Continue 

button. This element is located in resources.xml. 
  

 10 Question Table border color: Use this to customize the border color that surrounds 
the Question Table. This element is located in the resources.xml. 



  Publish Content 

   447 

Warning! Customization of any other files is not supported. 

20.5.17 Customize Assessment Elements 

You can customize the way assessments look in the Player and the Developer by editing the 
resources.xml and assessment.css files. This enables you to customize the assessment default 
text to match a localized Player or Developer interface. 

 
The resources.xml file is the language resource file that contains assessment template specific 
language elements (such as headings or buttons) that appear on the Summary page when a 
user completes an assessment. The assessment.css file is the style sheet that controls icons 
and header elements such as background color. 
 
Warning! Customizations to assessments are not part of the Customization Package and are 

overwritten upon upgrade. It is recommended that you create a copy of the Standard template 
in the Assessment Templates folder. Rename the copy and make your customizations to the 
copy. This provides a backup so you can restore the original if necessary. In addition, when 
you upgrade to a newer version of the Developer, your customized template are not 

overwritten. 
  

 
  

Customize the resources.xml file 
You can customize the text for any of the HTML_strings in the resources.xml file. These 

changes can appear in both the Developer and the published output depending on the string 
you modify and the format you publish. 
 
You can customize the Summary page text, such as the Print button or the Question Name 
heading text, if your company uses different terminology in assessments. Open the 

resources.xml file in any text editor and edit the appropriate lines. For example, if you want to 
change the Print button text to Print Summary, find the resource id element and change the 
text from Print to Print Summary as in the following example. 
 
<resource id="print">Print</resource> 
<resource id="print">Print Summary</resource> 

 
The Standard template is located in the System/Assessment Templates folder in the Library. 
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The resources.xml file is located inside the lang/<language code> folder. The resources.xml 

file is also located in the lang folder for each language in the published output.  

 

Customize the assessment.css file 
You can customize the look of the Question header, Response header and Assessment bar of 
questions in the Player and Developer. You can replace the Question and Response icons, 

change border and background colors of the headers and the font of the header text by editing 
the appropriate lines in the assessment.css file. For example, if you want to increase the font 
size of the text in the Assessment Bar, find the .AssessmentBar element in the assessment.css 
file and change the font from 10px to the desired font. 
 
The Standard template is located in the System/Assessment Templates folder in the Library. 
The assessment.css file is located at the root of the template package. 

 
The following elements are fully customizable. Additional elements in the assessment.css file 
can be customized for appearance (for example, font) but not for positioning. Only properties 
that already exist for the element can be customized. No new additional properties can be 

added. 

 1 Assessment Summary & Results table background color (.theader): Use this to 

customize the background color (default is cde2fe) of the Assessment Summary and 
Results table headers. This element is located in assessment.css. 
   

 2 Results table odd row color (#responsesum td, #sectionsum td): Use this to 
customize the color of the odd numbered rows in the Results table.  Default settings 

include 3 pixel padding and a top border of 1 pixel. The background color defaults to 
b2b1b5). These elements are located in assessment.css. 
   

 3 Results table even row color (.graycolor): Use this to customize the color (defaults 

to rgb 240,240,240) of the even numbered rows in the Results table. This element is 
located in assessment.css. 
   

 4 Icon for correct response (ok.gif, ok.png): Use this to customize the graphic that 

signifies a correct answer. These graphics are located at the root of the assessment 
template. 
   

 5  Icon for incorrect response (x.gif, x.png): Use this to customize the graphic that 

signifies an incorrect answer. These graphics are located at the root of the assessment 
template. 
   

 6 Text of Assessment Summary (summary): Use this to customize the text in the 

Assessment Summary header. This element is in resources.xml. 
   

 7 Date text (date): Use this to customize the text of the date just below the 
Assessment Summary header. This element is in resources.xml. 

   

 8 Completion text (completed): Use this to customize the text that indicates the 

assessment has been completed. This element is in resources.xml. 
   

 9 Correct score text (respondedscore): Use this to customize the text that indicates 
the total number of correct answers. This element is in resources.xml. 
   

 10 Total score text (totalscore): Use this to customize the text that indicates the total 

score. This element is in resources.xml. 
   

 11 Print button text (print): Use this to customize the text on the Print button. This 

element is in resources.xml. 
   

 12 Table border color (.tlastline); Use this to customize the border color around the 
Results table. This element is located in assessment.css. 



  Publish Content 

   449 

Warning! Customization of any other files is not supported. 

20.5.18 Control "For Example" Text in String Inputs 

If meta entries are used in a string input step, you may prefer to remove the “for example” 
text (“Tuesday”) from appearing during playback. When you suppress the “for example” text, 
the bubble for a meta entry changes from Enter a valid value (for example, “Tuesday”) to 

Enter a valid value.   
 
You can edit templates using the Template Editor. See Customize Templates for more 
information. 

20.6 Customize the Presentation Format 
The Presentation output uses a Microsoft PowerPoint template called 
PresentationTemplate.pptx to control the format and layout of the presentation. Each 

language has its own template file. A folder for each language is located in the lang folder 
within the print style. To make any customization, you modify the PowerPoint template.  

 
The template contains two slides with pre-defined layouts and text, one for the title slide and 
one for the steps. 
 

Change the Logo 

The logo appears at the top left corner of each slide. You can change this logo as desired by 
replacing it on the two slides in the template with your own company logo. With this method, 
it can be any size that fits appropriately on the slide. 
 
Note: You can also use the Customize Logo tool in the Developer to replace the logo. If you 

use this tool, the logo should be no larger than 230x44 pixels. 
 

Change the Slide Theme 

You can apply any slide theme or design you wish. Depending on the position of the elements 
in the design, you may need to adjust the position of the placeholder images and text boxes. 

You can also apply a background color to the slides. 

 

Configure the Slide Layout 
The second slide in the presentation contains the default layout for the steps. You can 
rearrange or resize these text boxes as desired. Note that at a minimum, there must be one 
image placeholder for the graphic and one text box placeholder for the bubble text for each 
step. 

 

Adjust Paper Size 

By default, the slides are sized for an onscreen show. If you are printing the presentations, 
you can set a page size in the Page setup dialog box. 
 

Change Font and Font Attributes 

You can change the default font in the text boxes as desired. You can also change the font 
attributes such as color, size, and weight (bold). 

 

Title of Slide 

You can change or delete the title of the slide. 
 

Transition Effects 

By default, there are no transition effects. You can set the default transition effect as desired. 
 
See Customize Publishing Styles for more information about copying, renaming and editing 

publishing styles. 
 
Note: If you create custom publishing styles, you should document your customizations so 
you can easily re-apply them, if necessary, after a software upgrade. 
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20.7 Customize the Test Case Output 
For the Test Case, the publishing process uses an xml file which contains column definitions 
for all the columns that can be exported from the Developer into the file. The xml file is 
located in the lang folder within the Test Case publishing style. Each language has an xml file; 
customize the languages you need. In addition, each format within the Test Case style has its 
own xml file:  
  

HP Quality Center: ColumnSpec.xml 
Oracle Application Testing Suite: OATS_ColumnSpec.xml  
IBM Rational Quality Manager: Rational_ColumnSpec.xml  
Other: Other_ColumnSpec.xml  
  
To customize the output, edit the .xml file in an editor of your choice. Before you customize 
the style, it is highly recommended that you make a copy of it and then make your 

modifications to the copy. See Customize Publishing Styles for more information about 
copying, renaming, and editing publishing styles. 
 

Include or Exclude Columns 

You can specify the columns you want. By default, the columns that are required for import 
into each format are included. In addition, the .xml file contains definitions for all of the data 

that can be retrieved from the Developer database. Within each column definition, between 
the <col> and </col> tags, there is an export parameter with a yes or no value. Yes means 
that the column is included in the output. 
 
Note: The Output and Required Fields columns have an additional parameter for fixed width 
font. These columns contain the information in the Output and Required fields tables. In order 

to represent the tables properly, table columns are separated by spaces, and each table row is 
on a separate line. This information is easier to read when it is formatted with a fixed width 
font such as Courier. Therefore, by default, the fixedWidthFont parameter has a value of Yes 
for these two fields. If you want these fields to appear in a proportional font, change the 
parameter to No. 
 

Change the Column Name 

Another parameter within the column definition tags is header. This value is the text for the 
column name. You can change the text in between the <header> and </header> tags to 
whatever you wish. Do not change the xml:id reference or its value. 
 

Repeat Topic Data 

By default, the data in the columns repeats for every row in the topic. If you do not want this 
information to repeat for every row, you can use the repeat parameter in the <data> tag. A 
value of Yes causes the data to appear in each row of the topic; a value of No causes the data 
to appear in the first row of the topic only. 
 

Set a Default Value 

You can use the <defaultvalue/> tag to set a default value for a column if the value specified 
in the <data> tag is blank. Modify the <defaultvalue/> tag so that it has begin and end tags, 
and enter the text for the default value between tags. For example, <defaultvalue>XYZ 

Company</defaultvalue>, which places the XYZ Company text in the field if the <data> tag 
returns a blank value. 
 
Note: The value in the Step column is set to integer in the OATS_ColumnSpec.xml. 

 

Set Column Width 

Each column is set with a default width. The <width> tag specifies the width of the column 
expressed in the number of characters. For example, if the default font is Arial 10, then a 
column width of 10 displays 10 characters, which is equal to 75 pixels. If the font is changed 

to Courier New, the column width still displays 10 characters, but the column is resized to 85 
pixels. You can edit the value of the <width> tag to suit your needs. 
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20.8 Customize Document Formats 
Document outputs use a Microsoft Word template called PrintTemplate.docm to control the 

format and layout of the document. The template contains bookmarks, styles, document 
settings, and pre-defined text. Bookmarks are the mechanism used to insert and position the 

fields in the document and styles are used to format the fields. Document settings affect the 
page layout, such as paper size and margins. Pre-defined, or static, text can appear in several 
places in any template, usually the header and footers and the labels for the fields in the body 
of the document. The template also contains a toolbar which allows you to insert the desired 
bookmarks in the template you want to customize.  
 

Each print style has a lang folder, and within it is a folder for each language. Each language 
has its own template file. To make any customization, you modify the publishing style for the 
specific language. 
  
Follow these basic steps to customize a document format: 

 Create a new publishing style. See Customize Publishing Styles for more information 

about copying and renaming publishing styles. It is highly recommended that you do 

not customize a standard template; you should make a copy and make your edits to 
the copy. 
  

 Open the new publishing style package that you copied, navigate to the 

lang/<language> folder, and open the PrintTemplate.docm file. 
  

 Make the edits to the PrintTemplate.docm file as desired by inserting or deleting 
bookmarks, Word fields, static text, or graphic elements. Be sure to use Check Syntax 

to verify that there are no errors in your changes to the bookmarks. 
  

 Save the edited template in the publishing style, and then save the package. 
  

 Publish the content using your new publishing style. Be sure to select the correct 
category and language on the Advanced Publishing Options page. 

20.8.1 Use Bookmarks 

Bookmarks have two parts: the bookmark name and the descriptive text in angled brackets 
(<>). The entire bookmark is enclosed in grey square brackets ([ ]). To display the grey 
brackets, you must turn on all formatting marks, plus select the Show bookmarks option 
under the Show document content section on the Advanced page of the Word Options dialog 
box in Microsoft Word. This is important, because if you want to move a bookmark, you need 

to make sure that you select the entire bookmark. 
 

Types of bookmarks 

There are three basic types of bookmarks: 

 Single field: Bookmarks with a single piece of data, such as topic name, status, 

document ID, or creation date. 

  

 Multiple fields: Bookmarks with multiple fields, most often in a table. Examples include 
the Required fields table, Output table, and Table of Properties in the System Process 

Document, the Instructor Guide notes, and the table of Context IDs. 
  
This type of bookmark also includes the bookmarks which insert the concepts for the 
modules, sections, and topics as well as the list and table of action steps, the table of 
attachments, the screenshot, and the table of glossaries. 
  

 Repeating: Bookmarks that contain definitions to allow insertion of multiple items, 

such as rows in a table or multiple attachments to a frame. These bookmarks may also 
contain table definitions, placeholders for graphics, and static text. 
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20.8.2 Publishing Template Toolbar 

The PrintTemplate.docm file includes a toolbar. There are five menu items, three of which 

allow you to insert bookmarks. In some cases, the menus insert several bookmarks or an 
entire structure, such as a table of action steps for a topic.  
 
If Word is set to English, Spanish, French, German, or Japanese, the Publishing Template 
toolbar appears in the same language by default when you open the template. If Word is set 
to any other language, the template toolbar appears in English by default. You can use the 

Language menu to choose the language in which the toolbar is displayed. 
 
You use the Add-ins ribbon to view the toolbar. When you open the file, you may receive a 
security warning. If you do, then you need to enable macros. 
 

Outline Menu  

 Outline Name: Inserts the name of the outline. The outline name is the text in the 

tab that was active when you published. 
  

 Modules and Sections submenu 

  
Module and Section: Inserts the pair of repeating tags required to define the 
beginning and end of the module or section. Any bookmarks for the contents of the 
module or section should be included between these bookmarks, such as the module 
or section name, concept, or topics. 
  
Name, with Style Defined in Template: Inserts and formats the names of modules 

and sections, using the style defined in this template. With this bookmark, all the 
modules and sections use the Heading 1 style in Word, and all of the topic names use 
Heading 2. These are the default bookmarks. 
  
Name, with Style Referenced to Outline Level: Inserts and formats the names of 
modules and sections, using the outline level style. The outline levels use the various 

Heading styles in Word. You may need to modify several styles, depending on how 
many levels you have in your content. 
  
Concept: Inserts and formats the web pages used for concepts for modules and 
sections, using the web page format source selected during publishing. Sources 
include Developer settings or Word template settings. Developer settings use the 
formatting from the Web Page Editor in the Developer. Any formatting or style 

changes you make in the template are ignored. Word Template settings use the style 
and formatting in the template. 
  
Table of Context IDs: Inserts a table of Context IDs for modules and sections. The 
context ID table has three columns: Context Name, Application Name, and Context 
IDs. Each of these columns contains a corresponding bookmark to insert the data. 
There is also a hidden bookmark at the beginning of the heading row to allow the rows 

to repeat for multiple Context IDs. 

  

 Questions & Assessments submenu  
  

Question: Inserts the pairs of repeating tags required to define the beginning and end 
of each question type. A dialog box allows you to choose the question types you want 
to include in the document. 
  
Assessment: Inserts the pairs of repeating tags required to define the beginning and 
end of an assessment. A dialog box allows you to choose the question types you want 

to include in the assessment. 
  
Associated Assessment Link: Inserts the pairs of repeating tags required to provide 
a list of links to associated assessments. 
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Associated Assessment: Inserts the pairs of repeating tags required to define the 
beginning and end of an associated assessment. A dialog box allows you to choose the 

question types you want to include in the assessment. 
  

 Topics submenu 
  
Topic: Inserts the pair of repeating tags required to define the beginning and end of a 
topic in a multiple topic output format. Any bookmarks for the contents of the topic 

should be included between the beginning and ending topic bookmarks, such as name, 
concept, or action steps. 
  
Name, with Style Defined in Template: Inserts and formats the name of the topic, 
using the style defined in this template. You can, therefore, create a style specifically 
for the topic name, no matter its position in the outline hierarchy. 
  

Name, with Style Referenced to Outline Level: Inserts and formats the name of 
the topic, using the outline level style. The outline levels use the various Heading 
styles in Word; topics are always Heading 2. 

  
Concept, with Format Defined in Template: Inserts and formats the web pages 
used for topic concepts, using the style and formatting in the template. These 

bookmarks honor the text alignment as set in the Developer. They also honor any 
image properties set on images in web pages. 
  
Concept, with Format Defined in Developer: Inserts and formats the web pages 
used for topic concepts, using the formatting from the Web Page Editor in the 
Developer. Any formatting or style changes you make in the template are ignored. 
  

Play Modes: Inserts a list of topic play modes, as specified in the Properties toolpane 
for the topic. 
  
Know It? Remediation Levels: Inserts the Know It? remediation levels, as specified 
in the Properties toolpane for the topic. 

  
Know It? Required Score: Inserts the Know It? passing score, as specified in the 

Properties toolpane for the topic. 
  
Number of Frames: Inserts the number of frames in the topic. 
  

 Frames submenu  

  
Frame: Inserts the pair of repeating tags required to define the beginning and end of 
a frame. These bookmarks should be between the beginning and ending tags for the 
topic. 
  

Table of Action Steps: Inserts a customizable table of action text, including the 
introduction frame text. This set of bookmarks also includes the begin and end tags for 
the frames. There is a hidden bookmark in the heading row of the table which controls 

the multiple rows. When you select this menu, a dialog box appears allowing you to 
select various options. You can choose whether the text style for the action steps is 
controlled by the style in the Topic Editor or by the style you set in the template. A 
series of checkboxes allows you to choose whether to include action images for each 

step, attachments, Context IDs, and Decision and alternative path action text, for 
example, Go to step x. 
  
List of Action Steps: Inserts a customizable list of action text, including the action 
text. This set of bookmarks also includes the begin and end tags for the frames. This 
option creates a list of the action steps that does not use a table. When you select this 
menu, a dialog box appears allowing you to select various options. You can choose 

whether the text style for the action steps is controlled by the style in the Topic Editor 
or by the style you set in the template. A series of checkboxes allows you to choose 
whether to include action images for each step, attachments, Context IDs, and 
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Decision and alternative path action text, for example, Go to step x. 

  

Table of Attachments: Inserts customizable table of attachments. This set of 
bookmarks must be included between the begin and end tags for the frame. When you 
select this menu, a dialog box appears allowing you to select various options. You can 
choose whether the text style for web pages is controlled by the style in the Topic 
Editor or by the style you set in the template. Checkboxes allow you to choose 

whether to include action attachment icons and images in packages. 
  
Screenshot: Inserts the bookmark for a screenshot placeholder. 
  
Author Notes: Inserts the bookmark for the author notes from the Topic Editor. 
  
Expected Test Results: Inserts the bookmark for the expected test results from the 

Topic Editor. 
  
Instructor Notes: Inserts the bookmark for the instructor notes from the Topic 

Editor. 
  

 Publication Date: Inserts the date on which the document was last published 

  

 Table of Glossaries: Inserts a table of glossary terms, as in the Training Guide. 

There are bookmarks to define the beginning and ending of the Glossary table. In 
addition, there is a bookmark to insert the glossary term. 

Details Menu  

 Checked Out by Author: Inserts the person's name to whom the document is 
checked out as indicated in the Checked Out By field in the Details view in the 
Developer. 
  

 Checked Out on Workstation: Inserts the workstation's name on which the 

document is checked out as indicated in the Checked Out Hostname field, which can 
be added to the Details view in the Developer. 
  

 Creation Date: Inserts the date on which the document was created as indicated in 

the Creation Date field, which can be added to the Details view in the Developer. 
  

 Custom Properties: Inserts a table of custom properties. It has two columns, name 

and value. These fields are specified in the General section of the Properties toolpane 
in the Developer. 
  

 Document ID: Inserts the document ID as indicated in the Document ID field, which 

can be added to the Details view in the Developer. 
  

 Keywords: Inserts the keywords assigned to the module, section, or topic in a 

comma separated list, as specified in the Properties toolpane. 

  

 Language: Inserts the language of the module, section, or topic, as specified in the 
Properties toolpane for the topic. 

  

 Last Modified By: Inserts the person's name who last modified the document as 
indicated in the Last Modified By field, which can be added to the Details view in the 
Developer. 

  

 Last Modified Date: Inserts the date on which the document was last modified, as 
indicated in the Last Modified Date field in the Details view in the Developer. 
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 Links Count: Inserts the number of items linked from the document as indicated in 

the Link Count field, which can be added to the Details view in the Developer. 

  

 Links To: Inserts the number of items linked to the document as indicated in the 
Links To field, which can be added to the Details view in the Developer. 

  

 Owner: Inserts the person's name who owns the document, or to whom it is 
assigned, as indicated in the Owner field in the Details view in the Developer. 
  

 Roles: Inserts a list of roles assigned to the document, as specified in the Properties 

toolpane for the topic or in the Roles field in the Details view. 
  

 State: Inserts the state of the document, such as Draft, as specified in the Properties 

toolpane for the topic or in the State field in the Details view. 
  

 Type: Inserts the document type, such as Section or Topic, as indicated in the Type 

field, which can be added to the Details view in the Developer. 

  

 Version: Inserts the version of the document as indicated in the Version field in the 
Details view of the Developer. 

Topic Properties Menu  

 System Process Document submenu 
  
Output Table: Inserts a table of output results. This is the Output - Results and 
Comments table for the System Process Document as specified in the Properties 
toolpane for the document. Each column has a bookmark to insert the data. There is a 
hidden bookmark at the beginning of the heading row to control the repetition of 

multiple rows in the table. 
  
Required Fields Table: Inserts a table of required fields. This is the Required Field(s) 

and Comments table for the System Process Document as specified in the Properties 
toolpane for the document. Each column has a bookmark to insert the data. There is a 
hidden bookmark at the beginning of the heading row to control the repetition of 
multiple rows in the table. 

  
Table of Properties: Inserts a table of properties. This is the first table in the System 
Process Document. It includes Department, Responsibility/Role (list of roles), File 
Name (this is a Word field), Revision (version number appended to the document type 
at publication), Document Generation Date (the date on which the document was last 
published), Date Modified, Last Changed By (SPD property field; the person's name 
who last modified the document in the Developer), Status (SPD property field), Trigger 

(SPD property field), and Additional Information (SPD property field). All of these 
fields are as specified in the Properties toolpane in the Developer. 
  

 Test Document submenu  

  
Additional Validation: Inserts the Additional information to validate the test, as 
specified in the Test Document section of the Properties toolpane in the Developer. 
  
Estimated Time: Inserts the Estimated time to complete the test, as specified in the 
Test Document section of the Properties toolpane in the Developer. 

  
Purpose of Test: Inserts the Purpose of the test, as specified in the Test Document 
section of the Properties toolpane in the Developer. 
  
Test Document Revision: Inserts the Test Document Revision, as specified in the 
Test Document section of the Properties toolpane in the Developer. 
  

Test Setup: Inserts the Test setup, as specified in the Test Document section of the 
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Properties toolpane in the Developer. 

  

 Instructor Manual Notes: Inserts the Instructor notes, as specified in the Instructor 
Manual section of the Properties toolpane in the Developer. 
  

 Job Aid Revision: Inserts the Job Aid Revision, as specified in the Job Aid section of 
the Properties toolpane in the Developer. 

20.8.3 Insert, Move, and Delete Bookmarks 

You can add bookmarks to the PrintTemplate.docm file from the Developer Publishing Toolbar 
or from the Bookmark dialog box in Word. You can use the toolbar to add extra information to 
the template easily.  
 

You can also make substitutions with the toolbar. For example, the default template for the 
Training Guide uses the text formatting for concept web pages as set in the template. If you 
want to use the formatting as it is in the Developer, you can delete everything between and 

including the ModuleSectionConcept beginning and ending tags, and then use the toolbar to 
easily insert the bookmarks for the Developer-formatted web pages. 
 
You can also insert bookmarks using the Bookmark dialog box in Microsoft Word. You can 

access this dialog box with the Bookmark command from the Insert ribbon. The bookmarks 
appear in the list with numbers appended to the name. In Word, each bookmark must have a 
unique name. The numbers are also used to identify beginning and ending bookmarks for a 
block, such as ForEachAttachment_Begin_1 and ForEachAttachment_End_1. The Check Syntax 
feature uses these numbers to verify that all necessary pairs are present. 
 
See the Bookmark Reference topic in the Customize Document Formats chapter of the Content 

Development guide to determine the bookmark that you want to insert, then enter it in the 
Bookmark Name field at the top of the Bookmark dialog box, appending a number. You can 
insert any bookmark, including those, such as FrameID, that are not present by default in any 
of the output formats. 
 

Note: If you insert Developer bookmarks in the headers or footers of the template, they are 

ignored during the document processing. Microsoft Word fields, such as the document name, 
the page number, or the date of publication are honored. 
 

Move and Delete Bookmarks 

When you select bookmarks to move or delete them, you should make sure that you select 
the entire bookmark, including the grey brackets at the beginning and the end and the no-

width non breaking space before the bookmark. 
 
You cannot copy bookmarks; you must move them using cut and paste. When you delete 
multiple bookmarks, especially a block of bookmarks, make sure you delete both the 
beginning and ending tags. If there are extra tags, you receive an error when you check the 
syntax or attempt to use the template. 
 

At the end of the template, there are bookmarks that you should not delete. These bookmarks 

control the images for the action areas, screenshots, packages, and web pages. If they are 
missing, the template is not processed correctly during publishing. If you delete these 
bookmarks, you should replace them by copying them from an unmodified template. 

20.8.4 Bookmarks in Multi-topic Formats 

The structure of the bookmarks in multi-topic formats such as the Training Guide and 
Instructor Manual is complex. To help you better understand the structure of the bookmarks 

and how they work in these documents, a high-level overview of the sections in the order as 
they appear in the document is below.  
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ForEachModuleSection_Begin  

{ModuleSectionConcept}    

ForEachChildOutlineItem_Begin (Iterates through all the outline items inside a 
module or section to include them in the document.) 

           Topic_Begin (the topic definition)  

TopicConcept_begin  

{Webpage}  

TopicConcept_end  

ForEachFrame_Begin  

{LeadinFrameType}  

{NormalFrameType}  

{DecisionFrameType}  

{EndFrameType}  

ForEachFrame_End  

Topic_End  
Question_Begin (Question definition for single questions in the outline.)  
{QuestionName}   
{QuestionImage}   
FillInQuestionType   
MultipleChoiceSingleAnswerQuestionType   
MultipleChoiceManyAnswerQuestionType   
TrueFalseQuestionType   
MatchingQuestionType   
HotspotQuestionType   
Question_End   
Assessment_Begin (Assessment definition for assessments in the outline, 

including how questions in the assessment are shown.)    
{AssessmentName}    

               Question_Begin (Definition for questions in the assessment.)    
{QuestionName}   
{QuestionImage}   
FillInQuestionType   
MultipleChoiceSingleAnswerQuestionType   
MultipleChoiceManyAnswerQuestionType   
TrueFalseQuestionType   
MatchingQuestionType   
HotspotQuestionType   
Question_End   
Assessment_End   
Related_Assessment_Link  
ForEachChildOutlineItems_End    

ForEachModuleSection_End  
ForEachRelatedAssessment_Begin (Definition for Related Assessment.)    
Assessment_Begin  
{AssessmentName}    

              Question_Begin   
{QuestionName}   
{QuestionImage}   
FillInQuestionType   
MultipleChoiceSingleAnswerQuestionType   
MultipleChoiceManyAnswerQuestionType   
TrueFalseQuestionType   
MatchingQuestionType   
HotspotQuestionType   
Question_End   
Assessment_End   
ForEachRelatedAssessment_End   
{Glossary}    

20.8.5 Insert Bookmarks for Questions and Assessments 

You can insert bookmarks for Questions and Assessments in the print templates 
(PrintTemplate.docm) of the Instructor Manual or Training Guide. The bookmarks control how 

Questions and Assessments appear in these printed documents. 
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Bookmarks for Questions and Assessments are added to the print template from the Outline 

menu in Microsoft Word. Selecting Questions from the menu opens the Insert Questions dialog 

box. You select the type of question bookmarks you want to add plus the option to include 
bookmarks for the correct answer and/or remediation text when publishing the Training Guide 
or Instructor Manual. 

20.8.6 Insert Bookmarks for Custom Properties 

If you have created custom properties for documents, you can use the Custom Properties 
menu command on the Details menu of the template toolbar to insert a table of the custom 

properties and their values. You can also insert individual custom properties outside the table, 
using the following format:  
  
CP_<bmname>_Val_<N>  

  
Example: CP_authorname_val_1  
  
Parameters for the bookmark:  

  

CP   

Indicates that the bookmark is for a custom property.  
  

<bmname>  

The name of the bookmark as shown in the Custom Properties table in the Developer.  
  

val  
The value of the bookmark from in the Custom Properties table in the Developer.  
  

<N>  

A unique number for the bookmark.  

20.8.7 Insert Word Fields, Static Text, and Graphic Objects 

In addition to bookmarks, the template contains static text for labels for parts of the document 
and for field labels, and Word fields.  
 

Insert Word Fields 

You can insert any standard Word fields, such as date printed or last saved date. You can also 
use these in the header and the footer. You access the Field dialog box using the Quick Parts 
command on the Insert ribbon and then selecting Field. 
 

Insert Static Text or Graphic Objects 

You can edit existing static text or add any static text anywhere on the template. You can also 

add graphic images or drawings, such as a line to separate sections or a graphic on the title 
page of the training manual. 

20.8.8 Format Bookmarks and Text 

If you have standard Word styles that you use for your documentation, you can copy them 
into the print template and use them for the printed outputs. You can also modify the existing 
styles in the template. 
 
Note: If you use bookmarks that use the formatting as set in the Developer, any formatting in 

template is ignored. 
 
You can also format bookmarks by formatting the name of the bookmark. This overrides the 
style that is applied to the bookmark. For example, if you want the Start frame text to be bold 
or larger than the text for the action frames, you do not need to create another style. 

20.8.9 Bookmark Reference 

The following list contains all of the bookmarks available in the PrintTemplate.docm template. 
It also indicates whether you can insert the bookmark through the menus on the Developer 
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Publishing Template toolbar, or if you need to insert it manually in the Bookmark dialog box in 
Microsoft Word. See the Publishing Template Toolbar topic in the Customize Document 

Formats chapter for more information. This list is useful if you delete a bookmark by mistake 
and want to insert it again, especially if the bookmark is not available from the toolbar.  

 ActionText: Inserts action text with formatting indicated in this template. Action text 
refers to the bubble text. It is inserted as a part of the Table of Action Steps and the 
List of Action Steps, both of which are on the Frames submenu of the Outline menu. 
   

 AdditionalInformation: Inserts additional information to be published with the 

document, as specified in the System Process Document section of the Properties 
toolpane in the Developer. It is inserted as part of the Table of Properties on the 
System Process Document submenu of the Topic Properties menu. 
  

 AdditionalValidation: Inserts additional validation as specified in the Test Document 

section of the Properties toolpane in the Developer. It can be inserted from the Test 
Document submenu of the Topic Properties menu. 

  

 AllOfTheAbove_Begin and _End: A pair of bookmarks containing localizable text for 

the All of the Above option for the Multiple Choice Single Answer (MCSA) question 
type. Inserted as part of the set of bookmarks for the question. 
  

 ApplicationName: Inserts the application name as indicated in the Topic Editor. It is 

inserted as part of the Table of Context IDs on the Modules and Sections submenu of 
the Outline menu. 
  

 Assessment_Begin: Beginning of a repeating bookmark for an assessment. It is 

inserted as part of an Assessment from the Questions and Assessments submenu on 
the Outline menu. 
  

 Assessment_End: End of a repeating bookmark for an assessment. It is inserted as 

a pair with the begin tag. It can be inserted from the Questions and Assessments 

submenu on the Outline menu. 
  

 Assessment_Name: Inserts the name of the assessment. It is inserted as part of the 

Assessment option on the Questions and Assessments menu on the Outline menu. It 
should be located between the beginning and end tags for an assessment. 
  

 AssociatedAssessmentHeader_Begin: Beginning of a repeating bookmark that 

inserts the title "Associated Assessments" in the document. It is inserted as part of the 
Associated Assessment option from the Questions and Assessments submenu of the 
Outline menu. 
  

 AssociatedAssessmentHeader_End: End of a repeating bookmark that inserts the 

title "Associated Assessments" in the document. It is inserted as a pair with the begin 
tag. It is inserted as part of the Associated Assessment or Associated Assessment Link 
option from the Questions and Assessments submenu of the Outline menu. 

  

 AssociatedAssessmentLink: Inserts a link to associated assessments. It should be 

located between the ForEachAssociatedAssessmentLink repeating tags. It is inserted 
as part of the Associated Assessment Link option from the Questions and Assessments 
submenu of the Outline menu. 
  

 AttachmentIcon: Inserts the attachment icon for items attached to frames in a topic. 
It should be located between the ForEachAttachment repeating tags. It is inserted as a 
part of the Table of Action Steps and the List of Action Steps, both of which are on the 
Frames submenu of the Outline menu. 

  

 CheckedOutByAuthor: Inserts person's name to whom the document is checked out 
as indicated in the Checked Out By field in the Details view in the Developer. It can be 
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inserted from the Details menu. 

  

 CheckedOutonWorkstation: Inserts workstation's name on which the document is 
checked out as indicated in the Checked Out Hostname field, which can be added to 
the Details view in the Developer. It can be inserted from the Details menu. 

  

 ContextIDs: Inserts the context IDs as indicated in the Properties toolpane or the 
Topic Editor. It should be located between the ForEachModuleSectionCtx or 
ForEachFrame repeating tags. It is inserted as part of the Table of Context IDs on the 

Modules and Sections submenu of the Outline menu. 
  

 ContextName: Inserts the context names as indicated in the Properties toolpane or 
the Topic Editor. It should be located between the ForEachModuleSectionCtx or 

ForEachFrame repeating tags. It is inserted as part of the Table of Context IDs on the 
Modules and Sections submenu of the Outline menu. 
  

 CorrectAnswerNum: Inserts the number of correct answers for a Multiple Choice 

Many Answer (MCMA) question. Inserted as part of the set of bookmarks for the 
question. 
  

 CreationDate: Inserts the date on which the document was created as indicated in 

the Creation Date field, which can be added to the Details view in the Developer. It 
can be inserted from the Details menu. 
  

 CustomProperty: Inserts the name of the custom property. It is inserted as part of 

the Custom Property table, which is available from the Details menu. 
  

 CustomPropertyValue: Inserts the value of the custom property. It is inserted as 
part of the Custom Property table, which is available from the Details menu. 
  

 DecisionFrameType_Begin: Beginning of a repeating bookmark for decision frame 
paths. It is inserted as a part of the Table of Action Steps and the List of Action Steps, 

both of which are on the Frames submenu of the Outline menu. 
  

 DecisionFrameType_End: End of a repeating bookmark for decision frame paths. It 
is inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
which are on the Frames submenu of the Outline menu. 
  

 DecisionHeader: Inserts the header text for a decision frame. It is inserted as a part 
of the Table of Action Steps and the List of Action Steps, both of which are on the 
Frames submenu of the Outline menu. 
  

 DecisionText: Inserts the text of a decision frame path. It must be located between 
the ForEachDecision repeating tags. It is inserted as a part of the Table of Action Steps 
and the List of Action Steps, both of which are on the Frames submenu of the Outline 
menu. 

  

 Define_Hotspot_Begin: Beginning of a bookmark that controls the hotspot graphics 
within the template. Do not delete. Must be inserted manually. 
  

 Define_Hotspot_End: End of a bookmark that controls the hotspot graphics within 
the template. Do not delete. Must be inserted manually. 
  

 Define_PackageImage_Begin: Beginning of bookmark that controls the package 

graphics within this template. Do not delete. Must be inserted manually. 
  

 Define_PackageImage_End: End of bookmark that controls the package graphics 

within this template. Do not delete. Must be inserted manually. 
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 Define_QuestionIcon_Begin: Beginning of a bookmark that controls the graphic for 

the question icon. Do not delete. Must be inserted manually. 

  

 Define_QuestionIcon_End: End of a bookmark that controls the graphic for the 
question icon. Do not delete. Must be inserted manually. 

  

 Define_QuestionImage_Begin: Beginning of a bookmark that controls the 
background graphic for the question. Do not delete. Must be inserted manually. 
  

 Define_QuestionImage_End: End of a bookmark that controls the background 

graphic for the question. Do not delete. Must be inserted manually. 
  

 Define_ResponseIcon_Begin: Beginning of a bookmark that controls the graphic 

for the response icon. Do not delete. Must be inserted manually. 
  

 Define_ResponseIcon_End: End of a bookmark that controls the graphic for the 

response icon. Do not delete. Must be inserted manually. 

  

 Define_Screenshot_Begin: Beginning of repeating bookmark that controls the 
screenshot graphics within this template. Do not delete. Must be inserted manually. 

  

 Define_Screenshot_End: End of repeating bookmark that controls the screenshot 
graphics within this template. Do not delete. Must be inserted manually. 
  

 Define_WebpageImage_Begin: Beginning of bookmark that controls the web page 
graphics within this template. Do not delete. Must be inserted manually. 
  

 Define_WebpageImage_End: End of bookmark that controls the web page graphics 

within this template. Do not delete. Must be inserted manually. 
  

 Department: Inserts the department as specified in the System Process Document 

section of the Properties toolpane in the Developer. It is inserted as part of the Table 

of Properties on the System Process Document submenu of the Topic Properties menu. 
  

 DeveloperWebpageText: Inserts web page text with formatting as defined in the 

Developer. Must be inserted manually. 
  

 DocType: Inserts the document type, such as Section or Topic, as indicated in the 

Type field, which can be added to the Details view in the Developer. It can be inserted 
from the Details menu. 
  

 DocumentID: Inserts the document ID as indicated in the Document ID field, which 

can be added to the Details view in the Developer. It can be inserted from the Details 
menu. 
  

 EndFrameType_Begin: Beginning of a repeating bookmark for end frames. It is 

inserted as a part of the Table of Action Steps and the List of Action Steps, both of 

which are on the Frames submenu of the Outline menu. 
  

 EndFrameType_End: End of a repeating bookmark for end frames. It is inserted as a 

part of the Table of Action Steps and the List of Action Steps, both of which are on the 
Frames submenu of the Outline menu. 
  

 EstimatedTime: Inserts the estimated time as specified in the Test Document section 

of the Properties toolpane in the Developer. It can be inserted from the Test Document 
submenu of the Topic Properties menu. 
  

 FillInQuestionType_Begin: Beginning of a set of bookmarks for a Fill-in question. It 

is inserted as part of the Question option on the Questions and Assessments submenu 
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of the Outline menu. 

  

 FillInQuestionType_End: End of a set of bookmarks for a Fill-in question. It is 
inserted as part of the Question option on the Questions and Assessments submenu of 
the Outline menu. 

  

 ForEachAlternative_Begin: Beginning of a repeating bookmark for alternative 
actions and paths on a frame. Must be inserted manually. 
  

 ForEachAlternative_End: End of a repeating bookmark for alternative actions and 
paths on a frame. Must be inserted manually. 
  

 ForEachAssociatedAssessment_Begin: Beginning of a repeating bookmark for 

associated assessments. It is inserted as part of the Associated Assessment option on 
the Questions and Assessments submenu of the Outline menu. 
  

 ForEachAssociatedAssessment_End: End of a repeating bookmark for associated 

assessments. It is inserted as part of the Associated Assessment option on the 
Questions and Assessments submenu of the Outline menu. 
  

 ForEachAssociatedAssessmentLink_Begin: Beginning of a repeating bookmark for 

associated assessment links. It is inserted as part of the Associated Assessment Link 
option on the Questions and Assessments submenu of the Outline menu. 
  

 ForEachAssociatedAssessmentLink_End: End of a repeating bookmark for 

associated assessment links. It is inserted as part of the Associated Assessment Link 
option on the Questions and Assessments submenu of the Outline menu. 
  

 ForEachAttachment_Begin: Beginning of a repeating bookmark for attachments. It 

is inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
which are on the Frames submenu of the Outline menu. 
  

 ForEachAttachment_End: End of a repeating bookmark for attachments. It is 

inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
which are on the Frames submenu of the Outline menu. 
  

 ForEachChildOutlineItem_Begin: Beginning of a repeating bookmark to insert each 

section, topic, question, and assessment in order. 
  

 ForEachChildOutlineItem_End: End of a repeating bookmark to insert each section, 

topic, question, and assessment in order. 
  

 ForEachDecision_Begin: Beginning of a repeating bookmark for decision frames. It 
is inserted as a part of the Table of Action Steps and the List of Action Steps, both of 

which are on the Frames submenu of the Outline menu. 
  

 ForEachDecision_End: End of a repeating bookmark for decision frames. It is 

inserted as a part of the Table of Action Steps and the List of Action Steps, both of 

which are on the Frames submenu of the Outline menu. 
  

 ForEachFrame_Begin: Beginning of a repeating bookmark for frames. It is inserted 
as a part of the Table of Action Steps and the List of Action Steps, both of which are 

on the Frames submenu of the Outline menu. 
  

 ForEachFrame_End: End of a repeating bookmark for frames. It is inserted as a part 
of the Table of Action Steps and the List of Action Steps, both of which are on the 

Frames submenu of the Outline menu. 
  



  Publish Content 

   463 

 ForEachGlossary_Begin: Beginning of a repeating bookmark for glossaries. It is 

inserted as part of the Table of Glossaries on the Outline menu. 

  

 ForEachGlossary_End: End of a repeating bookmark for glossaries. It is inserted as 
part of the Table of Glossaries on the Outline menu. 

  

 ForEachModuleSection_Begin: Beginning of a repeating bookmark for modules and 
sections. It is inserted as a pair with the end tag. It can be inserted from the Modules 
and Sections submenu on the Outline menu. 
  

 ForEachModuleSection_End: End of a repeating bookmark for modules and 
sections. It is inserted as a pair with the begin tag. It can be inserted from the 
Modules and Sections submenu on the Outline menu. 
  

 ForEachModuleSectionCtx_Begin: Beginning of a repeating bookmark for table of 
context IDs. It is inserted as part of the Table of Context IDs on the Modules and 
Sections submenu of the Outline menu. 

  

 ForEachModuleSectionCtx_End: End of a repeating bookmark for table of context 
IDs. It is inserted as part of the Table of Context IDs on the Modules and Sections 
submenu of the Outline menu. 
  

 ForEachTopic_Begin and _End: Repeating bookmarks for topics. Do not use; have 
been replaced by Topic Definition bookmarks. These remain to support legacy 
templates. 
  

 FormattedActionText: Inserts action text with formatting indicated in the Developer. 
Action text refers to the text in the bubble. It is inserted as a part of the Table of 
Action Steps and the List of Action Steps, both of which are on the Frames submenu of 
the Outline menu. 

  

 FrameAuthorNotes: Inserts author notes added to topic during recording or in the 

Author Notes field in the Topic Editor. It can be inserted from the Frames submenu on 
the Outline menu. 
  

 FrameExpectedTestResults: Inserts the text entered in the Expected Test Results 
field in the Topic Editor. It can be inserted from the Frames submenu on the Outline 
menu. 
  

 FrameID: Inserts the frame ID as indicated in the Topic Editor. It must be inserted 
manually. 
  

 FrameInstructorNotes: Inserts the text entered in the Instructor Notes field in the 

Topic Editor. It can be inserted from the Frames submenu on the Outline menu. 
  

 GlossaryTerm: Inserts the glossary term. Inserted as part of Table of Glossaries. It 

should be located inside the ForEachGlossary repeating tags. It is inserted as part of 

the Table of Glossaries on the Outline menu. 
  

 Goto_Begin: Beginning of a repeating bookmark for GoTo steps for alternatives and 

decision frames. It is inserted as a part of the Table of Action Steps and the List of 
Action Steps, both of which are on the Frames submenu of the Outline menu. 
  

 Goto_End: End of a repeating bookmark for GoTo steps for alternatives and decision 

frames. It is inserted as a part of the Table of Action Steps and the List of Action 
Steps, both of which are on the Frames submenu of the Outline menu. 
  

 HotSpotImage: Inserts a placeholder for the action image. It is inserted as a part of 

the Table of Action Steps and the List of Action Steps, both of which are on the Frames 
submenu of the Outline menu. 
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 HotspotQuestionType_Begin: Beginning of a set of bookmarks for a Hotspot 

question. It is inserted as part of the Question option on the Questions and 

Assessments submenu of the Outline menu. 
  

 HotSpotQuestionType_End: End of a set of bookmarks for a Hotspot question. It is 

inserted as part of the Question option on the Questions and Assessments submenu of 
the Outline menu. 
   

 IfGlossary_Begin: Beginning of a conditional bookmark if there are glossaries. It is 

inserted as part of the Table of Glossaries on the Outline menu. 
   

 IfGlossary_End: End of a conditional bookmark if there are glossaries. It is inserted 

as part of the Table of Glossaries on the Outline menu. 
   

 IfHotspotImage_Begin: Beginning of a conditional block for hotspot images for 

frames. Must be inserted manually. 
   

 IfHotspotImage_End: End of a conditional block for hotspot images for frames. 
Must be inserted manually. 

   

 IfIMNotes_Begin: Beginning of a conditional bookmark if there are Instructor Notes. 
It is inserted as part of the Instructor Manual Notes command on the Topic Properties 
menu. 

  

 IfIMNotes_End: End of a conditional bookmark if there are Instructor Notes. It is 
inserted as part of the Instructor Manual Notes command on the Topic Properties 
menu. 

  

 IfNotShowNumberOfCorrectAnswer_Begin: Beginning of a set of bookmarks to 
insert the "Select all that apply" text for a Multiple Choice Many Answer question in 
which the number of correct answers is not specified. The text can be localized. 

Inserted as part of the set of bookmarks for the question. 

  

 IfNotShowNumberOfCorrectAnswer_End: End of a set of bookmarks to insert the 
"Select all that apply" text for a Multiple Choice Many Answer question in which the 

number of correct answers is not specified. The text can be localized. Inserted as part 
of the set of bookmarks for the question. 
  

 IMNotes: Inserts the Instructor Notes as specified in the Instructor Manual section of 
the Properties toolpane in the Developer. It should be between the IfIM_Notes 

repeaters. It is inserted as part of the Instructor Manual Notes command on the Topic 
Properties menu. 
  

 IfRemainingSteps_Begin: Beginning of conditional bookmark if there are remaining 

steps for an alternative or decision path. It is inserted as a part of the Table of Action 
Steps and the List of Action Steps, both of which are on the Frames submenu of the 
Outline menu. 

  

 IfRemainingSteps_End: End of conditional bookmark if there are remaining steps 

for an alternative or decision path. It is inserted as a part of the Table of Action Steps 
and the List of Action Steps, both of which are on the Frames submenu of the Outline 
menu. 
  

 IfShowNumberOfCorrectAnswer_Begin: Beginning of a set of bookmarks to insert 

the "Select # of the following." text for a Multiple Choice Many Answer question in 
which the number of correct answers is specified. The text can be localized. Inserted 
as part of the set of bookmarks for the question. 
  

 IfShowNumberOfCorrectAnswer_End: End of a set of bookmarks to insert the 

"Select # of the following." text for a Multiple Choice Many Answer question in which 
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the number of correct answers is specified. The text can be localized. Inserted as part 
of the set of bookmarks for the question. 

  

 IteratingRowAlternatives: Controls alternative step repeating and numbering. Do 

not delete. Must be inserted manually. 
  

 IteratingRowOutputResult: Controls repeating rows in the in the Output Results 

table in the System Process Document. Do not delete. Must be inserted manually. 
  

 IteratingRowRequiredField: Controls repeating rows in the Required Fields table in 

the System Process Document. Do not delete. Must be inserted manually. 
  

 JARevision: Inserts Job Aid revision appended to the document type at publication as 
specified in the Job Aid section of the Properties toolpane in the Developer. It can be 

inserted from the Topic Properties menu. 
  

 Keywords: Inserts the keywords assigned to the document in a comma separated 

list, as specified in the Properties toolpane for the topic. It can be inserted from the 

Topic Properties menu. 
  

 KnowItRemediation: Inserts Know It? remediation levels as specified in the Topic 
section of the Properties toolpane in the Developer. It can be inserted from the Topics 

submenu on the Outline menu. 
  

 KnowItScore: Inserts Know It? required scores as specified in the Topic section of 
the Properties toolpane in the Developer. It can be inserted from the Topics submenu 

on the Outline menu. 
  

 Language: Inserts the language of the content as specified in the Properties toolpane 
in the Developer. It can be inserted from the Details menu. 

  

 LastChangedby: Inserts the person's name that last modified the document as 

specified in the System Process Document section of the Properties toolpane in the 
Developer. It is inserted as part of the Table of Properties on the System Process 
Document submenu of the Topic Properties menu. 

  

 LastModifiedBy: Inserts the person's name who last modified the document as 
indicated in the Last Modified By field, which can be added to the Details view in the 
Developer. It can be inserted from the Details menu. 

  

 LastModifiedDate: Inserts the date on which the document was last modified, as 
indicated in the Last Modified Date field in the Details view in the Developer. It can be 
inserted from the Details menu. 

  

 LeadinFrameType_Begin: Beginning of a repeating bookmark for lead-in frames 
text. It is inserted as a part of the Table of Action Steps and the List of Action Steps, 
both of which are on the Frames submenu of the Outline menu. 

  

 LeadinFrameType_End: End of a repeating bookmark for lead-in frames text. It is 
inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
which are on the Frames submenu of the Outline menu. 

  

 LinkCount: Inserts the number of items linked from the document as indicated in the 
Link Count field, which can be added to the Details view in the Developer. It can be 
inserted from the Details menu. 

  

 LinksTo: Inserts the number of items linked to the document as indicated in the Links 
To field, which can be added to the Details view in the Developer. It can be inserted 
from the Details menu. 
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 MatchingQuestionType_Begin: Beginning of a set of bookmarks for a Matching 

question. It is inserted as part of the Question option on the Questions and 

Assessments submenu of the Outline menu. 
  

 MatchingQuestionType_End: End of a set of bookmarks for a Matching question. It 

is inserted as part of the Question option on the Questions and Assessments submenu 
of the Outline menu. 
  

 MCSAQuestionType_Begin: Beginning of a set of bookmarks for a Multiple Choice 

Single Answer question. It is inserted as part of the Question option on the Questions 
and Assessments submenu of the Outline menu. 
  

 MCSAQuestionType_End:End of a set of bookmarks for a Multiple Choice Single 

Answer question. It is inserted as part of the Question option on the Questions and 
Assessments submenu of the Outline menu. 
  

 MCMAQuestionType_Begin: Beginning of a set of bookmarks for a Multiple Choice 

Many Answer question. It is inserted as part of the Question option on the Questions 
and Assessments submenu of the Outline menu. 
  

 MCMAQuestionType_End: End of a set of bookmarks for a Multiple Choice Many 

Answer question. It is inserted as part of the Question option on the Questions and 
Assessments submenu of the Outline menu. 
  

 MergeTables: Controls merging multiple glossary tables into one table in the Training 

Guide and Instructor Manual. Do not delete. Must be inserted manually. 
  

 ModuleSectionConcept_Begin: Beginning of a repeating bookmark for concepts. It 

is inserted as part of Concept, with Format Defined in Developer and Concept, with 
Format Defined in Template on the Modules and Sections menu on the Outline menu. 
  

 ModuleSectionConcept_End: End of a repeating bookmark for concepts. It is 

inserted as part of Concept, with Format Defined in Developer and Concept, with 
Format Defined in Template on the Modules and Sections menu on the Outline menu. 
  

 ModuleSectionName: Inserts module and section names, with style defined in this 

template. It can be inserted from the Modules and Sections menu on the Outline 
menu. 
  

 NoneOfTheAbove_Begin and _End: A pair of bookmarks containing localizable text 

for the None of the Above option for the Multiple Choice Single Answer (MCSA) 
question type. Inserted as part of the set of bookmarks for the question. 
  

 NormalFrameType_Begin: Beginning of a repeating bookmark for normal frames. It 

is inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
which are on the Frames submenu of the Outline menu. 
  

 NormalFrameType_End: End of a repeating bookmark for normal frames text. It is 

inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
which are on the Frames submenu of the Outline menu. 
  

 OLModuleSectionName: Inserts module and section names in outline, with style 

referenced to outline level. It can be inserted from the Modules and Sections menu on 
the Outline menu. 
  

 OLTopicName: Inserts topic name in outline, with style referenced to outline level. It 

can be inserted from the Topics menu on the Outline menu. 
  

 OutlineName: Inserts the outline name. The outline name is the text in the tab that 
was active when you published. It can be inserted using the Outline command on the 
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Outline menu. 
  

 OutputComment: Inserts the output comment as specified in the Output table in the 

System Process Document section of the Properties toolpane in the Developer. It is 
inserted as part of the Table of Properties on the System Process Document submenu 
of the Topic Properties menu. 
  

 OutputResult: Inserts the output result as specified in the Output table in the System 

Process Document section of the Properties toolpane in the Developer. It is inserted as 
part of the Table of Properties on the System Process Document submenu of the Topic 
Properties menu. 
  

 Owner: Inserts the person's name who owns the document, or to whom it is 
assigned, as indicated in the Owner field in the Details view in the Developer. It can be 
inserted from the Details menu. 
  

 PackageImage: Inserts a placeholder for an image in a package. It is inserted as a 

part of the Table of Action Steps and the List of Action Steps, both of which are on the 
Frames submenu of the Outline menu on the toolbar, as well as Concept, with format 
defined in Developer, on the Topics and Modules and Sections submenus on the 

Outline menu. 
  

 PlayModes: Inserts play modes as specified in the Topic section of the Properties 
toolpane in the Developer. It can be inserted from the Topics submenu on the Outline 
menu. 

  

 PublicationDate: Inserts the date on which the document was published. This is a 
Word field. It can be inserted from the Outline menu. 
  

 PubOptionWebpageText: Inserts the web page which uses the settings from the 
Web Page Format option in the Publishing Wizard. It is inserted as a part of the Table 
of Action Steps and the List of Action Steps, both of which are on the Frames submenu 

of the Outline menu on the toolbar; Concept on the Topics and Modules and Sections 

submenus on the Outline menu; and Table of Glossaries on the Outline menu. 
  

 Question_Begin: Beginning of a set of bookmarks for a question. It is inserted as 
part of the Question option from the Questions and Assessments submenu of the 

Outline menu. 
  

 Question_End: End of a set of bookmarks for a question. It is inserted as part of the 
Question option from the Questions and Assessments submenu of the Outline menu. 

  

 QuestionAnswer: Inserts the bookmark for the possible answers within a question. 
  

 QuestionAnswerNC: Inserts the bookmark for the possible answers without 

displaying the answers within a question. 
  

 QuestionChoices: Inserts the bookmark for the answer choices within a question 

type bookmark. 
  

 QuestionCorrectAnswer: Inserts the bookmark for the correct answer within a 

question type bookmark. 
  

 QuestionFalse_Begin: Beginning of a set of bookmarks to insert the "False" text for 
a True/False question. The text can be localized. Inserted as part of the set of 

bookmarks for the question. 
  

 QuestionFalse_End: End of a set of bookmarks to insert the "False" text for a 
True/False question. The text can be localized. Inserted as part of the set of 

bookmarks for the question. 
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 QuestionImage: Inserts the bookmark for the question background image within a 

question. 

  

 QuestionName: Inserts the Question Name bookmark within a question. 

  

 QuestionRemediationText: Inserts bookmark for the remediation text within a 

question. 
  

 QuestionText: Inserts the Question Name bookmark within a question type 
bookmark. 
  

 QuestionTrue_Begin: Beginning of a set of bookmarks to insert the "True" text for a 
True/False question. The text can be localized. Inserted as part of the set of 
bookmarks for the question. 
  

 QuestionTrue_End: End of a set of bookmarks to insert the "True" text for a 
True/False question. The text can be localized. Inserted as part of the set of 

bookmarks for the question. 
  

 QuestionType: Inserts the Question Type within a question type bookmark. 
  

 RequiredField: Inserts the required fields as specified in the System Process 

Document section of the Properties toolpane in the Developer. It is inserted as part of 
the Table of Properties on the System Process Document submenu of the Topic 
Properties menu. 
  

 RequiredFieldComment: Inserts the required field comments as specified in the 

System Process Document section of the Properties toolpane in the Developer. It is 
inserted as part of the Table of Properties on the System Process Document submenu 
of the Topic Properties menu. 
  

 Roles: Inserts a list of roles assigned to the document as specified in the Properties 

toolpane for the topic or in the Roles field in the Details view of the Developer. It can 
be inserted from the Details menu. 
  

 ScreenShotImage: Inserts a placeholder for the screenshot for a frame. It is 
inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
which are on the Frames submenu of the Outline menu. 
  

 SPDRevision: Inserts the revision number appended to the document type at 

publication as specified in the System Process Document section of the Properties 
toolpane in the Developer. It is inserted as part of the Table of Properties on the 
System Process Document submenu of the Topic Properties menu. 
  

 State: Inserts the document state, such as Draft, as specified in the Properties 
toolpane for the document or in the State field in the Details view. It can be inserted 
from the Details menu. 

  

 Status: Inserts the status of the document as specified in the System Process 
Document section of the Properties toolpane. It is inserted as part of the Table of 
Properties on the System Process Document submenu of the Topic Properties menu. 
  

 TableHeader: Controls table row repeating and step numbering. Do not delete. Must 
be inserted manually. 
  

 TargetFrameNum: Inserts target frame number for Decision frame paths and 

alternative paths. It is inserted as a part of the Table of Action Steps and the List of 
Action Steps, both of which are on the Frames submenu of the Outline menu. 
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 TargetPageNum: Inserts target page number for Decision frame paths and 

alternative paths. It is inserted as a part of the Table of Action Steps and the List of 

Action Steps, both of which are on the Frames submenu of the Outline menu. Do not 
use; it has been deprecated and remains to support legacy templates. 
  

 TDRevision: Inserts test document version appended to the document type at 

publication as specified in the Test Document section of the Properties toolpane in the 
Developer. It can be inserted from the Test Document submenu of the Topic 
Properties menu. 
  

 TestNotesFrameID: Used in the template to find an HTML element that needs to be 

updated with Pass/Fail/Skip status. To be used only in the Test It! Detailed Summary 
Report. 
  

 TestPurpose: Inserts the purpose of the test as specified in the Test Document 

section of the Properties toolpane in the Developer. It can be inserted from the Test 
Document submenu of the Topic Properties menu. 

  

 TestResultsFrameID: Used in the template to find an HTML element that needs to 

be updated with Pass/Fail/Skip status. To be used only in the Test It! Detailed 
Summary Report. 
  

 TestSetup: Inserts the test setup as specified in the Test Document section of the 

Properties toolpane in the Developer. It can be inserted from the Test Document 
submenu of the Topic Properties menu. 
  

 Topic_Begin: Beginning of a repeating bookmark for topics. It can be inserted from 

the Topics submenu on the Outline menu. 
  

 Topic_End: End of a repeating bookmark for topics. It can be inserted from the 

Topics submenu on the Outline menu. 
  

 TopicConcept_Begin: Beginning of a repeating bookmark for concepts. It is inserted 
as part of Concept, with Format Defined in Developer and Concept, or with Format 
Defined in Template on the Topics menu on the Outline menu. 

  

 TopicConcept_End: End of a repeating bookmark for concepts. It is inserted as part 
of Concept, with Format Defined in Developer and Concept, with Format Defined in 
Template on the Topics menu on the Outline menu. 

  

 TopicFrameCount: Inserts the number of frames per topic. It can be inserted from 
the Topics submenu on the Outline menu. 
  

 TopicName: Inserts the topic name, with style defined in this template. It can be 
inserted from the Topics menu on the Outline menu. 
  

 Trigger: Inserts action or condition that triggers the system process as specified in 

the System Process Document section of the Properties toolpane in the Developer. It is 
inserted as part of the Table of Properties on the System Process Document submenu 
of the Topic Properties menu. 
  

 TrueFalseQuestionType_Begin: Beginning of a set of bookmarks for a True/False 
question. It is inserted as part of the Question option on the Questions and 
Assessments submenu of the Outline menu. 
  

 TrueFalseQuestionType_End: End of a set of bookmarks for a True/False question. 
It is inserted as part of the Question option on the Questions and Assessments 
submenu of the Outline menu. 
  

 Url: Inserts a URL link. It must be located between the UrlType repeating tags. It is 
inserted as a part of the Table of Action Steps and the List of Action Steps, both of 
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which are on the Frames submenu of the Outline menu on the toolbar, as well as 

Concept, with format defined in Developer, on the Topics and Modules and Sections 

submenus on the Outline menu. 
  

 UrlType_Begin: Beginning of a repeating bookmark for inserting URLs. It is inserted 

as a part of the Table of Action Steps and the List of Action Steps, both of which are 
on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with 
format defined in Developer, on the Topics and Modules and Sections submenus on 
the Outline menu. 
  

 UrlType_End: End of a repeating bookmark for inserting URLs. It is inserted as a part 

of the Table of Action Steps and the List of Action Steps, both of which are on the 
Frames submenu of the Outline menu on the toolbar, as well as Concept, with format 
defined in Developer, on the Topics and Modules and Sections submenus on the 
Outline menu. 
  

 UserDefinedQuestionType_Begin_End: Inserts the beginning and ending of a 

repeating bookmark for a User Defined Question. 
  

 Version: Inserts the version of the document as indicated in the Version field in the 

Details view of the Developer. It can be inserted from the Details menu. 
  

 Webpage_Begin: Beginning of a repeating bookmark for web pages. It is inserted as 

a part of the Table of Action Steps and the List of Action Steps, both of which are on 
the Frames submenu of the Outline menu on the toolbar, as well as Concept, with 
format defined in Developer, on the Topics and Modules and Sections submenus on 
the Outline menu. 
  

 Webpage_End: End of a repeating bookmark for web pages. It is inserted as a part 
of the Table of Action Steps and the List of Action Steps, both of which are on the 
Frames submenu of the Outline menu on the toolbar, as well as Concept, with format 
defined in Developer, on the Topics and Modules and Sections submenus on the 

Outline menu. 
  

 WebpageImage: Inserts a placeholder for an image in a web page. It is inserted as a 
part of the Table of Action Steps and the List of Action Steps, both of which are on the 

Frames submenu of the Outline menu on the toolbar, as well as Concept, with format 
defined in Developer, on the Topics and Modules and Sections submenus on the 
Outline menu. 
  

 WebpageText: Inserts web page with formatting defined in this template, with the 

exception of the alignment of images. Images reflect the alignment as it is in the 
Developer. 
  
Note: This bookmark is being deprecated in a future release. 

20.8.10 Style Reference 

The following is a list of styles used in the template.   

 Header: Arial, 14 point, Bold; used for the name of the document type in the header. 
  

 Footer: Arial, 10 point; used for the footer text. 

  

 Heading1: Arial 16 point Bold, space before 12 point, space after 3 point, Keep with 

next; used for the Glossary header and all level 1 items in the outline, usually the 
Outline name. Text with this style appears in the Table of Contents. 
  

 Heading2: Arial 16 point Bold, space before 12 point, space after 3 point, Keep with 

next; used for all level 2 items in the outline. Text with this style appears in the Table 
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of Contents. 
  

 Heading3: Arial, 14 point , space before 12 point, space after 3 point, Keep with 

next; used for all level 3 items in the outline. Text with this style appears in the Table 
of Contents. 
  

 Heading4: Arial Bold, space before 12 point, space after 3 point, Keep with next; 

used for all level 4 items in the outline. Text with this style appears in the Table of 
Contents. 
  

 Heading5: space before 12 point, space after 3 point, Keep with next; used for all 

level 5 items in the outline. Text with this style appears in the Table of Contents. 
  

 Heading6: space before 12 point, space after 3 point, Keep with next; used for all 

level 6 items in the outline. Text with this style appears in the Table of Contents. 
  

 Heading7: space before 12 point, space after 3 point, Keep with next; used for all 

level 7 items in the outline. Text with this style appears in the Table of Contents. 

  

 Heading8: space before 12 point, space after 3 point, Keep with next; used for all 
level 8 items in the outline. Text with this style appears in the Table of Contents. 
  

 Heading9: space before 12 point, space after 3 point, Keep with next; used for all 
level 9 items in the outline. Text with this style appears in the Table of Contents. 
  

 procedure: Times New Roman, 11 point, bold. This style defines the formatting of the 

word “Procedure”. This text does not appear in the Table of Contents. 
  

 infoblock: Times New Roman, 11 point; used for formatting the icon for the frame-

level attachments. 
  

 highlighttext: Times New Roman, 11 point, 12.5% shading; used for highlighting the 

text in the action steps, such as Go to step and End of Procedure. 
  

 titlepagetitle: Times New Roman, 16 point, Bold centered. This style is used for the 
Title on the Title Page of the Training Guide and the Instructor Manual. 

  

 titlepagedate: Times New Roman, 14 point, Bold centered. This style is used for the 
date on the Title Page of the Training Guide and the Instructor Manual. 
  

 Leadintext: Times New Roman, 11 point. This style is used for all lead-in text 
information. 
  

 Steptext: Times New Roman, 11 point. This style is used for the text that appears in 

the action steps. 
  

 Glossarytext: Times New Roman, 11 point. This style handles the definitions of the 

words in the glossary section. 
  

 Glossaryword. Times New Roman, 11 point, Bold. This style handles the glossary 

words (may or may not be a style). 
  

 AFORWARD: Arial 18 Small caps. This style formats the "Copyright & Trademarks" 
text. 

  

 tocheader: Times New Roman, 20 point. This style formats the text “Table of 
Contents”. 
  

 TOC1: Times New Roman, 12 point, Bold, 6 point space before. This is the first level 
heading that appears in the Table of Contents. All items that are Heading1 style 
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appear in the TOC using this style. 

  

 TOC2: Times New Roman, 11 point, Bold, 6 point space before, Indented left 0.15". 
All topics that are H2 style appear in the Table of Contents using the TOC2 formatting. 
  

 TOC3: Times New Roman, 10 point, Indented left 0.30". All topics that are H3 style 
appear in the Table of Contents using the TOC3 formatting. 
  

 TOC4: Times New Roman, 9 point, Indented left 0.45". All topics that are H4 style 

appear in the Table of Contents using the TOC4 formatting. 
  

 TOC5: Times New Roman, 9 point, Indented left 0.60". All topics that are H5 style 

appear in the Table of Contents using the TOC5 formatting. 
  

 TOC6: Times New Roman, 9 point, Indented left 0.75". All topics that are H6 style 

appear in the Table of Contents using the TOC6 formatting. 
  

 TOC7: Times New Roman, 9 point, Indented left 0.90". All topics that are H7 style 
appear in the Table of Contents using the TOC7 formatting. 

  

 TOC8: Times New Roman, 9 point, Indented left 1.05". All topics that are H8 style 
appear in the Table of Contents using the TOC8 formatting. 
  

 TOC9: Times New Roman, 9 point, Indented left 1.20". All topics that are H9 style 
appear in the Table of Contents using the TOC9 formatting. 

20.8.11 Modify the Header or Footer 

One of the most common items to customize is the header and footer of any of the document 
types. You can change the logo, insert any Microsoft Word fields, or add static text. Note that 
you cannot insert bookmarks from the toolbar in the header or footer, only standard Word 
fields such as page number or document name. If you do put bookmarks in the header or 

footer, they are not processed and appear as static text in the published document. 
 

Change the Logo in the Header 

Each print document displays a default logo in the header. The graphic is embedded in the 
Microsoft Word template. You can use the copy and paste functions within Microsoft Word to 
embed your logo graphic. Be sure to size the graphic properly so that the header is not 

stretched out of proportion. 
 
Note: You can also use the Customize Logo tool in the Developer to replace the logo. If you 
use this tool, the logo should be no larger than 230x44 pixels. 
 

Add the Document Name to the Footer 

You can add the document name to the footer of the document using a Microsoft Word field. 
In the PrintTemplate.docm file, choose Quick Parts from the Insert ribbon and select Field. 
Select FileName from the Field Names list. 

20.8.12 Check Syntax 

After you have made your changes to the PrintTemplate.docm file, it is highly recommended 
that you check the syntax. This tool checks: 

 For repeating pair omission: The begin or end half of the pair was found, but not the 

other half. Check that the tag exists and that the bookmark name is spelled correctly. 
   

 For begin and end tags in the wrong order: The end tag appears before the begin tag 
for the same repeating pair. Delete the pair and insert them in the correct order. 

The syntax checker starts at the beginning of the file. When it encounters an error, the check 
Syntax dialog box opens with an explanation of the error that was found, and the error is 
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highlighted in the document. Make the correction, close the Check syntax dialog box, and start 
the syntax checker again. Repeat this process as necessary to find and correct all errors. 

 
Note: The syntax checking process is manual; it does not happen automatically when the 

document is saved. 

20.8.13 Control the Size of Images and Hotspots 

The print template contains placeholders that control the size of images in web pages, images 
in packages linked to concepts, and the screenshots that appear in the steps of the procedure. 
The placeholders determine the maximum size of the image; if the image is larger, it is sized 
down to fit. If the image is smaller than the placeholder, it is simply inserted in the document; 
it is not sized up to fit. If you want to allow the images to be larger or make them smaller than 
the default size of the placeholder, resize the placeholder. Note that Microsoft Word does not 

allow either the horizontal or vertical dimension of a graphic to be larger than the margins of 
the page. 
  
There are placeholders in the steps of the procedure for the images which contain the action 

area, or hotspot, for the step. If the action area is larger than the placeholder, the image is 
not included in the document; there is no resizing. If you want to allow for larger action areas, 

you can resize the placeholder. 
  
There are also placeholders in the steps of the procedure for images which contain the print 
area for the step, if one exists. This placeholder allows for a larger area than the action area. 
In addition, if the image for the print area is larger than the placeholder, it is scaled down to 
fit. 

20.9 Customize Logos by Category 
Although you can manually customize the logo in each publishing style such as the Player, the 
Presentation, and the document formats, you can also globally change the logo in all 
publishing styles and languages for a specific category in the Library.  
 
You should always make a copy of original publishing styles installed with the software before 

you make any modifications. Also consider adding a new category in which to store the 
customized publishing styles. When you publish content, make sure you choose the 

appropriate category that contains the customized publishing styles. 
 
Note: If you create custom publishing styles, you should document your customizations so 
you can easily re-apply them, if necessary, after a software upgrade. 

20.9.1 Use the Customize Logo Tool 

To customize logos globally for all publishing styles in a category, you can use the Customize 
Logo command on the Tools menu. This command prompts you to choose a category of 

publishing styles and an image file. You can choose to replace the default logo with any image 
in .gif, .bmp, .jpg, .jpeg, .tif, or .png file format. The Developer converts and renames it to 
small_logo.gif, and replaces all instances of small_logo and large_logo in all output styles for 
the selected category. This process overrides any existing graphics that are in the existing 

publishing styles. 
 
Note: The image that you use is not resized, cropped, or otherwise edited. You should use an 

image of the recommended pixel size (230W x 44H). 
  

 Multi-user Considerations 

 For changes to be made to a document using this tool, the document must be checked 

out. If you plan to use this tool offline, you should check out all affected documents 
before going offline. 
  
When you execute this process, the Developer searches through all of the documents 
in the selection, regardless of their check in/out state. If a change is necessary and 
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the document is not checked out and if you are working online, the Developer 

automatically checks the document out to you and makes the change. If the document 

cannot be checked out, for example, if it is open in another editor or checked out to 
another user or you are working offline, it is skipped. At the end of the process, a 
summary message appears with a link to an activity log. Clicking the View activity log 
link in the message displays a list of the documents that were checked out to you 
during the process and those that could not be checked out. After you save any 

changes, you should check in the documents to make them available to other authors 
and add the changes to the Developer's version control system. 
  
Also note that you must have Modify permission to the folder where the publishing 
styles (or project documents) are stored for the category you select to successfully 
change logos. 

To globally customize logos for a category of publishing styles: 

1. On the Tools menu, choose Customize Logo. 

  
2. Select a category or accept the default. 

  
3. Browse to the location of the image file and select it. 

  
4. Click Open to add the image. 

  
5. Click OK to process the changes. When the process is complete, you can view the 

activity to determine the changes that were made. 
  

6. Click OK to close the Update dialog box. 

20.10 Command-Line Publishing 
You can launch the publishing process from a command line. This allows you to create a batch 

publishing task that can be scheduled and run automatically at a time when the server or 
network is not as busy, such as at night or on the weekend. 
 
You must publish content first to create a publishing task. This creates a folder structure and 
at least three files that are needed for command line publishing. The selection.xml, 
publishing.project.xml and at least one configuration (<format_guid>.config.xml) files are 
created at the root of the destination folder. 

 
The selection.xml file contains a list of the documents to publish, the publishing.project.xml 
contains global parameters that apply to all publishing formats and a list of all configuration 
files (<format_guid>.config.xml) - one for each output format. The <format_guid>.config.xml 
contains the parameters that apply to a particular format. 
 
The output from command line publishing is stored in the same location as it would be if the 

publishing process was launched from within the Developer. 

20.10.1 Use Command-Line Publishing 

To use command-line publishing, you create a command line in the following format:  
 

\path\commandlinepublish <settings> /profilename:<profile_name>  

 
or 
 

\path\commandlinepublish <settings> /profile:<profile_path>  

 

You can use either the profilename or profile parameter; you do not need to use both. The 
password parameter is optional. See the descriptions below for details. 
 



  Publish Content 

   475 

<settings> 
Path to the destination folder for the published content where the selection.xml and the 

Publishing.Project.xml are located. You do not need to specify a file; the path is enough. 
 

/profilename 
The name of the user profile to use for the publishing process. This profile must exist in the 
UserProfiles folder of the computer on which the publishing job is being run and the password 
must be stored with the profile. 
 
/profile 
The path and file name of a user profile, such as \path\<profile>.xml. If this is not an absolute 

path, it is interpreted as a path relative to the publishing utility's folder. Use this parameter to 
specify a profile that exists outside of the UserProfiles folder. The password must be stored 
with the profile. 
 
You must put the path for the commandlinepublish.exe file in the batch file, or issue a 
command to change into the appropriate directory first. The commandlinepublish.exe must 

reside in and be executed from the folder where the Developer is installed. In addition, the 

location where the Developer is installed and the destination location for publishing must be in 
accessible locations. 
 
Note: If the path to the commandlinepublish.exe or the settings file contains spaces, you 
must enclose the entire path in quotes. 

20.10.2 Execute Batch Publishing 

You can execute multiple publishing jobs in a batch. Each job must be on a separate command 

line in the batch file. 
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21 Export/Import Content 
You can exchange content between libraries and database servers and create backup copies of 
your content using export and import. When selecting content to export, you can choose a 
single document or folder, a selection of related documents, a collection of folders, or even an 
entire Library. The export process creates a single archive file that contains all of the 
documents included in the selection. Import adds all of the contents of an archive file to your 

Library, including their folder structure. If any errors occur during either process, they are 
written to an activity log, which is available for viewing upon completion of the process. 
 
The export/import functionality allows you to: 

 Deliver content to your clients, allowing them to import it into their own libraries on 
their own servers and modify it further 
  

 Share and/or combine content among multiple developers working in single-user 
environments 
  

 Modify publishing styles 

  

 Share content defaults 

  

 Localize content 
  

 Share (Import/Export) sound files 
  

 Prepare a backup archive of your current content that can be imported back into the 
same Library for content restoration or recovery if necessary 

Note: Use of export/import as a means of backing up your content is especially recommended 

for single user installations, as this type of installation does not include version control. 
 
The export command is available only from the Library and Outline Editor, whereas import is a 
global menu command. Both commands are invoked from the Tools menu. 
 
All document content in the Library, such as modules/sections, topics, web pages, glossaries, 

style sheets, roles, questions/assessments, publishing styles, and so on, can be exported and 
hence imported as well. Included with each exported document are its embedded document 
properties, such as document name and language, as well as information about its links to 
other documents and its location within the folder structure of the Library. This information is 
included in the export archive even if the folders and/or the targets of the links themselves are 
not. Likewise, the folder structure is recorded in the export archive even if no folders are 
selected for export. The links and folder structure are rebuilt upon import as needed. 

 

 Multi-user Considerations 

 Unlike embedded document properties, external document properties are not included 
in the export of a document. These properties, such as State, are generally workflow-

related and are stored on the server rather than as part of the document. When you 
import a document into a new Library, you must reset these properties as needed. 
  
Also excluded from export, and therefore import, are document history and deleted 
documents. As a result, export/import provides only a partial backup in a multi-user 
environment. Therefore, you should use export and import for backup only as a 

supplement to your standard server backup procedures. 
  
Folder permissions are not exported. 
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You can export and import whether online or offline. To export while offline, you must 
have the documents in your local cache. If you import while offline, you should check 

in the imported documents the next time you are working online, to make them 
available to other authors and add any changes to the Developer's version control 
system. 

21.1 Export Content 
Export, in combination with import, allows you to exchange content between libraries and 
database servers and create backup copies of your content. You can export your content from 
either the Library or the Outline Editor. An advantage of exporting from the Library is that you 
can choose a wider range of content to export by selecting multiple folders or multiple 
documents that are not necessarily linked to each other. In fact, you can export your entire 
Library by selecting the root folder. 
 

Tip: You can back up all or part of your Library using the export command. Select the root 
folder of the Library to export and backup your entire Library. 
 

Exporting from the Outline Editor allows you to easily select all or part of a specific outline for 
export. However, you cannot select unrelated documents or multiple, independent outlines 
from the Outline Editor. 

 
Tip: You can select multiple documents in the Library using the standard Windows selection 
keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All 
from the Edit menu. 
 
After selecting content and initiating the export process, your next step is to set the export 
options. 

 
The first option is the location in which to save the export archive. The default location is the 
My Documents folder on your local hard drive, but you can choose any other location on your 
computer or server for which you have Write permissions. You must also specify a name for 
the archive file, which has the extension odarc. 

 
The second option allows you to export your selection only or your selection and all related 

documents. In general, documents linked as children of the documents in your selection are 
included as related, whereas those linked as parents are not. Click the View related documents 
link to display a list of all documents related to your selection. 
 
Note the following points about related documents as applied to export: 

 If the selection is a folder, related documents include all documents related to the 

documents contained in the folder, regardless of where they are located in the Library. 
The folder structure of the related documents is recorded in the archive file as well. 
  

 Any glossary assigned to a document selected for export is included as a related 

document, along with all packages and web pages used for definition links. 
  

 When you export a glossary document directly (by selecting it from the Library), its 
related documents include all packages and web files used for definition links. 

Documents to which the glossary is assigned are not included as related documents. 
  

 Any style sheet assigned to a document selected for export is included as a related 
document. When you export a style sheet, documents to which a style sheet is 
assigned are not included as related documents. 

 If topics contain overlays, the topic export includes the PowerPoint overlay files 
(Overlay.pptx) and a folder named Original with the original topic screenshots. 
   

 Icon packages (both standard and custom) are included as related documents of topics 

containing frame links. 
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 Questions or assessments (including all questions in the assessment) are included as 

related documents for export. 

  

 Role lists are not included as related documents for export. However, roles assigned to 

each topic are included, because they are part of the topic's properties. If you wish to 
export a role document, you must explicitly select it from the Library. 
  

 Custom-recorded sound is saved as part of its topic and is therefore included when the 

topic is exported. 
  

 Web page sound is exported when it is part of the selection or related documents, or is 

part of a frame link concept. 
  

 Templates are not included as related documents for export. To export a template, 
you must select it directly from the Library (System/Templates folder). 

  

 Packages containing template and object name sound are not included as related 

documents of templates. To export these packages, you must select them directly 
from the Library (subfolder of the System/Templates folder). Alternatively, you can 

select the parent folder to export the template and associated sound together. 
  

 Packages, role documents, and templates do not have related documents. 

 Multi-user Considerations 

 In a multi-user environment, when you are online, you also have the option to choose 
local or server content. Local content includes the locally edited copies of all selected 
documents that you have checked out and the server versions of those not checked 
out to you. Use this option for documents in progress for review. Server content 
includes only the checked in versions of the selected documents. Any local changes to 
checked out documents are ignored. Use this option for final versions of documents. 

  
Also note that you can export while offline, but to do so, you must have the 
documents in your local cache. 

During the export process, all of the selected content is written to a single compressed archive 
file with the extension odarc. The archive file also includes the absolute Library folder 
structure for each document, as well as information about all links to and from the documents. 
A summary message appears if some of the documents you selected could not be processed. 
Clicking the View Activity Log link in the message displays a list of the results for each 
document. 

 
Note: A utility exists to uncompress and recompress odarc archives, if you need to work with 
the constituent files outside the Developer. See Understand Developer Archives for more 
information. 
 

Selecting Cancel during the export process displays a message with a link to a list of the 
documents that have already been exported. Although the partial archive file resulting from 

the cancelled process is not deleted automatically, this archive file is unusable and cannot be 
successfully imported. In addition, you cannot continue an export process that has been 
cancelled, and you cannot add to an existing archive file. To obtain a usable archive file in this 
case, you must restart the process from the beginning. 
 

To export content: 

1. From the Library or Outline Editor, select the folder(s) and document(s) you want to 

export. 
  
You can select multiple documents using the standard Windows selection keys 
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(CTRL+click and SHIFT+click). 
  

2. On the Tools menu, point to Export and choose Documents. 
  

3. Set the export options. 
  

4. Click Export to execute the process. 
  
The export tool analyzes and processes the selected documents, creating a single 
archive file in the specified location. 
  

If any errors occur, they are written to an activity log, and a Partial Export message 
box appears. You can click the View Activity Log link to view the results of the export 
or click OK to close the message box. 

21.2 Import Content 
Import, in combination with export, allows you to exchange content between libraries and 

database servers and restore backup copies of your content. You can import a content archive 
file from the Tools menu. 
 

When importing, you can select an archive file(s), identified by the extension odarc. The 
Developer validates the archive structure when you initiate the import process. Therefore, you 
cannot choose to import only specific pieces of an archive; you must import the entire archive 
as a unit. 
 
Next, you specify the Library location into which the contents of the archive are to be 
imported. You can browse to select an existing folder or type a new folder name, including 

Library path if necessary, to create a new folder for the imported material. 
  
Finally, you have the option to overwrite existing documents or not. You should choose the 
overwrite option if the archive contains updated versions of documents that are already in 
your Library. In contrast, you might choose not to overwrite existing documents to import only 

new documents from an archive containing some documents that are new and some that are 
already present in your Library. Skipping the existing documents in this way speeds the import 

process. 
 
In general, the import process writes the contents of the archive file to your Library in the 
selected location, re-creating the documents and their Library structure as necessary, as well 
as links to and from the documents. A summary message appears if some of the documents 
you selected could not be processed. Clicking the View Activity Log link in the message 

displays a list of the results for each document. 
 
The specific results of importing an archive depend on the contents of the archive, the existing 
contents and structure of the Library, and the specified import options, as detailed next. 

 The Library folder structure represented in an archive corresponds to the absolute 
folder structure relative to the root of the Library from which the archive was created. 

During import, this folder structure is created relative to the import location specified 

in the Import dialog box. Therefore, to exactly reproduce the folder structure of the 
Library from which the archive was created, you should select the root ("/") as the 
import location. 
   

 If the Library folder structure represented in an archive already exists in the specified 

import location, the contents of the archive folders are written to the existing Library 
folders, which has the net effect of merging the corresponding folders. Otherwise, the 
archive folder structure is created in the specified location. 
   

 For the purpose of overwriting during import, documents are identified solely on the 

basis of Document ID, not title, language, or any other document property; location in 
the Library is also not important. Therefore, for a given document in an archive, the 
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following three situations can arise: 

  

No document with the same ID exists in the Library - The new document is created in 
the specified import location. 
  
A document with the same ID exists in the Library but overwrite is not selected - The 
archive document is skipped. 

  
A document with the same ID exists in the Library and overwrite is selected - The 
document is overwritten in its current Library location, regardless of the selected 
import location. That is, documents are never moved within the Library when they are 
overwritten during import. 
   

 For the purpose of re-creating links during import, documents are again identified 

solely on the basis of Document ID; location in the Library is not important. Therefore, 
if a document links to a child document with a given ID and a document with the same 
ID as the child already exists in the Library (or is imported at the same time as the 

parent), the link is re-created. If no such child document exists, a broken link results. 

   

 If the imported content includes new documents that were stored in the System 
folder, the new documents are always imported into the System folder and not in the 
folder specified for the import. 

The following information summarizes the results of import for different combinations of 
import options: 

 New content with new folder structure 
Overwrite: NA 
Results: New folder structure is created in the specified Library location; new 
documents are created in these folders 
   

 New content with existing folder structure and root folder selected as the import 

location 
Overwrite: NA 
Results: New documents are created in the existing folder structure (the folders are 
merged). 
   

 Existing content with new or existing folder structure 
Overwrite: No 
Results: Existing documents that are not overwritten are not imported. 
  

 Existing content with new or existing folder structure 
Overwrite: Yes 
Result: Existing documents are overwritten in their current Library locations. 
  

 Mixture of new and existing content with new or existing folder structure and the root 
not selected as the import location 

Overwrite: Yes 
Result: New folder structure is created in the specified import location, and new 

documents are created in these folders; existing documents are overwritten in their 
current Library locations. 
  

 Mixture of new and existing content with existing folder structure and the root selected 
as the import location 

Overwrite: Yes 
Result: Existing documents are overwritten in their current Library locations, and new 
documents are created in the existing folder structure. 
  

 Selecting Cancel during import stops processing after completion of the current 

document and displays a message with a link to a list of the documents that have 



  Export/Import Content 

   481 

already been imported. Click the View Activity Log link in the message to display a list 
of the results for each document. 

Also note that, during import, the Developer identifies all roles used in the imported content. 
It then compares these roles to the master role list of the same language. If any of these roles 
is not included in the appropriate master role list, the Developer attempts to add the role to 
the role list. If the role cannot be added to the list, for example, if the master role list is open 

in an editor, the role is still kept in the content but is not included in any role list. You can 
later update the master role list to include these roles, if desired. 
 

 Multi-user Considerations 

 For a document to be overwritten during import, it must be checked out. Therefore, 
before initiating the import process, you should ensure that any documents that must 
be overwritten are either checked out to you or checked in to the server. If you plan to 
import an archive while offline, you must check out all such documents before going 
offline. 

  
However, if a document that needs to be overwritten is not checked out and you are 

online, the Developer automatically checks the document out to you and replaces it 
with the corresponding document from the archive. If the document cannot be 
checked out, for example, if it is open in another editor or checked out to another 
user, it is skipped. 
  
Note that, if a document in the archive existed in the Library but had been deleted, 

overwriting moves the document from Deleted view to Library view, thus restoring the 
document. The document is restored in its original location, regardless of the selected 
import location. 
  
Also note that, if the Developer needs to add roles to a master role list during import, 
this master role list must be checked out. If the role list is not checked out and you 
are online, the Developer automatically checks it out to you and adds the necessary 

roles. If the role list cannot be checked out, for example, if it is open in an editor or 
checked out to another user, the roles are kept in the imported content but are not 
added to the role list. You can later update the master role list to include these roles, if 
desired. 
  
After you complete the import process, you should check in all affected documents 
(new and overwritten) to make them available to other authors and add the changes 

to the Developer's version control system. If a document was overwritten, its version 
number is incremented only if its contents have changed. That is, if a document in the 
archive was identical to the same document already in the Library, overwriting on 
import does not affect the document's version history. 

To import content: 

1. On the Tools menu, point to Import and choose Documents. 

   
2. Type the name and location of the .odarc file to import or browse to the file(s). 

  
You can select multiple files using standard multi-select keys (Ctrl-click or Shift-click). 
   

3. Type the destination location of the .odarc(s) or browse to the location. 

   
4. Check the Overwrite existing documents box if you want to overwrite existing 

documents of the same name with the imported documents. 
   

5. Click Import to execute the process. 
  
The import tool analyzes and processes the selected archive, adding the archive 
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documents and re-creating their relative folder structure in the specified Library folder. 

  

If any errors occur, they are written to an activity log, and a Partial Import message 
box appears. You can click the View Activity Log link to view the results of the import 
or click OK to close the message box. 

Note: When importing multiple .odarc files of the same name, files are imported in the order 
of the date they were created. This insures the .odarc that was created last overwrites earlier 
versions if the Overwrite existing documents box is checked. 

21.3 Export and Import Sound Files in Bulk 
While you can work with sound files individually while recording a topic or in the Sound 
Properties pane from within the Developer, you can also work with them outside of the 
Developer. To do this, you export and import the sound files in bulk. Exporting the sound files 
creates a central location for the files, with the appropriate folder structure. After you have 
created or edited the files, you can them import them back in to the Developer easily. 

  
The process consists of three overall steps: 

 Export the files: This creates a central location where the sound files are stored as 
.wav files. 
   

 Create or edit the files: Using external tools, edit existing sound files or create new 

ones. The sound report, created during export, lists the existing and missing files. 
   

 Import the files: This imports the sound files from the external location back in to the 
appropriate topics or web pages in the Developer. 

21.3.1 Export Sound Files in Bulk 

Sound files can be exported from the Outline Editor or the Library. When exporting sound files, 

you select the location for the exported files. By default, the files are exported to 

\MyDocuments\<brand>\Sound. The export process creates two folders within the Sound 
folder. The Bubble folder contains the topic sound files, and the WebPage folder contains the 
web page sound files, web pages exported as HTML files, images embedded in the web pages, 
linked packages with all package files, and the CSS file and custom bullet images for linked 
style sheets. Within each of these folders, there are folders named with the GUID of the topic, 
web page, package, or style sheet.   
  

The export process also creates a Sound Report as an .html file. This report provides 
information about each exported sound file and is useful in identifying missing sounds that 
need to be created. The report can be used as a map to quickly record all the necessary 
sounds outside of the Developer and then they can be imported back to the proper location in 
the content. Bubble sound and web page sound are listed separately on the report.  You can 
specify if the sound report contains all sounds related to See It!/Try It! modes or Do It! mode 
only. 

  

When you export sound, the resulting Sound Report includes bubble text in the report table 
and links to the web pages. Scrollbars are added as needed to insure the text fits in the Sound 
Report cells. Graphics are not exported for bubble text. 
 
Web page sound is exported if it is included in a selection or if it is part of the related 

documents. Web page sound that is linked to a frame using the Frame Link toolpane in the 
Topic Editor is also exported. A link to the sound for a web page appears in the sound report, 
and when you open an exported web page, the link also appears in a File Details table at the 
bottom of the HTML file.  
  
Frame links to content outside of the Developer are not exported. Web page links to content 
outside of the Developer open in a new browser window or tab. 
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Note: You can export sound files on a frame by frame basis from the Topic Editor. See Export 
a Sound File for more information. 

 

 Multi-user Considerations 

 In a multi-user environment, when you are online, you have the option to export local 
or server content. Local content includes the locally edited copies of all selected 
documents that you have checked out and the server versions of those not checked 
out to you. Use this option for documents in progress for review. Server content 

includes only the checked in versions of the selected documents. Any local changes to 
checked out documents are ignored. Use this option for final versions of documents. 
  
Also note that you can export while offline, but to do so, you must have the 
documents in your local data storage location. 

 To export sound files: 

1. On the Tools menu, point to Export and choose Sound. 

  
2. Choose whether you want to export related documents, server or local content, and 

the text for See It!/Try It! or Do It! modes. 
  

3. Click Export. 

21.3.2 Use the Sound Report 

The Sound Report.html provides information about each exported sound file. It is useful in 
identifying missing sound files that need to be created or locating sound files that need to be 

edited. Bubble sound and web page sound are listed separately on the report. One of the 
options during export allows you to specify whether the Sound Report has the text for See 
It!/Try It! mode or Do It! mode. 
  

The Sound Report has several columns: 

 Document: The name of the topic or web page. 
   

 Text: The HTML formatted bubble text or links to web page text, as appropriate. You 
can record the entire text or paraphrase it when recording sound. 
   

 Sound File Name: The name of the .wav file for the sound. If the name is 

sound.wav, the sound is for a web page. If the name is Intro.wav, End. wav, or a 
number .way, for example, 12.wav, the sound is for the bubble in a topic. 
   

 Location: The location where the sound file is stored or should be stored. The link 

also indicates whether the file belongs in the Bubble folder or the WebPage folder. You 
can click the link to open the correct folder for the file. 

   

 File Exists?: Indicates whether the file has already been created. 

21.3.3 Import Sound Files in Bulk 

Once you have finished editing or creating sound files, you can easily import them back in to 
the Developer. Select the root folder of your audio files and import the entire sound folder 
structure. Topic sound is imported from the Bubble folder and web page sound is imported 
from the WebPage folder. Upon completion of import, an activity log is generated showing the 
import status, file names and locations where the files where imported. 
 
Note: You can import sound files on a frame by frame basis from the Topic Editor. See Import 

a Sound File for more information. 
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To import sound files: 

1. On the Tools menu, point to Import and choose Sound. 

  
2. Indicate whether you want it to overwrite existing files. 

  
3. Click Import to execute the process. 

  
The import tool analyzes and processes the selected archive, copying the sound files 
into the appropriate locations in the Library. When the import is complete an Import 
Sound Complete dialog box opens with a View Activity link to see what was imported. 

21.4 Extract a Developer Archive 
If you plan to edit any of the documents contained in an archive, you must first extract the 
archive file. To do this, you use the command-line utility OdArc. After saving your changes to 

the documents, you use the same Odarc utility to recompress the archive so that it can be 

imported.  
 
Odarc is stored in the directory in which the Developer is installed. Therefore, you must 
change to this directory in order to execute OdArc.exe from the command line. 
 

The syntax for extraction is as follows: 
 

odarc /x <archive_path> <destination_folder>  

 
where 

 <archive_path> is the filename, including absolute path, of the archive to be 
extracted 
  

 <destination_folder> is the location for the extracted files 

During archive extraction, the OdArc utility processes the selected archive and writes its 
contents to the specified location in the form of an archive manifest and a collection of folders 

for the documents contained in the archive. Because the functioning of the archive depends on 
its relative structure, you should always extract each archive to a clean, empty folder, so that 
the folder contains only the extracted archive files. This destination_folder location can be a 
subfolder of the directory containing the archive to be extracted, or it can be a completely 
different location. However, you should not extract an archive into the same folder in which 
the archive itself is located. 
 

As an example, consider a Developer archive file named "test.odarc" that was exported to the 
"temp" directory at the root of the local computer and is to be extracted to a subfolder named 
"extract" in the same directory, the command line should read: 
 

odarc /x c:\temp\test.odarc c:\temp\extract  

 
Tip: As with all command-line utilities, you must enclose folder names and paths in double 
quotation marks (") if they include spaces. For example, if the archive mentioned above had 
been exported to a folder named "export" on the desktop of the local computer, the command 
line should read: 
 
odarc /x “c:\documents and settings\userid\desktop\export\test.odarc” 

“c:\documents and settings\userid\desktop\export\extract”  

21.5 Understand Developer Archives 
The export process writes all of the selected content to a single compressed archive file with 

the extension odarc. The import process then takes a single odarc file as input to re-create the 
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contents of the archive in the current Library. Therefore, to exchange documents between 
libraries, you need not open any archive files. However, if you plan to edit any documents 

contained in an archive outside the Developer, you need to extract the archive and understand 
its structure and contents. When you are done making your changes, you must then 

recompress the archive to make it available for import. See the Extract a Developer Archive 
and Recompress a Developer Archive topics in the Import/Export Content chapter for more 
information. The overview of Developer archives provided here can help you determine which 
files you need to edit to make your desired changes. 
 

Each archive file consists of several components representing the documents it contains and 
their relative structure. In particular, the archive consists of an archive manifest and a folder 

for each document, labeled with the Document ID. The manifest lists all of the Library folders 
and documents included in the archive, and each document folder in the archive contains all 
necessary information and files required to re-create the document in the Developer upon 
import. The specific contents of each archive folder therefore depend on the type of document, 
as summarized later in this section. 
 

Manifest File 
The manifest file, manifest.xml, begins with a list of the Library folders making up the absolute 
Library paths of all documents in the archive. The manifest then lists each document, along 
with several properties, including absolute Library path, Document ID, title, type, and 
language. The schema used to render the document type upon import is also included. 
 

The manifest file therefore functions as a table of contents for the archive, defining the 
documents it contains and their relative folder structure. Upon import, the Developer reads the 
manifest and verifies that appropriate archive folders exist for all documents listed therein. All 

of the documents specified in the manifest must be present for the archive to be imported. 
This manifest information then directs how the archived documents are re-created during 
import from the contents of the archive folders. 
 

Warning! Do not rename or delete any of the files and folders contained in a Developer 
archive, as this renders the archive unusable. 
 

Module/Section Archive Folder 

The archive folder for each module and section contains the following three files: 

 section.xml: List of several properties of the module/section, including document 
schema, template, glossary (if assigned), screen resolution, and directly linked 
children 
  

 linksto.xml: List of Document IDs of all documents directly linked as children of the 
module/section, as well as the template and glossary (if assigned) 
  

 search.xml: Search proxy file used to speed text search, spell checking, and glossary 
markup in the Developer 

Topic Archive Folder 

The archive folder for each topic contains the following three files, as well as a varying number 

of graphics files depending on the number of frames in the topic: 

 topic.xml: List of several properties of the topic, including document schema, 
template, glossary (if assigned), screen resolution, play modes, and topic context; 

also includes detailed information specific to each frame of the topic, such as 
screenshot file name, action, hotspot, and custom bubble text 
  

 linksto.xml: List of Document IDs of all linked attachments and link icons, as well as 

the template and glossary (if assigned) 
  

 search.xml: Search proxy file used to speed text search, spell checking, and glossary 
markup in the Developer; includes all searchable text in the topic, such as bubble text, 
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keywords, and decision frame text 

  

 n.png: Graphics files containing screenshots for all frames, numbered in the same 
order as the frames in the Frame Structure window of the Topic Editor 

Package Archive Folder 

The archive folder for each package contains the following subfolder: 

 Parts subfolder: Contains all package files and folders, if applicable 

Web Page Archive Folder 

The archive folder for each web page contains the following three files and one subfolder: 

 webpage.xml: List of properties of the web page, including document schema and 
glossary (if assigned) 
  

 linksto.xml: List of Document IDs of any packages or other web pages linked through 

hyperlinks inserted in the web page; also includes glossary (if assigned) 
  

 search.xml: Search proxy file used to speed text search, spell checking, and glossary 

markup in the Developer; includes all searchable text in the web page, such as visible 
text and hyperlink tooltips 
  

 Parts subfolder: Contains index.html, the web page document itself; also contains an 
images sub-subfolder for embedded graphics, if used in the web page 

Note: Images inserted in a web page from a package are represented in index.html by the 

"file not available" indicator . However, the link to the package graphic is maintained and 
is restored upon import as long as the web page was exported with its related documents or 
the same package already exists in the new Library. 

 
Images inserted in a web page from a URL remain linked and visible in index.html. 
 

Glossary Archive Folder 

The archive folder for each glossary document contains the following three files: 

 glossary.xml: List of glossary terms, including Document IDs or URLs of definition 
links, tooltips, and matching conditions (match whole word, match case) 
  

 linksto.xml: List of Document IDs of packages and web pages used as definition links 
(does not include URL definition links) 
  

 search.xml: Search proxy file used to speed text search, spell checking, and glossary 
markup in the Developer; lists text of all glossary terms and tooltips 

Role Archive Folder 

The archive folder for each role document contains the following file: 

 roles.xml: List of the roles included in the role document 
  

 search.xml: Search proxy file used to speed text search, spell checking, and glossary 
markup in the Developer; lists text of each role 

Template Archive Folder 

The archive folder for each template contains the following two files: 
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 template.xml: Detailed listing of all template components, such as context-specific 

template bubble text and associated sound files 

  

 template.xsl: Style sheet transformation file for processing the template 

Publishing Style Archive Folder 

The contents of the archive folder for a publishing style depend on the specific output format 
selected. In general, each publishing style includes files with instructions for executing the 

publishing process (the two most important being project.xml and style.xml), as well as 
components needed to build the output. Also included are settings for the publishing style in 
the Developer Publishing Wizard and options pages. 
 

The types of components included in a publishing style vary depending on whether the 
selected publishing format is a document or Player output. For example, styles for document 
outputs include document templates, as well as logos, style sheets, and style sheet 

transformation files. Styles for Player-type outputs require many more components, including 
style sheets and associated transformation files, graphics and icons, framesets and default 

frame pages, and JavaScript programs for managing Player-specific functions such as 
displaying attachments. 
 

See the Customize Publishing Styles topic in the Publish Content chapter for more information. 

21.6 Recompress a Developer Archive 
After making changes to documents extracted from an archive, you must recompress the 

archive to prepare it for import. To do this, you use the same command-line utility as used for 
extraction, OdArc.exe.  
 

OdArc.exe is stored in the directory in which the Developer is installed. Therefore, you must 
change to this directory in order to execute OdArc.exe from the command line. 
 

The syntax for compression is as follows: 
 

odarc /a <source_folder> <archive_path>  

 

where 

 <source_folder> is the location of the extracted files 
  

 <archive_path> is the filename, including absolute path, of the recompressed archive 

During archive recompression, the OdArc utility processes all files contained in the 
source_folder location and uses them to create the specified Developer archive file. Therefore, 
you cannot recompress an archive to the source_folder location or any subfolder thereof, as 
this would create a loop in which the utility was essentially trying to compress the archive into 
itself. In addition, because the functioning of an archive depends on its relative structure, you 
should not remove files/folders from or add files/folders to the directory containing an 
extracted Developer archive, as the archive obtained upon recompression is unusable. In 

general, this means that you should extract each archive to a clean, empty folder; edit the 
extracted files in place; and then recompress the archive from the same folder. 
 

As an example, consider a Developer archive file named "test.odarc" that was exported to the 
"temp" directory at the root of the local computer and then extracted to a subfolder named 
"extract" in the same directory. To recompress this archive back to its original name and 
location, the command line should read: 
 

odarc /a c:\temp\extract c:\temp\test.odarc  
 

Note that the name and path of a recompressed archive do not need to match those of the 
original archive. For example, you might use a name to indicate that the archive had been 
edited, such as "test_edited.odarc" in the above example. 
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Tip: As with all command-line utilities, you must enclose folder names and paths in double 

quotation marks (") if they include spaces. For example, if the archive file mentioned above 

had been extracted to a subfolder named "extract" within the folder "export" on the desktop of 
the local computer and was being recompressed to a folder named "edited archives" in the 
same location, the command line should read: 
 

odarc /a “C:\Documents and Settings\userID\Desktop\export\extract”  

 
“C:\Documents and Settings\userID\Desktop\export\edited 

archives\test.odarc” 

21.7 Import a New Topic from Record It! 
Record It! is a standalone application designed to provide anyone with the ability to create 
recorded content that can be imported into the Developer. Record It! allows you to easily 
record the necessary steps to complete any software transaction complete with sound and any 
additional notes or instructions that you want to provide to the author who will receive your 

content.  
  
Note: The Record It! application is automatically installed with a client installation of the 
Developer. 
  
Content authors can make this application available to subject matter experts who can record 
topics that can then be imported into the Developer for refinement and publishing. Topics 

created in Record It! are saved as .topic files to any file system location. The subject matter 
expert can either send the topics to a content author or save them to a location shared with 
the content author.  
  
Content authors can import Record It! .topic files from the Library or the Outline Editor views. 
Record It! files imported from the Library view are stored as topic documents in either the 
current or selected folder in the Library. Record It! files imported from the Outline Editor view 

are automatically linked to the selected parent document (module/section) in the outline and 
saved to the Library at the same time. You can import multiple Record It! files at one time. 

  
Record It! files imported from the Library inherit the current content default properties. Record 
It! files imported from the Outline Editor inherit the content default properties of the parent 
document in the outline to which the topic links.  

  

To import a new Record It! topic in the Library: 

1. Select a folder. 
  

2. Select the Tools menu, point to Import and choose  Topic from Record It! 
  

3. Browse to the location where the Record It! files are stored (.topic). 
  

4. Select one or more files to import and click Open. 

  
5. Click Import. 

To import and link a new Record It! topic in the Outline Editor: 

1. Display the Outline Editor by opening the module or section to which you want to link 

a new Record It! topic. 
  

2. Select the parent document to which you want link the new topic. 
  

3. Select the Tools menu, point to Import and choose  Topic from Record It! 

  



  Export/Import Content 

   489 

4. Browse to the location where the Record It! files are stored (.topic). 
  

5. Select one or more files to import and click Open. 
  

6. Click Import. 
 
Each imported topic is linked and appears beneath the parent document. 

Note: When importing a Record It! topic from the Library or Outline Editor, you can use the 
Import Content To field to change the Library folder in which the topic is saved. 
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22 Localize Content 
Once you have created content in one language, you might want to translate it into one or 
more different languages. The Developer provides functionality that facilitates this aspect of 
the localization process.  
  
Localization requires two main tasks; translating the textual content and re-recording the 

topics in the localized version of the target application. Text translation is usually handled by 
exporting the content to an XLIFF or Microsoft Word format, and sending the exported content 
to a localization company for translation. Topic re-recording is usually done in-house by 
authors or editors with Developer recording experience. 
  
This Developer localization flow involves six main steps: 

 Create a duplicate of the existing content to be translated. When duplicating, enable 

the option to also duplicate the glossaries. 
  

 Use the Localization process to export the content to an XLIFF or DOCX (Microsoft 
Word) translation package, depending on the requirements of your localization 

company. 
  

 Using the XLIFF or DOCX output, translate custom Developer text, including custom 
bubble text, web page text, link tooltips and alternative text, glossary terms, 

questions, and roles. 
  

 Use the Localization process to import the translated XLIFF or DOCX files back into the 
Library, creating content outlines for each language. 

   

 Re-record each topic to update screenshots, actions, and object names and apply the 
appropriate template for the target language to update template text. This task can be 

performed while the content is out for translation. 

  
Note: The Localization import also sets the language property for the imported 
documents to the target language if you choose to overwrite the existing content. 
  

 Translate external content, such as package files and graphics, and relink these 
documents to the translated Developer content, if necessary; update glossary links. 

Create a Duplicate 

To begin the localization process, you must first create a duplicate of the content to be 
translated. You do this using the Copy command and the Duplicate (selection and related) 
option of the Paste Special command. This creates new copies of the entire selection and all 
related documents and updates the links so that the new parent documents link to the new 
child documents. The resulting documents serve as placeholders that are overwritten with the 

translated content. Therefore, you need to create one duplicate of the original content for each 

language into which you plan to translate. For example, to translate English content into 
French, German, and Japanese, you need to create three separate duplicates of the original 
content. Note the following when creating a duplicate of the content. 
  
When duplicating content, you can choose to include or not include duplicate copies of the 
glossaries and style sheets linked to the selected content. 

 Glossaries: It is important to select the Duplicate Glossaries option to include 
glossaries for translation and break the link to the original glossary. The default setting 
for glossaries is to create a duplicate. 
   

 Style sheets: If you leave the Duplicate Style Sheets option unchecked, the 

duplicated content links to the style sheets linked to the original source content; 
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allowing you to maintain a master style sheet for all related content. You can create 
language styles variations in the master style sheet if you need to use another font to 

display the text correctly in the localized language. There is no limitation to the 
number of language styles that you can add to a style sheet. 

  
If you prefer to have separate style sheets for each language, you can create a 
duplicate when you duplicate the content. The default setting for style sheets is not to 
create a duplicate, with the purpose of linking all content to a single style sheet. 
  
Note: A warning appears during export when you have multiple style sheets with the 
same name linked to the exported content. 

For simplicity in managing translations, especially those involving multiple languages, it is 
recommended that you create the duplicate for each target language in a separate, clearly 

identified Library folder. For the example above, if the English content were an outline titled 
"Document Basics" stored in a folder of the same name, you might create the folders 
"Document Basics - FR", "Document Basics - DE", and "Document Basics - JA" and paste one 

duplicate outline into each folder. 
 

Re-record Topics 

A crucial aspect of localizing content is capturing the screenshots and actions of each topic in 
the target language. To do this, you can use the re-record option in the Topic Editor, which 
allows you to easily re-create the same series of actions in the new language using the original 
topic as a guide. You must also update the template bubble text in the topic by selecting the 
appropriate template for the target language from the Properties toolpane. This provides a 
localized version of the automatically generated text portions of a topic. 

 
Note: The Developer provides a standard set of Default and Microsoft templates for all 
supported languages. Therefore, you do not need to translate template text unless you use a 
custom template or translate your content into an unsupported language. 
 

Translate Custom Text 
In addition to recorded topic steps, your content may also include custom text, such as bubble 
text, modules and sections titles for organizational headings, questions, attachment tooltips, 
and web pages to provide additional information. The text you produce while modifying your 
content in this way must also be translated for localization. The Developer provides a 
Localization export and import flow to assist in the translation of this custom text. 
 
You can export this custom text in Word (DOCX) format for manual translation or XLIFF format 

for use in professional translation software that supports this format. The export results in a 
single file that contains a listing of all custom text in the source language that needs to be 
translated, divided into individual translation units, along with processing information required 
to ensure that each unit of text is imported correctly. During translation, you add translated 
text to the Word or XLIFF file so that the file includes the translated text in the target 
language in parallel with the original source text. After completing the translation, you then 

import the modified file back into the Developer, using the Import Localization command. 
During import, the documents that were originally exported in the source language are 
overwritten with the translated text provided in the Word or XLIFF file, and the Language 

property of these documents is updated to match the target language. 
 
Warning! Because the import process overwrites the text in the original documents, you 
MUST make a duplicate of the content to be translated before exporting it for localization; 

otherwise, you overwrite the content in the original source language. 
 
For a detailed discussion of this process, see Export Content for Localization and Import 
Localized Content. 
 

Translate External Content and Update Glossary Links 

The third type of content to translate is external material such as package and URL 
attachments. For example, you might link to an Excel spreadsheet or an external web site 
from a topic frame, or you might include an embedded graphic in a web page. Such external 
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content is not included in the Localization export/import flow and must be translated 

separately. After translating such package files, graphics, and so on, you might need to update 

links in your translated content to ensure that they point to the appropriate targets. For 
example, if you translate the name of a file in a package, you must ensure that all links in the 
translated content are updated to reflect the new package file name. 
 
Tip: Renaming a package does not break the link to content; renaming linked package items 

does break the link. To avoid having to update links to package files in translated content, you 
should apply a language-neutral naming convention for package items and only change the 
name of the package itself. You can then differentiate package files of the same name based 
on the name of the package in which they are contained, which can be translated without 
breaking any links. 
 
After all text in your content has been translated, you should update glossary links in the 

translated documents. Because glossary documents are included in the duplication process 
and the Localization export/import flow, the appropriate glossary, including translated terms 
and tooltips and updated definition links, are already be assigned to each translated 

document. However, the links themselves are not preserved during the localization process so 
as to allow flexibility in the treatment of glossaries. 
 
Note that, aside from glossary links, the only links that might need to be updated in the 

translated content are those to package files, which are identified, in part, by file name. For 
other document types, which are identified solely on the basis of Document ID, links are 
updated automatically when you duplicate the selected content and related documents. 
Therefore, as stated above, duplication should always be the first step in the localization 
process. 
 

 Multi-user Considerations 

 You can use the State workflow property as a means of tracking the various stages of 
a localization project. For example, you could create State values that identify the 
typical events that occur such as Released for Translation, Sent to Translation, 

Translation Review, Translation Complete, and so on. 

22.1 Export Content for Localization 
The purpose of exporting documents for localization is to extract the text added while 

customizing your content in a format that makes it convenient for translation. 
 
Before exporting any documents for localization, you must create a duplicate of the complete 
set of related documents, including the glossaries, to be translated. The duplicated documents 
serve as placeholders for the translated content; therefore, one set of duplicates must be 
created for each target language. It is recommended that you create the duplicate for each 

target language in a separate, clearly identified Library folder. 
 
After creating the duplicate, you can export it for localization from either the Library or the 
Outline Editor. If you create the duplicate in a separate folder as recommended, you can 

simply select the folder itself from the Library. Alternatively, you can select one or more 
individual documents. 
 

Tip: You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 
 
After selecting content and initiating the export process, your next step is to set the export 
options. 

 Save Location and File Format 

The first option is the location in which to save the localization file. The default location 
is the My Localization subfolder of the My Documents folder on your local hard drive, 
but you can choose any other location on your computer or server for which you have 
Write permissions. You must also specify a name for the localization file. This file name 
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does not in any way affect the processing or translation of the documents it contains, 
but it is recommended that you use a meaningful name that reflects the intended 

translation process. For example, you might use the name Document Basics_EN_HU 
for content to be translated from English into Hungarian. Also note that certain 

reserved characters are not permitted in localization file names. 
  
In addition to specifying the file name, you also must select the translation file format 
as either Microsoft Word or XLIFF. In both cases, the same text components of the 
selected documents are exported; the difference is in the intended translation process. 
Exporting to Microsoft Word format (file extension DOCX) provides an easily readable 
listing of text that is amenable to manual translation. Exporting to XLIFF format (file 

extension xlf) provides an XML-based file for use with translation tools that support 
this format. See Localization Using Microsoft Word and Localization Using XLIFF for 
more detail. 
  

 Content Selection 

The second option allows you to export your selection only or your selection and all 
related documents. In general, documents linked as children of the documents in your 

selection are included as related, whereas those linked as parents are not. Any 
glossary assigned to one or more documents in the selection is also included as a 
related document. Click the View related documents link to display a list of all 

documents related to your selection. 
  
Note: The content of a package document is not exported for localization. 
   

 Language 

The third option is to specify the source and target languages. The source language is 
determined by the Developer and reflects the Language property of the selected 
document(s). The target language is the language into which the content is being 
translated. Note that only one target language can be selected. If the same content is 
intended for translation into multiple languages, this content must be duplicated 
multiple times, and each set of duplicated content must be exported separately with 
the appropriate target language specified. 

During the Localization export process, the Developer extracts the custom Developer text 

included in the selected document(s) and writes it to a single localization file of the selected 
format (Microsoft Word or XLIFF). Included with the text is some required processing 
information, such as document and translation unit IDs, that is essential for the text to be 
imported successfully after translation and must not be changed. (See Localization Using 
Microsoft Word and Localization Using XLIFF.) The custom Developer text that is exported for 
localization depends on the document type as follows: 

 Module 

- Document name 
- Roles 
- Keywords 
- Description 

   

 Section 

- Document name 
- Roles 
- Keywords 
- Description 
   

 Topic 
- Document name 
- Roles 
- Keywords 

- Custom bubble text, including formatting and markup for play modes and Player and 
document outputs (one or more translation units per topic frame, depending on play 
mode and output markup) 



Localize Content 

 

 494 

- String input text 

- Implicit text (for string input action) 

- Object names 
- Jump-in points 
- Decision frame header and Decision path names 
- Frame link tooltips 
- Frame comments (Expected Results, Author Notes, Instructor Notes) 

- Topic properties (Properties toolpane fields for Instructor Manual, Job Aid, System 
Process Document, and Test Document). 
   

 Package 

- Document name 
   

 Web Page 
- Document name 
- Body text, including formatting. Note that the body text is segmented. 

- Images (advisory title and alternative text)  

- Tables (cell contents, caption, and summary) 
- Links (tooltip) 
   

 Assessment 

- Document name 
- Roles 
   

 Question 

- Document name 
- Roles 
- Remediation text 
- Question text 
- Blank Answer text 
- Option text 

  

 Glossary 
- Document name 
- Glossary terms 
- Tooltips for glossary terms 

A summary message appears if some of the documents you selected could not be processed. 

Clicking the View activity log link in the message displays a list of the results for each 
document. 
  
The export creates either an XLIFF or DOCX file depending on your format selection. Selecting 
Cancel during the export for localization process displays a message with a link to a list of the 
documents that have already been exported. Although the partial localization file can be edited 
and imported, it includes only a subset of the documents intended for translation. Therefore, it 

is recommended that you delete the partial localization file and restart the process from the 
beginning. 

  
Note: In this version of the Developer, the Web Page Editor creates web pages with a 
different underlying structure than those web pages created with previous versions of the Web 
Page Editor (legacy web pages). However, during the export for localization, the Developer 

converts old web pages to the new structure. This structure change affects the existing 
translation memory (TM) for localized content created with previous versions of the Developer. 
  

 Multi-user Considerations 

 In a multi-user environment, when you are online, you also have the option to choose 

local or server content. Local content includes the locally edited copies of all selected 
documents that you have checked out and the server versions of those not checked 
out to you. Use this option for documents in progress for review. Server content 
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includes only the checked in versions of the selected documents. Any local changes to 
checked out documents are ignored. Use this option for final versions of documents. 

  
You can also export while offline, but to do so, you must have the documents in your 

local cache. 
  
Nevertheless, it is recommended that you check in all documents to be exported for 
localization and export the server content to ensure that you include the most up-to-
date versions. 

To export content for localization: 

1. From the Library or Outline Editor, select the folder(s) and document(s) you want to 

export for localization. 
  
You can select multiple documents using the standard Windows selection keys 
(CTRL+click and SHIFT+click). 

  

2. On the Tools menu, point to Export and choose Localization. 
  

3. Set the export options. 
  

4. Click OK. 
  
The Developer processes the selected documents, creating a single file containing all 

extractable text, and associated processing information, in the specified location. 
  
If any errors occur, they are written to an activity log, and a Partial Export message 
box appears. You can click the View activity log link to view the results of the export or 
click OK to close the message box. 

22.2 Import Localized Content 
After editing the exported localization file to include translated text, you use the Localization 
import command to add the translated content to your Library. This process overwrites the 
text in the set of duplicate documents that you exported for localization with the translations 

contained in the imported file. 
 
When importing for localization, you can select a single Microsoft Word or XLIFF localization 
file. The Developer reads the selected import file and identifies the documents to be replaced 
according to the Document IDs recorded during export. The replacement of source text by 
translated text within a document is then based on the translation unit IDs contained in the 

localization file. If no translation is provided for a particular translation unit, the source text is 
left unchanged. 
  
Warning! You cannot import localized content into documents that are open in the Developer. 
You should close the outline, and all documents related to the content that you are importing, 

before starting the localization import process. At the conclusion of the import, a message 
informs you if translated content was not imported and the errors appear in the activity log. 

  
When the Developer imports the localized content, it checks to see if the duplicate content you 
used to create the export has been changed since the export; for example, you may have 
added additional text to a web page. If you overwrite your duplicated web page, you lose your 
new edits. You can use the Overwrite Documents that Have Changed Since Last Export option 
to either skip importing the changed documents or overwrite them. If you choose to leave the 
option unchecked, the import preserves the changes by not overwriting the source documents. 

After the import, you can check the activity log to see which documents were not imported. 
You can then create a separate export of those updated documents to send for translation. 
  
The option to overwrite the original duplicate affects document types in different ways. 
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 Web Pages: Imported web pages replace the web pages in the duplicate outline that 
you used to create the localization export; any changes made to the source content 

after the export are overwritten during the import. 
  
Note: Due to a change in the Web Page format, you cannot import content that was 

exported and translated using a previous version of the Developer. If you are 
upgrading versions, make sure that you import your content into the Library before 
upgrading. 
   

 Topics: Frame screenshots in topics are not overwritten during the import; therefore, 

your re-recorded frames are preserved. Imported bubble text for a frame completely 
overwrites the existing text in the equivalent frame. Frames added to a topic during 
the re-record process are preserved, though you may need to localize custom text 
added to the frame. 
   

 Questions: All question text is replaced with the imported, localized text. New question 

options added to multiple choice and matching questions are preserved, though you 

may need to localize the new text. 
   

 Packages: Package files are not included in the content exported for localization and 
are not overwritten. 

In addition to adding the translated text to the imported documents, the import process also 
updates the Language property of each document to the target language selected during 
export. If the language of a document has changed since it was exported, you are not 
prevented from continuing with the import process, but an informational message is added to 
the activity log. 

 
Tip: If the imported content includes topics for which role assignments were translated, you 
should update the master role list for the target language to include these roles. If no master 
role list exists for the target language, you should create a new master role list before 
importing the translated content. 

 
A summary message appears if some of the documents you selected could not be processed. 

Clicking the View activity log link in the message displays a list of the results for each 
document. 
 
Selecting Cancel during import stops processing after completion of the current document and 
displays a message with a link to a list of the documents that have already been imported. 
Click the View activity log link in the message to display a list of the results for each 

document. 
  

 Multi-user Considerations 

 For a document to be overwritten during import, it must be checked out. Therefore, 

before initiating the import process, you should ensure that any documents that must 
be overwritten are either checked out to you or checked in to the server. If you plan to 

import a localization file while offline, you must check out all such documents before 
going offline. 
  
However, if a document that needs to be overwritten is not checked out and you are 
online, the Developer automatically checks the document out to you and replaces it 

with the corresponding document from the localization file. If the document cannot be 
checked out, for example, if it is open in another editor or checked out to another 
user, it is skipped. At the end of the process, a summary message appears with a link 
to an activity log. Clicking the View activity log link in the message displays a list of 
the documents that were checked out to you during the process and those that could 
not be checked out. 
  

After you complete the import process, you should check in all affected documents to 
make them available to other authors and add the changes to the Developer's version 
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control system. When you check in a translated document, its version number is 
incremented, reflecting the fact that its contents have changed. After updating the 

master role list, you should check it in. 
  

It is recommended that you always manually check out all documents to be 
overwritten during import, to ensure that all documents are processed during import 
of localized content. 

To import content for localization: 

  
Note: Close the content you are importing before starting the import process. 

1. On the Tools menu, point to Import and choose Localization. 

  
2. Click Browse and navigate to the translated file you want to import. 

  
3. Select the translated file and click Open. 

   

4. Leave the Overwrite documents that have changed since last export unchecked 
to skip source documents that have been changed since the localization export. Check 
the option to overwrite changed source documents with the localized versions. 
  

5. Click OK. 
  
The Developer processes the selected file, replacing the text in the original documents 

with the translated copy. 
  
If any errors occur, they are written to an activity log, and a Partial Import message 
box appears. You can click the View activity log link to view the results of the import 
or click OK to close the message box. 

22.3 Localization using XLIFF 
XLIFF, or XML Localization Interchange File Format, is an XML-based format that was 
developed specifically for use in translation projects. As its name and origin suggest, XLIFF 
was designed to facilitate the exchange of information across different systems during 

document localization. In general, source text is converted into XLIFF by a filter that depends 
on the source structure. This filter extracts the translatable content as plain, unformatted text, 
allowing the translator to concentrate on the meaning of the text to be translated, regardless 
of the original source file format, structure, or appearance. Such additional information about 
the source is still preserved in the XLIFF file in the form of tags, which are used to apply the 
appropriate processing to the translated text so that the original structure and formatting are 

reproduced upon conversion of the translated text back to the original format. 
 
It is assumed that, if you choose to localize your Developer content using XLIFF, you are 
already familiar with basic XLIFF concepts and are working with an XLIFF tool or sending your 
content to a localization vendor who does. For further information on XLIFF in general, see the 

web site of the OASIS Technical Committee on XLIFF at https://www.oasis-
open.org/committees/tc_home.php?wg_abbrev=xliff. 

 

Developer XLIFF Processing 

When you execute the Export Localization command, the Developer applies a filter to the 
selected content, extracting all translatable text and rendering it in a form that complies with 
XLIFF specifications. The text extracted depends on the type of document selected. Within the 
XLIFF file, the text is organized by document and then by translation unit within each 

document. Therefore, as you process the XLIFF file, you proceed sequentially through each of 
the exported documents. 
 
Warning! During the Localization export process, the Developer applies a unique ID to each 
translation unit that includes information regarding the document ID, document type, and text 
type (if the document can have multiple translation units; see below). Therefore, you should 
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neither merge nor split translation units during processing in XLIFF, as this could lead to 

problems upon import. Specifically, if the file selected for import contains translation units with 

invalid IDs or other problems, the Developer skips such translation units, thus not importing 
the corresponding text. 
  

Web Pages 

Each web page document is exported as at least two translation units, one for the document 
name and multiple for the body of the web page, regardless of the amount of text it contains. 
Web pages can include such elements as formatted text, images, and hyperlinks. Although 
such information is not relevant to the translation of the text itself, it is important for ensuring 
that the translated document has the same structure and appearance as the source document. 
Therefore, the XLIFF generated by the Developer includes such information within web page 
translation units using the standard XLIFF processing tags <bpt> (begin paired tag) and 

<ept> (end paired tag). These tags surround appropriate pieces of text in the source 
translation unit and contain XHTML code (generated by the Web Page Editor) corresponding to 
the formatting and processing needed. 
  

Topics   

Topics can consist of a large number of translation units, and the translation units 

corresponding to bubble text can include both formatting and markup for play modes and 
outputs. 
  
Custom bubble text can also include markup for play mode (visible in See It/Try It!, Do It!, 
and Know It? modes) and output (visible in Player and print outputs). If all of the custom 
bubble text in a topic frame is marked for the same play modes and outputs, it is exported as 
a single translation unit. However, if the same bubble contains custom text marked for 

different modes and outputs, multiple translation units are generated, one for each unique set 
of play modes and outputs. Despite the obvious overlap in content, these translation units 
should be translated and maintained as separate units because they represent different 
combinations of mode and output markup. Although this approach leads to some duplicate 
translation and repetition in the bubble of text appearing in different markup combinations, it 
ensures that the play mode and output markup of the source text is accurately reproduced in 

the translated bubble text, so that the translated topic publishes correctly. In addition, this 

approach simplifies the translation process. That is, translators are frequently comfortable with 
formatting attributes such as bold or font name, but might find it more difficult to interpret 
and appropriately process the mode and output markup, which are specific to the Developer. 
Moreover, use of a translation memory can minimize the impact of any duplication. 
 

Images and Hyperlinks 

For images (<img> tag) in web pages, the processing tags always include the image source 
attribute (src) and might also include attributes representing the properties that can be set 
using the Image Properties dialog box. Some of the attributes are alternative text (alt), size 
(style), border (border), and alignment (align). Likewise, for hyperlinks (<a>, or anchor, tag) 
in web pages, the processing tags always include the hyperlink target attribute (href) and 
might also include an attribute representing the tooltip (title). In general, image and hyperlink 

processing tags should also be copied from the source text to the corresponding portion of the 
translated text. However, you might want to translate the alternative text for an image or the 
tooltip for a hyperlink. You can do so by directly editing the corresponding <bpt> processing 

tag to include the appropriate translation in the alt or title attribute, respectively. 
  
Note that, except for URL images or URL hyperlinks, you should not need to edit the image 

source (img src) or hyperlink target (a href) attributes in web page translation units. Rather, 
these values are updated when you create a duplicate of your content (including related 
documents) before exporting it for localization. If you need to change these attributes further, 
you should edit the image properties or edit the hyperlink properties from the Web Page Editor 
after importing the translated web page. 
 
Note: Hyperlinks are included in translation units only for manually created links, not for 

glossary links. Rather, you should update glossary links from the Developer after importing 
the translated content and glossary (or glossaries). 
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See Export Content for Localization for a list of the text that is exported for each document 
type. 

 

Summary 

In summary, the translation of custom Developer text using XLIFF is relatively straightforward, 
with most translation units consisting simply of unformatted text. The exceptions are web 
page text and custom bubble text, which can include formatting and processing information in 
the form of <bpt>/<ept> processing tags. For the most part, these tags should be copied 
directly from the source text to the linguistically equivalent portion of the translated text. 
 

In addition, in cases where the mode and output markup of the text within a bubble differs, 
multiple translation units are created for a single bubble. Because the IDs of the resulting 
translation units contain information on markup, these translation units should always be 
processed individually, even if they contain similar text. This preserves the appropriate bubble 
text markup upon import of the translated content. A translation memory should prove helpful 
in automating translation in such cases. 

22.4 Localization Using Microsoft Word 
If you are not using XLIFF-based translation tools, you should use the Microsoft Word option 
for localizing your content. Exporting to Microsoft Word provides an easily readable listing of 
text that is amenable to manual translation. 
 
The same initial processing is applied to your content when you execute the Export 
Localization command, regardless of whether you choose to export to XLIFF or Microsoft Word. 

Specifically, the Developer applies a filter to the selected content, extracting all translatable 
text and creating a list of translation units, or logical segments of text, organized by 
document. The text extracted depends on the type of Developer document selected, as 
discussed later, but is the same for both XLIFF and Microsoft Word. In XLIFF, the translation 
units are presented as plain, unformatted text, with any necessary formatting or processing 
information managed through the use of processing tags. In contrast, in Microsoft Word, any 
formatting applied to the text in the Developer is directly reflected in the exported file, so that 

you can see how it actually appears in the source documents. You then replicate this 

formatting in the translated text using standard Microsoft Word formatting controls so that the 
translated content has the same appearance in the Developer upon import. 
 

Localization File Structure 

The localization file created upon export to Microsoft Word consists of a series of tables, one 
for each Developer document exported. The first table in the Word file specifies the hard-
coded language codes for the Source and Target properties. The Source is the language of the 
original content and the Target is the language selected as the target when the content was 
exported. Each subsequent table is captioned with the Document ID and Data Type (these 
fields must not be edited), with the table containing all translatable text from the document, 
with one row for each translation unit. (The number of translation units depends on document 

type and contents, as explained further below.) The five columns in each table are as follows: 

 Id: Translation unit ID; this field must not be edited 
  

 Source: Source text extracted from Developer content 

  

 Target: Placeholder for translated text 
  

 Notes: Field available for notes about the translation, if necessary; added after export 

  

 System Data: Processing information needed for translation unit, such as image 
properties; this field must not be edited 

Note: In previous versions of the Developer, the codes for the source and target languages 

were hard-coded as column headings into each translation table. 
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The source, target, and possibly Notes columns are the primary focus for translation; the 

information in the remaining columns can help provide context for the text to be translated 

but is required for system processing and should not be changed. 
 
Warning! Do not edit any system information contained in the exported localization file, 
including Document IDs, document data types, translation unit IDs, and System Data entries. 
Doing so can cause the import process to fail, either for the entire localization file or for any 

directly affected document(s). You should also not change layout attributes such as splitting 
tables, and so on. 
 
Use of a Microsoft Word file for localization is straightforward: Simply translate each source 
translation unit in the source column and add the translated text to the appropriate table cell 
in the target column. If a particular translation unit, such as a technical term, does not need 
to be translated, you can copy the source text directly to the target column without modifying 

it or leave the table cell empty. If the source text is formatted (which might be the case only 
for bubble text and web page body translation units, as explained in detail below), you should 
apply the same formatting to the translated text so that it matches the appearance of the 

source. If desired, you can also use the Notes column for communication with the translator 
about the translation. For example, you might include the note "Do not translate" for a 
translation unit that should be kept in the source language. Likewise, a translator could 
include notes about particular translation units, such as questions about the translation of 

technical terms. 
 
Upon import, the Developer processes each document and each translation unit in the 
localization file, overwriting the original source content with the text provided in the target 
column. If no translation is provided for a particular translation unit, the source text is left 
unchanged. The import and overwriting process is based solely on document and translation 

unit IDs; it is not affected by any changes that might have been made in the Developer 
content after it was exported or in the Source column text of the localization file. Any entries 
in the Notes column also do not affect the import process. 
 

Translation Unit IDs 

As mentioned above, you can localize your Developer content using Microsoft Word by 

considering only the source and target columns in the localization file. 
 
Note: The same translation unit IDs and other system information are also included in 
Developer-generated XLIFF localization files. However, this information generally remains 
hidden during XLIFF processing because it is not exposed by most XLIFF translation tools. 
 
Translation unit IDs depend on the function of the text within the document. As a result, each 

type of Developer document can correspond to only certain types of translation unit IDs. All 
documents include a TXT_Title translation unit ID with the unformatted document name. 
Other documents, such as modules, sections, and topic, may also include translation unit IDs 
for roles and keywords. Each web page document is exported as at least two translation units, 
one for the document name and one for the body of the web page, regardless of the amount 
of text it contains. If the web page contains one or more embedded image(s), one additional 

translation unit is created for each image. Web pages also include translation unit IDs for 
alternative text for images and summary text for tables. 

  

Web Pages 

If the source web page contains text and paragraph formatting, you should apply the same 
formatting to the translated text using Microsoft Word's formatting tools. However, you should 

use only the types of text formatting supported by the Web Page Editor, as all other 
formatting is removed upon import. The following web page formatting is preserved: 
  
Paragraph alignment 
Hyperlink 
Images 
Numbered and bulleted lists 

Fonts 
Bold, italic, underline 
Strikethrough 
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Subscript, Superscript 
Special characters 

Page breaks 
Cross-reference links 

  
In addition, if the source web page has a background color, the cells corresponding to the 
Source and Translation of the web page body translation unit have the same background 
color. However, this color is provided for illustration only, simply to match the appearance of 
the source document. Changing this color does not change the background color of the 
translated web page document upon import into the Developer. 
  

Tables 

Each table cell is segmented and exported as its own translation unit. In addition, translation 
units are created for the table caption and table summary. The table summary is used to 
provide an accessible description of the table's contents. 
 

Images in Web Pages 

If an exported web page contains an image, a small placeholder graphic appears in the source 
web page body translation unit to indicate its position in the layout of the web page. You 
should copy this graphic to the same location in the layout of the translated web page to 
include the image in the translated web page upon import. In addition, a separate translation 
unit is created for the image itself. The translatable text in this translation unit, if assigned, is 

the alternative text of the image (for accessibility) and the advisory title that appears in a 
tooltip for mouse hovering. Even if there is no source alternative text, you can add text to the 
Translation column that is imported as the alternative text for the image in the translated web 
page. Image translation units also always contain an entry in the System Data column that 
specifies the source of the image, as well as other image properties (such as size, border, and 
alignment), if assigned. You should not edit any system data. 
  

Hyperlinks in Web Pages 

If an exported web page contains a hyperlink, the hyperlink also appears in the source 
translation unit for the web page body. Use the Microsoft Word controls for editing and 
inserting hyperlinks to create the same hyperlink in the corresponding location of the 

translation (from the equivalent text or the placeholder graphic, as appropriate). You should 
use exactly the same Address for the hyperlink target in the Edit Hyperlink dialog box for the 

two hyperlinks. However, you can translate the hyperlink tooltip, or add a tooltip for the 
translated web page even if none is provided in the source web page, by clicking the 
ScreenTip button in the Edit Hyperlink dialog box and editing the text as necessary. 
 
Note that, except for URL images or URL hyperlinks, you should not need to edit the image 
source or hyperlink target attributes in web page translation units. Rather, these values are 

updated when you create a duplicate of your content (including related documents) before 
exporting it for localization. If you need to change these attributes further, you should edit the 
image properties or edit the hyperlink properties from the Web Page Editor after importing the 
translated web page. 
 
Note: Hyperlinks are included in translation units only for manually created links, not for 
glossary links. Rather, you should update glossary links from the Developer after importing 

the translated content and glossary (or glossaries). 
  

Topics 

Topics can consist of a large number of translation units, and the translation units 
corresponding to bubble text can include both formatting and markup for play modes and 
outputs. See Export Content for Localization for a list of the topic components that correspond 

to individual translation units. Except for custom bubble text, all of the other topic translation 
units contain unformatted text. 
  
The translation units for custom bubble text require additional explanation for two reasons: 
formatting and mode and output markup. 
 

If the source bubble text contains text and paragraph formatting (such as bold, italics, 
paragraph alignment, and so on), you should apply the same formatting to the translated text 
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using Microsoft Word's formatting tools. However, you should use only the types of text 

formatting supported by the Topic Editor, as all other formatting is removed upon import. 

 
If exported bubble text contains a hyperlink, the hyperlink also appears in the source 
translation unit for the bubble text. Use the Microsoft Word controls for editing and inserting 
hyperlinks to create the same hyperlink from the corresponding text in the translation. You 
should use exactly the same Address for the hyperlink target in the Edit Hyperlink dialog box 

for the two hyperlinks. 
  
Note that, except for URL hyperlinks, you should not need to edit the hyperlink target 
attributes in bubble text translation units. Rather, these values are updated when you create a 
duplicate of your content (including related documents) before exporting it for localization. If 
you need to change these attributes further, you should update the bubble text link from the 
Topic Editor after importing the translated topic. 

 
Note: Hyperlinks are included in translation units only for manually created links, not for 
glossary links. Rather, you should update glossary links from the Developer after importing 

the translated content and glossary (or glossaries). 
 
In addition to formatting and hyperlinks, custom bubble text can also include markup for play 
mode (visible in See It/Try It, Do It, and Know It modes) and output (visible in Player and 

print outputs). The ID of each custom bubble text translation unit indicates the mode(s) and 
output(s) in which the text is set to appear. 
  
If all of the custom bubble text in a topic frame is marked for the same play modes and 
outputs, it is exported as a single translation unit. However, if the same bubble contains 
custom text marked for different modes and outputs, multiple translation units are generated, 

one for each unique set of play modes and outputs. In this case, the same integer appears 
after the prefix BUB in all translation units corresponding to the same bubble, but the mode 
and output codes differ as needed to reflect the text markup. 
 
Despite the obvious overlap in content, these translation units should be translated and 
maintained as two separate units because they represent different combinations of mode and 

output markup. Upon import, these translation units are written to the same frame bubble, 

with the first marked to appear only in See It/Try It and Do It modes and the second marked 
to appear only in Know It mode. That is, where the original bubble text consisted of three 
sentences, the translated bubble text appears as five sentences overall, one set of two 
sentences from the first translation unit and another set of three sentences from the second 
translation unit. Although this approach leads to some duplicate translation and repetition in 
the bubble of text appearing in different markup combinations, it ensures that the play mode 
and output markup of the source text is accurately reproduced in the translated bubble text, 

so that the translated topic publishes correctly. 
 

Summary 

In summary, the translation of custom Developer text using Microsoft Word is relatively 
straightforward, with most translation units consisting simply of unformatted text. The 

exceptions are web page text and custom bubble text, which can include text and paragraph 
formatting and processing information such as hyperlinks. For the most part, this formatting 

should be exactly reproduced in the linguistically equivalent portion of the translated text. Any 
formatting present in the translated text that is not supported by the Developer is removed 
during import. 
 
In addition, in cases where the mode and output markup of the text within a bubble differs, 

multiple translation units are created for a single bubble. Because the IDs of the resulting 
translation units contain information on markup, these translation units should always be 
processed individually, even if they contain similar text. This preserves the appropriate bubble 
text markup upon import of the translated content. 

22.5 Summary of the Localization Process 
Create a duplicate of all documents to translate.  
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 Creating a duplicate must be the first step. 

   

 You need one new duplicate for each language into which content is being translated. 
   

 It is recommended that you create each duplicate from the Library, using a separate, 
clearly labeled folder for each language. 

Re-record topics. 

 Re-recording captures screenshots and object names in the target language. 
  

 This provides a translation only of automatically recorded content. 

  

 Apply the appropriate template for the target language to update template text. 

Use export/import for localization of custom Developer text. 

 You can export to Word or XLIFF formats. 
  

 It is recommended that you check in all content to be translated prior to exporting and 
export the server version. 
  

 Translation is performed external to the Developer. 

  

 During import, you can choose to skip documents that were changed after the 

localization export or overwrite the exported documents with the translations added to 
localization file. 

Translate external content and update glossary links. 

 Package files containing text, package graphics, and URL attachments must be 
translated separately from custom Developer text. 
  

 If necessary, fix any links to package files that might have been broken during the 

translation process (for example, if the name of a linked package file was changed). 
  

 As a final step after all content has been translated, update glossary links. 
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23 Customize Templates 
Templates are used for a variety of purposes in the Developer. They generate bubble text 
automatically for frames, determine the instructional text to be shown during Know It? mode 
playback, and control the example text given with string input events. You can customize 
these templates to reword the text or even translate it into any language not provided in the 
Developer.  

 
Templates are stored in the /System/Templates folder in the Library. There is a subfolder for 
each supported language, named according to the language code. 
 
Each folder contains two existing template sets, Standard and Microsoft. Each template has a 
template.xml file which contains the customizable text. These existing templates should not be 
customized, because when you upgrade to newer versions of the Developer, they are 

overwritten and your customizations lost. Instead, make a copy of one of the templates, 
rename it, and make your customizations to the copy. 

23.1 Start the Template Editor 
The Template Editor is a tool included with the Developer that provides an interface that 
enables you to easily edit the template.xml file to customize a template. The interface has 
several sections, each of which allows you to modify different parts of the template. You can 

change existing text elements or add text, or localize the text into any language. In addition, 
you can preview the results of your changes immediately. 
 
You can launch the Template Editor from the Windows Start menu. The installation process 
creates a shortcut in the same program group as the Developer. 
 

To create and customize a template: 

1. Open the Library. 

  

2. Navigate to the System/Templates folder, and then open the folder for the language 

templates you want to customize. 
  

3. In the language folder, select the template set you want to copy. 
  

4. On the Edit menu, choose Copy. 
  

5. On the Edit menu, choose Paste. 

  
6. Select the copy you just made. 

  
7. On the Edit menu, choose Rename. 

  
8. Type the name for the customized template. 

  

9. Press ENTER. 
  

10. Right-click the template set and choose Open. 
  

11. Copy the template.xml file to your local drive or a network drive. 
  

12. Start the Template Editor. 
  

13. Open the template.xml file in the Template Editor. 
  

14. Modify the text as desired, referring to the following sections. 
  

15. Save the template.xml file. 

  



  Customize Templates 

   505 

16. Copy the modified file into the template document in the Library. 
  

17. Close and save the template document. 
  

18. Apply the template to topics as appropriate. See Template Property for more 
information. 

23.2 Edit the Template.xml File 
The template.xml file has several different sections. 
 
Styles 
Statements used to format parts of the template text. 
 
Events 

Lists all events (actions) that are possible. 
 
Classes 

Lists all classes (types) of supported objects. 
 
Defaults 

Generic template definitions used when a specific template definition does not exist for a 
Class. 
 
Key Names 
The names of the special keys on the keyboard, such as Enter, Insert, Delete, Home, End, and 
Escape. 
 

Instructions 
Instructional text, such as "Press Enter to continue", found in the Player. 
 
The template text in the bubble is defined in the Classes and Defaults sections. The Classes 
define the objects, such as combobox, menuitem, pushbutton, or radiobutton. Each class has 

the same list of events, such as LClick1 or Drag. In the Template Editor, a pane at the top of 
the window displays the list of Classes. The Template section displays the Events in the left 

pane. The elements that make up the text for the event appear in the main pane, while the 
preview appears at the bottom of the window. See the following sections for details about how 
to use these panes to edit the template text. 
 
There is a Default template for each event. However, a particular Class may need a specific 
template, called a local template. For example, the Default template for the LClick1 action 

(single left click) is "Click the". However, for the Column class, the local template for the single 
left click action is "Click an entry in the". If there is a local template for a Class, it appears in 
the Events list in bold text. If it is a Default template, it appears in non-bold text. 
 

To open the template.xml file: 

1. In the Template Editor, select the File menu and choose Open. 

  
2. Navigate to the location on the network or local drive to where you copied the 

template.xml file. 
  

3. Select the template.xml file and click Open. 

23.2.1 Edit a Class 

A class defines a single type of object, for example a button or a menu. The list of classes 
appears in the Classes pane at the top of the Template Editor window. Each class has four 

attributes, displayed in columns in the Classes pane. 
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Name 

Unique identifier for the object type; for example, ROLE_STANDARD_ACTIVEX. You cannot 

change this attribute. 
 
List Name 
Text that appears in the object type list in the Frame Properties toolpane in the Topic Editor, 
for example ActiveX. 

 
Display Name 
Text that appears in the template-generated text when the <ObjectType/> attribute is used 
within a template definition. 
 
Gender 
Used to refer to the appropriate set of gender templates in the Defaults section. This affects 

languages other than English. See the Use Genders topic in the Translate Templates chapter of 
the Content Development guide for more information. 
 

To edit a class definition: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. Scroll the list of Classes as necessary and double-click the Class definition you want to 

edit. 
  

3. Edit the text in the List Name and Display Name boxes as desired. 

  
4. Change the Gender, if necessary. 

  
5. Click OK. 

23.2.2 Edit an Event in a Class 

An event definition is a sequence of elements that produces the default template text. Keep in 
mind that if you edit an event definition that is in non-bold text, you are changing the 
definition for all Classes that use the Default definition. 
 
text 

The static template text appears between <Text> and </Text> tags in the template.xml file. 
Note that a template may contain multiple text statements. 
 
ObjectType 
The ObjectType element is a placeholder used to insert the display name of the object type as 
defined in the Class. 

 
ObjectName 
The ObjectName element is a placeholder used to insert the name of the object on which the 
action is performed. 
 

To edit an event definition: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. Scroll the list of Classes as necessary and select a class. 

  

3. In the Event list, click the event definition you want to edit. 
  

4. In the pane to the right of the Event list, double-click the element you want to edit. 
  

5. Edit the element properties as desired. 
  

6. Click OK. 
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To add elements to an event: 

1. In the Event list, click the event definition to which you want to add an element. 

  
2. In the pane to the right of the Event list, click Add. 

  
3. In the Create New Element dialog box, click the Type list and select the type of 

element you want to add and click OK. 

  
4. Edit the element properties as desired. 

  
5. Click OK. 

To reposition elements in an event: 

1. In the Event list, click the event definition. 

  
2. In the pane to the right of the Event list, click the element you want to move. 

  
3. Click Move Up or Move Down to move the element to the desired position. 

To delete elements in an event: 

1. In the Event list, click the event definition. 

  
2. In the pane to the right of the Event list, click the element you want to delete. 

  
3. Click Delete. 

23.2.3 Edit or Suppress Example Text for String Input Events 

During topic playback, steps in which a user is asked to enter text are called string input 
events. The bubble for a string input event frame has example text, which you can customize.  
 

This text is defined in the default StringInput event. It has several elements to account for the 
string input options that you may have chosen in the Developer, such as adding meta entries 

or specific entry text. See Edit Action Properties in the Use the Topic Editor chapter for more 
information. 
 

As you edit the text, check the Preview area at the bottom of the Template Editor to see how 
your changes look in the content. There are options that allow you to view how the template 
changes with the different meta entries of Something, Anything, or Blank. In addition, the 
Exact option shows you how an exact match, for example no meta entry, appears. 
 

To change example text for string input events: 

1. In the Template Editor, open the Template.xml file you want to edit. 
  

2. Click StringInput in the Event list. 
  

3. In the pane to the right of the Event list, double-click the text or string input extension 
element you want to edit. 
  

4. Edit the text as desired. 
  

5. Click OK. 
  
Note: The "or" text that occurs between entries in a list of valid entries is instructional 
text. See Change Instructional Text for the Player for more information, and use the 
strinp_or instruction. 
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To suppress example text for string input events in Do It! mode: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. From the Edit menu, choose Instructions. 

  
3. In the Instructions toolpane, select the strinp_suppress_example instruction. 

  
4. In the Template toolpane, double-click the text element and change the entry to 1 to 

suppress the for example text. 
  

5. Click OK. 

23.2.4 Add a Local Template to an Event 

You can create a local template for an Event that uses the Default template. This allows you to 
customize the template for a specific event without affecting other events. 

 
You can also remove a local template so that the event for the Class reverts to the Default 
template. Be aware that you cannot undo this operation. If you decide you want a local 
template again, you must add it and create the elements manually. 
 

To add a local template to an event: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. Scroll the list of Classes as necessary and select a class. 

  

3. In the Event list, right-click the event definition to which you want to add a local 
template. 
  

4. On the shortcut menu, click Add Local Template. 

  
5. Edit the elements in the template as desired. 

To remove a local template from an event: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. Scroll the list of Classes as necessary and select a class. 

  
3. In the Event list, right-click the event definition to which you want to add a local 

template. 
  

4. On the shortcut menu, click Remove Local Template. 

23.3 Change Instructional Text 
When a user plays a topic in the Player, instructional text appears in various situations. During 
See It!, Try It!, Do It! and Know It? mode playback, navigational instructions appear in certain 
frames, such as "Press [Enter] to start" on the Start frame. Know It? mode has additional 
instructions plus remediation which appears when a user has performed a step incorrectly. In 
addition, a string input frame, which instructs the user to enter text, has example text.  

 
Each instruction may have more than one text element. The Leading Space option in the 
Element Properties dialog box enables you to insert a space before a text element to separate 
the text.  
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23.3.1 Change Instructional Text for the Player 

In the Player, instructional text appears in See It!, Try It!, and Do It! modes for the Start and 

End frames and on Explanation frames. You can customize this text in the template.xml file. 
 

This text is defined in the template elements in the Instructions toolpane, as shown below. 

 leadin: Start frame 

  

 leadout: End frame 
  

 continue: Explanation frame 

  

 decision_headline: Text at the top of a Decision frame 

Note: When you select certain instructions, the text in the Template area displays in raw 

XHTML format because it contains formatting that is not supported in the native template. The 

text you can edit is located between the <a class> and </a> tags. As you edit this text, be 
careful not to change or delete any of the other text or codes in the template definition, or the 
template may not work properly. 
 

To change instructional text for the Player: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. From the Edit menu, choose Instructions. 

  
3. In the Instructions toolpane, select the instruction you want to edit: leadin, leadout, 

continue, or decision_headline. 
  

4. In the Template toolpane, double-click the text element that you want to edit. 
  

5. Change the text as desired. 
  
or 

  
Edit the text in the XHTML code as desired. 
  

6. Select the Leading Space option, as necessary. 
  

7. Click OK. 

23.3.2 Change Instructional Text for Know It? mode 

During Know It? mode playback in the Player, instructional text appears for the Start and End 
frames and on Explanation frames. In addition, there are four levels of remediation that can 
appear if a user performs a step incorrectly. There is also text which informs a user the score 

needed to pass at the beginning of the topic, the score achieved at the end of the topic, and 

whether the user passed or failed. You can customize this text in the template.xml file. 
 

This text is defined in the Instructions section. The Template Contexts are defined as shown 
below. 

 knowit_leadin: Instructional text for the Start frame 
  

 knowit_leadout: Instructional text for the End frame 
  

 knowit_explanation: Instructional text for the Explanation frame 

  

 knowit_nextstep: Show Step text 
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 leadin_score: Text informing the user of the score needed at beginning of the topic 

  

 knowit_warningL1: Text for the first level of remediation 

  

 knowit_warningL2: Text for the second level of remediation 
  

 knowit_warningL3: Text for the third level of remediation 
  

 knowit_warningL4: Text for the fourth level of remediation 

  

 scoring: Scoring information at the end of the topic 
  

 scoring_YES: Indicates that the user has passed 
  

 scoring_NO: Indicates that the user has not passed 

  

 knowit_continue: Indicates that the user should continue working to complete the task 

  

 knowit_confirmdemo: Confirms that the user wants to view the step in See It! mode 
  

 knowit_dragwarning: Warns the user that the step is a drag and drop and that it is 

completed for them 
  

 knowit_finish_close: Gives the user a choice to exit without being scored or to return 
to Know It? mode 

Note: When you select certain instructions, the text in the Template area displays in raw 

XHTML format because it contains formatting that is not supported in the native template. The 
text you can edit is located between the <a class> and </a> tags. As you edit this text, be 
careful not to change or delete any of the other text or codes in the template definition, or the 
template may not work properly. 

 

To change instructional text for Know It? mode: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. From the Edit menu, choose Instructions. 

  

3. In the Instructions toolpane, select the instruction you want to edit. 
  

4. In the Template toolpane, double-click the text element that you want to edit. 
  

5. Change the text as desired. 
  

or 
  

Edit the text in the XHTML code as desired. 
  

6. Select the Leading Space option, as necessary. 
  

7. Click OK. 

23.4 Change the Font Format for Template Text 
In the template text generated for the bubble, there are certain items which have special 

formatting. These text items are listed below; each item is followed by its style name and 
format, for your reference. 
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 Object name: ObjectName; dark blue color, bold 

   

 Text entered in a string input: Content; red color, bold 
  

 Key name: Key; dark blue color, bold 

  

 Link: Link; light blue color, bold 

If you want to change this formatting, you cannot use the Template Editor; you must open the 
template.xml file in the xml editor of your choice. The statements in the Styles section at the 

beginning allow you to customize the color or the font weight of the text. The style is made up 
of three parts, as shown in the example below: 
 

<Style Name="ObjectName" Bold="true" Color="#000080"/>  
 

The Bold element is a Boolean value; it can be true or false. The Color element is the HTML 
code for the color. You can change either of these two values as desired. Do not change the 

style name. 

23.5 Translate Templates 
The Developer includes templates in several languages. If you need language(s) other than 
these, you can create a new template set for that language and translate the appropriate text 
in the template.xml file.  
 

First, create a subfolder for the language in the System/Templates folder. You must use the 

correct language codes, for example hu for Hungarian or pl for Polish. For a list of these codes, 
go to the following site: 
 

http://msdn2.microsoft.com/en-us/library/ms533052.aspx 
 

Follow the instructions for customizing the templates, except when you make a copy of an 
existing template, paste it into the new language folder. You can then translate the text in the 

template.xml file. 
 

The following items should be translated. 
 

Template text in the bubble 
See Edit the Template.xml File for more information. 
 

Instructional text for the Player 
See Change Instructional Text for the Player for more information. 
 

Instructional text for Know It? mode 
See Change Instructional Text for Know It? Mode for more information. 
 

Example text for String Input events 
See Change Example Text for String Input Events for more information. 
 

Note: Many of the templates have multiple elements. When you translate the templates into 
other languages, the order of these elements may need to be changed to account for 
differences in word order in various languages. 

23.5.1 Edit Event Names 

In the template.xml, there is a list of event types with corresponding names. These names 

should be translated. 
 

To edit Event names: 

1. In the Template Editor, open the Template.xml file you want to edit. 
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2. From the Edit menu, choose Event Names. 

  

3. In the Name list, click the event name once to select it. 
  

4. In the Name list, click the event name again to edit the text. 
  

5. Change the text as desired. 

  
6. Press ENTER. 

23.5.2 Edit Key Names 

In the template.xml, there is a list of all of the names of the non-alphanumeric keys on the 

keyboard. The names of the keys should be translated. 
 

To edit key names: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. From the Edit menu, choose Key Names. 

  
3. In the Name list, click the key name once to select it. 

  

4. In the Name list, click the key name again to edit the text. 
  

5. Change the text as desired. 
  

6. Press ENTER. 

23.5.3 Edit Shift Key Prefixes 

When there is an event that uses a keyboard combination, such as Shift+Click, the text in the 
bubble is "Press the Shift key and click...". There is a second template for multiple keyboard 

combinations, such as Alt+Ctrl+Click, for which the template text in the bubble is "Press 
Alt+Ctrl and click". These prefixes should be translated. 

 
For the multiple keyboard combinations, there are also separators that you can edit. 
 

To edit the shift key prefixes: 

1. In the Template Editor, open the Template.xml file you want to edit. 

  
2. From the Edit menu, choose Shift Key Prefixes. 

  
3. In the Prefix toolpane, click ShiftKeyPrefixSingle or ShiftKeyPrefixMulti. 

  

4. In the Template toolpane, double-click the text element in the Text column that you 

want to edit. 
  
Note: There may be no text in the Text column for the names of the keys. The name 
in the Shift Key field is the default. When you double click one of the names, you can 
add custom text to be used instead. 
  

5. Change the text as desired. 
  

6. Select the Leading Space option, as necessary. 
  

7. Click OK. 
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23.5.4 Use Genders 

In English, there is only one gender, called neutral in the English templates. In languages 

other than English, you may need to use multiple genders. For example, in English, a 
pushbutton and a radiobutton. 
 

To create and use genders, follow these basic steps: 

 Create the gender: When you create a new gender, it is copied from an existing 
gender of your choice. 
  

 Edit the class to use the appropriate gender: After you have created the genders as 

necessary, you must assign the correct gender to the class. 
  

 Edit the text for the events: Edit the text to be gender-appropriate for the events in a 

class. If the event uses the default template, then all events that use the default 
template for that gender are also updated. 

To create a new gender: 

1. In the Template Editor, open the Template.xml file you want to edit. 
  

2. In the Gender toolpane, right-click the gender you want to copy to create a new 
gender. 
  

3. From the shortcut menu, click Create New Gender. 
  

4. Enter a name in the Name field for the gender. 
  

5. Click OK. 

To edit the gender for the class: 

1. Scroll the list of Classes as necessary and double-click the Class definition you want to 

edit. 
  

2. Click the Gender list and select the appropriate gender. 

  
3. Click OK. 

To edit the text for an event: 

1. In the pane to the right of the Event list, double-click the text element you want to 
edit. 

  
2. Edit the element text as appropriate for the gender. 

  
3. Click OK. 
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24 Appendix A: Considerations for Setting 
Defaults 
When you use the Developer to create content, you may have many content authors working 
on the same project. Before you begin to record the content, it is important to determine 

certain defaults so that the finished content is consistent, no matter which content author 
created it. These defaults fall in to three basic categories: the content author's workstation, 
the target application, and the content defaults in the Developer. 

24.1 Set Workstation Defaults 
The Developer captures the entire screen, so how the screen looks on each computer is 
critical. Users can get confused if the data is inconsistent. Using default settings, then, is 
extremely important to provide consistency across all topics. You should determine these 

default settings before you begin development.  
  

Note: If authors are working in a team to develop content with sound, make sure that all 
authors are using the same microphones for a more consistent sound output. See Sound 
Recording Best Practices in the Enhance Content with Sound chapter for more information 
about recording sound. 

24.1.1 Set the Windows Default Color Scheme 

The color scheme on the development computers should be set to the company standard color 
scheme. If the company does not have a standard color scheme, the suggested color scheme 
is the default scheme for your operating system.  

24.1.2 Set the Video Resolution and Color Depth 

The color depth should be set to 256 or higher. The video resolution should be set to the 
lowest common resolution in the company, as it may impact the playback in See It! and Try It! 
modes. The bubbles may not be placed correctly, or the user may need to scroll to view the 

entire screen. 

  
Note: You can set a separate absolute or relative playback size for the See It! window in the 
Publishing Wizard when you publish Player content. You can also set a default See It! playback 
size in the Player category in the Options dialog box. 

24.1.3 Change the Taskbar Settings 

The option to always keep the taskbar on top of other windows and the option to auto-hide the 
taskbar should be selected before you record. These settings prevent the taskbar from 
appearing in the screen captures, and yet the taskbar is still easily accessible when needed.  

24.1.4 Turning Off Other Applications 

When you create content, you take screen shots of the entire screen. Therefore, items that 
appear on the desktop can also appear in the screen shot. You should close any other 

applications that are running or toolbars that appear. Also, turn off any memory-resident 
programs that might interrupt the screen capture process; for example, programs that 
automatically notify you when you have e mail. This procedure not only prevents these things 
from appearing in the screen shots but also reduces the load on system resources. A partial 

checklist of applications includes: 

 Mail programs, especially those with automatic notifications 
   

 Shortcut bars, such as the Microsoft Office shortcut bar 

   

 Customized menu bars 
   

 Virus protection software, where possible 
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Note: You should also be sure to maximize the target application window while you are 
recording content. 

24.1.5 Set the Defaults in the Target Application 

In many applications users can configure their GUI with colors and fonts. In addition, the user 
profile may have other defaults set as well, such as the date format or the default screen at 

startup. For the authors creating content, these defaults should all be reset to the defaults in 
general use at the company. This creates a uniform look and starting place for every topic. 
 
In addition, you should maximize the window for the target application when you are 
recording content. If the target application's window covers the entire screen, then the 
Windows desktop icons do not show in the screenshot. If possible, turn off tooltips in the 
target application as well. 

24.2 Set Content Defaults 
Content defaults act as a default set of properties for the creation of new frames and web 

pages. When the content defaults are changed, any existing content is not affected. 
 
These defaults must be set on each individual workstation and should be done before you 
begin development. You do not have to change the original default settings in the Developer; 

changing these defaults is a matter of choice to create the "look" you want for the content. 
Consistency is the key element. After deciding on a standard set of content defaults and 
creating them in the Developer, you should export these defaults and distribute the export 
(.ops) file to the other authors developing content. 
 
Certain changes that are highly recommended are indicated as such in the sections below. 
 

Note: When choosing font and background color defaults, it is recommended that you choose 
web safe options. For example, Arial is a font style widely used in web page development. For 
web pages, the safest choice is to select a predefined font family, which includes a group of 
multiple fonts that have similar characteristics. 

24.2.1 Set Bubble Defaults 

The Bubble page in the Content Defaults category contains the options that allow you to 
change the icon, pointer position, background color, and font for the bubble. In addition, the 
Bubble page contains the options that control if template text appears in the bubble and if 

custom text appears above (the default) or below template text. 

24.2.2 Set Other Font and Color Defaults 

You use the pages in the Content Defaults category to set the font and color defaults for the 
following components:  

 Introduction/End Frame: These frames appear at the beginning and end of each topic, 
displaying introductory and concluding text that the content author enters in the Topic 
Editor. In addition, the Introduction text for each topic displays in the Introduction 

pane in the Outline Editor and Player windows. By default, Introduction and End frame 
text uses the 10 point Arial font and a pale yellow background color. Changing these 
options affects the appearance of the Introduction pane, as well as the Introduction 
and End frames in all play modes. 
   

 String Input: String inputs are events that occur while recording a topic when you are 

typing, such as entering information into a field. When a user plays the topic in Try It! 
mode, the user must enter the specified text to move to the next step. The action area 
(the area in which the user must type the text) uses an 8 point font size in the default 
MS Sans Serif font, and white background color shown in the sample box in the String 
Input page You can change these options to better simulate the application in which 

you are recording. 
   



Appendix A: Considerations for Setting Defaults 

 

 516 

 Web Page: Web pages contain extra information that can be attached to the content. 

Web pages can display a simple note or definition of terms, or display a more complex 

arrangement of text, bulleted and numbered lists, tables, graphics and hyperlinks. 
Using a style sheet or setting content defaults provides a consistent appearance for 
web pages. Style sheets provide many more formatting controls than using content 

defaults. When you change the settings in a style sheet, the change applies to all web 
pages linked to the style sheet. Conversely, if you choose to use content defaults, the 
changes that you make to the content defaults affect new web pages only. The default 
setting for web pages is to use the Standard style sheet installed with the Developer. 
You can modify that style sheet or create a new style sheet and assign that style sheet 
as the default for all new web pages. The Standard style sheet sets a 10 point Arial, 

Helvetica, sans-serif font family with a white background. See the Create Styles to 
Format Content chapter for more information about creating different types of styles. 

24.2.3 Set the Frame Delay 

In See It! mode, there is a predetermined delay time between each action. This delay controls 

the amount of time that elapses between the appearance of the frame and the start of the 

action. The delay gives the user time to read the text in the bubble before the action starts. By 
default, the delay for all frames is 5 seconds. However, you can change the default frame 
delay time. You can either use a selection from the Frame Delay list or enter another delay 
time manually. If you choose the 0 or skip option, a "0" frame delay is applied to all action 
frames and "Skip" is applied to non-action frames. As a result, the playback for action frames 

starts immediately when the frame appears and for non-action frames, the playback skips the 
frame and moves immediately to the next frame. If you choose the Infinite option, the 
playback waits for the user to press ENTER before advancing to the next step. The bubble 
automatically displays the text "Press ENTER to continue." 
  
Warning! Be careful when setting the default Frame Delay to 0 or skip. This setting causes 
the playback in See It! mode to skip the Introduction, End and Explanation frames for all 

newly recorded content. 

24.2.4 Set Know It? Defaults 

Know It? mode is the assessment mode for the playback. If you intend to make this mode 
available to your users, you can select the defaults for the mode in the Know It? Options 
section on the Topic page, under Content Defaults, in the Options dialog box.  
 
Know It? defaults affect new content in a different way than other content defaults. Content 
defaults, as found on the Bubble, Introduction/End Frame and String Input pages, only affect 

a topic at the time of recording. You can create your entire outline and set those content 
defaults just before you start the recording process. The recorded topics reflect the new 
content selections. Know It? defaults, however, affect a new topic when you create/link it to 
the outline. Newly created topics, even those without content, inherit the defaults in the Know 
It? Options section. Therefore, it is best to set your Know It? defaults BEFORE you add topics 
to your outline. 

 
Note: You can change the Know It? defaults for existing topics by selecting the desired topics 
and opening the Properties toolpane. To open the Properties toolpane from the Library or 

Outline Editor, select the View menu, point to Panes, and select the Properties command, or 
click the Properties icon on the toolbar. You can also right-click your selection and select the 
Properties command from the shortcut menu. To disable Know It? mode entirely for the 
selected topics, deselect the Know It? option in the Play Modes property list. 

 

Set the Default Passing Score 

After users complete the task in Know It? mode, they are presented with their score, the 
passing score for the topic, and an indication of whether they passed or failed the topic. A 
separate passing score for an individual topic can be set in the Properties toolpane. 
 

Set the Remediation Levels 

When a user fails to complete a step in Know It? mode, they are marked incorrect for that 
particular step and presented with up to four levels of remediation. The first three levels of 
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remediation prompt the user to complete the step with increased support at each level. You 
can reduce the default number of remedial steps by eliminating levels. You can eliminate any 

of the first three levels; the fourth level completes the action for the user and cannot be 
removed. You can apply separate remediation settings for individual topics in the Properties 

toolpane. 
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25 Appendix B: Development Considerations 
This appendix describes various considerations for developing content. 

25.1 Assign Development Tasks and Flow 
You can assign the development tasks as best suits your available resources. Listed below are 
the major tasks and a suggested division of responsibility for each task.  
 

Develop standards 

Project leaders. Includes content, formatting and styles, and naming conventions. 
 

Create content 
Content authors. Includes recording topics, adding Introduction and End frame text, creating 
and linking attachments, adding Glossary terms, Jump-in points, adding bubble text (including 
Know It? mode text) as necessary, and creating questions and assessments to test existing 

competency and learning. 
 

Edit content (initial) 
Content authors or Editors. Includes playing topics in all play modes in the Developer to check 
for correct screens, correct text, correct web pages and apply styles, and so on. May also need 
to publish and test Jump-in points and See Also links in the Player window. This task could be 
done by a separate team of editors, or the content authors could check each other's work. 
 

Spelling/grammar check 
Content authors. Includes checking spelling and grammar, or creating a printed reference 

document. 
 

Create glossary terms 
Editors, Project leaders, or Content authors. Includes creating glossary terms. 
 

Create roles 

Editors or Project leaders. Includes creating and attaching roles to the topics. 
 

Attach keywords 

Editors or Project leaders. Includes attaching keywords to the topics. 
 

Testing (QA) 
Project leaders. Includes playing the topics in all modes in the Player and testing questions 
and assessments linked to the outline. 
 

In addition to assigning development tasks, you should create a development flow through the 
various tasks. A good flow can make the process smooth from first development through final 

editing. A bad flow can extend the process far longer than necessary. A recommended flow is 
shown below: 

1. Create scripts for the transactions (Development Team) 

  
2. Record initial content (Content authors) 

  
3. Test the recorded frames (Content authors) 

  
4. Make corrections or re-record frames as necessary (Content authors) 

  
5. Add text to recorded topics (for example, Introduction/End frames, extra bubble text, 

Know It? mode text) (Content authors) 
  

6. Create and link attachments (Content authors) 
  

7. Create, link and set properties for questions and assessments (Content authors) 
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8. Create and update Glossary terms (Editors or Project leaders, Content authors) 
  

9. Test the recorded topics (Editors) 
  

10. Verify text in Introduction/End frames, bubbles, attachments (Editors) 
  

11. Make necessary corrections (Content authors or Editors as appropriate) 
  

12. Preview questions and assessments to verify answers, remediation, and content links. 
(Content authors or Editors as appropriate) 
  

13. Create and associate Roles (Editors or Project leaders, Content authors) 
  

14. Assign keywords (Editors or Project leaders, Content authors) 
  

15. Perform spell check and final glossary update (Content authors) 
  

16. Test topics in the Player 

  
17. Test pre and post assessments in the Knowledge Center (available in the Professional 

edition only) 

25.2 Create Scripts 
Before you begin to create content with the Developer, you should first create scripts that 
identify the tasks your audience uses in the target application. These scripts should contain a 
list of the steps in each task and valid test data from the target application to complete the 
task. It can also include supplemental information about the task, such as the following:  

 Why and when the task is performed 
   

 Required and optional input fields 

   

 Appropriate results of the task; for example, a printed report or a file 
   

 Any hints, tips, and tricks for the user  

  

 Create an audio script with the verbal text for each topic action if recording sound and 
actions at the same time. 

When you are creating scripts, keep in mind the needs of your users. Try to anticipate the 
questions your audience may have and what information they need to use the application and 

perform the task successfully. For example, if there is prerequisite information needed before 
a task can be accomplished, or if specific information should always be used, these 
instructions should be available to your audience. 

25.3 Suggestions for Developing Content 
The following are some suggestions that may help you develop and organize content more 
effectively and efficiently:  

 Be consistent in naming modules, sections, topics, questions, and assessments in the 

outline. If the naming convention is not consistent, it is much more difficult for the 
user to locate a topic. 
   

 If you author content as a team in a multi-user installation of the Developer, or if you 

link content from multiple outlines, it is a good idea to develop a draft outline before 
you start creating content. Also, you may want to designate a small number of people 
to make changes to the outline. This can help avoid confusion about who is working on 
what content. 
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Note: If you are using the multi-user version of Developer, you can use the Owner 

property to assign documents to authors. 

   

 Create an overview course with topics that cover the basics of using the target 
application. This could include logging in, using the interface, general navigation 

(menus and shortcuts), and using searches to find valid values for data entry. 
Introducing the user to these techniques allows you to shorten the task topics by 
assuming a basic level of knowledge for the user. 
   

 Avoid using search features when recording most topics. This is most important for 

accurate steps in Do It! mode. The dialog boxes that open when a user searches for 
valid data offer many options. If a user chooses a different option than the one 
indicated by the Player in Do It! mode, the steps do not match and the Player is not 
able to display the appropriate information. 
   

 If you want to include navigation in the topic, use the shortcuts instead of the menu 

path if possible. This shortens the number of steps, as some menu paths may be quite 

long. 
   

 Create "stem" topics for those tasks that start with the same steps. Then, you can 

copy and rename the topic, or copy individual frames, and insert the necessary frames 
to complete the task. 
   

 Use only template text in the bubbles as much as possible. As changes are made to 
the system, the template text is updated more easily than custom text. 

25.4 Create Content in Multiple Languages 
At some organizations, content must be deployed in several languages. As you develop 
content, keep in mind that the default text in the bubbles is generated from templates. If you 
apply a template set in another language, the template text is "translated" into that language. 
The templates do not affect other text items, such as user-entered text in bubbles, 

Introduction and End frame text, web pages, and object names in bubbles. These items must 
be translated manually. In addition, the graphics that are captured remain in the original 
language.  
  
Note: If you are using style sheets, you can create language style variations that use fonts 
that are better suited for certain languages. 
 

When you create content in a different language you should install the Developer and set the 
primary authoring language to match the language that you are creating content in. Add your 
content in the language that you want and make sure all documents that you create have the 
appropriate language template assigned. When you publish the content, make sure you use 
the correct publishing style that matches the content language. 
 

Target application screens in each local language; Developer content in local 

language 

In this situation, you need to localize not only the text in the content, but the screenshots as 
well. 
 

To help you in recording the content, you record the content in one language (for example 

English) first. Then, create a duplicate of the content and assign the target language and 
template to the content. Open the application in the other language and use rerecord to guide 
you through capturing the screens and actions in the localized language. 
 

You can manually translate the bubble text for your content in-house or use localization to 
package the content for translation. After an exported package is localized, you import the 
package back into your Library. 
 

If you need to supply content for a language not supported by Developer, you can translate 

the supplied templates. 
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Target application screens in same language; Developer content in local 

language 

In this situation, you only need to localize the text in the content. To do this, you should 
create a duplicate copy of the content and assign the target language and template to the 
content. You can manually translate the bubble text for your content or use localization to 
package the content for outside translation. 
 
Note: See the Localize Content chapter for more information on localization. 

25.5 Development Tips 
Create the Outline  

 Be consistent in verb tense when naming outline items. 
   

 Create the outline even if it has not been finalized. You can always go back and 

rename and reorganize outline items. 

   

 Avoid using special symbols such as &, $, *, and so on when naming modules, section, 
and topics since they may cause problems when publishing.  

  

 Create an audio script if you intend to record sound at the same time you record the 
steps. 

Before You Record 

 Test the steps of the task to make sure you have all the steps and adequate test data. 
  

 Test the data before you record it and make sure it works. This helps prevent errors in 
your topic. 
  

 Make sure you set up the target application at the correct screen for the beginning of 

the topic. This may include logging out and logging in again to clear any “sticky” data. 
  

 If recording sound at the same time, check your sound and microphone recording 
levels and settings. 

As You Record 

 Until you are comfortable recording, you may want to change the recording mode to 
manual so that the Recorder does not capture incorrect actions and screenshots. You 
can change the recording mode in the Recorder category in the Options dialog box. 
  

 Go slowly when you are recording to be sure that the Developer has had time to read 

the objects on the screen completely and the screens in the application have a chance 
to refresh. 

  

 Make sure that the step you want to record is showing in the Next screenshot records 

area of the Recorder window before you press PRINTSCREEN. 
  

 Make sure that the action displayed in the Last recorded event area of the Recorder 

window accurately reflects the action you wanted to record. If it does not, click the 
Undo button in the Recorder window and re-record the action. 
  

 If you are not sure, record the action. It is easier to delete extra frames than insert 
ones that you missed. 
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After You Record 

 Immediately preview the topic in Try It! mode before you add attachments, bubble 
text, Introduction/End frame text, and so on. If you discover errors and have to re-
record the topic, you do not lose a lot of extra work. 
  

 Listen to the recorded sound for each frame. 

Editing Content 

 You cannot move (drag and drop) a frame in the Frame Structure window in the Topic 
Editor so make sure you insert it in the right place. However, you can move and copy 
frames within a topic and from topic to topic. 
  

 Be sure you know on which frame an Alternative Path starts and ends. However, if you 
choose the wrong end frame, you can change it. 

Fonts and Colors 

 You can create styles in style sheets and use those styles for a consistent appearance. 
You can also create separate print styles in a style sheet to modify to produce a better 
print appearance. If you publish documents using the Developer Settings option for 
web pages, the printed output uses the styles in the style sheet linked to the content 
instead of the settings in the print template. 

  

 If you are not using style sheets to format web pages, you can publish documents 
using the Word Template settings. When you publish with Word Template settings, 
changing the defaults in the Developer has no effect on the text fonts or colors for the 

printed outputs. If you want to change them, you should customize the 
PrintTemplate.docm file in the Styles folder for the appropriate print output. See 
Customize Document Formats in the Publish Content chapter for more details. 

Multi-user Considerations 

 When working in a multi-user installation, be sure to check in your checked out 
documents so that they are under version control and available to other authors. 
Before leaving on a vacation, check in all of your documents. 
  

 If you need to work on a portion of an outline, only check out those documents that 
you need to edit. 

25.6 Test the Content 
Before content is deployed to the user community, it should undergo a QA review. It should be 
tested for the accuracy of the information, to make sure that the topics play correctly in each 

mode; hidden frames and bubbles function correctly; items such as web pages, packages, see 
also links, jump-in points, and alternatives are in the right place and launch correctly; and 

sound, if included, possesses clarity and consistent sound levels. While much of this can be 
done using the Developer, it is a good idea to publish it to a Player environment and have a 
small group of users test it.  

25.6.1 Test Play Modes 

Play the topic in each play mode that your audience is using. Ask the following questions for 
each play mode.  
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See It! mode 

 Is this mode an appropriate mode for this topic? 
  

 Does the user have enough time to read the bubble text before the Player advances to 

the next step, or does the delay time need to be adjusted? 
  

 Is the action area in the correct location on the screen? 

  

 Is the text in the bubble appropriate for the screenshot? 

  

 Do all the paths of the available Decision frames work correctly? 

Try It! mode 

 Is this mode an appropriate mode for this topic? 

  

 Can the steps be completed correctly based on the information in the bubble? 

  

 Do the Alternative paths and actions work correctly? Do the paths rejoin at the 

appropriate place? 
  

 Do all paths of the Decision frames work correctly and/or rejoin at the correct 
location? 

  

 Do the web pages, packages, and URLs launch correctly? Do the links appear in the 
correct location? 
  

 Do the glossary terms work? Are they assigned correctly? 
  

 Are the screenshots accurate? 

Do It! mode 

 Is this mode an appropriate mode for this topic? 
  

 Are any necessary "set-up" instructions explained in the Concept pane or on the 
Introduction frame (for example, "You must have the Purchase Order number before 

you start this topic?") 
  

 Are the instructions for each step generic enough to allow for different situations in the 
target application? 

  

 Should any step be displayed in the window with the step following it? (using the Keep 
with next option, especially for menus and drop-down lists). 

  

 Do the Alternative paths and actions work correctly? Do the paths rejoin at the 
appropriate place? 
  

 Do all paths of any Decision frames work correctly and/or rejoin at the correct 

location? 
  

 Do the web pages, packages, and URLs launch correctly? Do the links appear in the 

correct location? 
  

 Do the glossary terms work? Are they assigned correctly? 
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Know It? mode 

 Is this mode an appropriate mode for this topic? 
  

 Does the user have the appropriate objective statement before beginning the topic? 

  

 For each step, are there hints and tips, if appropriate, to allow the user to complete 
the step successfully? For example, indicating what choice to make from a drop-down 
list or what to enter in a string input frame? 
  

 Do the glossary terms work? Are they assigned correctly? 
  

 Is the assigned score appropriate for the topic? 

  

 Is the correct remediation level assigned to the topic? 

25.7 Player Window 
Publish the content for the Player environment that your audience is using. Ask the following 
questions about these features:  

 Does the correct information display in the Concept and Introduction panes when the 
user clicks an outline item? 
   

 Do the Jump-in points work correctly for each topic? 

   

 Does each role display the correct content? 
   

 If you published content by role, were the correct modules, sections and topics 

included in the published package? 
   

 Does the Search feature (if available) display the correct content? 

   

 Does the Applicable option display the correct list of topics? 

   

 Do See Also links work correctly? 
   

 Do the Show Associated Content links work correctly for questions? 

  

 Does the sound play correctly for the selected play mode? 

   

 If you specified a window size for See It!, does the See It! window open in that size?  

25.8 Document Outputs 
Publish the content for the document format that you may use. Ask the following questions 

about the format and contents:  

 Does the document contain all the information that you want your audience to have? 

   

 Does the information appear in the appropriate location in the document; for example, 
does the concept information appear in the Training Guide document? Do the 
instructor notes appear in the Instructor Manual? Are the documentation fields for a 

System Process Document and Test Document populated? 
   

 Are there enough screenshots in the document, or should there be more or less? 
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26 Appendix C: Develop Content for Different 
Deployments 
You have many choices for deploying your content to your audience. When you create content, 
you can easily publish the content for the Player, as separate topics, and for documentation.  
 
When you create standards for authoring content, you should take into account the type of 
deployment method(s) being used. Depending on the deployment method you choose, there 

could be an impact on how you organize the content in an outline, how and where you use 
web pages and packages to convey information to the user, and where other information, such 
as Introduction or custom bubble text appears. 

26.1 Develop Content for Deployment in the Player 
If you are deploying your content via the Player, you are essentially creating online training. 
Typically, content for online training is brief and to the point. Online users are generally more 

interested in learning by doing (for example, performing the steps) rather than reading text on 

the screen. The following lists the items where you can add information to the topic and 
indicates suggested uses for each. 
 
Concept pane 
Provides helpful and/or critical information by links to web pages, package documents, and 
URLs at the module, section, or topic level for all modes. 

 
Topic frame and bubble text attachments 
Frame and bubble text links provide helpful and/or critical information by linking to web 
pages, package documents, and URLs. Frame links appear for all modes and bubble text links 
appear for Try It! and Do It! modes. 
 
Introduction frame 

Introduces a task in all modes. 
 

End frame 
Identifies the completion of a task in all modes. 
 
Explanation frame 
Calls attention to an area of the screen or provides an explanation of an action. 

  
Custom bubble text Adds specific information in bubbles for all modes, only simulated modes, 
or only Do It! or Know It? mode. 
 
Glossary terms 
Provides definitions for specialized terms and links to package files or URLs. 

 
Print It! mode 
Allows the user to print the topic steps from the Player in a Job Aid or System Process 
Document format for those topics for which the Print It! play mode is enabled. 

  
See Also list  
The See Also list provides links to other modules, sections or topics with related content. The 

See Also list only appears in the Player for documents that have the See Also property set. 
  
Recorded sound 
Recorded sound can duplicate the information in the web page or frame bubble, or it can 
contain additional supplemental information. If you use sound to add supplemental 
information, be sure to create web pages with the additional content and hyperlink them to 
your concepts or frames to make your content accessible. 
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26.1.1 Outline 

While users can search in the Player to locate topics, it is recommended that an outline has a 

logical flow. This could mean an outline for training, with the topics grouped in a hierarchy of 
modules and sections that build on previous modules and sections, or an outline for reference, 
with the topics grouped in modules or sections that contain all the topics that have to do with 
a specific subject. You could also build an outline in which each topic in a section is a different 
task in a particular business process.  

26.1.2 Attachments: Web Pages and Packages 

You should consider what information should be placed into attachments, and then where the 

attachment should be attached: a frame, a topic, a section, or a module. When you link an 
attachment to a frame, an icon appears in the bubble during playback. When you link an 
attachment to a module, section, or topic in the Outline Editor, it appears in the Concept pane 
in the Player. You may also want users to launch attachments through glossary hyperlinks.  
 

Note: Frame link attachments are not available in See It! or Know It? modes. Attachment 

links to bubble text appear in text marked to display in Know It? mode. 
 

When you link an attachment to a frame, you choose from icons that appear in the bubble in 

Try It! mode or at the top of the checklist in Do It! mode. It is highly recommended that you 
use these icons consistently to indicate the different types of information the attachment can 
contain. 
 

Note: If you do not enter a tooltip when you link an attachment, the default tooltip "Link" 
appears when the user points to the attachment. No tooltip appears if you delete the "Link" 
text. 

26.1.3 What Appears in Which Play Mode 

There are several choices you can make about how you transfer information from a script into 
the Developer. You can place any of this information in various places, including attachments, 
Explanation frames, bubble text, and Introduction and End frames, but it is important to 

consider in which mode the information is available to the user. The following list shows what 
features are available in each play mode.  

 Introduction/End text 
See It!, Try It!, and Do It! 

Know It? - if text is marked for Know It? 
   

 Attachment icons 
Try It! and Do It! 

   

 Bubble text links to attachments 
Try It! and Do It! 
Know It? - if text is marked for Know It? 

   

 Glossary terms 

Try It! and Do It! 
Know It? 

   

 Jump-in points 
See It!, Try It!, and Do It! 
   

 Explanation frames 
See It!, Try It!, and Do It! 
Know It? - if text is marked for Know It? 
   

 Alternative Actions 
Try It! and Do It! 
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Know It? 
   

 Alternative Paths 

Try It! and Do It! 
Know It? 
   

 Decision frames 

See It!, Try It!, and Do It!  
  

 String Input text 

Do It! and Know It? - can display additional text entries if the list does not contain 
"anything" or "something" entries 

26.1.4 Fonts and Colors 

Since content in the Player can be delivered through a browser window, users could have 
widely varying screen resolution and color depth settings. Therefore, it is important to 
consider the fonts and colors that you use in the content. Not all fonts are easily readable on 

the screen, and not all colors appear correctly.  
  
In general, sans-serif fonts such as Arial are recommended for anything appearing on the 
screen, since they appear more clearly. Also, avoid special fonts that every user may not have 

installed on their computer. If you do not know which fonts users have installed, it is advisable 
to use a font family for web pages. A font family is a group of fonts with similar 
characteristics. The web browser goes through the fonts in the family until it finds one that is 
installed. 
 
Different colors may appear differently on a user's computer, depending on the color depth 

that is set on the machine. For example, if a user has a lower color depth setting on his or her 
machine, a particular color may appear so dark that it prevents them from reading the text or 
viewing a graphic. The Web Colors palette in the Color dialog box contains colors that render 
similarly for most monitors, and are considered safe colors. 

26.2 Develop Content for Deployment as Printed Documentation 
You can publish content in four different document types: System Process, Training Guide, Job 
Aid, and Test Document. In addition, you can publish an Instructor Manual, which is a training 

guide that also includes instructor notes, or publish topics that can be exported via a comma 
separated (CSV) file (which can be opened in Microsoft Excel) to a testing application. Each of 
these documents has a different format and includes slightly different information from each 
topic.  
 
The following lists the items where you can add information to the topic and indicates 
suggested uses for each.  

 
Concept pane 
Provides helpful and/or critical information or images at the topic level in the System Process, 
Training Guide and Instructor Manual formats. 

 
Web pages 

Provides helpful and/or critical information at the concept (module, section, topic) or frame 
level for the System Process, Training Guide and Instructor Manual formats. 
 
Package image files 
Image files appear for module, section and topic concepts, and frame level links in the System 
Process, Training Guide, and Instructor Manual formats. Glossary terms that link to package 
images also appear in the Glossary for the Training Guide and Instructor Manual formats. 

 
Introduction frame 
Appears above the procedure steps in the System Process, Training Guide and Instructor 
Manual formats. 
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End frame 

Identifies the completion of a task in all outputs. 

 
Explanation frame 
Appears in all document outputs. 
 
Custom bubble text 

Adds specific information in the procedure steps for all document outputs. 

26.2.1 Outline 

In the Training Guide and Instructor Manual formats, the publishing process creates a single 
Word document for the entire selection. Each document has a table of contents, which is the 
same as the outline in the Developer. The outline, therefore, should reflect an outline for 
training, with the topics grouped in modules and sections that build on previous modules and 
sections.  
 

In the other document outputs, the publishing process creates a separate document for each 

topic. There is no table of contents, so the hierarchy of the outline is not used in the 
documents other than the outline and/or topic name, which may appear in the header.  

26.2.2 Attachments 

If you are publishing the content for printed training materials or a System Process Document, 
keep in mind that the document output includes web pages, graphics in packages, URLs as 
static text plus hyperlink, and link icons. In addition, linked bubble text appears as plain text; 
it is not underlined and hyperlinked as it appears in the actual topic. In addition, attachments 

that appear in the Concept pane appear as concept (discussion) text in the training guide 
output. 

26.2.3 What Appears in the Document Outputs 

There are several choices you can make about how you transfer information from a script into 
the Developer. You can place any of this information in various places, including web pages, 

packages, URLs, Explanation frames, bubble text, and Introduction and End frames, but it is 
important to consider in which mode the information is available to the end user. For example, 

you may not want to put critical information in the Introduction frame if you are using one of 
the printed output formats that do not include the Introduction frame. 
 
The list below gives a brief summary of the features that appear in each of the document 
formats: 
  
System Process Document  

Concept attachments (topics only)  
Introduction and End frames  
Explanation frames  
Decision frames  
Alternatives - Included (selectable)  
Bubble text mode - See It/Try It! (selectable) 

Web page format: Developer settings 

Web pages 
Images in web pages (selectable)  
Images in packages (selectable)  
URLs  
Relative links (selectable) 
Screenshots - Topic settings (selectable)  

  
Training Guide  
Concept attachments (all outline items)  
Introduction and End frames  
Explanation frames  
Decision frames  
Alternatives - Included (selectable)  
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Bubble text mode - See It/Try It! (selectable)  
Web Page format: Developer settings  

Web pages 
Images in web pages (selectable)  

Images in packages (selectable)  
URLs  
Relative links (selectable) 
Screenshots - Topic settings (selectable)  
Questions and Assessments  
  
Instructor Manual  

Concept attachments (all outline items)  
Introduction and End frames  
Explanation frames  
Decision frames  
Alternatives - Included (selectable)  
Bubble text mode - See It/Try It! (selectable)  

Web Page format: Developer settings  

Web pages 
Images in web pages (selectable)   
Images in packages (selectable)  
URLs  
Relative links (selectable) 
Screenshots - Topic settings (selectable)  

Questions and Assessments  
Instructor Notes  
  
Job Aid  
End frame  
Explanation frames  
Decision frames  

Alternatives - Not included  (selectable)  
Bubble text mode - Do It! (selectable) 

URLs  
Relative links - Not included (selectable) 
Screenshots - None (selectable)  
  

Test Document, Test Results   
End frame  
Explanation frames  
Decision frames  
Alternatives - Included (selectable)  
Bubble text mode - Do It! (selectable) 
URLs  

Relative links (selectable) 
Screenshots - Topic settings (selectable)  

26.3 Control Bubble Text for Document Outputs 
The play mode for which custom text is marked determines in what playback or document 
output the text appears.  
 

See It/Try It! 

 System Process Document 

 Training Guide 

 Instructor Manual 
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Do It! 

 Job Aid 

 Test Document 

 Test Case 

However, you may want custom text to appear during playback, but not appear in your 
training guide. Conversely, you may want text to appear in the document output, but not in 
the Player. By using the Visible in Player and Visible in Print buttons, you can control whether 
your custom text appears for Player output only, a Print output only, or in both. 
 
Warning! Selecting or deselecting the Visible in Player or Visible in Print buttons affects the 
visibility of the selected text in all selected play modes for Player or document output. If 

custom text is marked for both See It/Try It! and Do It! modes, deselecting the Visible in Print 
button means that the text does not appear in any document output. 
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27 Appendix D: Accessible Content 
Accessibility is the ability of the disabled to utilize your products, services, tools and content. 
  

Accessible content must be: 

 Perceivable: Users must be able to perceive the information being presented. It must 
be visible to at least one of their senses. 
   

 Operable: Users must be able to operate the interface and its components. The 

interface cannot require interaction that the user cannot perform. 
   

 Understandable: Users must be able to understand the information as well as the 

interface. 
   

 Robust: Content must be robust enough that it can be interpreted reliably by a wide 
variety of user agents, including assistive technologies. 

A key part of accessibility is providing a comparable learning experience for a disabled user. A 
comparable experience means that the product, service, tool or content meets the following: 

 Timely access: The information and data is available to individuals with disabilities at 
the same time as individuals without disabilities. (This does not preclude captions that 
are slightly delayed or other reasonable differences). 
   

 Accurate: The information and data reflects the intended meaning especially when 

converted into another form or media. 
   

 Complete: All crucial information and data is included when accessed by assistive 

technology or converted into another form or media. 

   

 Efficient: An individual with a disability exerts a reasonably similar or comparable 
amount of effort in using electronic and information technology as compared to an 
individual without a disability. 

27.1 Best Practices: Create Accessible Content 
The HTML Web Site publishing format is designed to provide an accessible experience for 
users.  
  
While authoring content, there are some guidelines and practices you should consider to 
ensure that all of your content is accessible. 

 Provide keyboard alternatives for topic procedures. 
   

 Use glossary terms for definitions of abbreviations. 
   

 Try to use style sheets and styles for web pages instead of inline formatting. Style 

sheets provide accessibility coding for layouts and screen presentation elements. 
  
Note: Web pages are coded to comply with provisions to supply equivalent 
information or functionality. 
     

 Use a consistent page layout and terminology across pages. 
  

 For web page images that convey ideas or information, use the Alternative Text field 

in the Image Properties to add text explaining the information that a sighted person 
learns from viewing the image. Right-click the image and select Image Properties to 
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access the Alternative Text field. 

  

 Be consistent in your Alternative Text descriptions of images and buttons. 
  

 For web page images that are solely decorative, leave the Alternative Text field blank. 

This creates an empty HTML alt tag that is ignored by a screen reader. 
  

 Do not use images in place of text. Information relayed by the image should also be 

available in text form. 
   

 Provide row or column headings for tables, and if possible, use both. 

   

 Provide a description of tables in the Summary field in Table Properties dialog box. You 
may also need to include information about how the table is sorted and why there may 
be empty cells. Right-click the table and select Table Properties to access the 

Summary field. 
  

 Set the Table Type to Data or Layout. The table style tells the screen reader if the 
table needs to be read for data or if the announcement can be skipped because it is 

used to control the organization of the content only. The default table type is data. To 
set the table type to Layout in the Web Page Editor, right-click the table, select Table 
Properties, and use the Advanced tab to access the Table Type list. 
  
Note: You cannot set the Table Type for table styles in the Style Editor. The Layout 
type must be set in the Web Page Editor for each layout table. You can, however, copy 

a table with a Table Type set to Layout to another web page and the Layout property 
is preserved. 
   

 If using sound, ensure that you provide comparable text content. For example, for 
web pages, you can either include the information directly in the page, or provide a 

link to open the text script of the audio. 
  

 Avoid using color as the only means of distinguishing visual elements. 
   

 Avoid descriptions using relative size, position, shape, and orientation. 
   

 While the Developer software writes a valid Doctype in the heading for topics, 

questions, and webpages, and also uses the Title element to create unique page 
names, it is up to authors and content developers to make sure that external content 
is also appropriately tagged. 
   

 Include Print It! mode in HTML format for an accessible Player output. 

   

 Publish the Player with the option that allows users to change preferences; for 
example, marquee color, key combinations for advancing Do It!. 

 


